RISA-3D
Rapid Interactive Structural Analysis –
Version 20- General Reference

RISA Tech, Inc.
27442 Portola Pkwy, Suite 200
Foothill Ranch, California 92610

(949) 951-5815
(949) 951-5848 (FAX)
risa.com

Copyright © 2022 RISA Tech, Inc. All Rights Reserved. RISA is part of the Nemetschek Group.
No portion of the contents of this publication may be reproduced or transmitted in any
means without the express written permission of RISA Tech, Inc. RISA and the RISA logo are
registered trademarks of RISA Tech, Inc.

We have done our best to ensure that the material found in this publication is both useful
and accurate. However, please be aware that errors may exist in this publication, and that
RISA Tech, Inc. makes no guarantees concerning accuracy of the information found here or in
the use to which it may be put.

Table of Contents

Table of Contents
1

Cold Formed Shape Types

44

Overview

1

Cold Formed Steel - Design

46

Minimum System Requirements

1

Design Parameters

46

Program Limits

2

AISI Steel Code Check Results

48

License Agreement

2

Assumptions and Limitations

50

Maintenance (Perpetual License Only)

2

Special Messages

52

Before You Begin

Application Interface

4

Starting a Model

4

Title Bar

5

Ribbon Toolbar

6

Concrete Member - Database
Custom Rebar Layout Database
Concrete Member - Design

53
53
59

Concrete Spans

59

Panels

12

Concrete Design Parameters - Columns

60

3D View

17

Concrete Design Parameters - Beams

62

Shortcut Menu

21

T-beam & L-beam Sections

64

Dynamic View Controls

22

Parabolic vs. Rectangular Stress Blocks

64

Shortcut Keys and Hot Keys

23

Biaxial Bending of Columns

65

Status Bar

25

Windows

26

British Eurocode Design Parameters (BS EN
1992-1-1: 2004)
66

Modes

28

Limitations - General

66

30

Limitations - ACI

67

31

Limitations - Canadian Code

67

33

Limitations - Australian and New Zealand
Codes

67

Limitations - British

68

Limitations - Euro

68

Limitations - Indian

68

Limitations - Saudi Code

68

Special Messages

69

Aluminum - Databases
Aluminum Shape Types
Aluminum - Design
Design Parameters

33

Aluminum Code Check

34

Aluminum Detail Report

35

Assumptions and Limitations

35

Special Messages

36

Boundary Conditions

37

Creating and Modifying Boundary Conditions37
Boundary Conditions Spreadsheet

39

Boundary Condition Options

40

Boundary Conditions at Wall Panels

42

Cold Formed Steel - Databases
Custom vs. Manufacturer Shapes

General Reference Manual

43
43

Concrete Member - Design Results

71

Beam Results

71

Column Results

73

Concrete Detail Reports

75

Beam Detail Reports

76

Column Detail Reports

80

RISAConnection Integration

86

I

Table of Contents

Available Connection Types

86

Integrated Connection Design Procedure

87

Drift Definitions Spreadsheet

145

Seismic Connections

94

Drift Results

146

Tapered Wide Flange Members

95

Drift Modeling Tips

148

Troubleshooting RISAConnection Integration 96
Integration Error Messages
RISAFloor and RISA-3D Connection
Design Interaction

98

145

DXF Files

150

Importing DXF Files

150

Exporting DXF Files

151

100

Merge After Importing a DXF File

153

Customizing RISA-3D

102

DXF Element Numbers

153

Save as Defaults

102

DXF File Format

153

Application Settings

102

Dynamic Analysis - Eigensolution

156

109

Required Number of Modes

157

Member Design Lists

109

Dynamic Mass

157

Member Design Rules – Size / U.C.

109

RISAFloor Diaphragm Mass Options

158

Member Design Rules – Deflection

110

Modeling Accidental Torsion

158

Member Design Rules – Concrete Rebar

110

Eigensolution Convergence

159

Member Design Rules Editor

111

Saving Dynamic Solutions

159

Member Optimization Procedure

113

Work Vectors

159

Optimization Results

113

Dynamics Modeling Tips

160

116

Calculate Residual Mass

160

Rigid Diaphragms

116

Modal Frequency Results

161

Semi-Rigid Diaphragms

118

Mode Shape Results

162

Flexible Diaphragms

121

Dynamics Troubleshooting – Local Modes 164

Diaphragms Spreadsheet - General Tab

122

Diaphragm Modeling Tips

124

Member Design Optimization

Diaphragms

Dynamic Analysis - Response Spectra

166

Response Spectra

167

Response Spectra Analysis Procedure

167

Frequencies Outside the Spectra

167

Mass Participation

168

Modal Combination Option

168

Other Options

170

RISAFloor Spectra Results

170

RSA Scaling Factor (Manual Scaling)

170

Flexible Diaphragm Results - Detail Reports 137

RSA Scaling Factor (Automatic Scaling)

171

Deflection Calculations

142

Automatic Response Spectra Generation

173

Diaphragm Key Plan

143

Adding and Editing Spectra

174

Diaphragm Design Limitations

143

Tripartite Response Spectra Plot

175

Semi-Rigid Diaphragm Analysis Considerations

128

Mesh Considerations

128

Slab Stiffness Considerations

130

Flexible Diaphragms - Analysis and Results 133
Analysis / Loading For Flexible Diaphragms133
Diaphragms Spreadsheet - Wood Diaphragms Tab

II

Drift

136

RISA-3D V20

Table of Contents

Single Spectra Plot

176

Graphic Editing

222

Dynamic Analysis - Time History

178

Drawing and Modification Features

222

Time History Functions / Pattern

178

Undo Operations

223

Time History Loads Spreadsheet

183

Redo Operations

223

Required Number of Modes

188

Project Grid

224

Damping

189

Drawing Grid

228

Soil Properties

191

Snap Points

231

Results - Time History Trace

192

Lock to Axis

231

Results - Export Time History Traces

193

Lock to Plane

232

Results - Animate Time History Deflection 194

Import DXF

232

Member Stiffness Issues:

197

Deleting Elements

234

What Solution Method should I Use?

197

Copying Model Elements

236

198

Moving and Rotating Model Elements

241

Starting Off

198

Splitting Members

244

Appending Models

200

Adding Nodes to Members

245

Importing and Exporting Files

201

Swap Member Ends

245

Automatic Backup

201

Trim/Extend Members

246

202

Re-Labeling Selected Elements

249

Circular Arc Generation

202

Merging Model Elements

249

Parabolic Arc Generation

203

Match

250

Grid Generation

204

General Truss Generation

205

Selection Shortcuts

253

Geodesic Dome Generator

206

Cycle Selection

254

Cylinder Generation

207

Selection Modes

254

Cone Generation

208

Inverting Selections

255

Circular Disk Generation

209

Criteria Selections

255

Circular Radius Generation

210

Lock & Dim Lock

265

Rectangular Tank Generation

211

Viewer Mode

267

213

Input Filter

269

Window Behavior

213

Graphic Selection from Spreadsheets

270

Multiple Windows

214

Saving Selections

270

3D View

215

Quick Find

271

Quick View Buttons

216

View Tab

217

General

274

Viewing Part of the Model

221

Members

275

Saving and Retrieving Model Views

221

Plates

276

File Operations

Generation

Graphic Display

General Reference Manual

Graphic Selection

Graphics - Model View Settings

252

273

III

Table of Contents

Wall Panels

277

EuroCode Design Codes - Limitations

Solids

278

EuroCode Design Codes - Special Messages 320

Loads

279

Indian Design Codes - Limitations

Diaphragms

280

Australian & New Zealand Design Codes Member Design Parameters
321

Graphics - Model View Settings

321

Australian & New Zealand Design Codes Limitations
322

General

283

Members

284

Plates

285

AISC 13th, 14th, and 15th Editions - Design
Guide 25
323

Wall Panels

286

ASD 9th, LRFD 2nd, LRFD 3rd

325

Solids

287

Foreign Codes

325

Loads

288

Buckling-Restrained Brace (BRB) Members 326

Diaphragms

289

Hot Rolled Steel - Code Check

328

291

AISC Code Check Results

328

Reactions

292

Canadian Code Check Results

329

Members

292

British Code Check Results

331

Plates

294

EuroCode Code Check Results

333

Wall Panels

295

Indian Code Check Results

335

Solids

296

Australian Code Check Results

337

Deflection

297

New Zealand Code Check Results

339

Help Options

299

Tapered Member Results

341

Graphics - Results View Settings

IV

282

319

Electronic Help File

299

Stainless Steel

344

Context Sensitive Help

299

Loads

348

RISA Tech, Inc. Online

299

Self Weight (Gravity Load)

348

Tool-tips

299

Drawing Loads

349

Tutorials

299

Modifying Loads

349

Hot Rolled Steel - Databases

300

Deleting Loads

349

Hot Rolled Steel - Design

306

Loads - Basic Load Cases

351

Design Parameters Spreadsheet

307

Basic Load Case Spreadsheet

351

Unbraced Lengths

308

Copying Basic Load Cases

352

K Factors (Effective Length Factors)

308

Deleting Basic Load Cases

353

Sway Flags

308

Scaling Basic Load Cases

353

AISC Design Codes - Limitations

310

Load Categories

355

AISC Design Codes - Special Messages

312

Canadian Design Codes - Limitations

314

Loads - Load Combinations

357

Load Combinations Spreadsheet

358

Canadian Design Codes - Special Messages 315

Load Combinations with RSA Results

361

British Design Code - Limitations

Load Combinations with Capacity-Limited
(CL) Design
362

316

RISA-3D V20

Table of Contents

Load Combinations with Moving Loads

364

Drawing Plate Surface Loads

413

Nesting Load Combinations

364

Drawing Wall Panel Surface Loads

414

ASIF Factors for Wind / Seismic Load Combinations
365

Surface Loads Spreadsheet

415

Surface Load Directions

416

P-Delta Load Combinations

Surface Loads at Openings (Wall Panels)

417

366
366

Load Generation - Notional Loads

421

Timber Design Load Duration Factor

367

Generating Building Code Combinations

368

Vertical Load used for Notional Force Calculations
421

375

Notional Load Generation Dialog

421

Drawing Nodal Loads

375

Notional Load Results

422

Nodal Load Spreadsheet

376

Nodal Mass

376

Seismic Weight

423

379

Seismic Design Parameters

423

Drawing Area Loads

379

Seismic Load Results

425

Member Area Loads Spreadsheet

380

Semi-Rigid Seismic Loads

426

Member Area Load Direction

380

Load Generation - Wind Loads

428

Area Load Distribution

382

Wind Load Parameters

428

Area Loads and Wall Panels

387

Wind Load Results

430

Area Load Attribution

390

Parapet Wind Loading

434

393

Mezzanine Levels (No Wind Loads)

442

Drawing Point Loads

393

Sloped Roof Wind Loads

442

Point Load Spreadsheet

394

Semi-Rigid Wind Loads

443

Point Load Directions

395

Other Considerations and Limitations

444

Loads - Nodal Load / Displacement

Loads - Area Loads

Loads - Point Loads

Loads - Line Loads

396

Load Generation - Seismic Loads

Material Properties
Material Properties Spreadsheet

423

446

Drawing Line Loads

396

446

Distributed(Line) Loads Spreadsheet

397

Material Take-Off

452

Distributed Load Directions

399

Members

454

402

Drawing Members

454

Moving Loads Spreadsheet

405

Modifying Member Properties

456

Moving Load Patterns

406

Material and Cross Section Properties

459

Moving Loads Solution Procedure

407

Members Spreadsheet - Primary Data

459

Moving Loads Results

408

Members Spreadsheet - Advanced Data

461

411

Members Spreadsheet - Detailing Data

463

Recording Thermal Loads for Members

411

Tension/Compression-Only Members

463

Thermal Force Calculation

412

Physical Members

466

Prestressing with Thermal Loads

412

Member Local Axes

467

413

Defining Member Orientation

468

Loads - Moving Loads

Loads - Thermal Loads

Loads - Surface Loads

General Reference Manual

V

Table of Contents

Member End Releases

469

Modeling Inclined Supports

522

Simpson Yield-Link

471

Modeling One Member Over Another

523

Deflection Ratio Options

475

Analysis Offset

478

Reactions at Nodes with Enforced Displacements

523

Member End Offsets

483

Rigid Links

523

Inactive and Excluded Elements

483

Solving Large Models

524

Member Shear Deformations

483

Member Shear Areas

484

Modeling a "Gap" (Expansion Joint)
Between Structures

525

Member Shear Stresses

484

Torsion

485

Members - Results
Number of Reported Sections

489

Number of Internal Sections

489

Member Force Results

490

Member Stress Results

493

Single Angle Results

495

Member Torsion Results

496

Member Deflection Results

527

Node Coordinates Spreadsheet

528

Node Information Dialog

528

Nodes - Results

530

Node Deflections Results

530

Node Reaction Results

531

Nodes - Tethering Nodes

533

P-Delta - Analysis

535

P-Delta Procedure

535

497

P-Delta Limitations on Standard Nodal
Shear Method

536

505

Compression Only P-Delta

536

Model Merge Options

505

P-Delta Convergence

537

Model Merge Examples

506

P-Delta Troubleshooting

537

Model Merge Limitations

506

Wall Panels

538

Model Merge Process

506

Leaning Column Effect

538

Model Merge

Model Settings

VI

489

Nodes

509

P-Little Delta Analysis

539

Project Information

509

P-Little Delta Procedure

539

Solution

510

AISC Direct Analysis Method

540

Axis

514

ACI Concrete Design

540

Codes

515

Concrete

517

Drawing Plates

541

Rebar

518

Modifying Plates

542

Seismic

519

Submeshing Plates

543

Modeling Tips

520

Plates Spreadsheet - Primary Data

547

Applying In-Plane Moment to Plates

520

Plates Spreadsheet - Advanced Data

549

Modeling a Beam Fixed to a Shear Wall

520

Plate Information

549

Modeling a Cable

521

Plate Corner Releases

550

Modeling Composite Behavior

521

Inactive and Excluded Plates

551

Plates/Shells

541

RISA-3D V20

Table of Contents

Plate Local Axes

552

Concrete Floor Slabs

595

Plate/Shell Element Formulation

553

Gravity Loads

595

Plate Modeling Tips

555

Wind Loads

596

Plate Error Checking

556

Seismic Loads

596

Finite Element Basics

557

Plates/Shells - Results

559

Buckling-Restrained Braced Frame (BRBF)
System
596

Plate Stress Results

559

Detach

Plate Force Results

560

Plate Corner Force Results

561

RISAFoundation Interaction with RISA-3D 597

563

RISAFoundation Interaction with
RISAFloor

599

Limitations

600

Plates/Shells - Design Tools
Internal Force Summation Tool

563

Contour Display Details

566

Plates/Shells - Modeling Examples

567

Shear Wall Modeling

567

Shear Wall Design Forces

568

Shear Wall Penetrations

570

Diaphragm Modeling

571

Spread Footing Modeling

572

Plate Connectivity Problems

574

Mesh Transition Examples

575

Printing

576

Printing Reports

577

Printing to a File

579

Graphics Printing

580

Results

582

Saving Results

582

Results Spreadsheets

583

Excluding Results

583

Graphic Results

585

Clearing Results

585

Internal Force Summation Tool

586

Member Detail Report

587

Concrete Member Detail Reports

593

RISAFloor and RISA-3D Integration

594

Lateral System Model Generation

594

Diaphragms

595

RISAFoundation Interaction

Section Sets
Section Sets Spreadsheet
Seismic Detailing - Input / Design Rules

597

601
601
603

Seismic Design Rules - Hot Rolled Frame General / Columns
603
Seismic Design Rules - Hot Rolled Frame Beams
605
Seismic Design Rules - Hot Rolled Frame Braces
607
Limitations
Seismic Detailing - Results

608
609

Seismic Results Spreadsheet - Columns

609

Seismic Results Spreadsheet - Beams

611

Seismic Results Spreadsheet - Braces

613

Seismic Detailing - Detail Reports
Design Forces for Moment Connections

615
615

Column Panel Zone Capacity Calculations
for Moment Frames
616
Continuity Plate Checks for Columns in
Moment Frames

616

Strong Column / Weak Beam (SC/WB)
Moment Ratios

618

Bracing Requirements for Beams in a
Moment Frame

619

Requirements for Braced Frames

619

Miscellaneous Seismic Checks

620

Shape Databases

General Reference Manual

596

622

VII

Table of Contents

Database Shape Types

622

Moving and Copying Cell Contents

651

Hot Rolled Shapes

622

Sorting and Finding in Spreadsheets

652

Cold Formed Shapes

622

Default Spreadsheet Data

652

Concrete Shapes

622

Special Spreadsheet Functions

652

Wood Shapes

623

Aluminum Shapes

623

Instability Procedure

655

General Shapes

623

Instability Causes

655

Database Files

625

Instability Examples

656

627

Testing Instabilities

660

Solid Elements

Stability

655

Creating Solids

627

Modifying Solids

628

Lb Values (Lb, Lu, Le)

662

Sub-Meshing Solids

629

Lcomp Values (Lcomp, Le-bend)

663

Solids Spreadsheet

630

L-torque

664

Solid Information

631

Automated Unbraced Length Commands

664

Inactive and Excluded Solids

632

Material Specific Behavior

667

Solids Formulation

632

K Factors (Effective Length Factors)

669

Solid Modeling Tips

633

Sway Flags

671

Loading

634

Verification Examples

634

Standard Imperial Units

673

Solid Elements - Results

636

Standard Metric Units

673

Solid (Global) Stress Results

636

Units Specifications

673

Solid Principal Stress Results

637

Solid Corner Force Results

638

Drawing Wall Panels

675

640

Modifying Wall Panels

676

Solution

661

Units

672

Wall Panels

675

Differences Between RISA-3D and
RISAFloor

Wall Panel Spreadsheets

677

640

Wall Panel Editor

680

Static Solutions / Stiffness Matrix

641

Wall Panel Local Axes

685

Loading

685

Load Attribution

686

Meshing the Wall Panels

687

Dynamic Solutions - Eigenvalues & Mode
Shapes
643
Dynamic Solutions - Response Spectra

644

Spreadsheet Operations

645

Moving and Scrolling

646

Spreadsheet Keyboard Commands

646

Selecting Spreadsheet Cells

647

Undoing Operations

647

Redoing Operations

648

Editing Spreadsheets

649

VIII

Unbraced Lengths

Wall Panels - Results

696

Wall Force Results

696

General Wall Detail Report

697

CFS Wall - Design

699

CFS Wall Input

699

General Requirements for Shear Walls

701

RISA-3D V20

Table of Contents

General Program Functionality and Limitations

Shear Design - In Plane ASD

772

703

Shear Design - Out of Plane ASD

773

712

Axial Design - ASD

774

Unity Check

712

Bending Design - ASD

775

CFS Wall (Studs)

712

In Plane Design - Strength

778

Design Rules - CFS Wall (Fasteners)

713

Out of Plane Design - Strength

780

715

Unreinforced Masonry Design - ASD

782

CFS Wall Results Spreadsheets

715

Unreinforced Masonry Design - Strength

784

CFS Wall Self Weight

716

Masonry Lintel Design - ASD

784

CFS Wall Detail Reports

716

Masonry Lintel Design - Strength

785

Concrete Wall Panel - Design

725

CFS Wall - Design Rules

CFS Wall Results

Masonry Wall - Design Rules

787

Concrete Wall Input

725

Unity Check

787

Concrete Design Considerations

727

Masonry Wall General

787

Concrete Lintel Considerations

732

Masonry Wall In Plane Design

788

Concrete Wall Modeling Considerations

734

Masonry Wall Out of Plane Design

789

737

Masonry Wall Lintel Design

791

Concrete Wall - Design Rules
Unity Check

737

Concrete Wall (Rebar) Rules

737

Masonry Wall Spreadsheet Results

792

Concrete Wall (Cover) Rules

738

Concrete Reinforcing Spreadsheet Results

794

741

Masonry Wall Detail Reports

794

Concrete Wall Spreadsheet Results

741

Wall Report

795

Concrete Reinforcing Spreadsheet Results

742

In Plane Masonry Detail Reports

796

Concrete Wall Detail Reports

743

Masonry Detail Reports - Lintels

804

Concrete Wall - Seismic Design

754

Concrete Wall Results

Masonry Wall Results

Masonry Wall - Seismic Design

792

807

Seismic Design Rules

754

Seismic Design Rules

807

Shear Force Amplification in ACI 318-19

754

Design Considerations

808

Pier Design

755

Coupling Beams

756

ASD Masonry Code - Additional Requirements
809

Boundary Elements/Zones

757

Reinforcement Limits for Regions

757

LRFD Masonry Code - Additional Requirements
810

Design Spreadsheet Results

757

Assumptions and Limitations

Reinforcing Spreadsheet Results

758

Detail Report Results

759

Design Spreadsheet Results

813

763

Reinforcing Spreadsheet Results

813

Masonry Wall Input

763

Detail Report Results

814

Masonry Wall Optimization

768

Wood Wall - Design

818

Masonry Wall Panel - Design

772

Wood Wall Input

818

Masonry Wall Panel - Modeling

General Reference Manual

Masonry Wall - Seismic Design Results

812
813

IX

Table of Contents

General Requirements for Shear Walls

821

Unsupported STAAD Features

890

General Program Functionality and Limitations

826

STAAD User’s Overview

890

839

STAAD Differences from RISA-3D

891

Unity Check

839

STAAD Mapping File

891

Wood Wall (Studs)

839

Appendix D – File Format

893

Design Rules - Wood Wall (Fasteners)

841

Appendix E - Interfacing with Other Programs

894

845

Integration with other RISA programs

894

Wood Wall Results Spreadsheets

845

Exporting to ADAPT Builder

894

Wood Wall Self Weight

847

Exporting to SDS2

894

Wood Wall Detail Reports

847

894

Wood Wall - Design Rules

Wood Wall Results

Warning Log

861

Linking your Autodesk Revit Structure
model with RISA-3D

Wood - Database

862

Importing or Exporting SAF Files

894

Wood Database Limitations:

864

Importing or Exporting CIS/2 Files

894

Custom Wood Sizes:

867

Importing or Exporting DXF Files

895

Wood - Design

868

Importing STAAD Files

895

Glu-Lams

868

Importing SAF Files

895

Custom Wood Materials

869

Exporting to an SDNF File Format

895

Wood Member Design Parameters

872

Structural Desktop

896

NDS Adjustment Factors

873

CSA O86 Adjustment Factors

876

Hold Downs

897

Limitations - Wood Design

877

Straps

899

NDS Emin Calculation

878

Panel Nailing Schedules

900

Wood Member Code Check Results

878

Diaphragm Nailing Schedules

903

Special Messages - Wood Design

880

Appendix A – Redesign Lists
Creating or Modifying Redesign Lists

881
881

Appendix F – Wood Shear Wall Files

Appendix G – CFS Shear Wall Files
Panel Nailing Schedules
Technical Support

897

906
906
909

881

X

Design List Mismatch

883

Locating the Design Lists

883

File Naming Convention for the Design
Lists

883

File Format for Redesign Lists

883

Manual Modification

885

Appendix B – Error Messages

886

Appendix C – STAAD® Files

887

Supported STAAD Features

887

RISA-3D V20

Before You Begin

Before You Begin
Welcome to the RISA-3D General Reference manual. Please read this topic prior to installing the program and pay
particular attention to the License Agreement. If you are a first time user of RISA-3D you should turn your attention
to the Tutorials (a separate document) which are designed to get you up and running as fast as possible while still
exposing you to the important features of the software.
The Tutorials are designed to be read in two ways. If you are already familiar with structural modeling in general
you can skip the supporting text and read only the underlined action items to quickly move through the tutorial. If
you want more thorough explanations of the modeling process you may read all or some of the supporting text as
you see fit.
After you have gone through the Tutorials, use this General Reference for detailed information on any topic. The
topics are arranged in alphabetical order and are thoroughly indexed.

Overview
RISA-3D is a general-purpose -dimensional analysis and design program. This program has been developed to make
the definition, solution and modification of structural models as fast and easy as possible. Analysis, up to and
including calculation of maximum deflections and stresses, may be done on structures constructed of any material
or combination of materials. Complete steel and wood design are also included in the program.
RISA-3D has full graphical modeling capability. You can draw your model on the screen and also perform extensive
graphical editing simultaneously in multiple views. To modify your model data directly, RISA-3D employs a
powerful, proprietary spreadsheet. All this combined with flexible data generation algorithms makes modeling very
easy. Graphic display of the model along with applied loads, boundary conditions and much more, is always
available. The model can be rapidly edited, solved, viewed, modified, re-solved, etc. The truly interactive nature of
RISA-3D is its primary strength. RISA-3D is also able to perform elaborate error checking as you define the model,
and offers context sensitive help every step of the way.
RISA-3D is an interactive program as opposed to a batch mode program. With a batch mode program, you would
edit a text file in one program (typically called a pre-processor), and then solve it with another program, and then
view the solution results in yet another program (typically called a post-processor). With RISA-3D, all model editing,
model solution, and results browsing is accomplished through the same interface and with the same program. The
interactive approach offers several unique advantages over batch mode which include; the ability to do real time
error checking of your model data, the ability to do rapid model editing, solution, editing, and re-solution without
jumping from one program to another, and the need for the user to learn only one program interface.
You may access the features in RISA-3D by using the menu system, or the toolbars. The best way to learn RISA3D is to go through the Tutorials. The advantage to this is that you are exposed to the tools RISA-3D provides and
the ways that you can take advantage of them.

Minimum System Requirements
One of the following operating systems is required:
l
l
l

Microsoft Windows 11 (64 bit only)
Microsoft Windows 10 (64 bit only)
Microsoft Windows 8.1 (64 bit only)

Internet (Subscription License Only)
An internet connection is required to launch the program. The internet connection must be maintained as long as
the program is open, although brief internet outages (a few minutes) do not affect the user's ability to keep the
program open.
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Hardware
The following hardware is required:
l
l
l
l
l

1 GHz or faster processor (x86-64)
1920x1080 monitor resolution recommended (1024x768 minimum)
2 (or more) button mouse, mouse wheel recommended
8 GB of RAM
4 GB of hard disk space

Program Limits
Software Limitations
Joints

500,000

Members

100,000

Plates

250,000

Shapes

100,000

Wall Panels

10,000

Openings/Regions (per Wall Panel)

25/100

Solids

250,000

Section Sets

10,000

Loads (All Types Combined)

300,000

Materials

500

Custom Wood Species

500

Diaphragms

500

Basic Load Cases

1,000

Moving Loads

500

Time History Functions

500

Load Combinations

5,000

Mode Shapes

2,000

Time History Load Functions

500

Demonstration Version: While you can open and solve a larger model, the largest model that can be saved to disk
with the demonstration version is limited to Saving and printing results. RISAConnection results may not be
exported back into RISA-3D when using the demonstration version.

License Agreement
For the full license agreement, please visit: risa.com/eula

Maintenance (Perpetual License Only)
Program maintenance provides all upgrades to RISA-3D.
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When your maintenance expires, you will be given the opportunity to continue program maintenance on an annual
basis. You are under no obligation to continue program maintenance, of course, but if you decide to discontinue
maintenance you will no longer receive RISA-3D program upgrades and technical support. Customers who
discontinue maintenance will need to purchase a subscription license for future program upgrades and/or technical
support is required .
Complete program support is available to registered owners of RISA-3D and is included in the purchase price. This
support is provided for the life of the program. See Technical Support for a list of your support options.
The “life of the program” is defined as the time period for which that version of the program is the current version.
In other words, whenever a new version of RISA-3D is released, the life of the previous version is considered to be
ended.
RISA Tech, Inc. will provide technical support only for the current version of RISA-3D.
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The Tutorials (a separate document) contain a tutorial that leads you through the RISA-3D interface with an actual
model. Consider going through the tutorial if you have not done so already, as it is the fastest way to learn the
program. Although it requires some time up front, the tutorial will save you time and brainpower in the long run.
The features that are available to you in RISA-3D may be accessed through the Ribbon toolbar, Quick Access toolbar,
Properties panel, Explorer panel, 3D view and shortcut keystrokes. You may use any or all of these vehicles to
interact with the software. The Ribbon toolbar has the advantage of containing all of the program options and
features. The Quick Access toolbar contain more common options and invoke with one click. The Properties panel
will display relevant properties for selected elements within your model and allow you to make quick changes to
those elements. The Properties panel is also where you will modify and execute most of the program features. The
Explorer panel provides a quick way to access all of the data entry and results spreadsheets. The shortcut menus
present options relevant to the task at hand. The shortcut keys provide a fast way to access features should you use
the program often enough to make them familiar to you. All of these features are discussed in the sections below.
There are many ways to access features and the method that you will use will simply be a matter of personal
preference. The good news is that you have the options.

Starting a Model
The first dialog that appears when you launch the program is Starting a Model. From this dialog, you can create a
new model, open an existing model, or open a sample model which is included with the installation. The Recent
Projects section displays a preview of recently opened projects. At the bottom, the Get Started in RISA-3D section
contains quick links to learn more about the program like reading the Tutorials or requesting a live Software Tour.
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Title Bar
The bar along the top of the screen is called the title bar and contains: the Quick Access toolbar (to the left next to
the 3D logo), the name of the file that is currently open (in the middle) and application controls (to the right).

The three buttons on the upper far right side of the title bar are used to control the main window. The left button
will shrink the main application window to a button on the taskbar.
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The middle button will shrink or maximize the window on your screen. The right button will close the window,
prompting you to save changes if necessary. You will also see these buttons in other windows and they have
basically the same functions there as well. Below these three buttons are the Director button, Help File button and
Minimize Ribbon Toolbar button. The Director button

The Director button will allow you to transfer back to your RISAFloor model or transfer to your RISAFoundation
model. The question mark will pull up the RISA-3D help file. The carrot allows you to minimize the contents within
the Ribbon toolbar.
To the left of the title bar next to the 3D logo is the Quick Access toolbar.

The Quick Access toolbar provides a quick way to access commonly used features and functions within the
software. See the Quick Access toolbar section for more information.
Most of the functions and features that you will be using will be within the Ribbon toolbar. By clicking the headings
or tabs that are presented in the lower half of the title bar will give you access to different portions of the Ribbon
toolbar (discussed below).

Ribbon Toolbar
All of the program features may be accessed through the Ribbon toolbar system beginning with the File tab on the
far left and ending with Results tab on the far right. Clicking on each of these tabs (listed below) will display
options that you may choose from.

File Menu
Clicking the File tab will expand the File menu.

6

RISA-3D V20

Application Interface

New will close the current file, prompting for saving if necessary, and will open a new file.
Open will close the current file, prompting for saving if necessary, and will open an existing file.
Retrive Backup... close the current file, prompting for saving if necessary, and will open an available backup file
Save will save the current file, prompting for a name if necessary.
Save As will save the current file, prompting for a name.
Append will insert another RISA- model into the current model.
Import will close the current file, prompting for saving if necessary, and will open an existing RISA-2D (R2D), DXF,
STD, Autodesk Revit, Tekla Structures, tnxTower, or SAF file. For more information on how RISA-3D interacts with
other programs, see Appendix E - Interfacing with Other Programs.
Export will export the current file to a DXF, ADAPT Builder, SAF, SDS2 End Reactions, or SDNF file.
For more information on the interaction between RISA and other programs refer to Appendix E.
Print will access RISA printing options.
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Application Settings will allow you to modify several program options. Refer to the Customizing RISA topic for
more information.
Logout and Exit will log out your Subscription credentials and will close RISA-3D, prompting for saving if
necessary. The next time the program is opened you will need to re-enter your subscription license username and
password.
Exit will close RISA, prompting for saving if necessary.
To the right of the File Menu are recently opened files with a preview of the model file. Selecting one of these files
will close the current file, prompting for saving if necessary, and will open the selected file.

Home Tab

Units will allow you to control the units to be used in the project. See the Units topic for more information on this.
Info will allow you to enter descriptive information such as a title for the particular model being defined, the name
of the designer and a job number. See the Model Settings topic for more information.
Settings will allow you to modify settings specific to the model which is currently open. See the Model Settings
topic for more information.
Members will allow you to graphically draw members within your model. See the Members topic for more
information.
Automesh of Plates will allow you to draw a polygon that will automatically submesh into smaller quadrilateral
plate elements. See the Submeshing Plates topic for more information.
Plates will allow you to graphically draw plates in your model. See the Plates topic for more information.
Wall Panels will allow you to graphically draw wall panels in your model. See the Wall Panels topic for more
information.
Solids will allow you to extrude plate elements into solid elements. See the Solids topic for more information.
Boundary Conditions will allow you to apply boundary conditions in your model. See the Boundary Conditions
topic for more information.
Subgrade Spring will allow you to generate compression-only springs in the vertical direction at all plate joints in
the selected group of plates. See the Generate Soil Springs topic for more information.
Templates will allow you to automatically generate typical structures or portions of structures to start a new
model or add to an existing model. See Generation topic for more information.
Project Grid will allow you add project grids to your model file. See the Project Grid topic for more information.
Nodal will allow you to graphically draw concentrated loads at nodal points. See the Nodal Load topic for more
information.
Line will allow you to graphically draw distributed loads in your model. See the Distributed Load topic for more
information.
Point will allow you to graphically draw concentrated loads on member elements in your model. See the Point
Loads topic for more information.
Point Moving will allow you to graphically draw moving loads in your model. See the Moving Loads topic for more
information.
Area will allow you to graphically draw area loads in your model. See the Area Loads topic for more information.
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Plate Surface will allow you to graphically draw plate surface loads. See the Surface Loads topic for more
information.
Wall Surface will allow you to graphically draw wall surface loads. See the Wall Surface Load topic for more
information.
Basic Load Cases will open the Basic Load Cases spreadsheet. See the Basic Load Cases topic for more information.
Load Combinations will open the Load Combinations spreadsheet. See the Load Combination topic for more
information.
Warning Log will open the Warning Log spreadsheet if warnings are available after solution. See the Warning Log
topic for more information.
Solve will solve the current model file. See the Solution topic for more information.
Quick Find will allow you to search for specific elements within the model. See the Graphic Selection topic for more
information.
Select by Property will allow you to select items within the model based on specific criteria. See the Graphic
Selection topic for more information.
The Quick View options are quick ways to toggle various display options within the model. See the Graphic Display
topic for more information.

Modify Tab

The Modify tab offers several tools and features that make modifying the elements in your model simple and easy.
The Delete tools provides a way to delete specific elements within your model. See the Deleting Elements section
within Graphic Editing for more information.
The Copy tools provide various ways to copy elements within the model. See the Copying Elements section within
Graphic Editing for more information.
The Move tools provide various way to move or rotate elements within the model. See the Moving Elements section
within Graphic Editing for more information.
The Members section provides various graphical tools to modify members within the model. See the Trim/Extend,
Swap Member Ends, and Split Members topics for more information.
The Labeling section provides ways to control the labels of elements within the model. See Graphic Editing for
more information.
The Plates section provides tools to modify both plates and solid elements. See the Plates and Solids sections for
more information.
The Walls section provides tools to flip the wall panel local axes. This will reverse the direction of the wall panel's
local x and z-axes. You can choose to flip the wall and the openings or flip just the wall's local axis without affecting
the openings or regions. This feature is useful for aligning the positive z-direction for a group of wall panels which
will all receive the same surface load.See the Walls section for more information.
Model Merge will merge elements within your model based on your merge tolerance. See Model Merge topic for
more information.
Round off Coordinates will round off the joint coordinates in your model.
Switch Vertical Axes will allow you to change the vertical axis of the model.
Delete All Wall Regions will delete all the wall regions currently assigned within the wall panels.
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View Tab

The View tab offers various tools to control the Graphic display settings. See the Graphic Display section for
detailed information on the options presented here.

Drawing Tab

The Drawing Tools tab provides options to aid in drawing the elements within the model. For detailed information
on how to use these tools see the Graphic Editing topic.

Spreadsheets Tab

The Spreadsheets tab provides a way to access all the Data Entry spreadsheets in the model as well as provide
various tools to manipulate spreadsheet values. If you do not have a spreadsheet open, the only option within this
tab would be to click on the Data Entry button to open a spreadsheet. Once you open a spreadsheet you will have
various tools pertinent to that spreadsheet available to you. For example, if you open the Materials spreadsheet the
Spreadsheets tab will now look like the below image.

For more detailed information the functions available within the Spreadsheets tab see the Spreadsheet Operations
topic.
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Advanced Tab

Wind will open the wind load generator in order to generate winds loads. See the Wind Loads topic for more
information.
Seismic will open the seismic load generator in order to generate seismic loads. See the Seismic Loads topic for
more information.
Notional will open the notional load generator in order to generate notional loads. See the Notional Loads topic for
more information.
Time History will open the Time History Function library. See Time History for more information.
Moving Loads will open the Moving Loads Pattern library. See Moving Loads for more information.
Response Spectra will open the Response Spectra library. See the Dynamics topic for more information.
Shape Database will open the Shape database. See Shape Database topic for more information.
Custom Wood will open the Custom wood database. See Wood Design for more information.
Custom Rebar will open the Custom Rebar database. See Concrete Design for more information.
Redesign Lists will open the Member Design List database. See Redesign List for more information.

Results Tab

The Results tab will become available after you solve the model and a solution is present.
For more information the various options available within the Results tab see the Results for more information.

Quick Access Toolbar
The Quick Access toolbar provides a quick and easy way to access commonly used features and functions within the
software.

Clicking the

icon will close the current file, prompting for saving if necessary, and will open a new blank file.
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Clicking the

icon will close the current file, prompting for saving if necessary, and will open an existing file.

Clicking the

icon will save the current file, prompting for a name if necessary.

Clicking the

icon will access RISA-3D printing options.

Clicking the
icon will undo the last edit that was applied ot the model whether it was graphically or in the
spreadsheets. You can click the small down arrow to the right icon to review the modeling history and revert the
model back several undo steps at once.
Clicking the
icon will reverse the last undo that was applied to the model. You can click the small arrow to the
right of the icon to review the modeling history and jump forward to a point in time.
Clicking the
Clicking the

icon will bring up solution choices to solve the model.
icon will activate the detail report feature. See the Results topic for more information.

Clicking the
icon will allow you to take an image of the 3D view and can be added to your report. See Printing
for more information.
Clicking the

icon will provide information about the software licensing and RISA-3D version.

Clicking the arrow to the very right of the Quick Access toolbar will allow you move the Quick Access toolbar below
the ribbon toolbar and customize the functions within the toolbar.

To customize the Quick Access toolbar simply click in the box Available toolbar buttons, and click on Add to place
them on the Current toolbar. Once you've moved the buttons to the Current toolbar, you can rearrange them by
clicking on Move Up or Move Down.

Panels
There are two primary panels within the software interface: the Properties panel and the Explorer panel.
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Properties Panel
The Properties panel is an affixed panel on the left side of the program interface. This panel will serve different
functions depending on what elements are selected or what function is activated. When there are no features
activated or no elements selected the Properties panel will display the Project Information entered for the current
model. Note that there is tab available in the middle of the Properties panel on the right side (circled in red in the
image below) that will allow you to expand or shrink the panel horizontally.

Selecting an element within the model the Properties panel will now display all of the information related to the
selected element(s). You can review and modify the element information and parameters directly from the
Properties panel.
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When activating a feature within the program such as adding a load or translation tool, the Properties panel will
serve as the method to specify and apply that feature's parameters.
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You can then use the Click to Apply to option to activate your parameters and click the elements you would like to
apply the feature to. Or you can click Apply to Selected in order to automatically activate and apply the feature to
applicable selected elements in your model.
When navigating through a spreadsheet or inputs for a specific function, you will find a short description at the
bottom of Properties panel.
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This can be very useful when you are not sure what a specific parameter means.

Explorer Panel
The Explorer panel is an affixed panel on the right side of the program interface. The Explorer panel contains a list
of all the Data Entry spreadsheets and, when a solution is present, the Results spreadsheets. Similar to the
Properties panel, you can use the tab (circled in red in the image below) that will allow you to expand or shrink the
panel horizontally. You can also click the carrot next to the Data Entry or Results title to collapse or expand the
spreadsheet list.
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3D View
The 3D View is where you will do the graphic editing of your model file and where you actual structure can be
viewed.
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You will notice that there are several toolbars located within the 3D View window. These toolbars can be
rearranged as desired by clicking on the 4 dots
perimeter.

and dragging the toolbar to any space along the window's

You can close this window at anytime by clicking the X to the right of the 3D View tab.

Window Toolbar
The toolbar at the top of the window provides controls to adjust the current 3D view.

Other 3D view windows that are open will not be affected so that each may show different information. For more
information on this, see the Graphic Display section.
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Custom Bins
Each grouping of quick buttons in the 3D View is called a Bin. You can customize your bins to have your most-used
tools easily accessible.
Click the Bin Library icon in the upper left corner of the 3D View to open the Bin Library.

In the Bin Library, you can add your own bins and customize the quick buttons within each bin. You can also edit
and delete bins. The default bins will not be able to be deleted (Rotation, Snap View, Loads Results View).
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Pressing Reset All from the Bin Library dialog will reset all your bins to the default configuration.

Selection Toolbar
The vertical toolbar on the left side of the screen is the Selection Toolbar. This toolbar will only be available when
the active window is a model view. The buttons on this toolbar help you select and unselect items in the model in
order to help you build and modify the model or view results. See Graphic Selection for more information.
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Results Toolbar
The vertical toolbar on the left side of the screen below the Selection Toolbar is the Results Toolbar.

The tools in this toolbar will become active when a solution is present and they provide quick access to Result tools
that would otherwise be selected in the Results tab in the Ribbon toolbar. For more information see the Results
topic.

Shortcut Menu
The Shortcut Menu is also referred to as the Right-Click Menu. This is because to access the shortcut menu you
simply click the RIGHT mouse button where you are working to see options that are relevant to what you are doing.
For example if you are working in a model view the right click menu will provide options to help you modify the
view and edit the model graphically. If you are working in a spreadsheet the menu will provide editing tools for that
spreadsheet.
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This menu will appear wherever you RIGHT click the mouse. This way you do not need to move away from where
you are working to select the features you want to use.

Dynamic View Controls
When your current window is a graphical model view, you can use the mouse wheel to dynamically zoom, pan, or
rotate the graphical image.

Mouse Action

Model View Function

Rolling the Wheel Forward

Zoom In

Rolling the Wheel Backward

Zoom Out

Clicking and holding the Wheel
Button

Grab the image and pan in the direction
of mouse movement

Click and hold the Wheel button
while pressing the Shift key

Dynamically rotate the structure in the
direction of mouse movement

Dynamic Pan: Clicking and holding the mouse wheel button triggers the tool and allows the user to pan or drag the
view to the limit of scroll bars.
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Dynamic Zoom: This tool uses the wheel button on the mouse. Rotating forward zooms in and rotating backward
zooms out.
Dynamic Rotate: This tool is triggered by clicking and holding the mouse wheel button while holding the Shift key.
The rotational movement will be based on the how the user drags the mouse cursor over the screen and the
projection of global axis on the screen. For rotation about X axis, drag the cursor perpendicular to the projection of
the global X axis. The same logic applies for Y or Z axis rotations. When rotation is initiated, the system locks for
rotation about that axis until the user releases the middle mouse button.
Zoom Previous/Next: Function keys F3 and F4 are associated with Zoom Previous and Zoom Next respectively.
The system holds a doubly linked list of zoom info. This list has 10 zoom-states in the list. The F3 or F4 keystroke
moves the active pointer forward or backward on the list. Each window has its own zoom list.
Dynamic Distance Tool: This tool triggers by pressing the F5 key. The user has to pick up two points on the screen
and the system gives back the total and partial distance between points on the status bar.

Shortcut Keys and Hot Keys
Shortcut Keys and Hot Keys allow you to use the keyboard to quickly access features. The difference between the
two is simply that the shortcut keys are related to a specific window and will only work in that window while the
hot keys will perform at most any time.

General Hot Keys
Key Combination

Function

F1

Help on the active window

F5

Activates the Distance Tool

Ctrl-F1

Main Help topics

F7

Opens solution choices

Ctrl-F7

Solve (Batch + Envelope Solution)

Ctrl-Alt-F7

Replace shapes with suggested shapes and resolve the model

Ctrl-C

Copy to the clipboard

Ctrl-V

Paste from clipboard

Ctrl-N

Start a new file

Ctrl-O

Open an existing file

Ctrl-S

Save the current file

Ctrl-P

Print

Ctrl-Z

Undo

Shortcut Keys available for Specific Windows
Key Combination

Model View Window

Spreadsheet

Ctrl-A

Select All

Select All

Ctrl-U

Unselect all

Unselect all

Ctrl-F
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Key Combination

Model View Window

Ctrl-M

Spreadsheet
Block Math

Ctrl-I

Invert Selection

Ctrl-L

Toggle Lock unselected

F2

Open Model View Settings

Start/Stop Cell Edit

F3

Insert line

F4

Delete Line

F5

Initiates the distance tool

F8

Find
Repeat Current Line

Spreadsheet Hot Keys that open spreadsheets
Key Combination

Unsolved
Model

Ctrl-Alt-B

Basic Load
cases
Node
Coordinates
Member
Distributed
Loads
Member
Primary Data

Ctrl-Alt-C
Ctrl-Alt-D

Ctrl-Alt-E
Ctrl-Alt-F
Ctrl-Alt-G
Ctrl-Alt-H
Ctrl-Alt-I
Ctrl-Alt-J
Ctrl-Alt-K
Ctrl-Alt-L
Ctrl-Alt-M
Ctrl-Alt-N
Ctrl-Alt-O
Ctrl-Alt-P
Ctrl-Alt-R
Ctrl-Alt-S
Ctrl-Alt-T
Ctrl-Alt-U
Ctrl-Alt-V
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Model Settings
Diaphragms
Wall Panel Rules
Load
Combinations
Materials
Joint Loads
Boundary Conditions
Member Point
Loads
Design Code
Check
Section Sets
Time History
Loads
Seismic Design
Rules
Moving Loads

Solved Model

Corner Forces
Node Deflections

Deflection Results
Member Forces
Model Settings
Suggested Shapes
Member Torsion
Solid Principal Stress
Solid Stresses
Plate Forces
Material Take Off
Concrete Reinforcing
Boundary Conditions
Plate Stresses
Node Reactions
Member Stresses
Story Drift
Code Check
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Key Combination

Unsolved
Model

Ctrl-Alt-X
Ctrl-Alt-Y

Surface Loads
Dynamics
Settings
Area Loads
Plates

Ctrl-Alt-Z
Ctrl-Alt-4

Solved Model

Status Bar
The Status Bar will show you the solution status of your model. It is comprised of three solution flags located along
the very bottom of the application window, just beneath the workspace.

The first flag corresponds to a static analysis while the second flag corresponds to a dynamic analysis
(eigensolution) and the third flag corresponds to a Response Spectra analysis. When the flags are gray (as shown in
the image above), this means that a solution is not present. The flag will turn green when a solution is present. In
the below example a static solution and eigensolution is present but a Response Spectra analysis solution is not
available.
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When the static solution flag turns yellow, this indicates that a static solution is present however instability have
been detected.

For more information on instabilities see the Stability topic.

Windows
Modeling the structure will take place within model views and spreadsheets, each in their own window that may be
moved around the workspace and sized as you wish. The ability to have multiple model views and multiple
spreadsheets open at one time is a powerful feature. You can move the windows around by clicking the 3D View tab
and dragging as desired.
These windows will all contain the
in the upper left corner to help you close the window. There are
also scroll boxes to help you view information that is outside of the window viewing area. Click the scroll bar
buttons or drag the scroll box to advance the display in one direction or another.
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Model Views

Model View windows show a graphic view of the model. Open a new view with the

button.

You may open as many model view windows as you like. This is especially helpful when working in close on large
models. You might have one overall view and a few views zoomed in and rotated to where you are currently
working. You may also have different information plotted in multiple views.
One thing to remember is that the toolbars that are displayed depends upon what window is active. The active
window is the one with the highlighted purple bar. An inactive window will be greyed out as shown below where
3D View 2 is the active window.

For more information on this view the Graphic Display topic.

Spreadsheets
Spreadsheet windows are made up of rows and columns of data cells. If you wish to add or edit data in a
spreadsheet cell you click on the cell, making it the active cell, and then edit the cell. This active cell is simply the
green cell that moves around the spreadsheet as you hit the cursor keys (← , →), Page Up, Page Down, Home, End,
etc. There is always one and only one active cell, which is the cell that has the “attention” of the keyboard.
You may also select blocks of data to work on. You can select a block of data by clicking and holding the mouse
button on the first cell in the block and then dragging the mouse to the opposite corner of the block and releasing
the mouse.
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Dialogs
A Dialog is a third type of window and is used to access a specific function within the program. Another powerful
feature is that most of the dialogs may be left open while you edit the model, making it easy to make adjustments as
you work. You will find that dialogs are very easy to work with. There are Help buttons that will bring you directly
to the relevant topic in the help file.

Window Tiling
Standard window tilings help you set up your workspace. With any 3D view or spreadsheet, you can click the tab
and drag the window into a configuration that best suites your preferences. When dragging a window you will see a
circle with four arrows.

You can place the windows over each of these arrows to designate where to place the window. Placing the window
over the center dot will make the window cover the entire workspace between the Properties and Explorer
panels.
By placing windows over the dot within other windows, the windows will tab together. See below example where
3D View 2 and 3D View 3 have been tabbed together.

The best way to learn how the tiling works within the program is to try it out.

Modes
There are three basic program modes (View, Select, and Edit) and a mode hierarchy to allow you to move between
them easily. While you are editing the model you may select items to edit. When you are finished selecting you
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will be returned to editing. Likewise, while you are selecting items you can adjust the view and then be returned
to selecting.
Different mouse cursors are used with each mode to make it clear what the current mode is.
View Mode is the upper level mode that allows you to adjust the view by zooming in and out, rotating and setting
Model Display Options. This mode supersedes all other modes so that you may do these things at any time, and then
be returned to the previous mode. This mode does not cancel other modes so that when you are finished adjusting
the view you are returned to what you were doing. See Graphic Display for more information.
Select Mode is the middle level mode that allows you to make a graphic selection of nodes, members and plates.
This mode supersedes the Edit Mode but not the View Mode. This means that you can make a selection while in
the middle of editing the view and when you are finished you are returned to the editing feature that you were
using. It also means that you may adjust the view while remaining in the same Select Mode. See Graphic Selection
for more information.
Edit Mode is the lower level mode that allows you to graphically edit the model. You may make selections and
adjust the view while in the edit mode such that when you are finished selecting you will be returned to the Edit
Mode. Some Edit Mode features have options on how you apply the edit. See Graphic Editing for more information.

Note
l

l

The default mode is the mode you are in if you are not in any other mode and is indicated by the standard mouse cursor. The default mode is a selection mode where you can select/unselect individual
items by clicking on them. You may also double-click on an item to view information about the item.
You may use the ESC key or the right mouse button to cancel a mode.
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Aluminum - Databases
Shapes are organized in the database by country. The shapes available are from the ADM 2005 Section Properties
section. You may type in the names directly, select shapes from these databases or add your own shapes.
RISA currently supports the following common Cold Formed steel databases: Aluminum US, and Aluminum CAN.

To Select a Cold Formed Database Shape
1. From the Aluminum tab on the Section Sets Spreadsheet, or the Primary tab of the Members Spreadsheet move the cursor to the Shape field and click
.
2. Specify the Database and Shape Type you wish to use and then select from the list of available shapes.

Database Files
The aluminum shape databases are stored in the files ADMdbUS32.fil and ADMdbCAN32.fil.

To Add a Database Shape

1.
2.
3.
4.
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On the Advanced tab of the Ribbon, click the Shape Database
button.
Select the Aluminum tab, then select the shape type you wish to add and click the Add button.
Specify a name for the shape and fill in the Basic Properties.
Click Calc Props to determine the shape properties.
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To Edit a Database Shape

1. On the Advanced tab of the Ribbon, click the Shape Database
button.
2. Select the Aluminum tab, then select the shape you wish to edit and click the Edit button.
3. You have the option to input Geometric Properties and Section Properties manually, or you may choose to
have the program calculate the Section Properties based on values input for the Geometric Properties.
4. Once an edit has been made to the Geometric Properties, select Re-Calc to have the program calculate the
Section Properties automatically.

Note
l

l

l

New shapes are added to the bottom of the database in a blue font to show they were not originally from
the default database.
To delete a shape, specify the database and shape type you wish to delete and then click the Delete button.
Only shapes added to the default database (shown in blue) are able to be edited or deleted.

Aluminum Shape Types
There are ten types of aluminum shapes. Names for each shape type follow the convention of the manufacturer for
each shape. If you know the shape name, you can type the name directly into the Shape field on the
spreadsheets. Alternatively, you may click the

button to look up a shape and select it.

WF sections
The wide flange shapes are called out by the designation given them in the aluminum manual. For example, if you
wanted to use a WF10x11.4 you would enter WF10X11.4 as the shape name in the database shape field. Aluminum
Association Standard I-Beams(AA), American Standard(S), Army-Navy(A-N), Canadian(CAN) I-Beams and Wide
Flange shapes are available.

Zee sections (Z)
The Z shapes are called out by the designation given them in the ADM manual.

Tee sections (T)
The T shapes are called out by the designation given them in the ADM manual. Army-Navy (A-N) shapes are also
available.
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Solid Rectangular
The Solid Rectangular sections or bar sections are defined by the user, there are no default shapes.

Angles sections (L)
Angles are entered with an "L" prefix. The syntax is "longXshortXthick", where "long" is the long leg length, "short"
is the short leg length, and "thick" is the thickness, in number of decimals. For example, L5X3X0.375 is a 5" by 3"
angle 0.375" thick. Square End Angles (LS) shapes are also available.

Channel sections (CS)
The CS shapes are called out by the designation given them in the ADM manual. The Aluminum Association (AA),
American Standard Channels (C) and Car and Ship Building Channels (CS), Canadian Channels (CAN) are available.

Double Sections
The CS shapes are also available Back-to-Back or Front-to-Front orientation.

Note
l

The program currently only performs an analysis of double sections and does not perform a code check
of any kind. This may be added into a future version of the program.

Round Tube or Pipe (OD or NPS)
The Round Tube shapes are called out by the designation given them in the ADM manual. The Outer diameter call
out is used as well as the Nominal Pipe Size.

Rectangular Tube sections (RT)
The RT shapes are called out by the designation given them in the ADM manual.
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Full code checking can be performed on standard aluminum shapes, based on the following codes:
l
l
l

Aluminum Design Manual 2015: Building and Bridge
Aluminum Design Manual 2010: Building and Bridge
Aluminum Design Manual 2005: Building and Bridge

Aluminum properties are available in the database and the values are based on the ADM values (See Aluminum
Database). You may also input your own basic shapes and the properties will be calculated automatically.

Design Parameters
The Aluminum tab on the MemberSpreadsheet records the design parameters for the aluminum code checks.
These parameters may also be assigned graphically. See Modifying Member Design Parameters to learn how to do
this.

These parameters are defined for each aluminum member. The entries are explained below.

Label
You may assign a unique Label to all of the members. Each label must be unique, so if you try to enter the same
label more than once you will get an error message. You may relabel at any time with the Relabel options on the
Tools menu.

Shape
The member Shape or Section Set is reported in the second column. This value is listed for reference only and may
not be edited as it is dictated by the entry in the Section/Shape column on the Primary tab.

Length
The member Length is reported in the third column. This value may not be edited as it is dependent on the
member end coordinatelisted on the Primary Data tab. It is listed here as a reference for unbraced lengths which
are discussed in the next section.

Unbraced Length
See the Unbraced Lengths topic.

K Factors (Effective Length Factors)
See the Unbraced Lengths topic.

Sway Flags
See the Unbraced Lengths topic.
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Cm - Interactive Bending Coefficient
Cm Coefficients are described in Section 4.1.1 of the ADM code. If these entries are left blank, they will be
automatically calculated.
The Cm value is influenced by the sway condition of the member and is dependent on the member's end moments,
which will change from one load combination to the next, so it may be a good idea to leave these entries blank.

Note:
l

Cm only shows up in the spreadsheet for the 2005 codes.

Cb - Bending Coefficients
For the aluminum codes, Cb Coefficients depends on the moment variation over the unbraced length as described
in ADM Chapter F. If this entry is left blank, it will be calculated automatically.

Function for Stiffness Reduction
The Function entry may be set to either 'Lateral' or 'Gravity' using the drop down list in the spreadsheet. If the
Adjust Stiffness option is set to Yes on the Codes tab of the Model Settings Dialog, then all members with a 'Lateral'
Function will be considered for the stiffness reduction required per the Chapter C.2 Calculations of Required
Strength.
The Flexural Stiffness Reduction of the Direct Analysis Method will be applied to all 'Lateral' members whose
member type is set to either 'Beam' or 'Column' on the Primary Tab of the Members Spreadsheet.
The program can perform an iterative analysis during the solution depending on the value of τb. In this case, the
stiffness matrix is recomputed for each iteration until the value of τb converges within 1 percent for all 'Lateral'
members in compression. In the unlikely event that τb is less than zero, the value of τb is considered to be 1.e-5.
When the users sets the Adjust Stiffness flag on the Model Settings to Yes (Tau =1.0), then the program will use a
Tau of 1.0 in the stiffness analysis and no iteration of the stiffness matrix is necessary. This option is a good feature
for models which take a long time to solve or which have not yet been proportioned to control drift.
The Axial Stiffness Reduction of the Direct Analysis Method will be applied to all 'Lateral' members whose
member type is set to either 'Column' or 'VBrace' on the Primary Tab of the Members Spreadsheet.

Note
l

The stiffness reduction required by the Chapter C will be ignored if the Adjust Stiffness option is not
selected on the codes tab of the Model Settings, or if the design code chosen does not have an option for
stiffness reduction.

Aluminum Code Check
Access the Code Check spreadsheet by selecting the Results tab
Alternatively, on the Results toolbar you can select Code Check.

Envelope (or LC) button

Code Check.

The final results of the code checking are the code check values UC Max and Shear UC. So, if this value is less than
1.0, the member passes. If it is greater than 1.0, the member fails. If the value is greater than 9.999 it will be listed
as "9.999". The Shear Check is based on fs/Fs. Note that torsional shear, if any, is also included in this check. The
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location for the shear check is followed by "y" or "z" to indicate the direction of the shear. The Loc field tells at
what location the maximum code check occurs measured from the I-joint location of the member. See Model
Display Options – Members to learn how to view the code check results graphically.
The remaining columns provide some of the values used in the code check with the equation number itself given in
the last column. The Member Detail Report gives more values used to perform the code check.
The final field lists the controlling equation for the code check. This will be one of the equations from Section 4.
For enveloped results the combination that produced the listed code and shear checks is given in the column "lc".
The other values are the corresponding values and are not necessarily the maximums across all the combinations.
The moving load results are enveloped and the governing load combination and step location is shown for each
result value under the "LC" column. The first number is the load combination, the second is the step number: (load
combination - step number). See Moving Loads to learn more.
Note
l

l
l
l

The program currently only performs an analysis of double sections and does not perform a code check
of any kind.
The Member Detail Report gives more values used to perform the code check.
See Spreadsheet Operations to learn how to use Find, Sort and other options.
See Results View Settings - Members to learn how to plot member results.

Aluminum Detail Report
The aluminum detail report has design information for the specific code checks:

The Max Bending Check is based on ADM Chapter H, with the governing Equation and Location listed.
The Max Shear Check is not provided in the ADM specification, this represents fs/Fs with the governing Location
listed.
The Max Defl Ratio is based on the entire length of the member.
The Slender Limitl1 and l2 are calculated based on the Gov Eqn. The Slenderness Ratio are given based on the
Design Aids in Tables 2-x ADM Section VI. The Slender. Ratio is also based on the Gov Eq , for further information
refer to the ADM Design Aids.

Assumptions and Limitations
For all shape types, it is assumed that the transverse load on the member is occurring through the member's shear
center. This means secondary torsional moments that may occur if the load is not applied through the shear center
are not considered.
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l

l
l

l
l
l

Single Angles are not checked for bending in the 2005 and 2010 codes. They are checked for bending in the
2015 and newer codes.
rye, effective radius of gyration from Eq 4.9.1-1 is used for doubly symmetric sections beams.
Welded regions are not checked in RISA-3D. You can use the welded material properties for the entire member, or create segments that are welded material in order to check the weld properties. For additional advice
on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in Search keywords:
Welded Aluminum.
Connections are not checked, including web crippling, fatigue or stiffeners.
Kt in is assumed to be the smaller of Kyy or Kzz.
Double Sections - The program currently only performs an analysis of double sections and does not perform a code check of any kind.

Special Messages
Aluminum Code Check Not Calculated
This message is displayed when the member is not defined with a database shape, is defined as a double section, or
an Aluminum code is not specified on the Model Settings, or no units were specified.

-Pu was ignored in the calculation of the unity checkThis message is reported in the detail report when the member axial force is low (less than 5% of capacity). This is
done so that beam members with very low axial forces will give similar code checks whether in tension or
compression.
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Boundary Conditions
Boundary Conditions define how the model is externally constrained. All models must be attached to some
external point or points of support. You may define these points of support as completely restrained or as partially
restrained with a Spring. You can also define a spring support that has stiffness in only one direction with tensiononly or compression-only springs.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Boundary Conditions.

Creating and Modifying Boundary Conditions
There are a number of ways to create or modify boundary conditions. You may view and edit the data in the
Boundary Conditions Spreadsheet, you may click a node to view and edit its properties, or you can use the
Boundary Conditions tool to graphically assign or modify a possibly large selection of boundary conditions.

Modify Boundary Conditions forNodes
The graphical Boundary Conditions tool discussed here lets you specify and modify boundary conditions
graphically. To use this, you will typically specify the new boundary condition, then press Click to Apply and click
on nodes one by one or press Apply to Selected after having selected the nodes that you want to assign or modify.
You can modify or assign nodes one at a time by selecting the Click to Apply option and then click on the nodes
you wish to modify. You may also modify or assign entire selections of nodes by selecting the nodes first and then
use the Apply to Selected option.
The parameters shown below are the same as those on the Boundary Conditions Spreadsheet and are described
in Boundary Condition Options. Use the ellipsis button to select the boundary condition.

To Apply Boundary Conditions
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1. If there is not a model view already open, click the Open 3D Views button in the View tab to open a new
view.
2. Click the Boundary Conditions button on the Home tab and select a boundary condition.
3. You may apply the boundary condition by choosing Click to Apply or Apply to Selected.
To choose nodes on the fly, choose Click to Apply. Click/Box the nodes with the left mouse button.
To apply the boundary condition to a selection of nodes, choose Apply to Selected.
Note
l
l

l
l

To apply more boundaries with different conditions, press the Boundary Conditions button once more.
You may also view and edit boundary conditions by clicking on a node and editing the values in the
Properties panel.
You may also specify or edit boundary conditions in the Boundary Conditions Spreadsheet.
You may undo any mistakes by clicking the Undo

button.

Generate Soil Springs
A subgrade modulus may be automatically applied to horizontal plates in a model using the Subgrade Springs tool.
The tool will generate compression-only springs in the vertical direction at all plate nodes in the selected group of
plates. Nodes must be connected to plates which are perpendicular to the vertical direction or the nodes will be
ignored. If a boundary code other than a compression-only spring already exists in the vertical direction at that
node, the boundary code will NOT be modified.

RISA-3D calculates the tributary area for each plate node individually and multiplies that area by the subgrade
modulus to determine the spring stiffness for the compression-only spring at that node. The boundary codes for all
plate nodes affected are automatically modified in the Boundary Conditions Spreadsheet.
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Boundary Conditions Spreadsheet

The Boundary Conditions Spreadsheet records the boundaries for the nodes and may be accessed by selecting
Boundary Conditions from the Data Entry drop down menu in the Spreadsheets tab of the Ribbon Toolbar or
by selecting Boundary Conditions from the Data Entry Window.

The Node Label column contains the label of the node that is restrained.
The remaining columns record the boundary conditions that apply to the node. There are six degrees of freedom for
each node (3 translation, 3 rotation), so there are six columns for degrees of freedom. The boundary conditions are
entered in these remaining columns by selecting the cell, clicking
may also type them in directly.

and choosing from the boundary options. You

Advanced Boundary Conditions
The Advanced tab of the boundary conditions spreadsheet contains information on nodal damping.
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Damping for Spring Boundary Conditions
When the user has defined a two-way soil spring to a node and chooses to run a time history analysis using the
Direct Integration solution method, then they may manually assign a Damping value to each of these soil springs.
Note:
l

l

If there is not a spring boundary condition for the direction specified, then the user entered damping value
will be ignored. You can only manipulate supports in this column if they are simple point supports. Any footings, piles or pile caps are manipulated in the other columns.
These damping entries are only used when the direct integration method is selected for the time history solution. These values are not editable unless this method is already selected in the Global Parameters.

Boundary Condition Options
Free nodes have no restraint in any of the degrees of freedom and need not be listed on the Boundary Conditions
Spreadsheet. The following are the valid boundary condition options that may be used for the six degrees of
freedom.
Note
l

l

l

Models that contain compression-only or tension-only springs must be iterated until the solution converges. Convergence is achieved when no more load reversals are detected in the springs. During the iteration process, each spring is checked, and if any springs are turned off (or back on), the stiffness
matrix is rebuilt and model is resolved. This can take quite a bit longer than a regular static solution.
With this iteration procedure it is possible to run into a phenomenon known as "clapping". This occurs
when a compression-only spring keeps going between a tension force present (where the spring is
removed) to a compression force present (where the spring is re-added). This can be somewhat common
in non-linear solutions. If you run into this phenomenon, you may see the program give Error 1162. The
fix is to very slightly adjust either the loading or the spring/element stiffness to get the offending spring
out of the range where it can bounce back and forth. Another option would be to move the location of
the soil spring slightly so it's not right at an inflection boundary.
You can enter the first letter of the option ("R" for Reaction, "S" for Spring, etc.) rather than typing out
the entire code. RISA-3D fills in the rest automatically. The exception is the Tether entry, where the full
word does have to be entered. After Tether, the primarynode needs to be entered (for example, Tether
N2)

Boundary Condition at ALL Nodes
The entry "ALL" may be entered in the Node Label field. The boundary conditions entered on this line will be
applied to ALL the nodes not otherwise listed. This is useful if you should want to lock certain directions of
movement for all or most of the nodes. For example, if you are solving a 2D frame defined in the XY plane and
you're only interested in the planar action, you could enter "ALL" and put an "F" (for Fixed) for Z translation, X
Rotation and Y Rotation. See the following figure:
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Note
l

l

If a node is explicitly listed with boundary conditions, those boundary conditions override the "ALL" conditions for all 6 directions. The "ALL" specified boundary codes apply only to those nodes NOT otherwise
listed on the Boundary Conditions Spreadsheet.
When using the "ALL" command, boundary conditions are no longer graphically displayed.

Reaction Boundary Condition
The "R" code, for Reaction, specifies full restraint for the indicated direction. No movement will be allowed in the
indicated direction for this node. Furthermore, the reaction will be calculated at this node, for this direction.

Fixed Boundary Condition
The "F" code, for Fixed, specifies full restraint for the node in the indicated direction. The difference between
"Fixed" and "Reaction" is that for the "Fixed" code, no reaction is calculated. The "Fixed" condition actually removes
the degree of freedom from the solution, which is why the reaction value is not available. If you aren't interested in
the reaction value, using the "Fixed" code will result in a slightly smaller model and less output.

Spring Boundary Condition
The "Snnn" code, for Spring, models a spring attached to the node in the indicated direction. The "nnn" portion of
the code is the numerical magnitude of the springs' stiffness. The units for the spring stiffness depend upon
whether the spring is translational or rotational. The appropriate units are shown at the top of the column.
For example, if a spring of stiffness 1000 Kips per Inch were desired in the X direction at a particular node, for that
node you would enter 'S1000' for the X direction boundary condition.

Compression-Only Springs
The "CSnnn" code, for Compression-Only Springs, models a one way "compression-only" spring attached to the
node in the indicated direction. This spring has stiffness for negative displacements and NO stiffness for positive
displacements. The "nnn" portion of the code is the numerical magnitude of the springs' stiffness. The spring
stiffness units are the same as those for a normal spring. Compression-only springs are useful as soil springs when
analyzing foundations that may have uplift.
For example, if a compression-only (CS) spring with a stiffness of 500k/in were desired in the Y direction at a
certain node, you would enter 'CS500' for the Y direction boundary condition.
This means that all displacements at this node in the negative Y direction will be resisted with a stiffness of
500k/in. However, the node is free to move in the positive Y direction.
l

When a model contains T/C only springs, the program must iterate the solution until it converges. Convergence is achieved when no more load reversals are detected in the T/C only springs. During the
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iteration process, each T/C only boundary condition is checked. If any springs are turned off (or turned
back on), the stiffness matrix is rebuilt and model is resolved. For models with lots of T/C only elements,
this can take a bit longer than a regular static solution.

Tension-Only Springs
The "TSnnn" code, for Tension-Only Springs, models a one way "tension-only" spring attached to the node in the
indicated direction. This spring has stiffness for positive displacements and NO stiffness for negative displacements.
The "nnn" portion of the code is the numerical magnitude of the springs' stiffness. The spring stiffness units are the
same as for a normal spring.
For example, if a tension-only (TS) spring with a stiffness of 500k/in. were desired in the Y direction at a certain
node, you would enter 'TS500' for the Y direction boundary condition.
This means that all displacements at this node in the positive Y direction will be resisted with a stiffness of 500k/in.
However the node is free to move in the negative Y direction.
l

When a model contains T/C only springs, the program must iterate the solution until it converges. Convergence is achieved when no more load reversals are detected in the T/C only springs. During the
iteration process, each T/C only boundary condition is checked. If any springs are turned off (or turned
back on), the stiffness matrix is rebuilt and model is resolved. For models with lots of T/C only elements,
this can take a bit longer than a regular static solution.

Tethered Nodes
You may tether any or all of the node degrees of freedom to another node. See Tethering Nodes for more
information.

Story Drift Nodes
l

The Boundary spreadsheet is also used to record nodes to be used for story drift calculation. For
example, to indicate that a particular node is to represent the fourth story level for X direction drift, you
would enter “STORY 4” for the X direction boundary condition for the node. These STORY entries may
only be made in the translation degrees of freedom. See Drift for more information.

Boundary Conditions at Wall Panels
If the edge of a wall panel is to be viewed as continuously pinned or fixed, then the boundary condition for that wall
must be set in the wall panel editor. Situations can arise where there is a difference between the wall panel edge
boundary condition and the boundary condition defined at a node along that edge. In these situations the node
boundary condition will always govern for that node. However, the rest of the edge will be based on the wall panel's
boundary conditions.
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Cold Formed Steel - Databases
Shapes are organized in the database by manufacturer. Common shapes are supported such as C sections(with and
without lips), Z sections(with and without lips), and Hat sections(without lips). Each of these shape types may be
used as Single section, a Back-to-Back section, or a Face-to-Face section. You may type in the names directly, select
shapes from these databases, or add your own shapes.
RISA currently supports the following common Cold Formed steel databases: AISI 2007, Dale-Incor, Dietrich,
Marino-Ware, and SSMA.

To Select a Cold Formed Database Shape
1. From the Cold Formed tab on the Section Sets spreadsheet, or the Primary tab of the Members Spreadsheet, move the cursor to the Shape field and click
.
2. Specify the database and shape type you wish to use and then select from the list of available shapes.

Custom vs. Manufacturer Shapes
You can enter your own cold formed shapes as well as use those provided in the manufacturer database. When the
cold formed database type is selected, you'll notice a "Manufacturer" list box that appears in the Shape Selection
dialog. You can specify a manufacturer or choose “Custom” to select, add or edit your own custom shapes. New
shape properties are calculated using the linear method described in Part I of the AISI code.

Database Files
The cold formed manufacturer shape databases are stored in the file aisidb32.fil, and the custom cold formed
shapes are stored in the file aisicust.fil.

To Add a Database Shape

1.
2.
3.
4.

On the Advanced tab of the Ribbon, click the Shape Database
button.
Select the Cold Formed tab, then select the shape type you wish to add and click the Add button.
Specify a name for the shape and fill in the Basic Properties.
Click Calc Props to determine the shape properties.

General Reference Manual

43

Cold Formed Steel - Databases

To Edit a Database Shape

1. On the Advanced tab of the Ribbon, click the Shape Database
button.
2. Select the Cold Formed tab, then select the shape you wish to edit and click the Edit button.
3. You have the option to input Geometric Properties and Section Properties manually, or you may choose
to have the program calculate the Section Properties based on values input for the Geometric Properties.
4. Once an edit has been made to the Geometric Properties, select Re-Calc to have the program calculate the
Section Properties automatically.

Note
l

l

l

New shapes are added to the bottom of the database in a blue font to show they were not originally from
the default database.
To delete a shape, specify the database and shape type you wish to delete and then click the Delete button.
properties. Only shapes added to the default database (shown in blue) are able to be edited or deleted.

Cold Formed Shape Types
There are five types of shapes. Names for each shape type follow the convention of the manufacturer for each
shape. If you know the shape name, you can type the name directly into the Shape field on the
spreadsheets. Alternately you may click the

button to look up a shape and select it.

C sections without lips (CU)
For the AISI database, CU shapes are called out by the designation given them in the AISI steel manual. For
example, if you wanted a 12" deep unstiffened C section, you'd call it out as 12CU1.25x071. The '12' is the depth,
the CU specifies a C section without lips, the '1.25' is the flange width, and the '071' is the decimal thickness. Other
manufacturer databases generally follow similar conventions.
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C sections with lips (CS)
For the AISI database, CS shapes are called out by the designation given them in the AISI steel manual. Other
manufacturer databases generally follow similar conventions.

Z sections without lips (ZU)
For the AISI database, ZU shapes are called out by the designation given them in the AISI steel manual. Other
manufacturer databases generally follow similar conventions.

Z sections with lips (ZS)
For the AISI database, ZS shapes are called out by the designation given them in the AISI steel manual. Other
manufacturer databases generally follow similar conventions.

Hat sections without lips (HU)
For the AISI database, HU shapes are called out by the designation given them in the AISI steel manual. Other
manufacturer databases generally follow similar conventions.

Closed Box Members (Tube)
For the AISI database, HU shapes are called out by the designation given them in the AISI steel manual. Other
manufacturer databases generally follow similar conventions.

Double Sections
For each of the five shape types the selected shape may be used as a standard single section or as a double section.
The choices for double sections are Back-to-Back and Face-to-Face. A typical double section is designated with a "2" preceding the shape name and a "-BB" (Back-to-Back) or "-FF" (Face-to-Face) following the shape name. For
example, a "2-12CU1.25x071-FF" section represents two 12" deep C sections with 1.25" wide flanges and a 0.071"
thickness placed face-to-face.
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Full code checking can be performed on standard cold formed steel shapes, based on the following codes:
l
l
l
l
l
l
l
l

l

l
l

l

l

l
l
l
l
l
l

The 1996 edition of the AISI code with 1999 Supplement (AISI-99 ASD and LRFD)
The 2001 edition of the AISI code (AISI NAS-2001 ASD and LRFD)
The 2001 edition of the Mexican code (CANACERO-2001 ASD and LRFD)
The 2001 edition of the Canadian code (CSA S136-01 LSD)
The 2004 Supplement of the AISI code (AISI NAS-2004 ASD and LRFD)
The 2004 Supplement of the Mexican code (CANACERO-2004 ASD and LRFD)
The 2004 edition of the Canadian code (CSA S136-04 LSD)
The 2007 edition of the AISI code (AISI S100-2007 ASD and LRFD) including Supplement No.1 (August
09)
The 2007 Supplement of the Mexican code (CANACERO-2007 ASD and LRFD) including Supplement No.1
(August 09)
The 2007 edition of the Canadian code (CSA S136-07 LSD)
The 2010 edition of the AISI code (AISI S100-10 ASD and LRFD contained in the Supplement No. 2 February 2010)
The 2010 Supplement of the Mexican code (CANACERO-2010 ASD and LRFD contained in the Supplement No.2 February 2010)
The 2010 edition of the Canadian code (CSA S136-10 LSD contained in the Supplement No.2 February
2010)
The 2012 edition of the AISI code (AISI S100-12 ASD and LRFD)
The 2012 edition of the Canadian code (CSA S136-12 LSD)
The 2012 edition of the Mexican code (CANACERO-2012 ASD and LRFD)
The 2016 edition of the AISI code (AISI S100-16 ASD and LRFD)
The 2016 edition of the Canadian code (CSA S136-16 LSD)
The 2016 edition of the Mexican code (CANACERO-2016 ASD)

Note:
l
l

Back to Back and Face to Face member checks are available for AISI S100-07 and newer.
Unless otherwise specified, all code references below are to AISI S100-16.

Cold formed shape properties are available in the database and the values are based on the AISI or manufacturer
values, whichever is selected (See Cold Formed Steel Database). You may also input your own basic shapes and the
properties will be calculated automatically.

Design Parameters
The Cold Formed tab on the Members Spreadsheet records the design parameters for the cold formed steel code
checks. These parameters may also be assigned graphically. See Modifying Member Design Parameters to learn
how to do this.
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These parameters are defined for each cold formed member. The entries are explained below.

Label
You may assign a unique Label to all of the members. Each label must be unique, so if you try to enter the same
label more than once you will get an error message. You may relabel at any time with the Relabel options on the
Tools menu.

Shape
The member Shape or Section Set is reported in the second column. This value is listed for reference only and may
not be edited as it is dictated by the entry in the Section/Shape column on the Primary tab.

Length
The member Length is reported in the third column. This value may not be edited as it is dependent on the
member end coordinates listed on the Primary Data tab. It is listed here as a reference for unbraced lengths which
are discussed in the next section.

Unbraced Length
See the Unbraced Lengths topic.

K Factors (Effective Length Factors)
See the Unbraced Lengths topic.

Sway Flags
See the Unbraced Lengths topic.

Cm - Interactive Bending Coefficient
Cm Coefficients are described in Section C5 of the AISI code. If these entries are left blank, they will be
automatically calculated.
The Cm value is influenced by the sway condition of the member and is dependent on the member's end moments,
which will change from one load combination to the next, so it may be a good idea to leave these entries blank.
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Cb - Bending Coefficients
For the cold formed codes, Cb Coefficients are used in the calculation of the nominal flexural strength, Mn. If this
entry is left blank, it will be calculated automatically.

R Value
The R Value for cold formed steel design is described in Section I6.2.1 of the AISI code and is used to calculate the
moment capacity of beams that have one flange fastened to deck or sheathing. This value only applies to C or Z
members and can vary from 0.4 to 0.7 based on the depth of the member (See Table I6.2.1-1 in the AISI Supplement
for the actual values).
If a value is entered by the user, that value will be used by the program in the moment capacity calculation of the
member. There are a number of restrictions that must be met to use this section of the code for moment capacity
and the user is responsible to check that these restrictions are satisfied.

Note:
l

If the R value is entered, the program will use Section I6.2.1 to check moment capacity calculations.

a - Connector Spacing
For double sections, the connector spacing 'a' is used in the calculation of the KL/r. There are also limitations on the
connector spacing length that are checked.

Function
The stiffness of gravity members will not be adjusted.

AISI Steel Code Check Results
Access the Code Check spreadsheet by selecting the Results tab
Alternatively, on the Results toolbar you can select Code Check.

Envelope (or LC) button

Code Check.

The final results of the code checking are the code check values UC Max and Shear UC. These values represent a
factored ratio of actual to allowable load for ASD or ultimate load to design strength for LRFD or LSD, based on the
provisions of Section H1. Section H2 is also used to check combined bending and shear. So, if this value is less than
1.0, the member passes. If it is greater than 1.0, the member fails. If the value is greater than 9.999 it will be listed
as "9.999". The Shear Check is based on section C3.2.1. Note that torsional shear, if any, is also included in this
check. The location for the shear check is followed by "y" or "z" to indicate the direction of the shear. The Loc field
tells at what location the maximum code check occurs measured from the I-joint location of the member. See Model
Display Options – Members to learn how to view the code check results graphically.
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The remaining columns, discussed below, provide some of the values used in the code check with the equation
number itself given in the last column. The Member Detail Report gives more values used to perform the code
check.
For ASD, the available strengths Pn/Omega, Tn/Omega, Mnyy/Omega, Mnzz/Omega, Vny/Omega, and Vnz/Omega
are calculated for the member.
For LRFD or LSD, the values for factored compression Phi*Pn, factored tension Phi*Tn, factored moments Phi*Mnyy
and Phi*Mnzz, and factored shears Phi*Vny and Phi*Vnz are displayed.
Pn is calculated according to the provisions of AISI 2016, Chapter E. Tn is based on Chapter D. The Mn values are
calculated based on Chapter F. The Vn values are calculated based on Chapter G. Note that for RISA-3D, "zz"
corresponds to "xx" in the AISI code, i.e. RISA-3D substitutes Mnzz for Mnx, to maintain consistency with the
member local axis system.
Cb will be calculated automatically if not specifically entered by the user, which is conservative. For AISI S100-12,
the Cm coefficients described in Section C5 are also listed. These also are influenced by the sway flag settings.
The final field lists the controlling equation for the code check. This will be one of the equations from Section H1 or
H2.
For enveloped results, the combination that produced the listed code and shear checks is given in the column "LC".
The other values are the corresponding values and are not necessarily the maximums across all the combinations.
The moving load results are enveloped and the governing load combination and step location is shown for each
result value under the "LC" column. The first number is the load combination, the second is the step number: (load
combination - step number). See Moving Loads to learn more.

Member Detail Report
The image below is the last portion of a detail report for a Cold Formed Steel member showing the member
warnings, code checks, and section properties.

Below describes the Cold Formed Steel specific parameters. Refer to the Member Detail Report for more
information on the values used to perform the code check.
Cw- Torsional warping constant. This will only be shown for Back-to-Back and Face-to-Face shapes. See Unbraced
Lengths topic to understand how the bracing affects this calculation.
a (conn. Spacing)- distance between connections locations of built-up shape. This spacing is checked by code
prescribed limits and is used in the calculation of KL/r. This will only be shown for Back-to-Back and Face-to-Face
shapes.
A eff. (Fy)- The effective Area used in determining the nominal strength of the section, where the maximum stress is
the yield stress.
A eff. (Fn)- The effective Area calculated at stress Fn, where Fn is the nominal buckling stress.
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Iy eff. – The effective Moment of Inertia about the y-axis.
Iz eff– The effective Moment of Inertia about the x-axis.
Sy eff(L) - Effective section modulus about the Y axis for the extreme left fiber.
Sy eff.(R) Effective section modulus about the Y axis for the extreme right fiber.
Sz eff(T) - Effective section modulus about the Y axis for the extreme top fiber.
Sz eff.(B) - Effective section modulus about the Y axis for the extreme bottom fiber.
The effective properties listed above are based on the governing values used to determine the Mny and Mnz. The
labels on the effective properties will al always state "Sy eff" however depending on the governing value it might be
the fully unreduced section (Sf), effective section calculated relative to the extreme compression fiber at Fc (Sc) or
effective section calculated relative to the extreme compression or tension fiber at Fy (Se).
When the Combined Tensile Axial load and Bending unity equations govern, the Detail Report will display the Sf.
When the Combined Bending and Shear unity equations govern, the Detail Report will display the Se. When the
Combined Compressive Axial load and Bending unity equations govern, the display depends if governing equations
are: local yielding (Se), Lateral Torsional Buckling (Sc) or Distortional Buckling (Sf).
l
l

See Spreadsheet Operations to learn how to use Find, Sort and other options.
See Results View Settings - Members to learn how to plot member results.

Assumptions and Limitations
For all shape types, it is assumed that the transverse load on the member is occurring through the member's shear
center. This means secondary torsional moments that may occur if the load is not applied through the shear center
are not considered.
Iterations for the effective section modulus (Se and Sc) are ended when a difference less than 1% is achieved in the
neutral axis distance calculation with a maximum of 5 iterations. Holes in sections are not considered in the shear
strength calculations or for effective width calculations. Deflections are based on the full section properties, not the
effective section properties.
Torsional warping effects are not included. Torsion stiffness and stress are calculated as pure torsion only. Web
crippling is not considered.
See the Unbraced lengths for Cold Formed Steel section for the full details.
Kt in Section F2.1 is assumed to be 1.0. Effects of shear stiffeners for Section G2 are not considered.
Z Shapes – The bracing length in Lbyy is assumed to brace the minor principal axis. Z sections in compression are
assumed to buckle in Euler buckling about their weakest principal axis. The value of rmin is used rather than the
geometric rx and ry values.
H Shapes – Hat sections in bending about the y-y axis such that the brims are in compression are assumed braced
such that the brims cannot each fail in lateral torsional buckling independently. For AISI S100-12 and older, lateraltorsional buckling is not checked for HU shape.
Slenderness Limitations - The w/t limits of Section B4 are enforced. However, the shear lag effects (Section B4.3)
are not enforced. Below is an example showing the slenderness checks (AISI S100-12) for a CU and CS shape:
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Double Sections
The distance between connector spacing is checked per smax (AISI Eq I1.1-1) however the spacing is considered
uniform. The concentrated loads are not checked (AISI Eq I1.1-2) and there is no covered plate sections available
(AISI Section I1.3).
The Slenderness ratio is altered based on the intermediate fastener spacing when applicable (AISI Eq I1.2-1). The
Detail Report will display the modified KL/r if it governs. This modification is applied if the spacing meets the code
limits that states a/ri does not exceed one-half the governing slenderness ratio of the member. The welds length
and/or weld/fastener strengths are not checked in RISA (Section I1.2b,c). If the fastener spacing does not satisfy the
aforementioned conditions, the global buckling stress of the built-up member is calculated based on the section
properties of the individual stud members.
For Back to Back sections, the Weak Axis moments (My) or shear forces (Vz) for back-to-back shapes are not
considered in the code check and this is noted in the Detail Report. The program will give you analysis information
in the Detail Report and spreadsheets.
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For Face to Face sections, the Torsional Constant (J) and Torsional warping constant (Cw) are calculated based on a
tube shape if the Connector spacing is set to fully connected (a=0). If the connector spacing is greater than zero
(a>0), the J and Cw calculation will be based on the summation of each element.

Special Messages
AISI Code Check Not Calculated
This message is displayed when the member is not defined with a database shape, or a steel code is not specified on
the Model Settings, or no units were specified.

Can't do code check, stiffener D/w > 0.7 (Table B4.1-1)
The ratio D/w exceeds the limiting criteria listed in Table B4.1-1 (AISI S100-16) or Section B4.2 (AISI S100-12) for
simple lip stiffeners. (“D” and “w” are length of the stiffener and the flat length of the flange as defined in B4.2)

Stiffener angle gamma is < 40 or > 140 (Sect. B4.2)
The angle (gamma) for a simple lip stiffener must be greater or equal to 40 degrees or less than or equal to 140
degrees per the criteria in Commentary Section 1.3 (AISI S100-16) or Section B4.2 (AISI S100-12). The angle
gamma for this shape is outside this range.

Can't do code check, flange w/t > limit (Table B4.1-1)
The ratio w/t exceeds the limiting criteria listed in Table B4.1-1 (AISI S100-16) or Section B1.1 (AISI S100-12) for
flanges. A value of 60 is used per the AISI code for unstiffened elements and elements stiffened with simple lips.

Can't do code check, web h/t > 200 (Table B4.1-1)
The ratio h/t exceeds the limiting criteria listed in Table B4.1-1 (AISI S100-16) or Section B1.2 (AISI S100-12) for
webs. The program currently considers all webs as unreinforced, so a value of 200 is used as the limit.

Can't do code check, Connector spacing 'a' > L/6 per I1.1
The connector spacing "a" exceeds the limiting criteria listed in Section I1.1 (AISI S100-16) or Section D1.1
(AISI S100-12). The "L" in this equation is the beam span (full length of the member).
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There are two types of concrete shapes currently supported, Rectangular and Circular. If you’re familiar with the
shape definitions, you can type the name directly into the appropriate field. Alternately you may click the
button to have the program generate the desired shape definition for you.

Rectangular Sections
Rectangular sections are defined using a parametric shape code since a rectangular shape may be any depth or
width. The code is CRECT'depth'X'width', where 'depth' and 'width' are the values in the current dimension units.
For example, if you wanted a beam that was 18" deep and 12" wide, you would enter "CRECT18X12". Note that the
dimensions can also be decimal values like "18.25".

Circular Sections
Circular/Round sections are also defined using a parametric shape code since a round shape may have any
diameter. The code is CRND'diameter', where 'diameter' is the value in the current dimension units. For example, if
you wanted a column that was 14" in diameter, you would enter "CRND14". Note that the dimension can also be a
decimal value like "14.5".

Custom Rebar Layout Database
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On the Advanced tab of the ribbon, the Custom Rebar
button will open the database that is used for creating
and storing custom rebar layouts. This allows the user to create multiple layers of bars and add in compression
reinforcement or unusual bar arrangements.
These reinforcement layouts may be assigned to beam or column members in the same way as the other concrete
design parameters are assigned. This can be done from the Concrete Beam (or Column) tabs of the Members
Spreadsheet, or the Rebar Design dropdown in the Properties Panel,

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Custom Rebar Layouts.

Beam Rebar Layouts
Since beams are only designed for uniaxial bending, the only requirements for the beam layouts are that you specify
the depth at which the bars are located and the size & number of the bars that are present at that depth. You can
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specify the depth with respect to the top surface of the beam or the bottom surface.

The Start and End locations dictate the location along the length of the beam where these bars will be present. You
can use these entries to specify partial length bars that will only be present in locations with a higher moment
demand. If the bar should be present for the entire length of the beam, the start location should be '0' and the end
location should be '%100' as shown in the dialog above.

Rectangular Column Rebar Layouts
Since columns are designed for biaxial bending, they require more information about the location and arrangement
of the bars.
Normally, column bars are arranged in layers. One 'Top' and one 'Bottom' horizontal layer must always be defined,
each containing at least two bars. These layers, as well as any additional horizontal layers, will be specified by
entering a y1 value to specify the depth from the top or bottom fiber to the centerline of the reinforcing steel. The
number and size of the bars must then be entered. The z1 and z2 values dictate where the first and last bar in that
layer are located. Additional bars in that layer will be placed so that they are evenly spaced in that layer.
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Vertical layers can be specified by entering a y1 value specifying the depth from the right or left most fiber to the
centerline of the reinforcing steel. The number and size of the bars must then be entered. The z1 and z2 values are
ignored for vertical layers because the bars will be assumed to be evenly spaced between the required top and
bottom layers referred to previously. If this is not desired, then the side bars should be entered individually as
custom single bars.
Custom single bars are specified by their y and z coordinates measured from the local y and z-axis respectively. A
positive y coordinate would place the bar closer to the top fiber and a negative y coordinate would place the bar
closer to the bottom fiber. Similarly, a positive z coordinate would place the bar closer to the right side and a
negative z coordinate would place the bar closer to the left side.
The Start and End locations dictate the location along the length of the member where these bars will be present.
You can use these entries to specify partial length bars that will only be present in locations with a higher moment
demand. If the bar should be present for the entire length of the member, the start location should be '0' and the
end location should be '%100' as shown in the dialog above.

Circular Column Rebar Layouts
For circular columns, you may specify equally spaced concentric rings of bars at given depths, z1, measured from
the exterior fiber of the column. You may also specify custom single bars.
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Custom single bars are specified by their y and z coordinates measured from the local y and z axis respectively. A
positive y coordinate would place the bar closer to the top fiber and a negative y coordinate would place the bar
closer to the bottom fiber. Similarly, a positive z coordinate would place the bar closer to the right side and a
negative z coordinate would place the bar closer to the left side.

The Start and End locations dictate the location along the length of the member where these bars will be present.
You can use these entries to specify partial length bars that will only be present in locations with a higher moment
demand. If the bar should be present for the entire length of the member, the start location should be '0' and the
end location should be '%100' as shown in the dialog above.

Shear Rebar Layouts
These rebar layouts may be assigned to either columns or beams. They are specified by giving the size and spacing
of the bars as well as the location on the member where that reinforcement will be present.
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The Start and End locations dictate the location along the length of the member where these bars will be
present. You can use these entries to specify partial length reinforcement that will only be present in locations with
a higher shear demand. If the reinforcement should be present for the entire length of the member, the start
location should be '0' and the end location should be '%100' as shown in the dialog above.
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Concrete design and optimization can be performed for standard concrete shapes based on the following codes:
l
l
l
l
l
l
l
l
l

The 2019, 2014, 2011, 2008, 2005, 2002 and 1999 Editions of ACI 318
The 1997 Edition of the British code (BS 8110)
The 1992 EuroCode (EC2) and the British publication of the 2014 and 2004 Eurocode (BSEN)
The 1994 and 2004 Editions of the Canadian code (CSA A23.3)
The 2000 Edition of the Indian code (IS 456)
The 2001 Edition of the Australian code (AS 3600)
The 1995 Edition of the New Zealand code (NZS 3101)
The 2004 Edition of the Mexican code (NTC-DF)
The 2007 Edition of the Saudi Building Code (SBC 304)

Note:
l
l

Unless otherwise specified, all code references below are to ACI 318-14.
Beams and Columns designed in RISA meet all of the requirements for Ordinary Moment Frames except for
the additional requirements indicated in ACI 318-14 Section 18.3. Those provisions should be checked by
hand outside of RISA.

The program will design the longitudinal and shear reinforcement for rectangular beams and rectangular or circular
columns. These calculations encompass all the code requirements except those noted in the Limitations section of
this document. The program also provides reinforcement detailing information for concrete beams and interaction
diagrams for concrete columns in the member detail reports.
To Apply a Concrete Design Code
1. On the Code tab of Model Settings Dialog, select the concrete code from the drop down list.
2. Click Apply or OK.

Concrete Spans
Beam member types are supported by the following: Vertical Boundary Conditions (Fixed, Reaction), Column
Members, Near Vertical Plate Elements, and other Beam Members that are supporting that member.
Column member types are supported by the following: Horizontal Boundary Conditions (Fixed, Reaction, Spring),
Beam Members, Near Horizontal Plate Elements, and Rigid Diaphragms.

Note
l
l

l

l

l

The quickest way to create new joints at beam / column intersections is to run a Model Merge.
Clear spans must be greater than 1 ft for the program to design the member. This considers half the
depth of the columns or beams framing into the ends of the member.
The program's ability to recognize spans is important because it will give you more relevant span to
span information without overwhelming you with independent design results for each finite element segment that comprises your physical member.
For continuous beam members, the program will evaluate the framing to determine which beams elements are supporting other beam elements so that only supporting members are treated as supports and
not vice versa.
Currently, members of type HBrace, VBrace, and None do not affect the span distances. Nor do any arbitrary joints within each span along a member.
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Concrete Design Parameters - Columns
The Concrete Column tab on the Members Spreadsheet records the design parameters for the code checks of
concrete columns. These parameters may also be assigned graphically. See Modifying Member Design Parameters to
learn how to do this.

The following parameters can be defined for each concrete column.

Label
You may assign a unique Label to all of the members. Each label must be unique, so if you try to enter the same
label more than once you will get an error message. You may relabel at any time with the Relabel options on the
Tools menu.

Shape
The member Shape or Section Set is reported in the second column. This value is listed for reference only and may
not be edited as it is dictated by the entry in the Section/Shape column on the Primary tab.

Length
The member Length is reported in the third column. This value may not be edited as it is dependent on the
member end coordinates listed on the Primary Data tab. It is listed here as a reference for unbraced lengths which
are discussed in the next section.

Unbraced Length
You may specify unbraced lengths or have RISA-3D calculate them for you. The unbraced lengths are Lu-yy and Luzz.
The Lu values, Lu-yy and Lu-zz, represent the unbraced length of column members with respect to column type
buckling about the member's local y and z axes, respectively. These Lu values are used to check the column for
Euler buckling, and for the Moment Magnification Procedure in older editions of the ACI code.
If left blank these unbraced lengths all default to the member's full length.
For physical members, you can enter the code “Segment” in the unbraced length fields and the length of each
segment will be used. A “segment” is the distance between the joints that are on the physical member. For example,
suppose you have a physical member that is 20 feet in length, and there are two joints along the physical member,
one 5 feet from the end and one at 15 feet. An unbraced length of 5 feet will be used for the first segment, then a
value of 10 feet will be used in the middle segment, and again a value of 5 feet would be used in the last segment.

Note
l

l
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When the "segment" code is used, ALL joints on a column will be considered to brace the column for that
type of buckling, even if a joint is associated with a member that would actually only brace the column
against buckling in the other local axis. Therefore, the "segment" code should only be used for columns that
are truly braced in that direction at each interior joint.
The calculated unbraced lengths are listed on the Member Detail report.
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For additional advice on this topic, please see the RISA Tips & Tricks website: www.risa.com/post/support. Type in
Search keywords: Unbraced Lengths.

K Factors (Effective Length Factors)
The K Factors are also referred to as effective length factors. Kyy is for column type buckling about the member's
local y-y axis and Kzz is for buckling about the local z-z axis.
If a value is entered for a K Factor, that value will be used for the entire length of the physical member. If an entry
is not made (left blank), the value will internally default to '1' for that member. See ACI 318-14 Section R6.2.5 (ACI
318-11 Section R10.10.1) for an explanation of how to calculate K Factors.
RISA-3D is able to approximate the K-values for a column based on the member's sway condition and end
release configuration. The K-factor approximation is based on the idealized tables given in the AISC steel
specification. The following table gives the values used for various conditions.

Table Case End Conditions Sidesway? K-Value
(a)
(b)
(c)
(d)
(e)
(f)

Fixed-Fixed
Fixed-Pinned
Fixed-Fixed
Pinned-Pinned
Fixed-Free
Pinned-Fixed

No
No
Yes
No
Yes
Yes

.65
.80
1.2
1.0
2.1
2.0

Note
l

This is an approximation of K-values and is NOT based on the Jackson and Moreland Alignment Charts
presented in ACI 318-14 Section R6.2.5.

RISA-3D will recognize a pinned boundary condition for the K approximation for a full pin, i.e. if all the rotations in
the boundary condition are released. If any of the rotations in a boundary condition are restrained, the boundary
condition is considered “fixed” for the K approximation.
Any configuration not described here will be given the default value of 1.0.
If any value that influences these K values is changed, the K approximation should be redone. For instance, if you
have RISA-3D approximate K-values then change some end release designations, you should redo the K
approximations.
Remember that the K-values are approximations, and you should check to make sure you agree with all K-values
RISA-3D assigns. You can always override a K-value after an approximation by directly entering the value that you
want in the appropriate field. Keep in mind that a subsequent approximation will overwrite any manually input
values so you will need to override the approximation each time it is performed.
Limitation:
RISA-3D will currently neglect the influence of adjoining framing members when those members are connected at a
joint that also has degrees of freedom restrained by boundary conditions. For example, suppose a column and
beam member connect at a joint that is restrained for translation in all directions (I.e. the joint is “pinned”). The K
factor approximation will neglect the beam member when it calculates the K factor for the column and vice versa.
The effect will be that the ends of the members at that joint will be seen as “pinned” and not “fixed” for the K-factor
approximation.

Sway Flags
The Sway Flags indicate whether the member is to be considered subject to sidesway for bending about its local y
and z axes. The y sway field is for y-y axis bending and the z sway field is for z-z axis bending. Click on the field to
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check the box and indicate that the member is subject to sway for that particular direction, or leave the entry blank
if the member is braced against sway. These sway flags influence the calculation of the K Factors as well as the Cm.

Cm – Equivalent Moment Correction Factor
The Cm Coefficients are used to check the column for Euler buckling, and for the Moment Magnification Procedure
in older editions of the ACI code. Cm-yy is for bending about the columns's local y-y axis and Cm-zz is for bending
about the local z-z axis. If these entries are left blank they will be automatically calculated.
In the ACI design code, the Cm values are only applicable for non-sway frames. Therefore, this value will be ignored
if the corresponding sway flag is checked.

Flexural and Shear Rebar Layout
The user may choose to manually create the reinforcement layout for the column. This must be done if the user
wishes to take advantage of bundled bars, multiple layers of reinforcement, or an unequal number of bars per face.
See the section on the Concrete Database and Rebar Layouts for more information. If 'Default' is specified, then the
program will design for an equal number of bars in each face of the rectangular column and may vary that
reinforcing based on ACI minimums, maximums and the moment and shear demand at each section along the span.

Icr Factors (Cracked Moment of Inertia Factors)
The Icr Factor is used to reduce the bending stiffness of concrete columns per ACI 318-14 Table 6.6.3.1.1(a) (ACI
318-11 Section 10.10.4.1). If this entry is left blank, default values of 0.35 for beams and 0.70 for columns will be
used.

Note
l

l

l

The Icr Factor will be ignored if the “Use Cracked Sections” box is not checked on the Concrete tab of
the Model Settings dialog.
The alternative calculations in ACI 318-14 Table 6.6.3.1.1(b) (ACI 318-11 Equations 10-8 and 10-9) are
not considered.
The sustained load reduction of ACI 318-14 Section 6.6.3.1.1 (ACI 318-11 Section 10.10.4.2) is not considered.

Service Level Stiffness
Due to cracking and material non-linearity, modeling the stiffness of concrete members is more complex than it is
for steel or wood members.
For typical applications, ACI 318-14 Section 6.6.3.1 (ACI 318-11 Section 10.10.4) requires that member stiffness be
reduced to account for the cracking that occurs when a member is subjected to ultimate level loads. As described in
the previous section, RISA uses the Icr Factor to account for this stiffness reduction. However, for service level
analysis, the level of cracking will be significantly less. Therefore, the stiffness used in your analysis should be
representative of the reduced loading and reduced cracking. Per the ACI 318-14 Section R6.6.3.2.2 (ACI 318-11
Section R10.10.4.1), the program will account for this increased stiffness by applying a factor of 1.43 to the cracked
section properties for any load combination that has the “Service Load” flag checked on the Design tab of the Load
Combinations Spreadsheet.

Note

Concrete Design Parameters - Beams
The Concrete Beam tab on the Members Spreadsheet records the design parameters for the code checks of
concrete beams. These parameters may also be assigned graphically. See Modifying Member Design Parameters to
learn how to do this.
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The following parameters can be defined for each concrete member.

Label
You may assign a unique Label to all of the members. Each label must be unique, so if you try to enter the same
label more than once you will get an error message. You may relabel at any time with the Relabel options on the
Tools menu.

Shape
The member Shape or Section Set is reported in the second column. This value is listed for reference only and may
not be edited as it is dictated by the entry in the Section/Shape column on the Primary tab.

Length
The member Length is reported in the third column. This value may not be edited as it is dependent on the
member end coordinates listed on the Primary Data tab. It is listed here as a reference only.

Flexural and Shear Rebar Layout
The user may choose to manually create the reinforcement layout for the beam. This must be done if the user
wishes to take advantage of compression steel, or multiple layers of reinforcement. See Concrete Database - Rebar
Layouts for more information. If Use Design Rule is specified, then the program will design for one layer of
reinforcing and may vary that reinforcing based on ACI minimums, maximums, and the moment and shear demand
at each section along the span using the Member Design Rules as the parameters of the reinforcement selection. If
you define your own rebar layout, and compression reinforcement is defined, then the program will consider the
compression reinforcement in the analysis.

Icr Factors (Cracked Moment of Inertia Factors)
The Icr Factor is used to reduce the bending stiffness of concrete beams.
For ACI and Canadian codes (ACI 318-14 Section 6.6.3.1 and A23.3-04 section 9.2.1.2), if this entry is left blank, the
Icr factor will default to a value of 0.35 for beams and 0.70 for columns.
For Australian and New Zealand codes (per section 6.6.2 of AS3600-2001), this will default to a value of 0.4 for
beams and 0.8 for columns.
For Indian and Saudi codes, this entry will default to a value of 1.0 for beams and columns.

Note
l

The Icr Factor will be ignored if the “Use Cracked Stiffness” box is not checked on the Concrete tab of
the Model Settings dialog.

Service Level Stiffness
Due to cracking and material non-linearity, modeling the stiffness of concrete members is more complex than it is
for steel or wood members.
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For typical applications, ACI 318-14 Section 6.6.3.1 (ACI 318-11 Section 10.10.4) requires that member stiffness be
reduced to account for the cracking that occurs when a member is subjected to ultimate level loads. As described in
the previous section, RISA uses the Icr Factor to account for this stiffness reduction. However, for service level
analysis, the level of cracking will be significantly less. Therefore, the stiffness used in your analysis should be
representative of the reduced loading and reduced cracking. Per ACI 318-14 Section R6.6.3.1.1 (ACI 318-11 Section
R10.10.4.1), the program will account for this increased stiffness by applying a factor of 1.43 to the cracked section
properties for any load combination that has the “Service Load” flag checked on the Design tab of the Load
Combinations Spreadsheet.

Note

T-beam & L-beam Sections
T-beams and L-beams may be specified by assigning effective slab widths and slab thicknesses for the left and
right side of the beam on the Concrete Beam tab of the Members Spreadsheet. These modifications may also be
made graphically via the Modify Properties tab of the Draw Members tool.

RISA-3D will automatically trim the effective slab widths, B-eff Left and B-eff Right, to the maximum values
indicated in ACI 318-14 Table 6.3.2.1 (ACI 318-11 Sections 8.12.2(a) and 8.12.3(a) & (b)) if the value entered by the
user is greater than that allowed by the code. It should be noted that RISA-3D does not check ACI 318-14 Table
6.3.2.1 portions referring to adjacent framing (ACI 318-11 Sections 8.12.2(b) and 8.12.3(c)) because no adjacent
framing checks are performed.
If the values of either B-eff Left or B-eff Right are left blank, a value of zero will be assumed, indicating no
additional slab width beyond 1/2 the beam width on that side.

Note:
l

B-eff Right corresponds to the positive local z-axis of the beam. Subsequently, B-eff Left corresponds to
the negative local z-axis.

Parabolic vs. Rectangular Stress Blocks
You can specify whether you want your concrete design to be performed with a rectangular stress block, or with a
more accurate parabolic stress block. While most hand calculations are performed using a rectangular stress block,
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the parabolic stress block is more accurate. In fact, most of the PCA design aids are based upon the parabolic stress
distribution. A good reference on the parabolic stress block is the PCA Notes on ACI 318-99.

Biaxial Bending of Columns
You can specify whether you want your column design to be performed by using Exact Integration, or by using the
PCA Load Contour Method. While most hand calculations are performed using the Load Contour Method, this
method is merely an approximation based on the uniaxial failure conditions and the Parme Beta factor. In contrast,
the Exact Integration method uses the true biaxial strain state to design the member. A good reference on the Load
Contour Method is chapter 12 of the PCA Notes on ACI 318-99.
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British Eurocode Design Parameters (BS EN 1992-1-1: 2004)
General
l
l
l
l
l
l

f’ck – Can not be more than 50 MPa (7252 psi) for normal strength concrete
αcc is assumed to be 1 (recommended value) : See 3.1.6
Effective length of T and L: Lo=.7*span length and beff,i =Lo/10
φconcrete = 1.5
φrebar = 1.15
Maximum bar spacing for beams = 300 mm

Tension Development Length
l

αct= 1 (assumed in Eq 3.16)

l

η1= η2=1 (assumed in Eq 8.2 to calculate bond stress)

l

λ3, λ5, λ4=1 (assumed in Eq 8.4)

l

Cd in Table 8.2 assumed to be 1 bar diameter rebar spacing

l

Development length when hooks are provided uses same assumptions as BS 8110-1: 1997

Shear Capacity of Concrete
To compute the shear capacity of concrete the following recommended values are being used:
l

CRd,c =0.18/γc for Eq 6.2.a

l

vmin =0.035 k3/2 fck1/2

l

ν =.6*[1- fck /250]

l

Vmax is calculated from Eq. 6.5.

l

θ is assumed 45 degrees in Eq 6.8.

Slender Column Design
l

Biaxial column design done using Eq. 5.39

l

Design based on nominal curvature
λlim = 20 A B C/n1/2 (A=.7, B= 1.1, C=0.7 for unbraced)

l

l

Kϕ =1 in Eq 5.34; the effect of creep is neglected.

Limitations - General
Torsion – Beams and columns ignore torsion with respect to the design of shear reinforcement. A message is
shown in the detail report to remind you of this. You can turn the warning messages off on the Concrete tab of the
Model Settings Dialog. However, when using the 2002 and newer ACI 318 code the program does check the
torsion on the member against the Threshold Torsion value (see ACI 318-14 Section 22.7.4.1 and ACI 318-11
Section 11.5.1). A warning is produced, implying that the shear reinforcement will have to be designed by the
engineer for torsion.
Creep / Long Term Deflections – No considerations are taken in the analysis to account for the effects of creep or
long term deflections.
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Beam Design – Beams are not designed for weak axis y-y bending, weak axis shear, or axial forces. A message is
shown in the detail report to remind you of this. You can turn the warning messages off on the Concrete tab of the
Model Settings Dialog. Beams currently do not consider any compression steel in the calculation of the moment
capacity. Beam "skin reinforcement" per the requirements of ACI 318-14 Section 9.7.2.3 (ACI 318-11 Section) 10.6.7
for beams with "d" greater than 36" is currently not specified by the program. The provisions in ACI 318-14 Section
9.9 (ACI 318-11 Section 10.7) for deep beams are not considered.
Column Design – Columns with biaxial moment and no axial load will currently be designed using the PCA Load
Contour Method even if Exact Integration is selected on the Model Settings dialog. This is shown on the detail
report.

Limitations - ACI
Shear Design –When ACI 318-19 is selected, the shear strength of concrete (Vc) uses equations in Table 22.5.5.1.
Note that for members meeting the minimum shear reinforcement requirement (Av≥Av,min), Vc is taken as the
larger of the results calculated by the equations (a) and (b) in the table. ACI 318-19 code suggests ρw may be taken
as the sum of the areas of longitudinal bars located more than two-thirds of the overall member depth away from
the extreme compression ﬁber. Therefore, RISA calculates ρw as the sum of the areas of longitudinal bars on the
tension face.
When other ACI 318 editions are selected, the shear strength of the concrete alone is limited to the standard
2*λ*sqrt (f'c) equation from ACI 318-14 Section 22.5.5.1 (ACI 318-11 Section 11.2.1.1) and does not use the more
detailed calculations of ACI 318-14 Table 22.5.5.1 (ACI 318-11 Section 11.2.2). Also, note that for members with
significant axial tension (greater than 0) the program designs the shear reinforcement to carry the total shear per
ACI 318-14 Section R22.5.7.1 (ACI 318-11 Section 11.2.1.3).
Deep Beam Design – The program does not design deep beams as defined in ACI 318-14 Section 9.9.1.1(a) (ACI
318-11 Section 10.7).
Threshold Torsion - The program does not adjust the threshold torsion value for the presence of axial force in a
beam, though it does do this for columns.

Limitations - Canadian Code
Concrete Stress Profile – Concrete stress strain curve (parabolic) is assumed same as PCA method for the
Canadian codes.
Bi-Axial Bending - The program uses the simplified uniaxial solution provided in the Canadian specification rather
than performing a complete biaxial condition.
Mid-Depth Flexural Strain for Shear Design - The program uses the code equation (per the General Method) to
calculate exwith the moment and shear at the section taken from the envelope diagrams. The maximum ex for each
span is conservatively assumed for the entire span. Currently the program has no option for pre-stressing, so Vp
and Ap are both taken as zero.
Shear Design - The shear strength of concrete is calculated using β and θ, which are both calculated per the
General Method (Clause 11.3.6.4 from the 2004 CSA A23.3). Sze is calculated per equation 11-10 and ag is always
assumed to equal 20 mm (maximum aggregate size).

Limitations - Australian and New Zealand Codes
Concrete Stress Profile – Concrete stress strain curve (parabolic) is assumed same as ACI for the New Zealand
and Australian codes.
Neutral Axis Parameter – Ku in AS code is always assumed to be less than 0.4.
Rebar Spacing – NZS and AS codes: max spacing of rebar (beam) is 300 mm and minimum spacing is one bar
diameter or 25mm whichever is bigger.
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Shear Strength in Beams – In AS code, when calculating the shear strength of a beam β2, β3 are always assumed
to be unity. This is always conservative for beams will little axial load, or beams in compression. But, may be
unconservative for members subjected to significant net tension.
Bi-Axial Bending – The New Zealand code does not appear to give a simplified method for solving biaxial column
design. Therefore, the PCA load contour method is being used instead.
Shear Tie Spacing – Column/beam shear tie spacing is based on (a) and (c) of NZS 9.3.5.4 :1995.
Development Length – Development length in NZS is based on NZS 7.3.7.2 where αa is conservative assumed to be
1.3 (top bars) for all cases. For the AS code, it is assumed that K1=1 and K2=2.4 in clause 13.1.2.1 of AS 3600:2001.
Slender Column Calculations – EI is assumed to be equal to 0.25EcIg (with βd =0.6) in slender column
calculations in AS and NZS codes (like in ACI).

Limitations - British
Concrete Stress Profile – Concrete stress strain curve (parabolic) is taken from the British specification.
Cracked Sections – Icracked defaults to 1.0 for the British code. But, a user entered value may be entered if
desired. Service level stiffness is assumed to be 1.43 times the strength stiffness, but is not allowed to exceed Igross.
Bi-Axial Bending – The program uses the simplified uniaxial solution provided in the British specification rather
than performing a complete biaxial condition.

Limitations - Euro
Concrete Stress Profile – Concrete stress strain curve (parabolic) is taken from the EuroCode specification.
Cracked Sections – Icracked defaults to 1.0 for EuroCode. But, a user entered value may be entered if desired.
Service level stiffness is assumed to be 1.43 times the strength stiffness, but is not allowed to exceed Igross.
Bi-Axial Bending – The program uses the simplified uniaxial solution provided in the EuroCode rather than
performing a complete biaxial condition.

Limitations - Indian
Concrete Stress Profile – Concrete stress strain curve (parabolic) is taken from the Indian specification.
Cracked Sections – Icracked defaults to 1.0 for the Indian code. But, a user entered value may be entered if
desired. Service level stiffness is assumed to be 1.43 times the strength stiffness, but is not allowed to exceed Igross.
Bi-Axial Bending – The program uses the simplified uniaxial solution provided in the Indian specification rather
than performing a complete biaxial condition.

Limitations - Saudi Code
Concrete Stress Profile – Concrete stress strain curve (parabolic) is assumed to be the same as the ACI code.
Shear Strength– The shear strength is based on 11.3.1.1 and does not include the more detailed provisions of
section 11.3.1.2.
Yield Strength of Shear Ties - The yield strength of shear ties is not allowed to exceed 420MPa.
Shear Tie Spacing - Minimum spacing of shear ties is set to 50mm
Bi-Axial Bending – Both the Exact Integration and the PCA Load Contour methods for bi-axial bending are
supported in the Saudi code.
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Special Messages
In some instances code checks are not performed for a particular member. A message is usually shown in the
Warning Log and Detail Report explaining why the code check was not done. There are also instances where a
code check is performed, but the results may be suspect as a provision of the design code was violated. In these
cases, results are provided so that they can be examined to find the cause of the problem. Following are the
messages that may be seen.

No Load Combinations for Concrete Design have been run.
None of the load combinations that were run had the Concrete Design box checked on the Design tab of the Load
Combinations Spreadsheet. Since there are no concrete design specific load combinations, there are no results or
force diagrams to show.

Warning: No design for spans with less than 5 sections.
Certain very short spans in physical members can end up with less than 5 design sections. No design is attempted
without at least 5 sections because maximum values may be missed and an un-conservative design may result.

Warning: No design for spans less than 1 ft.
Certain very short spans in physical members can end up with lengths less than 1 foot. No design is attempted for
these sections.

Warning: Member is slender and can sway, but P-Delta Analysis was NOT run.
Under older ACI codes slender sway members need to be run with the P-Delta option turned on to account for
secondary forces and moments. In some situations, a preliminary design without P-Delta is useful and so a design is
performed and this warning is shown to remind you to run the final analysis including P-Delta effects. Alternately, if
you’re using the redesign feature, the next suggested column may resolve this issue if it’s not slender.

Warning: Slender Compression Failure (Pu > .75Pc). No Slender calculations done.
Since RISA-3D allows you to specify a starting column size, it’s possible that for slender columns under substantial
axial load you'll exceed the critical buckling load used in the slenderness equations in ACI 318-14 Section 6.6.4.5.2
(ACI 318-11 Section 10.10.6). Design results are still shown so the suggested shapes can be used to pick a new
suggested column size that will not have this problem. Note that the design results shown are NOT valued because
the slender moment effects have NOT been considered.

Warning: KL/r > 100 for this compression member. See ACI 318-05 Section 10.11.5
Members that violate the KL/r limit still have design results calculated and shown. If you’re using the redesign
feature, the next suggested shape should resolve this problem. Note this is only checked for the 2005 code and
older. Newer codes require a P-Delta analysis and omit this consideration.

Warning: Exact Integration selected but PCA method used
This message is shown when you've requested the Exact Integration option on the Model Settings Dialog, but we
weren't able to converge a solution for the column in question. When Exact Integration does not converge, the PCA
Method is used instead to give an idea of the demand vs. the capacity.

Warning: PCA Method Failed. Axial Load > Axial Capacity.
One of the limitations of the PCA Method is that it requires the column being checked to have a greater axial
capacity than the axial demand. Since RISA-3D allows you to set a starting size, it’s possible that the demand may be
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greater than the capacity. In this case a very rough estimate of the capacity is calculated by using the independent
moment capacity about each axis considering the axial load. The resulting code check value is then based on the
combined demand vector over the combined capacity vector and will always be greater than 1.0. The purpose of the
results in this case is to show the column failed, not to give an accurate estimate of the over-demand. The redesign
feature will suggest a larger shape to resolve this issue.

Warning: The shear tie spacing does not meet the code Minimum Requirement
This warning is stating that either minimum spacing or strength requirements are not being met for the shear
reinforcement in the concrete member.

P-Delta analysis required for all ACI 318-14/11/08 Load Combinations
A second order analysis is required as of the 2014, 2011 and 2008 editions of the ACI 318 code. A code check will
only be given if P-Delta is turned on in the Load Combinations spreadsheet, or if this requirement is intentionally
waived in the Application Settings.
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Access the Code Check spreadsheet by selecting the Results tab Envelope (or LC) button Code Check.
Alternatively, on the Results toolbar you can select Code Check. Unlike wood and steel, concrete results are
different for beams and columns so they each get their own results spreadsheet. Note also that concrete results are
always based on envelope results, even if you've run a batch solution.
For beam flexural design, the required bars are based on the envelope moment diagrams. For column flexural
design, the required bars for each load combination are calculated at various sections for the moments and axial
forces at those sections. The required bars for all load combinations are then enveloped. For both beam and column
shear steel design, the required bars are based on the enveloped shear force diagrams.

Beam Results
Beam results are shown in the three following spreadsheets: Design Results, Beam Bending Reinforcement, and
Beam Shear Reinforcement.

Design Results Spreadsheet
The Design Results Spreadsheet shows the governing maximum code check for the top and bottom of the beam
for all spans.

These top and bottom code checks, UC Max Top and UC Max Bot, are based on the top/bottom moment capacities
and maximum top/bottom moment. Currently the moment capacity is based only on the tension steel (NO
compression steel is considered in the capacity calculation). The governing maximum shear check for all spans,
Shear UC, is also shown. The capacities shown are only for the governing section. Capacities for each span, as well
as beam reinforcement detailing diagrams, may be viewed on the Detail Report.

Beam Bending Reinforcement Spreadsheet
The Beam Bending Reinforcement Spreadsheet records the top and bottom flexural reinforcement steel required
for the left, middle, and right locations of each beam. This spreadsheet may be accessed by selecting Members
Concrete Reinforcing on the Results Menu and the results are listed on the Beam Bending tab.
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The Member column lists the beam label.
The Shape column displays the beam size. When no adequate member could be found from the available shapes
list, this field will display the text "not designed". Consider re-framing, relaxing the design requirements (see Design
Optimization), or adding more shapes to the available Redesign List (see Appendix A – Redesign Lists).
The Span column displays the span number corresponding to the reinforcement sections listed. Span '1' is the span
beginning at the "start" of the beam and subsequent spans are numbered '2', '3', '4', and so forth moving from the
"start" to the "end" of the beam.
The program assumes that the moment diagrams for all beam spans have two or fewer points of inflection.
Therefore, each span is broken into Left, Middle, and Right Reinforcement Sections for flexural steel layout. Each
section is further broken into Top and Bottom Reinforcement Sections. Note that a beam may have only two or
even one reinforcement section. In this case, the other reinforcement sections would be left blank in this
spreadsheet.
The Left Top, Left Bot, Mid Top, Mid Bot, Right Top, and Right Bot entries record the number and size of flexural
reinforcement bars that are required in each of the six Reinforcement Sections. The first number indicates the
number of parallel reinforcement bars in that section. The second number, preceded by the '#' sign, indicates the
size of reinforcement bars used.

Note
l

l

l

Only reinforcement bars selected by the program are listed in this spreadsheet. If a custom rebar layout
is used for a particular beam, all six reinforcement section entries will report "CUSTOM" as a reminder
that the user applied a custom rebar layout.
Longitudinal reinforcement bars are assumed to be in a single layer at the top and/or bottom of the
member.
Longitudinal reinforcement bars for the left and right sides of adjacent spans have been "smoothed" such
that the larger steel area is used for both sides.

Beam Shear Reinforcement Spreadsheet
The Beam Shear Reinforcement Spreadsheet records the shear reinforcement ties required in each shear region
of each beam. This spreadsheet may be accessed by selecting Members Concrete Reinforcing on the Results
Menu and the results are listed on the Beam Shear tab.
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The Member column lists the beam label.
The Span column displays the span number corresponding to the shear regions listed. Span '1' is the span
beginning at the "start" of the beam and subsequent spans are numbered '2', '3', '4', and so forth moving from the
"start" to the "end" of the beam.
Each beam's shear reinforcement layout is broken into either two or four Shear Reinforcement Regions. The user
can control whether the program uses '2' or '4' regions from the Concrete tab of the Model Settings Dialog. The
program will try to group the required shear ties/stirrups into two or four regions and will allow for a middle
region to have no shear reinforcement if the shear force is lower than that for which the code requires shear
reinforcement.
The Region 1, Region 2, Region 3, and Region 4 entries record the number, size, and spacing of shear
reinforcement ties/stirrups that are required in each of the Reinforcement Regions. The first number of each
entry indicates the total number of ties/stirrups that are required in that region of the beam span. The second
number, proceeded by the '#' sign, indicates the size of reinforcement bars used. The third number, proceeded by
the "@" symbol, indicates the spacing of the ties/stirrups in that region of the beam span.

Note
l

l

If '2' shear regions are selected on the Concrete tab of the Model Settings Dialog, the Region 2 and
Region 3 entries in this spreadsheet will be left blank.
The concrete code checks are only performed at the sections where the internal forces are
calculated. The number of internal force calculations is based on the setting in the Model Settings
dialog. Normally, this is acceptable for design and analysis. However, it is possible for the design locations (face of support for moment and "d" from the face of support for shear) to be located far enough
away from the nearest internal force location that it could affect the code check results. If this happens, it
may be advisable to use a larger number of internal sections. Or, the user may be forced to calculate the
maximum Vu and Mu themselves.

Column Results
Column results are shown in the three following spreadsheets: Design Results,Column Bending Reinforcement,
and Column Shear Reinforcement.

Design Results Spreadsheet
The Design Results Spreadsheet shows the governing maximum code check for the column for all spans.
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The governing maximum shear check for all spans is also shown. The governing load combination for the governing
code check is shown because the column capacity is based upon the actual moments and axial forces for that load
combination. The capacities shown are only for the governing section. Capacities for each span, as well as column
reinforcement detailing diagrams, may be viewed on the Detail Report.
The moving load results are enveloped and the governing load combination and step location is shown for each
result value under the "UC LC" column. The first number is the load combination, the second is the step number:
(load combination - step number). See Moving Loads to learn more.

Column Bending Reinforcement Spreadsheet
The Column Bending Reinforcement Spreadsheet shows the perimeter flexural reinforcement steel required in
each span of each column. This spreadsheet may be accessed by selecting Members Concrete Reinforcing on
the Results Menu and the results are listed on the Column Bending tab.

The Column field displays the column label.
The Shape column displays the physical column or lift size. When no adequate member could be found from the
available shapes, this field will display the text “not designed”. Consider re-framing, relaxing the design or deflection
requirements (see Design Optimization), or adding more shapes to the available Redesign List (see Appendix A –
Redesign Lists).
The Span column displays the span number corresponding to the perimeter reinforcement listed. Span '1' is the
span beginning at the "start" of the column and subsequent spans are numbered '2', '3', '4', and so forth moving
from the "start" to the "end" of the column.
The Perim Bars column records the number and size of perimeter longitudinal reinforcing bars. The first number
indicates the total number of longitudinal bars in that span. The second number, preceded by the '#' sign, indicates
the size of the reinforcement bars used.

Note
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l

l

l
l

Only reinforcement bars selected by the program are listed in this spreadsheet. If a custom rebar layout
is used for a particular column, the Perim Bars entry will be left blank.
Longitudinal reinforcement bars are assumed to be uniformly arranged around the perimeter of the
column for both rectangular and round column sections.
A minimum of 6 bars will be used in round column sections.
Longitudinal reinforcement bars for the bottom and top sides of adjacent spans have been "smoothed"
such that the larger steel area is used for both sides.

Column Shear Reinforcement Spreadsheet
The Column Shear Reinforcement Spreadsheet shows the shear reinforcement ties required in each shear region
of each column. This spreadsheet may be accessed by selecting Members Concrete Reinforcing on the Results
Menu and the results are listed on the Column Shear tab.

The Column field displays the column label.
The Span column displays the span number corresponding to the shear regions listed. Span '1' is the span
beginning at the "start" of the column and subsequent spans are numbered '2', '3', '4', and so forth moving from the
"start" to the "end" of the column.
Each column's shear reinforcement layout is broken into either two or four Shear Reinforcement Regions. The
user can control whether the program uses '2' or '4' regions from the Concrete tab of the Model Settings dialog.
The program will try to group the required shear ties into 2 or 4 regions. Unlike beams, columns cannot have a zero
shear steel region. Note also that columns in tension receive NO shear capacity from the concrete.
The Region 1, Region 2, Region 3, and Region 4 entries record the number, size, and spacing of shear
reinforcement ties/stirrups that are required in each of the Reinforcement Regions. The first number of each
entry indicates the total number of ties/stirrups that are required in that region of the column span. The second
number, proceeded by the '#' sign, indicates the size of reinforcement bars used. The third number, proceeded by
the "@" symbol, indicates the spacing of the ties/stirrups in that region of the column span.

Note
l

If '2' shear regions are selected on the Concrete tab of the Model Settings dialog, the Region 2 and Region
3 entries in this spreadsheet will be left blank.

Concrete Detail Reports
The Concrete Detail Reports allow you to see the overall force, stress, and deflection state for any particular
member. Detail reports for concrete members are not based on individual load combinations as they are for steel or
wood members. Instead, they are based on an envelope of the solved load combinations. Concrete columns are the
exception to this in that the columns are solved for all load combinations and then the resulting required steel is
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enveloped. The detail reports for concrete Column member types are also different than those for concrete Beam
member types in terms of the design information that is shown below the force diagrams.
Detail reports for concrete members can, and often do, go more than one page in length due to the large amount of
information that must be displayed for concrete design. One reason for this is that RISA figures out the number of
spans for concrete beams and columns based on the number of internal supports, thus one physical member may
have several spans that all must be reported.

Note:
l

- This button will allow you to take a snapshot of the current detail report you are viewing so that it can
be added to a report. View the Printing topic for more information.

Beam Detail Reports
The image below is the first portion of a detail report for a concrete beam member showing the member
information, warnings, force diagrams, code checks, and span information.

You can tell the Member Type by looking at the black title in the upper left corner next to the red member label.
This title will always show the member type (Beam, Column, HBrace, VBrace). If the member type is 'None', this
title will be displayed as 'Member'.
The Member Information in the text above the force diagrams shows basic member information as well as the
Concrete Stress Block type used in the solution, whether Cracked Sections were used for the nominal design, and
the Cracked 'I' Factor that was used for that member.
The next section of the detail report contains the Member Force Diagrams. The diagrams shown are envelope
diagrams of all solved load combinations. Any Unused Force Warnings or critical Design Warnings will be shown
directly below the force diagrams in the detail report.
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Each enlarged diagram will also have a slider bar at the bottom of the window for checking forces at all locations
along the member. There is also an Abs Max button that will jump the slider bar to the absolute maximum value in
the diagram. Note that once an enlarged diagram is opened, diagrams for other forces may be accessed via the pull
down menu on the left.
The Code Check Information directly below the force diagrams is a summary of the governing checks for bending
and shear, their location, and the section capacities at those locations. Separate bending checks for the most critical
top and most critical bottom condition are given. Gov Muz Top and Gov Muz Bot represent the governing ultimate
moment in the top and bottom of the beam respectively. Gov Vuy represents the governing ultimate shear along the
local y axis of the beam.
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The values phi*Mnz Top and phi*Mnz Bot represent the nominal moment strength in the top and bottom of the
beam respectively, reduced by the appropriate Strength Reduction Factor, Phi, as indicated in the code. Likewise,
the value phi*Vuy represents the nominal shear strength in the beam, reduced by the appropriate Phi Factor.
There is also general concrete, reinforcement, and bar cover information about the section provided which you
would need if you were doing a hand check. Concrete Type (Normal Weight vs Light Weight) is automatically
determined from the Concrete Weight density per the ACI code. λ is taken from the Materials spreadsheet. The E_
Concrete value shown here is either the value entered on theConcrete tab of the Materials Spreadsheet or is the
calculated value based on the given f’c and weight density (if the 'E' value was left blank on the Materials
Spreadsheet).
The Span Information gives the start and end of each span centerline within the member, as well as the distance
from the column centerline to the face of the column for each end of the span.
The next portion of the detail report shown below contains detailed information for the placement of the Bending
Steel and the Bending Span Results for each span. The bending capacity for the governing section in each span is
shown as Mnz, the nominal moment strength. Rho Min and Rho Max are the minimum and maximum required
reinforcement ratios at each location. These values are based on the minimum and maximum reinforcing
requirements for flexural members as described in ACI 318-14 Sections 9.6.1 and 21.2.2/9.3.3.1 respectively (ACI
318-11 Sections 10.5.1 and 10.3.3/10.3.5 respectively). Rho is the ratio of reinforcement corresponding to the area
of steel provided at each location, As Prvd. The As Req value is the area of steel required at each location.
Note:
l

Per ACI 318-14 Section 9.6.1 (ACI 318-11 Section 10.5.3), the reinforcement ratio (ρ) chosen by the program
can be less than ρmin when As Provided exceeds As Required by more than 33%

The next portion of the detail report, shown above, contains detailed information for the placement of the Shear
Steel and the Shear Span Results for each span. Shear results are shown by region within each span. The number
of regions used is a function of the shear diagram, with the maximum number of regions being taken from the
Shear Regions setting on the Concrete tab of the Model Settings Dialog. The number, size, and spacing of
reinforcing bars is given for each region. Also indicated is the nominal shear strength, Vn, in each region. The
portion of the nominal shear strength provided by the concrete and the steel, Vc and Vs respectively, is given for
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each region. The area of steel required, As Reqd, and the area of steel provided, As Prvd, are also given for each
shear region and are reported as 'area of steel per unit dimension', i.e. in2/in or mm2/mm.
It should be noted that the values for Mn and Vn given in this section of the detail report are the UNREDUCED
nominal capacities of the member at each span/region. The actual design capacities would be obtained by
multiplying these values by their respective Phi Factors indicated in the code.
The last section of the detail report shows the Beam Reinforcement Detailing Diagrams. The Rebar Detailing
portion of the report shows elevation views of the beam complete with top and bottom flexural reinforcement
indicated for the left, middle, and right portions of each span. The number and size of bars required in each section
is indicated on the top middle of each drawn bar. The required length of each bar is indicated on the bottom middle
of each drawn bar in parenthesis. Development lengths are shown in parenthesis at one end of each bar and is
represented by a dashed line. For bars at the ends of the beam, hook lengths are given in addition to the
development lengths and are shown in brackets.
Note:
l

Development lengths are calculated per ACI 318-14 Sections 25.4.2 and 25.4.3 (ACI 318-11 Sections 12.2.2
and 12.5.2. No additional factors are used, aside from the lightweight modification factor.

The values shown at the bottom corner of each span indicate the distance from the start of the beam to the face of a
support. Flexural bars at the ends of the beam are measured beginning at the face of the support and bars at
intermediate supports are measured to the center of the support.
The number, size, and spacing of shear reinforcement is also indicated below each span in the corresponding shear
region. Each shear region is indicated by vertical lines at the bottom of the beam.
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The Cross Section Detailing portion of the report shows cross sectional views for the start, middle, and end of
each beam span. The number and size of flexural bars for each cross section are shown as well as the orientation of
the shear ties/stirrups. The clear cover to each stirrup for the top and sides is shown. The overall beam dimensions
for each span are indicated on the 'Start' cross section.

Column Detail Reports
The image below is the first portion of a detail report for a concrete column member showing the member
information, warnings, force diagrams, code checks, and span information. As can be seen, the concrete column
results are very similar to the beam results with just a few additions and differences.
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You can tell the Member Type by looking at the black title in the upper left corner next to the red member label.
This title will always show the member type (Beam, Column, HBrace, VBrace). If the member type is "None", this
title will be displayed as "Member".
The Member Information in the text above the force diagrams shows basic member information as well as the
Concrete Stress Block type used in the solution, whether Cracked Sections were used for the nominal design, and
the Cracked 'I' Factor that was used for that member. The Biaxial Bending Solution method that was used is also
reported, and if applicable, the Parme Beta Factor.
The next section of the detail report contains the Member Force Diagrams. The diagrams shown are envelope
diagrams of all solved load combinations. Any Unused Force Warnings or critical Design Warnings will be shown
directly below the force diagrams in the detail report. An enlarged interactive member force diagram can be
accessed by clicking on the desired diagram. For more information, see Beam Detail Reports.
The Code Check Information below the force diagrams is a summary of the governing checks for bending and
shear, their location, and the section capacities at those locations. Gov Pu represents the governing ultimate axial
load in the column. Gov Muy and Muz represent the governing ultimate moment about each local axis of the
column. Gov Vuy and Vuz represent the governing ultimate shear along each local axis of the column.
There is also general concrete, reinforcement, and bar cover information about the section provided which are
useful for hand calculation verification.Concrete Type (Normal Weight vs Light Weight) is automatically
determined from the Concrete Weight density per the ACI code. The E_Concrete value shown here is either the
value entered on the Concrete tab of the Materials Spreadsheet or is the calculated value based on the given f’c
and weight density (if the 'E' value was left blank on the Materials Spreadsheet).
Note:
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l

When solving using the PCA Load Contour method, Pu will always equal Pn. This represents the axial value at
which the controlling slice of interaction diagram was taken. The bending check is taken as the following
equation, which is derived from the PCA Notes on ACI 318-99, Chapter 12.

l

When solving using the Exact Integration method, a worst-case combination of Pu, Muy, and Muz is determined. A straight line is essentially drawn between the origin of the interaction diagram, and this coordinate
within the 3D interaction diagram. The bending check is taken as the length of that line, divided by the distance from the origin to the intersection of that line and the interaction diagram. For this reason the ratios
(Pu/φPn), (Mu/φMn) are all equal to the bending check.
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The next portions of the detail report shown above contain the Column Interaction Diagrams for the column
member and the Span Information.
A Column Interaction Diagram for uniaxial bending is shown for each axis of the column. These diagrams plot the
unreduced nominal strengths P vs. M for the corresponding column local axis. If the column only has bending about
one axis there will be only one interaction diagram shown.
For columns under biaxial bending there is also a diagram which plots the unreduced nominal moments strengths
Mz vs. My at the governing ultimate axial load, P. The last diagram is for the biaxial bending condition where the
exact integration method is used and shows the interaction surface plotted at the angle of applied load (Pu, Muy,
Muz). This last diagram is only shown when the Exact Integration Method is used.
The Span Information section shows the length of each span and the distances from the centerline of each support
to the face of each support.
This portion of the report shown above contains the sections pertaining to the axial, bending, and shear results as
well as the longitudinal and shear reinforcement.
The Column Steel section indicates the longitudinal reinforcement in each span as well as the governing load
combination and location. The ultimate axial load, Pu, and the ultimate moments, Muy and Muz, are also given for
each span.
The Axial Span Results show the strength reduction factor, Phi_eff, used for each span. The axial capacities for
each span are shown as Pn, the nominal axial strength, and Po, the nominal axial strength with zero
eccentricity. The area of longitudinal reinforcement provided in the column is listed as As Prvd and the ratio of As
Prvd to the gross cross sectional area of the column is listed as Rho Gross.
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The Bending Span Results show the calculated eccentricities, ecc. y and ecc. z, due to the ultimate moment about
each axis divided by the ultimate axial load. The neutral axis depth for bending about the local y-axis and z-axis are
listed as NA y-y and NA z-z respectively. These neutral axis locations are always given with respect to the
geometric center of the column. Also shown in this section are the unreduced nominal moment capacities, Mny and
Mnz, for each span of the column. If the PCA Load Contour Method is used, Mnoy and Mnoz are given,
representing the maximum allowable moment for uniaxial bending at the nominal axial strength, Pn (see Biaxial
Bending of Columns). If the Exact Integration Method is used, these values will be left blank.
The Shear Steel section of the report shows each span of the column broken into one or more shear regions and
the number, size, and spacing of shear stirrups required in each of those regions is given. The shear design for
columns is the envelope of all the shears for both directions.
The y-Dir and z-Dir Shear Span Results show the nominal shear strength, Vny and Vnz, in each shear region of
the column followed by the nominal shear strengths of the concrete, Vcy and Vcz, and the nominal shear strengths
of the steel, Vsy and Vsz. The area of shear reinforcement required in each shear region of the column is shown as
Asy Reqd and Asz Reqd. The area of shear reinforcement provided in each shear region of the column is shown as
As Prvd. Shear demand and concrete capacity are shown for both directions, but only one design of shear ties is
used. Thus the As_reqd may vary for each side, but the As_prvd will always be the same.
Note:
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l

ACI 318-19 requires the consideration of shear interaction in y and z directions when both Vuy/φVny and
Vuz/φVnz are larger than 0.5. In this case, the program recalculates the shear UC based on Equation
22.5.1.11. If the UC considering shear interaction happens to govern, a new section is added in Detail Report
to present this check:

l

In the Code Check spreadsheet the direction (Dir) becomes “y,z” to indicate the governing load combination
is considering shear interaction.
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Magnified Moments / Slenderness Effects

The Slender Bending Span Results give the ultimate moments for each axis amplified for the effects of member
curvature, Mcy and Mcz. These values will be left blank for spans that do not meet the criteria for slender columns
in the specific direction. Also shown in this section are the values KL/r for the y and z-axis, followed by the
equivalent moment correction factors Cm yy and Cm zz. The unbraced lengths of the column for each span and
each direction, Lu yy and Lu zz, are given as well.
For Non-Sway frames, the assumption is that EI = 0.25*Ec*Ig. This is equivalent to setting Bdns to 0.6 in ACI 318-14
Equation 6.6.4.4.4c (ACI 318-11 Equation 10-15). For sway frame columns with a KL/r value greater than 22, the
moment amplification is applied to the total moment rather than the "non-sway" portion of the moment.
Warning Log Messages will be produced when the following occurs:
l

l

If the KL/r for the column exceeds 100 per Section 10.11.5 of ACI 318-05. Note this message only occurs for
2005 and older codes.
If a slender member is classified as being part of a Sway frame, but a P-Delta analysis was NOT performed.
For sway frames this P-Delta requirement applies anytime the slenderness ratio KL/r exceeds 22.
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RISAConnection Integration
RISAConnection can be used with RISAFloor and/or RISA-3D to design hot-rolled steel connections. The integration
will send the member geometry, loads, and connection type information into RISAConnection. You can then open
RISAConnection to edit/adjust the details of the connection. When satisfied with an appropriate connection design,
you can then send the connection design results back into RISAFloor and RISA-3D for results presentation.

Available Connection Types
The list of available connection types depends on what version of RISAConnection you are integrating with. The list
below represents the available connection options from the current version of RISAConnection:
l

l

l

l

l

l

l

l

l

l

l

Beam to Column Shear Connections (shear tab, clip angle, end plate).
l Columns may be Wide Flanges, HSS tubes, or HSS pipes (shear tab only).
l Beams may be Wide Flanges or Channels (not for end plate).
l Double-sided connections available for clip angle shear connections into the column web.
Beam to Girder Shear Connections (shear tab, clip angle, end plate).
l Girders may only be Wide Flanges.
l Beams may be Wide Flanges or Channels (not for end plate).
l Double-sided connections available for clip angle shear connections into the girder web.
Shear Splices (beam and column).
l Columns may only be Wide Flanges.
l Beams may only be Wide Flanges.
Beam to Column Flange Moment Connections (direct weld, extended end plate, flange plates, flush end
plate).
l Direct Weld and Flange Plate moment connection columns may be Wide Flanges or HSS Rectangular
Tubes.
l Extended End Plate and Flush Plate moment connection columns may only be Wide Flanges.
l Beams may only be Wide Flanges.
Beam to Column Web Moment Connections (direct weld, flange plates).
l Columns may only be Wide Flanges.
l Beam may only be Wide Flanges.
Moment Splices (beam and column, direct weld, end plate, flange plate).
l Columns may only be Wide Flanges.
l Beams may only be Wide Flanges.
Vertical Brace Connections (Chevron, Diagonal Brace, and Knee Brace).
l Columns may be Wide Flanges, HSS Tubes, or HSS Pipes.
l Beams may be Wide Flanges, HSS Tubes (Chevron and Knee Brace connections only), or HSS Pipes
(Chevron and Knee Brace connections only).
l Chevron and Diagonal Braces may be Wide Flanges, HSS Tubes, HSS Pipes, Channels, WTs, Double
Angles, or Single Angles.
l Knee Braces may be HSS Tubes, HSS Pipes, Channels, WTs, Double Angles, or Single Angles.
Single Column Base Plate Connections
l Column may be a Wide Flange, Tube, or Pipe.
Brace to Base Plate Connections
l Column may be a Wide Flange, Tube, or Pipe.
Brace to Column Base Plate Connections
l Column may be a Wide Flange, Tube, or Pipe.
l Brace may be HSS Tube, HSS Pipe, Single Angle, Double Angle, WTs, or Channels.
Truss HSS T-Connections
l Chord member must be a HSS Tube.
l Branch member must be a HSS Tube.

See Troubleshooting below for more assistance with connection type limitations.
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Integrated Connection Design Procedure
The steps required to design connections using this integration are as follows:

1. Completing the Full Structural Model
You must first draw your model in RISA-3D or RISAFloor. It is important that you use the Member Type (Column,
Beam, VBrace, HBrace) designation properly. Otherwise your connections will not be designed. Keep in mind that
connection design will only work for hot rolled connections at this point. Future versions will add to the current
RISAConnection connection type capabilities.

2. Defining Connection Rules
Next, you must define Connection Rules. These rules allow you to define which types of connections you want to
design in your model. You must have a rule for each type of connection you want considered. You may also want to
create two separate rules for the same connection Type so you can manipulate these groups separately.

To open the Connection Rules spreadsheet click the
button on the Data Entry toolbar. Then
create rules for each type of connection that you want to be designed with RISAConnection. The spreadsheet entries
are explained below:
l

l
l

l

Label - This is how you will identify your Connection Rule in other areas within the program. Each Connection Rule must have a unique Label.
Conn Type - The Conn Type drop-down filters the list of Types into Shear, Moment, or Brace connections.
Type - The Type refers to the different types of connections currently considered in RISAConnection. You
will need to set up at least one connection rule for each connection type in your project. When you solve the
connections in RISAConnection the member ends assigned to an individual Connection Rule will be grouped
together.
l Note: You may have many double angle shear connections in your project. However, some are bolted
with A325 bolts and some use A490 bolts. You should define these as separate Connection Rules.
Beam Conn - This option defines how the beam is connected to the supporting pieces (plate, clip angle, etc).
When you go to RISAConnection all connections grouped in this Connection Rule will default to this type of
connection.
l Note:Many connections do not have options for these, so "N/A" will be shown
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l

l

Col/Girder Conn - This option defines how the supporting member (column or girder) is connected to the
supporting pieces (plate, clip angle, etc.). When you go to RISAConnection all connections grouped in this
Connection Rule will default to this type of connection.
l Note: Many connections do not have options for these, so "N/A" will be shown
Eccentricity - This value has no effect on the RISAConnection integration. Instead it is used for analysis purposes. In models integrated with RISAFloor, beam/column shear connections add an automatic eccentricity
equal to half the column's depth automatically (see the Model Settings - Solution tab for more information on
this). However an additional eccentricity away from the column face may be entered in the Connection Rules
spreadsheet. The value entered here should be equal to the distance between the face of column and the resultant beam end reaction (i.e. centroid of bolt/weld group on beam web).
l This column is only available in RISAFloor and in RISA-3D if you came in from RISAFloor.
l This eccentricity is only applied to beams which connect to columns and which have the Connection
Rule specified in the Connections tab of the Beams spreadsheet.

3. Assigning Connection Rules
Once the Connection Rules are defined they must be applied to the member ends in your model.
l
l
l
l
l
l

For Column/Beam connections the rule is assigned to the beam end but not the column.
For Girder/Beam connections the rule is assigned to the beam end but not the girder.
For Column/Beam/Brace connections the rule is assigned to the beam and brace(s) ends but not the column.
For Chevron Brace connections the rule is assigned to the brace ends but not the beam.
For Knee Brace connections the rule is assigned to the brace ends but not the supporting beam or column.
For Splice connections, the rule is assigned to both of the Column or Beam ends.

Assigning the Connection Rules in the Properties Panel:
l

l
l

To assign Connection Rules, click on a member and expand the RISAConnection Properties section in the
Properties panel.
Select the proper Connection Rule for both the Start and End of the member.
You can apply a Connection Rule to one member at a time, or select multiple members to assign a
Connection Rule to multiple members.

Assigning the Connection Rules in the Members Spreadsheet:
The RISAConnection tab of the Members spreadsheet provides a place to assign, edit and view Connection Rules
as they apply to individual members.
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l
l
l

l

Label - These are the member labels for all Hot Rolled Steel members in the model.
Shape - This allows you to view what shape is assigned to the member.
Start Conn/End Conn - These entries allow you to select a rule from the Connection Rules spreadsheet.
You will need to know which end of the member is the Start (I end) and the End (J end), which you can view
graphically.
Start Release/End Release - The end release for the beam is reported here. This is useful in verifying the
that the chosen connection for the beam is valid for its end fixity (i.e. shear connections for pinned-end
beams).

Note:
l

Connections can only be designed for Hot Rolled Steel members, so only those members are shown on this
tab in the spreadsheet.

Viewing Connection Rules Graphically
Use the Quick View toolbar to view the assigned connection rules directly on your model. Click on the Member
Ends button and select Connection Rules to display the connection rules in a color-coded view. Click on the
Member Label button and select Connection Rules to display the connection rule label.

4. Assigning Load Combinations
Once you have all of your Connection Rules assigned properly you must define which load combinations that you
wish to use for connection design.
On the Design tab of the Load Combinations spreadsheet there is a check box for Connection. This check box
defines whether you want your connections designed for that LC or not.
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There are times where the member design may be designed by LRFD methods and the connections designed by ASD
methods. This check box allows for that flexibility.

5. Designing Connections
To design connections you must first have either a Single LC or Batch solution present. Once there is a solution,
there are two ways to design connections.
1. Choose Solve - Design Connections.

This option will not automatically open RISAConnection. Instead, it will run in the background, using whatever
default or previous settings are in RISAConnection. Once you've done this the Connection Results browser will be
populated. To fully export into RISAConnection, use the Director tool, as shown next.
2. Choose Director - RISAConnection.

This option will automatically launch RISAConnection where you can modify the connection parameters, such as
number of bolts, clip angle size, clearances, etc., for all the valid connections in your project (see the
RISAConnection Help file for more information on how to design connections using RISAConnection). You can then
solve your model in RISAConnection and then send the information back to RISA-3D to populate the Connection
Results browser.
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RISAConnection File Creation and Workflow
When using RISAConnection integration, a RISAConnection file will be created automatically. The file will have the
same naming convention as the RISA-3D file and will be created in the same directory as the RISA-3D file. It will
have a .rcn file extension.
Once this RISAConnection file is created then you can use this file separately to make connection changes. The file
can be transferred to another machine and worked on separately. Items related to the connections can be modified
(bolt criteria, weld criteria, connector sizes, clearances, edge distances, etc.). You can then modify/design your
connections so that they now work. Then, simply move that file back to the location where the RISA-3D model is
located and then redesign connections in RISA-3D. These changes will then be considered.
Note that any items defined by the RISA-3D models can not be modified (beam/column sizes, bolted vs welded
connections, design code, etc). Any of these changes must be taken care of in RISA-3D and then sent back over to
RISAConnection.

6. Connection Design Results
Once the connections have been designed in RISAConnection from either of the methods above the results will be
available in RISA-3D. You can view the results browser or see color-coded results graphically.

Connection Results Browser

l
l
l
l
l
l

Label/Member End - These fields give the location in the model that this connection result corresponds to.
Connection Rule - Shows the Connection Rule assigned to this location.
Pass/Fail - Tells whether the connection passes ALL connection checks or not.
Max UC - Gives the maximum unity check for the worst case LC.
Gov LC - Gives which LC provided the Max UC.
Limit State - Gives the governing Limit State which produced the worst case code check or failing criteria.

When viewing this browser there is a button at the top of the screen, Detail Results for Current Connection.

Clicking this button will open up RISAConnection to this specific connection, allowing you to take a further look at
the connection results and allow you to edit connection properties in a quick, efficient manner.
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Note
l

The Limit State field will also give notes for any connections that were not able to be designed in RISAConnection. See the Troubleshooting section below.

Viewing Results Graphically
Use the Quick View toolbar to view the connection results directly on your model. Click on the Member Color
button and select Connection Results to display the results in a color-coded view. Click on the Member Label
button and select Connection Results to display the governing unity check value.

If you are in a graphic view and have valid connection results you can also press the Connection button on the lefthand side of the screen.
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This will give a selection cursor and allow you to click on a member end that has a Connection Rule defined and will
open RISAConnection to the specific connection that you clicked on.

7. Multiple Round Trips Between RISAFloor/RISA-3D and RISAConnection
When round tripping between RISAConnection and RISAFloor/RISA-3D multiple times there are a few items to
consider:
l

l

After the first pass into RISAConnection, connection property changes in the RISAConnection file will be
saved. This means that if the RISAFloor/RISA-3D model is modified and the connections are re-designed you
will not lose the connection information that you have modified.
o One exception to this is if you make a change to the Connection Rule for that member end. If that
occurs then the basic input of the connection is modified and your connection changes will be deleted
and replaced with the new connection's default settings.
Thus, you are able to work on a RISAConnection file separately from the RISAFloor/RISA-3D file. You can
then re-locate them back in the same directory and they will be able to work together, as long as none of the
Connection Rules changed in RISAFloor/RISA-3D. Any change of an individual member end's Connection Rule
will wipe out any changes made in the RISAConnection file.
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Seismic Connections
With the help of the Seismic Detailing feature within RISA-3D, the program can handle a variety of column/beam
moment and vertical brace connections with additional seismic level checks per the Seismic Design Manual (AISC
341-10 and AISC 358-10). These connections include:
l
l
l
l
l
l

Reduced Beam Section (RBS) Moment Connection
Welded Unreinforced Flange-Welded Web (WUF-W) Moment Connection
Bolted Extended End Plate Moment Connections (Unstiffened and Stiffened)
Bolted Flange Plate (BFP) Moment Connection
Diagonal Vertical Brace Connection.
Chevron Vertical Brace Connection.

Rules for Export:
In order to export a seismic connection, you must do the following:
1. Assign the connection with a Seismic Design Rule in RISA-3D. This defines what level of ductility (OMF,
IMF, SMF, OCBF, SCBF) will define your connection and, if it is a seismic moment connection, which predesignated type (RBS, WUF-W, BFP, BEEP, etc.) it shall be designed as.

2. If the connection is a moment frame connection, assign the connection with a Seismic Moment Connection
Rule.
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3. If the connection is a braced frame connection , assign the connection with the appropriate Diagonal Brace
Seismic or Chevron Brace Seismic connection type.

Limitations:
o

o

o
o

As with the regular moment connections, all beams in seismic moment connections must be connected to the
flange of the column.
The model must be solved in both RISAFloor and RISA-3D in order to send the lateral load combination results to RISAConnection.
Seismic moment splice connections are not currently supported.
The program does not put any limitations on which RISA-3D load combinations (overstrength or not) are
solved and sent to RISAConnection. Therefore, we assume that the user is selecting the correct combinations
to include for connection design. Once in RISAConnection, you will be able to scroll through the results from
each load combination.

Tapered Wide Flange Members
Several connections (listed below) can be designed for tapered wide flange members as well as for prismatic wide
flanges. RISA-3D will require that the connection occurs at the ends of the members (no mid span connections).
This is because RISAConnection will import the section as a prismatic (non tapered) section with the cross-sectional
dimensions equal to those of the selected end of the tapered member in RISA-3D.

Available Tapered WF Member Connections:
l
l
l
l
l
l
l
l
l
l
l
l

Beam members in the Beam Shear Tab Splice Connection
Column members in the Column Shear Tab Splice Connection
Column and Beam in the Column/Beam Clip Angle Shear Connection
Column and Beam in the Column/Beam End Plate Shear Connection
Column and Beam in the Column/Beam Shear Tab Shear Connection
Beam member only in the Girder/Beam Clip Angle Shear Connection
Beam member only in the Girder/Beam End Plate Shear Connection
Beam member only in the Girder/Beam Shear Tab Shear Connection
Beam members in the Beam Direct Weld Moment Splice Connection
Beam members in the Beam Extended End Plate Moment Splice Connection
Beam members in the Beam Moment Plate Moment Splice Connection
Column members in the Column Direct Weld Moment Splice Connection
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l
l
l
l
l

Column members in the Column Extended End Plate Moment Splice Connection
Column members in the Column Moment Plate Moment Splice Connection
Column and Beam in the Column/Beam Direct Weld Moment Connection
Column and Beam in the Column/Beam End Plate Moment Connection
Column and Beam in the Column/Beam Flange Plate Moment Connection

Limitations:
l

l

l

Currently this is limited to just doubly-symmetric tapered members (flanges must be equal). In the future,
we do plan on also allowing singly-symmetric tapered WF sections with unequal flanges.
Tapered WF connections will only be considered if they occur at the member ends. (For example, connections applied to beams who are supported by girders or columns along their midspan will not be
designed).
A custom Tapered WF shape must be entered and saved permanently to the shape database through RISA3D before it can be accessed for use in RISAConnection.

Troubleshooting RISAConnection Integration
If you have difficulty getting your RISA-3D or RISAFloor model to integrate into RISAConnection, it is possible that
you have defined connection or member information incorrectly, or there may be a program limitation which
prevents the integration. Please see below for assumptions, modeling rules, and possible error messages.

Moment Connection Considerations
The following moment connections are currently supported in RISAConnection:
l

l

l
l
l
l
l
l
l
l
l

Beam to column flange plate moment connections for wide flange or HSS tube columns and wide flange
beams.
Beam to column direct weld end plate moment connections for wide flange or HSS tube columns and wide
flange beams.
Beam to column extended end plate moment connections for wide flange members.
Beam to column partially extended end plate moment connections for wide flange members.
Beam to column flush end plate moment connections for wide flange members.
Column flange plate moment splice.
Beam flange plate moment splice.
Column direct weld moment splice.
Beam direct weld moment splice.
Column extended end plate moment splice.
Beam extended end plate moment splice.

Shear Connection Considerations
The following shear connections are currently supported in RISAConnection:
l
l
l
l
l
l

Single or double clip-angle connections for wide flanges
Shear tab connections for wide flanges
End plate connections for wide flanges
Single or double clip-angle connections for channel beams
Shear tab connections for channel beams
Double-sided double clip angle connections to the column or girder web.
l Beams on either side of the web must be within 3 inches (parallel) to be considered a double-sided
connection.

Vertical Brace Connections
The following vertical brace connections are currently supported in RISAConnection:
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Diagonal Brace Connections
In order to properly export a diagonal brace connection to RISAConnection you must obey the following rules:
l
l
l

l

l
l

l

l
l
l

A Diagonal Brace connection rule must exist in the Connection Rules spreadsheet.
That connection rule must be applied to the end of the VBrace which connects to the gusset
That connection rule must also be applied to the end of the beam which connects to the gusset and to the
column.
There may be one or two VBrace members per connection. If there are two VBrace members, they must
frame in from above and below the beam respectively
There must be one beam member on the same side as the VBrace per connection.
The VBrace(s) may be offset from the beam / column work point. If the offset is along the length of the
column then each brace cannot be more than 18 inches from the work point. If the offset is along the length
of the beam then the two beams must share a common work point. This eccentricity will be accounted for in
the design of the connection. But, the connection design will NOT consider any of the EBF (Eccentrically
Braced Frame) requirements of AISC seismic provisions.
The beam must be horizontal, and the VBrace cannot have an angle of less than 10 degrees with respect to
the Beam or the column.
The column must be a prismatic Wide Flange, a HSS Tube, or a HSS Pipe.
The beam must be a prismatic Wide Flange.
The brace(s) must be a single angle, double angle, channel, tube, pipe, WT, or prismatic Wide Flange shape.

Chevron Brace connections
In order to properly export a Chevron Brace connection to RISAConnection you must obey the rules below:
l
l
l

l

l
l

l

l

A Chevron Brace connection rule must exist in the Connection Rules spreadsheet.
That connection rule must be applied to the ends of both VBraces which connect to the gusset.
There must be exactly two VBrace members per connection. They must frame in from the same side (above
or below) of the beam.
The VBraces need not share a common node. However, any eccentricity that exists will not be accounted for
in the connection design.
The beam and VBraces must exist in the same plane.
The beam must be horizontal, and the VBraces cannot have an angle of less than 10 degree with respect to
the beams or the vertical plane.
The beam must be a prismatic Wide Flange, a HSS Tube, or a HSS Pipe.
o Note: Currently HSS beams on seismic chevron braces are not supported.
The brace(s) must be a single angle, double angle, channel, tube, pipe, or WT, or prismatic Wide Flange
shape.

Knee Brace Connections
In order to properly export a Knee (or Kicker) brace connection to RISAConnection you must obey the following
rules:
l
l

l
l
l
l

A Kneel Brace connection rule must exist in the Connection Rules spreadsheet.
That connection rule must be applied to the end of the VBrace which connects to the gusset. This can either
be at the end that connects to a beam or the end that connects to a column.
The VBrace cannot have an angle of less than 10 degrees with respect to the Beam or the column.
The supporting member (beam or column) must be a prismatic Wide Flange, a HSS Tube, or a HSS Pipe.
The Vbrace must be a HSS Tube, HSS Pipe, Channel, WT, Double Angle, or Single Angle shape.
The Vbrace and its supporting member (beam or column) must be in the same plane.
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Splice Connections
RISAConnection can design wide flange (including tapered wide flange) splice connections for beam and column
splices. These can be either shear or moment splices. Keep in mind these items when creating your model:
l
l

For beam to beam column to column splices, both members must be oriented in the same direction.
You must apply your splice Connection Rule to both sides of the splice.

Base Plate Connections
RISAConnection can design single column base plate connections for shear and/or moment forces. Keep in mind
these items when creating your model:
l
l
l

A Base plate connection rule must exist in the Connection Rules spreadsheet.
The column must be a Wide Flange, a HSS Tube, or a HSS Pipe.
Base plate connection rules may only be assigned to the bottom of a column member.

Brace to Base Plate Connections
RISAConnection can design vertical brace into a column base plate connections for shear and/or moment forces.
Keep in mind these items when creating your model:
l
l
l
l

l

A Brace to Base Plate connection rule must exist in the Connection Rules spreadsheet.
The column must be a Wide Flange, a HSS Tube, or a HSS Pipe.
The brace must be a HSS Tube, HSS Pipe, Channel, WT, Double Angle, or Single Angle.
Base plate connection rules must be assigned to the bottom of a column member and the end of the brace
that connects to the column.
The brace end node may be offset along the column center-line up to 24 inches away from the end of the
column.

Truss HSS T-Connections
RISAConnection can design HSS T-Connections that have been exported from your RISA-3D model. Keep in mind
these items when assigning the connection rule in RISA-3D:
l
l
l
l

l

l
l

A Truss HSS T-Connection rule must exist in the Connection Rules spreadsheet.
The branch member (vertical member) must be an HSS Tube section.
The chord member (horizontal member) must be an HSS Tube section.
The branch and chord members may be assigned as one of the following Shape Type Combinations:
l Beam supported by Column
l Column supported by Beam
l VBrace supported by Column
l VBrace Supported by Beam
l HBrace supported by Column
l HBrace supported by Beam
The chord member must be continuous under the branch. If the chord member is broken into two members
it will not export.
The branch and chord member must be in the same plane.
The branch and chord member must be perpendicular to one another.

Integration Error Messages
If you try to send a connection to RISAConnection from RISAFloor or RISA-3D, the program will test whether that is
a valid connection. If the program finds the connection or the Connection Rules to be incorrect or unsupported,
then the program will not design the connection and will give the error in the Connection Results spreadsheet Limit State column.
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The possible error messages are:
l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

Connection not supported : This message will occur when there is a connection configuration that RISAConnection can not design. An example would be a horizontal brace connection where brace members frame into
a beam web.
Invalid or missing supporting connection members: This message will occur if the member(s) that a member is framing into is not of the proper material, shape, member type, etc. Also check that the Member Function is the same (lateral or gravity) for all members for a particular connection.
Invalid connection member material: This message will occur if the member's material is not hot-rolled
steel.
Invalid connection member shape: This message will occur if the member's shape is not one of the supported shape types for that connection type.
Invalid member/beam slope (more than 15 degrees): This message will occur if the member being connected has an invalid slope. Currently, beam/column connection design is only for orthogonal connections. If
the angle between members is greater than 15 degrees from orthogonal then this message is given.
Invalid member/brace rotation (more than 15 degrees): This message will occur if the member being connected has an invalid rotation. Currently, members can only be designed at certain orientations. For example,
weak axis beam to column design is not currently supported and will instead give this message.
Invalid member skew (more than 15 degrees): This message will occur if the member being connected has
an invalid skew. Currently, beam/column connection design is only for orthogonal connections. If the angle
skew between members is greater than 15 degrees from orthogonal then this message is given.
Connections on skewed members are not supported: This is a similar message to the invalid member skew
message.
Invalid vertical brace connection: This message will occur if there was not a valid configuration. If there is
not a valid column, beam and vertical brace intersection (at proper orientation, member type, member material, etc) then you may see this message. Note that for integration you must assign BOTH the beam and the
brace to the vertical brace Connection Rule.
Brace angle is invalid: For a corner brace or chevron vertical brace connection the brace angle with the
column and beam must be > 10 degrees.
Members have different/missing connection rules: If there is a vertical brace connection and the beam and
brace have different Connection Rules, you will get this message.
Beam must be a WF in a Chevron brace connection: This message will come up if you have assigned a
chevron brace connection type to a tapered WF beam member.
Beam and Column must be WF in Diagonal brace connections: This message will come up if you have
assigned a diagonal brace connection type to a tapered WF beam member.
Invalid code. HR Steel and Connection design codes must be the same: This message will occur if the
design codes do not match on the Model Settings Codes tab. Seismic design requires that these match.
Invalid design method. IMF/SMF connections must be design with LRFD: This message will occur if an
IMF or SMF seismic connection is applied to a model that is assigned the AISC 360-10 (14th edition) ASD
design code. Section 1.3 of the AISC 358-10 design code requires that seismic connection design must be
done per LRFD.
Incomplete definition of connection rule: This message will occur if you have not selected an appropriate
"Beam Conn" or "Col/Girder Conn" input in the Connection Rules spreadsheet. To correct this, simply go back
to Connection Rules and select the connection type (Bolted or Welded).

Connection Types Not Currently Supported
l

l

Skewed or sloped connections. If the skew or slope is less than 15 degrees, we will transfer the connection to
RISAConnection as an orthogonal connection. If the skew or slope is greater than 15 degrees than the connection will not be transferred.
Horizontal brace connections.
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RISAFloor and RISA-3D Connection Design Interaction
RISAFloor and RISA-3D both have the ability to have their connections designed with RISAConnection. Thus, there
are three possible scenarios for connections between RISAFloor, RISA-3D and RISAConnection:
1. Connections that are only in RISAFloor (Gravity connections in a combined RISAFloor/RISA-3D model).
2. Connections that are in both RISAFloor and RISA-3D (Lateral connections in a combined RISAFloor/RISA-3D
model).
3. Connections that are only in RISA-3D.
The third option above does not involve RISAFloor, thus it will not be discussed here.

RISAFloor Gravity Member Connections (Scenario 1)
Connections that are gravity in RISAFloor (option 1) are only RISAFloor members, which makes this more
straightforward. When designing connections from RISAFloor you get a very similar behavior to what is shown in
the behavior above.
The difference is when you use the Director to go into RISA-3D and then into RISAConnection, the Gravity
connections are still in the RISAConnection project. The .rcn file contains BOTH RISAFloor AND RISA-3D
connections. Therefore, when entering RISAConnection from RISA-3D, you will see more connections in
RISAConnection then just those sent over from RISA-3D.

RISAFloor Lateral Member Connections (Scenario 2)
Additional items to consider are:

Load Combinations
Lateral connections in RISAFloor will also come into RISA-3D. Thus, two sets of load combinations will come into
RISAConnection. Below is the Load Combination drop-down list from RISAConnection after coming in from a
RISAFloor/RISA-3D model.

Here we can see that the RISA-3D LC's come in first followed by those from RISAFloor.
Note:
l

This also occurs in scenario 1 above, except that all of the RISA-3D load combinations will have zero loading.

When reporting results in the Connection Results spreadsheets, both programs may list load combinations from
the other program if those LC's happened to be governing. In RISAFloor it would look similar to the image below:
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Naming Convention
RISAFloor and RISA-3D have different naming conventions for members. Thus, members taken from RISAFloor to
RISA-3D will NOT have the same name between both programs.
RISAConnection will ALWAYS use the RISAFloor naming convention. This may be a little confusing. One way we
have made this easier to comprehend is that in the Connection Results spreadsheet in RISA-3D we give BOTH the
RISAFloor and RISA-3D label.

In this image the F1_B labels are the RISA-3D labels. The labels in parentheses are the RISAFloor labels.
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Customizing RISA-3D
You may customize many of the default parameters, design and analysis options in RISA-3D. In this way you can
modify the program so that it best suits you and your work processes. All customization may be defined or
redefined at any time. The Application Settings option the provides you control over the behavior of the software
by clicking the File button and selecting Application Settings. The Save as Defaults feature allows you to specify
the default settings for new model files. These features are discussed below. Custom reports may also be defined
and saved for future use. See Printing to learn how to build a custom report.

Save as Defaults
You may use the Save as Defaults feature in the following dialog boxes by entering the default information in the
dialog and clicking the Save as Defaults button: Model Settings, Units, and Drawing Grids. This will cause the
program to use these settings with any new files that are then created.

Many of the spreadsheets also provide the option to save the current data as the default and every subsequent new
file will already have that data. Simply enter the data you want then save it as the default by clicking on the Save as
Defaults button. This way the office standards that you might use in most of your models are already entered and
available in new models. This feature is available in the following spreadsheets: Materials, Custom Wood Species,
Design Rules, and Load Combinations.
Once you create a new file you may redefine any of the default data and settings for that particular file so the Save
as Defaults feature may be used to give you a good starting point for new files but won’t hold you to those settings.

Application Settings

Program options may be accessed by clicking the File button and selecting Application Settings. Application
Settings are divided into the four sections described below. Many of the Application Settings themselves are selfexplanatory.

General Application Settings
The general Application Settings are straightforward. For help on an item click
for more information. You can set
the backup timing within the general section. See Automatic Backup to learn about the backup capabilities of RISA3D. The Reset all Program Defaults button in the Advanced General Application Settings will clear all of the
Application Settings that you have set on any of the tabs.
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Show "Starting a Model" Panel when starting a new model – The New Model Dialog will be displayed when
opening the program or selecting 'New File' from the File Menu.
Open Project Information window when loading model – Displays the Project Information settings
automatically after loading a file.
Warn before Filtering Input – With this option checked, the program will always warn you before you filter input.
Show Detailing Info for members (CIS/2 Translator only) – Choose to display the Detailing information in the
spreadsheets and Properties panel. This information is only applicable for the CIS/2 translator.
Omit unused items from Color Coded Legend for input information – This option will clean up the Color Coded
Legend to only display items used in the model.
Show Basic Load Case Factor – This option will allow you to factor your Basic Load Cases. A new column will
display in the Basic Load Cases spreadsheet called Basic Load Case Factor. The loads in a particular Basic Load Case
will be factored by the value entered into this column.
Hover to show detailed information on elements – Click the Hover Details button to customize the information
shown when hovering over an elemen.t
Show Delete Based on Criteria Summary – This provides an option to display a summary of all items that were
deleted after deleting base on a specific criteria.
Click Workspace to Clear Selected Items – This option allows you to click the white space in the 3D View to clear
your current selection.
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Enable Smart Ribbon Toolbar behavior – The Smart Ribbon Toolbar behavior will predict which tab of the
Ribbon Toolbar to open based on the actions performed in the program.
Enable Auto Input/Output Filtering in Viewer Mode – This option will automatically filter both input and output
spreadsheets based on visible items in Viewer Mode.
Show Rotation Increment in 3D View – This option will show the degree increment field in the Incremental
Rotate bin.
Background Color – Choose which color to make the background color in the user interface.
Window Behavior - Choose your window behavior option. For more information, see Window Behavior.
Automatic backup timing – Automatic backup of the currently open model occurs at the specified interval. Each
backup overwrites the previous one, such that only one backup of a given model exists at any time.
Maximum Number of Models to Backup – This controls how many models are kept in the backup folder. Once
the folder becomes "full" according to this setting, the oldest backups will be deleted automatically. Setting this to
zero turns off automatic backups.
Additional program options can be found by clicking the Advanced button.

Number of Animation Frames - This option allows you to specify how many frames are used in the animation to
move from the undeflected state of the model to the fully deflected state.
Size - This option controls the size of the Global Axes.
Grab Rotation Coeff - This option controls the rate of rotation when rotating the model with mouse cursor. A small
grab rotation coefficient will cause the model to rotate less as your rotate it with your mouse. A large grab rotation
coefficient will cause the model to rotate at a higher rate as you rotate using your cursor.
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Face Color - This option controls the color of the front of the Global Axes icon.
Back Color - This option controls the color of the back face of the Global Axes icon.
Node Scale - This setting controls the size of the nodes displayed in the 3D View.
Text Scale - This setting controls the size of the text displayed in the 3D View.
Rotation - This setting controls the rotational increment for the Click to Rotate function.
Interface Layout Template - This setting controls the layout of the Bins in the 3D View.
No Logo - This option will not include a logo on your printed output.
RISA Logo - This option will place the RISA logo on all printed output.
Custom Logo - This option allows you to add a custom company logo to your printed output.
Default Region - Choose the default region for your projects.
Reset all Program Defaults – Choose this to reset all of the Application Settings that you have a set on any of the
tabs.

Input Application Settings
Here you can specify the number of decimal places that are displayed. The one exception is the Node Coordinates.
RISA-3D maintains the coordinates to 15 significant figures and the exact value is always displayed. You may also
use the Round off Coordinates button in the Modify tab to round off node coordinates.

If you wish to use a prefix with your node, member, and plate labels, such as "N" with nodes, you can specify the
default prefix. The prefixes may be changed as you build your model.
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Node Labels - Sets the default prefix to be used in node labels.
Member Labels - Sets the default prefix to be used in member labels.
Plate Labels - Sets the default prefix to be used in plate labels.
Wall Panel Labels - Sets the default prefix to be used in wall panel labels.
Solid Labels - Sets the default prefix to be used in solid labels.
Decimal places for Input – Sets the number of decimal places to display in the data spreadsheets with a maximum
of four places.

Output Application Settings
At solution time RISA-3D finds and locks any instabilities to allow the solution to occur. See Stability to learn more
about this. Rotational instabilities are commonly inconsequential and RISA-3D allows these instabilities to be locked
without any warning.
RISA-3D can provide a warning when clearing results. You may also specify the number of decimal places that are
displayed. The number of figures displayed may not be the actual number. Behind the scenes RISA-3D maintains
numbers to numerous decimal places.
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Lock isolated rotational instabilities without notification – Locks insignificant rotational instabilities at solution
time without warning. This will cut down on joint instabilities that are technically unstable but in practice are
unnecessary.
Note:
l

If you are getting a Warning Log message that states "Sum of reaction is not equal to the sum of the loads",
you may need to uncheck this box to look for instabilities in your model.

Warn before clearing results – Verifies that results are to be cleared to edit the model.
Warn before filtering results – With this option checked, the program will always warn you before you filter
output results.
Enforce code RECOMMENDED slenderness limits (KL/r > 200, etc) - Unchecking this option waives the slender
check for slender members.
Enforce code required P-Delta analysis - Unchecking this option waives the P-Delta analysis requirement for
certain design codes.
Compare total input load against total reaction and warn if different - Enables a check in the program to
confirm that the total applied load equals the sum of the joint reactions. See the Warning Log topic for more
information on this. For additional advice on this topic, please see the RISA Tips & Tricks website:
www.risa.com/post/support. Type in Search keywords: Sum of Reactions.
Decimal Places for Output – Sets the number of decimal places to display in the results spreadsheets with a
maximum of four places.
Round rotations in radians down to 0 below – Shows 0 for the rotation when smaller than this value.
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Display Batch Results by - The results of a batch solution may be grouped by load combination or by item. For
example you can group results for all members under each particular load combination or you can group results
from each combination under a particular member. The setting here is merely a preference. Once you have solved a
model you can switch back and forth using the Sort by Combination or Sort by Item options found on the Results
tab.
Display Instabilities in new 3D View – If the model has instabilities, the program can provide an additional 3D
view selecting only the nodes that were locked as a result of the instability. This option lets you control if and when
this additional view is displayed.
Save Results with Model – These options let you control what is done with the results when saving a file.
Spreadsheet to open after static solution – This option allows you to select the default results spreadsheet to
open after solution. You can also choose 'None'.

File Locations Application Settings
The locations for data files, databases, temporary space, importing, and backing up may be specified separately by
choosing from the list.

For each file type in the list the current setting is displayed. Click the browse button
location.
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Member Design Optimization
RISA-3D will optimize Hot Rolled Steel, Cold Formed Steel, Wood, and Concrete members. The criteria used for this
optimization are the selected design code and the Design Rules assigned to the member. The sizes are chosen from
a Redesign List assigned to the member.
The Member Design Rules Spreadsheet records the parameters for the optimization. Optimization is performed
for minimum weight, taking into consideration any depth, width, rebar limitations, etc. Note that the design rules
input is one large spreadsheet, thus all of your design rules will be in the same place. Note that the dimensional
rules and the reinforcement rules are all a separate entity. They have no interaction with each other in the program.
They are simply all input into the same location. For example, your minimum member width rules will not be
influenced by concrete beam reinforcement rules.
You can assign the design rules graphically as you draw members or later as a modification. See Modifying Member
Properties for more information.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Redesign.

Wall Design Optimization
The program will also optimize concrete, masonry, and wood walls. For Wall Design Rule information see these
topics:
l
l
l

Concrete: Concrete Wall - Design Rules
Masonry: Masonry Wall - Design Rules
Wood: Wood Wall - Design Rules

Note:
l
l
l

For the optimization procedure on concrete walls see Concrete Wall - Design.
For the optimization procedure on masonry walls see Masonry Wall - Design.
For the optimization procedure on wood walls see Wood Wall - Design.

Member Design Lists
A Design List defines a set of member sizes that are considered when the program is suggesting member sizes. You
may assign a Design List to a member based on Member Type. The design lists available for Column members may
not match the design lists for Beam members, because some shapes are more appropriate for use as beams than as
columns. You may edit these lists or create additional custom lists of your own. For more information on these
redesign lists, including file format, editing procedure, and user defined lists refer to Appendix A - Redesign Lists.

Member Design Rules – Size / U.C.
The Design Rules Spreadsheet records the limitations for the design and may be accessed by selecting Design
Rules on the Spreadsheets Menu. You may create and name any number of design rules and assign different rules
to various members.
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The spreadsheet has three tabs: Size/UC, Deflection, and Concrete Rebar. The entries for the Size / UC tab are
explained below:

Design Rule Labels
You must assign a unique label to the design rules. You then refer to the design rule by its label when assigning it to
members. The label column is displayed on all tabs of the spreadsheet.

Max/Min Depth
You may enforce depth restrictions by setting either a maximum and/or minimum depth.

Max/Min Width
You may enforce width restrictions by setting either a maximum and/or minimum width.

Max Bending and Shear Check
Enter the maximum bending and shear unity checks. This should usually be specified as "1". If you desire a larger
factor of safety, provide a lower factor (i.e. ".95").

Member Design Rules – Deflection

This spreadsheet allows you to define deflection criteria for beams in the model. You must choose specific load
combinations from the Load Combinations spreadsheet (up to three) and give the maximum deflection L/y criteria.

Note:
l

l

In the Load Combination Generator - Gravity tab the program will create deflection load combinations for
you automatically to match up with the defaults.
If you write "None" in the LC column the program will ignore this criteria when checking deflections. If all
three LC columns are defined as "None" then no deflection checking will be done for beams in the model.

Member Design Rules – Concrete Rebar

The entries for the Concrete Rebar tab are explained below.

Note
l
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Optimize
The options in this column are Optimize and Explicit. Optimize indicates the program will find the most optimal
size and spacing of the reinforcement. Explicit indicates the exact number of and size of reinforcement bars. When
Explicit is selected the additional columns are editable and allow you to enter the quantity for Top/Bottom Bars,
Add'l Side Bars, and Shear Bar Spacing. These columns are greyed out when Optimize is selected.

Flexural Bars
Use the Min Flex Bar and Max Flex Bar columns to restrict bar sizes for your flexural reinforcing. Currently we
support the ASTM A615 (imperial), ASTM A615M ("hard" metric, i.e. #8M is an 8mm bar), BS 4449 (British), prENV
10080 (Euro), CSA G30.18 (Canadian), and IS 1786 (Indian) reinforcement standards. You may specify your rebar
set in the Model Settings - Concrete. You can force the program to analyze one bar size by setting the Min and Max
values to be the same bar.

Shear Ties
Use the Shear Bar column to enter the size of your shear ties. Currently we support the ASTM A615 (imperial),
ASTM A615M ("hard" metric, i.e. #8M is an 8mm bar), BS 4449 (British), prENV 10080 (Euro), CSA G30.18
(Canadian), and IS 1786 (Indian) reinforcement standards. You may specify your rebar set in the Model Settings Concrete.

Legs per Stirrup
Use the Legs per Stirrup column to enter the specific information about how may legs (2 to 6) each of your shear
ties is expected to have.

Concrete Cover
The last three columns are used to specify the clear cover measured to the shear reinforcing. Note that the Top
Cover is used for all sides of Column members.

Member Design Rules Editor
The Member Design Rules Editor provides a way to create or modify member design rules in a graphical way.
This editor automatically updates any information input into the Member Design Rules spreadsheet.
Note:
l

Keep in mind that this dialog has three tabs. Make sure to fill out the information on all the tabs before
clicking OK.

l

See the information in the Status Bar for more information on each of these entries.

The Design Rule Label is editable and will change the spreadsheet label. It is useful to name the design rule with a
descriptive name like "First Floor Columns".
The Member Type listed is for reference of the picture only in this dialog. The member type will not control the
Member Type of the beam or column which you will need to assign separately when the member is drawn.
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The Size/UC tab:

Deflection (Beams) tab:
This only applies to Beam members.

Rebar tab:
You can select Optimize or Explict to set the rebar design parameters.
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Accessing the Member Design Rules Editor
To access this editor you can click the three dots on any tab in the Member Design Rules spreadsheet (click in the
Label cell to make the three dots appear).

Member Optimization Procedure
Member optimization is performed both on explicitly defined members and on members defined through the use of
Section Sets. Members defined as part of a Section Set are checked to determine which member has the highest
code check value and which member has the highest shear check value. These members are considered to be the
controlling members for that section set.
The controlling forces on a member or a section set are then applied to new shapes satisfying the redesign
parameters and a code check is calculated. If the calculated code check and shear check falls within the specified
range the shape is considered to be an acceptable alternate.

Optimization Results
Suggested Shapes Spreadsheet
Access the Member Suggested Shapes spreadsheet by selecting the Results tab Envelope (or LC) button
Suggested Design. Alternatively, on the Results toolbar you can select Suggested Design.
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These are the suggested shapes resulting from the optimization calculations. They are chosen from each member's
assigned Design List. The suggested shape is estimated to most closely meet the criteria specified in the Member
Design Rules without exceeding them. If the member is a "Beam" member type then the Controlling Criteria could
be based on either strength criteria or deflection criteria.
Note:
l

The suggested shape may be larger or smaller than the current shape, except for the case of members
brought over from RISAFloor, for which the program never recommends downsizing.

To confirm that these alternate shapes are acceptable you MUST adopt any changes into the model then re-solve
and check the results. The suggested shapes are based on the forces for the current model. Keep in mind that the
current results are based on the stiffness of the current shapes. Changing the shapes will change the stiffness, which
is why the model needs to be resolved. It may be necessary to cycle through this process a few times to achieve the
best shapes.
You may try the new shapes by right clicking in the Suggested Shapes spreadsheet and selecting Solve Again Using
the Suggested Shapes. The shapes listed in the Suggested Shapes column will only be used to update the model
file if the "Use Suggested?" box is checked for that particular member or section set.

If the message "No Shapes Found" is given, then no satisfactory shapes could be found in the Design List specified
for that member or section set. This can occur for a number of reasons. Common reasons are:
l
l

l

l
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The loads applied are too large for the shapes in the redesign list.
No load combinations were checked for the design of this material type. See Load Combinations - Design
Tab for more information.
A code check could not be performed for a member in the section set. See the Code Check spreadsheet or
the Warning Log for these members.
The member has not been assigned an initial redesign list. Check the Members and Section Sets spreadsheets to be sure they are defined with a redesign list.
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l
l

l

On-line shapes (RE, PI and BAR) cannot be redesigned.
If you've entered a minimum code check value and the members assigned to this section set are lightly
loaded, it is possible that no shape generates a code check value high enough to exceed the minimum.
A code was not specified for that material on Model Settings - Codes.

Note:
l
l

For masonry wall design optimization see the Masonry Wall - Design topic.
For wood wall design optimization see the Wood Wall - Design topic.
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Diaphragms
Diaphragms provide lateral load distribution functions, and are necessary for automatic Wind and Seismic load
generation. There are three fundamental types of diaphragms in structural modeling:
l
l
l

Rigid Diaphragms
Semi-Rigid Diaphragms
Flexible Diaphragms

Note:
l

l

See the Diaphragms - Analysis and Results topic for more information on flexible diaphragm analysis and
design.
Wall panels can be detached from a diaphragm from the Wall Panel Editor.

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Diaphragms.

RISA-3D Rigid Diaphragm

RISAFloor linked with RISA-3D Includes Rigid and Flexible
Diaphragms

Rigid Diaphragms
Rigid diaphragms represent a plane of very high rigidity. Rigid diaphragms distribute load to elements which
connect to them solely based on the stiffness of the elements. They achieve this by tying all of the nodes within the
diaphragm plane together for both translation and rotation, but only within the plane of the diaphragm. This is
typical behavior for most slabs and decks, which attribute vertical loads based on the tributary area of their
supporting members.

Note:
l

l
l
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Older versions of RISA-3D had a diaphragm option called "Planar". This option was removed due to a lack of
real-world applicability to any structure.
There is no rigid diaphragm design in the program. This is strictly an analysis tool.
Sloped rigid diaphragms are not supported. Therefore, rigid diaphragms always exist in a flat horizontal
plane.
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Load Attribution
Loads applied within the plane of a diaphragm will be attributed to all elements which connect to the diaphragm.
The amount of load which each element takes is proportional to its stiffness. Diaphragms are capable of both
translation and rotation, so the torsional effects of the moment arm between the center of load and the center of
rigidity are accounted for. This is also true for a dynamic mass which is offset from the center of rigidity.
Because a rigid diaphragm is part of the stiffness matrix, an explicit Center of Rigidity is not calculated or
reported. Internally, the program creates a hidden set of rigid links which interconnect all of the nodes in the
diaphragm, therefore preserving the diaphragm's rotational degree of freedom (something which traditional nodal
slaving is incapable of).

Connectivity
All nodes which fall within the plane of the diaphragm automatically become connected to it. Nodes may be
intentionally disconnected from the diaphragm by checking the Detach From Diaphragm box in the Node
Coordinates spreadsheet. If a boundary condition exists within the plane of a diaphragm it will act as a restraint for
all of the nodes connected to the diaphragm.
Rigid Diaphragms must be defined along the Global Axes, therefore they can only exist in the XY, XZ, or YZ planes. If
rigid behavior is desired along a plane other than these, a semi-rigid diaphragm (made of plates) with a large
stiffness value can be used instead.

Rigid Diaphragm Stiffness
The stiffness of the rigid diaphragm is set to a unitless value of 1 x 107 by default. This value has been calibrated as
providing the best behavior for most models. It can be adjusted from within the diaphragms spreadsheet, however
adjusting this value is only recommended in the following circumstances:
1. The lateral stiffness of elements which pass through the diaphragm is sufficiently large to cause the rigid diaphragm to behave as a semi-rigid diaphragm (i.e. the translations of the nodes within the diaphragm do not
correspond to a uniform rotation about one point). If this is the case, try a diaphragm stiffness of 1 x 108.
2. The dynamics solver is not converging. In this case, try reducing the diaphragm stiffness to 1 x 106, however,
be sure to confirm that the diaphragm is not behaving semi-rigidly (see #1)
3. The program has generated a warning that the sum of the reactions does not equal the total applied load. In
the case of points on the diaphragm which have a very close proximity to each other, the stiffness of the
internally generated rigid link between them may approach the stiffness of a boundary condition. If this happens, the model can have Ghost Reactions, which are points which act as boundary conditions (dumping load
out of the model) without any notification. In this case try reducing the diaphragm stiffness to 1 x 106.
However, be sure to confirm that the diaphragm is not behaving semi-rigidly (see #1).
To adjust the diaphragm stiffness, right-click on the diaphragms spreadsheet and select Set Diaphragm Stiffness.
You may also modify this value in Model Settings Solution tab Advanced options:
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Rigid Diaphragms in a RISA-3D Only Model
With RISA-3D's diaphragm feature, a node can be defined within a given plane as the diaphragm node, and all
points in that plane will be rigidly connected to each other with internal rigid links. Thus, each node will rotate and
translate as one rigid body and exhibit rigid diaphragm behavior. RISA-3D's rigid diaphragm feature is discussed
further in the Diaphragm Modeling Tips section.

Rigid Diaphragms in a Combined RISAFloor/RISA-3D Model
A RISA-3D model that is linked up to RISAFloor has an automatic rigid diaphragm analysis and design. Each
individual slab/deck polygon is converted to a rigid diaphragm within RISA-3D. Therefore, it is possible to have
multiple independent diaphragms at any given floor elevation.

Semi-Rigid Diaphragms
A semi-rigid diaphragm is one which distributes loads based on both the stiffness of elements which connect to it
and on the stiffness of the diaphragm itself.

Semi-Rigid Diaphragms in a RISAFloor/RISA-3D Model
The Semi-Rigid diaphragm in RISA-3D will help you distribute the lateral forces based on the stiffness of the slab.
When RISA-3D is integrated with RISAFloor the program can create a Semi-Rigid diaphragm automatically. The
Semi-Rigid diaphragm is defined in Diaphragm Parameters in a Beam Supported Floor and the Slab Definitions
spreadsheet in a Concrete Floor Slab. During the integration between RISAFloor and RISA-3D, the program creates a
mesh of FEA plate elements within the edges of the slab. The thickness of the plates is defined by the
slab/diaphragm defined in RISAFloor. The plate elements are automatically submeshed so that they attach to all
vertical elements (columns and walls) as well as any new members or loads added into the RISA-3D model. Below
shows an example of a simple L-shaped building with the mesh displayed.For further display information see the
Results View Settings - Diaphragms topic.
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When the model is in RISA-3D, the mesh size is controlled by the Model Settings - Solution Tab -Semi-Rigid
Mesh . For RISAFloor ES models, the slab stiffness can be reduced based on the Icr factor in the RISAFloor Slabs
spreadsheet and the Use Cracked Slabs checkbox in the Model Settings in RISA-3D. The Icr slab stiffness only
affects the out-of-plane stiffness. For further information on cracked slabs, see Elevated Slabs - Analysis. The top of
the columns are fixed to the diaphragm using links to distribute the forces over a 12"x12" area rather than a single
column node. For further information see the Column Meshing section of the help.

Note:
l

Sloped semi-rigid diaphragms are not supported. Therefore, semi-rigid diaphragms always exist in a flat horizontal plane.

Semi-Rigid Modeling Tips for Concrete Floor Slabs
Lateral Elements: When modeling with a Semi-Rigid diaphragm, it's important to make all columns and walls
Lateral. This will bring all the columns and walls into RISA-3D which will support the slab as the vertical loads are
applied. In RISA-3D, the program will apply both lateral and vertical loads to the diaphragm for analysis of the
lateral system. This is different than Rigid diaphragms because only the lateral resisting system needs to be
transferred into RISA-3D.
Reinforcement Design: RISA-3D will not design the reinforcement for the slab. The reinforcement is designed in
RISAFloor and is based on the vertical loads. However, you can find forces in the slab in RISA-3D using the tools
listed below.
1. Contours: The contours will display the global axis forces over the slab. See the Results View Settings - Diaphragms section for further information on display of the contours. The contours can be used to find the high
and low forces as needed for reinforcement design.
2. Internal Force Summation Tool (IFST): There is an IFST Slab tool that allows you to find forces from a point
on the submesh to another point on the slab. This tool can be used to "cut" across the slab and will finds
forces along the "cut". This is the same tool that is used internally in RISAFloor to find Auto-Design Cuts
inside the Design Strips. For further information on this tool, see the IFST Topic.

Semi-Rigid Modeling Tips for Beam Supported Floors
Vertical Loads: The semi-rigid diaphragm has self weight and out-of-plane stiffness. Internally, the plates are
modeled as normal so that there is stiffness out-of-plane. The diaphragm is used for out-of-plane and in-plane load
distribution.
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Diaphragm Material:The Semi-Rigid diaphragm material uses the General Materials. There are a list of default
General Materials, however you can add to this list to match your diaphragm. See Materials for further information
on creating your own General Material.
Diaphragm Thickness:The Semi-Rigid diaphragm thickness should be selected based on the approximate stiffness
you expect from the slab or deck for lateral loading. The semi-rigid diaphragm is modeled using isotropic plates.
Therefore, there is no association with the deck direction for the semi-rigid diaphragms. If your diaphragm is truely
one-way, you may consider using a Flexible diaphragm.

Semi-Rigid Diaphragms for RISA-3D Only Models
RISA-3D does not have the ability to automatically define a Semi-Rigid diaphragm. However, Semi-Rigid diaphragms
can be represented in the model using plates.
A semi-rigid diaphragm is modeled with plates, and requires you to model and submesh the plates appropriately. In
order to adequately mesh your plates it is good to be familiar with Plate-Member Interaction. Plates are modeled
using general materials, so the first step is to set up a material with the material properties of your diaphragm.

Next, model your plates using the specified material, and with an accurate thickness. Be sure to check the “Plane
Stress” option. This makes it so that the plates only have stiffness within their own plane, and as a result won’t add
any composite bending strength to the beams in the plane of the diaphragm.

Note:
l
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When meshing a floor diaphragm around members, you want to make sure that the corners of your plates
meet at members. Otherwise, when applying surface loads to plates, the members will not see that load.
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Flexible Diaphragms
Flexible diaphragms distribute loads to elements which connect to them solely based on the tributary area of the
element within the plane of the diaphragm.

Flexible Diaphragms in a RISA-3D Only Model
The diaphragm feature in RISA-3D cannot be used to create a flexible diaphragm. To consider a flexible diaphragm
in RISA-3D there are a couple of options. The main option is to manually calculate how much force is going to each
frame or shear wall in the lateral system and apply that load directly to those elements as a point or distributed
load. Another option is to essentially use a semi-rigid path to use plates with an equivalent thickness and material
properties as your diaphragm. You may choose a very small equivalent thickness which will still be semi-rigid, but
much closer to flexible than rigid.

Flexible Diaphragms in a Combined RISAFloor/RISA-3D Model
A flexible diaphragm can be defined in a combined RISAFloor/RISA-3D model. For wood diaphragms, the program
will actually design the sheathing and nail spacing, incorporating the code specified design tables from the NDS/IBC.
See the Diaphragms - Analysis & Results topic for more information on how the design works and how loads are
attributed both for wind and seismic loads. The diaphragm can be defined as flexible when drawing the deck edge
or from the Diaphragms spreadsheet.

Note:
l

Flexible diaphragms cannot be defined on an elevated slab floor.

Flexible diaphragms within RISAFloor/RISA-3D are used solely as load-attribution devices, and do not exist as
elements within the stiffness matrix, unlike rigid or semi-rigid diaphragms. Flexible diaphragms have no stiffness,
and are incapable of transferring load from one element within them to another. Thus, members that do not have
lateral resistance out of plane are susceptible to stability issues. To increase stability in a model with a flexible
diaphragm it may be necessary to add small springs in the out-of-plane directions on the frames at the tops of the
columns. This will stabilize the members while generally having a minimal effect on the analysis of the model.

Ceiling Diaphragm (Sloped Roofs)
When a flexible diaphragm is applied to a sloped roof in RISAFloor, a setting exists to specify whether a ceiling
diaphragm is present.
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The load attribution for the flexible diaphragm will occur only for Lateral Members from RISAFloor when a ceiling
diaphragm is not specified. This is illustrated above where the lateral load follows the rafters. When a ceiling
diaphragm is specified, it is necessary to draw in collector beams at the ceiling elevation so that the load can be
carried directly the columns or walls at the base of the sloped members. With a ceiling diaphragm, the sloped
members will not experience any lateral load directly. Note that the same total amount of lateral force will be
applied regardless of this setting. This only controls whether the lateral load is applied to the sloped members, or in
a horizontal flat plane.

Diaphragms Spreadsheet - General Tab
The Diaphragms Spreadsheet contains diaphragm information and may be accessed by selecting Diaphragms on
the Spreadsheets menu under Data Entry. Alternatively, it can be accessed by clicking the
on the Data Entry Toolbar.

button

For RISA-3D models there are two different versions of the Diaphragms spreadsheet. One version is for models
which have been created in RISA-3D, the other is for models which are linked to RISAFloor.

RISA-3D Only

Node Label defines the primarynode for the diaphragm. For diaphragms in the ZX plane, the diaphragm will be
created at the Y-coordinate of the specified node. Similarly, XY diaphragms will use the node's Z coordinate, and YZ
diaphragms will use the node's X coordinate.
When the Inactive box is checked the diaphragm will be ignored by the program. This is a convenient way to
disable diaphragms without deleting them.
You may designate any floor level as a No Wind / Drift (i.e. mezzanine) level in order to omit it from the generated
wind load calculation and the drift calculations.
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Note:
l

l

Previous versions of RISA-3D had a Type field that had a Membrane and Planar option. The Planar option
has been removed and all diaphragms are Membrane. Only the in-plane rigidity is in play and not the out-ofplane rigidity.
There are not semi-rigid or flexible options for RISA-3D as a standalone program.

RISA-3D Linked With RISAFloor

Elevation displays the elevation of the diaphragm. This is the same elevation as the floor which the diaphragm was
created on.
Mass displays the dynamic mass tributary to the diaphragm. This mass is used to calculate seismic forces for both
static and response spectra methods.
Mass MOI displays the dynamic mass moment of inertia of the diaphragm. This moment of inertia is used to
calculate seismic forces for response spectra analysis.
Center of Mass displays the X and Z coordinates of the center of mass of each diaphragm. This is the location at
which static (equivalent lateral force) seismic loads are applied for each diaphragm.
Eccentricities are the percent of length/width of the diaphragm which are used to place "accidental eccentric"
seismic loads for each diaphragm. This only applies to the static (equivalent lateral force) procedure. See ASCE 7-16,
Section 12.8.4.2 for more information.
When the Inactive box is checked, the diaphragm will be ignored by the program. This is a convenient way to
disable diaphragms without deleting them.
You may designate any floor level as a No Wind/ Drift (i.e. mezzanine) level in order to omit it from the generated
wind load calculation and the drift calculations.
Diaphragm displays the diaphragm label. This label is used for the naming of Diaphragm Regions.
Type specifies whether the diaphragm is Rigid (Membrane) or Flexible for a Beam Supported Floor or Rigid
(Membrane) or Semi-Rigid for Concrete Floor Slab. If a diaphragm has been defined as Flexible within RISAFloor it
can be toggled between Rigid and Flexible in RISA-3D.
Region lists the diaphragm regions for each diaphragm. Diaphragm regions are used for the design of wood flexible
diaphragms, and are also useful for explicitly defining how flexible load attribution is to be performed.
Design Rule specifies the Design Rule which is assigned to each region. Only the information on the Diaphragms
tab of the Design Rules Spreadsheet is considered.
SGAF is the specific gravity adjustment factor for the design of wood flexible diaphragms. For more information see
AF&PA NDS SDPWS, Table A4.2, Note 2. This value defaults to 1. However, it should be manually changed if the
framing supporting the wood flexible diaphragm is not Douglas Fir-Larch or Southern Pine.

Note:
l

For information about the Wood Diaphragms tab see the Diaphragms - Analysis and Results topic.
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Diaphragm Modeling Tips
Modeling a Rigid Diaphragm in RISA-3D
In the Diaphragms spreadsheet, enter the node in the Node Label column that the diaphragm will be defined by.
Designate the Plane the diaphragm will act.

Internally, the Rigid Diaphragm ties all nodes at that elevation together with Rigid links.

To view the diaphragm, click the Toggle Display of Diaphragms button
. This allows you to visually see the
location of the diaphragms. Inactive diaphragms will not show up graphically.
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From here the Wind and Seismic load generators can be run.

Axial Load Limitation
Members in the plane of the diaphragm will have no axial load attributed to them. This is because the internal rigid
links that are created to achieve rigid behavior take the entire load. In these cases, the axial loads in these members
will need to be considered outside of the program.

Openings in a RISA-3D Only Model
If there are openings within the defined diaphragm, where portions of the structure are not rigidly connected, it is
possible to disconnect those locations from the diaphragm in the Node Coordinates spreadsheet.
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Use of Rigid Diaphragms with the Top of Member Offset
Never use Top of Member Offsets with the diaphragm feature. This combination will almost surely make the forces
in the member incorrect. This is because a Vierendeel-type truss is created, where the internal rigid links created by
the diaphragm feature acts as a top flange and the member acts as the bottom flange. What now is drawn as a single
member has multiple internal members influencing these forces.

Partial Diaphragms in a RISA-3D Only Model
There may be times when you want to model a partial diaphragm, i.e., a diaphragm that extends over only a portion
of a floor or plane. For example, let’s say you are trying to model a floor that is composed of a relatively rigid
section (thick concrete slab) and a relatively flexible section (corrugated steel decking). You would like a way to
model a rigid diaphragm for only the rigid portion of the floor.
To accomplish this, you may specify that a node or group of nodes be detached from the diaphragm. This may be
accomplished by selecting the Detach from Diaphragm option in the Node Coordinates spreadsheet or click a
node and specify it in the Coordinates dialog.
Another way this can be done is to offset the elevations of the nodes that comprise the rigid floor section so that
they are all a little higher or a little lower than the surrounding floor. The offset only needs to be slightly larger
than the Merge Tolerance, since this is the tolerance for other nodes to be on the same plane as the primarynode.
This works because the rigid diaphragm feature will only rigidly connect nodes that are at the same elevation as the
primarynode. The other nodes, which are on the flexible portion of the floor and are now at a different elevation
than the primarynode, will not be incorporated into the diaphragm. This can also be used for a "twin tower"
situation where you want each tower to act independently of the other.
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Partial Diaphragms in a Combined RISAFloor/RISA-3D Model
For buildings where a flexible diaphragm and rigid diaphragm occur on the same floor you can model the
diaphragms using separate slab edges. This will require a gap between the framing of the two diaphragms however,
such that load will not automatically be shared between the diaphragms.
Below is a screenshot of the gap for example:

Sloped Roof Flexible Diaphragms (RISAFloor/RISA-3D Integration)
The flexible diaphragms at sloped roofs require members that are in the horizontal plane to attribute load to. These
members must exist at the base roof elevation. For that reason, in the example below, the program reports "Loads
are not attributed for Diaphragm". In the direction perpendicular to the ridge, there are no members for the
program to attribute the wall wind loads to, so no loads are attributed to the diaphragm at all in that direction.
To correct this issue, simply draw horizontal bracing in the structure which can pick up the load and transmit it to
the main lateral force resisting system.

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Sloped Roofs.
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Semi-Rigid Diaphragm Analysis Considerations
If you are running a RISAFloor ES/RISA-3D combined model that has semi-rigid diaphragms then at solution time,
the elevated slab will be automatically meshed into quadrilateral plate elements. The automatically generated plate
elements are transient in the program and will not be saved in the input file.
The slab meshing is treated similar to analysis results. When the results of an analysis are deleted, the slab mesh is
cleared to be re-built during the next solution. When a solution results file is saved, the meshed elements will be
included in that file.

Note:
l

l

This topic is only applicable for RISAFloor ES/RISA-3D combined models that have semi-rigid diaphragms.
For information on semi-rigid considerations for RISA-3D only models see the Diaphragms topic.
The program uses the finite element analysis, along with cracking factors (columns, beams and slabs) to
come up with the stiffness of each element and the system as a whole. ACI 318-14 Sections 8.11.3, 8.11.4 and
8.11.5 (ACI 318-11 Sections 13.7.3, 13.7.4 and 13.7.5) provide ways to estimate the stiffness of individual elements in the equivalent frame method. These provisions are not used in the program.

Mesh Considerations
Mesh Size
The global mesh size for the slab can be input on the Solution tab of the Model Settings. As a smaller mesh size is
more accurate, the mesh size can get too small. The smaller mesh size will lead to longer solution time and more
memory usage.

Graphical Display of the Slab Mesh
By default, the plate elements associated with the slab are not visible to the user. The mesh can be turned on using
the setting on the Model View Settings - Diaphragms tab. Listed under the Wireframe selection, the Show Mesh
check box will turn the display of the slab mesh on or off.

Note
l

The display of the mesh is only available when there are active analysis results.

Point and Line Constraints for the Slab Mesh
Point constraints are the locations within the slab that require connectivity to the meshed plate elements. The
program will automatically generate point constraints at the following locations:
1. Support points which include: joints along a wall panel and column joints (see Column Meshing for full
description).
2. Beams points which include: the start, end and intermediate joints along the beam.
3. Any nodes that land in the plane of the semi-rigid diaphragm that have Joint Loads applied to them.

Note:
l

The P-Delta Leaning Column effect is not considered for RISAFloor gravity columns in a combined
RISAFloor/RISA-3D model.

Beam Connectivity to Mesh
Beams drawn on a Two-Way slab are meshed directly to the surrounding plates. The picture below shows the
center-line of the beam is meshed to the plates.
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Column Meshing
The top of the column will be submeshed and connected to the surrounding plates with rigid links in a 12" x 12"
square. This approach is more accurate than modeling the column connection at only one node. When only one
node is used the slab will have a higher peak moment and higher deflection at that one point. Instead the rigid links
create a rigid region over the top of the column that approximate the stiffness of the column attachment to the slab.
The size of the rigid links will not change based on the column dimensions as this is only approximate. In most
cases there will be 4 plates inside the rigid links.

The column node will connect to the slab via the additional diagonal rigid links. After the slab is meshed, additional
diagonal rigid links are drawn to connect the column node to the square rigid links (shown below). The column
node has rotational and translational support so there will be vertical and rotational constraint at the column
location.
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In most cases, the column node will land inside the 2x2 plate mesh in the same location as a plate corner. However,
in certain edge and corner situations, as well as beam intersections, the column node will not align with the plate
corners.

Edge Column
l

Beam Intersecting a Column

The slab connection to the column rigid link top depends on the model merge tolerance being within the
12"x12" rigid link square. If the model's merge tolerance has been set too high in the Model Settings, the slab
mesh may not connect to the columns as seen by the deflected shape and slab forces. If this occurs, reduce
the merge tolerance back to the default 0.12" and the slab mesh will attach to the column.

Slab Stiffness Considerations
Selecting a Deflection Method of I Cracked/Elastic in the Model Settings controls the stiffness reduction based on
the Icr factor in the Slabs spreadsheet available only in RISAFloor.
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The Icr factor default is set to 0.25 per ACI 318-14 Section 6.6.3.1.1 (ACI 318-11 Section 10.10.4.1). You can modify
this factor with any value between zero and 1.0 by typing in this field. The Icr factor adjusts the stiffness of the
plate elements comprising the slab by altering the thickness during solution. This adjusted thickness does not,
however, affect design values (reinforcement calculations).

Service Checkbox

The commentary in ACI 318-14, Section 6.6.3.1.1 (ACI 318-11 Section 10.10.4.1) recommends a 1.43 factor to be
applied to the cracked moment of inertia for all service loads. The program applies this factor to all Load
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Combinations that have the Service checkbox turned on, as long as the Use Cracked Slabs is selected in the Model
Settings. This results in an effective default slab moment of inertia of (0.25)*(1.43)*Ig = 0.3575*Ig
Note: The Long Term Deflection will also give the cracking analysis for the Service Load Combinations in the
graphical display, spreadsheet results and Detail Report.
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Flexible Diaphragms - Analysis and Results
Flexible diaphragms can only be designed in RISA-3D if they have come in from an integrated RISAFloor / RISA-3D
model. This is because RISAFloor contains information about slab edges, deck direction and geometry that cannot
be entered in RISA-3D. To get this design, however, you must create diaphragm regions in RISAFloor. See the
Diaphragms topic in the Flexible Diaphragms section for more information.

Analysis / Loading For Flexible Diaphragms
Seismic Load
The program only applies seismic loads to flexible diaphragms that were generated using the seismic load
generator. The load is internally converted into a one way member area load where the direction of the load
attribution is perpendicular to the direction of the applied load. This internal conversion is done at solution time.
This area load then gets broken down into a series of "transient" distributed loads that are applied to the members
which support the diaphragm. These transient loads can be viewed as Basic Load Cases. Refer to Member Area
Loads for more information about how these transient loads are generated.

Wind Loads
The program only applies wind loads to flexible diaphragms that were generated using the wind load generator.
The load is internally converted into a distributed load at the front face of the diaphragm. Then it is broken into
area loads of varying magnitudes depending on the depth of the diaphragm. In this way, an L shaped building will
have less load per foot applied at the deep section of the L than the skinny section, since an equal amount of wind
from each side is spread over more floor area in the deeper section.
These area loads then gets broken down into a series of "transient" distributed loads that are applied to the
members which support the diaphragm. These transient load can be viewed as Basic Load Cases. Refer the section
on Member Area Loads for more information about how these transient loads are generated.
Note:
The shear capacities of the diaphragm panels will automatically be multiplied by 1.4 for wind forces if the Wind
ASIF function is enabled.

Wood Diaphragm Design Rules
Note that these are only available in a combined RISAFloor/RISA-3D model. Here you can input the parameters for
your diaphragm design.

The program will use your min/max panel thickness and nail spacing to choose an appropriate nailing and panel
layout from the Database chosen. The database options can be viewed by clicking the red arrow in the Database
column.
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For more information on this, see the Appendix F - Wood Shear Wall Database Files topic.

Diaphragm Regions
Diaphragm Regions are used for explicitly defining load attribution, and for wood diaphragm design. They are not
required for flexible diaphragm analysis. To draw a diaphragm region, click on the
toolbar.

button on the graphic editing

A diaphragm is drawn by clicking the opposite corners of the rectangular area. For regions that have already been
created it is possible to update the design rule by clicking the Modify Diaphragm Region tab:
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Below are some limitations for drawing diaphragm regions:
l

l
l

l

Diaphragm Regions can only be drawn on flexible diaphragms. Therefore, a Flexible slab edge must be
present around the portion of the floor where the diaphragm region is drawn.
Diaphragm Regions must be rectangular.
Diaphragm Regions must have a closed-circuit of lateral members around their perimeter. This ensures that
there will be chords and collectors for diaphragm design.
Diaphragm Regions must be oriented along the Global X and Z axes.

Load Attribution
Only automatically generated lateral loads (wind, seismic, and notional) are considered for flexible diaphragms. Any
user-defined loads are ignored.
If Diaphragm Regions have not been drawn then loads are attributed to all horizontal members within the floor
plane (except members perpendicular to load direction). Therefore, drag struts and collectors MUST be modeled in
order to get proper load attribution into lateral frames.
If Diaphragm Regions have been drawn then loads are attributed to the perimeter of the diaphragm region, and all
members within the region are ignored.

If any diaphragm regions have been drawn on a Floor then the total generated lateral load on that Floor will be
attributed to the diaphragm regions, and no other members on that Floor will receive lateral loads. This allows you
to use diaphragm regions to explicitly define load paths in the building.
Note:
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l
l

Openings which fall within diaphragm regions are ignored.
When a flexible diaphragm has been defined on a sloped roof, the generated lateral loads (wall wind and roof
seismic) are applied at the base of the roof. This assumes that a 'ceiling diaphragm' is present to flexibly distribute the loads. This assumption is not valid for structures which have no ceiling or horizontal
bridging/bracing, such as log cabins.

For additional advice on this topic, please see the RISA Tips & Tricks website: www.risa.com/post/support. Type in
Search keywords: Flexible Diaphragm Design.

Diaphragms Spreadsheet - Wood Diaphragms Tab

Note:
l

In RISA-3D the wood diaphragms tab of the Design Rules spreadsheet is only available if the model is being
transferred from RISAFloor.

Database
Within the Wood Diaphragm Schedule dialog, you can select between oriented strand board (OSB) or wood
structural panels (WSP) databases (plywood or OSB), which have values that are pulled directly from the 2006 IBC.
You are also allowed to select between design groups based on cases and whether the diaphragm is blocked or not.
You may also specify exact diaphragm parameters by selecting "Use Individual" in the Current Selection Type. For
more information on this database, as well as information on how to edit or create your own custom database, see
Appendix F-Wood Design Databases

Panel Grade
This column allows you to specify the sheathing grade for your diaphragm. The program will then choose a
diaphragm selection from the database that has this grade.

Max/Min Panel Thickness
These values set minimums and maximums for the thickness of the sheathing that will be designed. If the same
value is input for both max and min, then that will be the thickness used.

Max/Min Nail Spacing
These values set minimums and maximums for the edge nailing spacing. If the same value is input for both max and
min then that nail spacing will be used. These values will only control the outer-most zones of a multi-zone
diaphragm region.

Nail Spacing Increment
The nail spacing increment defines how much the spacing must differ between adjacent zones. The program will
design the diaphragm panel with the highest demand for the outer zone, and then step-up the nail spacing by the
increment until it finds the next nail spacing that matches all other criteria. This nail spacing will be used to create
the next zone.
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Flexible Diaphragm Results - Detail Reports
Diaphragm results can be accessed by the Detail Report button
then clicking on the Flexible Diaphragm
perimeter. This opens the Diaphragm Detail Report Key Plan, from which a diaphragm region can be chosen by
clicking to review its results.
The Diaphragm Region detail report gives detailed information about the diaphragm design. It is split into four main
sections: Input, Envelope Diagrams, Design Summary and Chord Force Summary.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Flexible Diaphragm Design.

Input
Below is the input echo portion of the detail report:

Code – Reports the code used to design the diaphragm.
Design Rule - Lists the Design Rule which has been assigned to this diaphragm region.
Panel Grade – Reports the grade of the panels used in the design (Structural-I, Rated Sheathing, or Other)
Panel Schedule – Reports the nailing schedule database used to optimize panel selection
SGAF - The specific gravity adjustment factor, input in the Diaphragms spreadsheet, reduces the capacity of the
diaphragm. Note 2 from Tables A.4.2A-A.4.2C of the NDS 2005 SDPWS gives the calculation of this value as: SGAF =
(1 - (0.5 - G)), where G = Specific gravity of the floor framing members.
In addition the basic geometry information for the diaphragm (Total Length, Total Width, Elevation, and L/W
Ratio) are also reported here.

Envelope Diagrams
The detail report presents envelope diagrams for the shear and moment demand seen on the flexible diaphragm for
both the strong and weak directions. The diagrams are color coded yellow for strong direction and green for weak
direction for quick reference.
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Design Summary
The results for design summary are displayed for both strong and weak directions as shown below.

Panel Required Capacity is the scaled maximum design shear, also reported on the envelope diagram. The
maximum shear as determined from analysis is compared against Fp for seismic loads. If Fp exceeds the shear as
determined by analysis then that shear is scaled up to match Fp. For more information see ASCE7-10, Section
12.10.1.1.
Panel Provided Capacity is the capacity of the designed diaphragm. For diaphragms with multiple nailing zones,
this will be reported as capacity at the point of maximum shear. For more information on how the program selects
between the various nailing schedules provided in the database, please refer to Appendix F.
The Ratio provides the code check for the diaphragm based on shear demand versus shear capacity.
Governing LC gives the load combination that controls the design. This is based on whichever load combination
resulted in the highest ratio for shear capacity. In parentheses it is stated whether the governing load combination
was seismic or wind based. If the panel was governed by wind, then you are allowed to use a 40% increase in panel
strength. The program will automatically consider this, as long as you have checked the Increase Nailing Capacity
for Wind checkbox in the Model Settings-Solution tab.
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The deflection of a diaphragm is comprised of two main terms, depending on the equation used. The terms are as
follows:
The Flexure Component accounts for the deflection of the diaphragm based on bending stresses. Refer to
Diaphragm Deflections for more information.
The Shear Component accounts for the deflection of the diaphragm based on shear stresses. Refer to Diaphragm
Deflections for more information.
This deflection is based on the actual maximum shears in the diaphragm, which are given. It is not based on the
scaled Fp forces, thus we report the unscaled shears.

Chord Force Summary

The chord force summary gives an overall view of the chords on all sides of the diaphragm design region. The chord
force calculation is simply the calculated moment divided by the length of the diaphragm (M/L). As the diagram
above shows, we will give both tension and compression maximum values, if there are both tension and
compression forces for the solved load combinations. The global axes are shown as a reference.

Design Details
The details of the designed panel are reported here:

Panel Label - This is the call-out that the program uses to describe the specific panel and nailing. This information
is expanded upon afterward.
Layout Case- This reports the case (panel layout) used for the diaphragm design. Because each diaphragm has a
strong and weak direction, the program will actually report two cases associated with each diaphragm.
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Blocked – This reports whether the diaphragm was designed as blocked or unblocked
Panel Thickness – This reports the decimal thickness of the wood panels. For convenience the following table lists
the decimals that correspond with common panel thicknesses:

Panel Thickness Decimal Equivalent
5/16

0.3125

3/8

0.375

7/16

0.4375

15/32

0.4688

19/32

0.5938

Required Nail Penetration – This is the minimum nail penetration as required by the IBC/NDS. This value is taken
from the diaphragm nailing schedule/database. For more information on the database refer to Appendix F.
Nail Size - This is the size of the nail required for this call-out.
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Nail Spacing Schedule
A diaphragm region is split into various nailing zones. The optimum nailing is chosen from the diaphragm nailing
database for the highest point of shear of the diaphragm region in each direction. The program considers the Nail
Spacing Increment as defined in the Design Rules. If a nailing arrangement is available that has spacing wider than
the sum of the nailing increment and the spacing in the “higher” zone then a new nailing zone can be created. The
arrangement of the nailing zones is such that they line up with the threshold shears of the capacities of the zones.

The nail spacing schedule reports the nail spacing for each zone. The zones are shown on a legend below.
Note:
l

If there is only one zone defined in each direction, their default names will be A and D.

The following information is shown in the nail spacing schedule:
The Zone gives the zone label so you can compare it to the zone layout below.
The Location defines the distance to that zone from the edge of the diaphragm. Note that this is a symmetric
distance from either side of the diaphragm.
The Label is giving the call-out for the diaphragm panel.
The Lines entry gives the number of lines of nails on each panel edge. Normally, this value is greater than one only
for High-Load diaphragms. This entry is taken directly from the diaphragm nailing schedule database and is not
otherwise used in the diaphragm design.
Note:
l

If there is only one zone, the location value will just be zero.

The Framing Width displays the nominal width required of the framing members that support the diaphragm
panels. This entry is taken directly from the diaphragm nailing schedule database and is not otherwise used in the
diaphragm design.
The Boundary column gives the required boundary edge nail spacing.
The Cont Edge column gives the required nail spacing at continuous boundary edges that are parallel to the
direction of load.
The Other Edge column gives the required nail spacing at all other edges. i.e. edges that are not considered to be
boundaries or continuous edges parallel to load.
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Collector Forces
The collector forces are not currently reported in the Detail Report. However, the applied seismic forces are
considered in the normal member design of the collectors. The only issue here is that the seismic forces have not
been amplified by the seismic overstrength factor (Ω).

Deflection Calculations
Flexure Component
If you think of the diaphragm as a beam with the chord members acting as the flanges, then this is the deflection
due to the tension and compression forces that develop in the chords.

v = Maximum shear load in diaphragm region
L = Diaphragm dimension perpendicular to the direction of applied load
E = Chord modulus of elasticity
A = Chord cross-sectional area
W = Diaphragm dimension parallel to the direction of applied load

Shear Component
If you think of the diaphragm as a beam with the diaphragm sheathing acting as the web of the beam, then this
component represents the deflection due to the shear forces in the sheathing. This term is based on the apparent
shear stiffness (Ga) as described in the NDS Special Design Provisions for Wind and Seismic. As such, this term
includes the effects of both elastic shear deformation of the sheathing and nail slip of the panels.

v = Maximum shear load in diaphragm region
L = Diaphragm dimension perpendicular to the direction of applied load
Ga = Apparent diaphragm shear stiffness
For diaphragm regions that have only one zone in each direction the value of Ga is taken directly from the nailing
database. For multi-zone diaphragm regions the program internally calculates an equivalent Ga using the formula
below:

vs = Diaphragm shear capacity (ASD value taken from nailing database)
Gt = Shear stiffness of panel depth (taken from nailing database)
en = Nail slip (taken from nailing diaphragm nailing schedule / database)
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α = Nail slip adjustment factor. This factor accounts for non-uniform nail slip across multiple zones, and is derived
from the process outlined in the ATC-7 and further explained in the APA design / Construction Guide on
Diaphragms and Shears Walls.

Diaphragm Key Plan
The diaphragm key plan is just a plan view of the diaphragms at a given level. The key plan can be accessed by
clicking the Detail Report button
then click on the Flexible Diaphragm perimeter. This opens the Diaphragm
Detail Key Plan, from which a diaphragm region can be chosen by clicking to review its results.

The key plan will list each diaphragm (D1, D2, etc.) and the diaphragm regions within (DR1, DR2. etc.). This key
plan is to be used as a summary in RISA-3D for where the diaphragm regions are located within the floor plan. The
elevation is also given.
In the future this key plan will give a summary of the diaphragm designs at this level.

Diaphragm Design Limitations
Rigid Diaphragms - Currently, the program does not provide any design or code check information for Rigid
diaphragms. The rigid diaphragms are solely used to attribute load to the supporting frames or walls.
Unblocked Diaphragm - The program will not optimize multiple nailing zones for unblocked diaphragms.
Chord Slip - The deformation due to chord slip is not considered in the deflections calculations.
Required Framing Size - The detail report lists a required framing nominal width, however no check is performed
to ensure that the framing modeled actually meets this requirement.
Diaphragm Loading - The only load seen by flexible diaphragms is the load coming directly from the automatically
generated loading. Any loading added in RISAFloor or RISA-3D will not be considered in the design of the
diaphragms and will not be attributed to the shear walls.
Sloped Diaphragms - Currently the program will not design sloped flexible diaphragms. At solution in RISAFloor
the program will force you to change the diaphragm to rigid. This feature will be added in an upcoming release.
Moisture Content - The program is not considering a reduction in strength due to moisture content.
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Orientation - No diaphragm design will be done for regions placed over deck that is not parallel to the Global X and
Z axes.
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You may calculate and report inter-story drift based on calculated node displacements. The calculations will be
performed in the two horizontal translation directions, but not for the vertical direction.

Drift Definitions Spreadsheet
The Drift Definitions spreadsheet defines where the drift calculations will be performed. If the model contains
diaphragms, the nodes connected to that diaphragm will automatically be considered in the drift calculations. Drift
calculations may be performed at specific elevations (where diaphragms don't exist). However, these elevations
must be manually entered by the user in the Drift Definitions spreadsheet. These elevations are defined with
respect to the vertical axis of the model.
In addition, the user may specify individual nodes to be used in drift calculation. Node definitions are included for a
number of reasons. They allow models defined in older versions of the program (which only used defined "story
joints") to produce identical drift results in the current version. They also allow users to get drift reporting at
specific points of interest even if these points don't line up well from floor to floor or don't behave the same as
other nodes at that elevation. See Drift Modeling Tips for more information.

Note
l

l
l

l

Elevations and Diaphragms are treated interchangeably for drift calculations. Nodes must be in exactly
the same location on the upper and lower floors for drift to be calculated.
When Elevations are entered manually, there MUST be defined nodes at that elevation.
When Node definitions are used, the drift calculation for the node is based only on the defined nodes.
Therefore, you must also create a Node definition for the story below (unless it is at zero ft) in order to
get correct behavior.
The Drift Definitions spreadsheet is currently applicable to rigid diaphragms only.

Inactive Diaphragms
Drift is not reported for elevations that have been flagged as "Inactive" on the Diaphragms Spreadsheet. However,
the inactive diaphragm is still considered for the drift calculation for the floor above in the determination of story
height.

No Wind / Drift Checkbox
When the No Wind / Drift box is checked on the Diaphragms Spreadsheet, then that diaphragm will be completely
ignored for drift calculations. Drift will not be reported at that level. It will also not affect the story height
calculation for the floor above or below.
To Define an Elevation for Drift Calculation
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l
l

On the Drift Definitions specify Elevation as the Type of drift definition you are creating.
Enter the value for the elevation.

Note
l

The program will also assume a default base elevation of 0. This will NOT be done if there are any drift
definitions defined for elevations below 0.

To Define a Node for Drift Calculation
l
l

On the Drift Definitions specify Node as the Type of drift definition you are creating.
Enter the Node label.

Note
l

This node will be included in the drift calculations for both horizontal deflections.

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Story Drift.

Drift Results
Once the solution is performed you may view the drift results in the Story Drift spreadsheet. Access the Story Drift
spreadsheet by selecting it from the Results menu in the Explorer panel. This report lists the drift for all defined
Diaphragms, Elevations and Nodes that exist in the Drift Definitions spreadsheet. The results are reported in the
order in which they appear in the Drift Definitions spreadsheet.

To calculate inter-story drift for a particular direction, the displacement at the lower level is subtracted from the
current story displacement. For example, to calculate X direction drift for story 2, the X displacement for the node
representing story 1 is subtracted from the X displacement for the node representing story 2.
For Diaphragm and Elevation definitions, the drift calculations are only done at locations where columns or walls
have nodes at the current level and at the level below.
For NodeDefinitions, the calculations are done for the current defined drift node compared to the nearest defined
drift node at a the level below. Node definitions never look at the nodes in a Diaphragm or Elevation definition.
These are user-defined drift nodes which act completely independent of the more automated Diaphragm and
Elevation drift results and offer flexibility for cases where the Diaphragm or Elevation options don't give the output
needed.
For story height, the vertical axis is used to determine the distance. For example when the Y-axis is specified as the
vertical axis, the story node Y coordinate values are used to calculate heights for X and Z direction drift. If Y
direction drift is being calculated, the Z coordinate values for the story nodes are used to calculate heights.
The base elevation of the structure is assumed to be zero. If the 0 ft elevation should NOT be used as the base of the
structure for drift calculations, then the user should enter in an Elevation entry in the Drift Definitions spreadsheet
to define the elevation of the base of the structure. This applies whether the base is a positive or negative value. If
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the value is positive, then there will be a reported drift (probably zero) at the base elevation that can be ignored by
the user.
Service level and strength level drifts are reported on different tabs of Drift Results Spreadsheet. This is because
seismic drift checks are usually checked purely for the strength level Load Combinations while wind drift is usually
checked against service level Load Combinations.

Story Drift and Drift Ratio %
The Drift at a given level is equal to the deflection at that level minus the deflection at the level below. For the
image below:
1st Level Drift = X1
2nd Level Drift = X2 - X1
The Drift Ratio (%) is equal to the drift at that level divided by the height from that level to the level below. For the
image below:
1st Level drift ratio % = (X1 / H1 ) *100%
2nd Level drift ratio % =((X2 - X1) / H2 ) *100%

Seismic Drift Checks
Seismic drift are reported for all codes for load combinations containing earthquake loads, but the program will
report failures in red text for the ASCE 2005, 2010, and 2016 codes based on the following table of allowable
seismic drift versus Risk Category / Occupancy Category:
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I or II

III

IV

High Drift Design

2.5%

2%

1.5%

Masonry Cantilever

1%

1%

1%

Other Masonry

0.7%

0.7&

0.7%

Other

2%

1.5%

1%
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When the ASCE and IBC codes are used, the Story Drift for the strength level combinations will account for the
inelastic deflection (i.e. the Cd factor) by amplifying the node deflections at each level by Cd/ I per Section 12.8.6 of
ASCE-7. Where Cd is the Deflection Amplification factor intended to convert the elastic deflection levels given in the
analysis to the inelastic levels used for seismic drift checks. Similarly, I is the importance factor (based on Risk /
Occupancy Category) which was presumably used to amplify the seismic forces applied to the structure.
For codes other than the US codes the drift results are not modified for Cd, I or rho, and are never reported in red
text to indicate a failure.

Note
l
l

l

l

These seismic checks are only performed for strength level load combinations.
Stiffness reduction (per AISC Direct Analysis Method) does NOT change the drift code checks in RISA
even though it may cause significant increase the reported drift.
Load Combinations with Overstrength (Omega) seismic loading are not included in the drift reporting at
all.
To negate the effect of the redundancy factor (rho), the node deflection results are divided by rho before
drift calculations are perform. This only occurs, of course, for load combinations where rho was used to
amplify the seismic loading. This is done because the redundancy factor is not intended to affect story
drift calculations per section 12.3.4.1 item 2 of ASCE-7 2016.

2nd Order / 1st Order Deflection Ratio
The program will report the ratio of 2nd order deflection to 1st order deflection for the nodes used in the drift
calculation. This is useful when determining whether it is required by the AISC code to use the Direct Analysis
Method. In general, if the ratio is greater than 1.5 (or 1.7 if stiffness adjustment has been turned on) then you MUST
use the Direct Analysis Method on your structure.
To facilitate this check, RISA will color the check in red whenever the ratio exceeds the 1.5 limit (or 1.7 when
stiffness adjustment is used). This is done regardless of what has been chosen for the HR steel code. While the 1.5
or 1.7 may not be a code trigger in other HR steel codes, it remains because it can be an indicator of when 2nd
order effects become troublesome.
There is an internal tolerance of 0.0005 inches, below which the deflection will not be reported in drift results. This
is because while the drift is essentially zero, testing showed cases where minor increases in these small values
could result in high 2nd order / 1st order deflection ratios. Which were falsely indicating 2nd order effects as
reaching high or troublesome levels.

Drift Modeling Tips
Inclined Columns
When using diaphragm or elevations, the drift is reported for aligned nodes connected by columns or walls. This
doesn't help for inclined columns because those nodes will very specifically NOT align from level to level. If drift
reported is required for these nodes, then they should be defined using the Node option instead. When defined this
way, the drift from level to level will be reported based on the nearest node at the level below.

Multi-Story Columns
In the image below, node N2_3 should have its drift calculated based on a story height that is twice what the other
nodes at that level would be based on. In that case, the user should use Elevation or Diaphragm definitions for the
majority of the nodes, but use Node definitions for N2_3.
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Troubleshooting NC results
There are times when drift results will be reported as "NC" (which stands for Not Calculate). This can occur for a
number of reasons:
l
l
l
l

The Story Drift for that floor is below the 0.005" minimum tolerance for reporting.
If a diaphragm is flagged as inactive then all results for that diaphragm will report NC.
When there are no aligned drift nodes between that diaphragm / elevation and the one below.
The 2nd / 1st Ratio will report NC for any load combinations where a P-Delta analysis was not included in
the solution.
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DXF Files
You may read and writeexport DXF files. Generally, you would read in a DXF file to create the geometry for a new
structural model, or you could write out a DXF file from an existing model to form the basis for a model or a CAD
drawing. This feature provides two-way compatibility with any other program that can read and write DXF files.
This includes most major CAD programs and many analysis programs.

Note
l
l

l

l

Perform a Model Merge on any model created from a DXF file. See Model Merge for more information.
You may want to round off the joint coordinates after importing a DXF file. You may do this from the
Tools menu.
When importing a DXF file it is essential to specify a column layer. Only beams that are fully supported
will be imported.
You can also import a DXF as a Drawing Grid. See the Import DXF section of the Graphic Editing topic for
more information.

Importing DXF Files
You may translate POINT’s, LINE elements and 3DFACE’s. POINT’s are converted into nodes, LINE’s are converted
into members and 3DFACE’s are converted into plates. Circles, arcs, polylines, text, etc. may be present in the DXF
file, but these will be ignored. At this time, only the basic geometry will be translated via DXF files. You have
several options available for controlling how DXF files are imported. They are as follows:

DXF Units
Select the units you used in the CAD model from which you produced the DXF file. The supported DXF units are
none, inches, feet, mm, cm, and meters.

CAD Scale
Enter the scale factor that will cause the DXF file to be scaled up or down to full scale. For instance, if you had
created a scaled model in AutoCAD at a scale of 1/4"=12", then the appropriate scale factor to produce a full size
RISA-3D model would be 48. The default is 1.0.

DXF File Vertical Axis
Although it is not specifically noted in the AutoCAD documentation, the implied default vertical axis is the positive
Z-axis of the current User Coordinate System.
The default vertical axis in RISA is usually the positive Y-axis and may be specified in the Model Settingsunder the
Axis Tab. When you import your model from a DXF file, you can have the program automatically rotate your
geometry so that the Y axis is now the vertical axis for your RISA model.

Translate Layer Names to Section Sets
This is a Yes/No check box. If you check the box “Yes”, the program will translate the DXF file's layer names into
RISA Section Sets Labels. The program requires that you add a prefix to each Layer Name to designate what type of
material that section set is defined for. The prefixes are as follows:
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Layer Prefix

Cold Formed Steel

CF_

Concrete

CN_
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Material Type

Layer Prefix

Hot Rolled Steel

HR_

General Materials

GN_

Wood

WD_

For example, let’s say you have designed a structure with Hot Rolled steel section sets that you want to call
"Column"and " Girder", as well as a Wood section set called "Joist". If you do not prefix your section sets then they
will all be imported as General Material section sets. To have them imported into the proper Material type the
column layer would have to be named "HR_Column", the girder a layer "HR_Girder", and the joists layer "WD_Joist".

Translate Shapes to Layer Names
This is a Yes/No choice. If you choose “Yes”, the program will take members and assign them to a shape based on
their shape label. If there is not a database shape that corresponds to the DXF Layer Name, then these member will
be assigned a general RE4x4 shape or a BAR2.

Note
l

When assigning layer names in AutoCAD, remember to use an underscore character ("_") in place of a
period (".") where a period would normally occur. For instance a C10X15.3 should be entered as
C10X15_3. RISA-3D will automatically convert the “_” to a “.” when the DXF file is read in.

Exporting DXF Files
Only the node, member, wall and element geometry will be translated and used to create an ASCII DXF file. Any
other information such as the boundary conditions, loads, member end releases, etc. will not be translated at this
time. You have several options available for controlling how DXF files are exported as follows:

Node Layer
Type the name of the layer for the node point entities. If you don’t enter anything, the default layer name will be
“MODEL”.

Member Layer
Type the name of the layer for the line entities. If you don’t enter anything, the default layer name will be “MODEL”.
Note that this entry will be ignored if you select the option below to translate section set database shape names into
layer names.

Plate Layer
Type the name of the layer for the plate elements, which will be represented as 3DFACE entities. If you don’t enter
anything, the default layer name will be “MODEL”.

DXF Units
Select the units you desire the CAD model to be created in. The options for the DXF units are none, inches, feet,
mm, cm, and meters.

CAD Scale
Enter the scale factor that will cause the full scale RISA model to be scaled up or down to the desired drawing scale.
For example, if you created a full scale model that you wanted scaled down to 1/4"=12", the factor would be
0.020833, which is (.25/12).
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Line End Standoff Distance
Enter the distance you wish to have the line entities “stand off” from the nodes to which they are attached. The
standoff distance is measured along the axis of the line. The distance will be in the DXF units, which is defined
below. The distance will be used as entered and will not be scaled by the CAD Scale factor.
Note that if you create a DXF file with a non-zero standoff distance, it will be difficult to use the file for model
geometry if you read the file back into RISA. (If you read such a file back in, you will end up with multiple nodes at
each member endpoint which will separated by the standoff distance)

DXF File Vertical Axis
Although it is not specifically noted in the AutoCAD documentation, the implied default vertical axis is the positive
Z-axis of the current User Coordinate System.
The default vertical axis in RISA is usually the positive Y-axis and may be specified on the Model Settings. When
you export your model to a DXF file, you can have the program automatically rotate your geometry to match the
vertical axis of your CAD program.

Translate Section Sets to Layer Names
This is a Yes/No check box. If you check the box “Yes”, the program will translate Section Set Labels to layer names.
Layers will be created in the DXF file corresponding to the section set labels in the RISA model. A “Yes” choice here
overrides any layer name entered for the member layer.
The program will add a prefix to each section set layer to designate what type of material that section is. The
prefixes are as follows:

Material Type

Layer Prefix

Cold Formed Steel

CF_

Concrete

CN_

Hot Rolled Steel

HR_

General Materials

GN_

Wood

WD_

For example, let’s say you have designed a structure with Hot Rolled steel section sets called "Column"and " Girder",
as well as a Wood section set called "Joist". If you type in a member layer name such as "STEEL" then all members,
regardless of size, will appear on a layer named "STEEL". However, if you choose “Yes” for the translate section sets
to layers option, then all the member that are assigned to the Column section set will appear on a layer named "HR_
Column", the girders on a layer named "HR_Girder", and the joists on a layer called "WD_Joist".

Translate Shapes to Layer Names
This is a Yes/No choice. If you choose “Yes”, the program will take members and assign them to a layer which uses
their shape label as the layer name. Layers will be created in the DXF file corresponding to the shape labels in the
RISA model. A “Yes” choice here overrides any layer name entered for the member layer.

Note:
l
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If you check BOTH the Translate Section Sets and Translate Shapes boxes, then only the explicitly defined
shapes will be put placed on a layers according to their shape labels. All members defined with section
sets will still be placed on layers according to their section set label.

RISA-3D V20

DXF Files

l

l

Please note that if the section set database shape designation includes one or more decimal point (".")
characters, the export will translate each occurrence of a decimal point character into an underscore
(“_”) character. For instance, a section set or shape label such as a C10X15.3 will translate into a layer
name of "C10X15_3" or "HR_C10X15_3".
The DXF format does not properly recognize certain ASCII text characters for layer names (< > / \ “ : ; ? *
| = ‘). Therefore, these characters should be avoided for shape or section sets when using the "translate
to layer names" options.

Merge After Importing a DXF File
It's always a good idea to do a Model Merge on any model created from a DXF file! In the process of creating a wire
frame model in your CAD software, certain events may take place that cause end-points of LINE elements that were
once matched to become mismatched by very small amounts. This most often happens as a result the following:
l
l
l
l

Use of mirroring or rotating operations.
Improper use or lack of use of point snaps.
Trimming or breaking operations.
Inconsistent precision when inputting point coordinates from the keyboard.

Model Merge combines nodes that are within the “merge tolerance” distance of one another. The default distance
for the merge tolerance is 0.01 ft. for all unit types.
You can also deal with several other possible problems by performing a Model Merge. This feature will also deal
with intermediate nodes along member spans, a common problem in models created from DXF drawings and
members that cross, but do not have nodes at their intersection point. See Model Merge for more information.

DXF Element Numbers
Different CAD packages handle ordering of geometric data in their DXF files in two basic ways.

Method 1:
Entities are written out into the DXF file based on the order in which they were created within the CAD program
itself regardless of the order in which they were selected at the time the DXF file was made. Different operations
such as copying, mirroring, arraying, etc. can produce unexpected results and it therefore becomes necessary to
consult your CAD program documentation to understand how it stores and orders the geometry that you create via
these various operations.

Method 2:
Entities are written out into the DXF file based on the order in which they were selected at the time the DXF file
was made. AutoCAD is such a program. In order to control the ordering of the LINE entities, you must select the
"Entities" option under the DXFOUT command and then select the lines in the order that you want them to appear
in the RISA model.

Note
l

Another option to help improve the ordering of the nodes, members and elements in a model obtained
from reading in a DXF file is to sort and relabel them once in RISA.

DXF File Format
The specific DXF file that you may read and write is the ASCII Drawing eXchange Files (DXF) file. Please note that
AutoCAD has several different forms of DXF files available. ASCII is the default form and is the only form currently
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supported. The DXF read/write feature was written based on the DXF documentation for AutoCAD release 14. The
feature has been tested with AutoCAD Versions 13 and 14.
The following is a short excerpt of the AutoCAD ASCII DXF format. This information is provided to help you debug
any problems you may be having with DXF files that you are trying to read. For more complete information, consult
your CAD documentation.

General
A DXF file is composed of sections of data. Each section of data is composed of records. Each record is stored on
it’s own line. Each particular item is stored as two records, the first record is a group code and the second record is
the data or a keyword. RISA only reads the ENTITIES section.

Group Codes
Each 2 record item start with an integer group code. RISA recognizes the following group codes:

Group Code

Description

0

Identifies the following overall keywords:
SECTION, ENDSEC, and EOF. Within the
ENTITIES section it also identifies POINT,
LINE, and 3DFACE.

2

Identifies a section name (I.e., ENTITIES)

8

Identifies a layer name.

10, 11, 12, 13

Identifies the X coordinate of the 1st, 2nd,
3rd and 4th points of an item.

20, 21, 22, 23

Identifies the Y coordinate of the 1st, 2nd,
3rd and 4th points of an item.

30, 31, 32, 33

Identifies the Z coordinate of the 1st, 2nd,
3rd and 4th points of an item.

First and Last Records for a DXF file
Each DXF file must start with the first record as the group code “0”. The 2nd record must be the keyword
“SECTION”. Each DXF file must have the 2nd to last record as the group code “0". The last record must be the
keyword “EOF”.

Entities Section
The ENTITIES section will be identified by a group code of “0”, followed in the next record by the keyword
“SECTION”. The next record will be the group code 2, followed in the next record by the keyword “ENTITIES”.

Item Formats within the ENTITIES Section
The POINT format is started by a group code of “0” followed by the keyword “POINT”. The layer name for the
POINT will start with a group code record of 8, followed by a record with the actual layer name.
The coordinates for the point will be started by the 10, 20, and 30 group codes respectively for the X, Y, and Z
coordinates. Other group codes and data may be present within the POINT data but these will be ignored.
The LINE format is started by a group code of “0” followed by the keyword “LINE”. The layer name for the LINE
will start with a group code record of 8, followed by a record with the actual layer name.
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The coordinates for the first point will be started by the 10, 20, and 30 group codes respectively for the X, Y, and Z
coordinates. The coordinates for the second point will be started by the 11, 21, and 31 group codes respectively for
the X, Y, and Z coordinates. Other group codes and data may be present within the LINE data but these will be
ignored by RISA-3D.
The 3DFACE format is started by a group code of “0” followed by the keyword “3DFACE”. The layer name for the
3DFACE will start with a group code record of 8, followed by a record with the actual layer name.
The X, Y, and Z coordinates for the 1st through 4th points will be started by the 10, 20, and 30 through 14, 24, and
34 group codes respectively. Other group codes and data may be present within the 3DFACE data but these will be
ignored.

AutoCAD Layer Names
The only valid characters in an AutoCAD layer name are the letters A to Z, the numbers 0 to 9, and the three
following characters: the dollar sign “$”, the underscore “_”, and the dash “-”.
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Dynamic Analysis - Eigensolution
The dynamic analysis calculates the modes and frequencies of vibration for the model. This is a prerequisite to the
response spectra analysis, which uses these frequencies to calculate forces, stresses and deflections in the model.
For more information, see Dynamic Analysis - Response Spectra.
The process used to calculate the modes is called an eigensolution. The frequencies and mode shapes are referred
to as eigenvalues and eigenvectors. Refer to the Program Limits section for information on the maximum number of
modes that can be solved for in RISA. The program can also solve for an approximate type of eigenmode called a
Ritz Vector.
The dynamic analysis uses a lumped mass matrix with inertial terms. Any vertical loads that exist in the Load
Combination for Mass will be automatically converted to masses based on the acceleration of gravity entry on the
Solution tab of the Model Settings. However, you must always enter the inertial terms as Nodal Masses.

To Perform a Dynamic Analysis / Eigensolution

1. You may wish to solve a static analysis first to verify that there are no instabilities.
2. Click Solve on the Home tab and select Dynamics from the solution options.
3. Specify the load combination to use as the mass and the number of modes to solve.

Note
l
l
l
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You may view the mode shapes graphically by choosing this option in the Model Display Options.
Refer to Dynamic Analysis - Response Spectra for more information on that type of dynamic analysis.
For information about the solver options (Standard, Accelerated and Ritz Vectors see the Model Settings
- Solution tab Advanced options. For documentation information on these solvers see the Solution topic.
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l
l

See the Residual Rigid Response section for more information about the Calc Residual Mass? checkbox.
See the Dynamic Analysis - Response Spectra topic for more information about the Use Dominant Mode
for Signage checkbox.

Eigensolutions In a Combined RISAFloor/RISA-3D model
When a dynamic solution is run from within a combined RISAFloor / RISA-3D model, the Eigensolution portion of
the dialog includes eccentric mass and Floor Diaphragm mass options as described in RISAFloor Diaphragm Mass
Options.

Required Number of Modes
You may specify how many of the model’s modes (and frequencies) are to be calculated. The typical requirement is
that when you perform the response spectra analysis (RSA), at least 90% of the model's mass must participate in
the solution. Mass participation is discussed in the Response Spectra Analysis topic.
The catch is you first have to do a dynamic analysis in order to know how much mass is participating so this
becomes a trial and error process. First pick an arbitrary number of modes (5 to 10 is usually a good starting
point) and solve the RSA. If you have less than 90% mass, you'll need to increase the number of modes and try
again. Keep in mind that the more modes you request, the longer the dynamic solution will take.

Note
l

If you are obtaining many modes with little or no mass they are probably local modes. Rather than asking for even more modes and increasing the solution time see Dynamics Troubleshooting – Local Modes
to learn how to treat the unwanted modes.

Dynamic Mass
The eigensolution is based on the stiffness characteristics of your model and also on the mass distribution in your
model. There must be mass assigned to be able to perform the dynamic analysis. Mass may be calculated
automatically from your loads or defined directly.
In order to calculate the amount and location of the mass contained in your model, RISA takes the vertical loads
contained in the load combination you specify for mass and converts them using the acceleration of gravity defined
in the Model Settings. The masses are lumped at the joints and applied in all three global directions (X, Y and Z
translation).
You may also specify mass directly. This option allows you to restrict the mass to a direction. You can also apply a
mass moment of inertia to account for the rotational inertia effects for distributed masses. See Loads - Nodal Load
/ Displacement to learn more about this.

Note
l

l

l

l

Only the VERTICAL loads (including vertical components of inclined loads) contained in the load combination are converted to mass.
Model Settings - Axis tab is where you can designate which of the three global axes is to be considered
the vertical axis.
The self-weight of the model is NOT automatically included in the mass calculation. If you wish to have
self-weight included, you must have it defined as part of the load combination for mass.
You may want to move the mass to account for accidental torsion, which is discussed in the next section.
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RISAFloor Diaphragm Mass Options
Models that get generated by RISAFloor will automatically assign dynamic mass and mass moments of inertia
(MMOI) to each of the RISAFloor diaphragms. This mass and MMOI is based on the self weight and loading
information defined in RISAFloor and specified in RISAFloor's Model Settings.
There are 4 different sets of Mass defined for each diaphragm. The Centered Mass solution is when the mass is
located at the mass centroid of the diaphragm. The Plus X, Minus X, Plus Z, and Minus Z solutions are when the
mass has been offset to account for accidental eccentricity as specified in the Floor Diaphragms spreadsheet.

Whether this diaphragm mass / mass moment of inertia is included in the definition of dynamic mass is determined
by the Include Floor Diaphragm Mass check box.
If the Include Floor Diaphragm Mass option is included in the analysis, then a Load Combination in most cases
should not be considered for mass. The reasons you may wish to check the Include Load Combination box are:
l

l

If you have RISA-3D only elements that you want to also include their mass in the eigensolution. To do this
you would need to create a load combination that either contains only this additional seismic load, or that
one that includes ALL seismic weight. If you choose to include ONLY the additional seismic weight in this
load combination then you would check both the Include Floor Diaphragm Mass and the Include Load
Combination checkboxes. If you include ALL seismic weight in your load combination then you would only
choose the Include Load Combination checkbox.
If you had a specific reason to not wish to use the RISAFloor calculated masses. In that case you would
uncheck Include Floor Diaphragm Mass and have only the Include Load Combination checkbox checked.

Eccentric Mass Solutions (for Accidental Torsion)
The eccentric mass options give an automated way to consider accidental torsion.
When more than one eigensolution option is selected (centered mass or one of the eccentric mass options), the
program will solve for a different set of frequencies and mode shapes for each of the mass options included in the
solution. For information on how this affects response spectra analysis results, see RISAFloor Spectra Results.

Note:
l

The eccentric mass solution options have no effect on semi-rigid or flexible diaphragms.

Modeling Accidental Torsion
Most design codes require an assumed accidental torsion that is in addition to the natural torsion created by the
location of mass with respect to rigidity. While RISA-3D calculates the natural torsion you may want to model
additional accidental torsion. This can be done easily by taking advantage of the rigid diaphragm feature.

Note:
l

Review the specific requirements of the building code to confirm this. But, most codes will allow you to neglect accidental torsion for dynamic analysis and response spectra.

If you have modeled the dynamic mass at the center of mass only, then you may simply move the nodes that specify
the center of mass. For example, if the required accidental eccentricity is 5% of the building dimension then move
the nodes that distance, perpendicular to the applied spectra. You may then run the dynamic/rsa solution and
combine the results with a static solution to check your members and plates for adequate capacity. You will have to
do this by running solutions for all four directions to capture the controlling effects on all frames. You will not be
able to envelope your results since you are changing the dynamic results each time you move the mass, so you will
probably want to check all your load conditions one additional time after all your member sizes work to make sure
that any force redistribution in your frames hasn't caused other members to fail.
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Note that when you lump all your floor mass to the center of mass, you should also enter a Mass Moment of Inertia
for your diaphragm as well by applying it as a Nodal Mass to the center of mass node. The rotational inertial effects
of the diaphragm mass will contribute to your torsion shears and should not be ignored in most cases. See Loads Nodal Load / Displacement to learn more about this.
If you have not modeled the mass at discrete points that can be easily moved then you will have to apply the
accidental torsion as a static load that will be part of a static analysis solution that includes the response spectra or
equivalent lateral force procedure results. The magnitude of the torque will be the product of the story force and
the accidental offset distance.
The accidental offset distance is usually a percentage of the building dimension perpendicular to the assumed
earthquake direction. The story force is the story mass times the acceleration at that story level. If you are using
an equivalent lateral static force procedure, you will have already calculated your story forces. If you are
performing a response spectrum analysis, you can get the story forces exactly as the difference between the sum of
the shears below and above the floor. Alternately, you could more simply use the full weight of the floor as the
story force and then apply the scaling factor for your normalized spectra to this value as well. This simplified
method may be unconservative if your floor accelerations have large amplifications as compared to your base
acceleration due to the dynamic characteristics of your building.
The torsion can be applied as a point torque that you can apply to a node on the diaphragm. The torque can also be
applied as a force couple, with the magnitude of the forces determined by the distance between them to make the
needed torque value. Often it is convenient to apply the forces for the couple at the ends of the building. One
advantage of applying the accidental torsion as a static force is that you can set up all your required load
combinations and let RISA-3D envelope them for you in one solution run.

Note:
l

For rigid diaphragms in a combined RISAFloor/RISA-3D model the accidental eccentricity is automatically
accounted for see the Eccentric Mass Solutions section for more information.

Eigensolution Convergence
The eigensolution procedure for dynamic analysis is iterative, i.e. a guess is made at the answer and then improved
upon until the guess from one iteration closely matches the guess from the previous iteration. The tolerance value
is specified in the Model Settings and indicates how close a guess needs to be to consider the solution to be
converged. The default value of .001 means the frequencies from the previous cycle have to be within .001 Hz of
the next guess frequencies for the solution to be converged. You should not have to change this value unless you
require a more accurate solution (more accurate than .001?). Also, if you're doing a preliminary analysis, you may
wish to relax this tolerance to speed up the eigensolution. If you get warning 2019 (missed frequencies) try using a
more stringent convergence tolerance (increase the exponent value for the tolerance).

Saving Dynamic Solutions
After you’ve done the dynamic solution, you can save that solution to file to be recalled and used later.

Note
l

This solution is saved in a .__R file and will be deleted when the Save or Save As options are used to overwrite the file. You may also delete this file yourself.

Work Vectors
When you request a certain number of modes for dynamic analysis (let's call that number N), RISA tries to solve for
just a few extra modes. Once the solution is complete, RISA goes back to check that the modes it solved for are
indeed the N lowest modes. If they aren't, one or more modes were missed and an error is reported.
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Dynamics Modeling Tips
Dynamics modeling can be quite a bit different than static modeling. A static analysis will almost always give you
some sort of solution, whereas you are not guaranteed that a dynamics analysis will converge to a solution. This is
due in part to the iterative nature of the dynamics solution method, as well as the fact that dynamics solutions are
far less forgiving of modeling sloppiness than are static solutions. In particular, the way you model your loads for a
static analysis can be very different than the way you model your mass for a dynamic analysis.
The term “dynamics solution” is used to mean the solution of the free vibration problem of a structure, where we
hope to obtain frequencies and mode shapes as the results.
In general, the trick to a “good” dynamics solution is to model the structure stiffness and mass with “enough”
accuracy to get good overall results, but not to include so much detail that it take hours of computer run time and
pages of extra output to get those results. Frame problems are simpler to model than those that include plate
elements. “Building type” problems, where the mass is considered lumped at the stories are much easier to
successfully model than say a cylindrical water tank with distributed mass. It is often helpful to define a load
combination just for your dynamic mass case, separate from your “Dead Load” static case (You can call it “Seismic
Mass”). Your seismic mass load combination will often be modeled very differently from your “Dead Load” static
case.
Modes for discretized mass models with very few degrees of freedom may not be found by the solver, even if you
know you are asking for fewer modes than actually exist. In this case it may be helpful to include the self weight of
the model with a very small factor (i.e. 0.001) to help the solver identify the modes.

Self-Weight Considerations
Distributed mass models with plate elements, like water tanks, often require special consideration. You will want to
use a fine enough mesh of finite elements to get good stiffness results. Often though, the mesh required to obtain
an accurate stiffness will be too dense to simply model the mass with self-weight or surface loads. You will want to
calculate the water weight and tank self-weight and apply it in a more discrete pattern than you would get using
surface loads or self-weight. This method of using fewer nodes to model the mass than to model the stiffness is
often referred to as "discretizing" the mass. You want to lump the mass at fewer points to help the solution
converge faster, however you have to be careful to still capture the essence of the dynamic behavior of the
structure.
Whenever you perform a dynamic analysis of a shear wall structure, and the walls are connected to a floor, you
must be careful to use a fine mesh of finite elements for each wall. Each wall should be at least 4 elements high
between floors. This will give you at least 3 free joints between them.

Beam Vibration Considerations
When you perform a dynamic analysis of beam structures, such that you are trying to capture the flexural
vibrations, (i.e., the beams are vibrating vertically or in the transverse direction), you must make sure that you have
at least 3 free joints along the member between the points of support. If you use a distributed load as the mass, you
must remember that some of the load will automatically go into the supports and be “lost” to the dynamic solution.
In general, you will get the best results by applying your mass as joint loads to the free nodes.
If you are trying to model dynamic effects on a 2D frame, you will want to make sure that you restrain the out-ofplane degrees of freedom. See Boundary Conditions at ALL Nodes to learn how to do this.

Calculate Residual Mass
The mass of the structure that has not been activated by the solved number of periodic modes may still be included
in the response spectra analysis results. This is done by checking the Calc. Residual Mass box. This checkbox
calculates a residual mass mode shape which helps to show where the missing mass in the structure is located. It
also includes the response of this missing mass as a static correction to the response spectra results. The
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acceleration used to calculate this static correction vector is based on largest acceleration from the specified
response spectra which occurs between the user entered Cut Off frequency (see below) and the zero period
acceleration.
Note:
l

l

l

The inclusion of Residual Mass does not guarantee that dynamic solution will achieve 100% mass participation . It will normally be close.
This feature is intended to capture missing RIGID response. When un-solved mode shapes would produce significant periodic response (at frequencies less than 33 Hz, for example), it would be more accurate to include
these modes in the analysis than to assume that they are accounted for in the residual mass correction.
The implementation of the residual mass feature is based on the requirements of ASCE 4 - 1998: Seismic Analysis of Safety-Related Nuclear Structures.

Common Application for Missing Mass Vectors
If you apply your dynamic mass with distributed loads or surface loads on members/plates that are adjacent to
supports, remember that the some of the load will go directly into the support and be lost to a traditional dynamic
solution. The mass that can actually vibrate freely is your “active mass”, as opposed to your “static mass” which
includes the mass lost into the supports. If you are having trouble getting 90% mass participation, you should
roughly calculate the amount of mass that is being lost into your support to determine if that is the cause of the
problem.
Since this mass is directly associated with boundary conditions and cannot be activated by a traditional
eigensolution mode, it is referred to as the Residual Rigid Response of the structure. The common solution to
account for this response, is to check the Calc. Residual Mass? checkbox. This will calculate a "Missing Mass
Vector" or "Residual Mass Vector" to account for this residual mass in the dynamic analysis.
Alternatively, one may switch to the Ritz Vector dynamic solver because Ritz modes inherently include correction
for the rigid response

Modal Frequency Results
Access the Frequencies and Participation spreadsheet by selecting Frequencies from the Results Menu.

These are the calculated model frequencies and periods. The period is simply the reciprocal of the frequency.
These values will be used along with the mode shapes when a response spectra analysis is performed. The first
frequency with a high participation is sometimes referred to as the model's natural or fundamental frequency.
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These frequency values, as well as the mode shapes, will be saved and remain valid unless you change the model
data, at which time they will be cleared and you need to re-solve the dynamics to get them back.
Also listed on this spreadsheet are the participation factors for each mode for each global direction, along with the
total participation. If the participation factors are shown in red (as opposed to black) then the response spectra
analysis (RSA) has not been performed for that direction. If the RSA has been done but a particular mode has no
participation factor listed, that mode shape is not participating in that direction. This usually is because the mode
shape represents movement in a direction orthogonal to the direction of application of the spectra. See Dynamic
Analysis - Response Spectra for more information.

Note:
l

l

l

If you have not solved an RSA for a given direction then the participation factor will show in red as an indicator. This is not an indication that there is anything wrong with the solution.
If you are using the Calc Residual Mass? checkbox then you will get three "residual" mode shapes that will
account for the missing mass vector. For more information on this see the Residual Rigid Response section.
At this time residual / missing mass modes are not considered in Time History analysis.

Mode Shape Results
Access the Mode Shape spreadsheet by selecting Mode Shapes from the Results Menu.

162

RISA-3D V20

Dynamic Analysis - Eigensolution

These are the model's mode shapes. Mode shapes have no units and represent only the movement of the nodes
relative to each other. The mode shape values can be multiplied or divided by any value and still be valid, so long
as they retain their value relative to each other. To view higher or lower modes you may select them from the
drop-down list of modes on the Window Toolbar.

Note
l

l

Keep in mind that the X, Y, and Z mode shapes do not, in and of themselves, represent model deflections.
They only represent how the nodes move relative to each other. You could multiply all the values in any
mode shape by any constant value and that mode shape would still be valid. Thus, no units are listed for
these mode shape values.
The rotation is in units of radians.

These mode shapes are used with the frequencies to perform a Response Spectra Analysis. The first mode is
sometimes referred to as the natural or fundamental mode of the model. The frequency and mode shape values will
be saved until you change your model data. When the model is modified, these results are cleared and you will
need to re-solve the model to get them back.
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You can plot and animate the mode shape of the model by clicking the Results button in the Animate section within
View tab. This allows you to verify the mode shapes that were obtained and highlights local modes making them
easy to troubleshoot. See Results View Settings - Deflections for more information.

Dynamics Troubleshooting – Local Modes
A common problem you may encounter are “localized modes”. These are modes where only a small part of the
model is vibrating and the rest of the model is not. A good example of this is an X brace that is vibrating out of
plane. Localized modes are not immediately obvious from looking at the frequency or numeric mode shape results,
but they can be spotted pretty easily using the mode shape animation feature. Just plot the mode shape and
animate it. If only a small part of the model is moving, this is probably a localized mode.
The problem with localized modes is that they can make it difficult to get enough mass participation in the response
spectra analysis (RSA), since these local modes don’t usually have much mass associated with them. This will show
up if you do an RSA with a substantial number of modes but get very little or no mass participation. This would
indicate that the modes being used in the RSA are localized modes.
Quite often, localized modes are due to modeling errors (erroneous boundary conditions, members not attached to
plates correctly, etc.). If you have localized modes in your model, always try a Model Merge before you do anything
else. See Model Merge for more information.

Eliminating local modes Using Boundary Conditions
To get rid of localized modes that are not the result of modeling errors, you can sometimes use boundary conditions
to restrain the mode shape. For example, if your localized mode is at a weak X brace (as mentioned before), you
could attach a spring to the center of the X brace to restrain the mode shape. Alternatively, in this instance you
could also:
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l

l

Make the braces a weightless material. In that case no mass would be assigned to the X-brace intersection
and it would not participate in the eigensolution.
Delete the node at the crossing of X-braces. If there is no node here there is no degree of freedom. This location will not likely be crucial for a dynamic solution anyway, so eliminating the node eliminates a flexible
mode with minimal mass participation.

Using Ritz Vectors to Minimize Local Modes
Another cause of local modes is including the self-weight in models with walls or horizontal diaphragms modeled
with plate/shell elements. These walls and floors can have many modes that will tend to vibrate out-of-plane like
drums, but will have very little effect on the lateral seismic response of the structure. For cases like this it will often
be better to switch from the standard or accelerated dynamic solvers to the Ritz Vector dynamic solver because Ritz
vectors are inherently biased to avoid modes with little mass participation in the desired direction.
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Dynamic Analysis - Response Spectra
A Response Spectra Analysis may be performed after the dynamic analysis to obtain forces, stresses and deflections.
In general, the response spectra analysis procedure is based on the assumption that the dynamic response of a
structural model can be approximated as a summation of the responses of the independent dynamic modes of the
model.

To Perform a Response Spectra Analysis
1. Select Dynamics (Eigensolution / Response Spectra) from the Solve menu.
2. Set the Eigensolution parameters.
3. Select the desired Combination Method. Then use the checkboxes to indicate which directions you want to
perform your response spectra analysis.
4. Select the spectra to be used for each direction. Then specify the other parameters.

Note
l
l

l

For a more thorough explanation of the Eigensolution options refer to Dynamic Analysis - Eigensolution.
Upon the completion of the solution you are returned to the Frequencies and Participation spreadsheet and the participation yielded by the RSA is listed. To view model results such as forces/deflections/reactions you will need to create a load combination on the Load Combination spreadsheet
that includes the spectra results. See below.
The Dynamic Solver options are located in the Model Settings - Solution tab Advanced options.

To Include Response Spectra Analysis Results in a Load Combination
1. After running the response spectra analysis go to the desired combination on the Load Combination spreadsheet.
2. In the BLC column enter "SX", "SY", or "SZ" as the BLC entry (SX for the X direction RSA results, SY for the Y
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direction RSA results, etc.).
3. To scale the spectral results enter the spectra-scaling factor in the Factor column.

Note
l

You can include more than one spectra solution in a single load combination. If you do this you can also
have RISA-3D combine the multiple RSA results using an SRSS summation. To do this, set the "RSA
SRSS" flag for the combination to "+" or “-”. Use “+” if you want the summed RSA results (which will be
all positive) added to the other loads in the load combination. Use “-” if you want the summed results
subtracted.

Response Spectra
The response spectra represent the maximum response of any single degree of freedom (SDOF) system to a
dynamic base excitation. The usual application of this method is in seismic (earthquake) analysis. Earthquake time
history data is converted into a "response spectrum". With this response spectrum, it is possible to predict the
maximum response for any SDOF system. By "any SDOF system", it is meant a SDOF system with any natural
frequency. "Maximum response" means the maximum deflections, and thus, the maximum stresses for the system.

Response Spectra Analysis Procedure
In the response spectra analysis procedure, each of the model's modes is considered to be an independent SDOF
system. The maximum responses for each mode are calculated independently. These modal responses are then
combined to obtain the model's overall response to the applied spectra.
The response spectra method enjoys wide acceptance as an accurate method for predicting the response of any
structural model to any arbitrary base excitation, particularly earthquakes. Building codes require a dynamics
based procedure for some structures. The response spectra method satisfies this dynamics requirement. The
response spectra method is easier, faster and more accurate than the static procedure so there really isn't any
reason to use the static procedure.
If you wish to learn more about this method, an excellent reference is Structural Dynamics, Theory and
Computation by Dr. Mario Paz (1991, Van Nostrand Reinhold).

Frequencies Outside the Spectra
If a response spectra analysis is solved using modal frequency values that fall outside the range of the selected
spectra, RISA will extrapolate to obtain spectral values for the out-of-bounds frequency. If the modal frequency is
below the smallest defined spectral frequency, a spectral velocity will be used for the modal frequency that will
result in a constant Spectra Displacement from the smallest defined spectral frequency value. A constant spectral
displacement is used because modes in the “low” frequency range will tend to converge to the maximum ground
displacement. If the modal frequency is above the largest defined spectral frequency, a spectral velocity will be
used for the modal frequency that will result in a constant Spectra Acceleration from the largest defined spectral
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frequency value. A constant spectral acceleration is used because modes in the “high” frequency range tend to
converge to the maximum ground acceleration (zero period acceleration).

Mass Participation

The mass participation factors reported on the Frequencies Spreadsheet reflect how much each mode participated
in the Response Spectra Analysis solution. Remember that the RSA involves calculating separately the response for
each mode to the applied base excitation represented by the spectra. Here is where you can tell which modes are
important in which directions. Higher participation factors indicate more important modes. The participation
factor itself is the percent of the model's total dynamic mass that is deflecting in the shape described by the
particular mode. Thus, the sum of all the participation factors in a given direction can not exceed 100%.
The amount of participation for the mode may also reflect how much the mode moves in the direction of the
spectra application. For example, if the 1st mode represents movement in the global Y direction it won't participate
much, if at all, if the spectra is applied in the global X direction. You can isolate which modes are important in
which directions by examining the mass participation.

Note
l

l

l

Usually for the RSA to be considered valid, the sum of the modal participation factors must equal or
exceed 90% (e.g. ASCE7-10, Section 12.9.1). If you do an RSA and the total participation is less than
90%, you need to return to the dynamic solution and redo the dynamic analysis with more modes. If
you are getting a lot of modes with little or no participation see Dynamics Troubleshooting – Local
Modes.
You may also want to account for accidental torsion. See Modeling Accidental Torsion to learn how to do
this.
Models with a large amount of mass lost into boundary conditions may have difficulty achieving 90%
mass participation. See Dynamics Modeling for more information.

Modal Combination Option
There are three choices for combining your modal results: CQC, SRSS, or Gupta. In general you will want to use
either CQC or Gupta. For models where you don’t expect much rigid response, you should use CQC. For models
where the rigid response could be important, you should use Gupta. An example of one type of model where rigid
response would be important is the analysis of shear wall structures. The SRSS method is offered in case you need
to compare results with the results from some older program that does not offer CQC or Gupta.
CQC stands for "Complete Quadratic Combination". A complete discussion of this method will not be offered here,
but if you are interested, a good reference on this method is Recommended Lateral Force Requirements and
Commentary, 1999, published by SEAOC (Structural Engineers Assoc. of Calif.). In general, the CQC is a superior
combination method because it accounts for modal coupling quite well.
The Gupta method is similar to the CQC method in that it also accounts for closely spaced modes. In addition, this
method also accounts for modal response that has “rigid content”. For structures with rigid elements, the modal
responses can have both rigid and periodic content. The rigid content from all modes is summed algebraically and
then combined via an SRSS combination with the periodic part which is combined with the CQC method. The Gupta
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method is fully documented in the reference, Response Spectrum Method, by Ajaya Kumar Gupta (Published by
CRC Press, Inc., 1992).
The Gupta method defines lower ( f 1 ) and upper ( f 2 ) frequency bounds for modes containing both periodic and
rigid content. Modes that are below the lower bound are assumed to be 100% periodic. Modes that are above the
upper bound are assumed to be 100% rigid.

Unsigned (All Positive) Results and the Use Dominant Mode For Signage Checkbox
A response spectra analysis involves calculating forces and displacements for each mode individually and then
combining these results. The problem is both combination methods offered (SRSS and CQC) use a summation of
squares approach that loses the sign. This means that all the results are positive, except reactions, which are all
negative as a result of the positive displacements.
Because the RSA results are unsigned you cannot directly add the results to other static loads in you model. One
way around this is to treat the RSA results as both positive and negative by manually providing the sign. Using two
combinations for each RSA result, one with a positive factor and the other with a negative factor you can capture
the maximum deflections, stresses and forces when combining with other loads. See Load Combinations with RSA
Results for an example.
The mass participation may indicate that a model is dominated by a single mode in a direction. You may base the
signs for the final combined RSA results on the signs for the RSA for this single dominant mode by checking the box
that says “Use Dominant Mode for Signage?”. When that option is selected then the Mode that that the highest
mass participation in that direction will be considered to be the dominant mode.

Limitations on Response Spectra Results
Because of the statistical method used to combine the results , response spectra results can be confusing or
misleading to engineers that are not familiar with the process. The confusion is usually associated with the fact any
single response spectra result is correct, but that it is not known whether the sign of that result should be positive
or negative. This results in a number of limitations that should be considered when using response spectra analysis.
Statics: By default with an RSA solution the results will not obey statics, due to the nature of combining the modes
via SRSS, CQC, etc. Thus, if you view the reactions, member forces, etc., the model will not obey statics. If the model
has a "dominant" mode in the given direction then the normal path forward would be to select the Use Dominant
Mode for Signage? checkbox when solving for the dynamic solution.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Response Spectra Reactions Satisfy Statics.
Deflected Shape: By default with an RSA solution the results will not obey statics, due to the nature of combining
the modes via SRSS, CQC, etc. Thus, if you view the deflected shape you will see that the deflected shape looks odd.
Similar to the "Statics" limitation above, one possible path forward is to use the Use Dominant Mode for Signage?
checkbox when solving your dynamic solution.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Response Spectra Reactions Satisfy Statics.
Plate and Wall Contours: Plate contours are not presented to the user for RSA load combination unless the Use
Dominant Mode for Signage? option has been chosen. This is because the results can be misleading due to the
"Statics" issue described above.
Wall Panel Reactions: Wall Panel reactions consist of a number of internal nodal reactions that are then summed
together across the wall. Since the signs of those reactions are unknown, the reactions for each Wall Panel cannot
be correctly calculated. There are two methods of dealing with this issue:
1. The solution described in the "Statics" limitation above
2. Use the Wall Forces spreadsheet results or Wall Detail Report instead.
Note:
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l

The Wall Force results (in the detail reports and the Wall Force Results spreadsheet) are calculated correctly
because each force is calculated and stored for each mode, which allows a final RSA result to be calculated
using the combination method (SRSS, CQC etc) chosen by the user. A future revision to the program may be
to calculate and store wall reactions for each mode similar to what is done for the Wall Forces spreadsheet.

Internal Force Summation Tools : Because the Internal force summation tool relies on plate corner forces, these
results are not available for wall panels for any load combination which contains RSA results. Internal force
summation tools may be used on other portions of the model. However, they will face the same issue that is
described under the "Statics" limitation above. For that reason the results are suppressed unless the Use Dominant
Mode for Signage? option has been chosen.

Other Options
Cut Off Frequency
This is the frequency used by the Gupta method to calculate the upper bound for modes having periodic and rigid
content. The “rigid frequency” is defined as “The minimum frequency at which the spectral acceleration becomes
approximately equal to the zero period acceleration (ZPA), and remains equal to the ZPA”. If nothing is entered in
this field, the last (highest) frequency in the selected response spectra will be used.
For seismic response, the typical cutoff frequency would be 33 Hz.

Damping Ratio
The damping ratio entered here is used in conjunction with the CQC and Gupta combination methods. This single
entry is used for all the modes included in the RSA, an accepted practice. A value of 5% is generally a good number
to use. Typical damping values are:
2% to 5% for welded steel
3% to 5% for concrete
5% to 7% for bolted steel, wood

RISAFloor Spectra Results
When a response spectra analysis is run in a combined RISAFloor/RISA-3D model with multiple eigen solutions
(centered mass versus eccentric mass solutions), the results for each item will be based on the worst case of the
response spectra for the multiple modes. An example would be that node N1 gets its base reaction value from the
centered mass response spectra solution while another node, N2, gets its base reaction from the Plus X eccentric
mass response spectra solution.
When using the Use Dominant Mode for Signage option with multiple eigen solutions under RISAFloor, the
dominant mode is defined by the centered mass solution with highest mass participation in that direction.

RSA Scaling Factor (Manual Scaling)
The most difficult part of the entire RSA procedure is normally calculating the scaling factor to be used when
including the RSA results in a load combination.
The ASCE 7 uses a particular “shape” for it’s spectra (See Figure 11.4-1), but the parameters SDS and SD1 make it
specific to a particular site. However, the ASCE 7 imposes several requirements regarding the minimum design
values. ASCE 7-16 Section 12.9.1.4.1 specifies a modification factor, V/Vt( ASCE 7-10 Section 12.9.4.1 specifies a
modification factor, 0.85*V/Vt), that may be used to scale the response spectra results to something less than or
equal the base shear calculated using the static procedure (ASCE 7 Sect. 12.8).
The static base shear (V) is calculated using the equations in ASCE 7-16 Sect. 12.8.1
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Note that there are limiting values for the static base shear in ASCE 7-16 equations 12.8-3 through 12.8-6.
Therefore, in order to calculate the proper scaling factor, we need to know what the unscaled RSA base shear (this
is called the Elastic Response Base Shear in the IBC) is, and we also need to calculate the value of "V" (static base
shear). The calculation of V isn't particularly difficult because the two values that present the biggest problem in
this calculation (T and W) are provided by RISA. To calculate the value of W, simply solve a load combination
comprised of the model seismic dead weight. This almost certainly will be the same load combination you used in
the Dynamics settings for the Load Combination for Mass. The vertical reaction total is your "W" value.
The T value is simply the period associated with the dominant mode for the direction of interest. For example, if
you're calculating the scaling factor for a Z-direction spectra, determine which mode gives you the highest
participation for the Z direction RSA. The period associated with that mode is your T value. Note that there are
limiting values for T, see ASCE 7-16 section 12.8.2.
Calculating the unscaled RSA base shear also is very straightforward. Just solve a load combination comprised of
only that RSA, with a factor of 1.
Example:
l

l

l

Assuming we're looking at a Z direction RSA, enter “SZ” in the BLC field of the Load Combinations spreadsheet and for the Factor enter "1". Leave all the other BLC fields blank.
Solve the load combination and look at the Z direction reaction total. This total value is the unscaled RSA
base shear.
To get the correct scaling factor, solve this equation:
Scale Factor = (V / Unscaled RSA base shear)

You would do this calculation to obtain the scaling factors for all the directions of interest (X, Y and/or Z). Unless
the model is symmetric the fundamental period for each direction is probably different. Be sure to use the proper
value for "T" for the direction being considered.
Note: The ASCE 7 has additional requirements for vertical seismic components. (See ASCE 7-16 section 12.4.2.2).

RSA Scaling Factor (Automatic Scaling)
The most difficult part of the entire RSA procedure is normally calculating the scaling factor to be used when
including the RSA results in a load combination. The Scaling Factor tool can be used to automatically calculate the
RSA scaling factor for each direction within your model.
The RSA scaling factors automatically default to 1.0 and can only be changed from within the Scaling Factor dialog.
The dialog may be opened by clicking the scale factor button, RSA Scaling Factor, at the top of the Load
Combinations spreadsheet.

Note
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l

Currently these factors are only calculated when you open this dialog and click the Calculate button.
Therefore, if you have previously calculated these and then made changes to your model, you will need
to come back into this dialog and re-click the Calculate buttons to update the scaling factors.

Base Shear
The Base Shears section of the Spectra Scaling Factor dialog box reports to you the static base shear and the unscaled RSA base shear for each direction. If these values have not been calculated yet, then you may press the
Calculate button. This will launch the Seismic Load Generation window for the calculation of the Static Base Shear,
or the Dynamic Solution dialog for the calculation of the Unscaled Base Shear for your Response Spectra results.

Scaling Factor
Program Calculated
This section compares the ELF (Equivalent Lateral Force) Limit, as reduced by the Base Shear Multiplier, and the
I/R Limit. These values are explained in detail below.
l

l

l

l
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The Base Shear Multiplier is used in the calculation of the ELF Limit. This multiplier can be used to reduce
the calculated (unscaled) base shear lower (typically no more than 85%) than the Equivalent Lateral Force
Method per ASCE 7-10. For the 1997 UBC, this is covered in section 1631.5.4. For the 2000 IBC, this is
covered in section 1618.7. For the 2015 NBC, it is discussed in clause 4.1.8.12 (8). In the ASCE 7-16, it is discussed in section 12.9.1.4.1.
The ELF Limit is the limiting scaling factor calculated per the Equivalent Lateral Force procedure:

The I/R Limit simply takes the elastic dynamic base shear and reduces it to an inelastic base shear. This
value is calculated per the I (Importance Factor) and R (Response Modification Coefficient). You may edit
these values in the Seismic tab of Model Settings.
The Controlling Limit is the governing (larger) value of the ELF limit and I/R limit.
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User Input
You may manually override the program calculated factor by selecting the User Input option and entering in an
alternate value.

Apply Checkbox
The Apply SF to all RSA Load Combinations checkbox will apply the SF scale factors to all load combinations that
currently reference response spectra results. The final Load combinations will appear similar to those shown below:

Automatic Response Spectra Generation
1997 UBC
You may have the 1997 UBC spectra generated automatically by selecting "UBC 97, Parametric Design Spectra" for
your RSA. The Ca and Cv seismic coefficients are needed to calculate the values for the UBC ’97 spectra. See Figure
16-3 in the UBC for the equations used to build the spectra. See Tables 16-Q and 16-R to obtain the Ca and Cv
values. The default values listed are for Seismic Zone 3, Soil Type “Se” (Soft Soil Profile). These values can be edited
in the Seismic tab of Model Settings.

2000 IBC
You may have the 2000 IBC spectra generated automatically by selecting "IBC 2000, Parametric Design Spectra" for
your RSA. The SDS and SD1 seismic coefficients are needed to calculate the values for the IBC 2000 spectra. See
Figure 1615.1.4 in the IBC for the equations used to build the spectra. See section 1615.1.3 to obtain the SDS and
SD1 values.These values can be edited in the Seismic tab of Model Settings.

2005 ASCE
You may have the 2005 ASCE spectra generated automatically by selecting "ASCE 2005, Parametric Design Spectra"
for your RSA. The SDS, SD1, and TL seismic coefficients are needed to calculate the values for the ASCE 2005
spectra. See Figure 11.4-1 in ASCE-7 2005 for the equations used to build the spectra. See section 11.4.4 to obtain
the SDS and SD1 values and Figures 22-15 thru 22-20 for the TL value. These values can be edited in the Seismic
tab of Model Settings.

2010 ASCE
You may have the 2010 ASCE spectra generated automatically by selecting "ASCE 2010, Parametric Design Spectra"
for your RSA. The SDS, SD1, and TL seismic coefficients are needed to calculate the values for the ASCE 2010
spectra. See Figure 11.4-1 in ASCE-7 2010 for the equations used to build the spectra. See section 11.4.4 to obtain
the SDS and SD1 values and Figures 22-12 thru 22-16 for the TL value. These values can be edited in the Seismic
tab of Model Settings.
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2016 ASCE
You may have the 2016 ASCE spectra generated automatically by selecting "ASCE 2016, Parametric Design Spectra"
for your RSA. The SDS, SD1, and TL seismic coefficients are needed to calculate the values for the ASCE 2016
spectra. See Figure 11.4-1 in ASCE-7 2016 for the equations used to build the spectra. See section 11.4.5 to obtain
the SDS and SD1 values and Figures 22-14 thru 22-17 for the TL value. These values can be edited in the Seismic
tab of Model Settings.

2005 NBC
You may have the 2005 NBC spectra generated automatically by selecting "NBC 2005 Parametric Design Spectra"
for your RSA. The Site Class and the Savalues are needed to calculate the values for the NBC 2005 spectra. Please
see section 4.1.8.4(7) to obtain the Sa values and Table 4.1.8.4(A) for the Site Class. Please see section 4.1.8.4(7) for
the equations used to build the spectra.These values can be edited in the Seismic tab of Model Settings.

2010 NBC
You may have the 2010 NBC spectra generated automatically by selecting "NBC 2010 Parametric Design Spectra"
for your RSA. The Site Class and the Savalues are needed to calculate the values for the NBC 2010 spectra. Please
see section 4.1.8.4(7) to obtain the Sa values and Table 4.1.8.4(.A) for the Site Class. Please see section 4.1.8.4.(7) for
the equations used to build the spectra.These values can be edited in the Seismic tab of Model Settings.

2015 NBC
You may have the 2015 NBC spectra generated automatically by selecting "NBC 2015 Parametric Design Spectra"
for your RSA. The Site Class and the Savalues are needed to calculate the values for the NBC 2015 spectra. Please
see section 4.1.8.4(7) to obtain the Sa values and Table 4.1.8.4(.A) for the Site Class. Please see section 4.1.8.4.(7) for
the equations used to build the spectra.These values can be edited in the Seismic tab of Model Settings.

Adding and Editing Spectra
You may add your own spectra to the database and edit and delete them once they are created. You can add/edit
spectra data pairs in any configuration by choosing between Frequency or Period and between the three spectral
values. You may also choose to convert the configuration during editing. At least two data points must be defined.
Log interpolation is used to calculate spectra values that fall between entered points. Make sure that all of the
modal frequencies in your model are included within your spectra.
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To Add or Edit a Spectra
1. On the Advanced tab, click on the Response Spectra button.
2. Select Generate or View/Edit.
3. Select the format to be used and specify the parameters. For help on an item, click

.

Note
l
l

Zero values are not allowed in the data.
The spectra data is not currently stored with the RISA model file. Instead it is stored in the
RSPECT32.FIL database file located in the directory set using 3D Button - Application Settings - File Locations. If a file with a custom spectra needs to be transferred to another computer, then this file must also
be transferred to the new computer.

Tripartite Response Spectra Plot
This plot is a convenient logarithmic representation of all the values of interest in the response spectra definition.
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These values are as follows:
Frequency (f)
Period (T)
Pseudo Velocity (Sv)
Pseudo Acceleration (Sa)
Pseudo Displacement (Sd)
The relationships between these values (for the undamped case) is as follows:
T = 1. / f
Sv = Sd * 2πf = Sa / 2πf
For the tripartite plot, the frequency values are plotted along the bottom with the reciprocal period values
displayed along the top. The ordinate axis plots the Sv values (labeled on the left side) and the diagonal axes plot
the Sa (lower left to upper right) and Sd (upper left to lower right) values.
The spectra data itself is represented with the thick red line. Therefore, to determine the Sv, Sa or Sd value for a
particular frequency or period, locate the desired period or frequency value along the abscissa axis and locate the
corresponding point on the spectra line. Use this point to read off the Sv, Sa and Sd values from their respective
axes. Remember, all the axes are logarithmic!

Single Spectra Plot
This plot is a Response spectra representation that is given in the building codes. The vertical axis can plot the
spectra using Pseudo-Acceleration, Pseudo-Velocity, or Pseudo Displacement on a vertical or logarithmic scale. The
horizontal axis will plot the Period or Frequency using a Linear or Logarithmic scale.
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These values are as follows:
Frequency (f)
Period (T)
Pseudo Velocity (Sv)
Pseudo Acceleration (Sa)
Pseudo Displacement (Sd)
The relationships between these values (for the undamped case) is as follows:
T = 1. / f
Sv = Sd * 2πf = Sa / 2πf
The spectra data itself is represented with the thick red line. Therefore, to determine the Sv, Sa or Sd value for a
particular frequency or period, locate the desired period or frequency value along the horizontal axis and locate the
corresponding point on the spectra line. Use this point to read off the Sv, Sa and Sd values from their vertical axis.

General Reference Manual

177

Dynamic Analysis - Time History

Dynamic Analysis - Time History
An Eigensolution uses the mass and stiffness matrices to calculate natural frequencies and natural modes of
vibration for a structure due to free or unforced vibration. A Time History Analysis uses the mass, stiffness and
damping matrices to solve for the forced vibration of the structure due to an applied load that varies with time.
Therefore, the program must have information about the force (as a function of time) applied to the structure and
the structure's damping in order to solve the dynamic analysis.

Time History Functions / Pattern

The library of Time History functions may be accessed by clicking on the Time History Library button
the RISA Toolbar.

on

These time history functions are each stored in their own *.FIL file in the Time History sub-folder of the RISA
working directory. The path to these files is specified in 3D Button Application Settings on the File Locations
tab.
Time History Load Functions / Patterns may be Generated or Imported. Typically, seismic blast loading functions
are imported. Loading from dynamic equipment is likely to be generated from a simple sinusoidal function.

Generate
Generated Loads may be used for simple sine and cosine functions. The generate option also allows for those
functions to be assigned Ramp Up functions at the beginning of the pattern, or Coast Down functions at the end of
the pattern. These functions can adjust how both the frequency and magnitude change with time.
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Base Function

Currently, a generated function may be defined as either a sine or cosine.
The Phase angle allows the user identify sinusoidal loading that starts at values other than the maximum or zero.
The Scale Factor allows the user to scale a function up or down by a given amount. This will often be entered in as
the total force produced by the sinusoidal function.
The Freq / Period allows the user to enter the function based on whatever criteria (Hertz, Rotations per Minute, or
natural period) is most convenient for them.
Complete Last Cycle will change the duration of the function so that the last cycle is completed.
The Apply button forces the plotted image of the function to be updated. The text of this button will turn bold when
the program detects that changes have been made that are not reflected in the current function plot.

Display Range
This section controls the display of the function. This may be useful when it is necessary to zoom in on certain
times within the overall pattern / function, especially ramp up or coast down regions. This allows the user to verify
that the function is created correctly and that no discontinuity exists at the ramp up or ramp down transition
points.

The #of Steps is not as relevant to generated functions because these are displaying general functions. The default
displayed step is 0.001 seconds in the generation window and currently cannot be changed.
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The Apply button forces the plotted image of the function to be updated. The text of this button will turn bold when
the program detects that changes have been made that are not reflected in the current function plot.

Note:
l

The 0.001 second display can be problematic for high frequency functions greater than about 100 Hz. But,
this is merely a limitation in the display behavior and does not represent a problem with the internally created function.

Ramp Up
The Ramp Up section controls how the frequency and magnitude change with time at the beginning of the function.
When AutoCalc option is selected for the magnitude that means that it will vary with the square of the frequency.
This can be thought of as the behavior of the equipment when it is first turned on before it attains its normal
operating speed.

The Apply button forces the plotted image of the function to be updated. The text of this button will turn bold when
the program detects that changes have been made that are not reflected in the current function plot.

Coast Down
The Coast Down section controls the frequency and magnitude change with time at the end of the function. When
AutoCalc option is selected for the magnitude that means that it will vary with the square of the frequency. This
can be thought of as the behavior of the equipment as it is turned off and slows down from its operating speed.

The Apply button forces the plotted image of the function to be updated. The text of this button will turn bold when
the program detects that changes have been made that are not reflected in the current function plot.

Import
For more complex functions, the program allows importing from a text file. That text file must be written in a
particular format in order to be read properly. See information below for a brief example:
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[TIME_HISTORY_INPUT_DATA]
[HEADER]
Original Blast
[END_HEADER]
[FUNCTION_INFO]
[.MULTIPLIER] <1>
1 ;
[.END_MULTIPLIER]
[.TIME_STEP] <1>
0.1 ;
[.END_TIME_STEP]
[.RECORD_PER_LINE] <1>
1;
[.END_RECORD_PER_LINE]
[END_FUNCTION_INFO]
[RECORDS] <7>
0.
5.
3.
1.
-1.
-0.5
0.
[END_RECORDS]
[END_FILE]
The [HEADER] section is the name of the time history as it will appear in the library of time history patterns /
functions. This section is a required field.
The [FUNCTION_INFO] section gives information on the function itself, like time step, number of records per line, et
cetera.
The [.MULTIPLIER] is used for converting the units of the record data. For example, acceleration records in RISA
are assumed to be entered in terms of acceleration of gravity. If the record gives the acceleration in terms of meters
per second squared, then this multiplier would be set to 0.10194 (1/9.81). This value will be assumed to be equal to
1.0 if not specifically entered.
The [.TIME_STEP] will be assumed to be 0.01 sec if not entered.
The [.RECORD_PER_LINE] field corresponds to the number of records per line. This will be assumed to be 1 if not
entered.

Note:
l

l

Acceleration based functions are assumed to already be entered in terms of the acceleration of gravity (g).
Therefore, it is not necessary to multiply
Text files which illustrate example functions exist in the RISA\Time History\ sub-folder of the main RISA directory. These are merely ASCII text files with an extension of *.TH to identify them as Time History functions.

The [RECORDS] section gives the actual time history records. These values may be separated by spaces, semicolons or carriage returns. The <number> which follows this entry is the number of lines of data, not the total
number of records. Therefore, if the file contains 3 records per line and 500 lines of data. This entry would say
<500> not <1500>

View/Edit
The View / Edit Dialog looks different depending on what type of time history function is being viewed. When it is a
generated sinusoidal function, there are controls that allow the user to edit the function. This editing is performed
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with the same controls (Freq/Period, Ramp Up, Coast Down) shown in the Generate screen.
When it is an imported time history, the only editing that can be done is to shorten the duration time of the motion.
This can be done, for example, if the imported Seismic Record contains 50+ seconds of data, but the strong motion
data lasts only a fraction of that time. If this is desired, then enter cutoff time in the duration and the time history
function will be truncated at that time.

In this view / edit dialog, the Values table lists the time / value pairs for the function. This can be used to view the
exact time at which the function reaches a maximum or the exact value of a function at a given moment in time.
Hovering the cursor over the graph will make a vertical grey line appear that will follow the cursor so long as it is
hovered over the graph area. Clicking anywhere in the graph area will then highlight the corresponding values in
the Values table on the right-hand side.

Time History Loads Spreadsheet
The Time History Loads spreadsheet allows the user to assign one of the existing time history to specific nodes or
all nodes in the model. This spreadsheet may be accessed by selecting Time History Loads from either the
Spreadsheets Data Entry Time History Loads portion of the Main Menu toolbar, or the Data Entry Toolbar.
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Each Time History Load definitions is automatically assigned a Tag (such as T1, T2, et cetera) as shown on the left
side of the spreadsheet. These tags are assigned by the program and may not be edited. Time History Loads are
included in the analysis by referencing this Tag in the Load Combinations spreadsheet. Multiple loads or lines of
data may be assigned within a given time history tag.

Label
This field is editable and is for the users reference as an identifier for that specific set of time history loads. Only
one label is allow per time history tag, even if the tag contains multiple lines of data.

Time Step
This is used to specify the integration time step used in the time history analysis. Refer to the section titled What
integration time step should I use? for more information on this subject. Only one time step is allowed for a given
time history tag, even if the tag contains multiple lines of data.

Note:
l

l

l

l

The user has the option of leaving the time step blank. If this is done the program will automatically use
a value of 1/10th the lowest mode with at least 10% mass participation. If the time history forcing function were imported, the time step will not be taken greater than the time step specified in the imported
function. If the user input time step is greater than either of the two above limits then a warning log message will be produced.
Using the HHT method for a Direct Integration solution in combination with a negative alpha integration
constant creates some energy dissipation of higher frequency response. This may allow the user to set
integration time steps that are greater than the values described above.
If multiple Time Histories are applied at the same time for a single load combination then the lowest
integration time step will be used.
If multiple time histories are applied to a load combinations, which do not overlap, then each time history will be integrated based on the smaller time step

What Integration Time Step Should I Use?
The answer to this question is a matter of engineering judgment, of course. And, a good reference on dynamic
analysis should be consulted. However, there a few basic factors that come into play. This section is not meant to
provide definitive recommendations on what the engineer should do. Rather it is meant to identify some common
practices.
For dynamic equipment with a known excitation frequency, the answer will usually be based on the operating
frequency. A common choice would be to pick an integration step equal to 1/20th or 1/24th the operating period of
the equipment. Though the exact fraction of the operating period can be debated, the 1/20th and 1/24th values
ensure there is an integration step for every 18 or 15 degrees of rotation.
For a more random excitation (like seismic loading), the important consideration is more likely to be related to the
natural frequencies of the structure which have significant mass participation. A common choice would be to make
sure that the integration step is less than 1/10th the smallest significant natural period. Though again, the exact
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fraction of the significant period can be debated. It may also be necessary, however, to identify the frequency
content of the forcing function and use a time step (similar to the 1/20th of the lowest equipment period) that can
capture the frequency content of the forcing function.

Type
This indicates whether this time history function applied to the model will be a Force or an acceleration. Units for
each are reported in the status bar at the bottom of the screen. Acceleration functions are always assumed to be
given as a fraction of the acceleration of gravity.

Function
This identifies the Time History Function / Pattern that will be applied to the model.

Node
The time history load function is applied to the node specified. For seismic time history analysis, the node should be
identified as ALL to indicate that the acceleration load is applied to the entire model.

Dir
The direction setting identifies the direction of the load. This is input with respect to the global axes, X, Y, and Z.

F Factor
This is a magnification factor applied to the function. This can be used for any purpose the user desires. A common
use would be to use this field to account for an increase in the operating speed of dynamic equipment, or to account
for tributary area for a blast analysis. A blank value will default to 1.0.
For example, theBlastLoadingExample function is really a time dependent pressure resulting from some form of
explosion. The load is applied to individual joints thus the F Factor is used to enter the tributary area for each node.
Therefore, this effectively converts the blast load from pressure to force.

T Factor
This factor adjusts the time steps in the forcing speed of the forcing function. A factor less than 1 increases the
speed of the equipment and a factor greater than 1 decreases the speed of the equipment. This can be a quick and
useful way to adjust a given TH function for variations in speed instead of having to create new functions for each
case. A blank value will default to 1.0.
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For example, the 0.9 T Factor is used to adjust the 3000 RPM function to something that is about 11% higher (1/0.9
= 1.11111). This would be about 3333 RPM.
Similarly, use a factor of 1.10 is used to adjust the 3000 RPM function to something that is about 9% lower (1/1.10
= 0.90909). This would be about 2727 RPM.

Note: One important consideration is that the integration time step is not automatically converted based on the T
Factor. That is why the time step changes from 0.001 seconds to 0.00909 in the example above. This is only
necessary in this example because the desire was to have exactly 20 integration steps for each full cycle of the sine
wave. This means that there will be an integration time step for every pi/10 radians of cyclic motion.

Arrival
This indicates the time at which the forcing function will start. A blank value will default to 0.

Run Out
This indicates how long to continue the time history integration after the function has ended. A blank value will
default to 0.
To Apply a Time History Load
1.
2.
3.
4.
5.
6.
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From the Spreadsheets menu, select the Time History Loads spreadsheet from the Data Entry button.
Specify a function / pattern in the Function field by selecting it from the drop down list.
In the Time Step field specify the time (in seconds) between each integration time step.
Use the Type field to indicate whether the entry will correspond to a force / moment or an acceleration.
Specify the node and direction using the Nodes and Dir fields.
The remaining fields will adjust the force factor, the time step / period of the input motion, and arrival time.
These may be left blank if no modification is necessary.
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Note:
l

If the load is to apply to all nodes in the model, enter the node label as "ALL".

To Include a Time History Load in a Load Combination
1. To include a Time History in your analysis, specify it in the Load Combinations spreadsheet in one of the
BLC fields and enter a corresponding BLC Factor.
2. You may either type in the Time History load tag (i.e. T1, T2, etc.) directly or you may select it by
clicking the ellipsis
the drop down list.
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Required Number of Modes
The time history solution requires the use of the structure's mass matrix. In order to ensure that this matrix is
present and valid, RISA requires an active Dynamic / eigen solution before a Time History Analysis can be run. The
number of modes that need to be solved, however, depends on the Time History Solution method chosen by the
user.

Modal Superposition
For dynamic equipment with a known excitation frequency, the required number of modes is usually related to the
operating frequency of the equipment. This means solving for all modes within certain percentage of the operating
frequency of the equipment, even if those modes have little mass participation.
For more random excitation (like seismic loading), the important consideration is likely the total mass participation
for the solved modes.

Note
l

l
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If you are obtaining many modes with little or no mass they are probably local modes. Rather than asking for even more modes and increasing the solution time refer to Dynamics Troubleshooting – Local
Modes to learn how to deal with these unwanted local modes.
At this time residual mass / missing mass vectors are NOT considered in a Time History analysis. Therefore, models with low mass participation would be more efficiently solved using the Ritz Vectors solution
option.
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Direct Integration
The number of modes solved during a dynamic analysis does NOT affect the accuracy of the Time History solution
when the Direct Integration solution method is chosen. The dynamic analysis is only required to ensure that RISA
has a valid stiffness matrix available to be used during the time history solution.

Damping
Modal Superposition
When the Modal Superposition option is chosen, RISA requires the user to enter in a single damping value which
applies to all modes. While it is technically possible to assign a different damping value for specific modes,
RISA does not currently support this behavior.
The modal superposition method does not support the building of a damping matrix. Therefore, the user defined
damping values that are associated with translational or rotational springs are not used in the solution.

Direct Integration
When the Direct Integration solution option is chosen, the damping matrix will generally be built using the classic
Rayleigh Damping formulation based on the Mass proportional and Stiffness proportional damping as shown in the
following equations where mu and kappa are merely constants used to form the damping matrix out of the existing
mass and stiffness matrices.

The relationships between mass and stiffness and frequency means that the % damping values vary with frequency
(see curve below). These values can be adjusted so that a targeted damping ratio is achieved at two specific
frequencies. In the image below, the target damping ratio was 5% at 15 Hz and 18.33 Hz. It remains relatively close
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to 5% between those target frequencies, but will be slightly less than 5%.

The user may directly assign the mu and kappa constants, or they may choose to use the dialog below which is
activated by clicking on the ellipsis
button in the advanced solution dialog of the Model Settings. The user need
only enter in their targeted damping ratio and the two target frequencies, then the program will calculate a mu and
kappa value that produces the desired damping for those frequencies.
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Note
l

It is technically possible to build the damping matrix so that different material types have different damping values. This could be accomplished by setting different mu and kappa values for the different materials. The RISA interface does not currently support this type of damping, but it is being considered for a
future release.

User Defined Spring Damping
When the structure is supported on spring boundary conditions, the user may directly enter damping values using
the boundary conditions spreadsheet or dialog. This directly sets the values of the damping matrix for those
boundary condition degrees of freedom. The most common usage for this is when the user wishes to use Rayleigh
Damping for the super structure, but a higher damping ratio to model the represent the higher levels of damping
that occur at the soil / structure interface due to the radiation of the vibrational energy into semi-infinite material
that is not part of the structural model.

Soil Properties
For industrial foundations subject to large dynamic forces, one of the variable properties to be considered are the
properties (stiffness and damping) of the soil. This section is not meant to provide true recommendations on what
the engineer should do. Rather it is meant to identify some common practices and point to some references which
may discuss the matter in more depth.

Stiffness and Damping
One of the considerations for soil stiffness is the magnitude of the anticipated response. For most dynamic
equipment, the amplitude of the vibration response may be assumed to be low. The type of elastic soil stiffness that
is estimated in a soils report, may be intended to limit settlement or prevent soil failure. If so, this would be an
inappropriately low estimate for a vibration response. That's because it is based on large strains at ultimate failure
levels. Instead, it would be more appropriate to use a higher soil stiffness based on low magnitudes of vibration that
are expected during normal operation.
The American Concrete Institute (ACI) has an excellent report titled ACI 351.3-R Foundations for Dynamic
Equipment. This document references a number of other good technical sources. But, in the opinion of the
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Engineers at RISA, this ACI document is probably the best starting point for understanding how to set these
parameters. In particular this document describes two common methods for assessing the stiffness properties of the
soil.
Richart - Whitman Model: This is a frequency independent method of determining foundation stiffness (vertical,
horizontal, and rocking) and damping. Equations for calculating this stiffness are found in section 4.2.1.1 of ACI
351.3-R.
Veletsos Model:This is a frequency dependent criteria for establishing soil stiffness (vertical, horizontal and rocking)
and damping. The dominant operating frequency of the equipment would be the normal choice for calculating the
Veletsos stiffness and damping values.
Unfortunately, it is not as simple as just calculating a value from these models and using that value. The final
decision will involve some engineering judgment and experience. Decisions which require engineering judgment:
l

l

l

l

What criteria should be used for establishing the soil properties the Richard-Whitman (frequency independent) or the Veletsos (frequency dependent) model?
How much variation should be assumed in the soil stiffness? Since the soil properties are not know precisely,
do you run a separate analysis at +10% and -10% of the base values calculated?
How do you adjust the damping values? The ACI sections referenced above describe the radiation / geometric damping that would occur. This likely accounts for the majority of the energy loss in the soil, but
there is also material damping (somewhere between 2 and 5% of critical damping) that would occur as well.
What is the maximum damping value allowed per your design criteria? There is often design criteria that will
limit the maximum damping to be considered in the analysis to some percentage of critical damping.

Note
l

User entered damping values for spring boundary conditions are only considered when using the Direct
Integration method of Time History analysis and are not supported when using the Modal Superposition
method.

Results - Time History Trace
When Time History results are available the user may view a trace of particular node results as a function of time.
This may be viewed by selecting Advanced TH Trace from the main menu toolbar.
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The user may choose between displaying Displacement, Velocity, Acceleration, or Reaction. The user may also
choose the direction to display as X, Y, or Z . In addition, the user may choose to view the RX, RY, RZ rotational
displacement, velocity, acceleration or moment reaction. These values are all given with respect to the global axes.
The slider bar at the bottom of the dialog is linked to the Values table on the right hand side of the screen to allow
the user to see exact values for any time in the trace. Values that correspond to the slider bar location will be
highlighted in gray in the table.
The Display Range allows the user to view only selected portions of the solved data if extra clarity is needed for a
relative tight window of time.
This image may be printed or the data may be exported to an ASCII text file that can be opened in Excel or Access
or such.

Results - Export Time History Traces

This feature will export a series of time history traces to an ASCII text file that can be opened in excel. This can be
done for a graphical selection of nodes by clicking the Export TH Trace button. This button becomes available
whenever a valid time history solution is present.
The Values to Export section indicates whether you are exporting displacements, velocities, accelerations,
reactions, or input functions. It also dictates for which directions the export is being performed.
The Load Combinations section allows the user to export for all the solved time history load combinations or only
a single one. It also allows the user to export only a specific time range of the overall response. This then allows the
user to ensure that they are getting only the steady response when performing an equipment vibration analysis and
that any transient response due to start-up effects can be excluded.
The Field Delimiter section allows the user to choose what characters will be used to separate individual fields.
General Reference Manual
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The Report Section Options controls the column headers in the ASCII text files as well as whether or not the user
wants to see the time values, or time steps in the file itself.

Results - Animate Time History Deflection
When a time history load combination has been solved, the user may build a animation movie of the deflected
shape of the structure as a function of time. The user can speed up or slow down the animation to control the
length of the movie. They may pause it and re-start it at a particular time step or time.

Note
l
l

Time History Deflection diagrams only display joint translation. Joint rotation is not currently displayed.
The Export Animation feature may be used to save a video file of the animated mode shapes.

To View a Time History Animation
1. From the View tab, go to the Animate section and click the Results button.
2. Select the load combination that you would like to animate after clicking the Time History radio button.
3. Click the
button.
This will bring up the Animation window similar to what is shown below:
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To Add Trace Data to the Animation

1. Click the Trace button to bring up the small dialog window below.
2. Specify the node, direction and Display Type(displacement reaction or input function).
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3. Click OK and a Time History Trace of the specified joint result or input function will be appended to the bottom of the deflection animation.
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Member Stiffness Issues:
Cracking for Concrete Member
The design tab of the load combinations spreadsheet has a Service checkbox which indicates whether the loading is
at service level (when the box is checked) or ultimate level (when the box is unchecked).
If the Time History Load combination has the service box checked, then the concrete stiffness will be the larger
stiffness assumed for service level loads. If the box is unchecked, then the concrete members will have the lower
stiffness that is applicable for ultimate level loads.

Note
l
l

l

This applies to both Concrete members and concrete walls.
This does NOT currently apply to Masonry walls which always assume a level of cracking that occurs at
ultimate level loads.
Refer to relevant sections in the Concrete Design, and Wall Panel topics for more information.

What Solution Method should I Use?
Two different Time History procedures are discussed in detail in the Solution topic.
The choice between the two solution methods comes down to questions about solution speed and damping . The
Modal Superposition method will be faster for models that don't require large number of modes in the dynamic
solution. But, the advantage in solution speed gets reduced as the number of modes solved gets very high.
Therefore, this solution method would normally be used in cases where solution speed is the main consideration.
The Direct integration procedure doesn't technically require any modes to be solved. However, RISA requires that
one mode be solved so that the program can build and validate the mass matrix before the Time History solution.
Therefore, in models where it is very difficult to capture enough modes to get a comfortable level of mass
participation, the Direct Integration procedure would likely be chosen. In addition, the Direct Integration method
allows the user to directly set damping values at boundary condition springs. Therefore, in models where this extra
sophistication in the damping terms is required, the Direct Integration method is the obvious choice.

Note
l

The solution time may be reduced by setting the members', solids', plates' or wall panels' activation
status to "Active but Excluded". Deflections will still be calculated for all nodes, but force and stress results for the those excluded elements will not be produced.
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File Operations
You may create, save, and recall files from the File Menu or from the Quick Access Toolbar. Importing and
exporting other file types may also be accomplished from the File Menu.

Starting Off
When you open the program, you are presented with the following options: Recent Models, Create a New Model,
and Open an Existing Model.
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Creating a New Model
l

On the Quick Access Toolbar click the New Model button. You will be prompted to 'Save' if you have
made any changes to the current model that have not yet been saved.

Opening an Existing Model
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l

On the Quick Access Toolbar click the Open Model button. You will be prompted to 'Save' if you have
made any changes to the current model that have not yet been saved.

l

To open a model you have used recently, click the File Menu and select from the list of Recent Models
shown to the right of the standard menu, with a preview image of the rendered structure.

Tip

Saving a New Untitled Model
l

On the Quick Access Toolbar click the Save Model button. You will be prompted to 'Save' if you have
made any changes to the current model that have not yet been saved.

Saving an Existing Model
l

On the Quick Access Toolbar click the Save Model button.

Appending Models
You may append other models into the current model by choosing Append from the File menu. This lets you have a
library of common model parts that you can use later or to divide projects into smaller parts and later combine
them. This feature does not allow you to combine two unopened models. You must first open one of the models, and
then append the second model into the first model. If you want to have an unmodified copy of the first model, you
will need to save the new combined model under a new file name.
You can only append files from version 6.0 and newer ,files. If you’ve got an older file that you want to append, you
will first need to open that file by itself and save it.
Your appended model will be placed in the current model using the original coordinate data that was in the
appended model. The appended model is NOT moved to the origin of the current model. So, if the appended model
had an X coordinate of 9.0 for all joints, then it will be placed at a X coordinate of 9.0 in the current model.
The Drawing Toolbar will already be opened in the model view so that you can easily adjust the placement of your
appended model using the graphics editing tools. The entire original model will automatically be unselected and
your appended model will be selected. If you're going to make several adjustments to the position of your appended
model, you should probably click the Lock Unselected
button. Then you can use the graphical editing tools to
put your appended model where you want it in the current model.
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You can use the labels for the Joints, Members, and Plates to help identify the parts as you append them into your
current model. Use the Relabel Joints, Relabel Members, and Relabel Plates options on the Tools menu to make
the label prefix unique for each of your model parts before you append them.

Note
l

l

l

The appended model properties will be set to the current model properties in cases where there is a conflict. For example, if both models use the same section set label, the current model properties will be
used to define the section set. The same is true for material properties, moving loads, and so on.
Loads remain in the same basic load case. For example if the appended model has loads in BLC 3 these
loads will be placed in BLC 3 of the current model.
tnxTower model files may also be appended together.

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Append.

Importing and Exporting Files
You may import RISA-2D files, STAAD files, tnxTower files, DXF drawing files and BIM Exchange files. See DXF Files,
Appendix C, and Appendix E for more on these file types.
To Import Other File Types
1.
2.
3.
4.
5.

On the File menu click Import.
Choose the File Type.
Select the file you wish to import.
Choose from the options associated with the type of file.
Perform a Model Merge. See Model Merge for more information.

To Export Other File Types
1.
2.
3.
4.

On the File menu click Export.
Choose the File Type in the drop down list.
Select the file you wish to export.
Choose from the options associated with the type of file.

Importing RISA-2D (v4.0 and Newer)
RISA-2D models may only be imported if they are from version 4.0 or higher and will be put in the 3D XY
plane. "PIN" member releases will be converted to "BENPIN" in RISA-3D. If the 2D members are not assigned a
database shape, the torsional stiffness, J, is set to '1'. The out of plane translational degree of freedom (Z), and the
out of plane rotational degrees of freedom (2y and 2x), are fixed in the 3D model for all joints.

Automatic Backup
RISA-3D provides an automatic backup system for systematically backing up your models. The purpose of this is to
provide a means for you to recover your data in the event RISA-3D or your computer closes unexpectedly. As you
work within RISA-3D your model is saved with a "_backup" suffix to a model backup folder. By default, this
automatic save operation takes place every 5 minutes, but you can alter the timing and location with the
Application Settings option in the File Menu. Backups for the last 100 models that you worked on are saved,
although you can control how many models are backed up with the Application Settings.
If RISA-3D does close unexpectedly, the next time you start the program the following message will appear:
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Generation
You may automatically generate regular structures or portions of structures to start a new model or add to an
existing model.

Access the Generation types from the Home tab by clicking on the Templates button. You will see the following
options, which require you to specify basic parameters to generate structures with beam elements, plates, or a
combination of both.

Note
l

l

l

To generate items that are not coincident to the global axes first define them in the global directions and
then rotate them into the correct position.
The plate and member generation is optional for each generation. For example the cone generator can
generate a cone of nodes, members and plates or just a cone of nodes.
The generations are powerful but as a result of this some also have many options. Remember that any
generation may be undone by clicking Undo so don’t hesitate to try something just to see what it does.

Circular Arc Generation
The circular arc generation enables you to generate a full circle or partial arc comprised of beam elements.
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The polar origin is the center point of the arc. A global axis (X, Y or Z) is entered as the axis of rotation and the arc
will be in the plane normal to this axis. You may generate an arc the full 360 degrees around the axis of rotation or
generate a partial arc by specifying the start and sweep angles.
The arc radius is the length from the polar origin to the arc. The arc increment determines how many piecewise
straight segments are used to model the arc.
To generate members for the arc, you must select a valid section set. This section set will be used for all parts of
the arc. If you don’t select a section set, you will generate an arc of joints without members. The “x-axis rotate”
may be used to rotate the local axes to a desired orientation, however you may find that a K-node better serves this
purpose in some instances. You may also have unique labels assigned to the generated members, by entering a
start label.
For additional advice on this topic, and how to use the Circular Arc to model a Dome structure, please see the RISA
Tips & Tricks website: www.risa.com/post/support. Type in Search keywords: 3D Dome.

Parabolic Arc Generation
The Parabolic Arc generation is used to make arcs that are parabolic. The arc model will be comprised of nodes
and optional members.
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Specify the polar origin about which the arc will be generated.
You must enter the arc height and the arc width and choose a rotation axis.
Enter the number of arc increments to be used to model the arc. The more increments used, the more closely the
final geometry will follow the desired parabola. The minimum increments are two, which will give you a triangular
shape.
You may optionally enter a Node Label prefix that will be used for all the nodes generated as part of the arc. This is
useful if you want a way to track individual parts of your model by looking at node prefixes.
To generate members for the arc, you must select a valid section set. This section set will be used for all parts of
the arc. If you don’t select a section set, you will generate an arc of nodes without members. The “x-axis rotate”
may be used to rotate the local axes to a desired orientation, however you may find that a K-joint better serves this
purpose in some instances. You may also have unique labels assigned to the generated members, by entering a
start label.

Grid Generation
This generation enables you to generate 2D or 3D grids (or even 1D (line) grids) of nodes, plates, and members
with equal or unequal grid increments.
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Define the X, Y, and Z coordinates of the origin and the increments for spacing in up to three global directions. If
you don't define any increments parallel to a particular axis no grids will be generated in that direction. Negative
increments are OK. Nodes are created at all the grid intersection points.
You may create members in the global directions between the grid points. You may use different section sets in the
three global directions. For example if the Y-axis is the vertical axis you can specify a column shape for the Y-axis
members and different or similar beam shapes for the X-axis and Z-axis members.
You may have unique labels assigned to the generated members, by entering a start label, and you may also use
different labels for the three member directions.
You may also create plates in a global plane between the grid points. Keep in mind that the grid increments you
define and the global plane(s) you select must be consistent for the plates to be generated. For example, if you
defined increments only along the X and Y axes, you’ve defined an XY plane of nodes. If you then enter “ZX” for the
plane of the plates, no plates will be generated; only the joints in the XY plane would be generated. You would need
to specify “XY” as the plane to have the plates generated.
A valid material set must be selected in order for plates to be generated. The default is the first Material listed in
the General tab of your Materials spreadsheet.
A hydrostatic load may also be generated along the grid of plates as you generate it. The hydrostatic load will be
generated using a series of uniform surface loads on your plate elements. If the fluid depth is constant along the
grid, you will just get uniform loads on your plates. If the fluid depth varies along the grid, you will get a series of
uniform surface loads that increase in a “stair step” fashion , as you move down the fluid depth. The value of each
uniform surface load is equal to the value of the actual hydrostatic load at the mid-point of the plate. The load
direction will be perpendicular to the plates.
The fluid depth is measured in the positive vertical direction from the starting point for the plate grid.
The default fluid density is for water, but any density can be entered. The Fluid Load BLC provides a drop down list
of all the Basic Load Cases. If you’ve defined in any descriptions for your BLC’s, these will be shown in the drop
down list. The surface loads generated will be placed in the selected Basic Load Case.

General Truss Generation
The general Truss Builder generation is used to make various trusses and various forms of truss joists. The truss
will be comprised of nodes and an optional top chord, bottom chord, vertical strut member, and diagonal brace
member. You may make the truss out of any material type (General, Hot Rolled, Wood, et cetera) by choosing your
Material.
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The Origin for the truss generation defines the first point of the bottom chord.
You must enter the truss height and the panel lengths to the left and right of truss "peak".
The Truss Type selects what configuration the truss will use. The Truss Plane defines the plane of the truss.
You may optionally enter a Node label prefix that will be used for all the nodes generated as part of the truss.
Similarly, you may enter a Member label prefix that will be used for all the members generated as part of the
truss. This is useful if you want a way to track individual parts of your model by looking at Member or Node
prefixes.
You may optionally create members for the bottom chord, top chord, vertical strut, and diagonal brace. For each
one of these members you must assign a valid independent section set, and “x-axis rotate angle”. Note that you must
mark the checkbox for a member type before you can set any of the values to indicate that you want generation
performed for that member type.
The “x-axis rotate” may be used to rotate the local axes to a desired orientation, however you may find that a Knode better serves this purpose in some instances.

Geodesic Dome Generator
The geodesic dome generator is used to construct a geodesic dome comprised of member and plate elements. The
following dialog box will be displayed and you can enter in the necessary information for the geodesic dome
properties:
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The Triangle Subdivision section will designate the number of triangular submeshes per side.
The Platonic Solids section is used to designate the number of faces of the geodesic dome.
The Dome Height and Radius can be set in the graphical interface.
The Polar Origin allows you to choose the dome origin coordinates.
Check the Members checkbox to create strut members. Designate the member prefix, a member material, and a
section set.
Check the Plates checkbox to create exterior plate members. Designate the plate prefix, a general material, and the
thickness of the plate elements.
Click OK and the program will apply this information to create the geodesic dome structure.

Cylinder Generation
The cylinder generation is used to make cylinders comprised of nodes and optional members and plates.
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The Polar Origin is the point about which the arc rotates and a global axis is the axis of rotation. You may
generate a cylinder the full 360 degrees around the axis of rotation or generate a partial cylinder by specifying the
start and sweep angles.
The Radius is the distance from the axis of rotation to the cylinder. The number of Sweep Increments determines
how many piecewise straight segments are used to model the arc of the cylinder. The number and length of
increments along the axis of rotation is used to "extrude" the cylinder in the direction of the axis of rotation.
There are entries for a Section Set for both the arc members and the axis members so these two sets of members
can be different sizes. To generate these members you must select a valid section set. If you don't select a section
set, you won't generate these members. Different labels may be assigned to the two member types. The X-axis
Rotate may be used to rotate the local axes in to place however you may find that a K-node better serves this
purpose. You can also select the Polar Origin from the drop-down under x-Axis Rotate to force the stiffeners to all
point their local y (vertical) axes towards the center of the cylinder.
You must enter a Material Set and Thickness for plates to be defined and the label prefix may be specified as well.

Cone Generation
The cone generation is used to make cones comprised of nodes and optional members and plates.
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Specify the polar origin as the point about which the arc rotates and a global axis as the axis of rotation. You may
generate a cone the full 360 degrees around the axis of rotation or generate a partial cone by specifying the start
and sweep angles.
The start radius and end radius are the distances from the axis of rotation to the cone. The number of increments
along the sweep determines how many piecewise straight segments are used to model the arc of the cone. The
number and length of increments along the axis of rotation is used to "extrude" the cone in the direction of the axis
of rotation.
There are entries for a section set for both the arc members and the axis members so these two sets of members
can be different sizes. To generate these members you must select a valid section set. If you don't select a section
set, you won't generate these members. Different labels may be assigned to the two member types. The “x-axis
rotate “ may be used to rotate the local axes in to place however you may find that a K-node better serves this
purpose.
Finally, you may enter a material set, thickness and label for plates to be defined.

Circular Disk Generation
The Circular Disk generation enables you to generate a circular disk comprised of plate elements.
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Specify the polar origin as the point about which the grid rotates and a global axis as the axis of rotation. The grid
is generated the full 360 degrees around the axis of rotation.
The radius is total length from the polar origin to the outer edge of the grid. The quadrant increment determines
how many piecewise straight segments are used to model the sweep for each quadrant of the arc. Note this entry
must be a multiple of 2 (2,4,6, etc.) due to modeling constraints at the center of the disk. The radius increment
specifies how many “rings” to use to create the grid.
You must enter a material set and thickness to have plates defined. Only quadrilateral plates are generated. You
may also specify labels assigned to the plates.

Circular Radius Generation
The circular radius generation enables you to generate a full or partial circular grid comprised of nodes and
optional members and plates.
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The polar origin is the center point of the disk. A global axis is entered as the axis of rotation (X, Y or Z) and the
disk will be in the plane normal to the axis of rotation. You may generate a grid the full 360 degrees around the
axis of rotation or generate a partial grid by specifying the start and sweep angles.
The start radius is the radius of the “hole” in the center. This distance must be greater than zero and less than the
end radius entry. The end radius is total length from the polar origin out to the edge of the grid. The number of
increments along the radius tells RISA-3D how many “rings” to use to create the grid. The sweep increment
determines how many piecewise straight segments are used to model the arc.
There are entries for a section set for both the arc members and the radius members so these two sets of members
can be different sizes. To generate these members you must select a valid section set. If you don’t select a section
set, you won't generate these members. You may also have unique labels assigned to the generated members by
entering a start label.
Finally, you enter a material set and thickness to have plates defined. Only quadrilateral plates are generated. You
may also have unique labels assigned to the generated plates by entering a start label.

Rectangular Tank Generation
The Rectangular Tank generation is used to make rectangular tanks out of plate finite elements. Stiffeners and
hydrostatic loads may also be modeled. The tank will be pin supported around the bottom perimeter. No supports
will be generated in the interior of the tank floor.

Specify the origin for the tank generation. This defines the bottom corner of tank floor. The tank height will always
be towards the positive vertical axis. The width and length will be along the other 2 axes as shown in the figure.
For example, if the vertical axis is Y, then the width would be along the X-axis, and the length would be along the Zaxis.
A plate element edge length may be specified. The program generates the tank out of plates which are
approximately square, with an edge dimension approximately (+/- 20%) equal to this user-specified value.
Regardless of this dimension there will always be at least 5 plates along each side of the tank, and there will always
be at least three plates (vertically) between each stiffener.
Horizontal stiffeners may optionally be generated around the top, bottom, or at intermediate locations on the tank
walls. The middle stiffeners are evenly spaced from the top and bottom of the tank. For example, specifying 2

General Reference Manual

211

Generation
middle stiffeners would divide the tank wall horizontally in thirds, with the first stiffener at one-third the tank
height, and the second stiffener at two thirds of the tank height.
You may offset the stiffeners with rigid links in order to model the composite action of the stiffener and the tank
wall due to the center of the stiffener being offset from the tank wall. When this option is not used, the stiffener
and plate centerlines are at the same location and share the same joints. If this option is used, the generator will
automatically create a material set for the rigid links called "TANK_RIGID_RISAMAT", and a section called "TANK_
RIGID_RISASEC". The properties for these are preset and should only be modified if the rigid links are acting
"flexible" relative to the rest of your model. Each time the generator is run, the properties are reset to the default
values if these material/section sets have already been created.

Note
l

You cannot use this option for Arbitrary shapes, Tapered WF shapes, and shapes that are defined on the
section screen by typing in their area, moment of inertia’s and torsional stiffness. These shapes can still
be used as stiffeners; you just can’t have the composite offset automatically calculated and modeled.

A node label prefix may be entered, which will be used for all joints generated for the tank. A valid material set
must be selected in order for plates to be generated. A plate label prefix may be entered, which will be used for all
the plates generated for the tank.
A valid section set must be selected in order for stiffeners to be generated. A stiffener label prefix may be entered,
which will be used for all the members generated for the tank stiffeners. Any rigid links generated to model the
offsets will have a prefix of "RIGIDTANK"
A hydrostatic load may also be generated. This load will be generated using a series of uniform surface loads on the
plate elements. The fluid depth is measured in the positive vertical direction from the bottom of the tank and is
constant along the floor giving a uniform surface load on the floor plates. The fluid depth will vary along the walls
of the tank and these will increase in a "stair step" fashion, as you move down the fluid depth. The value of each
uniform surface load is equal to the value of the actual hydrostatic load at the mid-point of the plate. The load
direction will be perpendicular to the plates and outward.
The default fluid density is for water, but any density can be entered. The Fluid Load BLC provides a drop down list
of all the Basic Load Cases. If you’ve defined in any descriptions for your BLC’s, these will be shown in the drop
down list. The surface loads generated will be placed in the selected Basic Load Case.
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Graphic Display
RISA-3D's robust graphics make building and understanding your model much easier. You may have numerous
independent views open and active at the same time. Fast redraw times, responsive panning, true to scale
rendering, animation capabilities, and graphic editing tools all help you build and understand your model. You may
draw the model and specify loads and boundary conditions graphically. These items may be modified graphically as
well. Verification of your model is made simple with true-to-scale rendering and color coded code checks. Results
such as member force diagrams, color-coded stress levels, deflected shapes, and animations may also be viewed for
solved models.

Window Behavior
The Window Behavior may be specified within the Application Settings.

Single Window Focus
Clicking within the 3D view will automatically close all open/visible spreadsheets and detail reports.
Auto-Docking Windows
Clicking within the 3D view will automatically dock all open/visible spreadsheets and detail reports as new tabs.
Multiple Screen

General Reference Manual

213

Graphic Display
This window behavior is useful when you want to keep detail reports or spreadsheets visible on a separate monitor
while navigating through the 3D view. If a detail report or spreadsheet is open and is visible on the same monitor
as the active 3D view, clicking within the 3D view will send the spreadsheet behind the program window.

Multiple Windows

You may have multiple views of the model open at the same time, each with it’s own characteristics. For example
you can simultaneously view and work with members in one window and plates in another. You can have multiple
spreadsheets open as well.
To Open a New 3D View

l

l

To open a new view of the model, go to the View tab and select the Open 3D Views button to +Add
New 3D View.
Alternatively, you can right-click in the existing 3D View and select Add New 3D View.

Note
l
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With the model view active you may then use the snap buttons at the top of the 3D View to adjust the
view of the model.
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l

To window snap, drag the purple title bar of any window (3D View or spreadsheet) until you see the
arrow controls appear. Use the arrow controls around the screen to snap the window into place.

3D View
To Zoom In and Out
l

Use the wheel button on the mouse to dynamically zoom in or out the model view. Rotating the wheel
forward zooms in and rotating the wheel backward zooms out.

To Pan the View
l

Clicking and holding the mouse wheel button triggers a dynamic pan and allows the user to drag the current model view to the edges of the 3D view.

To Snap to a View
l

l

To snap to an isometric or planar view of the model, click any of the Snap buttons at the top of the
3D View window.
You can also add your own custom snap views by selecting the down arrow. This will allow you to save
your current view and add it to the end of the Snap buttons.

To Click to Rotate
l

l

To click to rotate the view of the model, click any of the Click to Rotate buttons at the top of the
3D View window.
You can also change the rotation angle by entering a different degree magnitude. This will affect the rotation of the model as you click to rotate.

To Rotate a View
l

l

When holding down the SHIFT key, press down the mouse wheel button to dynamically rotate the structure. See Application Interface - Dynamic Controls for more information.
You can also click and drag the 3D box in the top-left corner of the 3D View window to change the rotation of the model.
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l

To rotate the view of the model about a global axis, hover over the axis until it turns blue, then click and
drag to change the rotation of the model. Holding down the SHIFT key while rotating the model using
the individual axes will only rotate at 45 degree increments around that axis.

l

Double-click the 3D box to reset the isometric view.
As you rotate the view, the global X-Y-Z axis orientation is shown by the orientation of the 3D box.

Note

l

Display Options
Each 3D View has several display options located at the top of the view:
l

l

l

Click the Toggle Display of Loads button to display loads. You can change the Type to specify whether
you want to display loads based on Basic Load Case, Load Category, or Load Combination. Use the pull
down list to control which load case, category, or combination is shown in the view. See Model View Settings for more control over the display of loads.
Click the Results button to show color coded results for your model. See Results View Settings for more
control over the display of results. Deflection and results can only be shown for Load Combination load
types.
Click the Deflect button to show the deflected shape of your model with or without an undeflected
shadow.

Quick View Buttons

The Quick View buttons, located on the Home tab, can be used to change the graphical display of the model. You
may use these buttons to turn on member and node labels, and view color-coded properties and results. Additional
view options can be specified in the View Settings on the View tab.
Click

to toggle model rendering. See Model View Settings for more information on rendering.

Click

to toggle the boundary conditions.

Click

to toggle the member labels on and off. If rendering is on, member labels will not be visible.
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Click

to toggle display of member color basis.

Click

to toggle the plate labels on and off.

Click

to toggle the solid labels on and off.

Click

to toggle the wall panel labels on and off.

Click

to toggle the display of diaphragms on and off.

Click

to use the distance tool.

Click

to restore the default Quick View button settings.

Click

to toggle the node labels.

Click

to toggle display of member results.

Click

to toggle the display of end releases.

Click

to display member forces.

Click

to toggle display of plate contours (see Plates).

Click

to toggle display of solid contours (see Solids).

Click

to toggle display of wall panel contours (see Wall Panels).

View Tab

The options in the View tab can be used to change the model view, display of loads and results, and active
windows. Each option is further expanded below.
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Project Grid

Click the Project Grid button to toggle the Project Grid on and off. The Project Grid is part of the model and may be
allowed to move model elements as grid lines are moved. See Project Grid for more information.

3D View

Use the 3D View buttons to snap your model to a specific view. Click the Isometric button to snap the model to an
isometric view. The XY, XZ, and YZ buttons will snap the model view to the specified plane.

View Settings

The Model View Settings (see Model View Settings ) and Results View Settings (see Results View Settings ) are
located on the View tab in the View Settings section. These two dialogs provide various options not otherwise
available in the Quick View buttons on the toolbar. It allows you to specify how to plot nodes, members, plates,
loads and the information that is to accompany them.
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Animate Results

Click the Results button in the Animate section to animate deflection, mode shape (dynamic analysis), or time
history. A new model view will be created with the animation. When this model view is active, the Animation tab
provides additional settings depending on the type of animation selected. Additional controls are available for the
animation of Time History motion, see Animate Time History Deflection.

Click the Pause button to pause the animation. Use the Animation Speed slider to control the speed of the
animation. Dragging the marker to the right will increase the speed, while dragging it to the left will decrease the
speed. Press the Export Animation button to export the animation as a .wmv or .mp4 file. Use the Scale slider to
control the scale of the animated deflection. You can toggle the Undeflected Shadow on or off.

Animate Moving Loads

Click on the Moving Loads button in the Animate section to animate moving loads. See Animate a Moving Load for
more information.
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Zoom

Use the Zoom tools to change the view of the model in the 3D View.
l

To snap the model to a full model view, click the Zoom Extents button on the View tab in the Zoom section.

l

To zoom in towards the center of the model view, click the Zoom In button

l

To zoom out from the center of the model, click the Zoom Out button

l

To zoom in on a specific area of the model view, click the Zoom Box button
draw a box around the zoom area by clicking and dragging with the left mouse button.

.
.
and then

Image Capture

The Image Capture tool is a great way to add images of model views and detail reports in your report printing. See
Printing for more information.

Saved Views

Click the Saved Views button to save and recall views. If you have a view that you like to work with or have
created a view that took some time to set up, save it with this feature. All of the Model View Settings are saved with
the model for later recall. See Saving and Retrieving Model Views for more information.
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Window

The Window section can be used to specify the active windows in the program. Click the Explorer button to show
or hide the Explorer panel on the right hand side which holds the Data Entry and Results toolbars. Click the
Properties button to show or hide the Property Grid panel on the left hand side which contains model
information. Click the Open 3D Views to create additional 3D View windows (see To Open a New 3D View).

Viewing Part of the Model
You may want to view only part of your model, especially if it is a big one. You may use the selection tools to give
you the view that you want. You can graphically unselect parts of the model that you don't wish to see, or you can
use a range of coordinates or other criteria to specify what to view. See Graphic Selection for more information.

Saving and Retrieving Model Views
You can save and recall views for a model. Saved views are model dependent so any views you save will stay with
the model. A saved view includes information such as the current view angle, zoom state, pan location, plot option
settings, etc. Saved views do NOT include the selection state for the model. You can save selection states separately.
See Saving Selections for more information.

To Save the Model View
l
l

Click the Saved Views button on the View tab.
Click the Save button and enter a name and then click OK.

To Retrieve a Saved Model View
l
l

Click the Saved Views button on the View tab.
From the drop down list, choose the view you wish to recall and then click the Retrieve button.

To Delete a Saved Model View
l
l

Click the Saved Views button on the View tab.
From the drop down list, choose the view you wish to delete and then click the Delete button.
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You may draw, edit, and load your model directly in the model views. You can draw members and plates between
existing nodes or draw to grid intersections and have the nodes created automatically. You may graphically select
nodes to be restrained, members to be loaded, and plates to be submeshed. All or selected parts of the model may
be moved, copied, and/or modified allowing you to quickly model and edit your structure. See Graphic Selection to
learn how to make selections.

Drawing and Modification Features
There are several graphic editing features that make the creation and modification of models quite easy. Use the
Draw Elements tools in the Home tab and the tools in the Modify tab to utilize these features in the model view.
To create new members, plates, etc., you can draw them using a drawing grid or draw "dot to dot" from existing
nodes. Once you have created these items you may use other graphic features to load the model and set boundary
conditions.
l
l
l
l
l
l
l
l

See Members for more information on drawing and modifying Members.
See Plates/Shells for information on drawing and modifying Plates/Shells.
See Boundary Conditions for information on creating and modifying Boundary Conditions.
See Loads - Point Loads for information on drawing Point Loads.
See Loads - Nodal Load / Displacement for information on drawing Nodal Loads.
See Loads - Distributed Loads for information on drawing Distributed Loads.
See Loads - Surface Loads for information on drawing Surface Loads.
See Loads - Area Loads for information on drawing Area Loads.

All model data is automatically recorded in spreadsheets and will always be in tune with the model view. As you
edit a model graphically, the spreadsheets are automatically updated and as you make changes in the spreadsheets
the model views reflect these changes immediately.
All of the graphical modeling tools may be found in the Home tab and Modify tab shown below.

Where to Start
The Project Grid and Drawing Grid are often useful when you are starting a new model from scratch or adding a
new section to a model. They allow you to set up grid lines which may then be used to define the members, plates,
and boundaries. The differences between the two grids are simple. The Project Grid is part of the model. The Project
Grid is limited to the model 'plan'. The Drawing Grid is independent of the model so you may change the grid and
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place it anywhere, without affecting the model and whenever it is convenient. The Drawing Grid may be placed in
any global plane so you may draw in 'plan' or in 'elevation'.
There are also times when it is simpler to define nodes in the spreadsheet and then draw the members or plates
between them. This might be the case if you are working with just a few nodes, or if the structure is irregular and
does not lend itself to a grid.

Apply Options
The Properties Panel makes it very easy to apply modifications to a single member and multiple members. For
example, changing the material of a beam from A36 steel to A572 steel can be accomplished through the Members
Spreadsheet. However, if you had to apply this change to 100 beams you would not want to do that for each of
them. A better way to do this would be to graphically select all of the beams and then apply the changes all at once
in the Properties Panel.
Use the tools on the Selection Toolbar to choose the items you want to modify and then make the changes in the
Properties panel to apply the modifications to all selected items at once. See Graphic Selection for more information
on the selection tools.

Note
l

l

l

The selection and viewing tools override the graphic editing modes so that as you are editing the model
you can alter the selected state. The Properties Panel will update based on the selection you make.
You may also click any single node, member, or plate to view and edit it’s properties in the Properties
Panel.
To correct any modeling errors it is a good idea to run Model Merge before performing a solution.
Becoming familiar with this feature will also allow you to take shortcuts while modeling. See Model
Merge for more information.

Undo Operations

RISA-3D provides you with unlimited 'Undo' capability so that you may easily correct mistakes or just back up to
try different possibilities. Simply click the Undo button on the Shortcut Toolbar as many times as you wish to
undo your previous actions. The model view and the spreadsheets will visually display the "undoing". Remember
that spreadsheet edits are undone as well.

Note
l

Changes made to the selection state of the model, the zoom level or rotation of the model view, or to the
Model Display Options settings are NOT undone. Only a change to the model data can be undone.

Redo Operations

RISA-3D provides you with unlimited 'Redo' capability so that you may easily redo any actions that were previously
undone using the 'Undo' button. Simply click the Redo button on the Shortcut Toolbar as many times as you wish
to redo actions that were previously undone. The model view and the spreadsheets will visually display the
“redoing”. Remember that spreadsheet edits are redone as well.

Note
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l

Changes made to the selection state of the model, the zoom level or rotation of the model view, or to the
Model Display Options settings are NOT redone, since they cannot be undone to begin with. Only a
change to the model data can be redone.

Project Grid
The Project Grid provides convenient snap points for modeling columns and walls in buildings and building-type
structures. It also provides a convenient terminology to refer to locations in a model, such as "Grid Intersection C4". The Project Grid is intended to be a permanent part of the model so unlike the Drawing Grid it is saved with the
model.

Project Grid Spreadsheet

Click the Project Grid button in the View tab, or click the Project Grid button on the Data Entry Toolbar to open
the Project Grid Spreadsheet shown below.
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Each Grid Line (as opposed to Grid Arcs) is defined by Start and End coordinates along the X and Z axes. This
method of defining grids allows them to be oriented in any direction, including skewed grids or non-parallel grids
within the same building.

Project Grid Line Generation

The Project Grid Line generator can be accessed using the
button in the Project Grids
spreadsheet, or by clicking the Project Grid button in the Draw Elements section of the Home tab.
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The generator provides the ability to generate an entire grid system at once rather than entering the grids in
manually in the project grid spreadsheet.
You may use symbols such as "@", "/" and "," when entering the increments.
The "@" entry may be used to specify multiple, equally spaced, grid increments. For example, if you wanted 7
increments at 10 units each, you would type "7@10" in the increment field.
The "/" entry subdivides a larger increment into smaller equal increments. For example, the entry "12/4" would
create 4 increments of 3 units each.
Use commas (",") to enter multiple increments in the increment field. For example, if you wanted to define
increments of 3, 4, 7 and 2 units, you could enter "3,4,7,2" in the increment field.
The Apply and Undo buttons provide an easy way to preview a Project Grid before adding one to the model.
Once the project grid is specified and displayed in the model view, it will provide snap points while drawing your
model. The grid exists at an elevation specified in the Elevation field.

Editing the Project Grid (Adding or Moving Grid Lines)
Once a Project Grid has been created the grid lines can be moved, or additional grid lines can be created, by double
clicking on a grid line in the model view.
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The Generate Parallel Line button allows a line to be created by offsetting an existing grid line.

The Move Lines button allows a grid line to be moved by a specified distance. A positive distance will move the line
in the positive global direction, while a negative distance will move the line in the opposite direction.
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Drawing Grid
The Drawing Grid is a tool that lets you draw new members and plates in the model view. This grid is independent
of the model, so you may change the grid as you build your model without changing any modeling that you have
completed. This is because as you draw the members and plates the joints used to define them are created
automatically. These joints remain in their locations if the grid is relocated.

Drawing Grid Dialog
Click the Drawing Tools tab to show the dialogue shown below. The display of the Drawing Grid in the current
model view may be turned on and off by toggling the Display Grid button in the Drawing Tools Tab.

You may choose between a rectangular drawing grid or a radial drawing grid and may place the grid in any of the
three global planes. Also, rectangular drawing grids may be skewed from perpendicular to the global axis plane.
The drawing grid X Increments and Y Increments can be expanded to enter more values by clicking the arrow in
the lower right corner of the Drawing Grid section.
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The Save Grid and Load Grid buttons allows for drawing grids to be saved and recalled for later use. Saved
drawing grids are model independent, i.e. when you save a grid, you can reuse it in any other model you are
working with in the future. To save a drawing grid, click the Save Grid button after defining the grid. You will be
prompted for a name for the drawing grid and it will then be saved and added to the list of grids available for recall.
To recall a previously defined drawing grid, select the grid name from the drop down list. If you wish to delete a
previously saved drawing grid, select the grid name you want to delete from the drop down list and click the Delete
button.
You may save any of the grid information as the default setting so that when you start a new model that
information is already there. To do this, simply enter the information that you want to save in the Drawing Grids
Section and check the Save as Default button.

Rectangular Drawing Grid
The rectangular drawing grid is defined by increments in two directions. The X, Y, Z Origins are where you want
the grid increments to start. The X, Y, Z Increments are the distances between the grid points or lines in two global
directions.

You may use symbols such as "@", "/" and "," when entering the drawing grid increments.
The "@" entry may be used to specify multiple, equally spaced, grid increments. For example, if you wanted 7
increments at 10 units each, you would type "7@10" in the increment field.
The "/" entry subdivides a larger increment into smaller equal increments. For example, the entry "12/4" would
create 4 increments of 3 units each.
Use commas (",") to enter multiple increments in the increment field. For example, if you wanted to define
increments of 3, 4, 7 and 2 units, you could enter "3,4,7,2" in the increment field.
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Once the drawing grid is specified and displayed in the model view, it will provide snap points while drawing your
model.

Skewed Drawing Grid
The rectangular drawing grid can be skewed by specifying a skew angle. This option is available in the Drawing
Grid Section section of the Drawing tools tab. This skew angle will allow the creation of a regular rectangular
drawing grid, but displayed in the model view at the specified angle, inclined from the global axis.

Radial Drawing Grid
Increments in two polar directions define a radial drawing grid. The Drawing Grid Origin is the point about which
the grid will rotate. The default is at the global origin (0,0,0). The Start Angle defines the angle from the global axis
that the first spoke will be drawn. The Angle Increment controls the number and angular spacing of the spokes in
the grid. The Radial Increments controls the number and location of the rings in the grid.

Relocating the Drawing Grid
The origin of the drawing grid may be specified in two ways. The first is to enter the exact global coordinates for
the origin. This can be done by entering the values in the X Origin, Y Oirigin, and Z Origin fields. The second option
is to specify the origin by clicking on an existing point in the model. This option is available by clicking the Click to
Locate button, and then clicking on the specific location in the model view where you wish the drawing grid origin
to be located. The drawing grid origin will then be moved to this point.
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Snap Points
Snap Points let you draw in the model view without the use of grids. To view or modify the snap point settings go
to the Snap Settings section in the Drawing Tools tab.

You can set the program to automatically snap to the Quarter Points and/or Third Points and/or Intersections of
a member by checking the appropriate boxes.
The Universal Snap Points section is used to define a snap grid for "free" drawing to any incremental location on a
plane. To activate this feature, check the Active box.
When snap points are activated, a red dot or asterisk will appear on your screen as you move your drawing cursor
over one of these points after you have selected to draw an element. The exact coordinates of this point, and
whether it is a 1/3 or 1/4 point of a member, are reported in the status bar at the very bottom of the main
application window just beneath the workspace as well as next to the cursor.

Lock to Axis
The Lock to Axis options allow you to draw while locked to the global or local axis. This tool can be used to draw
members and plates.

Lock to Global Axis
1. First, on the Home tab, select either Draw Members or Draw Plates.
2. On the Drawing Tools tab, click Lock to Global Axis. This means the lock axis will follow the global axis orientation.
3. Your first click point in the 3D View will specify the origin of the lock axis, which is shown in dashed red
lines.
4. As you draw, the origin of the lock axis will change with every subsequent click. The axis will continue to follow the global axis orientation.
5. To disengage the drawing tool, right-click twice.
Lock to Local Axis
1.
2.
3.
4.
5.

First, on the Home tab, select either Draw Members or Draw Plates.
On the Drawing Tools tab, click Lock to Local Axis.
Click on a member, plate, or wall panel to specify the local axis to lock to.
Your next click in the 3D View will specify the origin of the lock axis, which is shown in dashed red lines.
As you draw, the origin of the lock axis will change with every subsequent click. The axis orientation will
remain locked to the local axis of the originally specified element.
6. To specify a new local axis to lock to, right-click twice (the cursor will change to a hand) and click on a
new member, plate, or wall panel.
7. To disengage the drawing tool, right-click three times.
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Lock to Plane
Lock to Plane allows you to draw while locked to a specific global plane. This tool can be used while drawing
members, wall panels, or plates.

1.
2.
3.
4.

First, on the Home tab, select which element to draw.
On the Drawing Tools tab, click Lock to Global Plane and specify the plane.
Your first click point in the 3D View will specify the location of the plane.
To reset the origin of the plane, right-click once. While still in the drawing tool, make another click to
reset the origin of the plane.
5. To disengage the drawing tool, right-click twice.

Import DXF
Import DXF lets you import a DXF drawing into the model view as a grid. The DXF image is imported so that you
can snap to any point or intersection to aid in the drawing of your model. The DXF Import Drawing Grid supports
Lines, Polylines, Circles, Arcs, Polylines with Arcs, and Points.
To Import DXF Drawing Grid:
1.
2.
3.
4.
5.

Go to the Drawing Tools tab on the ribbon toolbar.
Under the Type dropdown, select DXF Underlay.
Assign the DXF import options like Scale Factor, Units, and Angle Inc. as well as the DXF Plane.
Select the DXF File from a file by clicking the Import .dxf Grid button.
Once the file is imported, you will be prompted to "Use All Layers" or "Select Layers from the List". You can
check or uncheck selected layers, and select colors of the layers display by clicking on the gray box (defaults
to gray).
6. Set the Drawing Grid Origin or use the drop down menu to select Click to Locate origin.
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The program will default to use All Layers. Or you can select the color of the grid lines/points by clicking on the
color box next to each layer name and select the color.
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Locating the DXF Drawing Grid
The origin of the drawing grid may be specified in two ways. The first is to enter the exact global coordinates for
the origin. This can be done by entering the values in the X, Y, and Z fields of the Grid Origin section. The second
option is to specify the origin by clicking on an existing point in the model. This option is available by selecting the
Click to Locate Origin option from the drop down menu, clicking the OK button, and then clicking on the specific
location in the model view where you wish the drawing grid origin to be located. After you have browsed for your
file, the drawing grid origin will then be set to this point.

Drawing Plane
Select the RISA drawing plane for the DXF file shall be placed.

DXF Scale Factor
Enter the scale factor that will cause the DXF file to be scaled up or down to full scale. For instance, if you had
created a scaled model in AutoCAD at a scale of 1/4"=12", then the appropriate scale factor to produce a full size
RISA-3D model would be 48. The default is 1.0.

DXF Plane
Select the DXF drawing plane to import from the DXF file. The DXF file will be flattened to this plane and all
lines/points visible from this plane will be imported.

DXF Units
Select the units you used in the CAD model from which you produced the DXF file. The supported DXF units are
none, inches, feet, mm, cm, and meters.

Angle Increment
The program will break an arc or circle into straight line segments to allow you to snap to them. This indicates the
number of degrees the that an imported arc or circle should be broken into.

Deleting Elements

You can delete parts of the model based on the current selection state, or you can click on the items you wish to
delete individually. If you accidentally delete something you didn't want deleted, you can use the Undo(Ctrl+Z)
feature to repair the damage.
If you wish to delete based on the current selection state, you must use the check boxes to define the criteria the
program will use to perform the deletion. Only items that are selected and that have their check boxes "checked"
will be deleted. The choices let you delete nodes, members, plates, wall panels, solids and/or loads.
Keep in mind that if you delete nodes, any members, plates, etc. attached to the deleted nodes MUST also be
deleted, regardless of whether those elements are selected or not.
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Two noteworthy features are the ability to delete unattached nodes and zero length members. Sometimes in the
process of modeling you accidentally create unwanted unattached nodes or zero length members. These two
parameters give you a convenient way to remove these unwanted items.
If you request deletion of displayed loads, you'll get exactly that. Any load currently displayed will be deleted. By
controlling what loads are displayed via the Loads tab in the Model View Settings Dialog, you can easily delete
specific types of loads for particular basic load cases, load categories or load combinations.
Alternatively, you can choose to delete items by clicking on them individually. Select the Delete Single button in the
Modify tab of the Ribbon Toolbar and use the mouse to click on any individual item you wish deleted.

Note
l

Primary nodes for rigid diaphragms are not treated as unattached nodes.

To Delete Selected Items
1. If there is not a model view already open then click the View tab on the Ribbon Toolbar then press the
Open 3D Views button to open a new view .
2. Select the items you want to delete.
3. To delete the items, option 1 is to go to the Modify tab of the Ribbon Toolbar and press the Delete Multi
button.
4. Check the boxes of the items you wish to be deleted, then press Apply to Selected.
5. The second option is to simply press the Delete key on your keyboard after you have selected the items you
wish to delete.

Note
l

You may undo any mistakes by clicking the Undo
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Copying Model Elements

To Copy Selected Items
1. If there is not a model view already open then click the Open 3D Views button in the window section of the
View tab.
2. Select the items you want to copy.
3. To copy the selection linearly go to the Copy section in the Modify tab and select one of the following
options:
l
Global
l
Offset
l
Point to Point
l
Rotate
4. To mirror the selection click the Mirror button and specify the mirror plane.

Note:
l

l

l

Be sure to check your member orientations after performing the copy. RISA-3D will apply the default
member orientation if you do not explicitly define it. You may use a K joint to help maintain orientations. See Defining Member Orientation for more information.
Use the "@" symbol to specify multiple equal increments. For example specifying "3@10" will give you 3
copies at 10 units apart.
You may undo any mistakes by clicking the Undo button.

Global Copy
This allows you to copy the selected items by entering in increments in any or all of the global directions. The
selected items will copy the increment distance(s) that you have entered.
Use the "@" symbol to specify multiple equal increments. For example specifying "3@10" will give you 3 copies at
10 units apart.
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For example, if you indicate 3 feet in the Y direction then click on the member, it will be copied 3 feet in the positive
global Y direction.

Select the Diagonal checkbox to combine the orthogonal increments into a single resultant increment vector to
copy the elements in a direction other than the three global orthogonal directions.
Checking the Copy Loads? box will cause ALL loads associated with the original selected model elements to be
copied to the corresponding newly created model elements.
Checking the Connect Bays? box will cause new members to be generated that connect all member end nodes of
the originally selected model elements with the corresponding member end nodes in the newly created model
elements. You may also indicate whether the new member end releases are to be Fixed or Pinned by selecting the
corresponding option from the Bay Fixity section.

Note:
l

l

Only member end nodes will be inter-connected. The corner nodes of Plates and Solids will NOT be inter-connected.
Member end nodes that have a boundary condition associated with them will NOT be inter-connected.

Local Offset Copy
This tool allows you to copy selected members at an offset simply by entering the offset distance and then clicking
on the member to be offset.
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If you indicate 3 feet in the local y direction then click the on the member, it will be copied 1.414 feet in the positive
local y direction.

Point to Point Copy
This allows you to copy the selected items by clicking on any two points. The selected items will copy the distance
between the two points in the direction of the first to second click.

For example, if you click two points: A then B in the model below, the frame will copy 40 feet in the positive X
direction.
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Rotate Copy
You can copy the selected part of the model by rotating the copies about an axis. Simply enter which axis is to be
rotated about, the rotation angle, the number of increments along the rotation angle, and the location of the polar
origin (the point rotated about). Only two of the three polar coordinate values are used, the value corresponding to
the axis of rotation is not used.
Instead of specifying coordinates for a polar origin, it may instead be chosen by clicking in the model view. Select
Click to Locate, specify the appropriate Rotation Axis and Rotation Angle, then click Click to Applyor Apply to
Selected. The cursor will show a cross-hair, with which a polar origin may be specified by left-clicking on a Joint or
snap point.
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For example, suppose you wish to copy the selected part of your model in six 30° increments (for a total of 180°)
about the Y-axis. You would enter "Y" as the axis of rotation, "180" as the rotation angle and "6" as the number of
increments. For the polar origin, enter the X and Z coordinates of where you want the Y-axis of rotation to pass
through the XZ plane.
Checking the Connect Bays? box will cause new members to be generated that connect all member end nodes of
the originally selected model elements with the corresponding member end nodes in the newly created model
elements. You may also indicate whether the new member end releases are to be Fixed or Pinned by selecting the
corresponding option from the Bay Fixity drop down menu.

Note
l

l

Only member end nodes will be inter-connected. The corner joints of Plates and Solids will NOT be inter-connected.
Member end nodes that have a boundary condition associated with them will NOT be inter-connected.

Checking the Adjust Local Axis box will cause the local axis of each member to be rotated with the newly created
model elements. Otherwise, the member local axes will retain their original orientation with respect to the global
axis. The local axes of Plates and Solids will ALWAYS be rotated with the newly created model elements.
Checking the Copy Loads? box will cause ALL loads associated with the original selected model elements to be
copied to the corresponding newly created model elements.

Mirror Copy
You can mirror selected parts of your model. Enter the global plane that you want to mirror about and enter a
location along the normal axis to move the mirror plane location. If the mirror plane location is left blank, the
mirror plane is placed at the origin.
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For example, suppose you want to mirror part of your model about the XY plane at a location +3.0 feet from the
origin along the Z-axis. You would enter "XY" as the Mirror Plane and enter a "3.0" for the mirror plane location. (If
the mirror plane is XY, the normal axis is the Z-axis).
Checking the Connect Bays? box will cause new members to be generated that connect all member end nodes of
the originally selected model elements with the corresponding member end nodes in the newly created model
elements. You may also indicate whether the new member end releases are to be Fixed or Pinned by selecting the
corresponding option from the Bay Fixity drop down menu.

Note
l

l

Only member end nodes will be inter-connected. The corner nodes of Plates and Solids will NOT be inter-connected.
Member end nodes that have a boundary condition associated with them will NOT be inter-connected.

Checking the Copy Loads? box will cause ALL loads associated with the original selected model elements to be
copied to the corresponding newly created model elements.

Moving and Rotating Model Elements

To Move or Rotate Selected Items
1. If there is not a model view already open then click the View tab on the Ribbon Toolbar then click the
Open 3D Views button to open a new view .
2. Select the items you want to move by clicking on them or clicking and dragging over them.
3. To move the selection linearly click the Global or Local Offset button and specify the offset distances.
4. To move the selection based upon two selected points for direction and distance, select the Point to Point
button.
5. To move the selection in a polar fashion click the Rotate button and specify the axis and angle.
6. To scale the selection click the Scale button and enter a scaling factor.

Note:
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l

l

Be sure to check your member orientations after performing the copy. RISA-3D will apply the default
member orientation if you do not explicitly define it. You may use a K joint to help maintain orientations. See Defining Member Orientation for more information.
You may undo any mistakes by clicking the Undo button.

Global Move
You can move the selected part of the model. Just enter the desired translation distances in the global axes
directions.

Local Offset Move
You can offset elements in the model by choosing a local axes direction, specifying an increment, then clicking the
element of the mode you wish to move.

Point to Point Move
You can move elements in the model by clicking on any two points. The selected items will move the distance and
direction based upon the vector drawn from your first to your second points.

Rotate Move
To rotate the selected parts of the model about an axis enter an axis of rotation, the desired rotation angle, and the
coordinates of the polar origin (the point rotated about). Only two of the three polar coordinate values are used, the
value corresponding to the axis of rotation is ignored. Instead of specifying coordinates for a polar origin, it may
instead be chosen by clicking in the model view. Select Click to Locate, specify the appropriate Rotation Axis and
Rotation Angle, then click Click to Applyor Apply to Selected. The cursor will show a finger pointer, with which a
polar origin may be specified by left-clicking on a node or snap point.
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For example, say you wish to rotate the selected part of your model 90° about the Z-axis. You would enter "Z" as the
axis of rotation and "90" as the rotation angle. Under specify origin, select Coordinates or Click to Locate. If
Coordinates enter the X and Y coordinates of where you want the Z-axis of rotation to pass through the XY plane. If
Click to Locate is selected, press Apply to Selected then click a location in the 3D view.
Checking the Adjust Local Axis box will cause the local axis of each member to be rotated along with the model
elements. Otherwise, the member local axes will retain their original orientation with respect to the global axis. The
local axes of Plates and Solids will ALWAYS be rotated along with the model elements.

Scaling Elements

The scale feature allows you to change the size of selected items. Selected nodes, members and plates are all
affected when the scaling is applied. Loads are not scaled except distributed and surface loads that are a function of
the size of the element.

Enter an origin about which to scale if choosing the Coordinates option in the Specify Origin line and a scale
factor to apply to each global direction. You can also select Click to Locate in the specify origin line to click a node
to define the origin. The origin is the point that remains stationary during the scaling. The factors are applied in
each direction to adjust the node coordinates, member lengths and plate sizing. The factors work so that a factor of
one has no affect, a factor of two will double the size of the item, and so on.
What is actually happening when you scale items is that the node coordinates that define these items are being
moved. For this reason, the scaling is applied to all selected items plus unselected nodes of selected items. For
example, if you have selected members to scale but have unselected some of the end nodes, the nodes are scaled
anyway since this is the only way to scale the member.

Note
l

If you wish to scale in a direction other than a global direction you can rotate the model to a global direction, scale it, and rotate it back.

To Scale Selected Items
1. If there is not a model view already open then click in the View tab of the Ribbon Toolbar to open a new
view.
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2. Select the items you want to copy.
3. To scale the selection click the Modify tab, press the Move button, then press the Scale Button and specify
the scale factors for each direction.
4. Choose one of the options for Specify Origin, then press Click to Apply or Apply to Selected.

Note
l

You may undo any mistakes by clicking the Undo button.

Splitting Members
You can split members into a number of equal length pieces or you may split into two members at a specified
location from the I joint. You may specify the split location as a length or a percentage of length. For example
specifying %50 will split the members at the midpoints.

To Split Members
1. If there is not a model view already open then go to the View tab and select the Open 3D Views button to
open a new view.
2. From the Modify tab on the ribbon toolbar, select the Split button from the Members section.
3. Set the parameters for splitting the members.
4. You may choose to modify a single member at a time or an entire selection of members.
To modify a single member at a time, press choose Click to Apply then click on the members with the left
mouse button.
To modify a selection of members, first select the members you want to split before pressing the Split button,
then choose Apply to Selected.

Note
l
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Adding Nodes to Members
You can add nodes to members at equal length intervals or you may add nodes at specific locations from the I Joint.
You may specify the location as a length or a percentage of length. For example specifying %25 will add nodes at
the quarter points of the members.
For Physical members it is likely that you will not want to actually split the member but prefer instead that joints
be placed along the member so that you may specify other members, plates, loads or boundary conditions.

To Add Nodes to Members
1. If there is not a model view already open then go to the View tab and select the Open 3D Views button to
open a new view.
2. From the Modify tab on the ribbon toolbar, select the Add Nodes button from the Members section.
3. Set the parameters for adding nodes to the members.
4. You may choose to modify a single member at a time or an entire selection of members.
To modify a single member at a time, press choose Click to Apply then click on the members with the left
mouse button.
To modify a selection of members, first select the members you want to split before pressing the Split button,
then choose Apply to Selected.

Note
l

You may undo any mistakes by clicking the Undo

button.

Swap Member Ends
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The Swap Ends button will swap the start (I-node) and end (J-node) of a member. This can be useful if you are
trying to assign connection rules to your members and need to quickly swap columns such that their I-end is at the
bottom of the column.
You can also choose to swap the loads with the member ends. If you do not swap the loads, they will remain
graphically as they are.

Trim/Extend Members
As you modify the model, you may find that you will need to trim or extend a member. The Trim/Extend tool will
allow you to modify the ends of any member in relation to another member. This extension is for members only,
not walls or plates.

Note
l

l

This tool is sensitive to the end that you click. Each member has an I and J end. Make sure to click on
the member side that you want to modify.
You need to click on the member NOT the node. This tool is modifying the length of the member.

To Perform a Trim

1. If there is not a model view already open then click the View tab on the Ribbon Toolbar and then the Open
3D Views button to open a new view.
2. Go to the Modify tab of the Ribbon Toolbar and click the Trim button.
3. Click on the member end to Trim. Then click on the boundary member.
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To Perform an Extend

1. If there is not a model view already open then click the View tab on the Ribbon Toolbarand then the Open
3D Views button to open a new view.
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2. Click the Modify tab in the Ribbon Toolbar and then the Extend button.
3. Click on the member end to Extend. Then click on the boundary member.
Example 1:

Example 2: The Extend tool can also be used to extend a member to intersection of that member's projected
location.
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Re-Labeling Selected Elements

You can use the Relabel buttons in the Modify tab of the Ribbon Toolbar to re-label only the selected items or all
items. This is useful when you want all members at a certain elevation to have a prefix which denotes the floor on
which it is located.

Merging Model Elements

As you build your model, you may find that you will need to perform a model merge from time to time. In fact, if
you count on doing this, you can generally build your models faster and let the model merge feature do a lot of the
work for you. See Merge Tolerance to learn about inputting the merge tolerance.

To Perform a Model Merge
1. If there is not a model view already open then go to the View tab in the Ribbon Toolbar and press the Open
3D Views button to open a new view.
2. Select the items you wish to merge. Typically you will want everything to be selected.
3. Click the Model Merge button, set the parameters for the new merge then either press Apply All or Apply
Selected.
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Match

Use the Match tool to match the properties of one element to another element.
To use Match feature
1. Go to the Modify tab and select the Match button.
2. Select the target element you would like to copy the properties of.
The label of this element will appear in your properties panel in the Match properties of:section.

3. Next you will select the elements that you would like to match the properties to. These elements will now share
all the properties of the element that was selected in step 2.
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Note
l
l

l

Subsequent clicks after the first click will continue matching elements to the first member.
If you would like to create a new target member to match the properties of, you can click the Reset button in the Properties Panel. This will make the next element you select become the new target member
to match properties of.
Currently the program will match all of the properties of the target member. There is not a way match
partial properties at this time.
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Graphic Selection
You may graphically select items in order to view or modify part of the model or to print part of the results. When
used in conjunction with the graphic editing features it allows you to quickly model and make modifications to the
model. If used with results it allows you to view and print only the input or results that you want.

The elements that you see in the model views have two possible states; selected and unselected. By default, all
items are unselected, and therefore fully displayed with no selection highlight. If you select any items, they will be
highlighted in a blue shade. To select or unselect an item simply click on it with the left mouse button. You may also
use one of the selection tools below to select multiple items.
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Note
l

l
l

l

As an alternative to using the selection tools, some operations offer a Click to Apply option, which
allows you to modify items by clicking or boxing them with the mouse. This is useful when working with
a few items.
Inactive items can only be selected with Criteria Selection.
Unselected items remain as part of the model for the solution. To remove items from the analysis you
need to make them inactive.
If you choose not to display items by turning them off in the Model View Settings dialog, they will be
removed from the 3D View and will not be able to be selected/unselected until you turn the display back
on.

Selection Shortcuts
You can add elements to a selection state by pressing Ctrl on your keyboard and clicking with the left mouse
button. When pressing Ctrl+Left Mouse Click, a plus sign will appear adjacent to the mouse cursor
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. You can now select a single element to add to the selection state, or you can select multiple elements by
boxing them with the mouse.
Similarly, you can remove elements from a selection state by pressing Shift on your keyboard and clicking with the
left mouse button. When pressing Shift+Left Mouse Click, a minus sign will appear adjacent to the mouse cursor
. You can now deselect a single element from the existing selection state, or you can deselect multiple elements
by boxing them with the mouse.

Cycle Selection
To cycle through elements that are near the cursor, press the Crtl key while Scrolling the mouse wheel, either
forward or backward. This can be useful if you have a model with elements blocking others that you are interested
in selecting and do not want to rotate the model to a position that exposes the desired elements.

Selection Modes
The Selection Toolbar is the vertical toolbar located on the left side of the screen. This toolbar is for selecting
joints, members, and plates in model views. This toolbar will not be available when a model view is not active.
Some of the tools are for one-time applications such as Select All. Other tools, such as Box Select, place you in a
selection mode that remains active until you cancel it. The current mode is indicated by the mouse pointer and by
the state of the button. While in a selection mode the button will stay depressed until you click it again, choose
another button, or press the ESC key. You may have more than one model view open and may be in different modes
in each view.

Note
l

l

There are other types of graphic modes such as editing and viewing (zooming) modes. The viewing
mode overrides the selection mode, which overrides the editing mode. This is so that while you are editing the model you can alter the selected state. You will be returned to the current editing mode when
you terminate a selection mode.
To cancel a selection mode press the ESC key, or click the right mouse button.

Select All and Unselect All
Clicking Select All
in the model.

and Unselect All

tools will select or unselect all of the active joints, members, and plates

Box Select and Unselect Modes
The Box Select
and Box Unselect
tools allow you to draw a box around the items that you wish to select
or unselect. Members and plates must be entirely within the box in order for them to be affected.
When selecting members by boxing, dragging your mouse from left to right will select members completely
encompassed within the selection. This selection style is denoted by the solid blue line type of the selection box.
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Alternatively, dragging your mouse to box from right to left will select all elements that you box through. This
selection style is denoted with a striped blue line type.

Polygon Select and Unselect
The Polygon Select
and Polygon Unselect
tools allow you to draw a polygon around the items that you
wish to select or unselect. Members and plates must be entirely within the polygon in order for them to be affected.

Line Select and Unselect
The Line Select
and Line Unselect
tools allow you to draw a line through the items that you wish to select
or unselect. Any element the line crosses will be affected. This is useful when choosing items between other items
such as columns between floors.

Inverting Selections
The Invert Selection
button is used to invert the selected state of the model. When clicked, all selected items
are made unselected and all previously unselected items are made selected. For example, this can be very useful
when many items are to be selected in a large model. Simply click on the undesired items to select them, then click
the Invert Selection button to make them unselected and everything else selected.

Criteria Selections
The Criteria Selection
button allows you to select items based on a wide range of criteria such as coordinates,
labels and many other conditions. When the Criteria Select button is clicked, you will be presented with the
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Criteria Selection Dialog with options grouped by tabs across the top. Each tab represents groups of criteria that
you may use to refine your selection.
The options are numerous making it easy to quickly achieve complicated selections. This is a powerful tool so it is
worth taking the time to experiment with the options so that you will know how to use it to your advantage. The
various tabs in the dialog are described below.

Nodes

You may Select or Unselect joints as follows.
Node Label – You may specify a range of node labels. Specifying only one label selects just that one node.
Boundary Codes – You may specify boundary condition criteria in all six degrees of freedom.
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Diaphragm (Primary Node or Detach From) – Checking this box and choose from the dropdown menu for either
Primary Node or Detach From to select the nodes that currently define diaphragms or nodes that currently have
their “Detach From Diaphragms” flag set.
Overwrite Lock - Checking this box will apply the specified criteria to be selected or unselected regardless of any
part of the model being locked.
Overwrite previous selection - Checking this box will overwrite the previous selection shown in the 3D View.

Note
l

If no criteria are specified, all the nodes will be selected/unselected.

Members
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You may Select or Unselect members based on the following criteria.
Member Label – You may specify a range of member labels. If only one label is entered, only that one member will
be selected.
Parallel – You may select members that are parallel to a certain member, whose label you enter, or parallel to a
global axis.
Member Properties – You may specify a Section Set/Shape, Design List, Materials, Member Type, Design Rule,
Function, Seismic Design Rule, Tension/Compression-Only, or Connection Rule to be applied when selecting
members.
Overwrite Lock - Checking this box will apply the specified criteria to be selected or unselected regardless of any
part of the model being locked.
Overwrite previous selection - Checking this box will overwrite the previous selection shown in the 3D View.

Note
l
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Plates

You may Select or Unselect plates based on the following criteria.
Plate Label – You may specify a range of plate labels. If only one label is entered, only that one plate will be
selected.
Parallel – You may select plates that are parallel to certain plate, whose label you enter, or parallel to a global
plane.
Plate Properties – You may specify a minimum and maximum Thickness and Material to be applied when selecting
plates. You may also select only the plane stress plates. You also may select plates that are currently inactive.
Using this criterion will make these plates active. To make them inactive once again you can then use Modify
Plates.
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Overwrite Lock - Checking this box will apply the specified criteria to be selected or unselected regardless of any
part of the model being locked.
Overwrite previous selection - Checking this box will overwrite the previous selection shown in the 3D View.

Note
l

If no criteria are specified, all the plates will be selected/unselected.

Wall Panels

You may Select or Unselect panels based on the following criteria.
Wall Panel Label – You may specify a range of panel labels. If only one label is entered, only that one panel will be
selected.
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Parallel – You may select panels that are parallel to certain panel, whose label you enter, or parallel to a global
plane.
Wall Panel Properties – You may specify a Material Type (Wood, Masonry, etc) and/or Material Set (Larch, Clay,
etc). You also may select panels that are currently inactive. Using this criterion will make these panels active. To
make them inactive once again you can then use ModifyPanels.
Overwrite Lock - Checking this box will apply the specified criteria to be selected or unselected regardless of any
part of the model being locked.
Overwrite previous selection - Checking this box will overwrite the previous selection shown in the 3D View.

Note
l

If no criteria are specified, all the panels will be selected/unselected.
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Solids

You may Select or Unselect solids based on the following criteria.
Solid Label – You may specify a range of Solid labels. If only one label is entered, only that one Solid will be
selected.
Material Properties – You may select or unselect solid elements base on their material. You also may select solids
that are currently inactive. Using this criterion will make these solids active. To make them inactive once again you
can then use ModifySolids.
Overwrite Lock - Checking this box will apply the specified criteria to be selected or unselected regardless of any
part of the model being locked.
Overwrite previous selection - Checking this box will overwrite the previous selection shown in the 3D View.
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Note
l
l

If no criteria are specified, all the solids will be selected/unselected.
The ONLY way to make an inactive solid active again is to use this criteria select dialog.

Loads

You may Select or Unselect loads based on the following criteria.
Basic Load Case – You may specify a Basic Load Case for which to select or unselect loads.
Load Type – You may select or unselect loads based on the load type. You also may select a direction or min/max
magnitude.
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Select Elements used to define load – You may also choose to select elements which are used to define a load.
These can be nodes, members, wall panels, etc.
Overwrite Lock - Checking this box will apply the specified criteria to be selected or unselected regardless of any
part of the model being locked.
Overwrite previous selection - Checking this box will overwrite the previous selection shown in the 3D View.

Note
l

If no criteria are specified, all the loads will be selected/unselected.

Coordinates
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You may select or unselect elements based on coordinate criteria and combine this with the criteria on the other
tabs.
Coordinate Range– You may specify minimum and maximum bounds in the global directions. Items within these
bounds AND meeting the criteria in the other groups will be selected/unselected.
Nodes – You may specify that nodes in the coordinate range be selected or not.
Members – You may specify that one or both member end nodes be within the bounds. You may also specify that
no members be selected within the range.
Plates – You may specify that one or all plate corner nodes be within the bounds. You may also specify that no
plates be selected within the range.
Wall Panels – You may specify that one or all panel corner nodes be within the bounds. You may also specify that
no panel be selected within the range.
Solids – You may specify that one or all solid corner nodes be within the bounds. You may also specify that no
solid be selected within the range.
Also Consider Members/Plates/Walls/Solids Tab – This option allows you to include selection criteria from the
other pages Members, Plates, Wall Panels, Solids and combine it with the coordinate range specified on this page.

Note
l

If the “Also Consider ... Tab” checkbox is checked, all criteria will be applied together so that the affected
items will meet all of the criteria. For example if you specify a range of node labels and coordinates, only
the nodes within the coordinate bounds and within the label range will be selected/unselected.

Lock & Dim Lock
Click the Lock Unselected
button to cause all currently unselected items to stay unselected and be visually
removed from the current model view. This is useful when you are editing or printing a portion of a model and
need to clear the model view of all items not involved. For example in a multistory building when working on one
floor you can lock the other floors. Just unselect the entire model, then use box select to select the floor you would
like to work on, then press the Lock Unselected button and the rest of the model will stay unselected until you
press the button again to turn it off. This tool is also helpful when trying to select an item that is behind other
items.
To Unlock the unselected members in the model view, click the Unlock Unselected
button and the unselected
items that were previously "removed" from the model view will be returned to the view in the unselected state.
Clicking the Dim Lock
button will cause all currently unselected elements to become visually dim or greyed
out. While in the dim lock state, you will not be able to click on these dimmed elements nor will they graphically
show any labels or results. This is useful for when you want to keep a portion of your structure for visual reference
only but also have it stay out of your way when modeling or reporting graphical results.
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Note that when you are in the dim lock state, you will see a blue border around the 3D view.
To unlock the Dim Lock state, simply click the
original state
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button and the dimmed elements will return back to their
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Viewer Mode
Similar to the Dim Lock feature, clicking the Viewer Mode eye icon
will cause all currently unselected
elements to become greyed out. However, in viewer mode, you can select or unselect elements with a single click.

While in viewer mode, labels, results and other element specific information will only be displayed for elements that
are selected. You can quickly click on different elements to make them visible or grayed out.
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In addition to the graphic display, both the input and result spreadsheets will automatically filter its information
based on the elements that are selected in the viewer mode. This automatic filtering can be turned off within your
Application settings > General tab.
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Note that while in viewer mode you will see a green border around the 3D view.
It is also important to note that while in viewer mode, it is not possible to model or make edits to your model. The
intention behind this is that viewer mode is primarily focused on ‘viewing’ your elements and associated element
information.

Input Filter
To filter the input spreadsheets based on your selection, click the Input Filter
option in the Selection Toolbar
. You have the option to filter out the UnSelected items or the Selected items from the input spreadsheets.
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When you open any input spreadsheet, you can tell if it has been filtered by the filter icon in the spreadsheet
header.

Graphic Selection from Spreadsheets
In many spreadsheets, both Data Entry and Results, you can select rows on the spreadsheet and use the right-click
menu to select the Select Marked Lines in Current View or Unselect Marked Lines in the Current View
options. This will graphically select or unselect the items corresponding to the selected rows in the top most model
view window. This is very useful for highlighting failing members in a spreadsheet and then having them
graphically selected in a model view to see where the problems are.

Saving Selections
You can save and recall various selection states for a model. If the model is altered after a selection state has been
saved, the saved selection state will also be altered. Any new items (joints, members…) will be set to "selected" in
any selection states saved prior to the creation of the new item.
To save a selection state, click the Save Selection State
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Click the Save button and provide a name for the saved selection. You can have up to 15 different saved selections
in a model. To retrieve a saved selection, choose the selection state from the drop down list and click the Retrieve
button. To delete a saved selection, choose the selection state from the drop down list and click the Delete button.

Quick Find

You can quickly find elements in a model using the Quick Find tool located on the Home tab of the ribbon toolbar.
You can type in the labels of the elements you wish to find in the Quick Find dialog, using commas to specify
multiple elements.
You have the option to select only these elements or to add these elements to the existing selection. You can also
Auto Zoom the Current Model View to these elements.

General Reference Manual

271

Graphic Selection

272

RISA-3D V20

Graphics - Model View Settings

Graphics - Model View Settings

The Quick View buttons on the Home tab (see Graphic Display for more information) offers some common
graphical plotting choices, but these are just a few of the options available. Many more options are located in the
Model View Settings dialog which may be accessed by clicking the Model View Settings button on the View tab.
The options are organized into groups of items. Access each group by clicking on the tabs along the top of the dialog
box. Some of the options are mutually exclusive and others are conditional. Typically, only one radio button option
may be chosen at a time and indented options will not be available to choose from unless the heading radio button
is not selected.
Each of the groups presents the option to turn off those particular items in the view. This is not the same as
unselecting the items. Turning items on and off is independent from selecting and unselecting. For example if you
make a selection of members and then turn off members all together, the selection still stands for any modification
applied to members.

Defaults
You may make any settings in the Model View Settings dialog the default start-up settings. To do this, go through all
the Model View Settings tabs and set all the options to what you want as the start-up default. Once that is done,
select the General tab and check the option at the bottom of the dialog Set as Default.
Note:
l

Remember, this button applies to ALL tabs in the Model View Settings dialog.

General Reference Manual

273

Graphics - Model View Settings

General
Access the graphical options for nodes by clicking the Model View Settings button on the View tab and selecting
the General tab shown below.
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You may specify that Nodes are, or are not, displayed and you may include the joint label.
You may display Boundary Conditions and as part of this option you may display any spring stiffnesses that you
have specified. The “ALL” boundary condition will not be shown unless it is also specified.
Rigid Diaphragms will be plotted if its box is checked.
You may indicate whether the global axes icon is to be displayed in the upper left corner of the model view by
checking the Global Axes box.
Checking the Project Grid Lines box will turn on the display of the project grid in the current model view. The
color and line type for the grid may also be customized. Click the colored rectangle to choose a custom color.
Choose from the Line Type drop down to display the project grid with dashed or solid lines. The Bubble Size drop
down list allows you to choose a font size for the grid labels and the bubbles that encompass them.
Finally, you may make any model view settings the default startup settings. To do this, go through all the Model
View Settings tabs and set all the options to what you want as the startup default. Once that is done, press the Set
as Default button. This button applies to ALL the Model View Settings tabs.

Members
Access the graphical Model View Settings for members by clicking the Model View Settings button on the View tab
and selecting the Members tab shown below.
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You may specify that no members are drawn, or you may draw them as Wireframe (with a Label or Color Code) or
Rendered.
Uncheck Members to not display the members in the model at all.
With the Wireframe options you may include textual member information alongside each member. The Labeling
drop down list provides the choices you have as to what information will be displayed alongside each member. The
Wireframe option also allows you to display member Pinned End conditions and/or either Rigid End Offsets.
Wireframe options also includes color coding members which plots the members using various colors to represent
particular information such as the section set assigned to each member, member type, etc. Use the Color Coding
drop down list which provides the choices you have as to how the colors are to be assigned to each member. The
key that defines these colors is shown in the upper right corner of the model view.
The Rendering option will produce true-to-scale renderings of the members. These may be rendered full length or
pulled back by a specified distance or a percentage of the member length for a better understanding of complicated
intersection areas and a better view of the member cross-section. This option is also very useful for verifying
member orientations. You can also adjust the transparency of the rendering.
The detailing information check box pertains to information that is for export through the CIS\2 Translator. See the
Cardinal Points topic for more information.
For additional advice on this topic, please see the RISA Tips & Tricks website: www.risa.com/post/support. Type in
Search keyword: Graphics.

Plates
Access the graphical Model View Settings for plates by clicking the Model View Settings button on the View tab
and selecting the Plates tab shown below.
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This tab allows you to specify that plates are to be drawn as wireframe, color coded, or rendered elements, or that
they are not to be shown at all.
Uncheck Plates to not display the plates in the model at all.
When the Wireframe option is selected, you may include information on the plates when plotted. The Labeling
drop down list provides the choices you have as to what information will be displayed on each plate, such as the
plate label, material, thickness, or the plate local axes. The wireframe option also allows you to display plate Pinned
Corner conditions.
When the Color Coded option is selected, plates are plotted with different colors that are mapped in a key shown
in the upper right corner of the model view. You may color the plates by material set or specify a uniform color for
all plates. You can toggle the Outline of the plates on and off. The color coded plates themselves may be presented
with varying Transparency with 100% transparency meaning completely see through and 0% indicating
completely solid.
When the Rendered option is selected, true to scale representations of the plates will be drawn with thickness.
You may also display the rendered plates at a percentage of their Size. This is useful in understanding orientation
and connectivity in complex views as shown below.
The Transparency setting described above for Color Coded plates also applies to Rendered plates.

Wall Panels
Access the graphical Model View Settings for wall panels by clicking the Model View Settings button on the View
tab and selecting the Wall Panels tab shown below.

General Reference Manual

277

Graphics - Model View Settings

The Wall Panels tab allows you to specify that panels are to be drawn as wireframe, color coded, or rendered
elements, or that they are not to be shown at all.
Uncheck Wall Panels to not display the wall panels in the model at all.
When the Wireframe option is selected, you may include information on the panels when plotted. The Labeling
drop down list provides the choices you have as to what information will be displayed on each wall panel, such as
the wall panel label, material, or the wall panel number. You also have the option to see the mesh that the program
automatically creates internally for all Wall Panels.
When the Analysis Mesh option is checked on, wall panels are plotted showing the internal plate mesh
automatically generated during a solution. This is useful for verifying and understanding how the forces/stresses
are distributed within a panel.
When the Color Coded option is selected, wall panels are plotted with different colors that are mapped in a key
shown in the upper right corner of the model view. You may color the panels by material set or specify a uniform
color for all panels. The color coded panels themselves may be presented with varying Transparency with 100%
transparency meaning completely see-through and 0% indicating completely solid.
When the Rendered option is selected, true to scale representations of the panels will be drawn with thickness. The
Texture checkbox will show the wall panels with different texture depending on the wall panel material. You may
also display the rendered panels at a percentage of their size. This is useful in understanding orientation and
connectivity.

Solids
Access the graphical Model View Settings for solids by clicking the Model View Settings button on the View tab
and selecting the Solids tab shown below.
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The Solids tab allows you to specify that solids are to be drawn as wireframe, color coded, or rendered elements, or
that they are not to be shown at all.
Uncheck Solids to not display the solids in the model at all.
When the Wireframe option is selected, you may include information on the solid elements when plotted. The
Labeling drop down list provides the choices you have as to what information will be displayed on each solid, such
as the label, material, or number.
When the Color Coded option is selected, solids are plotted with different colors that are mapped in a key shown in
the upper right hand corner of the model view. You may color the solids by material set or specify a uniform color
for all solids. The color coded solids themselves may be presented with varying Transparency with 100%
transparency meaning completely see-through and 0% indicating completely solid.
When the Rendered option is selected, true to scale representations of the solids will be drawn. You may also
display the rendered panels at a percentage of their size.

Loads
Access the graphical Model View Settings for loads by clicking the Model View Settings button on the View tab and
selecting the Loads tab shown below.

General Reference Manual

279

Graphics - Model View Settings

The Loads tab allows you to specify that loads are to be displayed graphically, or that they are not to be shown at
all.
Uncheck Loads to not display the loads in the model at all.
Check Magnitudesto display the numerical magnitude of the loads. You may specify that the loads be drawn as
Basic Load Cases, Load Categories or Load Combinations by selecting the corresponding radio button. The load
types to be displayed can be selected by checking the corresponding boxes.

Note:
l

The Transient (Wall) check box will show how loading is attributed to wall panel nodes. For a distributed
load applied to the top of the wall this check box will show you how the line load is attributed as point loads
to each plate corner at the top of the wall. For out of plane loading on walls with openings, this check box
will show how the load in the area of the opening is attributed as point loads to the edges of the opening in a
two-way distribution.

Once you set the Model View Settings for loads, you may then run through all of the load cases, load categories or
load combinations by choosing them from the drop down list at the top of the 3D View.

Diaphragms
Access the graphical Model View Settings for Semi-Rigid Diaphragms for models integrating from RISAFloor by
clicking the Model View Settings button on the View tab and selecting the Diaphragms tab shown below.
The Draw Diaphragms As...section of this tab allows you to specify that solids are to be drawn as wireframe,
contour, or that they are not to be shown at all.
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When the Wireframe option is selected, you may include the contours or the FEA plate submesh after a single or
batch solution has been performed. The display of line contours represents the force or stress results for the
internal plates. Each color line represents a specific value. For batch solutions, you must choose which load
combination you want to view in the Combination To Use For Results Display drop down list.
The Contours are plotted with a global smoothing algorithm that allows the contour to vary across the internal
plate elements. The contours are drawn as color filled areas.
The Contouring Control section determines what force or stress result is to be contoured and how the contour
colors are to be assigned. The Value drop down list is where you select the specific result to be contoured (QX, QY,
MX, MY, etc.). Note the forces are based on the global axis as indicated with a capital axis letter (MX vs Mx). The
Range controls determine how the contour colors are assigned. You can either contour the full range of the results
by choosing Calculated Maximum to Minimum, or, if you are only interested in a specific range of values, you can
choose User Defined and enter your own max and min values.
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The Quick View buttons on the Home tab (see Graphic Display for more information) offers some common
graphical plotting choices, but these are just a few of the options available. Many more options are located in the
Model View Settings dialog which may be accessed by clicking the Model View Settings button on the View tab.
The options are organized into groups of items. Access each group by clicking on the tabs along the top of the dialog
box. Some of the options are mutually exclusive and others are conditional. Typically, only one radio button option
may be chosen at a time and indented options will not be available to choose from unless the heading radio button
is not selected.
Each of the groups presents the option to turn off those particular items in the view. This is not the same as
unselecting the items. Turning items on and off is independent from selecting and unselecting. For example if you
make a selection of members and then turn off members all together, the selection still stands for any modification
applied to members.

Defaults
You may make any settings in the Model View Settings dialog the default start-up settings. To do this, go through all
the Model View Settings tabs and set all the options to what you want as the start-up default. Once that is done,
select the General tab and check the option at the bottom of the dialog Set as Default.
Note:
l
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General
Access the graphical options for nodes by clicking the Model View Settings button on the View tab and selecting
the General tab shown below.
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You may specify that Nodes are, or are not, displayed and you may include the joint label.
You may display Boundary Conditions and as part of this option you may display any spring stiffnesses that you
have specified. The “ALL” boundary condition will not be shown unless it is also specified.
Rigid Diaphragms will be plotted if its box is checked.
You may indicate whether the global axes icon is to be displayed in the upper left corner of the model view by
checking the Global Axes box.
Checking the Project Grid Lines box will turn on the display of the project grid in the current model view. The
color and line type for the grid may also be customized. Click the colored rectangle to choose a custom color.
Choose from the Line Type drop down to display the project grid with dashed or solid lines. The Bubble Size drop
down list allows you to choose a font size for the grid labels and the bubbles that encompass them.
Finally, you may make any model view settings the default startup settings. To do this, go through all the Model
View Settings tabs and set all the options to what you want as the startup default. Once that is done, press the Set
as Default button. This button applies to ALL the Model View Settings tabs.

Members
Access the graphical Model View Settings for members by clicking the Model View Settings button on the View tab
and selecting the Members tab shown below.
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You may specify that no members are drawn, or you may draw them as Wireframe (with a Label or Color Code) or
Rendered.
Uncheck Members to not display the members in the model at all.
With the Wireframe options you may include textual member information alongside each member. The Labeling
drop down list provides the choices you have as to what information will be displayed alongside each member. The
Wireframe option also allows you to display member Pinned End conditions and/or either Rigid End Offsets.
Wireframe options also includes color coding members which plots the members using various colors to represent
particular information such as the section set assigned to each member, member type, etc. Use the Color Coding
drop down list which provides the choices you have as to how the colors are to be assigned to each member. The
key that defines these colors is shown in the upper right corner of the model view.
The Rendering option will produce true-to-scale renderings of the members. These may be rendered full length or
pulled back by a specified distance or a percentage of the member length for a better understanding of complicated
intersection areas and a better view of the member cross-section. This option is also very useful for verifying
member orientations. You can also adjust the transparency of the rendering.
The detailing information check box pertains to information that is for export through the CIS\2 Translator. See the
Cardinal Points topic for more information.
For additional advice on this topic, please see the RISA Tips & Tricks website: www.risa.com/post/support. Type in
Search keyword: Graphics.

Plates
Access the graphical Model View Settings for plates by clicking the Model View Settings button on the View tab
and selecting the Plates tab shown below.
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This tab allows you to specify that plates are to be drawn as wireframe, color coded, or rendered elements, or that
they are not to be shown at all.
Uncheck Plates to not display the plates in the model at all.
When the Wireframe option is selected, you may include information on the plates when plotted. The Labeling
drop down list provides the choices you have as to what information will be displayed on each plate, such as the
plate label, material, thickness, or the plate local axes. The wireframe option also allows you to display plate Pinned
Corner conditions.
When the Color Coded option is selected, plates are plotted with different colors that are mapped in a key shown
in the upper right corner of the model view. You may color the plates by material set or specify a uniform color for
all plates. You can toggle the Outline of the plates on and off. The color coded plates themselves may be presented
with varying Transparency with 100% transparency meaning completely see through and 0% indicating
completely solid.
When the Rendered option is selected, true to scale representations of the plates will be drawn with thickness.
You may also display the rendered plates at a percentage of their Size. This is useful in understanding orientation
and connectivity in complex views as shown below.
The Transparency setting described above for Color Coded plates also applies to Rendered plates.

Wall Panels
Access the graphical Model View Settings for wall panels by clicking the Model View Settings button on the View
tab and selecting the Wall Panels tab shown below.
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The Wall Panels tab allows you to specify that panels are to be drawn as wireframe, color coded, or rendered
elements, or that they are not to be shown at all.
Uncheck Wall Panels to not display the wall panels in the model at all.
When the Wireframe option is selected, you may include information on the panels when plotted. The Labeling
drop down list provides the choices you have as to what information will be displayed on each wall panel, such as
the wall panel label, material, or the wall panel number. You also have the option to see the mesh that the program
automatically creates internally for all Wall Panels.
When the Analysis Mesh option is checked on, wall panels are plotted showing the internal plate mesh
automatically generated during a solution. This is useful for verifying and understanding how the forces/stresses
are distributed within a panel.
When the Color Coded option is selected, wall panels are plotted with different colors that are mapped in a key
shown in the upper right corner of the model view. You may color the panels by material set or specify a uniform
color for all panels. The color coded panels themselves may be presented with varying Transparency with 100%
transparency meaning completely see-through and 0% indicating completely solid.
When the Rendered option is selected, true to scale representations of the panels will be drawn with thickness. The
Texture checkbox will show the wall panels with different texture depending on the wall panel material. You may
also display the rendered panels at a percentage of their size. This is useful in understanding orientation and
connectivity.

Solids
Access the graphical Model View Settings for solids by clicking the Model View Settings button on the View tab
and selecting the Solids tab shown below.
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The Solids tab allows you to specify that solids are to be drawn as wireframe, color coded, or rendered elements, or
that they are not to be shown at all.
Uncheck Solids to not display the solids in the model at all.
When the Wireframe option is selected, you may include information on the solid elements when plotted. The
Labeling drop down list provides the choices you have as to what information will be displayed on each solid, such
as the label, material, or number.
When the Color Coded option is selected, solids are plotted with different colors that are mapped in a key shown in
the upper right hand corner of the model view. You may color the solids by material set or specify a uniform color
for all solids. The color coded solids themselves may be presented with varying Transparency with 100%
transparency meaning completely see-through and 0% indicating completely solid.
When the Rendered option is selected, true to scale representations of the solids will be drawn. You may also
display the rendered panels at a percentage of their size.

Loads
Access the graphical Model View Settings for loads by clicking the Model View Settings button on the View tab and
selecting the Loads tab shown below.
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The Loads tab allows you to specify that loads are to be displayed graphically, or that they are not to be shown at
all.
Uncheck Loads to not display the loads in the model at all.
Check Magnitudesto display the numerical magnitude of the loads. You may specify that the loads be drawn as
Basic Load Cases, Load Categories or Load Combinations by selecting the corresponding radio button. The load
types to be displayed can be selected by checking the corresponding boxes.

Note:
l

The Transient (Wall) check box will show how loading is attributed to wall panel nodes. For a distributed
load applied to the top of the wall this check box will show you how the line load is attributed as point loads
to each plate corner at the top of the wall. For out of plane loading on walls with openings, this check box
will show how the load in the area of the opening is attributed as point loads to the edges of the opening in a
two-way distribution.

Once you set the Model View Settings for loads, you may then run through all of the load cases, load categories or
load combinations by choosing them from the drop down list at the top of the 3D View.

Diaphragms
Access the graphical Model View Settings for Semi-Rigid Diaphragms for models integrating from RISAFloor by
clicking the Model View Settings button on the View tab and selecting the Diaphragms tab shown below.
The Draw Diaphragms As...section of this tab allows you to specify that solids are to be drawn as wireframe,
contour, or that they are not to be shown at all.
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When the Wireframe option is selected, you may include the contours or the FEA plate submesh after a single or
batch solution has been performed. The display of line contours represents the force or stress results for the
internal plates. Each color line represents a specific value. For batch solutions, you must choose which load
combination you want to view in the Combination To Use For Results Display drop down list.
The Contours are plotted with a global smoothing algorithm that allows the contour to vary across the internal
plate elements. The contours are drawn as color filled areas.
The Contouring Control section determines what force or stress result is to be contoured and how the contour
colors are to be assigned. The Value drop down list is where you select the specific result to be contoured (QX, QY,
MX, MY, etc.). Note the forces are based on the global axis as indicated with a capital axis letter (MX vs Mx). The
Range controls determine how the contour colors are assigned. You can either contour the full range of the results
by choosing Calculated Maximum to Minimum, or, if you are only interested in a specific range of values, you can
choose User Defined and enter your own max and min values.
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The Quick View buttons on the Home tab (see Graphic Display for more information) offers some common
graphical plotting choices, but these are just a few of the options available. Many more options related to results are
located in the Results View Settings dialog which may be accessed by clicking the Results View Settings button
on the View tab.
The options are organized into groups of items. Access each group by clicking on the tabs along the top of the dialog
box. Some of the options are mutually exclusive and others are conditional. Typically, only one radio button option
may be chosen at a time, while you may be allowed to select multiple check boxes.
Each of the groups presents the option to turn off the results for those particular items in the view by unchecking
the Display Results option located at the top of each tab.
The displayed results will be based on the specified Load Combination from the top of the Results View Settings
dialog.
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Reactions
Access the graphical options for displaying reactions by clicking the Results View Settings button on the View tab
and selecting the Reactions tab shown below.

Uncheck the Display Reaction Results option to not display any reaction results.
If a single or a batch solution has been performed you may choose to show the Reactions in any of the six degrees
of freedom. You can also include the magnitude values and specify the number of decimal places and display arrow
size. For Batch solutions you must choose which combination you want to view at the top of the Results View
Settings dialog.
If you run an Envelope solution or a Batch w/Envelope solution, you can check the "Show Enveloped" check box
and this will then ignore the "Display Results for:" selection.
If running Overstrength load combinations, you can then show the Overstrength level or Service/Strength level
envelope reactions.

Members
Access the graphical Results View Settings for members by clicking the Results View Settings button on the View
tab and selecting the Members tab shown below.
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Uncheck the Display Member Results option to not display any member results.
You may specify that member results are to be shown with labeling or using a color basis.
The Labeling drop down list provides the choices you have as to what information will be displayed alongside each
member.
Choosing a Color Basis for member results will utilize various colors to represent particular results such as the
unity check, stress levels, etc. The drop down list provides the choices you have as to how the colors are to be
assigned to each member. If a single or batch solution has been performed you may color the members by the code
check or the stress magnitudes. For batch solutions you must choose which combination you want to view at the
top of the Results View Settings dialog. The key that defines these colors is shown in the upper right corner of the
model view.

Note
l

The Tension and Compression color coding options depend on the total axial tension or compression in the
member. This includes the axial (tension or compression) stress plus the axial stress due to bending.
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If the model has been solved you may also plot the member force Diagrams along each member and include the
Magnitudes. You can set the number of Decimal Places for the magnitudes as well as control the graphic scaling of
these force diagrams using the Size slider. The diagrams themselves may be presented with varying degrees of
Transparency with 100% transparency meaning an outline of the force diagram and 0% indicating a solid fill. If a
batch solution has been performed you may also choose which combination you want to view at the top of the
Results View Settings dialog.
For additional advice on this topic, please see the RISA Tips & Tricks website: www.risa.com/post/support. Type in
Search keyword: Graphics.

Plates
Access the graphical Results View Settings for plates by clicking the Results View Settings button on the View tab
and selecting the Plates tab shown below.

You may specify that plate results are to be shown as contour lines, color gradient, or that they are not to be shown
at all. Uncheck the Display Plate Results option to not display any plate results.
If a single or batch solution has been performed, the contour lines represent the force or stress results for the
plates. Each color line represents a specific value. You also have the option to plot the stress and force results using
filled color contours where each fill color represents a range of values. For batch solutions, you must choose which
load combination you want to view at the top of the Results View Settings dialog.
The Color Contours are plotted with a global smoothing algorithm that allows the contour to vary across the
plates. Because of this, the plotted contour results will differ slightly from the tabulated results in the spreadsheets.
This effect will be heightened in regions of a high rate of change such as loads or boundaries. The contours may be
drawn as either lines or as color filled areas.
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The Contour Basis drop down list is where you select the specific result to be contoured (Qx, Fx, Mx, Von Mises,
etc.). The Range controls determine how the contour colors are assigned. You can either contour the full range of
the results by choosing Automatic, or, if you are only interested in a specific range of values, you can choose
Custom and enter your own max and min values.
Along with any of the above options you may also plot the plate Corner Forces. These are the global direction
forces applied to the corners of the plates that hold them in equilibrium. The Direction options specify which
corner force (or moment) is to be displayed. For batch solutions you must choose which combination you want to
view at the top of the Results View Settings dialog.

Wall Panels
Access the graphical Results View Settings for panels by clicking the Results View Settings button on the View tab
and selecting the Wall Panels tab shown below.

Uncheck the Display Wall Panel Results option to not display any wall panel results.
If a single or batch solution has been performed, you can display contour lines representing the force or stress
results for the panels. Each color line represents a specific value. You also have the option to plot the stress and
force results using filled color contours where each fill color represents a range of values. The wall panels are
plotted with different colors that are mapped in a key shown in the upper right corner of the model view. For batch
solutions you must choose which load combination you want to view at the top of the Results View Settings dialog.
The Color Contours are plotted with a global smoothing algorithm that allows the contour to vary across the
panels. Because of this, the plotted contour results will differ slightly from the tabulated results in the spreadsheets.
This effect will be heightened in regions of a high rate of change such as loads or boundaries. The contours may be
drawn as either lines or as color filled areas.
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The Color Basis drop down list is where you select the specific result to be contoured (Qx, Fx, Mx, Von Mises, etc.).
The Range controls determine how the contour colors are assigned. You can either contour the full range of the
results by choosing Automatic, or, if you are only interested in a specific range of values, you can choose Custom
and enter your own max and min values.

Solids
Access the graphical Results View Settings for solids by clicking the Results View Settings button on the View tab
and selecting the Solids tab shown below.

Uncheck the Display Solid Element Results option to not display any solid element results.
If a single or batch solution has been performed, you can display contour lines representing the force or stress
results for the solids. Each color line represents a specific value. For batch solutions, you must choose which load
combination you want to view at the top of the Results View Settings dialog.
The Color Contours are plotted with a global smoothing algorithm that allows the contour to vary across the solid
elements. Because of this, the plotted contour results will differ slightly from the tabulated results in the
spreadsheets. This effect will be heightened in regions of a high rate of change such as applied loads or boundary
conditions. The contours may be drawn as either lines or as color filled areas.
The Color Basis drop down list is where you select the specific result to be contoured (SigmaX, Y or Z, Sigma1, 2 or
3, Von Mises, etc.). The Range controls determine how the contour colors are assigned. You can either contour the
full range of the results by choosing Automatic, or, if you are only interested in a specific range of values, you can
choose Custom and enter your own max and min values.
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Deflection
Access the Results View Settings for deflections by clicking the Results View Settings button on the View tab and
selecting the Deflection tab shown below.

Uncheck the Display Deflected Model (using Model View Settings) option to not display any deflected shape
results.
In this tab you may specify that a deflected shape be drawn in the current model view based on either a static load
combination (if a single or batch static solution has been done) or a mode shape (if a dynamic solution has been
done). You can also display loads for the load combination at the same time as displaying the deflected shape. You
can control the magnification of the deflections with the Scale text box and specify whether an undeflected shadow
is to be shown by checking the Display shadow of undeflected model box. For batch solutions you must choose
which combination you want to view at the top of the Results View Settings dialog.

Note:
l

Time History Deflection diagrams only display joint translation. Joint rotation is not displayed.
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When displaying the deflection diagram for a Time History load combination, the user may select the Time Step for
which to display the deflected shape. This section will be grayed out if no time history load combination has been
solved. Additional controls are available for the animation of Time History motion. Please refer to the Dynamics Time History topic for more information.
To animate a particular deflected shape, first select the deflected shape (as described above) and then simply click
the Animate Results button on the View tab. See Animate Results.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Deflected.
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Help Options
RISA Tech, Inc. has, and will, put a great deal of effort into assisting you in getting your work done as quickly as
possible. This includes providing many ways that you can get help in understanding the software.

Electronic Help File
The Help File is designed to help you get your work done as quickly as possible and is intended to provide:
l
l
l
l
l

Procedures that lead users through the steps of completing tasks
Context-sensitive Help topics that provide users with quick descriptions of items on their screens
Troubleshooting topics that guide users through solutions to common problems
Extensive discussions for a thorough understanding of engineering and modeling topics
Easy access to related topics

The electronic help file can be accessed by clicking the Help File
button in the top right hand corner of the
Quick Access Toolbar. A new window containing a Table of Contents will be opened. Click on any item in the Table
of Contents for extensive information on the topic.

Context Sensitive Help
Context Sensitive Help is help that a user can access in context while working in a program. It provides you with
the information you need where and when you want it.
You may get detailed help when working in a dialog, spreadsheet or graphic view by pressing F1. This will launch a
Help File window displaying the topic that is related to the window in which you are working. The topic will be
explained and links to related topics may also be provided.

RISA Tech, Inc. Online
Our website, www.risa.com, provides various support information and documents.

Visit RISA Tech, Inc. on the web for:
l
l

l

Download program Manuals (General Reference or Tutorial)
Check our website for the latest updates - When a bug is discovered it is posted on the web site along
with possible work-around procedures and/or service releases to update your software.
Software Verification Problems

Tool-tips
Are you uncertain what a toolbar button is for? Simply hold your mouse pointer over that button without
clicking. Tool-tips are displayed that will explain what the button will do should you decide to press it.

Tutorials
The comprehensive Tutorials guide you through using most features. It is a real-world example of building and
solving a model, making changes, and optimizing. This is the best way to quickly get up and running. The Tutorials
are designed to be read in two ways. If you are already familiar with structural modeling in general you can skip the
supporting text and read only the underlined action items to quickly move through the tutorial. If you want more
thorough explanations of the modeling process you may read all or some of the supporting text as you see fit.
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Shapes are organized by Shape Type and Database / Manufacturer. Common shapes are supported such as wide
flanges, tubes, pipes, channels, etc. You may type in the names directly, select shapes from these databases or add
your own shapes.
RISA currently supports the following common Hot Rolled steel databases: AISC (United States), Australian, British,
Canadian, Chilean, Chinese, European, Indian, and Mexican.

Note:
l

Older AISC shapes which are no longer part of the AISC database will be automatically moved / exported to a
new AISC_backup database during installation or update.

To Select a Hot Rolled Database Shape
1. From the Hot Rolled tab on the Section Sets Spreadsheet, or the Primary tab of the Members Spreadsheet, move the cursor to the Shape field and click
.
2. Specify the database and shape type you wish to use and then select from the list of available shapes.

To Add a Database Shape

1.
2.
3.
4.
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On the Advanced tab of the Ribbon, click the Shape Database
button.
Select the Hot Rolled tab, then specify the database and shape type you wish to add and click the Add button.
Specify a name for the shape and fill in the Basic Properties.
Click Calc Props to determine the shape properties.
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To Edit a Database Shape

1. On the Advanced tab of the Ribbon, click the Shape Database
button.
2. Select the Hot Rolled tab, then select the shape you wish to edit and click the Edit button.
3. You have the option to input Geometric Properties and Section Properties manually, or you may choose to
have the program calculate the Section Properties based on values input for the Geometric Properties.
4. Once an edit has been made to the Geometric Properties, select Re-Calc to have the program calculate the
Section Properties automatically.

Note
l

l

l

New shapes are added to the bottom of the database in a blue font to show they were not originally from
the default database.
To delete a shape, specify the database and shape type you wish to delete and then click the Delete button.
Only shapes added to the default database (shown in blue) are able to be edited or deleted.

Wide Flange Database Shapes
For the AISC database, wide flange shapes are called out by the designation given them in the steel manuals. For
example, if you wanted to use a W10x33 you would enter W10X33 as the shape name in the database shape field.
M, S and HP shapes are also available. Trade Arbed shapes are called out similar to AISC shapes but with a “_ARB”
suffix. I.e. to call a Trade Arbed W12X96 would enter W12X96_ARB as the shape name in the database shape field.
Canadian and British shapes use the same format as the AISC shapes, but their values are metric. The depth is
called out in millimeters and the mass per length is kg/meter.
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Tube Database Shapes(Hollow Rectangular shapes)
The HSS tube properties are also available in the AISC database. The prefix for these tube shapes is "HSS". The
syntax is "HSSdepthXwidthXthick", where "depth" is the tube depth, "width" is the tube width and "thick" is the
tube thickness in number of 1/16ths. The nominal wall thickness is always used to call out a HSS tube, even though
the design wall thickness will vary based on the manufacturing process for the tube. Tubes manufactured using the
ERW process will use .93 times the nominal wall thickness as their design thickness. Tubes manufactured using the
SAW process will use the full nominal thickness as their design thickness. For example, an HSS12X10X8 would be a
12" deep, 10" wide tube, and a have a design wall thickness of .465” = .93*1/2" (8/16ths) . A HSS32X24X10 would
be 32” deep by 24” wide, and have a design wall thickness of 5/8”(10/16ths)
For the Canadian database, tubes also have a “HSS” prefix and the dimensions are all called out in millimeters.
British shapes use the prefix “SHS” for square tubes and “RHS” for rectangular tubes.

Note:
l

l

The prefix for older AISC tube shapes is "TU". These shapes reflect the properties that were published with
the older AISC 9th edition. As such, these shapes may only exist in the AISC_backup database.
Tubes using the TU prefix will have a design wall thickness of the nominal wall thickness. The syntax is
"TUdepthXwidthXthick", where "depth" is the tube depth, "width" is the tube width and "thick" is the tube
thickness in number of 1/16ths. For example, TU16X12X8 would be a 16" deep, 12" wide tube with a thickness of 1/2" (8/16ths).

Pipe Database Shapes
Pipe shapes, which are hollow circular shapes, are entered as on-line shapes. The syntax for these shapes is
"PIdiaXthick", where "dia" is the pipe outside diameter and "thick" is the pipe thickness (in inches or centimeters).
For example (assuming US Standard units), PI10X.5 would be a 10" diameter pipe with a wall thickness of 1/2".

Channel Database Shapes
Channel shapes are entered with the "C" or “MC” prefix. For example C15X50 would be a valid entry. For Canadian
and British shapes, the depth is called out in millimeters and the mass per length is in kg/meter. Double channels
are entered with the “2C” or “2MC” prefix.

Tee Database Shapes
The Tee shapes are entered with the "WT", “MT” or “ST” prefix. For example WT15X74 would be a valid entry. For
Canadian and British shapes, the depth is called out in millimeters and the mass per length is in kg/meters.

Tapered Wide Flange Shapes
Tapered Wide Flange shapes are called out by referring to the shape name that was given when it was defined in
the database shape editor. Tapered WF shapes can only be defined as database shapes using the “ADD” shape
function in the database editor.
Tapered WF shapes are special in that the cross sectional properties change along the length of the member. This is
as opposed to prismatic members, which have the same cross sectional properties along their length. (All other
shapes are prismatic members). Keep this in mind when defining the I and J joints for tapered shapes. To obtain
alternate tapered shape suggestions it is best to define all Tapered WF members consistently in the shape database
and handle orientation with the I and J joints.
The Tapered WF shape can also be used to define a prismatic WF with unequal flanges. Tapered wide flange shapes
can taper all cross section properties independently and can also have unequal top and bottom flanges. Each basic
property is assumed to taper linearly from the Start value to the End value. Shape properties like the area and the
moments of inertia will be computed at any required intermediate point from the linearly interpolated basic
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properties. (This means that the area and moments of inertia will probably NOT vary linearly along the member
length). Intermediate shape properties are used to calculate the member stiffness and stresses. The member
stiffness is computed internally from a series of piecewise prismatic sections. The error in the member stiffness
computed in this manner, as opposed to the theoretically “correct” stiffness, is always less than 10%.
Note that tapered members are always treated as physical members – not finite members. All the rules and
behaviors described for physical members always apply to tapered members even if the physical member flag is not
set for those members. See Physical Members to learn more about this feature.
To Add a Tapered Wide Flange to the Database
l

To enter a tapered shape in the database click
, select the Tapered WF Shape Type and click Add.
Enter the basic shape properties at the Start and End locations and to have all the necessary parameters
calculated for analysis and design at the member end points and at all the required intermediate locations.

l

To enter a prismatic WF member with unequal top and bottom flanges, just make sure that the shape
properties are the same at the Start and End points. The top and bottom flange information is entered
independently.

Note

Double Angle Database Shapes
These shapes are entered with the prefix "LL". The syntax is "LLbackXflangeXthickXspace" where "back" is the back
to back leg length, "flange" is the single angle flange leg length, "thick" is the angle thickness in number of 1/16ths
and "space" is the space between the angles in 1/8ths. For example, LL6X3.5X5X3 would be L6X3.5 angles 5/16"
thick, long legs back to back with a spacing of 3/8". For the Canadian and British shapes, all the dimensions are
called out in millimeters.

Single Angle Database Shapes
Angles are entered with an "L" prefix. The syntax is "LlongXshortXthick", where "long" is the long leg length,
"short" is the short leg length, and "thick" is the thickness, in number of 1/16ths. For example, L9X4X8 is a 9" by 4"
angle 1/2" (8/16ths) thick. The thickness is entered as 8, because the number of 1/16ths in 1/2 is 8. For the
Canadian and British shapes, all the dimensions are called out in millimeters.

Note:
l

rZ is the Radius of Gyration along the rotated (Principal) vertical axis (local y). The Canadian CSA code calls
this variable ry' but RISA calls it rZ based on the naming convention of the AISC 360.
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l

Solid Rectangular Shapes
These shapes can be defined as on-line shapes. The syntax is "REhtXbase", where "ht" is the rectangle height and
"base" is the rectangle base (in inches or cm). For example, RE10X4 would be a 10" deep, 4" width rectangular
shape (assuming US Standard units). These shapes can also be defined in the Shape Editor. When defined in the
Shape Editor the depth of the solid rectangular section must always be greater than or equal to the width.

Solid Circular Shapes
These shapes are defined as on-line shapes. The syntax is "BARdia", where "dia" is the circle diameter. For
example (assuming metric units), BAR2 would be a circular bar with a diameter of 2 cm.

Buckling-Restrained Brace Database Shapes
Buckling-restrained brace (BRB) shapes are only available in RISAFloor-RISA3D integration models. They can be
selected by choosing the BRB shape type and one of the BRB-related databases. Currently, only CoreBrace database
is supported.
When CoreBrace database is chosen, the syntax for CoreBrace BRB shapes is “CoreBRB_area”, where “CoreBRB” is
the prefix for the manufacturer and shape, and “area” is the steel core area. For example, CoreBRB_0.50 refers to a
BRB shape manufactured by CoreBrace with a 0.50 in2 steel core area. Other properties such as the casing size of
the brace are based on the data provided by the manufacturers.
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BRBs are not prefabricated with specific core sizes, casing sizes, or brace lengths. Instead, they are customfabricated for each project. Therefore the BRB properties in RISA-3D may not be the final and shall be carefully
reviewed by BRB manufacturers.

Note:
l

The BRB shape database is only available for RISAFloor/RISA-3D integration models.
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Full code checking member optimization can be applied to standard steel shapes based on the following codes:
l

l

l

l

l

l

United States:
l AISC 360-16 (15th Edition) ASD & LRFD
l AISC 360-10 (14th Edition) ASD & LRFD
l AISC 360-05 (13th Edition) ASD & LRFD
l AISC LRFD (2nd and 3rd Editions)
l AISC ASD (9th Edition)
Canada:
l CSA S16-14
l CSA S16-09
l CSA S16-05
l CSA S16-01
l CSA S16.1-94
Europe/Great Britain:
l EN 1993-1-1: 2014 (including the U.K. National Annex provisions)
l EN 1993-1-1: 2005 (including the U.K. National Annex provisions)
l ENV 1993-1-1: 1992
l BS 5950-1: 2000
India:
l IS 800: 2007
l IS 800: 1998
Australia:
l AS 4100-1998
New Zealand:
l NZS 3404: 1997

The calculations performed encompass all the code requirements (including the local buckling criteria for slender
compression elements in Appendix B of the 2nd, 3rd, and 9th Edition AISC codes) except those noted in the
Limitations section of this document
How To Apply a Steel Design Code
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1. On the Model Settings - Codes tab, select the steel code from the drop down list.

2. On the Hot Rolled tab of the Members Spreadsheet, enter the appropriate bracing information and factors.

Note:
l

For code checking to be performed on a member, the member must be defined with a database shape on
the Section Sets or Members Spreadsheet.

Design Parameters Spreadsheet
The Hot Rolled Steel Design Parameters Spreadsheet records the design parameters for the steel code checks and
may be accessed by selecting Members on the Spreadsheets menu and then selecting the Hot Rolled tab. These
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parameters are defined for each individual member and may also be assigned graphically. See Modifying Member
Designto learn how to do this.

The following topics will discuss the steel design parameters by first discussing how it applies to regular prismatic
steel sections. If the parameter is treated differently for Tapered WF shapes, that will be discussed separately in the
Tapered Members section.

Label
You may assign a unique Label to all of the members. Each label must be unique, so if you try to enter the same
label more than once you will get an error message. You may relabel at any time with the Relabel options on the
Tools menu.

Shape
The member Shape or Section Set is reported in the second column. This value is listed for reference only and may
not be edited as it is dictated by the entry in the Section/Shape column on the Primary tab.

Length
The member Length is reported in the third column. This value may not be edited as it is dependent on the
member end coordinates listed on the Primary Data tab. It is listed here as a reference for unbraced lengths which
are discussed in the next section.

Member Design Parameters - General

Unbraced Lengths
See the Unbraced Lengths topic.

K Factors (Effective Length Factors)
See the Unbraced Lengths topic.

Sway Flags
See the Unbraced Lengths topic.

308

RISA-3D V20

Hot Rolled Steel - Design

AISC Design Codes - Member Design Parameters

Cm - Interactive Bending Coefficient
Cm Coefficients are described in Chapter H of the 9th Edition AISC (ASD) code. If these entries are left blank, they
will be automatically calculated.
The Cm value is influenced by the sway condition of the member and is dependent on the member's end moments,
which will change from one load combination to the next, so it may be a good idea to leave these entries blank.

Note
l

The Cm factor is not used for LRFD code checking because the Chapter C requirement that P-Delta
effects be considered is met with a direct P-Delta analysis. LRFD code checks will not be performed
without P-Delta analysis.

Cb - Lateral-Torsional Buckling Modification Factor
Cb Factors are described in Chapter F of the AISC code and are used in the calculation of the nominal flexural
strength, Mn. If this entry is left blank, it will be calculated automatically for AISC code checks.
The calculation of Cb is based on the unbraced length of the compression flange and the moment diagram for the
unbraced segment in question. If a specific unbraced length is entered by the user, the program cannot interpret the
location of brace points and the Cb value will default to '1.0'. In some cases, it may be better to enter 'segment' as
the unbraced length for a physical member. When 'segment' is entered, the Cb value will be calculated individually
for each segment of the beam based on that segment's moment diagram.
Notes:
l

l

For members designated as "Tapered WF" shapes, Cb is always calculated per the AISC 360 section F1 equation.
AISC 9th Ed always assumes Cb = 1.0.

Function for Stiffness Reduction
The Function entry may be set to either 'Lateral' or 'Gravity' using the drop down list in the spreadsheet. If the
Adjust Stiffness option is set to Yes on the Codes tab of the Model Settings Dialog, then all members with a 'Lateral'
Function will be considered for the stiffness reduction required per the AISC Direct Analysis Method.
The Flexural Stiffness Reduction of the Direct Analysis Method will be applied to all 'Lateral' members.
The program can perform an iterative analysis during the solution depending on the value of τb. In this case, the
stiffness matrix is recomputed for each iteration until the value of τb converges within 1 percent for all 'Lateral'
members in compression. In the unlikely event that τb is less than zero, the value of τb is considered to be 1.e-5.
When used in the analysis, the value for τbwill be listed in the Detail Report for that member.
When the users sets the Adjust Stiffness flag on the Model Settings to Yes (Tau =1.0), then the program will use a
Tau of 1.0 in the stiffness analysis and no iteration of the stiffness matrix is necessary. This option is a good feature
for models which take a long time to solve or which have not yet been proportioned to control drift.
The Axial Stiffness Reduction of the Direct Analysis Method behaves differently. For the AISC 360-05, 360-10, and
360-16, the reduction will be applied to all 'Lateral' members.

Note
l

The stiffness reduction required by the Direct Analysis Method will be ignored if the Adjust Stiffness
option is not selected on the codes tab of the Model Settings, or if the design code chosen does not have
an option for stiffness reduction.
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l

l

The Direct Analysis Method requires the use of reduced flexural stiffness for all members whose flexural
stiffness is considered to contribute to the lateral stability of the structure. This will only apply to members designated as type 'Column' or 'Beam.' If the user assigns type 'None' to the member, the Flexural
Stiffness Reduction will not be applied.
When the Adjust Stiffness flag is set to Yes (Tau=1.0), then the code would requires a higher value for
the applied Notional Loads.

Channel Conn.
The type of connection for double channels is reported in the Channel Conn. column. This input is only for back to
back channels and is used in the calculation of KL/r.

a - Connector Spacing
For double channels, the connector spacing ‘a’ is used in the calculation of KL/r. This input is only used for back to
back channels.

Allowable Stress Increase Factor (ASIF)
AISC 9th Edition
Increasing of allowable stresses may be allowed when forces are transient. You may enter an ASIF factor on the
Load Combinations Spreadsheet to allow the increase for a specific load combination. The ASIF factor is then
applied to the allowable stresses in accordance with section A5. The ASIF factor also is applied to the Euler values
(F'e).

Note
l

If the allowable stress increase is being used, the final code check value should still be compared to '1.0'.

All Other US Codes
Setting the ASIF factor to a value greater than '1.0' will not cause the capacities to be increased by that factor.
However, setting the ASIF factor to a value greater than '1.0' is used as a flag to use of the seismic compactness
criteria of Table I-8-1 of AISC 341-05 Seismic Provisions of Steel Buildings. Specifically we will use the limiting
width-thickness ratios from this table for capacity calculations (for compression flange local buckling for example).
In these cases, we use Table I-8-1 of AISC 341-05 as opposed to Table B4.1 of AISC 360-05.

AISC Design Codes - Limitations
AISC 360-16 (15th Ed.)
Wide Flanges:
l
l

Flexural torsional buckling per Chapter E is included when Ltorque is greater than either Lbyy or Lbzz.
Flange local buckling per Chapter F is only included when the web is compact and the flange is either noncompact or slender.

Rectangular Tubes - Lateral torsional buckling is checked per section F7.4, however this section only applies to
strong axis bending.
Code Checks - For combined bending and tension (Section H1.2) the code-allowed modification of Cb is not applied.
For combined bending and compression, Section H1.3 is not considered, meaning that the program can be over
conservative in some situations.
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Single Angles - Single angles in compression are not checked for Section E4 because no standard single angle
shapes have a slenderness (b/t) > 20. They are also not checked for Section E5 as there is insufficient information
regarding the connections and usage of the member.
WT and LL Shapes - This code does not address the rare case where Lateral Torsional (or Flexural Torsional)
Buckling occurs for WT's and double angles bent about their weak axis. Therefore, only yielding is checked for weak
axis bending.
Double Channels -Double channel connector spacing requirements are not checked. Additionally, double channel
design is only available in AISC 360-16 and AISC 360-10 codes.

AISC 360-05 (13th Ed.) and AISC 360-10 ( 14th Ed.)
Wide Flanges:
l

l

l

For AISC 360-10, flexural torsional buckling per Chapter E is included when Ltorque is greater than either
Lbyy or Lbzz.
For AISC 360-05, flexural torsional buckling per Chapter E is only included when Ltorque > Lbyy and Ltorque
> Lbzz.
Flange local buckling per Chapter F is only included when the web is compact and the flange is either noncompact or slender.

Code Checks - For combined bending and tension (Section H1.2) the code-allowed modification of Cb is not applied.
For combined bending and compression, Section H1.3 is not considered, meaning that the program can be over
conservative in some situations.
Single Angles - Single angles in compression are not checked for Section E4 because no standard single angle
shapes have a slenderness (b/t) > 20. They are also not checked for Section E5 as there is insufficient information
regarding the connections and usage of the member.
WT and LL Shapes:
l

l

This code does not address the rare case where Lateral Torsional (or Flexural Torsional) Buckling occurs for
WT's and double angles bent about their weak axis. Therefore, only yielding is checked for weak axis bending.
For slender WT sections, the compressive capacity is calculated with Qa always assumed equal to 1.0.

ASD 9th Edition Limitations
Wide Flange Shapes - Code checks for shapes that qualify as plate girders, as defined by Chapter G, are not
performed. Plate girders that can be checked by the provisions of Chapter F will have code checks calculated.
Channels - The AISC 9th Edition (ASD) specification does not specifically address the allowable stress for weak axis
bending of channels. Therefore, the program uses the most similar formula for the weak axis bending of wide
flanges (0.75*Fy). For a complete and thorough treatment of channel code checks, refer to the LRFD specification.
WT and LL Shapes - ASD allowable bending stresses calculated for WT and LL shapes use Chapter F for cases
when the stem is in compression. This is not technically correct, but the ASD code does not provide direction
regarding other means of calculating the allowable bending stress in this situation. In the interim, the LRFD code
directly addresses this situation, so it is recommended that you use the LRFD code to check WT and LL shapes that
have their stems in compression.
Neither the ASD or LRFD codes address the rare case where Lateral Torsional (or Flexural Torsional) Buckling
occurs for WT's and double angles bent about their weak axis.
RE Shapes - Rectangular bar members (on-line shapes) are assigned allowable bending stresses for the yielding
limit state only. Lateral torsional buckling is not considered because the ASD code doesn't directly address this for
rectangular shapes. The strong axis bending stress is assigned as 0.66*Fy and the weak axis bending stress is
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assigned as 0.75*Fy. If you have a case where lateral torsional buckling may govern, you should use the LRFD code,
since the LRFD code does address this limit state.

LRFD 2nd and 3rd Edition Limitations
Wide Flange Shapes - LRFD code checks for shapes that qualify as plate girders as defined by Chapter G are not
performed.
Single Angles - Single angles are only checked for Euler buckling. They are not checked for Flexural-Torsional
buckling.
WT and LL Shapes - Neither the ASD or LRFD codes address the rare case where Lateral Torsional (or Flexural
Torsional) Buckling occurs for WT's and double angles bent about their weak axis.
Tapered Wide Flanges - ASD 9th edition code checks can be performed on tapered members with equal or
unequal top/bottom flanges, with the restriction that the compression flange area must be equal to or larger than
the tension flange area. LRFD 2nd edition code checks are limited to tapered members with equal area flanges. Code
checks are performed using Appendix F, Chapter F, and Chapter D as applicable. Note that the rate of taper is
limited by Appendix F, and the program enforces this. The interaction equations in Appendix F are used to compute
the final code check value. These equations also include the effects of weak axis bending, if present. Torsional
warping effects on Tapered WF members are NOT considered.
Prismatic Wide Flanges with Unequal Flanges - ASD code checks for prismatic WF members with unequal
flanges are also limited to shapes that have the compression flange area equal to or larger than the tension flange
area. LRFD code checks currently cannot be performed for prismatic WF members with unequal flanges.
Pipes and Bars - For pipes and round bars, the code check is calculated based on an SRSS summation of the y and
z-axis stresses calculated for the pipe or bar. This is done because these circular shapes bend in a strictly uniaxial
fashion and calculating the code check based on a biaxial procedure (as is done for all the other shapes) is overly
conservative.
Single Angles - Code checking (LRFD or ASD) on single angle shapes is based on P/A (axial load/axial strength or
axial stress/allowable axial stress) only. This is because the load eccentricity information needed for a meaningful
bending calculation is not available. Only Euler buckling is considered for single angles, flexural-torsional buckling is
NOT considered. Single angles will have the following message displayed on the Code Check Spreadsheet to remind
the user of the axial only code check: "Code check based on z-z Axial ONLY"
Please see Single Angle Stresses for more information on the calculation of single angle stresses.

AISC Design Codes - Special Messages
In some instances, code checks are not performed for a particular member. A message explaining why a code check
is not possible will be listed instead of the code check value. You may click the cell that contains the message and
look to the status bar to view the full message. The following are the messages that may be listed:

"AISC Code Check Not Calculated"
This message is displayed when the member is not defined with a database shape, a steel code is not specified on
the Model Settings or no units were specified. For LRFD this message is displayed if the steel yield stress is less
than 10ksi.

"Web is slender per Table B5.1, handle as a plate girder"
The ratio h/tw exceeds the limiting criteria listed in Table B5.1. This means Chapter G (plate girders) governs.

"Compressive stress fa exceeds F'e (Euler bucking limit)"
The axial compressive stress for the member is greater than the Euler buckling stress (per ASD criteria), meaning
the member is unstable. A code check can not be calculated.

312

RISA-3D V20

Hot Rolled Steel - Design

"Tube depth>6*width (Sec F3-1) where width=bf-3*tw, Sec B5-1"
A tube is failing to meet the depth/width requirements laid out in Section F3-1 of the ASD code. The depth of the
tube is the full nominal depth, which the width is taken as the full width minus 3 times the thickness. Section B5-1
specifies this calculation for the width when the fillet radius is not known.

"Tee or Channel fails on Table A-B5.1 (Appendix B)"
This message appears for ASD code checking when Appendix B calculations are being done for a Tee or Channel
shape and the shape fails to meet the requirements of Table A-B5.1, Limiting Proportions for Channels and Tees.

"Pipe diameter/thickness ratio exceeds 13,000/Fy (App. B)"
This message appears when Appendix B calculations are being done for a pipe shape and the diameter/thickness
ratio exceeds the limit of 13000/Fy specified in Section B5-b for ASD, Section B5-3b for LRFD.

"KL/r > 200 for compression member"
Section B7 recommends that KL/r for compression members not exceed 200. For the ASD 9th edition code, a
procedure is presented to handle when KL/r exceeds 200. Thus, for ASD 9th edition, KL/r>200 is permitted. For all
other AISC codes no guidance is provided as to what to do if KL/r>200, so exceeding this limit is not permitted. You
may override this in the Application Settings which can be accessed by clicking on the File meu.

"Taper Flange area is not constant per App. A-F7-1 (b)"
The limitations of Appendix F for the design of web tapered members include the restriction that the flange area
shall be constant along the length of the member. This member's flange area changes along its length. See Appendix
Section F7.1 (b).

"Taper rate exceeds gamma limit per App. A-F7-1 (c)"
The limitations of Appendix F for the design of web tapered members include a limit on how steep the rate of taper
can be along the member length. This member's taper rate exceeds the limit given by equation A-F7-1. See
Appendix Section F7.1 (c).

"Flanges not equal, currently don't do LRFD App. F1 calcs"
The requirements for Wide Flange members with unequal flanges in the LRFD, Appendix F1, are not addressed.

"Taper Comp. flange < Tension flange, per App A-F7-1 (b)"
The limitations of Appendix F for the design of web-tapered members include the restriction that the flange areas of
the top and bottom flange must be equal. The compression flange may be larger than the tension flange. However
equation A-F7-4 is unconservative for cases where the compression flange is smaller than the tension flange. See
Appendix Sections F7.1 (b) and F7.4.

Canadian Design Codes - Member Design Parameters
Parameters controlling the steel design are entered on the Member Design Parameters spreadsheet. These
parameters are entered on a per member basis, and control the code checking on a per member basis.

w1 Coefficient
w1 is the coefficient to determine equivalent uniform bending effect in beam-column, as described in Section 13.8.5
of CSA S16-09. If left blank, RISA-3D will calculate it. The w1 value is dependent on the member's end moments,
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which may change from one Load Combination to the next. Therefore it is a good idea to leave this entry blank and
let RISA-3D calculate it.

w2 Coefficient
w2 is the coefficient to account for increased moment resistance of a laterally unsupported doubly symmetric beam
segment when subject to a moment gradient, as described in Section 13.6a of CSA S16-09. If left blank, RISA-3D will
calculate it. The w2 value is dependent on the moment in the member, which may change from one Load
Combination to the next. Therefore it is a good idea to leave this entry blank and let RISA-3D calculate it.

Canadian Design Codes - Limitations
It is assumed the transverse load on the member is occurring through the member's shear center. This means
secondary torsional moments that may occur if the load is not applied through the shear center are not considered.
Pipes and Bars - For pipes and round bars, the code check is calculated based on an SRSS summation of the y and
z-axis stresses calculated for the pipe or bar. This is done because these circular shapes bend in a strictly uniaxial
fashion and calculating the unity check based on a biaxial procedure (as is done for all the other shapes) is overly
conservative.

S16-14, S16-09
Tapered Wide Flanges - No code checking is done for "Tapered WF" members which have different "Start" and
"End" Depths, or which have top and bottom flanges of different widths. In other words, the "Tapered WF" may only
be used for prismatic, doubly symmetric sections.
Single Angles - Single angles in compression are not checked for Clause 13.3.3.2 or 13.3.3.3 because there is
insufficient information regarding the connections and usage of the member. They are not checked for Clause 13.3.2
(Flexural-Torsional Buckling) either. Instead they are checked for Euler Buckling about their geometric or principal
axes per Clause 13.3.1. The slenderness classification for single angles is based on the longer leg.
S16-09 recommends using a "rational analysis" to account for lateral-torsional buckling and shear checks on single
angles, so RISA uses the AISC 360-10 (14th Edition) provisions for these checks.
Class 4 Members - Members with both Class 4 (slender) webs and Class 4 (slender) flanges are not designed. Per
S16-09, Clause 13.5.c.i these members must be designed per S136-07. Where only the web or the flange is Class 4
(slender) the capacity is determined per the provisions of S16-09, Clause 13.5c.
The code is not clear on whether this applies to WT, Double Angle, and Single Angle members, since they do not
have a "web". Therefore, for these member types, the program calculates an effective (reduced) yield stress for each
leg/flange/stem and uses the smallest value for the entire section.
Pipes and Round HSS - The code does not address how to determine the shear capacity of Class 3 or Class 4
(Noncompact, Slender) pipes. Therefore no design is done for those members. Class 1 and 2 member capacities are
determined per the provisions of S16-09.
Shear Capacity - The code does not address how to determine the shear capacity of WTs, Double Angles, or Single
Angles where shear buckling is a consideration (S16-09 Clause 13.4.3). Therefore no design is done for members
where d/w or bel/t exceeds 1014/(Fy)1/2.
WTs - The lateral-torsional buckling moment capacity calculation (Clause 13.6e.i) in the code does not address how
to calculate Lu when the stem of the WT is in compression. Therefore Lu is always taken as zero, which is
conservative. The code also does not address how to calculate βx when the stem is in compression. Therefore, Iyc is
taken as zero, which results in a negative value of βx, which is conservative.
Double Angles - The code does not address how to calculate lateral-torsional buckling moment capacity. RISA
therefore uses the AISC 360-10 (14th Edition) provisions for these checks, as they are a widely accepted rational
method. When this method is used, it is assumed that Cb = ω2. The slenderness classification for double angles is
based on the longer leg.
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Welded Reduced Flange (WRF) Members- Since these members are classified within RISA as "Tapered", there is
currently no design done for them. This limitation will be removed in a future release.
Torsional Buckling and Flexural Torsional Buckling (S16-09 and earlier) - The limit states of torsional
buckling and flexural torsional buckling are not considered for wide flange and channel members. This means that
the value Fez is not calculated for these members per Clause 13.3.2. The program takes the lesser of Fex and Fexy for
axial buckling capacity for the S16-09 and earlier codes. These limit states are fully considered for S16-14 because
an Ltorque input was added for S16-14 that was not present in earlier code implementations.
Compressive Strength (S16-09 and earlier) - For the equations in section 13.3.1, the parameter "n” is assigned a
value of 1.34 for all shapes for S16-09 and earlier codes. This is conservative for WWF shapes and HSS shapes that
are stress-relieved. For S16-14, members designated as type "Tapered WF" use n = 2.24 while members designated
as type "WF" use n = 1.34.
Double Channels - Double channel design for Canadian code is only available in S16-14. Connector spacing
requirements are not checked for double channels.

S16.1-94, S16-01, S16-05
WT and LL Shapes - The criteria in the AISC LRFD 2nd Edition code is used to perform code checks on WT and LL
shapes since the Canadian code does not explicitly specify how to calculate the flexural strength of WT and LL
shapes.
The Canadian code does not address the rare case where Lateral Torsional (or Flexural Torsional) Buckling occurs
for WT's and double angles bent about their weak axis.
Tapered Wide Flanges - The AISC LRFD 2nd code is used to perform code checks on Tapered WF shapes when the
Canadian code is specified. The Canadian code CAN/CSA S16.1-94 does not address web-tapered members.
Single Angles - Code checking on single angle shapes is performed for tension only. Single angles will have the
following message displayed on the Steel Code Check Spreadsheet to remind the user of the tension only code
check: "Single Angle code check based on Axial Tension ONLY"
Please see Single Angle Stresses for more information on the calculation of single angle stresses.
Slender Shapes - Shapes with any slender elements are not supported for axial compression. Shapes with slender
webs or flanges are not supported for flexure. These shapes use the criteria in the CAN/CSA S136 code, which is not
supported at this time.

Canadian Design Codes - Special Messages
When a code check is not performed for a particular member a message explaining why a code check is not possible
will be listed instead of the code check value. You may click the cell that contains the message and look to the status
bar to view the full message. Following are the messages that may be listed specifically for the Canadian Code:

"Tension member with L/r ratio > 300 (CAN Sect. 10)"
The maximum L/r ratio for this tension member exceeds the limit shown in Section 10.2.2 of the CAN/CSA S16.1-94
code.

"KL/r > 200 for compression member (CAN Sect. 10)"
The maximum L/r ratio for this compression member exceeds the limit shown in Section 10.2.1 of the CAN/CSA
S16.1-94 code. You may override this check in the Application Settings which can be accessed by clicking on the
File button.
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"Can't do unity check for slender compression member"
Compression strengths are not calculated for shapes that contain elements where the width to thickness ratios are
classified as “slender”.

"Can't do unity check for flexural member with slender web"
Flexural strengths are not calculated for shapes which have a web depth to thickness ratio classified as “slender”.

"Currently can't do unity check for member with slender flanges"
Flexural strengths are not calculated for shapes which have a flange width to thickness ratio classified as “slender”.

"Can't do unity check for single angles in compression"
Compression strengths are not calculated for single angle members.

British Design Code - Member Design Parameters
Parameters controlling the steel design are entered on the Member Design Parameters spreadsheet. These
parameters are entered on a per member basis, and control the code checking on a per member basis.

m Coefficients (Interactive Bending Coefficients)
Section 4.8.3.3.4 of the British code describes the m coefficient. If these entries are left blank, RISA will calculate
them. The m value is influenced by the sway condition of the member and is dependent on the member's end
moments, which will change from one Load Comb to the next. It's a good idea to leave these entries blank and let
RISA calculate them.

m-LT Coefficients (Bending Coefficients)
This coefficient is discussed in Section 4.3.6.6 of the BS5950-1:2000 code and is used in the calculation of the
flexural strength. If this entry is left blank it will be calculated automatically. This value also is impacted by the
member's sway condition and is dependent on the member's end moments so it may be a good idea to let it be
calculated internally. An exception to this would be for cantilever members in sway frames, this value should be
1.75, and it will be automatically calculated as 1.0. This will be addressed in a future program version.

British Design Code - Limitations
It is assumed the transverse load on the member is occurring through the member's shear center. This means
secondary torsional moments that may occur if the load is not applied through the shear center are not considered.
Tapered Members - Tapered WF shapes are done per the AISC LRFD 2nd specification at this time. The
appropriate sections of the BS5950-1 specification will be used in a later release.
Torsional Warping Effects - Combined bending and warping torsional stresses in WF and Channel shapes are
handled per the AISC publication "Torsional Analysis of Steel Members". A later release will use the SCI publication
"Design of Members Subject to Combined Bending and Torsion" for combined bending and warping stresses when
the British Hot Rolled Steel code is selected.
Single Angles - Single angles are checked for axial and shear forces only. No bending is considered at this time. A
later release will consider the requirements in Annex I4 for single angles.
Secondary Moments per Annex I - The program does not yet consider the internal secondary moments described
in Annex I.
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EuroCode Design Codes - Member Design Parameters
Parameters controlling the steel design are entered on the Member Design Parameters spreadsheet. These
parameters are entered on a per member basis, and control the code checking on a per member basis.

Cm Factors (Equivalent Uniform Moment Factors per the 2005/14 EuroCode)
If these entries are left blank, RISA will calculate them per Annex B of the 2005/ 2014 EuroCode otherwise the user
can choose to override the calculation by manually entering a value. The Cm value is influenced by the sway
condition of the member and is dependent on the member's end moments, which will change from one Load
Combination to the next. It's a good idea to leave these entries blank and let RISA calculate them.
For HSS Tubes, the program always uses Table B.1. For other members not subject to torsion deformations (wide
flange members with an unbraced length equal to zero) the program will use Table B.1. for the 2014 code. All other
members, the program will use table B.2.

Cm-LT Factor (LTB Equivalent Uniform Moment Factors per the 2005 EuroCode)
If this entry is left blank, RISA will calculate it per Table B.3 in Annex B of the 2005 EuroCode, otherwise the user
can choose to override the calculation by manually entering a value. The CmLT value is influenced by the sway
condition of the member and is dependent on the member's end moments, which will change from one Load
Combination to the next. It's a good idea to leave these entries blank and let RISA calculate them.

Bm Coefficients (Interactive Bending Coefficients per the 1992 EuroCode)
Section 5.5.4 (7) of the EuroCode describes the Bm coefficients. If these entries are left blank, RISA will calculate
them. The Bm value is influenced by the sway condition of the member and is dependent on the member's end
moments, which will change from one Load Comb to the next. It's a good idea to leave these entries blank and let
RISA calculate them.

Bm-LT Coefficient (LTB Bending Coefficient per the 1992 EuroCode)
This coefficient is discussed in Section 5.5.4 (7) of the 1992 EuroCode code and is used in the calculation of the
flexural strength. If this entry is left blank it will be calculated automatically. This value also is impacted by the
member's sway condition and is dependent on the member's end moments so it may be a good idea to let it be
calculated internally. An exception to this would be for cantilever members in sway frames, this value should be
1.75, and it will be automatically calculated as 1.0. This will be addressed in a future program version.

C1 Factor (Moment Distribution Modification Factor)
If this entry is left blank, RISA will calculate it per the explicit equation presented in the widely accepted article
"Lateral-Torsional Buckling of Steel Beams: A General Expression for the Moment Gradient Factor" by López, Yong,
and Serna (2006), as there is no suitable generic formula presented in the EuroCode.
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Otherwise the user can override this calculation by manually entering a value.

Note:
l

C2 and C3 are taken as zero because RISA relies on the "general case" lateral torsional buckling equations
(see section 6.3.2.2) rather that the more specialized section for rolled and welded I shaped sections
(6.3.2.3).

EuroCode Buckling Curve Factors
This factor is discussed in Section 6.3.1.2 of the 2014 EuroCode and is used in the calculation of the axial
compression. Table 6.1 is used except for when Lateral Torsional Buckling is considered then Table 6.4 is used
instead. The following illustrates what RISA uses for the buckling curve from Table 6.2:
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EuroCode Design Codes - Limitations
Tapered Members - Tapered member design per the Eurocode is not supported at this time.
Torsional Warping Effects - Combined bending and warping torsional stresses in WF and Channel shapes are
handled per the AISC publication "Design Guide #9- Torsional Analysis of Steel Members".
WT and Double Angle Limitations - The EuroCode does not address the rare case where Lateral Torsional (or
Flexural Torsional) Buckling occurs for WT's and double angles bent about their weak axis. Therefore, the
calculation of Mcr is based on AISC LRFD equation and used in the code checks for Lateral Torsional (or Flexural
Torsional) Buckling.
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Lateral Torsional Buckling - The value Mcr used in the lateral-torsional buckling capacity of beams relies on a
factor C1. When the C1 field is left blank it is automatically calculated per the explicit equation presented in the
widely accepted article "Lateral-Torsional Buckling of Steel Beams: A General Expression for the Moment Gradient
Factor" by Lopéz, Yong, and Serna (2006),, as there is no suitable generic formula presented in the EuroCode. C2
and C3 are taken as zero because RISA relies on the "general case" lateral torsional buckling equations (see section
6.3.2.2) rather that the more specialized section for rolled and welded I shaped sections (6.3.2.3).
Single Angles - Single angles are checked for axial and shear forces only for EuroCodes. No bending is considered
for Eurocodes.

EuroCode Design Codes - Special Messages
"Rho >= 1.0, No code check calculated"
In beams with high shear the code implements a moment strength reduction factor (ρ), but does not place an upper
limit on it. If this value exceeds 1.0 the beam has a negative moment capacity, which is irrational. The program
therefore prevents a code check for these circumstances.

Indian Design Codes - Member Design Parameters
Parameters controlling the steel design are entered on the Member Design Parameters spreadsheet. These
parameters are entered on a per member basis, and control the code checking on a per member basis.

Cm Coefficients (Interactive Bending Coefficients)
If these entries are left blank, RISA will calculate them. The m value is influenced by the sway condition of the
member and is dependent on the member's end moments, which will change from one Load Comb to the next. It's
a good idea to leave these entries blank and let RISA calculate them.

Indian Buckling Curve Factors
This factor is discussed in Section 7.1.2.2 of the 2007 Indian Design code and is used in the calculation of the axial
compression. The following illustrates what RISA uses for the buckling curve from Table 7:

320

RISA-3D V20

Hot Rolled Steel - Design

Indian Design Codes - Limitations
Tapered Members - Tapered WF shapes are done per the AISC ASD 9th (for the 1998 code) and LRFD 2nd (for the
2007 code) specifications at this time. The appropriate sections of the IS:800 specification will be used in a later
release.
Torsional Warping Effects- Combined bending and warping torsional stresses in WF and Channel shapes are
handled per the AISC publication "Torsional Analysis of Steel Members".
WT and Double Angle Limitations - The Indian code does not address the case where Lateral Torsional (or
Flexural Torsional) Buckling occurs for WT's and double angles bent about their weak axis. For the 2007 code,
RISA will use the AISC 360-05 (aka AISC 13th edtion) formulas for calculating member capacity for these failure
states.
Shear Stress - For all shapes, the average shear stress is not checked per section 6.4.2 at this time.
Class 4 (Slender) Sections - No code checking is performed for class 4 sections for the IS 800: 2007 code.
Single Angles - Single angles are checked for axial and shear forces only. No bending is considered at this time.

Australian & New Zealand Design Codes - Member Design Parameters
Parameters controlling the steel design are entered on the Member Design Parameters spreadsheet. These
parameters are entered on a per member basis, and control the code checking on a per member basis.
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Alpha_m Factor (Moment Modification Factor)
1. If this entry is left blank, RISA will calculate it based on the full length of the member.
2. When unbraced lengths (Lb_comp_top and Lb_comp_bot) are explicitly defined (enter a number), the program
does not have the segmental information of the member for alpha_m calculation.
It will assume the alpha_ m used for this particular member to be 1.0.
3. When unbraced lengths (Lb_comp_top and Lb_comp_bot) are defined by physical nodes along the member with
the entry ‘Segment’ typed in, alpha_m will be calculated automatically using equation 5.6.1.1(2) based on segments
defined by nodes along the member.
The alpha_m value is influenced by the sway condition of the member and is dependent on the member's end
moments, which will change from one Load Combination to the next.

Australian & New Zealand Design Codes - Limitations
Tapered Members - Tapered WF shapes are done per the AISC LRFD 3rd specification at this time. The
appropriate sections of the ENV 1993-1-1 specification will be used in a later release.
Torsional Warping Effects- Combined bending and warping torsional stresses in WF and Channel shapes are
handled per the AISC publication "Torsional Analysis of Steel Members".
WT and Double Angle Limitations - The NZ / AS codes do not address the rare case where Lateral Torsional (or
Flexural Torsional) Buckling occurs for WT's and double angles bent about their weak axis.
Torsional Unbraced Length - At present the program assumes 'Lcomp' as 'Le' in case of lateral torsional buckling.
Section 5.6.3 provides a procedure for calculating 'Le' which is not being addressed at this time.
Special Provisions for Cantilevers - At present the program does not address section 5.6.2 for cantilever
elements.

General Member Design Limitations
Composite Steel Design - This is not done in RISA-3D. RISAFloor has this capability.
Welded Sections - There is a basic assumption in the program that the steel sections are hot rolled not welded.
Therefore, any code provisions that assume additional stresses due to welding a built-up cross section are not
specifically accounted for. For the AISC-LRFD codes this generally means that the flange residual stress (Fr) is
always taken as 10ksi, as for a rolled shape. The only exception is for Tapered WF shapes where it is always taken
as 16.5 ksi, as for a welded shape.
Load Location - For all shape types, it is assumed that the transverse load on the member is occurring through the
member's shear center. This means secondary torsional moments that may occur if the load is not applied through
the shear center are not considered.
Single Angles - In all codes other than AISC 360-05 and 360-10, single angles are only checked for axial loading.
Flexural effects are not considered in the code check calculation. Under AISC 360-05 and 360-10 single angles are
checked for combined bending and axial about either their principal or geometric axes depending on how their
unbraced length has been defined.
l

l

l

l
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Lateral-Torsional buckling does not apply to Geometric bending angles, and is therefore not checked for
them.
Lateral-Torsional buckling does not apply to minor-axis bending on Principal bending angles, and is therefore not checked for them.
The provisions of Section E5 of the specification are not considered. The angle is considered to be loaded concentrically, and on both legs.
Interaction equation H2-1 is used for all the code check on all angles (equal and unequal leg).
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Double Angles - For y axis buckling (where stitch connections would be experiencing shear), the program only
considers KL/r of the overall built up shape and does NOT attempt to reduce the KL/r value based on the spacing
between connectors. Therefore the program assumes that there are pre-tensioned bolts or welds spaced closely
enough to allow the double-angles to act as one unit per AISC 360-10 Eqn E6-2a.
Net Section for Tension Capacity - The tension capacity is calculated using the Gross area. A later release will
include a "net area factor" that the user can enter to indicate what the effective area should be for the tension
capacity calculation.
Solid Rectangles - Solid rectangular members will not be checked for lateral torsional buckling. This limitation is
only important for tall, slender shapes as LTB should not be a realistic limit state for short and thick or square
shapes.
Torsional and Flexural Torsional Buckling of Doubly Symmetric Shapes - Flexural Torsional Buckling and
Torsional Buckling are checked for the following shape types for AISC 360-10 (14th Edition) and AISC 360-16 (15th
Edition) steel codes:
l
l
l
l
l

Non Slender WF
Non Slender Channels
Non Slender WTs
Non Slender Double Angles
Non Slender Single Angles

Flexural Torsional Buckling and Torsional Buckling are also checked for Non Slender WTs and Double Angles for
the AISC 360-05 (13th Edition Steel Code).
For WTs (KL/r)m per section E4 (a) is calculated per equation E6-1 with 'a' always assumed to be 0. This results in
(KL/r)m = (KL/r)o.
P-Little Delta Analysis - An incremental P-Delta re-iterative approach is used in RISA 3D. This method does NOT
automatically account for P-Little Delta effects. If these effects are expected to be significant please refer to the PLittle Delta section.
Notional Loads - Currently Notional Loads are not automatically included in the analysis and it is expected that the
user will create their own set of Notional Loads when required. Please see the Load Generation - Notional Loads
topic for more information on using the program to generate and apply notional loads.

Tapered Members
The analysis for tapered wide flange members is handled internally by breaking the member into a series of 14
piecewise prismatic members. Then the program will condense out the extra degrees of freedom when assembling
the stiffness matrix.
This does a very good job for member stiffness and basic analysis. However, because the extra degrees of freedom
are eliminated before the analysis, it does not currently account for the P-Little Delta effect. If this effect is desired ,
please refer to the P-Little Delta topic for techniques to add this effect into your frame analysis.

AISC 13th, 14th, and 15th Editions - Design Guide 25
These design specifications do not actually include any design provisions for tapered members. However, the
AISC and MBMA jointly released Design Guide 25 - Frame Design Using Web-Tapered Members, which provides a
design procedure consistent with the AISC design specifications.
RISA follows the recommendations of the Design Guide for tapered member codes checks whenever the AISC 13th,
14th, or 15th edition steel codes are selected.

Design Checks:
The member detail reports will display not only the governing capacity values, but also the governing
equations/limit state that provided the reported capacity. These limit states (and any design assumptions) are listed

General Reference Manual

323

Hot Rolled Steel - Design
below:
In-Plane Flexural Buckling (z-z): The RISA implementation uses the Equivalent Moment of Inertia method
described in Appendix A of Design Guide 25.
Out-of-Plane Flexural Buckling (y-y): This calculation uses the weak axis properties from the mid-section of the
unbraced length.
TB (Torsional Buckling): Columns with equal flanges will only be checked for Torsional Buckling when the
torsional unbraced length (K*L_torque) is greater than the weak axis buckling unbraced length (K*Lyy).
FTB (Torsional Buckling): RISA currently only checks flexural torsional buckling when the tapered member has
unequal flange widths and (for cases when flange widths are equal) when the ratio of the flange thickness is greater
than 1.5. This calculation uses the weak axis properties from the mid-section of the unbraced length.
LTB (Lateral Torsional Buckling): The RISA implementation uses the procedure for Single Linear Tapered
Members for most members. In cases where both the thickness and depth of the way change, however, the program
will use the more generalized procedure.
CAT (Constrained Axis Torsional Buckling): This is only checked when Lcomp-bottom is greater than Lcomp-top.
The assumption is that the top flange is the outside flange and may be more restrained due to the presence of
purlins or girts. The calculation of as and ac assume a girt or purlin depth of zero.
Combined Stress Equations: The RISA implementation uses the force based combined strength equations from
chapter H1 of the AISC specification. The program does not consider the alternate stress based combined stress
equations based on chapter H2 of the AISC specification.
Shear Strength: The shear check equations are based on section G2 of the AISC specification and do not consider
the effects of stiffeners or tension field action.
Please see the Tapered Member results topic for more information about the results reporting.
Unbraced Length and Section Properties: When the user manually enters an unbraced length the program
doesn't explicitly know where the brace points are and must make and assumption. This is done in order to
determine the section properties at the middle of the unbraced length which are used in the calculation of member
capacities. RISA assumes the brace points are equally spaced along the length of the member at the distance given
by the user.
For example if the user entered in an unbraced length of 4 ft for a tapered member that is 10 ft long, the program
will assume that there is bracing as 0ft, 4ft, 8ft and 10ft.

Limitations:
In general, this Design Guide allows for design of a wider range of members than permitted over the older AISC
Appendix F provisions. However, there are still a number of limitations that will prevent RISA from reporting a code
check. These are listed below:
Cb Calculation: Currently, RISA does not calculate Cb per Design Guide 25. Instead it is always calculated per the
AISC 360 section F1 equation.
Tension Rupture: The tension rupture limit state is not considered.
Flange Qs Calculations: RISA will calculate a Qs value for both flanges and conservatively use the lower value in
design calculations.
Direct Analysis Method: Currently, the Tau_b stiffness adjustments for the Direct Analysis Method is based on the
worst case section in the tapered member. This worst case stiffness adjustment is applied to the whole member.
55 ksi Limit: The Design Guide includes a 55 ksi limit on maximum yield strength. If this is violated a code check
will still be calculated, but a warning log message will be given.
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ASD 9th, LRFD 2nd, LRFD 3rd
For these design specifications, AISC included an Appendix F covering the design of tapered wide flange members.
When calculating code checks per these provisions, the design parameters used in RISA are subject to the following
additions / restrictions:
AutoCalc of K values:The Kyy factor for Tapered WF shapes can be approximated by RISA-3D, and is the same as
for a regular prismatic member. The Kzz value cannot be approximated by RISA-3D and should be entered by the
user. The default value for Kzz will be '1.0' if not entered by the user. See the ASD or LRFD Commentary on
Appendix F for an explanation of how to calculate the Kzz factor for Tapered members.
Cb value:For Tapered WF members, the Cb field is actually used to enter the "B" value. B is described in Appendix
F7.4 of the ASD (9th Edition) and LRFD (2nd & 3rd Edition) codes. This value is not calculated automatically and if
it is left blank, a value of '1.0' will be used per the commentary for Appendix F7. The Cb term used in the Chapter F
equations is calculated internally for Tapered WF members and will be shown on the Member Detail report and in
the Code Check Spreadsheet.
Cm values: For Tapered WF members, the Cm values will be used for C'm. The C'm values are described in
Appendix F7.6 of the ASD and LRFD codes. These terms are used in the interaction equations in Appendix F. If
these entries are left blank they will be calculated automatically.

Foreign Codes
Canadian - w1: For Tapered WF members, the LRFD code will be used and the Cmyy(w1yy) value will be used for
C'myy, and the Cmzz(w1zz) value will be used for C'mzz. The C'm values are described in Appendix F7.6 of the
LRFD codes. These terms are used in the interaction equations in Appendix F for the LRFD code. If these entries
are left blank RISAwill calculate them.
Canadian - w2: For Tapered WF members the LRFD code will be used and the w2 field is used for the “B” value. B
is described in Appendix F7.4 of the LRFD codes. The Cb term used in the Chapter F equations in the LRFD code is
always calculated internally for Tapered WF members and will be shown on the Member Detail report and in the
Unity check spreadsheet. If the w2 entry is left blank a value of 1.0 will be used for B, per the commentary for
Appendix F7. (The value of “B” is not calculated at this time.)
British - m: For Tapered WF members, the LRFD code will be used and the Cmyy(m_yy) value will be used for
C'myy, and the Cmzz(m_zz) value will be used for C'mzz. The C'm values are described in Appendix F7.6 of the
LRFD codes. These terms are used in the interaction equations in Appendix F for the LRFD code. If these entries
are left blank RISA will calculate them.
British - m_LT - For Tapered WF members the LRFD code will be used and the m-LT field is used for the “B” value.
B is described in Appendix F7.4 of the LRFD codes. The Cb term used in the Chapter F equations in the LRFD code
is always calculated internally for Tapered WF members and will be shown on the Member Detail report and in the
Unity check spreadsheet. If the m-LT entry is left blank a value of 1.0 will be used for B, per the commentary for
Appendix F7. (The value of “B” is not calculated at this time.)
Euro Code - Cm/Bm: For Tapered WF members, the AISC LRFD 2nd Edition code is used and the Cmyy(m_yy)
value will be used for C'myy, and the Cmzz(m_zz) value will be used for C'mzz. The C'm values are described in
Appendix F7.6 of the LRFD codes. These terms are used in the interaction equations in Appendix F for the LRFD
code. If these entries are left blank RISA will calculate them.
Euro Codes - Cm_LT / Bm_LT: For Tapered WF members the AISC LRFD 2nd Edition code is used and the m-LT
field is used for the “B” value. B is described in Appendix F7.4 of the LRFD codes. The Cb term used in the Chapter
F equations in the LRFD code is always calculated internally for Tapered WF members and will be shown on the
Member Detail report and in the Unity check spreadsheet. If the m-LT entry is left blank a value of 1.0 will be used
for B, per the commentary for Appendix F7. (The value of “B” is not calculated at this time.)
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Indian Codes - Cm: For Tapered WF members, the LRFD code will be used and the Cmyy(m_yy) value will be used
for C'myy, and the Cmzz(m_zz) value will be used for C'mzz. The C'm values are described in Appendix F7.6 of the
LRFD codes. These terms are used in the interaction equations in Appendix F for the LRFD code. If these entries
are left blank RISA will calculate them.

Buckling-Restrained Brace (BRB) Members
RISA follows Section F4 of the AISC 341-16 code for the design of BRB braces when AISC 15th edition steel code is
selected.

BRB Design Parameters
The BRB Design Parameters Spreadsheet records the design parameters for the BRB code checks and may be
accessed by selecting Members on the Spreadsheets menu and then selecting the BRB tab. These parameters are
defined for each individual member and may also be assigned graphically through the Properties panel.

FyMax, FyMin
These are the upper and lower bounds of the yield strength of the BRB steel core. These values are based on BRB
manufacturer's data on the products. FyMax and FyMin are used in different design calculations, see Design Checks
and BRB parameter Calculations below for more information.
Density
The density of BRB is reported in this column. If you choose the default "Auto-Calc", the weight density (weight per
linear length) is calculated automatically based on BRB manufacturer's data. Note that this weight density is an
approximate value and shall be carefully reviewed by BRB manufacturer to ensure its accuracy. User can also input
this value manually.
Beta, Omega
The compression strength adjustment factor (β) and strain hardening adjustment factor (ω) can be defined. These
parameters are calculated automatically based on BRB manufacturer's data if Auto-Calc is selected. User can also
input this value manually.
Kf
The stiffness modification factor Kf can be defined in this column. The BRB member is more rigid at the end zone
(connection to beams/columns) comparing to the steel core at the middle portion. Initially, the program calculates
the BRB axial stiffness based on steel core only, therefore a stiffness modification factor is needed to capture the
actual stiffness of whole member. This parameter (Kf ≥1.0) is calculated automatically based on BRB manufacturer's
data if Auto-Calc is selected. User can also input this value manually.
Connection
The connection type is defined in this column. Different connection types yield different Kf values due to the
connection geometry. Currently Bolted, Welded, and Pinned connection types are supported.
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BRB Analysis Consideration
RISA-3D calculates the BRB force demand neglecting the effect of gravity loads per AISC 341-16 Section F4.3. It only
considers lateral load categories such as ELs, WLs, NLs, and RSA forces (e.g. SX, SZ) in BRB design. For instance, DL
will be neglected in a load combination 0.9DL+1.0EL to obtain the BRB force demand. It is assumed that all gravity
members have been designed in RISAFloor for gravity loads when there is no braces yet.
Since the brace end zone (brace connections to beam/column) has a higher stiffness than the steel core, a stiffness
modification factor Kf is needed to accurately capture the BRB stiffness. The Kf can be input manually by users or
automatically calculated by the program. See BRB Parameter Calculation section below for additional information
for this factor. The BRB's stiffness used in analysis will be obtained by multiplying the steel core stiffness by Kf
factor.
BRBs shall be used to resist axial load only, so only axial load code check is performed for BRBs. Pin-Pin end
releases are set as default for BRB shapes. Currently the program does not support fixed end release for BRBs.

Design Codes (AISC 15th) and Required Design Checks
RISA follows Equation (F4-1) in Section F4.5.2 of AISC 341-16 code to calculate the BRB design axial strength in
tension and compression. Specified minimum yield stress of the steel core (Fysc) is taken as the FyMin in the BRB
properties.

BRB Parameter Calculations
The compression strength adjustment factor (β) and strain hardening adjustment factor (ω) can be user-input or
automatically calculated by the program. If Auto-Calc was used, RISA follows the procedure in Section F4.2b to
calculate these factors. The stress-strain curves for the steel core material are provided by BRB manufacturers. The
larger value of the expected deformation corresponding to a) 2% of the story height, or b) two times the design
story drift was used in the calculation of these factors. The BRB strain at two times design story drift was estimated
using 2*øBRB*Cd*(FyMin/E)/(ρ*Ie), this equation conservatively assumes the yield strength of steel core is fully
utilized and shall yield an upper bound of beta, omega factors. Kf was calculated based on the geometries of BRB,
connection, and beam/column etc.
β, ω will be used to determine the adjusted brace strength in compression (Pcmax) and in tension (Ptmax) per
Section F4.2:

Note:
l

The calculation of the factors β, ω, and Kf follows the recommendations and database provided by manufacturers, these factors shall be carefully reviewed by users as well as manufacturers when finalizing the
BRB design.

Limitations
BRB Shapes: Currently, only CoreBrace products are available for BRB shapes.
Integration: Buckling-restrained brace design is available for models that are transferred from RISAFloor.
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AISC Code Check Results
Access the Steel Code Check spreadsheet by selecting the Results menu and then selecting Members
Checks.

Steel Code

Note:
l
l
l
l

The Member Detail Report gives more values used to perform the code check.
See Spreadsheet Operations to learn how to use Find, Sort and other options.
See Results View Settings - Members to learn how to plot member results.
See the code specific topics on the Hot Rolled Steel - Design page for additional restrictions / limitations.

Unity Check (UC) Results
The UC Max value represents the maximum Unity Check value produced by the interaction of the axial and bending
stresses. This would be a factored ratio of actual to allowable stress, or demand vs capacity. The governing code
equation that resulted in this value is displayed in the far right column for reference as well.
The Shear UC represents a similar ratio based on the shear provisions of the design code. The location for the
shear check is followed by "y" or "z" to indicate the direction of the shear.
Generally, if UC Checks are less than 1.0, the member is considered passing. If either of them is greater than 1.0, the
member is considered failing. If the value is greater than 9.999 it will be listed as "9.999".
The remaining columns, discussed below, provide some of the values used in the code check with the equation
number itself given in the last column. The Member Detail Report gives more values used to perform the code
check.

Location of the Governing Unity Check
The Loc field tells at what location the maximum code check occurs measured from the I-joint location (starting
end) of the member. See Model Display Options – Members to learn how to view the code check results graphically.
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The moving load results are enveloped and the governing load combination and step location is shown for each
result value under the "LC" column. The first number is the load combination, the second is the step number: (load
combination - step number). See Moving Loads to learn more.

Design Capacities
For ASD 13th, 14th, and 15th Edition code checking, Pnc/Om, Pnt/Om, Mnyy/Om and Mnzz/Om are the design
capacities divided by the Omega safety factors. Whereas the LRFD code checks will display the capacities multiplied
by the Phi factor: Phi*Pnc, Phi*Pnt, Phi*Mnyy, and Phi*Mnzz.
For Pnc is calculated according to the provisions of Chapter E in the AISC 13th, 14th, or 15th Editions. Pnt is based
on Chapter D. The Mn values are calculated based on Chapter F. Note that for RISA-, "zz" corresponds to "xx" in
the AISC code, i.e. RISA- substitutes Mnzz for Mnx, to maintain consistency with the member local axis system.

Note:
l

AISC code checking requires a P-Delta analysis to satisfy the requirements of Chapter C, so if P-Delta analysis
is NOT turned on (via the P-Delta flag) code checks won't be performed.

Cb Coefficient
The Cb coefficient is calculated based on the description presented in Chapter F, section F1. Refer to the section on
Cb input for more information about this calculation.
Tapered Wide Flanges (ASD) - For Tapered WF shapes, the Cb value shown will be the Cb value that RISAcalculated internally, NOT the value that was entered and used for the “B” value. The values shown in the Cm fields
will be the C'm values that were used for the Appendix F calculations. The controlling equation from Appendix F
will be listed.
Tapered Wide Flanges (LRFD) - For Tapered WF shapes, the Cb value shown will be the Cb value that RISAcalculated, NOT the Cb value that was entered and used for the “B” value. The controlling equation from Chapter H
will be listed.

Governing Equation
The final field lists the controlling equation for the code check. This will be one of the equations from Chapter H
(for ASD and LRFD) or section 7 for the HSS code. If there is no moment demand in the member being checked,
then the program will calculate the unity ratio using Chapter D where it compares the axial demand to the axial
capacity of the member using Pu/(Phi*Pc).

Note:
l

l

The requirements of Section H3 of the LRFD code are satisfied since RISA- calculates and includes torsional
warping effects.
When the governing equation is flagged with an asterisk (*) that means the equation was modified slightly.
Example AISC equation H1-1b was used, but the code check was not allowed to be less than Pu/(Phi*Pc).

Load Combination
For enveloped results the combination that produced the listed code and shear checks is given in the"LC" column.
The other values are the corresponding values and are not necessarily the maximums across all the combinations.

Canadian Code Check Results
Access the Steel Code Check spreadsheet by selecting the Results menu and then selecting Members
Checks.
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Note:
l
l
l
l

The Member Detail Report gives more values used to perform the code check.
See Spreadsheet Operations to learn how to use Find, Sort and other options.
See Results View Settings - Members to learn how to plot member results.
See the code specific topics on the Hot Rolled Steel - Design page for additional restrictions / limitations.

Unity Check (UC) Results
The UC Max value represents the maximum Unity Check value produced by the interaction of the axial and bending
stresses. This would be a factored ratio of actual to allowable stress, or demand vs capacity. The governing code
equation that resulted in this value is displayed in the far right column for reference as well.
The Shear UC represents a similar ratio based on the shear provisions of the design code. The location for the
shear check is followed by "y" or "z" to indicate the direction of the shear.
Generally, if UC Checks are less than 1.0, the member is considered passing. If either of them is greater than 1.0, the
member is considered failing. If the value is greater than 9.999 it will be listed as "9.999".
The remaining columns, discussed below, provide some of the values used in the code check with the equation
number itself given in the last column. The Member Detail Report gives more values used to perform the code
check.

Location of the Governing Unity Check
The Loc field tells at what location the maximum code check occurs measured from the I-joint location (starting
end) of the member. See Model Display Options – Members to learn how to view the code check results graphically.

Design Capacities
Cr, Mryy and Mrzz are the factored resistances calculated for the member. Cr is the compressive resistance,
calculated according to the provisions of the design code. The Mr values are the moment resistances, calculated
based on provisions of the design code. Note that for RISA-, "zz" corresponds to "xx" in the Canadian code, i.e. RISAsubstitutes Mrzz for Mrx, to maintain consistency with the member local axis system.

Note:
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l

Canadian code checking requires a P-Delta analysis to satisfy the requirements of Section 8.6, so if P-Delta
analysis is NOT turned on (via the P-Delta flag) Canadian code checks won't be done.

W2 Coefficient
The w2 coefficient is calculated based on the description presented in Section 13.6. Whether or not the member is
subject to sidesway is determined from the setting for the strong axis sway flag on the Member Design
spreadsheet. The w1 coefficients, described in Section 13.8.4 are also listed. These are also influenced by the sway
flag settings.
Tapered Wide Flanges - For Tapered WF shapes, the provisions of the AISC LRFD 2nd code are used. The w2
value shown will be the w2\Cb value that RISA- calculated, NOT the w2 value that was entered and used for the “B”
value. The controlling equation from Appendix F in the LRFD code will be listed. The values shown under the
headers for Cr and Mr will instead be the Pn and Mn values calculated for the LRFD code. These are the unfactored
member strengths. (Similar to Cr and Mr, but without the “phi” reduction factor.)

Governing Equation
The final field lists the controlling equation for the code check. This will be one of the equations from Section 13.8.1,
13.8.2, or 13.9.

Note:
l

The requirements of Section 15.11 are satisfied since RISA- calculates and includes torsional warping effects.

Load Combination
For enveloped results the combination that produced the listed code and shear checks is given in the"LC" column.
The other values are the corresponding values and are not necessarily the maximums across all the combinations.

British Code Check Results
Access the Steel Code Check spreadsheet by selecting the Results menu and then selecting Members
Checks.

Steel Code

Note:
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l
l
l
l

The Member Detail Report gives more values used to perform the code check.
See Spreadsheet Operations to learn how to use Find, Sort and other options.
See Results View Settings - Members to learn how to plot member results.
See the code specific topics on the Hot Rolled Steel - Design page for additional restrictions / limitations.

Unity Check (UC) Results
The UC Max value represents the maximum Unity Check value produced by the interaction of the axial and bending
stresses. This would be a factored ratio of actual to allowable stress, or demand vs capacity. The governing code
equation that resulted in this value is displayed in the far right column for reference as well.
The Shear UC represents a similar ratio based on the shear provisions of the design code. The location for the
shear check is followed by "y" or "z" to indicate the direction of the shear.
Generally, if UC Checks are less than 1.0, the member is considered passing. If either of them is greater than 1.0, the
member is considered failing. If the value is greater than 9.999 it will be listed as "9.999".
The remaining columns, discussed below, provide some of the values used in the code check with the equation
number itself given in the last column. The Member Detail Report gives more values used to perform the code
check.

Location of the Governing Unity Check
The Loc field tells at what location the maximum code check occurs measured from the I-joint location (starting
end) of the member. See Model Display Options – Members to learn how to view the code check results graphically.

Shear Capacity
The shear capacity, Pv, is calculated per section 4.2.3 using the listed equations for the shear area of each section
type. Shear buckling per section 4.4.5 is also considered.
The reduction in design strength, “py”, per table 9 in section 3.1.1 is automatically considered by the program. The
reduction is based on the yield stress of the steel material used for the member and the maximum thickness of the
cross section.

Compression Capacity
The compression capacity, Pc is calculated based on section 4.7. The effective lengths shown in table 22 are shown
as “K” factors in the program ( K*length is the effective length) and these can be approximated by the program
based on the sway flags and the end release conditions of the member (the connection type is NOT considered.) The
user can also specify the effective length by entering the appropriate K factor.
For the case of a sway member having pinned ends, a value of 2.1 for K is used as table 22 does not address this
condition. The program considers all H sections as I sections for purposes of picking the proper strut curve in table
23 in section 4.7.5. For the same table and section, the program does not do interpolation for shapes that have
maximum thicknesses between 40 and 50 mm, per footnote 1.

Tension Capacity
The tension capacity, Pt, is calculated based on section 4.6 and currently done using the gross section.

Slenderness checks
Width to thickness checks are done for all shapes based on Tables 11 and 12 in section 3.5. Complete Effective
section properties for the Area, Plastic Modulus, and Section Modulus, are done per section 3.5.6 and 3.6.
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Moment Capacity
The moment capacity, Mc, is calculated per section 4.2.5, including consideration for the amount of shear at the
section. The limit states of lateral torsional buckling, per section 4.3.6 and web buckling per section 4.4.4.2 are also
considered.

Equivalent Uniform Moment Factors
The equivalent uniform moment factors (my, mz, mLT) used in section 4.8.3 and shown in table 26 of section 4 are
calculated automatically by the program based on the sway flag and member moment diagram. The user can also
enter their own values.

Governing Equation
The final field lists the controlling equation for the code check. Combined axial and bending stresses are computed
based on the equation shown in section 4.8, with the governing equation reported. Combined bending and warping
is calculated per the AISC specification and design guide.
Biaxial bending and biaxial shears on Pipes and solid circular bars are done using the square root sum of the
squares of the forces applied in or about the local y and local z directions.

Load Combination
For enveloped results the combination that produced the listed code and shear checks is given in the"LC" column.
The other values are the corresponding values and are not necessarily the maximums across all the combinations.

EuroCode Code Check Results
Access the Steel Code Check spreadsheet by selecting the Results menu and then selecting Members
Code Checks.

Steel

Note:
l
l
l
l

The Member Detail Report gives more values used to perform the code check.
See Spreadsheet Operations to learn how to use Find, Sort and other options.
See Results View Settings - Members to learn how to plot member results.
See the code specific topics on the Hot Rolled Steel - Design page for additional restrictions / limitations.
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Unity Check (UC) Results
The UC Max value represents the maximum Unity Check value produced by the interaction of the axial and bending
stresses. This would be a factored ratio of actual to allowable stress, or demand vs capacity. The governing code
equation that resulted in this value is displayed in the far right column for reference as well.
The Shear UC represents a similar ratio based on the shear provisions of the design code. The location for the
shear check is followed by "y" or "z" to indicate the direction of the shear.
Generally, if UC Checks are less than 1.0, the member is considered passing. If either of them is greater than 1.0, the
member is considered failing. If the value is greater than 9.999 it will be listed as "9.999".
The remaining columns, discussed below, provide some of the values used in the code check with the equation
number itself given in the last column. The Member Detail Report gives more values used to perform the code
check.
Important Notes:
l

l

The bending axes in the member local coordinate system are reversed between RISA and the Eurocode. All
input and results are shown in the member local coordinate system used by RISA. For a wide flange shape,
the “z-z” axis is parallel to the flanges and the “y-y” axis is parallel to the web.
The reduction in yield strength, “fy”, per table 3.1 in section 3.2.2.1 is automatically considered by the program. The reduction is based only on the maximum thickness of the cross section. Yield strengths for sections with a maximum thickness of 40mm or less are not reduced. Yield strengths for sections with a
maximum thickness greater than 40mm are reduced by 20 N/mm2

Location of the Governing Unity Check
The Loc field tells at what location the maximum code check occurs measured from the I-joint location (starting
end) of the member. See Model Display Options – Members to learn how to view the code check results graphically.

Compressive Capacity
The compression capacity, Nc.Rd is calculated based on section 62.4 and 6.3.1. The effective lengths shown in
tables E.2.1 and E.2.2 of the 1992 Eurocode are shown as “K” factors in the program ( K*length is the effective
length.) These can be approximated by the program based on the sway flags and the end release conditions of the
member (the connection type is NOT considered.) The approximate K factor values for reasonable “pinned” and
“fixed” conditions are taken from the British BS 5950-1:2000 code. The user can also specify the effective length by
entering the appropriate K factor. For the case of a sway member having pinned ends, a value of 2.1 for K is used
as a reasonable limit.

Tension Capacity
The tension capacity, Nt.Rd, is calculated based on section 6.2.3 and currently done using the gross section.

Slenderness checks
Width to thickness checks are done for all shapes based on table 5.2 from the 2005 EuroCode.

Shear Capacity
The shear capacity, Vpl.Rd, is calculated per section 6.2.6 using the listed equations for the shear area of each
section type. Shear buckling per section 5.6.3 of the 1992 Eurocode is also considered.
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Moment Capacities
The moment capacity, Mc.Rd, is calculated per section 6.2.5, including consideration for the lateral-torsional
buckling.

Equivalent Uniform Moment Factors
The equivalent uniform moment factors (Cm & CmLT per the 2005 code) are calculated per Table B.3 of Annex B
unless they are manually input by the user in the Member Design Properties spreadsheet.
The equivalent uniform moment factors (βm & βmLT per the 1992 code) used in section 5.5.4 and shown in figure
5.5.3 of section 5.5.4 are calculated automatically by the program based on the sway flag and member moment
diagram unless they are manually input by the user in the Member Design Properties spreadsheet.

Governing Equation
The final field lists the controlling equation for the code check. Combined axial and moment is checked for the limit
state of stress and high shear, The limit states of flexural buckling and lateral torsional buckling as well as web
buckling are also considered. The governing section is also reported. Combined bending and warping is calculated
per the AISC specification and increases the moment about the y-y axis.
Biaxial bending and biaxial shears on Pipes and solid circular bars are done using the square root sum of the
squares of the forces applied in or about the local axes.

Load Combination
For enveloped results the combination that produced the listed code and shear checks is given in the"LC" column.
The other values are the corresponding values and are not necessarily the maximums across all the combinations.

Indian Code Check Results
Access the Steel Code Check spreadsheet by selecting the Results menu and then selecting Members
Code Checks.
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Note:
l
l
l
l

The Member Detail Report gives more values used to perform the code check.
See Spreadsheet Operations to learn how to use Find, Sort and other options.
See Results View Settings - Members to learn how to plot member results.
See the code specific topics on the Hot Rolled Steel - Design page for additional restrictions / limitations.

Unity Check (UC) Results
The UC Max value represents the maximum Unity Check value produced by the interaction of the axial and bending
stresses. This would be a factored ratio of actual to allowable stress, or demand vs capacity. The governing code
equation that resulted in this value is displayed in the far right column for reference as well.
The Shear UC represents a similar ratio based on the shear provisions of the design code. The location for the
shear check is followed by "y" or "z" to indicate the direction of the shear.
Generally, if UC Checks are less than 1.0, the member is considered passing. If either of them is greater than 1.0, the
member is considered failing. If the value is greater than 9.999 it will be listed as "9.999".
The remaining columns, discussed below, provide some of the values used in the code check with the equation
number itself given in the last column. The Member Detail Report gives more values used to perform the code
check.

Location of the Governing Unity Check
The Loc field tells at what location the maximum code check occurs measured from the I-joint location (starting
end) of the member. See Model Display Options – Members to learn how to view the code check results graphically.

Compressive Capacity
The allowable compressive stress, Fa, is calculated based on section 5.1. The effective lengths shown in table 5.2
are shown as “K” factors in the program ( K*length is the effective length) and these can be approximated by the
program based on the sway flags and the end release conditions of the member (the connection type is NOT
considered.) The user can also specify the effective length by entering the appropriate K factor. For the case of a
sway member having pinned ends, a value of 2.1 for K is used as table 5.2 does not address this condition.

Tension Capacity
The allowable tensile stress, Ft, is calculated based on section 4.1 and is currently done using the gross section.

Slenderness Checks
The maximum slenderness ratios shown in table 3.1 are reported in the warning log when they are exceeded. The
program still calculates capacities for the members and reports a code check.
Width to thickness checks are done for all shapes based on section 3.5.2.1. Complete effective section properties for
the Area and Section Modulus are calculated.

Shear Capacity
The allowable shear stress, Fv, is used per section 6.4.1. This value is checked per the maximum shear stress in the
section based on elastic theory.

Moment Capacity
The strong axis allowable bending stress, Fb, is calculated per section 6.2. The limit state of lateral torsional
buckling, per sections 6.2.4 and 6.2.6, is considered. The allowable bending stress is increased per section 6.2.4.1 as
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appropriate. The weak axis bending stress is assigned per section 6.2.5.

Equivalent Uniform Moment Factor, Cm
The equivalent uniform moment factor, Cm, used in section 7.1 are calculated automatically by the program based
on the sway flag per section 7.1.3. The user can also enter their own values in the Member Design Parameters
spreadsheet.

Governing Equation
The final field lists the controlling equation for the code check. Combined axial and bending stresses are computed
based on the equations shown in section 7.1,with the governing equation reported. Combined bending and warping
is calculated per the AISC ASD specification.
Biaxial bending and biaxial shears on Pipes and solid circular bars are done using the square root sum of the
squares of the forces applied in or about the local y and local z directions.

Load Combination
For enveloped results the combination that produced the listed code and shear checks is given in the"LC" column.
The other values are the corresponding values and are not necessarily the maximums across all the combinations.

Australian Code Check Results
Access the Steel Code Check spreadsheet by selecting the Results menu and then selecting Members
Code Checks.

Steel

Note:
l
l
l
l

The Member Detail Report gives more values used to perform the code check.
See Spreadsheet Operations to learn how to use Find, Sort and other options.
See Results View Settings - Members to learn how to plot member results.
See the code specific topics on the Hot Rolled Steel - Design page for additional restrictions / limitations.
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Unity Check (UC) Results
The UC Max value represents the maximum Unity Check value produced by the interaction of the axial and bending
stresses. This would be a factored ratio of actual to allowable stress, or demand vs capacity. The governing code
equation that resulted in this value is displayed in the far right column for reference as well.
The Shear UC represents a similar ratio based on the shear provisions of the design code. The location for the
shear check is followed by "y" or "z" to indicate the direction of the shear.
Generally, if UC Checks are less than 1.0, the member is considered passing. If either of them is greater than 1.0, the
member is considered failing. If the value is greater than 9.999 it will be listed as "9.999".
The remaining columns, discussed below, provide some of the values used in the code check with the equation
number itself given in the last column. The Member Detail Report gives more values used to perform the code
check.

Location of the Governing Unity Check
The Loc field tells at what location the maximum code check occurs measured from the I-joint location (starting
end) of the member. See Model Display Options – Members to learn how to view the code check results graphically.

Compressive Capacity
The allowable compressive stress, Phi*N, is calculated based on clause 6.3. The effective lengths shown in Figure
4.6.3.2 are shown as “K” factors in the program ( K*length is the effective length) and these can be approximated by
the program based on the sway flags and the end release conditions of the member (the connection type is NOT
considered.) The user can also specify the effective length by entering the appropriate K factor.

Tension Capacity
The allowable tensile stress, Phi*Nt, is calculated based on clause 7.2 and is currently done using the gross section.

Slenderness Checks
Width to thickness checks are done for all shapes based on Table 5.2. Complete effective section properties for the
Area and Section Modulus are calculated.

Shear Capacity
The allowable shear stress, Phi*Vv, is used per clause 5.11. This value is checked per the maximum shear stress in
the section based on elastic theory.

Moment Capacity
The strong axis allowable bending stress, Phi*Mn, is calculated per section 5. The limit state of lateral torsional
buckling, per clause 5.6 is considered.

Moment Modification Factor, αm
The moment modification factor, Alpha_m, is calculated automatically by the program based on clause 5.6.1.1.
When explicit unbraced lengths are used, the program does not have the member segment information to calculate
alpha_m. It will conservatively assume alpha_m to be 1.0. The user can also enter their own values in the Member
Design Parameters spreadsheet.
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Governing Equation
The final field lists the controlling equation for the code check. Combined axial and bending stresses are computed
based on the equations shown in clause 8.4, with the governing equation reported. Combined bending and warping
is calculated per the AISC ASD specification.
Biaxial bending and biaxial shears on Pipes and solid circular bars are done using the square root sum of the
squares of the forces applied in or about the local y and local z directions.

Load Combination
For enveloped results the combination that produced the listed code and shear checks is given in the"LC" column.
The other values are the corresponding values and are not necessarily the maximums across all the combinations.

New Zealand Code Check Results
Access the Steel Code Check spreadsheet by selecting the Results menu and then selecting Members
Checks.

Steel Code

Note:
l
l
l
l

The Member Detail Report gives more values used to perform the code check.
See Spreadsheet Operations to learn how to use Find, Sort and other options.
See Results View Settings - Members to learn how to plot member results.
See the code specific topics on the Hot Rolled Steel - Design page for additional restrictions / limitations.

Unity Check (UC) Results
The UC Max value represents the maximum Unity Check value produced by the interaction of the axial and bending
stresses. This would be a factored ratio of actual to allowable stress, or demand vs capacity. The governing code
equation that resulted in this value is displayed in the far right column for reference as well.
The Shear UC represents a similar ratio based on the shear provisions of the design code. The location for the
shear check is followed by "y" or "z" to indicate the direction of the shear.
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Generally, if UC Checks are less than 1.0, the member is considered passing. If either of them is greater than 1.0, the
member is considered failing. If the value is greater than 9.999 it will be listed as "9.999".
The remaining columns, discussed below, provide some of the values used in the code check with the equation
number itself given in the last column. The Member Detail Report gives more values used to perform the code
check.

Location of the Governing Unity Check
The Loc field tells at what location the maximum code check occurs measured from the I-joint location (starting
end) of the member. See Model Display Options – Members to learn how to view the code check results graphically.

Compressive Capacity
The allowable compressive stress, Phi*N, is calculated based on clause 6.3. The effective lengths shown in Figure
4.6.3.2 are shown as “K” factors in the program ( K*length is the effective length) and these can be approximated by
the program based on the sway flags and the end release conditions of the member (the connection type is NOT
considered.) The user can also specify the effective length by entering the appropriate K factor.

Tension Capacity
The allowable tensile stress, Phi*Nt, is calculated based on clause 7.2 and is currently done using the gross section.

Slenderness Checks
Width to thickness checks are done for all shapes based on Table 5.2. Complete effective section properties for the
Area and Section Modulus are calculated.

Shear Capacity
The allowable shear stress, Phi*Vv, is used per clause 5.11. This value is checked per the maximum shear stress in
the section based on elastic theory.

Moment Capacity
The strong axis allowable bending stress, Phi*Mn, is calculated per section 5. The limit state of lateral torsional
buckling, per clause 5.6 is considered.

Moment Modification Factor, αm
The moment modification factor, Alpha_m, is calculated automatically by the program based on clause 5.6.1.1. The
user can also enter their own values in the Member Design Parameters spreadsheet.

Governing Equation
The final field lists the controlling equation for the code check. Combined axial and bending stresses are computed
based on the equations shown in clause 8.4, with the governing equation reported. Combined bending and warping
is calculated per the AISC ASD specification.
Biaxial bending and biaxial shears on Pipes and solid circular bars are done using the square root sum of the
squares of the forces applied in or about the local y and local z directions.

Load Combination
For enveloped results the combination that produced the listed code and shear checks is given in the"LC" column.
The other values are the corresponding values and are not necessarily the maximums across all the combinations.
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Tapered Member Results
The spreadsheet results for tapered members gives the same information as other AISC Code Checks. However, the
Detail Reports for tapered members designed to AISC Design Guide 25 give some additional information.
As shown in the image below, the code checks list the member capacity calculated for axial, flexure, and shear. In
addition to the capacity values, the table reports the equation number used to arrive at that capacity and the failure
mode which caused it (please see the example below). The table also gives the slenderness parameters that apply
for that failure state.

The following failure modes are listed for axial and strong axis bending:
l
l
l
l
l
l
l
l
l
l

(z-z) : In-Plane or Strong Axis flexural buckling of the member due to axial force.
(z-z) : Out-of-Plane or Weak Axis flexural buckling of the member due to axial force.
TB : Torsional buckling of the member due to axial force.
FTB : Flexural Torsional Buckling of the member due to axial force.
CAT : Constrained Axis Torsional Buckling of the member due to axial force.
FLB : Flange Local Buckling due to flexure.
WLB : Web Local Buckling.
TFY : Tension Flange Yielding due to flexure.
CFY : Compression Flange Yielding due to flexure.
LTB : Lateral Torsional Buckling of the member due to flexure.

Please see the Tapered Member design topic for more information about these limit states.

BRB Member Results
The spreadsheet results for BRB members are summarized under the BRB tab in the Code Checks spreadsheet. It
covers the brace UC check values under axial load and the adjustment factors for brace stiffness (Kf) and strength
(omega, beta). It also includes the tension and compression capacities of the braces. See Buckling-Restrained Brace
(BRB) Members for additional information on the parameters.
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The detail report is also customized for BRB members. For force diagrams, only axial load related diagrams are
reported. No shear/bending/torsion diagrams are reported since BRBs are supposed to resist axial load only. In the
BRB Check tab, the Kf, omega, and beta values are reported and the axial compression/tension code checks are also
presented:
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Note:
l

BRB axial load demand is obtained by analysis neglecting the gravity loads effects. However, the axial load
diagrams are displaying the analysis result based on the original load combination including the gravity loads
effects. So the reported axial load demand might be different from the envelop results in the force diagrams.
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Stainless Steel
Stainless steel shape properties and design are based on the recommendations in the AISC Design Guide 27
Structural Stainless Steel. The procedure outlined in the design guide follows the 2010 AISC Specification and 14th
Edition Steel Manual.

Database Shapes
Shapes are organized by Shape Type and Database / Manufacturer. Common shapes are supported such as wide
flanges, tubes, pipes, channels, etc. You may type in the names directly, select shapes from these databases, or add
your own shapes.
RISA currently supports only the AISC steel database.

To Select a Stainless Steel Database Shape
1. From the Stainless tab on the Section Sets Spreadsheet, or the Primary tab of the Members Spreadsheet,
move the cursor to the Shape field and click
.
2. Specify the database and shape type you wish to use and then select from the list of available shapes.
Shape Designations
Stainless steel shapes are similar to the AISC database for all shapes. See Hot Rolled - Databases for information on
the shape designations.

Design
Full code checking member optimization can be applied to standard stainless steel shapes based on the AISC Design
Guide 27 Structural Stainless Steel which refers to the 2010 AISC Specification and 14th Edition Steel Manual.
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How To Apply a Steel Design Code
1. On the Model Settings - Codes tab, select the steel code from the drop down list.

2. On the Stainless tab of the Members Spreadsheet, enter the appropriate bracing information and factors.

Note:
l

For code checking to be performed on a member, the member must be defined with a database shape on
the Section Sets or Members Spreadsheet.

Design Parameters Spreadsheet
The Stainless Steel Design Parameters Spreadsheet records the design parameters for the stainless steel code
checks and may be accessed by selecting Members on the Spreadsheets menu and then selecting the Stainless
tab. These parameters are defined for each individual member and may also be assigned graphically. See Modifying
Member Designto learn how to do this.

The design for stainless steel follows the design for Hot-Rolled Steel Design with a few exceptions outlined below.
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Implementation Notes

b/t ratio
The stainless steel b/t ratios differ from Tables B4.1a and B4.1b in Chapter B of the 14th Edition AISC code. The
b/t ratios used are listed in the AISC Design Guide 27 Stainless Structural Steel in Tables 3-1 and 3-2.

Axial Compression
The guidelines given in AISC Specification Chapter E apply except with some modifications to the equations and
some additional limitations for slender members. See AISC Design Guide 27 for the specific changes.

Bending Capacity
The guidelines given in AISC Specification Chapter F apply except with some modifications to the equations and
some additional limitations for slender members. See AISC Design Guide 27 for the specific changes.

Flexure Code Checks
The analysis will be provided for flexure but there will not be any flexure code checks for single angles, tees,
sections with slender webs, unequal angles, equal legs angles with slender sections, and round HSS.

Round HSS Shear Buckling
The limit state of shear buckling for round HSS (AISC Specification Equations G6-2a and G6-2b) are beyond the
scope of the AISC Design Guide 27 and thus are not included in RISA. The analysis will be provided but there will
not be any shear code checks for round HSS.

Combined Torsion
The design of members subject to combined torsion, flexure, shear, and/or axial force is beyond the scope of the
AISC Design Guide 27.

Slender WT's and Angle Sections
The Design Guide does not directly address the case of WT's with slender webs or angles with slender webs.
Therefore, the program uses modified versions of the similar equations from the AISC specification. This should be
considered only an approximation of the capacity of these slender members and should be reviewed and accepted
(or rejected) based on the engineering judgment of the user. The equations used are the following:
For slender single angles (or double angles when the legs spacing is nonzero), the equations used in RISA are:

For Wt's with slender stems / webs the equations used in RISA are:
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Limitations:
l
l

l

l

The code checks for Stainless in RISA are based on the AISC 360-10 Specification and 14th Ed Manual only.
Stainless code checks only apply to Hot-Rolled Stainless; ASCE 8 is for cold formed stainless and is not considered in RISA.
RISA does not consider the Precipitation Hardening Stainless Steel tension rods which have different safety
and resistance factors.
Serviceability checks for deflection based on the secant modulus Es are not implemented at this time. Deflections checks use the modulus of elasticity specified in the Materials spreadsheet.

Stainless Code Check Results
Access the Stainless Steel Code Check spreadsheet by selecting the Results tab
Code Check. Alternatively, on the Results toolbar you can select Code Check.

Envelope (or LC) button

Note:
l
l
l

The Member Detail Report gives more values used to perform the code check.
See Spreadsheet Operations to learn how to use Find, Sort and other options.
See Results View Settings - Members to learn how to plot member results.

Unity Check (UC) Results
The results for stainless steel follows the same results reporting as that for Hot-Rolled Steel Results.
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Loads
As you input loads they are grouped into separate sets of Basic Load Cases. These are the basic building blocks of
the loads applied to the structure, consisting of discrete loads and self-weight of the structure. The basic load cases
may also be grouped into load categories such as dead load and live load. In the end, the model will be solved
against load combinations that are built with the basic load cases and categories.
You may view the loads on your model. This is an excellent way to verify the loads that are on the model. You may
plot them by load case, load category or load combination. See Model View Settings - Loads to learn to do this.
Each of the discrete load types is described in it’s own section:
l
l
l
l
l
l
l

Area Loads
Distributed Loads
Joint Loads/Forced Displacements
Moving Loads
Point Loads
Surface Loads
Thermal Loads

Self Weight (Gravity Load)
The structure's self-weight may be automatically calculated and included in a solution. The inclusion of self-weight
may be specified within a Basic Load Case or as part of a Load Combination.
The self-weight is calculated as a full-length uniform load across each member of the model and as a surface load on
the plates. The magnitude of the load is the area times the material weight density.

Note
l

If a member has offsets defined, the offset distances are not included in the self-weight calculation.

Adding Self Weight to a Basic Load Case

l

Select the Basic Load Case spreadsheet by clicking the Basic Load Cases icon in the Home tab. On the
line of the load case you wish to contain self-weight, enter a load factor in the appropriate direction
column. For example, if you wish to apply 90% of the self-weight in the negative Y direction (down),
you would put -0.9 as the factor in the Y Gravity column.

Adding Gravity Load to a Load Combination
l

To include the self-weight in a Load Combination, put "X", "Y" or "Z" in the BLC field. The letter used
indicates which global direction the self-weight is applied in. Also put a factor in the Factor field. For
example, if you wish to apply 90% of the self-weight in the negative Y direction (down), you would put
"Y" as the BLC and "-0.9" as the BLC factor.

Note
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l

l

You may have multiple self-weight definitions, i.e. you could have self-weight applied in the "Y" and "X"
directions in the same or different load cases if you wished.
Don't inadvertently include the self-weight of the structure twice by specifying it within a combination
that includes a Basic Load Case that also contains the self-weight.

Drawing Loads

You may graphically apply loads to the model. You may apply one load at a time by clicking the mouse, or apply
loads to entire selections at once. All of the graphical loading tools may be found in the Draw Loads section within
the Home tab.

Modifying Loads
Modifying loads may be done within the spreadsheets. Click Data Entry from within the Spreadsheets tab and
then choose the spreadsheet that you wish to modify. You may then move through different Basic Load Cases by
using the drop-down list on the Window Toolbar.
See Spreadsheet Operations to learn how you can modify the loads. You may also copy or delete entire Basic Load
Cases from the Basic Load Case spreadsheet. See Copying Basic Load Cases and Deleting Basic Load Cases for
more information.
Alternatively you can directly click on the loads in the 3D View and edit the selected load within the Properties
panel.
From the Properties panel, you can change the configuration of the load as well as edit or create a basic load case
by clicking the triple dot in the BLC parameter.

Deleting Loads
Deleting loads may be done within the spreadsheets. Click Data Entry from within the Spreadsheets tab and then
choose the spreadsheet that you wish to modify. You may then move through different Basic Load Cases by using
the drop-down list on the Window Toolbar.
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You may use spreadsheet operations such to help modify the loads. You may also delete entire Basic Load Cases
from the Basic Load Case spreadsheet. See Deleting Basic Load Cases.
Alternatively you can directly click on the loads in the 3D View and press the Delete key.
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Loads - Basic Load Cases
When loads are defined they are grouped into basic load cases (BLC's). You are allowed up to 1000 separate Basic
Load Cases. These are the basic building blocks of the final load combinations applied to the structure. The basic
load cases may be assigned to load categories such as dead load and live load. These basic cases and categories are
then combined to define load combinations used in analysis. A BLC can be comprised of any type of load, such as
joint loads, distributed loads, member point loads, etc.
Any time you are applying or viewing loads, graphically or in the spreadsheets, they are assigned to the current
basic load case. The current basic load case is displayed in the Model View Toolbar in a drop down list. To
change to another BLC simply choose it from this list. If you wish to change the name the BLC's you may do this in
the Basic Load Case spreadsheet.
Access the Basic Load Cases spreadsheet from the Home tab by clicking on the Basic Load Cases button.

To Add Loads to a Basic Load Case
l

l

When adding loads graphically click on the toolbar button for the type of load you wish to add and specify the BLC along with the load definition.
When adding loads with the spreadsheets, open the spreadsheet for the load type you want to add and
select the BLC from the list on the Window Toolbar.

Basic Load Case Spreadsheet
The Basic Load Cases spreadsheet groups and summarizes the loads applied to the model. Access the Basic Load
Cases spreadsheet by selecting the Spreadsheets tab Data Entry button Basic Load Cases. Alternatively, on
the Data Entry toolbar you can select Basic Load Cases.

Information about Basic Load Cases (BLC’s) is recorded on the Basic Load Case Spreadsheet and the loads
themselves are recorded in the load spreadsheets for each load type.
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You may enter descriptions for each BLC in the first column. These descriptions are primarily for your own use.
The descriptions will print as part of the input printout and you can also display the description when plotting the
loads for the BLC or choosing them from the list.
The second column is used to assign the BLC to a load category such as Dead Load or Live Load. Simply choose the
category from the drop down list. You can then build load combinations for analysis by referring to the
categories rather than list each basic load case.
The next three columns may be used to specify that the self-weight of the structure be included in a load
case. Simply enter a factor in the column that represents the direction of the self-weight. Typically you will enter a
value of “-1” in the Y Gravity column assuming that Y is the vertical axis. If you enter a positive value, you will see a
warning message like below which is simply to alert you of a positive gravity value.

The remaining columns display the quantity of each type of load that is contained in the BLC. You may not edit
these values but you may click on the quantities to open the spreadsheet and view the loads that it
represents. For example, the previous figure has 15 distributed loads as part of BLC 2. Clicking on the number 15
with the mouse will open the Distributed Loads spreadsheet and display these loads.

Copying Basic Load Cases
You may copy the loads from one BLC into another BLC. This can be useful when one load case is similar to
another and can be entered quickly by copying a load case and then making changes to the copy with features such
as block math.
To do this, open the Basic Load Case spreadsheet and right click on the load case that you wish to copy and select
Copy Basic Load Case from the drop-down list. The Copy A Basic Load Case dialogue will open and allows you to
specify the load case that you want to copy the loads into, as well as the types of loads that you want to copy. For
example, if you check Nodal Loads and uncheck all the other load types, only the nodal loads will be copied.
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Any loads copied into a BLC will be added to any loads that may already exist in that BLC.

Deleting Basic Load Cases
You may automatically clear all the loads in a BLC. To do this, open the Basic Load Case spreadsheet and then
right click on the load case that you wish to delete and select Clear Basic Load Case from the drop-down list.

All of the loads in this BLC will be deleted including the description, category information and any self-weight
information.

Scaling Basic Load Cases
You may apply a scaling factor to an entire Basic Load Case in the Basic Load Case spreadsheet. These scaling
factors give the user the flexibility and freedom to modify and manipulate the loading conditions in the model.
To use this feature, you will need to enable it in the Application Settings. By default, the program will have this
feature inactivated.
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Once enabled, a new column will appear within the Basic Load Case spreadsheet. Basic Load Cases may be scaled
by both negative and positive values.

Note:
l

354

When this feature is disabled in the Application Settings, the column will be hidden but the values in the
column will still be applied to the Basic Load Cases. Therefore, it is imperative that values in this column be
cleared out before hiding the column if the intent is to not include the factors in the design.
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Load Categories
The basic load cases may be assigned to load categories, such as dead load and live load, which are commonly used
in building codes. You may do this on the Basic Load Cases spreadsheet. These categories may then be combined
to define load combinations used in analysis.
Categories are easy to use and are very helpful. They allow you to place your loads into groups that are commonly
used in load combinations, while keeping them in separate load cases. This is especially helpful in large models
where the loads might occupy many different load cases. They also allow you to define load combinations that are
easily understood because they resemble the combinations as they appear in the building code.

General Reference Manual

355

Loads - Basic Load Cases

Load Category

Description

DL
LL
EL
WL
SL
RLL
LLS
TL
SLN
HL
FL
RL
PL
EPL
IL
OL1 - OL100
ELX, ELY, ELZ
WLX, WLY, WLZ
WL+X, WL+Y,
WL+Z
WL-X, WL-Y, WLZ
WLXP1, WLYP1,
WLZP1
WLXP2, WLYP2,
WLZP2

Dead Load
Live Load
Earthquake Load
Wind Load
Snow Load
Roof Live Load
Live Load Special (public assembly, garage, storage, etc.)
Long Term Load (creep, shrinkage, settlement, thermal, etc.)
Snow Load Non-shedding
Hydrostatic Load
Fluid Pressure Load
Rain Load
Ponding Load
Earth Pressure Load
Impact Load
Other Load 1 - 100 (generic)
Earthquake Load along global X-axis, Y-axis, Z-axis
Wind Load along global X-axis, Y-axis, Z-axis

ELX+Z, ELX+Y
ELX-Z, ELX-Y
ELZ+X, ELZ+Y
ELZ-X, ELZ-Y
ELY+X, ELY+Z
ELY-X, ELY-Z
NL, NLX, NLY,
NLZ
WLX+R, WLY+R,
WLZ+R, WLX-R,
WLY-R, WLZ-R,

Wind Load along positive global X-axis, Y-axis, Z-axis
Wind Load along negative global X-axis, Y-axis, Z-axis
Partial Wind Load 1 along global X-axis, Y-axis, Z-axis
Partial Wind Load 2 along global X-axis, Y-axis, Z-axis
Eccentric Earthquake Load along global X-axis shifted along positive global Z-axis, Y-axis
Eccentric Earthquake Load along global X-axis shifted along negative global Z-axis, Y-axis
Eccentric Earthquake Load along global Z-axis shifted along positive global X-axis, Y-axis
Eccentric Earthquake Load along global Z-axis shifted along negative global X-axis, Y-axis
Eccentric Earthquake Load along global Y-axis shifted along positive global X-axis, Z-axis
Eccentric Earthquake Load along global Y-axis shifted along negative global X-axis, Z-axis
General notional load and along global X-axis, Y-axis, Z-axis
Roof wind loads in the positive and negative X-axis, Y-axis, Z-axis

Using categories is optional. Remember though that if you define combinations of categories you must define these
categories in the Basic Load Case spreadsheet. If you don't, the combinations will have no loads.
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Loads - Load Combinations
During solution the model is loaded with a combination of factored Load Categories and/or Basic Load Cases, both
of which are defined on the Basic Load Cases Spreadsheet. These combinations, load factors, and other
parameters are defined on the Load Combinations Spreadsheet. Most standard load combinations are included in
the program. See Solution to learn how to solve load combinations.

To Add Load Combinations Manually
1. From the Home tab click on the Load Combinations button .
2. Enter load combinations by pairing loads in the BLC fields with factors in the Factor fields.
To Add Auto-Generated Building Code Combinations
1. From the Home tab click on the Load Combinations button.
2.
3.
4.
5.
6.
7.

Select the
button from the top of the spreadsheet.
Select the Load Combination Region and Code from the drop down lists provided in the Gravity tab.
Select the desired Roof Live Load and Notional Load options and click Generate.
Click in the Wind tab, select the desired Wind Load options, and click Generate.
Click in the Seismic tab, select the desired Seismic Load options, and click Generate.
Modify the generated combinations and options in the spreadsheet as necessary.

Note
l

l

l

l

l

The generated building code combinations are made up of Load Categories and Factors. Loads that are
not assigned to these categories will not be included in the combinations upon solution.
All generated combinations are added and marked for the envelope solution. You may remove combinations from the envelope after adding them.
You may specify P-Delta options and SRSS combinations for each combination after you have added
them.
Verify the Wind/Seismic ASIF (allowable stress increase factor), and the Timber CD settings on the
Design tab for combinations after you add them.
You may save any preferred load combinations as the default by clicking the Save As Defaults
button on the Window Toolbar.

To Solve Load Combinations
l

To solve a single load combination, click the Solve from the Home tab. Select the load combination from
the drop down list and click the Solve button.
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l

To solve multiple load combinations, first mark the combinations to be solved by checking the Solve box
on the Load Combinations spreadsheet. Click the Solve button from the Home tab, and choose the
Envelope or Batch option before clicking Solve.

l

The Envelope solution is where all combinations with a checkmark in the Solve field are solved simultaneously. The Maximum and Minimum results of these solutions are listed, along with the number
of the controlling load combination for each solution result.
The Batch solution is where all combinations with a checkmark in the Solve field are solved
simultaneously. All results of these solutions are listed.

Note

l

Load Combinations Spreadsheet
The Load Combinations Spreadsheet records the combinations of loads for solution and may be accessed by
selecting Load Combinations on the Data Entry toolbar in the Explorer panel.

Combinations Tab
The first field, the Description, is strictly for the user's reference. Enter any descriptive label you wish and it may
be displayed with the results when the combination is solved.
The next three fields are for options that apply to each load combination.
The Solve box is used to indicate which combinations should be included in batch or envelope solutions. See
Solution for more information.
The P-Delta entry is used to enable an analysis of member secondary effects. See P-Delta Analysis for more
information.

Note
l

Per Section C1 of Chapter C (Design for Stability) of the AISC 15th Edition steel code, a factor of 1.6 will
be applied to all load combinations for which a P-Delta analysis is to be performed (and for which the
Hot Rolled box is checked on the Design tab) whenever 'AISC 15th: ASD' is selected on the Codes tab of
the Model Settings Dialog. This factor is applied prior to conducting the P-Delta analysis and the results
are subsequently divided by a factor of 1.6.

The SRSS entry is used to combine response spectra results by the Square Root of Sum of Squares. See SRSS
Combination of RSA Results for more information.
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The next eight pairs of fields (BLC, Factor) are for defining what loads are to be part of the combination, along with
factors for each. Select load categories from the drop down lists in the Category columns of the spreadsheet. The
following are the entries you can use in the BLC field:

Entry

Description
Entering a number includes that particular Basic Load Case, I.e. enter “3"
for BLC 3
Enter a category code such as DL, LL, etc to include all loads in that
category
Enter “Lnn” to nest the loads from another combination, where “nn” is the
number of the other combination, i.e. “L3" means include all loads from
load combination 3.
Use this entry to include a moving load where “Mnn” is the moving load
tag from the moving load spreadsheet
Includes response spectra results for the global direction “n”, I.e. enter
“SX” to include response spectra results calculated in the global X
direction, “SY” for global Y , etc.
Use this entry to include a time history load where “Tn” is the time history
load tag from the Time History Loads spreadsheet

Number
Category
Lnn
Mnn
Sn
Tn

There are also a number of BLC Prefixes that may be included in your load combinations. You can have these
generated by the LC Generator or you may click on the triple dot button in the BLC cell to select them manually.
These are defined in the Seismic tab of the Model Settings. They are explained below:

Prefix

Description

SF

Scaling Factor - applied to RSA results
Redundancy factor - applied to EL loads for seismic load combinations (or RSA
results)

ρ (Rho)

SDS

Note: If ELX and ELZ used, the ρ from the X and Z direction will be used
directionally. If EL is used, the ρ from the X direction will be used and the Z
direction will be disregarded. If ELY is used, the ρ from the Z direction will be
used and the X direction will be disregarded.
Spectral Response Acceleration Parameter for Short Periods - applied to DL for seismic
load combinations
Overstrength Factor - applied to EL loads for seismic load combinations (or RSA
results)

Ω (Om)

CL

Note: If ELX and ELZ are used, the Ω from the X and Z direction will be used
directionally. If EL is used, the Ω from the X direction will be used and the Z
direction will be disregarded. If ELY is used, the Ω from the Z direction will be
used and the X direction will be disregarded.
Capacity-Limited Forces - applied to EL loads for seismic load combinations for
braced frame seismic design (e.g. SCBF, BRBF). The program will conduct
capacity-limited design for beams and columns using braces' capacity-limited
forces in lieu of the applied seismic loads.
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Enter in the Factor field a multiplier to be applied to the loads being included.
You may also use the
button in the BLC cell to help you specify the loads. Choose from load categories, basic
load cases, or spectral results or moving loads from the drop-down lists.

Notice the Seismic Options and RSA Options that are described in the Prefix table above. For additional advice on
this topic, please see the RISA Tips & Tricks website: www.risa.com/post/support. Type in Search keywords:
Seismic Factors.

Design Tab

The first field, the Description, is strictly for the user's reference. Enter any descriptive label you wish and it may
be displayed with the results when the combination is solved.
The ASIF column is used to set the allowable stress increase factor used for both the AISC: ASD code checking and
ACI 530 ASD (masonry allowable stress design). See Allowable Stress Increase regarding its usage for Hot Rolled
Steel.
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The CD factor is the load duration factor and is only necessary for NDS timber design using ASD (see Load Duration
Factor). Note: this is KD for Canadian (CSA O86) wood design.
The lambda factor is the time effect factor and is only necessary for NDS timber design using LRFD (see Time Effect
Factor).
The Service check box is used in the following applications:
l

l

l

Cracked Concrete Section Properties: Per the provisions of ACI 318-14 Section 6.6.3.2.2 (ACI 318-11 Section R10.10.4.1) the cracked section properties of beams, columns and walls may be multiplied by a factor of
1.43 for service level loads (<= 1.0*Ig). All concrete members and walls apply this factor when the Service
box is checked. Note that this 1.43 factor does not apply to masonry walls. Masonry wall stiffness is
NOT dependent on this check box.
Story Drift: The story drift results are broken up by each lateral direction into Service and Strength load
combinations. These tabs can be seen in the Story Drift results spreadsheet.
Member Deflections: The first two tabs of the Member Deflections spreadsheet provide deflection and
deflection ratio results for Service and Strength load combinations.

The next seven check boxes designate which load combinations should be used for the code checking of each
material type. The example shown uses one set of Load Combinations for the NDS wood design, and another for the
ACI concrete design. Member results (Forces, Stresses, Torsion) will only be reported for a members if it’s material
type has been checked for that load combination. Member results for general material will be shown for all load
combinations. For example when using steel and wood in your model, you may design your steel for one set of load
combinations and your wood for another.
The last check box for Connection defines:
l

If this LC should be used in designing hot-rolled steel connections with RISAConnection.

Load Combinations with RSA Results
The results from response spectra analyses in the X, Y, and Z direction may also be included in the load
combinations. Remember, when you perform a response spectra analysis (RSA), you specify in which global
direction the spectrum is applied. RISA-3D will retain the three RSA solutions (one for each direction)
simultaneously.

To include the RSA results for a particular direction in a load combination, enter "Sn" in the BLC field, where n is
the global direction. Suppose you wanted to include X direction RSA results, you would enter SX in the BLC field.
You would enter SY for Y direction and SZ for Z direction RSA results. Also be sure to put the RSA Scaling Factor for
the RSA results in the Factor field. You can have more than one RSA entry in a load combination.

Note
General Reference Manual
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l

l

Remember that RSA results are typically unsigned (all positive) and you should provide some means of
accounting for this. The figure above uses two combinations for each RSA result, one with a positive
factor and the other with a negative factor to capture the maximum deflections, stresses and forces. See
Unsigned (All Positive) Results for more information.
If you have to combine 2 or 3 different spectra results with many static load combinations, it is convenient to put all the spectra results (SX, SY, and SZ) and factors in one load combination and nest that
combination in other combinations. You must set the RSA SRSS flag on each load combination for it to be
performed.

SRSS Combination of RSA Results
This is used to cause orthogonal RSA results in the combination to be summed together using an SRSS (Square Root
of Sum of Squares) summation. This gives a good approximation of MAXIMUM responses but it also causes all the
RSA results to be positive.
You may choose from the options by clicking on the
button. The entry is “+” or “-” to indicate whether the
combined RSA results are to be added (+) or subtracted (-) from the other loads in the combination.

Note
l

l

This flag is used to combine different spectra that are acting in different directions. This is different than
the modal combination method that combines results for one direction and is specified in the Response
Spectra settings.
This method was only approved for use in the 1997 UBC and is no longer noted as an appropriate
method in the current codes.

Load Combinations with Capacity-Limited (CL) Design
The capacity-limited design forces for braced frames (e.g. SCBF, BRBF) may also be included in the load
combinations. For capacity-limited design, the expected strengths of braces will be used in lieu of the applied
earthquake loads for columns and beams design in braced frames. The columns and beams will be designed to
resist the expected strength of the braces to ensure braces yield first to dissipate energy during an earthquake
event (e.g. Tne + Pne for BRBF, Tne + Pne or Tne + 0.3Pne for SCBF).

To include the capacity-limited (CL) design considerations for a particular direction in a load combination, enter
"ELn-CL" in the BLC field, where n is the global direction. Suppose you wanted to consider brace capacity-limited
forces for braced frames in the X direction, you would enter ELX in the BLC field.

Note
l
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Proper seismic design rules (e.g. SCBF, BRBF) are needed for frame members so the program can include
capacity-limited (CL) design considerations. No CL considerations will be done for members with incorrect seismic design rules.
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l

l

l

If both standard lateral loads and capacity-limited (CL) forces are specified in the same load combination, the non-CL lateral loads will be ignored. This is based on our understanding of the code requirement for CL design that the applied lateral loads in CL design shall be replaced by the brace CL forces.
The program will not consider both standard lateral loads and CL forces during analysis for the same
load combination.
The capacity-limited (CL) design procedure applies to only column and beam design in braced frames.
When an CL LC is solved, the program replaces braces with brace capacity-limited forces in frames that
are eligible for CL design (e.g. frames specified with proper seismic design rules). Since the braces are
removed during the CL design process, hidden boundary conditions are added in the lateral directions at
beam ends in the braced frames to avoid frame instability. The lock of beam ends in lateral directions
will not be an issue for CL design because this design process only applies to columns and beams. The
brace CL forces will be transferred to adjacent columns and beams properly for their CL design.
However, there are limitations due to the added hidden boundary conditions. Currently no beam axial
load redistribution is considered among braced beams in the same frame line due to the added boundary
conditions. Also no unbalanced beam axial load is considered for frames with braces connected to beam
ends directly (e.g. diagonal braced frames). The unbalanced beam axial load is considered for V and
Inverted-V braces. The display of the hidden boundary conditions can be turned on by going to the File > Application Settings -> Output, and selecting the checkbox "Display seismic capacity-limited boundary
conditions".
Users can display capacity-limited (CL) forces after solutions. The program requires solutions to determine and display the CL forces of braces. If users display the forces under CL load combinations before
solutions, the CL forces will be displayed as the associated standard seismic forces. For example, ELX-CL
will be displayed as ELX loads before solution. After solution it will be displayed as the brace expected
strength forces for braced frames in the X direction.

Limitations
l

The analysis consideration per AISC 341-2016 F2.3c of progressive yielding and buckling of the braces
for multi-tiered braced frames is not included in the current implementation of capacity-limited
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l

l

(CL) design.
The exceptions under AISC 341-2010 F2.3 are not fully considered in program. This is due to the program not having enough information to determine if these exceptions apply. Users need to use their judgment to check if these exceptions apply to their structure. The only exception the program partially
considers is the AISC 341-2010 F2.3 Exception 2a. Per this exception the program will perform
SCBF column design using the lesser of the forces determined from load combinations using the amplified seismic loads or the CL loads. However, the program cannot automatically remove compression
braces in the model. The users need to modify the models accordingly if they need to consider this exception.
Unbalanced forces for beams are only considered for V and Inverted-V braced frames. This is due to the
added hidden lateral boundary conditions for frame instability during capacity-limited (CL)design. No
unbalanced beam axial load can be considered for frames with braces connected to beam ends directly
(e.g. diagonal braced frames) because the unbalanced axial loads will go into the boundary conditions directly. Also, for the same reason the program currently does not consider any redistribution of beam
unbalanced axial loads among beams in the same frame line.

Load Combinations with Moving Loads
Moving loads are included in your analysis by referencing them on the Load Combinations spreadsheet. For
example, to reference moving load number “n” you would enter “Mn” in one of the BLC fields, and then also enter
the corresponding BLC factor. The moving load numbers are shown for each moving load on the Moving Loads
spreadsheet.

Nesting Load Combinations
You are allowed only 10 BLC's per load combination, which may not be enough. For this reason you can define
"combinations of load combinations". This means if you need more than 8 BLC entries in a single combination, you
can define the needed BLC's and self-weights over several load combinations and then pull these combinations
together into another load combination.
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Entering "Lnn" in the BLC field means include all the BLC entries (with their factors) from Load Combination "nn".
For example, say Load Combination 4 has "L1" entered for one of its BLC's. This specifies to include all the BLC's
(with their factors) entered in Load Combination 1 as part of Load Combination 4 (this includes self-weight and RSA
entries as well). The flags for Load Combination 1 (i.e. Solve, PDelta, and SRSS entries) apply only to Load
Combination 1 and will not be used when Load Combination 4 is solved.
Also, the factor we enter with the "Lnn" entry will be applied to the BLC factors entered for LC nn. Thus, if we enter
"L1" with a factor of "0.9", we're including 90% of the BLC entries of Load Combination 1.

Note
l

These “combinations of load combinations” can only be nested to one level; i.e. the load combs referenced with the Lnn entries may not themselves have Lnn entries.

ASIF Factors for Wind / Seismic Load Combinations
Entering a value/factor in the field labeled ASIF (Allowable Stress Increase Factor) indicates that the load
combination should be treated as a wind/seismic load combination.
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If AISC 9th Edition ASD code checking is selected, the allowable stress increase factor entered in this field is applied
to this load combination.
If LRFD code checking is selected, then any value of ASIF greater than 1.0 will indicate that the seismic provisions
for the WF compactness checks are to be used (Table 8-1, p. 6-317 of the 2nd ed. LRFD).

P-Delta Load Combinations
The P Delta field is used to perform a P-Delta calculation for that load combination. You may choose from the
options by clicking on the
button. A blank field indicates no P-Delta analysis, Y indicates that a P-Delta analysis
is to be performed for the combination.

You may also perform a compression only P-Delta analysis. Invoke this option by putting a C in the P Delta field.
See P-Delta Analysis for more information.

Note
l

l

P-Delta analysis is normally required for LRFD based code checks. If this is not desired, the user may
change the setting by selecting Application Settings on the Tools menu and clicking the Solution and Results tab.
P-Delta analysis is not performed on plates.

If P-Delta was not included in the load combination spreadsheet (PDelta column is blank) but is required by code,
the following message will display upon solution.

This warning means that the solution was run but the members requiring P-Delta will not provide any design
results. In order to bypass this warning to see results without P-Delta, you can turn off the "Enforce code required
P-Delta analysis" option in the Application Settings. An example of when this would be a recommended work flow is
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when investigating model instabilities. Once you are ready to view full design results for your model, it is
recommended to turn this requirement back on.

Timber Design Load Duration Factor
For Wood design, the load duration factor (CD) is entered in the CD field on the row that the particular CD factor
applies to. Different load combinations would have different CD factors. For example, per the NDS code, a load
combination that had only dead load, would have a CD factor of "0.9", while another combination that was
comprised of dead load plus wind load would have a CD factor of "1.6".
The CD factor will only be applied to wood code checks on wood members. "Wood" members are those members
whose material properties are defined on the Wood tab of the Material Properties Spreadsheet.

Note
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l

l

See Table 2.3.2 in the NDS 2018 code for the CD factors to be applied for typical loads. Note that the CD
factor used for a load combination should be for the load with the shortest load duration in that load
combination.
When the Canadian CSA O86 Wood design code is selected, these entries will all change to "KD". See
Table 5.3.2.2 of the CSA O86-14 code for direction on what factors to enter.

Generating Building Code Combinations
Major portions of the load combinations that are specified by building codes are included and may be applied to the
model for solution. These combinations may be inserted by selecting the
button from thetop
of the Load Combinations spreadsheet. This will activate the Load Combination Generator Dialog shown below:

Gravity Options
The first tab of the Load Combination Generator is the Gravity tab. This tab contains Roof Live Load and Notional
Load Options.
The LC Region refers to the various regions supported by the program (U.S., Canada, India, British, et cetera).
The LC Code refers to the actual code used to build the load combinations. For the United States, there are a
number of different codes that could be used to build load combinations. If the only option is Sample, that means
that no load combinations have been input for that region. See Customizing the Load Combination Generator for
more information on how to add or edit combinations for that region.
These settings can be changed on any of the three tabs will automatically update on the other tabs. Therefore
making it easy to simply move through the tabs, selecting the options you require, but not having to re-select the
region and code data on each page.
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Beam Deflection Options
The Generate Deflection LCs will automatically place 3 load combinations first that match DL, LL and DL + LL.
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This will match the Typical design rule from the default Member Design Rules - Deflection tab inputs.

Roof Live Load Options
The Roof Live Load Options allow the user to specify how complex the load combinations including roof live loads
should be.
Placing a check in the box next to RLL (Roof Live Load), SL (Snow Load), and/or RL (Rain Load) will indicate
that the selected load categories are to be included in the generated load combinations.

Notional Load Options
The Notional Load Options allow the user to specify how complex the load combinations including notional loads
should be.
When None is selected, the program will not generate any Load Combinations that include the NL load category.
The 2D Only option is used to indicate that only the most basic notional load category (NL) will be used.
The X and Z option is used to indicate that the program should generate separate notional load combinations for
each horizontal direction (NLX and NLZ).
When the Reversible box is checked, the program will generate every notional load combination twice. Once with a
positive load factor, once with a negative load factor.
For additional advice on this topic, please see the RISA Tips & Tricks website: www.risa.com/post/support. Type in
Search keywords: Notional Loads.

Wind Options
The second tab of the Load Combination Generator is the Wind tab. This tab contains Wind Load Options.
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Wind Load Options
The Wind Load Options specify how detailed the generated wind load combinations should be.
When None is selected as the wind load option, the program will not generate any Load Combinations that include
wind load categories.
The 2D Only option generates only the most basic wind load category (WL).
The X and Z option generates separate wind load combinations for each horizontal direction (WLX and WLZ when
Y is set at the vertical axis).
The X and Z w/ Ecc option generates all possible wind load combinations that include partial / eccentric wind
loading (WLX, WLXP1, WLXP2, et cetera) per Case 2 from Figure 27.3-8 in the ASCE 7-16.
The X and Z w/ Ecc, Quart option generates all possible wind load combinations per Cases 2, 3 and 4 from Figure
27.3-8 in the ASCE 7-16. For additional advice on this topic, please see the RISA Tips & Tricks website:
www.risa.com/post/support. Type in Search keyword: Quartering.
The Reversible option generates two combinations for each wind load, one with positive load factors and one with
negative load factors.
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The Generate Semi-Rigid Diaphragm Loads option generates wind loads for BLC's using windward and leeward
direction loads prescribed by the ASCE 7-16 (WLX+Z, WLX-Z, WLZ+X, WLZ-X).

Seismic Options
The third tab of the Load Combination Generator is the Seismic tab. This tab contains Seismic Load Options.

Seismic Load Options
The Seismic Load Options specify how complex the generated seismic load combinations should be.
When None is selected as the seismic load option, the program will not generate any Load Combinations that
include the EL load category.
The 2D Only option is used to indicate that only the most basic seismic load category (EL) will be used.
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The X and Z option is used to indicate that the program should generate separate seismic load combinations for
each horizontal direction (ELX and ELZ).
The X and Z w/ Eccentric option is used to indicate that the program should generate all possible seismic load
combinations that include eccentricities (ELX, ELX+Z, ELX-Z, et cetera).
The X and Z RSA option will use the spectral seismic loads (SX, SY, SZ) instead of the regular earthquake loading
(ELX, ELY, ELZ).
If you have selected the X and Z, X and Z w/ Eccentric, or X and Z RSA option, you will also have the ability to
include non-orthogonal seismic loads. Simply check the Include Non Ortho (100% + 30%) checkbox to include
these loads per the Orthogonal Combination Procedure of section 12.5.3.1(a) of the ASCE 7-16.
When the Reversible box is checked, the program will generate every seismic load combination twice. Once with a
positive load factor, once with a negative load factor.
Check the Include ρ checkbox if you want to include the redundancy factor in your seismic load combinations. This
factor is set in the Seismic tab of Model Settings.
Check the Include Ev (vertical) checkbox if you want to include the vertical seismic load effect in your seismic load
combinations. This value is calculated per equation 12.14-6 of the ASCE 7-16 using the SDS value set on the Seismic
tab of Model Settings.
The Capacity-Limited (CL) LC Options for Braced Frames will generate capacity-limited design forces based on
brace expected strength. The generator will use the overstrength load combinations per LC code selected, and
replace the overstrength seismic forces with CL forces.
Check the Add Notional Loads to Seismic Load Combinations checkbox if you want to include notional loads
applied as lateral seismic loads per the ASCE 7 and AISC codes.
The Save as Defaults button may be used to establish the current load combination generator settings as the
defaults for future use. Clicking the Generate button will generate load combinations in the Load Combinations
Spreadsheet based on the selected options.

General Notes on the Load Combination Generator
The following loads are not generally included in the standard combinations but may be added by editing the
combinations in the spreadsheet or by modifying the source document itself. For more information, see Customizing
the Load Combination Generator below:

Category Code

Description

SX, SY, SZ
TL
HL
FL
PL

Response Spectra Results
Long Term Load
Hydrostatic Load
Fluid Pressure Load
Ponding Load Category

EPL

Earth Pressure Load

OL#

Other Load Categories

Note
l

l

l

The standard combinations are made up of Load Categories and Factors. Loads that are not assigned to
these categories will not be included in the combinations upon solution.
Some load categories do not occur in all of the design codes. Loads placed in categories that are not part
of the standard combinations will not be included in the solution of these combinations.
All combinations added from the drop down list are added to the envelope solution. You may remove
combinations from the envelope after adding them.
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l
l
l

l

l

Verify the Wind/Seismic ASIF settings for combinations after you add them.
After you add the combinations, verify the settings for the wood design Load Duration factor, CD/KD.
You may specify P-Delta options and SRSS combinations for each combination after you have added
them.
See Editing Spreadsheets - Inserting, Deleting and Clearing Cells for quick ways to edit or add
combinations.
When a new installation is performed the program will back-up any existing XML files that contain load
combination data rather than overwriting them. The back up copies will be given the extension BAK.

Customizing the Load Combination Generator
The Load Combinations for each region are contained in an XML file which can be opened and edited using a
standard spreadsheet program. An example of on of these XML files is shown below:

The name of the file itself becomes the name of the Load Combination Region that appears in the Load Combination
Generator. Each XML file has a series of "worksheets" and the name of each worksheet will be the name of the Load
Combination Code that appears in the Load Combination Generator. The user may add, edit or modify these
documents to completely customize the available load combinations.

Note
l

When the program is updated for new versions, the existing XML files will be "backed up" and saved
with a '.bak' extension while the new XML files in the update will replace them. If any customizations
were made to the XML files, they can be retrieved from the back ups.

The first row of each sheet is reserved for the column headers. The recognized column headers are as follows:
Label, Solve, pDelta, SRSS, ASIF, CD, ABIF, Service, Hot Rolled, Cold Formed, Wood, Concrete, Masonry, Footings,
Aluminum, and Stainless,. In addition, there will be multiple pairs of BLC & Factor headers.
Other than Label and the BLC / Factor pairs, the user may omit columns. If a column is omitted, the default values
will be used for those entries. The order of the column labels is optional except for pairs of BLC and Factor. For the
program to correspond the Factor with correct BLC, the user should always provide BLC label PRIOR to the
corresponding Factor. The user may insert blank columns or columns with other labels than described above. In
those cases, the program omits those undefined columns.

Note
l

l

l
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As shown in the above example, the wind and seismic loads should be entered as WL and EL in order for
them to be "expanded" using the Wind Load Options and Seismic Load Options.
The program will read these files from the directory specified from clicking the 3D Button Application
Settings File Locations. See Customizing RISA for more information.
SX, SY, and SZ are not valid BLC that can be used within the Load Combination Generator spreadsheet. A
response spectra analysis must be done first within RISA-3D.
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Loads - Nodal Load / Displacement
You may specify nodal loads, and enforced nodal displacements and nodal mass in any of the global degrees of
freedom. Loads and displacements may be applied in any non-global direction by defining components of the load
in the global directions. This may be accomplished graphically or in the spreadsheets. See Drawing Nodal Loads
below to learn how to apply nodal loads/displacements/masses graphically.

Drawing Nodal Loads
You can apply nodal loads to nodes. You must enter the load direction, magnitude and type. Make sure that you are
careful to enter the correct BLC number that you want the loads assigned to. See Nodal Load/Displacement above
for more information on nodal loads.

To Apply Nodal Loads, Mass and Enforced Displacements

1. Go to the Home Tab and click on the Nodal button to bring up the nodal load information in the Properties
Panel.
2. Define the load in the Nodal Load Properties Panel. Use the dropdown menu to select Load Type, Direction,
and BLC. For help on an item, click
and then click the item.
3. You may apply the load by choosing nodes on the fly or apply it to a selection of nodes.
To choose nodes on the fly choose Click to Apply and click/box on the nodes with the left mouse button.
To apply the load to a selection, choose Apply to Selected.
If no nodes are selected, Apply to Selected will assume the full model is selected and apply changes to all
nodes. If any node is selected, Apply to Selected will only apply to the selected nodes.

Note
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l
l

You may also specify or edit nodal loads/displacements in the Nodal Loads Spreadsheet.
You may undo any mistakes by clicking the Undo

button.

Nodal Load Spreadsheet
The Nodal Load Spreadsheet records the loads for the nodes and may be accessed by selecting select Nodal Loads
from the Data Entry menu in the Explorer panel.

When you open this spreadsheet you may view only one basic load case at a time. Use the drop down list on the
toolbar to specify a different load case.
The Node Label specifies the node that receives the load or displacement. The same node may be listed any
number of times.
The next column indicates the value is a load or an enforced displacement. Enter "L" if it’s a load, "D" if it's a
displacement and “M” if it is a mass.
The direction code indicates in which of the global directions the value is applied. Valid entries are X, Y or Z for the
translational directions, or MX, MY or MZ for the rotational directions.
The Magnitude column holds the value of the load, displacement or mass. The appropriate units for the magnitudes
are displayed at the top of the column. Which units apply depends upon whether the value is a load, displacement
or mass, and whether the direction is translational or rotational.
The last column allows you to set the specified load as an "Active" load that will be considered for the analysis, or
an "Inactive" load that will not be included in the analysis.

Note
l

If you have a “Reaction” or a “Spring” boundary condition for the same degree of freedom that you have
an enforced displacement assigned, NO reaction will be calculated. See Reactions at Nodes with
Enforced Displacements to learn how work around this limitation.

Nodal Mass
For more sophisticated dynamics modeling, you can enter your mass directly as a mass rather than have the
program convert it from a load. Using nodal masses offers several advantages such as being able to define
directional mass and also the ability to specify mass moment of inertia’s to account for rotational inertial effects.
The units used for Nodal Mass are derived from the current Force and Length units as specified on the Units
settings. For example, if the current force units are Kips and the current length units are Feet, you will need to
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specify your mass as kips / g and mass moments of inertia as kip-ft2 / g where g is the acceleration of gravity given
in those units (feet per seconds squared).
When specifying a nodal mass on the Nodal Loads spreadsheet, enter an “M” for the load type. The directions are
defined relative to the global axes. Enter translational mass using the global X, Y, or Z codes and mass moments of
inertia by specifying the global MX, MY or MZ.
Nodal masses only allow dynamic response in the direction that they’ve been applied. This can be a very effective
way to prevent local modes. A good example is a floor diaphragm modeled with plate/shell finite elements. If the
mass is only specified for the two lateral directions, you will prevent any unwanted vertical modes. Care must be
taken in limiting dynamic response using directional mass for complicated structures. A structure that has “coupled
modes” will not give the “real” dynamic response when mass is only specified in one or two directions. A coupled
mode is a mode that has mass participate in two or three directions at one time.
Nodal masses also allow you to account for rotational inertia effects by specifying a mass moment of inertia. These
are particularly important when you’re using a rigid diaphragm and you’ve also lumped all your mass at one point
(typically the center of mass). The rotational inertia effects contribute to the torsion on the diaphragm and should
not be neglected. The following table shows some typical diaphragm shapes and the formulas to calculate their
mass moment of inertias. Note that you can use the axis transformation equation to calculate the mass moment of
inertia for diaphragms that are combinations of these basic shapes. For very irregular diaphragms, a more general
equation is given based on the in-plane moment of inertia and the area of the diaphragm.

Mass Moment of Inertia About an Axis Through the Center of Mass
In the table below C.M. is the center of mass point. M is the total Mass of the area (typically including self weight,
dead load, and a percentage of the live load) and is assumed to be uniformly distributed throughout. Ixx is the
moment of inertia about the X-X axis. Izz is the moment of inertia about the Z-Z axis. A is the area. MMIo is the
mass moment of inertia about some other point.

Area Plan View

Formula

M (b2 + d2) / 12

M d2 / 8
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Area Plan View

Formula

M (Ixx + Izz) / A

MMIo + M D2

378

RISA-3D V20

Loads - Area Loads

Loads - Area Loads
Area loads are loads that are applied to a planar area and automatically attributed to the members in that
plane. This gives you the ability to model the loading effects on a membrane, such as live load on a deck system or
wind on a curtain wall, without adding unwanted stiffness to the model. (To model load and stiffness you may use
plate shell elements loaded with surface loads.)
The area loads are defined by polygons of three or four sides. They may be assigned a direction for one-way span
situations, considered as two-way membranes that transfer load in all directions, or be assigned with an "Open
Structure" load distribution which will apply loads to members based solely on their projected surface area. The
loads from the area are assigned to the nearest members, not to plates.

Note
l
l

Area loads are not assigned to Tension-only and Compression-only members.
The nodes that define an area load must be coplanar.

Drawing Area Loads

To apply area loads to members enter the load direction and magnitude. Make sure that you are careful to enter
the correct BLC number that you want the loads assigned to.

To Apply Member Area Loads
1. If there is not a model view already open then go to the View tab and select the Open 3D Views button to
open a new view.
2. Go to the Home tab and press the Area button in the Draw Loads section.
3. Click on four nodes to define the area. For three sided areas click on the last node twice.

Note
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l
l

You may also specify or edit area loads in the Member Area Loads Spreadsheet.
You may undo any mistakes by clicking the Undo button.

Member Area Loads Spreadsheet
The Member Area Load Spreadsheet records the area loads to be attributed to the members and may be accessed
by going to the Spreadsheets tab Data Entry button Member Area Loads or by clicking the Member Area
Loads button in the Data Entry Panel.

When you open this spreadsheet you may view only one basic load case at a time. Use the drop down list or the
buttons to specify a different load case. The current load case is also displayed in the
title bar at the top of the spreadsheet.
The first four columns contain the nodes that define the area to be loaded. The fifth and sixth columns indicate the
direction and distribution of the load, both are discussed below.
The Magnitude column holds the load magnitude.
The last column allows you to set the specified load as an "Active" load that will be considered for the analysis, or
an "Inactive" load that will not be included in the analysis.

Member Area Load Direction
The direction code indicates the direction of application for the area load. The following directions are available:

Direction Code

Application Direction

X, Y, or Z
PX
PY
PZ
Perp

Global X, Y, or Z direction
Projected in the direction of the global X axis
Projected in the direction of the global Y axis
Projected in the direction of the global Z axis
Perpendicular to the plane of the area load polygon

Global loads are applied without being modified for projection. For example, a global Y-direction load of 1 ksf
applied to an inclined plane with an area of 10 sq.ft. generates a total force of 10 kips, no matter what the incline is.
Projected loads, on the other hand, are applied in the global directions, but their actual magnitude is influenced by
the planar orientation. The load is applied to the projected area of the element that is perpendicular to the load.
For example, a "PY" direction load is a projected load applied in the global Y direction. The actual magnitude of the
load is the entered magnitude reduced by the ratio A/Axz. "A" is the actual area of the element and Axz is the
element's projected area on the X-Z plane, which is always less than or equal to the actual area. See the following
figure:
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If the "Axis of Projection" in the figure is the Y-axis, then the shaded area is the total element area "projected" onto
the plane perpendicular to the Y-axis (which happens to be the X-Z plane). The total load generated is equal to the
input magnitude applied to the projected area. The generated load is then applied to the whole area, so the
generated load magnitude is reduced accordingly.
For additional advice on this topic, please see the RISA Tips & Tricks website: www.risa.com/post/support. Type in
Search keywords: Projected Loads.

Note
l

For the loading perpendicular to the plane of the area polygon, the order in which you click on the joints
will determine whether the load direction is into or away from the plane of the area. Clicking on the
ABCD joints in a clockwise order will create a loading heading down towards the plane.
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Area Load Distribution

The distribution of the area load determines which members "support" the area load you define. You may choose
between three main distribution options: two-way, one-way, or open structure. Below we will explain each of the
main options.

Two Way
Two way area load distribution is analogous to how load travels through a two-way slab. Load will be distributed to
the nearest member, regardless of direction. When a two-way area load is drawn there will be a star pattern shown
to verify that load will go out in all directions. Here is an example model of a two-way slab with an area load:
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At solution, we can view how this load was applied by viewing the appropriate transient Basic Load Case:
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Here we can directly see how the load was applied. See the Area Load Attribution section for more information.

One Way
For a one-way distribution, you are asking the program to distribute loads in a single direction. There are multiple
one-way options that all depend on the order that you click to create your area load. All options from A-B to
Perpendicular to B-D are one way options. The A-B option means that the load will span one-way in a parallel
direction to the first two corners of the area load (the A and B corners). Below is an image of what a B-C one-way
area load distribution would look like:
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For odd geometries the "Perpendicular..." options may be necessary to get the load distribution you are looking for.

Open Structure
As a third option, you may elect for the load to be distributed as an "Open Structure." This option applies the area
load to each member based solely on the projected surface area (in the direction of the loading) of that member.
The "Open Structure" distribution option is generally intended for open/lattice type structures for which a wind
pressure is acting uniformly on all the exposed structural surfaces of the structure. The program will distribute the
area load to the members as member distributed loads calculated as the area load magnitude multiplied by the face
of the member perpendicular to the direction of the "Open Structure" load. Below is an example of the calculation
for the "Open Structure" attribution:
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Note
l

l

The "Open Structure" load distribution option applies load to the members in the plane of the applied
load as well as the members in the structure in-front of or behind that plane.
Currently the "Open Structure" option does not take shielding into account for members behind other
members.

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Member Area Load.

Area Loads and Wall Panels
Wall panels can now accept area loads as well. This, however, will only occur at the tops of walls and at diaphragm
locations. If there is an area load applied at the top of a wall or where there is a diaphragm applied, then the wall
panel will receive area load in the same way as a member.
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This, however, will not work if the area load is not applied at the top of the wall, or there is no diaphragm defined
where the area load intersects the wall panel. In this case no load will be applied to the wall. All of the load will go
in the opposite direction.

The user can force area loads to attribute to walls even if there is not a diaphragm at that elevation. This can be
done by drawing in a "dummy" member or ledger beam at the same location as the wall. This member will receive
area load like any other member, but should then transfer its load directly into the wall.
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Area Load Attribution
Meshing
The program takes the area loads defined by the user and breaks the loads down into finite "pieces". These pieces
are broken down until the side dimension of the "piece" is less than that defined inMember Area Load Mesh Size
in the Model Settings - Solution tab. These pieces of load are then attributed to the members in the plane of the load
according to the distribution defined.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Verify Area Loads.

One way Attribution
One-way areas are attributed in the span direction based on the assumption of a simply supported deck. Each point
load "piece" is attributed to supporting members based on the ratio of the distance of that member compared to the
total deck span at that location. If there is no member in that direction then the load is attributed as a two-way
load.

Two Way Attribution
Two-way areas are attributed to the members in all 4 directions based on an extension of a simply supported deck.
Each point load "piece" is attributed to the members based on the ratio of the distance of that member compared to
the distance of that point from the other members as shown in the image below:
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This results in a load distribution that agrees very closely with traditional hand calc methods.

Transient Area Loads
After solution, the resulting distribution of the area load is stored in the first available basic load case with “BLC #
Transient Area Loads” as the description. They may be viewed graphically or in the spreadsheets as a basic load
case. These loads are transient which means they are only a result of the area load and will be deleted when the
results are cleared and re-determined each time you solve the model. The only purpose of these transient BLC's is
to let you view the exact load attribution created by the program.

Note
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l

l

Members that are designated as Tension Only, Compression Only, or Euler Buckling will not receive any
load during the Area Load Attribution.
Members that are designated with a member type of VBRACE or HBRACE will not receive any load during the Area Load Attribution.

You may disconnect the attributed loads and take control of them by assigning a category to the automatically
created basic load case. The original area loads will be left as they were so a subsequent solution will produce
another distribution of loads that are a result of the defined area loads.

Solution Speed
Note that the area load algorithm used by RISA-3D is very versatile in that it can work in any of the global
directions in a three dimensional model, so that it can be used for vertical dead or live load modeling as well as
wind loads. But it can add a fair amount to the analysis time when small mesh sizes are used with large models.
Sometimes a small mesh is necessary to get the desired accuracy for the area load attribution.
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Loads - Point Loads
Point loads are concentrated loads applied along the span of a member or the edge of a wall panel. Defining point
loads may be accomplished graphically or in the spreadsheets. See Drawing Point Loads below to learn how to draw
joint loads graphically.

Drawing Point Loads
To apply point loads, enter the load direction, magnitude, and location. Make sure that you are careful to enter the
correct BLC number that you want the loads assigned to.

Note:
l

In the event that a member end offset exists and the load lies on the offset the load will be applied at the
end of the offset.

To Apply Point Loads

1. On the Home tab click the Draw Point Load button to apply a Point Load.
2. You may choose to apply the load to a single member/wall panel at a time or to an entire selection of members/wall panels.the load.

To apply the load to just a few elements choose Click to Apply. Click on the members or wall
panels with the left mouse button.
To apply the load to a selection, choose Apply to Selected.
Note:
l

To apply more loads with different parameters, change the parameters in the Properties panel and
choose Click to Apply or Apply to Selected to apply the new loads.
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l

You may also specify or edit point loads in the Point Load Spreadsheet.

l

You may undo any mistakes by clicking the Undo

button.

Point Loads from a Moving Load
Please see the Moving Loads topic for more information on how to create static point loads from a specific moving
load step location.

Point Load Spreadsheet
You can access the Point Loads spreadsheet from the Basic Load Cases spreadsheet which is located on both the
Data Entry and the Home tab. In the Basic Load Cases spreadsheet, click on a cell in the Point column.

The Point Load Spreadsheet records the point loads for the member elements and may be directly accessed by
selecting the Point Loads spreadsheet from the Data Entry menu.

The first column contains the label of the member or wall panel to receive the load.
The direction in the second column represents the direction of the load as one of the options mentioned above.
The load magnitude is recorded in the third column. The units for the magnitude are listed at the top of the
column, depending upon whether the load is a force or a moment.
The fourth column contains the location of the load. The location is the distance from the I-joint of the member and
is unaffected by any member offsets. The location of the load may be defined as a percentage of member length. To
define the distance from the I-joint as a percentage of member length, enter the percentage value (0 to 100),
preceded by the symbol "%". For example, a load in the center of the member would be defined with a location of
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"%50". Using a percentage value is handy if the member's length will be changing due to editing of the model
coordinates and you wish to have the load some proportional distance from the I end.
The last column allows you to set the specified load as an "Active" load that will be considered for the analysis, or
an "Inactive" load that will not be included in the analysis.
The Wall Panel Point Loads Spreadsheet records the point loads on your wall panels. Note that the loads are
specific to the BLC's and that you can use the drop-down list to scroll between your various load cases. The columns
in the spreadsheet are the same as the member point loads spreadsheet.
For models integrated from RISAFloor with semi-rigid diaphragms, the Diaphragm Point Loads Spreadsheet
records the point loads on your semi-rigid diaphragm. These loads will be greyed out since they cannot be edited.
Note:
l

l

If you are using RISAFloor to bring your model into RISA-3D with a rigid or flexible diaphragm, this spreadsheet will be automatically populated with the point loads from RISAFloor.
Loads from RISAFloor will be grayed out because they cannot be edited in RISA-3D since they are tied to the
RISAFloor analysis.

Point Load Directions
x, y, z

- Load applied in local x, y or z direction

X, Y, Z

- Load applied in global X, Y or Z direction

My, Mz - Moment about member local y or z axis
Mx

- Torsional Moment about member local x-axis
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Loads - Line Loads
Line loads are loads that are spread across all or part of a member or wall panel and can be of uniform, stepped, or
varying magnitude such as triangular or trapezoidal. You may define distributed loads graphically or by using the
spreadsheets. See Drawing Line Loads below to learn how to draw line loads graphically.

Note
l

If a member has offsets defined, the offset distances will NOT be loaded. The locations are still relative
to the I Node, but if the start location is less than the I End Offset, the part of the load applied along the
offset distance will be ignored. The same is true for the end location and the J End Offset. So a fulllength load is actually applied to a length equal to the full I to J Node distance minus the I-End and J-End
offset distances.

Drawing Line Loads
You can draw line loads to members or wall panels. The direction of the load may either be defined in the global
axes or the local axes of the member and may also be projected. For full length loads leave the Start and End
Locations as zero.
Make sure that you are careful to enter the correct Basic Load Case number that you want the loads assigned to.

To Draw Line Loads
1. If there is not a model view already open, then choose the Add 3D View option from the Open 3D Views
drop-down on the Viewtab of the ribbon
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2. Click the Draw Line Load button and define the load in the Property Panel.

3. You may choose to apply the load to a single element at a time or to an entire selection of members and/or
wall panels.
l

l

To draw the load to only a few members/wall panels, choose Click to Apply. Click on the members/wall panels with the left mouse button to apply the load.
To apply the load to a selection of members/wall panels, choose Apply to Selected. The load will
then be applied to all the selected elements in the model.

Note
l
l

To apply more loads with different parameters, press CTRL + D to recall the Draw Line Load tool.
You may also specify or edit line loads in the Distributed Load Spreadsheet.

Distributed(Line) Loads Spreadsheet
The Member Distributed Load Spreadsheet records the distributed loads for the member elements and may be
accessed by selecting Distributed Loads from the Data Entry drop-down on the Spreadsheets tab of the ribbon, or
by clicking Distributed Loads on the Data Entry toolbar.
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The first column contains the Label of the element being loaded.
The Direction specified in the second column indicates which axes are to be used to define the load directions and
whether or not the load is to be projected. Directions are discussed in the next section.
Start and End Magnitudes of the load must be specified. Start and End locations for the load need only be specified
if the load is not across the full member length. If both locations are left as zero then the load will be applied across
the full member length.
The Location columns contains the location of the load. The location is the distance from the I Node of the member
and is unaffected by any member offsets. The location of the load may be defined as a percentage of member length.
To define the distance from the I Node as a percentage of member length, enter the percentage value (0 to 100),
preceded by the symbol "%". For example, a load starting or ending in the center of the member would be defined
with a start or end location of "%50". Using a percentage value is handy if the member's length will be changing
due to editing of the model coordinates and you wish to have the load some proportional distance from the I end.
The last column allows you to set the specified load as an "Active" load that will be considered for the analysis, or
an "Inactive" load that will not be included in the analysis.
The Wall Panel Distributed Loads Spreadsheet records the distributed loads on your wall panels. Note that the
loads are specific to the BLCs and that you can use the drop-down list to choose a different one. The columns in the
spreadsheet are the same as the member distributed load spreadsheet.
For models integrated from RISAFloor containing semi-rigid diaphragms, the Diaphragm Distributed Loads
Spreadsheet records the distributed loads generated from the wind and seismic load generation. These lines will
be grayed out because they cannot be edited from RISA-3D since they are tied to the RISAFloor analysis.
Note:
l

l
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If you are using RISAFloor to bring your model into RISA-3D with a rigid or flexible diaphragm, this spreadsheet will be automatically populated with the distributed loads from RISAFloor applied to members and
wall panels.
Loads from RISAFloor will be grayed out because they cannot be edited in RISA-3D since they are tied to the
RISAFloor analysis.
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Distributed Load Directions
The direction code indicates how the distributed load is to be applied. Following are the valid entries:

Entry

Load Direction

x, y or z
X, Y or Z

Applied in the member’s local x, y or z-axis
Applied in the global X, Y or Z-axis

Mx
T (or t)
PX
PY
PZ
SX
SY
SZ
Sy
Sz

Torque applied about the member's local x-axis
Thermal (temperature differential) load
Projected load in the global X-axis direction
Projected load in the global Y-axis direction
Projected load in the global Z-axis direction
Pressure load applied to projected surface of member in the global X-axis direction
Pressure load applied to projected surface of member in the global Y-axis direction
Pressure load applied to projected surface of member in the local Z-axis direction
Pressure load applied to projected surface of member in the local y-axis direction
Pressure load applied to projected surface of member in the local z-axis direction

This diagram illustrates the difference between local (x, y, z) and global (X, Y, Z) direction loads:

In this diagram, the local y and global Y loads shown are both negative, while the local x and global X loads are
positive. As can be seen, local direction loads line up with the element's local axis directions, so their direction
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relative to the rest of the model changes if the member/wall panel orientation changes. Global loads have the same
direction regardless of the element's orientation.
A distributed load in the Mx direction will be applied to the member/wall panel according to the right hand rule.
Remember that the positive local x-axis extends from the I nodeof a member towards the Jnode.

Projected Loads
Keep in mind that global loads are applied without being modified for projection. For example, a full length Y
direction load of 1 kip/foot applied to a 10 foot member inclined at 45 degrees generates a total force of 10 kips.
Projected loads, on the other hand, are applied in the global directions but their actual magnitude is influenced by
the member's orientation. The load is applied to the "projection" of the member perpendicular to the direction of
the load. For example, a "PY" direction load is a projected load applied in the global Y direction. The actual
magnitude of the load is the entered magnitudes reduced by the ratio L/Lxz, where L is the member's full length
and Lxz is the member's projected length on the global X-Z plane. See the following figure:

So the total load generated is equal to the input magnitudes applied along the projected length. This generated
force is distributed along the full member length, so the applied magnitudes are reduced accordingly.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Projected Loads.

Surface Loads
This is a load type that applies a pressure load to the face of the member in the direction specified. If a local axis
direction is specified then the load will be applied to the strong/weak direction of the member regardless of the
member orientation. If using the global coordinates then the program will take the projected face of the element in
the direction in question and calculate the pressure area accordingly.
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The program then takes this pressure multiplied by the width of the pressure area and creates a line load that is
then applied to the member.

Note:
l

Distributed pressure loads can not be applied to tapered members or wall panels.
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Loads - Moving Loads
The standard AASHTO loads are built into the moving loads database, however you can add and save custom
moving loads as well. The moving loads can be applied in any direction, so they can be used to model crane
loadings (which are typically applied in 2 or 3 directions at the same location). You can have up to 5,000 moving
loads in each model.
To Apply a Moving Load
1.
2.
3.
4.

From the Data Entry menu, select the Moving Loads spreadsheet.
Specify a pattern in the Pattern field by selecting it from the drop down list.
In the Increment field specify the distance for the load pattern to be stepped through the path.
Specify the path by defining the Nodes in the remaining fields and indicate if you wish the pattern to be
moved Both Ways through the path.

Note
l

l

You may skip nodes when specifying the path. The moving load feature is “smart” in the sense that it
will try to find a way to get from one node to the next node in the load path sequence. The load path
taken will usually be the most direct route between the nodes and may be verified by animating the moving load.
For example, in the image below, if you want the moving load to move left to right along the beam member (M4), there if no need to specify the intermediate node (N4) in the moving load path.

To Animate a Moving Load
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1. If there is not a model view already open, click Open 3D Views in the View Tab and add new 3D view to
open a new view and make any adjustments you wish to appear in the animation.You can also make further
view adjustments within the animation view.
2. In the View tab click the Moving Loads Icon.
3. Select the moving load or load combination from the drop-down list at the bottom of the options and then
click on the Animate button.
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To Include a Moving Load in a Load Combination
1. To include a moving load in your analysis, specify it in the Load Combinations spreadsheet in one of the
BLC fields and enter a corresponding BLC Factor.
2. You may either type in the moving load tag (i.e. M1, M2, etc.) directly or you may select it by clicking the
ellipsis

404

to open the Set BLC Entry dialog. Choose the appropriate moving load from the drop down list.
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Moving Loads Spreadsheet
The Moving Loads Spreadsheet records the moving loads for the member elements and may be accessed by
clicking Moving Loads in the Data Entry menu.

Each moving load definition is automatically assigned a Tag on the left side of the spreadsheet. These labels may
not be edited. Moving loads are included in your analysis by referencing this label on the Load Combinations
spreadsheet.
The Pattern field is the name of the moving load pattern used for that particular moving load definition. You can
access the drop-down list of valid pattern names by clicking the down

arrow in this cell. You may access the

Moving Load Patterns and add or edit your own patterns by clicking on the ellipsis

.

The Increment field is the distance that the moving load will be moved for each step in the moving load analysis.
The Both Ways field is a check box that indicates whether the moving load pattern is to be applied in both
directions of the load path or just one way along the load path. If the box is checked the load is first run from the
start node all the way to the last node of the load path. The load is then turned around and the last node is now
treated as the first node in the load path. The load is then run back to the first node in the load path.
The last 10 fields are the node numbers that are used to define the load path for the moving load. The moving load
feature is smart in the sense that it will try to always find a way to get from one node to the next node in the load
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path sequence. The load path taken will usually be the most direct route between the nodes. If you have a long
series of co-linear members, or if there is only one valid path between your start and end nodes, you usually will
only need to specify the first node and the last node in the series. If there are several members that branch from a
node that are all part of valid paths to the next node in the sequence, the member with the lowest member number
will be the one chosen. To control exactly which route is taken in this situation, use nodes at each intersection
point. See the figure below:

In the example moving load path shown, you would need to specify nodes A, B, C, and D as the load path nodes.
You would not have to specify the joints that were in between the points where the load path changed direction;
I.e., the moving load would automatically go in a straight line from node A to B, etc.

Moving Load Patterns

You may access the Moving Load Patterns and add or edit your own patterns by clicking on the Moving icon in the
Advanced tab and then clicking on Add Pattern or Edit Pattern.
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The file that the moving load pattern database is stored in is ML_LIB32.FIL. The path to this file is specified in the
Application Settings in the File Locations tab. You can add up to 500 different moving load patterns in the
pattern database.
When you add a new pattern, the new pattern must have a unique name and can consist of up to 50 different loads.
The sign of the load Magnitude will control which way the load is pointing in the direction specified in the
Direction field. The direction field can be any of the 3 global directions or the 3 local directions for the members
that the load will travel over. Note that if your load travels over multiple members, a local direction load will be
applied based on the local axes of each member it crosses over. There is also a special code, “V”, which causes the
load to be applied in the direction of the current vertical axis, whatever it is (X, Y, or Z). The Distance is the
distance between the loads.

Note: If you have two loads at the same location but in different directions, you may input them one after the other
with a Distance between them of 0 ft/m, as shown in the image below:

Moving Loads Solution Procedure
Moving loads are handled internally by applying the loads at discrete locations that are then moved through the
model. A static solution is performed for the model at each load location. Typically, once the first solution is
solved, the remaining loads are just solved against the existing stiffness matrix, so the stiffness matrix would not be
rebuilt for each load position.

Note:
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l

l

l

Models that contain tension/compression only items will have their stiffness matrix rebuilt at least once
at each load position. This can make the model solution take much longer than usual.
Multiple moving loads may be assigned to a single load combination. However, they cannot be assigned
different "start times". If a delay between moving loads is required, it must be accomplished by adjusting the moving load pattern.
The load increment may be adjusted to "slow down" a moving load when multiple moving loads are
applied.

Moving Loads Results
Load combinations that contain a moving load, will step the moving load through the load path and perform a
solution for each position. The results are enveloped, giving maximum and minimum results of these solutions.
For these result spreadsheets, the maximum and minimum values are shown for each section location, for each
active member. The governing load combination and step location is also shown for each result value under the
"LC" column. The first number is the load combination, the second is the step number: (load combination - step
number).

Step Location
The step location tells you where the moving load was located along the moving load path when the maximum or
minimum result value was obtained. This can help you recreate the static model to verify results.
The total number of steps is calculated as follows:

Note
l

The results for every load position are not stored; just the maximums and minimums. Therefore the program is unable at this time to give a detail report solution for the moving load results. However this is an
enhancement that we do plan on adding in the future.

Moving Load Step Point Load Generation
Because solving moving loads produces so much output (full model design at each moving load step increment), the
output is limited to Enveloped results. This means that the moving load results only show the maximum and
minimum values for each output result value.
However there are times when you may want to investigate the full model design (all member results, detail
reports, deflected shape, etc.) at a specific step. You can easily create a static load case of the moving loads at a
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specific load step using the Point Loads from a Moving Load feature. You can access this feature by clicking the
Point Moving icon in the Home tab.

Instructions to use this feature:
1. Determine which moving load step you want to investigate.
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2. Access this feature by clicking the Point Moving icon in the Home tab.
a. Select which Basic Load Case you want the static point loads to be added to.
b. Select which Moving Load or Load Combination with a moving load you want the point loads generated from.
c. Select the Moving Load Step you want the static point loads generated from.

3. Click Apply.

4. Create a Load Combination that includes the Basic Load Case selected in step #2a above and solve to see the
full results.
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Loads - Thermal Loads
You can model the effects of temperature differentials in members and plates. For members, these loads cause the
axial expansion or contraction of the member along its length, i.e. axial stress only. The temperature is assumed
constant across the member's depth. For plates, these loads cause an in-plane expansion or contraction of the plate.
The temperature is assumed constant through the thickness of the plate.

Note
l

The internal axial deflections for beam members are the average of the end deflections for thermal loads.

To Apply a Thermal Load

1. Select the members you wish to assign a thermal load.
2. On the Home tab, click the Draw Line Load button or the Draw Plate Surface Load button.
3. Define a distributed load with a direction of T and a magnitude, in temperature.

Note
l

l

You may also specify or edit thermal loads in the Distributed Loads Spreadsheet or the Plate Surface
Loads Spreadsheet.
An easy way to do thermal loadings is to define the joint temperatures (on the Joint Coordinates Spreadsheet) as all zero, so any defined thermal loads are the full stress inducing temperatures.

Recording Thermal Loads for Members
The Coefficient of Thermal Expansion (α) is entered on the Materials spreadsheet. Note that this value is entered
per 100,000 degrees (it is sometimes listed per 1,000 degrees).
The joint temperatures recorded on the Node Coordinates spreadsheet define the ambient thermal state of the
structure. Thermal loads, entered as distributed loads on the Distributed Loads spreadsheet, induce axial stress in
the member.

The difference between the applied thermal load and the ambient temperature is the stress inducing temperature.
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Since you can define start and end locations for the thermal load, you can define up to three separate thermal
regions. Interpolating from the I-end temperature to the start thermal load for the first region, from the start
thermal load to the end thermal load for the second region and from the end thermal load to the J end temperature
for the third region.

Thermal Force Calculation
The joint temperatures recorded on the Node Coordinates Spreadsheet define the ambient thermal state of the
structure. The joint temperature at the I-end of the member is interpolated across to the J end temperature to
define the ambient state of the member. Thermal loads, entered as distributed loads on the Distributed Loads
Spreadsheet, induce axial stress in the member. The difference between the applied thermal load and the ambient
temperature is the stress inducing temperature.
Thermal forces are calculated thusly:
Ft = A*E*a*ΔT
Where,
Ft = Calculated Thermal Force
A = Member Cross Sectional Area
E = Elastic Modulus
a = Coefficient of Thermal Expansion
ΔT = Stress Inducing Temperature

Prestressing with Thermal Loads
Thermal loads provide a way to introduce pre-stressing in a model. Given a desired prestress force, just back-solve
the thermal force equation for the needed ∆T. Remember, as the model expands (or contracts), the prestress force
may be altered.
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Loads - Surface Loads
Surface loads are loads that are spread out over the surface of a plate element or wall panel. RISA-3D allows
surface loads directed along the global axes, the local axes, or projected in the direction of the global axes. Loads
may be input manually or assigned graphically. See Drawing Surface Loads below to learn how to draw surface
loads graphically.

Drawing Plate Surface Loads
To apply surface loads to plates enter the load direction and magnitude. Make sure that you are careful to enter the
correct BLC number that you want the loads assigned to. See Surface Loads above for more information on surface
loads.

To Apply Plate Surface Loads

1. Go to the Home Tab and click on the Plate Surface button to bring up the plate surface load information in
the Properties Panel.
2. Define the load in the Plate Surface Properties Panel. Use the dropdown menu to select load Direction, and
BLC. For help on an item, click
and then click the item.
3. You may apply the load by choosing plates on the fly or apply it to a selection of plates.
To apply the load to a few plates choose Click to Apply and click on the plates with the left mouse button.
To apply the load to a selection, choose Apply to Selected. If nothing is selected, Apply to Selected will
assume the full model is selected and apply changes to all plates.

Note:
l
l

l

You may also specify or edit surface loads in the Surface Loads Spreadsheet.
Applied surface loads are converted to equivalent corner joint loads based on the plate area tributary to
each corner joint.
You may undo any mistakes by clicking the Undo

button.
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Drawing Wall Panel Surface Loads
To apply surface loads to wall panels enter the load direction, start location (from bottom), height, and magnitudes
(top and bottom). Make sure that you are careful to enter the correct BLC number that you want the loads assigned
to. See Surface Loads above for more information on surface loads.

To Apply Wall Panel Surface Loads

1. Go to the Home Tab and click on the Wall Surface button to bring up the wall surface load information in
the Properties Panel.
2. Define the load in the Wall Surface Properties Panel. Use the dropdown menu to select load Direction, BLC,
load distribution (uniform or tapered), and load height (entire wall or partial). For help on an item, click
and then click the item.
3. You may apply the load by choosing wall panels on the fly or apply it to a selection of wall panels.
To apply the load to a few wall panels choose Click to Apply and click on the wall panels with the left
mouse button.
To apply the load to a selection, choose Apply to Selected. If nothing is selected, Apply to Selected will
assume the full model is selected and apply changes to all wall panels.
To apply tapered wall load, choose Tapered from Load Distribution dropdown menu, and specify Top
Magnitude and Bottom Magnitude.
To apply partial height wall load, choose Partial from Load Height dropdown menu, and specify load Start
Location and Height.

Note
l
l

You may also specify or edit surface loads in the Surface Load Spreadsheet.
You may undo any mistakes by clicking the Undo

button.
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Surface Loads Spreadsheet
The Surface Loads Spreadsheet records the surface loads for the plate/shell elements and wall panels, and may be
accessed by selecting select Surface Loads from the Data Entry menu in the Explorer panel. Alternatively, it can
be accessed by going to the Spreadsheets Tab Data Entry Surface Loads.

When you open this spreadsheet you may view only one basic load case at a time. Use the drop down list on the
toolbar to specify a different load case. The current load case is also displayed in the title bar at the top of the
spreadsheet.
Under the Plate Tab the first column contains the label of the plate to be loaded. The second column defines the
direction of the load. Direction options are discussed in the next section. The third column holds the magnitude of
the load.
Under the Wall Panel Tab the first column contains the label of the wall panel to be loaded. The second column
defines the direction of the load. Direction options are discussed in the next section. The third and fourth columns
hold the magnitude of the load. The fifth and sixth columns define the Start Location (bottom) and Height of the
load.
For loads that apply to the full height of the wall, leave the start location and height as zero.
The last column allows you to set the specified load as an "Active" load that will be considered for the analysis, or
an "Inactive" load that will not be included in the analysis.
For models integrated from RISAFloor, the Diaphragm Tab records the surface loads applied on the semi-rigid
diaphragm. These loads are automatically generated during the integration from RISAFloor to RISA-3D. These lines
will be grayed out because they cannot be edited from RISA-3D since they are tied to the RISAFloor analysis. If you
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detach the model from RISAFloor in RISA-3D, these loads will not carry over since semi-rigid diaphragms are a
feature only available for models integrated with RISAFloor.

Surface Load Directions
The direction code indicates the direction of application for the surface load. The following directions are available:

Direction
Code

Applied Direction

x, y, or z
X, Y, or Z
PY
PX
PZ
T

Element’s local x, y, or z direction.
Global X, Y, or Z direction
Projected in the direction of the global Y axis
Projected in the direction of the global X axis
Projected in the direction of the global Z axis
Thermal (temperature differential) load

The following diagram illustrates the difference between local (x, y, z) and global (X, Y, Z) direction loads. The local
direction loads line up with the element’s local axis directions, so their direction relative to the rest of the model
changes if the element orientation changes. Global loads have the same direction regardless of the member’s
orientation. Keep in mind that global loads are applied without being modified for projection. For example, a
global Y direction load of 1 kip/sq.ft. applied to an element with an area of 10 sq.ft., which is inclined at 45 degrees,
generates a total force of 10 kips.

Projected loads, on the other hand, are applied in the global directions, but their actual magnitude is influenced by
the element orientation. The load is applied to the projected area of the element that is perpendicular to the load.
For example, a "V" direction load is a projected load applied in the global Y direction. The actual magnitude of the
load is the entered magnitude reduced by the ratio A/Axz. "A" is the actual area of the element and Axz is the
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element's projected area on the X-Z plane, which is always less than or equal to the actual area. See the following
figure:

If the "Axis of Projection" in the figure is the Y-axis, then the shaded area is the total element area "projected" onto
the plane perpendicular to the Y-axis (which happens to be the X-Z plane). The total load generated is equal to the
input magnitude applied to the projected area. The generated load is then applied to the whole area, so the
generated load magnitude is reduced accordingly.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Area Surface Loads.

Surface Loads at Openings (Wall Panels)
When a surface load is applied to a wall panel with openings it is converted into equivalent nodal loads around the
openings. The example below is a wall panel with an opening, and a surface load applied to the lower portion of the
wall.
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The program calculates transient nodal loads according to the following approximation procedure:
1. The centroid of the union of the surface load and the opening is determined
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2. Using the centroid location, the surface load within the opening region is split into two parts
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3. Each of the two parts the surface load are summed up and smeared as point loads along the edge nodes of
the opening. The forces and moments are conserved with this approximation method. These generated nodal
loads are transient, and will be deleted when the solution result is deleted. These loads are not visible by
default, however if you would like to view them you can select Include Transient WP Loads under Model
Display Options. Below is an example:
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Load Generation - Notional Loads
Notional Loads are used by some building codes for the stability design of a structure. They serve as a minimum
lateral load, or as an alternative to modeling the actual out-of-plumbness or out-of-straightness of the structure.
Instead of changing the geometry of the structure, an equivalent de-stabilizing load is added to the structure. There
are numerical benefits to handling this out-of-plumbness issue with loads rather than geometry. Essentially, it is
quicker and easier to adjust the loading on a structure than it is to modify the stiffness matrix of the structure.
The implementation of these notional loads is not based on a single code, but on the concept of using lateral forces
equal to a percentage of the applied vertical load at each floor level. Codes that may require the use of notional
loads include the following:
l

l

l
l
l
l

ASCE 7: A minimum lateral load of 1% of the Dead Load of the structure should be applied at each floor
as a notional load.
AISC 360: A notional load to account for out-of-plumbness of the structure of 0.2% to 0.3% of the total
gravity load (DL + LL) should be applied at each floor as a notional load.
AS 4100: Has a default of notional load of 0.2%
NZS 3404: Has a default notional load of 0.2%
BS 5950: Has a default notional load equal to 0.5%
EC 1993-1-1: Has a notional load that can vary, but which will not normally exceed 0.5% of the applied
vertical load

These notional loads are normally only assumed to act for load cases which do not include other lateral forces.
However, the specific requirements of the individual code may require the use of these loads for other load cases
depending on the sensitivity of the structure to stability effects.
Notional loads can only be automatically generated for diaphragm/floor levels. The program will automatically
calculate the center of mass and use that point as the location to apply the Notional Loads.

Note
l

l

The Notional Loads generated by the program are calculated for Building Structures ONLY and may not
apply to non-building structures, horizontal trusses, towers, or other specialty structures.
Notional Loads are currently only supported for rigid or flexible diaphragms. Semi-rigid diaphragms are
not currently supported.

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Notional Loads.

Vertical Load used for Notional Force Calculations
The Weight of each diaphragm is the total tributary weight associated with it depending on the Load Combination
chosen for calculating these forces on the Notional Loads dialog box.
While computing the tributary weight at a particular diaphragm, the self weight of the members/columns and
plates between any two diaphragms is equally distributed amongst these diaphragms. Any weight, or load included
in the specified load combination, supported between diaphragms is distributed to the diaphragm above and below
in inverse proportion to its distance from each diaphragm.

Notional Load Generation Dialog
The notional load dialog only asks for a load combination and the % of gravity loads that should be applied in the
lateral direction. Notional loads are only generated for a single load combination. Therefore, the user is encouraged
to choose a load combination which includes the most severe loading.
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Notional Load Results
The program will only calculate the notional loads when the user selects Notional from the Advanced tab and
clicks Generate to create the X & Z Notional Basic Load Cases.

Notional Load Generation Input
This section displays all the relevant design data entered so that it can be included on a print out with the Notional
Load results.

Notional Generation Detail Results
This section displays all important calculated information such as the Weight associated for each floor level, the
Center of Gravity location for this weight and the notional load applied to each diaphragm or floor level. To add the
detailed results to the final print out, click the check box for Add to Full Report found in the Notional Load
Generation Input.

Note
l
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The Joints / Nodes used to apply seismic load may appear as a "floating joint" at that diaphragm level.
While these nodes may not be attached to any beams or framing, they are attached to the diaphragm at
that floor level.
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Building Seismic Loads can be automatically generated according to the equivalent static methods of the following
codes:
l
l
l
l
l
l
l
l
l
l
l
l

ASCE 7-2016 / IBC 2015 / IBC 2018
ASCE 7-2010 / IBC 2012
ASCE 7-2005 / IBC 2006 / IBC 2009
ASCE 7-2002 / IBC 2003
IBC 2000
1997 UBC
2001 CBC (California Amended UBC)
Mexican NTC-04
Indian IS 1893:02
Canadian NBC-2015
Canadian NBC-2010
Canadian NBC-2005

Seismic load can only be applied at diaphragm/floor levels. The program will automatically calculate the center of
mass and the 5% accidental eccentricity for the various seismic load cases.

Note
l

l

The Seismic Loads generated by the program are calculated for Building Structures ONLY and may not
apply to non-building structures.
The Seismic Loads generated by the program consider accidental eccentric loading as well. If you plan on
using the Load Combination Generator in the Load Combinations spreadsheet, you must use the "X and Z
w/Eccentric" Seismic Load option. Otherwise the eccentric BLCs that have been generated will never
actually be applied.

Seismic Weight
The Seismic Weight of each diaphragm is the total tributary weight associated with it depending on the Load
Combination chosen for calculating these forces on the Seismic Loads dialog box.
While computing the seismic weight at a particular diaphragm, the self weight of the members/columns and plates
between any two diaphragms is equally distributed amongst these diaphragms. Any weight, or load included in the
specified load combination, supported between diaphragms is distributed to the diaphragm above and below in
inverse proportion to its distance from each diaphragm.
The total seismic weight of the whole structure is the sum of the seismic weights associated with all diaphragms
and the weight associated with the base level. The base shear is always computed using the total seismic weight.
The total seismic weight can be viewed using the Scaling Factor Dialog. To get here click the
button in the Load Combinations spreadsheet.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Diaphragms.

Seismic Design Parameters
The parameters used in the seismic calculations may be viewed or changed by selecting Seismic from the Load
Generators section of the Advanced tab.
In RISA-3D, the weight used for the calculation of seismic loads is based solely upon the Load Combination specified
as the Seismic Weight LC entered in the Seismic Loads Dialog shown below:
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For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Generate Seismic.

Seismic Load Parameters
Code currently allows you to choose the code which will be used for seismic load generation. For reference,
sections of the 2016 edition of ASCE 7 will be cited to explain the various entries.
T represents the input natural periods in each lateral direction. These would typically be determined from an
eigensolution analysis. If these values are not entered, then the program will calculate this using the Approximate
Fundamental Period as defined in section 12.8.2.1 of ASCE 7-16. This value is entered for each of the Global
horizontal directions.
Ctis the building period coefficient as defined in 12.8.2.1 of ASCE 7-16. It is used in conjunction with the Ct
exponent "x" to determine the Approximate Fundamental Period. These are defined for each of the Global horizontal
directions.
Note:
l

You can either input the period manually in the Global horizontal directions, or you can input Ct and the Ct
exponent "x" and the program will use Eq. 12.8-7 of the ASCE 7-16 for calculation of the period.

R is the Response Modification Factor as defined in table 12.14-1 of ASCE 7-16. It provides a reduction for the
design seismic force based on the ductility of the system. This is defined for each of the Global horizontal directions.
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Note:
l

The program offers a single R value input in each direction. There are situations where the lower portion of
the structure may have a different R value than the upper portion. This can be typical with a concrete pedestal supporting a wood structure. In this case, two sets of load combinations would be created, one set in
which only the Wood design check-box would be checked in the Load Combinations spreadsheet and one set
in which only the Concrete design check-box is checked. In this case, the R value for the concrete pedestal
would be input in the Seismic Load generator. Then, in the Load Combinations spreadsheet, the wood load
combinations would have their seismic load factors factored by the ratio of the wood R value over the concrete R value. In this way, the two R values can be taken into account in the same direction.

Base Elevation determines the height at which the structure is assumed to be connected to the ground. This is
important for hillside structures or structures with sub-grade floor levels. A certain amount of structure self weight
may be associated with base level (or sub-grade levels) of the structure. The Add Base Weight check-box
determines if that self weight will be added into the base shear to be distributed as lateral force through the height
of the structure per section 12.8.3 of ASCE 7-16. If no elevation is chosen for base elevation, then the lowest joint in
the structure will be assumed to be the base elevation.
Risk Categoryis used to determine the importance factor assigned to the structure per table 1.5-2 of ASCE 7-16.
SD1 represents the 5% damped spectral response Design acceleration for a 1.0 second period.
SDS represents the 5% damped spectral response Design acceleration for short period response.
S1 represents the 5% damped spectral response Mapped acceleration for a 1.0 second period.
TL represents the point at which the structural response is assumed to transition from a velocity controlled
response to a displacement controlled response. These values are shown on Figures 22-14 through 22-17 in the
ASCE 7-16.
Seismic Weight LC is used to dictate which load combination should be used to define the weight of the structure
when the seismic event is assumed to occur. In ASCE 7-16 this would be based on the criteria in section 12.7.2.

Seismic Load Results
When you activate RISA-3D via the Director Menu, the program will calculate the appropriate seismic loads and
present the calculations in a printable report. You may open the seismic load generator at any time to view, print,
or recalculate the seismic loads.

Seismic Generation Input
This section displays the user all the relevant design data entered so that it can be included on print outs with the
Seismic Load results.

Seismic Generation Detail Results
This section reports the values used to obtain the Base Shear in each of the two global directions.
TXand TZ are the periods which was actually used to determine an upper limit for Cs in equations 12.8-3 and 12.8-4
of ASCE 7-16 (if applicable). A user defined period can exceed the upper limit period.
Ta is the approximate period calculated per equation 12.8-7 of ASCE 7-16.
TLimit is the maximum allowable period to be used in equations 12.8-3 and 12.8-4, calculated per Table 12.8-1 of
ASCE 7-16.
Importance Factor is determined from Table 1.5-2 of ASCE 7-16, based on the specified Risk Category.
Design Category is determined in Section 11.6 of the ASCE 7-16 and reported here.
V (Base Shear) is calculated using the Governing Equation listed next to it.
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Governing Equation is the equation which was used to calculate the base shear. This is typically from 12.8 of ASCE
7-16.
CS is the seismic response coefficient used to calculate the seismic base shear, V.

Seismic Generation Force Results
This section displays information used in distributing the seismic force to each diaphragm or story level. This
includes the calculated Height and Weight of each diaphragm, the calculated Force in each horizontal direction
and the calculated location of the Center of Gravity of the diaphragm (CG).
Note:
l

In ASCE 7-16 there is no required seismic loading required for structures which fall under Seismic Design
Category A. Instead, notional loads should be applied.

Seismic Generation Diaphragm Results
This section displays information used in calculating the accidental torsion values. This includes the Width and
Length of each diaphragm and the distance used for the accidental eccentricity.

Note
l

l

l

The magnitudes of the seismic loads are based on the settings under the Seismic tab of the Model Settings dialog.
The Joints / Nodes used to apply seismic load may appear as a "diamond" shape pattern of unattached
nodes at that diaphragm level. While these nodes may not be attached to any beams or framing, they are
attached to the diaphragm at that floor level. To get rid of these nodes, it is necessary to re-run the Seismic force generation with the design code set to NONE.
Any equations based on NON-building structures are not currently taken into account for the seismic
load calculations.

Semi-Rigid Seismic Loads
When running a combined RISAFloor/RISA-3D model the program has the ability to create Semi-Rigid Seismic loads
and apply them to the diaphragm. The seismic load is calculated by taking the Total Seismic Weight and converting
it into a horizontal direction by multiplying by the seismic response coefficient Cs.
The program will apply a Diaphragm Surface load which represents the seismic contribution of the Slab weight and
any additional Dyn Load. There will be horizontal point loads and line loads at the top of the columns and walls
which represent their respective contribution of the seismic weight. Any point, line or area loads that are "Dyn
Mass" will also be converted as horizontal seismic load applied directly to the diaphragm. Below shows an example
of the Earthquake loads applied into a simple L-shaped building.
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Note
l

l

For a RISA-3D only model you will need to manually apply your loads and build your diaphragm with
plates. See the Semi-Rigid Diaphragms section for more information on this.
Any Openings in the slab (Concrete Floor Slabs) will have the self weight correctly accounted for.
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Load Generation - Wind Loads
"Building" Wind Loads can be automatically generated per the following codes:
l
l
l
l
l
l
l
l
l
l
l

ASCE 7-16
ASCE 7-10
ASCE 7-05
ASCE 7-02
ASCE 7-98
ASCE 7-95
NBC 2015 (Canadian)
NBC 2010 (Canadian)
NBC 2005 (Canadian)
NTC 2004 (Mexican)
IS 875: 1987 (Indian)

Note:
l

The wind load generator creates Basic Load Cases. You must generate wind load combinations to have the
wind loads actually applied to the structure.

Wind Load Parameters

The parameters used for automated wind load generation may be viewed or changed by clicking the Wind icon in
the Advanced tab within the ribbon toolbar. These settings may also be changed when the wind load dialog pops
up when transferring between RISAFloor and RISA-3D.
The parameters and results shown below are specific to ASCE 7-16, however the concepts apply to all wind codes.
For questions specific to other wind codes contact RISA Technical Support.
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RISA-3D Wind Load Options
Code specifies which code will be used to generate the loads.
Wind Speed (V) is used to calculate wind pressures. See ASCE 7-16, Section 26.5.1
Exposure Category is used for multiple wind load calculations, and is defined in ASCE 7-16, Section 26.7.3
Base Elevation defines the elevation that the program considers as the "ground elevation". This is typically used
for structures which have basements, or base coordinates other than 0.
Gust Stiffness is used in the calculation of the Gust Effect Factor. See ASCE 7-16, Section 26.11. (NOTE: This is only
available for ASCE 7-16 & ASCE 7-10).
Fundamental Frequency is used in the calculation of the Gust Effect Factor and can be modified when the Gust
Stiffness is set to Flexible.
Damping Ratio is also used in the calculation of the Gust Effect Factor. This option will appear and can be modified
when the Gust Stiffness is set to Flexible.
Gust Factor (G) is explained in ASCE 7-16, Section 26.11 and depends on the Gust Stiffness setting. See Gust Effect
Factor.

Site Parameters
Topographic Factors (K1, K2, K3) are used to calculate the Topographic Factor (Kzt) per ASCE 7-16, Section
26.8.2.
Directionality Factor (Kd) is used to calculate wind pressures. See ASCE 7-16, Section 26.6.
Ground Elevation Factor (Ke) is calculated per ASCE 7-16, Section 26.9 using Table 26.9-1 (note: Per ASCE 7-16,
Section 26.9, Ke is permitted to equal 1 for all elevations). This option will appear and can be modified when ASCE
7-16 is selected.
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Generate Roof Wind Loads is only present in RISA-3D models which are integrated with RISAFloor. This toggles
the automatic generation of sloped roof wind loads.

Wind Load Results
The program calculates the appropriate wind loads and presents the calculations in a printable report. You may
open the wind load generator at any time to view, print or recalculate the wind loads.
Changes made to RISAFloor models which are integrated with RISA-3D models will be reflected in automatically
updated wind loads when transferring between the programs.

Wind Generation Input
This section reports values which were directly or indirectly input from the Wind Load Parameters.

Wind Generation Detail Results
This section reports important values that were calculated using the Wind Load Parameters, as well as the height
and base elevation of the structure.
Importance Factor is calculated using the input Occupancy Category.
Exposure Constant Alpha (α) is determined from ASCE 7-16, Table 26.11-1 based on the input Exposure Category.
Exposure Constant zg is determined from ASCE 7-16, Table 26.11-1 based on the input Exposure Category.
Topographic Factor (Kzt) is calculated per ASCE 7-16, Section 26.8.2 using the input Topographic Factors (K1, K2,
K3)
Ground Elevation Factor (Ke) is calculated per ASCE 7-16, Section 26.9 using Table 26.9-1 (note: per ASCE 7-16,
Section 26.9 Ke is permitted to equal 1 for all elevations)
Mean Roof Height (h) is determined as illustrated below:

Exposure Coefficient (Kh) is calculated per ASCE 7-16, Table 26.10-1 at the mean roof height as illustrated above.
The Exposure Constants (zg, α) are used in conjunction with the formula in Table 26.11-1, Note 2 to calculate the
Exposure Coefficient.
Windward Pressure Coefficient (Cp) is calculated per ASCE 7-16, Figure 27.3-1. The wind load generator always
sets this value at 0.8 per ASCE 7-16, Figure 27.3-1.
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Mean Roof Velocity Pressure (qh) is calculated per ASCE 7-16, Section 26.10.2. The input Directionality Factor
and Wind Speeds are used.
Parapet Wind Pressure Coefficient (GCpn) is calculated per ASCE 7-16 Section. 27.3.4 for both windward and
leeward directions.

Gust Effect
When the Gust Stiffness is set to Flexible, this section reports the values used in the calculation of the gust effect
factor.
Gust Effect Factor(G) is explained in ASCE 7-16, Section 26.11. Gust Effect Factor depends on the Gust Stiffness
input setting (NOTE: This is only available for ASCE 7-16 & ASCE 7-10).

l
l

When Gust Stiffness is set to Rigid, the Gust Factor is automatically set to 0.85.
When the Gust Stiffness is set to Flexible, the Gust Factor is calculated per ASCE 7-16 Eqn (26.11-10).
o You must input the damping ratio and fundamental frequency for the flexible calculation.
o Your fundamental frequency must be less than 1 Hz per ASCE 7-16 section 26.2.
o Variables z
bar, c, l, epsilonbar, bbar, alphabar are determined from ASCE 7-16 Table 26.11-1.
o I
is
calculated
per ASCE 7-16 Eqn (26.11-7).
z-bar
o L
is
calculated
per ASCE 7-16 Eqn (26.11-9).
z-bar
o V
is
calculated
per ASCE 7-16 Eqn (26.11-16).
z-bar
o Variables g and g are taken as 3.4 per ASCE 7-16 section 26.11.5.
Q
v
o g is calculated per ASCE 7-16 Eqn (26.11-11).
R
o N is calculated per ASCE 7-16 Eqn (26.11-14).
1
o R is calculated per ASCE 7-16 Eqn (26.11-13).
n
o R is calculated per ASCE 7-16 Eqn (26.11-15).
h
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o
o
o
o
o

QX and QZ are calculated per ASCE 7-16 Eqn (26.11-8) for each horizontal direction.
RBX and RBZ are calculated per ASCE 7-16 Eqn (26.11-15) for each horizontal direction.
RLX and RLZ are calculated per ASCE 7-16 Eqn (26.11-15) for each horizontal direction.
RX and RZ are calculated per ASCE 7-16 Eqn (26.11-12) for each horizontal direction.
BX and BZ, LX and LZ are the width and lengths of the floor diaphragms for each direction. B is the
dimension normal to the direction of the wind, L is the dimension parallel with the direction of the
wind.

Wind Generation Floor Geometry Results
The wall geometry used to calculate the wind loads is reported here.
Floor Level is the name of the Floor from RISAFloor. Multiple diaphragms on the same floor will each be reported
separately. For sloped wall calculations the level will always be reported as "Sloped Roof".
Height is the height of each diaphragm above the input Base Elevation. For "Sloped Roof" floors from RISAFloor the
height reported is the height of the highest point in each diaphragm.
Exposure Coefficient (Kz) is the calculated exposure coefficient at the diaphragm elevation. For "Sloped Roof"
floors from RISAFloor the coefficient is calculated for the highest point in each diaphragm.
Width is calculated as the difference between the highest and lowest magnitude X-Coordinates on the diaphragm.
Length is calculated as the difference between the highest and lowest magnitude Z-Coordinates on the diaphragm.
Pressure Coefficient (Cp) is calculated per ASCE 7-16, Figure 27.3-1. The Height/Width and Height/Length ratios
(see above) are used to calculate leeward pressure coefficients.
If the level considered is not sloping and does not have a parapet then the results here will be a single line.

If a parapet exists at this level, then information regarding the parapet will be given as well.

If this level is sloping then there may also be a section giving the wind face information due to this sloping portion.

Sloped Roof Area is used to account for the wind load on walls which project above the base roof elevation due to
a sloping roof. This only occurs in models which are integrated with RISAFloor. The program determines area by
going from support-to-support finding vertical polygons along the slab edge, and calculating their projected area in
both the X and Z directions.
The area reported is the windward followed by leeward.
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Wind Generation Floor Force Results
The wind forces applied to each diaphragm are reported in this section.
Floor Level is the name of the Floor from RISAFloor. Multiple diaphragms on the same floor will each be reported
separately. For sloped wall calculations the level will always be reported as "Sloped Roof".
Velocity Pressure (qz) is calculated per ASCE 7-16, Section 26.10.2. The input Directionality Factor and Wind
Speeds are used.
Windward Pressure is calculated per ASCE 7-16, Section 27.3.1. The calculated Velocity Pressure and Pressure
Coefficient are used, as well as the standard Gust Effect Factor (0.85).
Leeward Pressure is calculated per ASCE 7-16, Section 27.3.1. The calculated Velocity Pressure and Pressure
Coefficient are used, as well as the standard Gust Effect Factor (0.85).
Force is calculated as the Length/Width (see above) of the diaphragm, multiplied by the tributary height of the
diaphragm, multiplied by the sum of the windward and leeward pressures. The additional "Sloped Roof" wall wind
force in RISAFloor integrated models is also added to this value for the Roof.
The tributary height of the diaphragm is defined as half the distance the diaphragm immediately above, and half the
distance to the diaphragm immediately below. At the roof the tributary height is just half the distance to the
diaphragm immediately below. At the lowest level of the structure the tributary height is half the distance to the
Base Elevation, as it is assumed that all wind load below that is tributary to the ground.
The Forces calculated for each diaphragm are applied as horizontal joint loads at the center of exposure, and four
"eccentric" points (per ASCE 7-16, Section 27.3.5). These joints form a diamond pattern, which can be viewed in the
model.
If the level considered is not sloping and does not have a parapet then the results here will be a single line.
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If a parapet exists at this level, then information regarding the parapet (and possibly the additional height of
multiple height parapets) will be given as well and the total force due to both the main wind force and the parapet
wind force will be summed.

If this level is sloping then information regarding the sloping area will be given as well and the total force due to
both the wind force below the eave and the wind force above the eave will be summed.

Note:
l
l
l

The Total value will be the magnitude actually applied in RISA-3D to this level.
For more information on parapets see the Parapet Wind Loading section.
For more information on sloping roof wind loads see the Sloping Roof section.

Parapet Wind Loading
When RISA-3D is integrated with RISAFloor then it is possible to define parapets for both wall panels and columns.
After parapets are defined the wind load generator will use these parapet heights to add additional wind loading to
the roof levels of your structure to include this parapet wind with the roof wind load. The total wind force,
including all parapets and the non-parapet wind, will be applied at the center of wind location in RISA-3D. Here we
will give some details as to how this works.

Display
The reporting was outlined above. However, the program will also give a Parapet Summary as well.

434

RISA-3D V20

Load Generation - Wind Loads

In this image you can see (to scale) where all the parapets in your structure are located. The base parapet
information has already been considered in the Base Parapet, so the only parapet information listed below the
image are for the parapets that extend above the Base Parapet. The GCpn for this portion of the parapets will be
assumed to always be windward. Each of these parapets is shown with the extra force above and beyond the Base
Parapet Height. The Force X & Z columns are once again added to the Base Parapet and the regular building wind to
give the total wind applied at that floor level.

Note:
l
l

Parapet widths do not include deck overhangs.
A simplifying assumption is made for these extended parapets that is summarized in the image below.
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Parapet Height Determination
Parapet height information is located in three places: the Floors, Columns, and Wall Panels spreadsheets. If a floor
has a Default Parapet Height set then all walls and columns at that level will have their parapet values set to that
value. This is considered the Base Parapet.

The walls and columns are physically extended. From here you can go to the Columns or Wall Panels spreadsheets
if you need to extend parapets above this base level. These values are the Top of Parapet Height. If this value is
higher than the Default Parapet Height then this component of win loading will show up in the Add'l Parapet
entry.

Note:
l

Limitations for slab-supported floors:
l Only the highest elevation floor in the structure can have a parapet.
l Parapets must be a uniform height around the entire slab edge and the height is defined in the Floors
spreadsheet.

For walls a parapet is defined along a line that defines the top of the wall. Thus, the area of the parapet is trivial.
For parapets defined by columns, however, we now have parapet heights at finite locations. In this case the
program will go "column to column" around the structure to determine the parapet height. The parapet height used
between columns is the SMALLER of the two values at each column. Below is an example of what this would look
like.
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Note:
l

l

A parapet can only be defined if it is along a deck edge. Any columns or walls that are either not along the
deck edge or are not the topmost element in the stack will not be allowed to define a parapet and NA will be
shown.
If there are re-entrant corners there may be a case where there is not a column at a corner location. In this
case a parapet height equal to the adjacent column/wall will be used in this area.

Code Criteria
Per the ASCE 7-16 Section 27.3.4, the velocity pressure at the top of the parapet shall be multiplied by a GCpn of
+1.5 for windward parapets and -1.0 for leeward parapets.

Note:
l
l

Older versions of the ASCE 7 have identical parapet considerations.
The Canadian codes (NBC 2015/10/05) do not have specific parapet treatment. The wind load section is also
very different from the ASCE 7 methodology. Thus, we do not consider additional parapet height for Canadian codes.
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l

l

The Mexican code (NTC 2004) gives nothing specific to parapets. However, the Mexican code lays out very
similarly to the ASCE 7 code. Thus, we are using the ASCE 7 methodology for this code, with a +1.5 GCpn
factor for windward parapets and -1.0 GCpn for leeward.
The Indian code (IS 875: 1987) specifies a parapet load factor of 2.25 GCpn, but they do not specify windward and leeward. We assume a +1.25 factor for windward and a -1.0 factor for leeward.

Windward/Leeward Pressure Considerations
Most codes prescribe a higher pressure on the windward parapet than the leeward parapet. Thus, parapet wind
loads may or may not be symmetric in each direction. The program will calculate the wind loads in both the
positive and negative directions and use the larger of the two. For rectangular structures it is very simple to
determine windward/leeward directions. However, a more complex structure can be more difficult. The image
below gives one example of how windward/leeward parapets are considered.

Note:
l
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For parapets that are non-orthogonal to the global axes, the program properly takes the projected area when
calculating wind areas.
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Sloping Floors with Parapets
In RISAFloor it is possible to slope the highest level in a structure. This can create "wind faces" due to these slopes.
Think of a monosloped structure. Above the eave you have triangular areas that are wind faces that the program
already calculates appropriately. If there are additional parapets to consider that occur as well the geometry can
become challenging.
Note that the program will look at both the +/- X and +/- Z directions to determine which direction has the higher
force and that is the force that will be used in the program.

Note:
l

All cases above are handled properly, except Case D. Because this would be a very odd scenario for a parapet
on a sloped roof, the orange area above would not be included in parapet wind load areas.

Here are some common conditions:
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Gabled Roof with No Vertical Wind Faces and Parapets

Here we have a sloping roof which will have perpendicular wind loads applied. This will occur. In addition there
will be additional horizontal loads due to the parapet.

Gabled Roof with End Vertical Faces and Parapets

In this case the triangular face is taken as a regular wind load and the additional triangular/polygon loads that are
due to the parapet (similar to Case A,B, or C) have their areas calculated and included as parapet loads.
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Monoslope Roof With Parapet

In this case there are triangular parapet wind areas on two sides (similar to Case C above) , a full parapet area on
one side, and no parapet on the backside. In the triangular parapet direction the wind areas are equal in each
direction thus the same value will occur in both directions. In the perpendicular direction the parapet is windward
and the sloped area is leeward in the positive direction, and vice-versa in the negative direction. In this case the
program will take the largest magnitude and apply it to your roof.

Gambrel Roof With Parapet
This is similar to the gabled with a slightly different geometry.

Partial Roof Levels
It is also possible to define partial roof parapets. The program will handle this scenario properly. Below we can see
that we have a lower level with parapets defined around the edges. Thus, for some of the length of the parapet
there is not a leeward parapet included.
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Mezzanine Levels (No Wind Loads)
You may designate any floor level as a mezzanine or "No Wind" level in the Diaphragms spreadsheet.

By checking this check box you are telling the program that the floor is to be ignored in the wind load calculations.
Note: When integrating a RISAFloor model into RISA-3D, this designation may only be set in the RISAFloor model. It
will show up as greyed out/unavailable in RISA-3D for integrated models, so you must go back to RISAFloor of you
want to change the selection.

Sloped Roof Wind Loads
When RISA-3D is integrated with RISAFloor the program is capable of automatically calculating the perpendicular
roof wind loads per ASCE 7-16, Figure 27.3-1. These loads are calculated using the mean roof height for each
diaphragm, the standard Gust Effect Factor (0.85), and a Roof Pressure Coefficient (Cp) for each roof plane.
The angle (θ) for each roof plane is taken as the angle between the roof plane and the horizontal plane, as projected
along the Global X and Z axes. To determine a Roof Pressure Coefficient the wind load is always assumed to act
"Normal to Ridge" with θ not less than 10°. Roof planes that do not meet these conditions will still be treated as
though they do.
Only the most positive values of Cp are used from the table in ASCE 7-16, Figure 27.3-1. The more negative values
typically result in less base shear within the Main Wind Force Resisting System, so they are ignored. Interpolation is
used between values given in the table.
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The sloped roof wind loads are applied as two-way Member Area Loads to each roof plane, and are created within
roof wind load Basic Load Cases.

Semi-Rigid Wind Loads
When RISA-3D is integrated with RISAFloor the program has the ability to create Semi-Rigid wind loads and apply
them to the diaphragm.. The wind load is calculated by taking the Windward and Leeward forces and distributing it
directly into the diaphragm as a linear load along the edge of the diaphragm. The Semi-Rigid Wind loads are placed
into the Basic Load Cases shown below with distributed loads. The distributed loads are displayed per slab and the
magnitude is shown but not editable. An example of the load distribution is shown on this L-shaped building.
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Note:
l

l

l

In order to use these loads you must create Load Combinations using these Semi-Rigid categories. The Load
Combination Generator will automatically create the LC's if the "Generate Semi-RIgid Loads?" is checked.
Check out Load Combination Generator for more information.
For a RISA-3D only model you will need to manually apply your loads and build your diaphragm with plates.
See the Semi-Rigid Diaphragms section for more information on this..
Parapet wind loads on semi-rigid diaphragms will also be added into these wind loads. Different height parapets are possible in different locations, however, the total magnitude of wind from the parapets is added uniformly to the non-parapet wind.

Other Considerations and Limitations
General
l
l
l

l
l
l

Each diaphragm receives a full wind load, with no shielding effects considered from other diaphragms.
The building is assumed to be fully enclosed with non-air-permeable cladding.
Internal wind pressure is ignored. Because it must apply outwardly or inwardly to every surface simultaneously, it would cancel itself out for wall wind loading.
Vertical uplift loads on flat roofs and flat portions of Mansard roofs are not included.
Roof overhangs are not addressed.
The same exposure is used for all wind directions.

ASCE 7-16
l
l
l
l
l

l

The Directional MWFRS Procedure (Chapter 27) is used for all wind load calculations
The "low rise" provisions of Part 2 of Chapter 27 are ignored
Components and Cladding loads are not calculated or applied.
The building is assumed to be "Regular Shaped" per the definition in Chapter 26
The building is assumed to not have response characteristics making it subject to across wind loading, vortex
shedding, or instability due to galloping or flutter.
The building is assumed to be located in a site for which channeling effects and buffeting in the wake of
upwind obstructions do not warrant special consideration.

ASCE 7-10
l
l
l
l
l

l

The Directional MWFRS Procedure (Chapter 27) is used for all wind load calculations
The "low rise" provisions of Part 2 of Chapter 27 are ignored
Components and Cladding loads are not calculated or applied.
The building is assumed to be "Regular Shaped" per the definition in Chapter 26
The building is assumed to not have response characteristics making it subject to across wind loading, vortex
shedding, or instability due to galloping or flutter.
The building is assumed to be located in a site for which channeling effects and buffeting in the wake of
upwind obstructions do not warrant special consideration.

ASCE 7-05
l
l
l
l

l
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Method 1 (Section 6.4) is not considered.
Method 3 (Section 6.6) is not considered.
The building is assumed to be "Regular Shaped" per the definition in Chapter 6
The building is assumed to not have response characteristics making it subject to across wind loading, vortex
shedding, or instability due to galloping or flutter.
The building is assumed to be located in a site for which channeling effects and buffeting in the wake of
upwind obstructions do not warrant special consideration.
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l
l

Special provisions for "Low-Rise Buildings" are not considered.
Components and Cladding loads are not calculated or applied.

NBC 2015
Note:
l
l
l

l

l

Both the static and dynamic wind procedures are considered.
Cp is calculated from Figure I-15 of the User's Guide - NBC 2015 Structural Commentary.
Ce is calculated from section 4.1.7.3.5 of the 2015 Building Code. Interpolation between low and rough terrain is not supported.
Cg is calculated from section 4.1.7.3.8 of the 2015 Building Code. Note that for the static procedure Cg = 2.0
always (for buildings as a whole and main structural members).
In the 2015 specification there is an experimental procedure as well. If your wind input criteria directs you
to this procedure we will give a note letting you know this and then continue with either the static or
dynamic procedure.

NBC 2010/2005
Note:
l
l
l

l

l

Both the static and dynamic wind procedures are considered.
Cp is calculated from Figure I-15 of the User's Guide - NBC 2010/05 Structural Commentaries.
Ce is calculated from section 4.1.7.1.5 of the 2010 Building Code. Interpolation between low and rough terrain is not supported.
Cg is calculated from section 4.1.7.1.6 of the 2010 Building Code. Note that for the static procedure Cg = 2.0
always.
In the 2010 specification there is an experimental procedure as well. If your wind input criteria directs you
to this procedure we will give a note letting you know this and then continue with either the static or
dynamic procedure.
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Material Properties
Material properties are defined on the Material Properties Spreadsheet and then are referred to as you build
section sets, members, and plates. You may perform analysis using any type of material; simply define the
properties for the material here. You may use up to 500 materials in a single model although most models will only
have one or two. For example, your model might be made up of members of various grades of steel along with
different concrete materials, timber or aluminum.

Material Properties Spreadsheet
The Material Properties Spreadsheet records the material properties to be used in the model and may be
accessed by selecting Materials from Data Entry toolbar in the Explorer panel. The entries are explained below.

The values for A36 steel are the default material set. You of course don't have to use the A36 properties; you can
change these and also add as many other materials as you need. You may then save your preferred materials as the
default materials by clicking the Save as Defaults

button on the Spreadsheets tab.

Label is the material label you wish to use to describe the entered material properties. This label is how you will
reference the set of properties later when defining section sets, members, and plates.
E is Young's modulus that describes the material stiffness.
G is the shear modulus and may be left blank if you would like it calculated automatically. The equation for “G” is:

Note
l

l

If you enter a value for Shear Modulus that does not match the value calculated using the above equation
you will be given a warning.
The default Plywood material has a much lower G value than the formula above would suggest. This is
because plywood is NOT an isotropic material. Also, the generic value (from the NDS or APA's Plywood
Design Specification) has been reduced somewhat to account for assumed nail slip.

Nu is Poisson's ratio. Besides being used for the “G” calculation, this value is also used for shear
deformation calculations. The value of Poisson's ratio may not exceed '0.5'.
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Therm is the coefficient of thermal expansion and is entered per 10^5 (100,000) degrees. This coefficient is used in
the calculation of thermal loads.
Density is the material density and is used in the calculation of the member and plate self weight. This density
times the area gives the self weight per unit length for the members; density times plate volume gives the total
weight of a given plate.
Yield is the yield stress and is used only for Hot Rolled and Cold Formed steel design.

Hot Rolled Specific Material Data
The Hot Rolled tab records a number of hot rolled steel specific material properties that do not exist for the other
materials. These entries are described below:

Ry is the ratio of the expected yield stress to the specified minimum yield stress. This value is used in determining
the required strength of an element for the seismic detailing checks.
Fu is the specified minimum tensile strength. This value is used per AISC 358 to calculate Cpr which is in turn used
to calculate the probable maximum moment at a plastic hinge in the seismic detailing calculations.
Rt is currently not used by the program. In a future version of the program this value will be used to calculate the
expected tensile strength for the seismic detailing checks.

Cold Formed Specific Material Data
The Cold Formed tab records a cold formed material property that may not exist for the other materials. This entry
is described below:

Fu (Ultimate) is the ultimate tensile stress.
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Wood Specific Material Data
The Wood tab records a number of wood specific material properties that do not exist for the other materials.
These entries are described below:

Type - Currently there are four wood types available: Solid Sawn, Glulam, SCL (this includes LVLs), and Custom.
Database - Based on your Type selection, the Database menu will filter to the appropriate databases.
Species - Based on your Database selection, the Species menu will filter to the appropriate databases. This is the
wood species designation from your selected design code.
Grade is the wood grade designation from your selected design code. This has a drop down list where you can
select the appropriate grade.
The Cm check-box determines if the wet service / moisture content factor should be applied. If you put a check in
the Cm field, the appropriate factors will be applied to the allowable stresses and Young’s Modulus (E).
The Ci check-box determines if the incision factor should be applied. If you put a check in the Ci field, the
appropriate factors will be applied to the allowable stresses and Young’s Modulus (E).
Emod is a factor that is applied to the Young’s modulus modifier to reflect the NDS Appendix F criteria. This is not
applicable to the CSA O86 design code.

Note:
l

Refer to Custom Wood to specify a custom wood material.

Commercial Species Groups:
When either the NDS 05/08, 12, 15, or 2018 wood design code is selected, the Solid Sawn Species menu lists two
new species listed that are not specifically shown in the NDS code. These are the Commercial Species Group I - DF/SP
and Commercial Species Group II - HF/SPFe Fir. These are meant to be simplified groupings of the most commonly
used wood species. It is meant to simplify the selection procession for wood member design in the United States.
The design values for Group I take the NDS allowable stress values for two of the most widely used species (Doug
Fir-Larch and Southern Pine) and uses the lower bound allowable stress value for each size and grade. To verify
exactly what base allowable stress values were used, the user may review the properties in the Shape Selection
dialog.
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Similarly, the design values for Group II take the allowable stress values for Hem Fir and Spruce-Pine-Fir and use
the lower bound allowable stress values for each size and grade. To verify exactly what base allowable stress values
were used, the user may review the properties in the Shape Selection dialog.

Concrete Specific Material Data
The Concrete tab records a few concrete specific material properties that do not exist for the other materials. These
entries are described below:

f'c is the concrete compressive strength used for concrete design.
Lambda, λ is the lightweight concrete modification factor. This factor only applies to the ACI 318-14, ACI 318-11,
ACI 318-08 and CSA A23.3-04 codes. For all other codes the Density value of the material determines any strength
reduction. The program will automatically calculate the correct value if it is left blank. Only values between 0.75 and
1.0 will be considered.
Flex Steel is the reinforcement yield strength for flexural bars in members and vertical bars in walls. Shear Steel is
the reinforcement yield strength for shear bars in members and horizontal bars in walls.

Masonry Specific Material Data
The Masonry tab records masonry specific material properties. Here we will describe items that do not exist for
other materials.

Masonry Self Weight can be accounted for by two different methods. Entering a number for the density will result
in masonry walls which have a self weight equal to that density multiplied by the wall cross-sectional area.
Otherwise, click within the cell to launch the masonry self weight dialog:
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Set the Using Block and Grout Properties option to have the program automatically calculate the self weight of
the wall using the weights from tableB3 of the Reinforced Masonry Engineering Handbook (RMEH). The self weight
will be listed as Custom.
f'm is the masonry compressive strength used for masonry design.
Flex and Shear Steel are the rebar yield strengths for flexural and shear bars used to reinforce the masonry.

Note:
l
l

Masonry Shear Steel is automatically set to the Flex steel strength.
Masonry materials are used only for walls in wall footings. See the Wall Footing Definitions
spreadsheet for more information.

Aluminum Specific Material Data
The Aluminum tab records a number of aluminum specific material properties that do not exist for the other
materials. These entries are described below:

Table B.4 is the table that refers to the Buckling Constants for a series of Temper designations. This column has a
drop down list where you can pick from Table B.4.1 equations or Table B.4.2 equations.
Note: This table is named Table 3.3 in ADM 05 and this column has a drop down list where you can pick from
Table 3.3-3 equations or Table 3.3-4 equations.
kt refers to coefficient for tension members listed in the ADM 10 Table A.3.3.
Ftu is the specified tensile ultimate strength.
Fty is the specified tensile yield strength.
Fcy is the specified compressive yield strength.
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Fsu is the specified shear ultimate strength.
Ct refers to Buckling Constant Intersection for Axial Compression in Curved Elements per Table B.4.1 and Table
B.4.2 ADM 10.

Stainless Steel Specific Material Data
The Stainless tab records stainless steel material properties. These entries are described below:

n is the specified Ramberg Osgood parameter used for determining secant modulus. See AISC DG27 Table 6-1.
Yield is the specified yield stress.
Fu is the specified ultimate tensile stress.

General Material Data
The General tab records general material properties. These entries are described below:

Plate Methodology is the behavior to use for plate analysis: isotropic or orthotropic. For more information, see
Orthotropic Behavior.
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Material Take-Off
Access the Material Take-Off spreadsheet by selecting it from the Results menu.

This spreadsheet shows material takeoff information for each material and shape in the model. For each material
the shapes are listed with the total length and weight. The total length and weight for each material is summed
beneath the listing of shapes.
The length listed is the sum of the lengths of all the members assigned to this shape. Member end offsets are
deducted from the length. The weight is the sum of the self-weight for all elements assigned to section set. This
weight is calculated as Area * Density * Length for each member, again with offset distances deducted from the
length.
For Concrete members and plates, the volume is shown rather than the length of the members.

Note:
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l

l

l

This material takeoff report is independent of the loads applied to the model, i.e. the applied loads do not
influence this report.
The number of pieces is reflective of the number of members of a particular size. For example, one double
angle will be counted as one piece, with the length being the member length, and the weight being that of the
double angle.
Plates are also included in the Material Take-Off.
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RISA-3D uses a Physical Member that is automatically sub-meshed into general-purpose beam elements. With the
use of the member End Releases you may define truss members or any other end condition for that matter. Member
data may be viewed and edited in three ways: graphically in a model view, in the Member Properties Panel, or in
the Members Spreadsheet. See Members Spreadsheet for descriptions of the member data. Design parameters for
steel, wood or concrete design are recorded on the material tabs of the Members spreadsheet and are discussed in
the Hot Rolled Steel - Design, Cold Formed Steel - Design, Stainless Steel - Design, Aluminum - Design, Concrete Design, and Wood - Design sections.

Drawing Members
To create new members you can draw them using a Drawing Grid, Project Grid, or drawing "dot to dot" clicking
existing joints. The member properties are specified in the Properties panel. You can set all of the member
properties up front or you can modify these properties after you draw the member. Graphically modifying
properties is discussed in the next section.

The Member Drawing Options are as follows:
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Draw Node to Node
Use the first mouse click to select the start node of the new member. Use the second mouse click to select the end
node of the new member. The tool will continue to draw node to node until you right-click to disengage.

Draw Node to Member/Wall
Use the first mouse click to select the start node of the new member. Use the second mouse click to select an
existing member which would contain the end node of the new member. ‘Offset’ is the offset of the end point of the
new member from the start node of the existing member.

Draw Member to Member
Use the first mouse click to select an existing member which would contain the start node of the new member. Use
the second mouse click to select an existing member which would contain the end point of the new member. ‘1st
Offset’ and ‘2nd Offset’ are the location offsets of the start and end nodes of the new member from the start nodes
of the existing members.

Draw Wall to Wall
Use the first mouse click to select an edge of an existing wall panel which will contain the start node of the new
member. Use the second mouse click to select an edge of an existing wall panel which will contain the end node of
the new member. ‘1st Offset’ and ‘2nd Offset’ are the location offsets of the start and end nodes of the new member
from the corner of the selected wall panel edge.

Draw Member/Wall to Node
Use the mouse click to select the existing member which would contain the start node of the new member. The new
member would have a length equal to ‘Length’. The new member would be created at an angle ‘Relative Angle’ to
the projection of the existing member on the horizontal plane (plane perpendicular to the vertical axis).
To Draw Members
1. If there is not a model view already open then go to the View tab and select the Open 3D Views button to
open a new view.
2. If you are not drawing between existing nodes, you will need to create a drawing grid or define nodes in the
Node Coordinates spreadsheet.
3. Go to the Home tab and press the Members button in the Draw Elements section.
4. Set the member properties in the Properties panel. You can specify the General Properties, Additional Properties, RISAConnection Properties, and Design Properties.
5. To start drawing members, click on nodes or grid intersections with the left mouse button. The coordinates
of the closest node or grid intersection to your cursor are displayed on the screen near your cursor.
The first click will define the I-end of the first member. The second click, and each click thereafter, will
define the J-end of the first member and also the I-end of the next member so that you may continue to
draw. To stop drawing, click the right mouse button. You may then start drawing somewhere else with the
left button.
The new members will be shown on screen and will be recorded in the Members spreadsheet.
6. To stop drawing altogether click the right mouse button or press the Esc key.

Note
l

You may also specify or edit members in the Members spreadsheet.

l

You may undo any mistakes by clicking the Undo
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Modifying Member Properties
There are a number of ways to modify members. You may view and edit the member data in the Members
Spreadsheet. You may also click a single member or select multiple members to view and edit its properties in the
Member Properties Panel. You can use the tools in the Modify tab to graphically modify the members in the
3D View.
The Properties Panel for members is discussed here which lets you modify the properties of members that already
exist in your model. To use this, you will select the members that you want to modify, select the member type from
the Selection Properties dropdown, then specify in the Properties panel the parameters you want changed. See
the Graphic Selection topic for more on selecting.

To Modify Members
1. If there is not a model view already open then go to the View tab and select the Open 3D Views button to
open a new view.
2. Click a single member or select multiple members that you wish to modify.
3. If you have multiple elements selected, specify which material type to view properties for using the Selection Properties dropdown in the Properties panel.
4. Set the parameters for the members within the Properties panel. If certain properties vary within your selection of members, the field will say Various.
5. You may choose to modify a single member at a time or an entire selection of members.
To modify a single member, click on the member in the 3D View to pull up the properties in the Properties
panel.
To modify a selection of members, select multiple elements in the 3D View and specify which type to view
properties for using the Selection Properties dropdown at the top of the Properties panel.

456

RISA-3D V20

Members

Note
l

You may undo any mistakes by clicking the Undo

button.

Member Properties
The parameters in the Member Properties section are the member label and length. The member length is defined
by the start and end node and cannot be edited from the Properties panel. You can modify members graphically in
the 3D View using tools on the Modify tab to modify the length.

Note
l

To relabel members first sort the Members Spreadsheet into the desired order, then select the Modify
tab Relabel All (or Relabel Selected) button Members.

General Properties
In the General Properties section of the Properties panel, you can specify the member parameters such as
member end release, material, and shape size. The parameters shown can be found in the Primary and Advanced
tab of the Members spreadsheet.
You can assign a shape by either using a Section Set or choosing a specific shape from the Shape Database.
If you assign a shape using a Section Set, several parameters like shape size and material will grey out and the
displayed values will be based on the Section Set. These parameters can be found in the Section Sets spreadsheet.
You can modify the general properties based on material type for a single member by clicking on a member or for
multiple members by selecting multiple members and selecting a material type from the Selection Properties
dropdown in the Properties panel.

Note
l
l

You may also modify members in the Members spreadsheet.
You can add a new Section Set by setting the Assign Shape parameter to Section Set and clicking the
triple dot next to the Section Set dropdown.
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Additional Properties
In the Additional Properties section of the Properties panel, you can specify the member parameters such as
member start and end nodes, physical or non physical member properties, and analysis offset. The parameters
shown can be found in the Primary and Advanced tab of the Members spreadsheet.
You can modify the general properties based on material type for a single member by clicking on a member or for
multiple members by selecting multiple members and selecting a material type from the Selection Properties
dropdown in the Properties panel.

Note
l

You may also specify or edit design parameters in the Advanced tab of the Membersspreadsheet.

RISAConnection Properties
In the RISAConnection Properties section of the Properties panel, you can view and define the connection rules
for your hot-rolled steel connection design to be used in conjunction with RISAConnection. The connection rule
parameters can be found in the RISAConnection tab of the Members spreadsheet. See the RISAConnection
Integration topic for more information.

Design Properties
In the Design Properties section of the Properties panel, you can specify the Hot Rolled, Cold Formed, Wood,
Concrete, Aluminum, or Stainless design parameters such as unbraced lengths and K factors. See Steel Design, Cold
Formed Steel Design, Stainless Design, Concrete Design, Aluminum Design, and Wood Design for information on the
design parameters themselves. The parameters shown are the same as those on the Hot Rolled, Cold Formed, Wood,
Concrete, Aluminum, or Stainless tab of the Members spreadsheet. The Seismic Design Rule can be found on the
Advanced tab of the Members spreadsheet and only pertains to hot rolled steel members.
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You can modify the design parameters based on material type for a single member by clicking on a member or for
multiple members by selecting multiple members and selecting a material type from the Selection Properties
dropdown in the Properties panel.

Note
l

You may also specify or edit design parameters in the Material Design Parameters tab of the Members
spreadsheet.

Material and Cross Section Properties
Member material and cross section properties may be assigned to a member in one of two ways – either directly by
specifying the shape and material explicitly, or by assigning a Section Set to the member. Section Sets allow you to
control properties for a group of members that share the same properties. Combining section sets with the Member
Redesign feature gives you great control over how new member sizes are picked and what members get updated.
Section sets must be used when the desired shape is not in the database or when steel redesign (optimization) is
desired. See Section Sets for more information.
All member properties may be assigned in the Properties panel either as you draw or later as a modification to the
members.

Members Spreadsheet - Primary Data
The Members Spreadsheet records the properties for the member elements and may be accessed by selecting
Members on the Spreadsheets Menu.
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The following data columns hold thePrimary data for the members:

Member Labels
You may assign a unique Label to any or all of the members. You can then refer to the member by its label. Each
label has to be unique, so if you try to enter the same label more than once you will get an error message. You may
relabel members at any time with the Relabel Members option on the Tools Menu.

Member End Joints
The I-Joint and J-Joint entries define the start (I-joint) and end (J-joint) locations of the member. The member local
axes are defined based on these joints. See Member Local Axes for more information.

K-Joint and X-axis rotation
These two parameters may be used separately or together to define the rotation of a member. See Member Local
Axes and Defining Member Orientation for more information.

Section / Shape
If you are explicitly assigning shapes to each member, then enter the database shape you wish to use for the
member. You can select this by clicking on the arrow in the cell. Alternatively, you may choose a section set to
represent the section properties, material properties, and re-design parameters.

Member Type
If you are explicitly assigning shapes to each member, then you may enter the member type that you wish to use.
The choices are Column, Beam, Vertical Brace, and Horizontal Brace.
Here are the main effects that the member type will have on your structure:
1) If you are using concrete, this will define the rebar layout (column vs beam) .
2) If you are using design lists, they specifically reference the member type.
3) If you are using member area loads, loads will not be attributed to members defined as Hbraces or Vbraces.
4) If you are using flexible diaphragms, transient loads will not be attributed to members defined as None, Columns
or Vbraces.
5) If you are using the RISA-Revit link the link will not work properly unless you use member types.
6) If you are integrating with RISAConnection, the connection validation requires proper use of member types.
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7) If you are using the seismic detailing provisions then you must use proper member types.

Note
l

If you are using Section Sets to define your member, then the information in this field will be generated
automatically based on the referenced section set.

Design List
If you are explicitly assigning shapes to each member, then you may enter the design list type that you wish to use.
This entry will affect the members that are available to program when it is suggesting alternate or optimized
shapes. Refer to Design Optimization for more information on the member optimization procedure. Also refer to
Appendix A – Redesign Lists for information on creating or editing these lists.

Note
l

If you are using Section Sets to define your member, then the information in this field will be generated
automatically based on the referenced section set.

Material
If you are explicitly assigning shapes to each member, then you may enter the material that you wish to use. You
can select this by clicking on the arrow in the cell.

Note
l

If you are using Section Sets to define your member, then the information in this field will be generated
automatically based on the referenced section set.

Design Rules
If you are explicitly assigning shapes to each member, then you may enter the design rules type that you wish to
use. When the program is checking alternate or optimized shapes, it will restrict its selections to members that obey
the chosen design rules. Refer to Design Rules– Size / U.C. for more information.

Note
l

If you are using Section Sets to define your member, then the information in this field will be generated
automatically based on the referenced section set.

Members Spreadsheet - Advanced Data
The Advanced tab records the properties for the member elements and may be accessed by selecting Members on
the Spreadsheets Menu.
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The following data columns hold the Advanced data for the members:

I and J Releases
Releases control the forces that may be resisted by a member. You may use these to define pinned connections,
truss members, and any other end condition. See Member End Releases for more information.

I and J End Offsets
End offsets may be used to model a rigid end zone for a member. See Member End Offsets for more information.

T/C Members
The T/C field is used to indicate that a member is to be Tension or Compression only. When a member is flagged as
C, any members it will only be able to take compressive loads. The member will have no stiffness to resist tensile
loads. When a member is flagged as T, the member will only be able to take tension loads. When a section is flagged
as E, the member will primarily take only tension loads, however it will also take some compression load, up to its
Euler buckling load.

Physical
This box is checked if the member is a Physical Member. See Physical Members for more information.

Defl Ratio Options
This option is only applicable to members designated as beams. This field is used to designate the member end
behavior either as supported or as a cantilever for the deflection ratio. If this field is blank, deflection ratio will be
based on original member behavior. See Deflection Ratio Options to learn more.

Analysis Offset
Members may be offset from their centerline for analysis. This is useful for members such as single angles bolted or
welded on only one leg, where axial compression also needs to induce bending. See Analysis Offset to learn more.

Inactive Members
Members may be removed from the solution without deleting them from your model by making them inactive. See
Inactive and Excluded Elements for more information.
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Seismic Design Rules
This entry may be used to assign a Seismic Design Rule to each member individually. This can be left as None if you
are not including seismic detailing in your design. This entry will only apply to Hot Rolled Steel members.

Members Spreadsheet - Detailing Data
The Detailing tab records the detailing data for the members that are necessary for full 2-way data transfer
between RISA and steel detailing packages. For more information on this subject refer to the Help file for the RISA
CIS/2 Translator which can be downloaded from our website.

Tension/Compression-Only Members
Members in RISA by default are allowed to take both tension and compression. However, some design or modeling
practices may require you to define specific members as either Compression Only or Tension Only. Here we will
define what each of the T/C Only options means.

Both Ways
This is the default behavior. In this scenario a member will be allowed to take either compression or tension and
the program will base the combined bending and axial code checks on these forces.

Tension Only/Euler Buckling
Tension-only behavior is just as it sounds. When a member is defined as tension-only the program will allow these
members to only resist tension forces. If the load path introduces compression forces into the member, then it will
be removed from the stiffness matrix and another solution will be run.

Note
l

l

To avoid stability issues, the program will allow the Tension Only member to resist a very small percentage
of compression in the member. By allowing the member to take 1e-8 of the member's stiffness in resistance
to compression, the program can avoid model instabilities which would be caused by removing the Tension
Only member all together.
Tension-only member code checks will ONLY consider axial tension. Bending forces will NOT be used when
computing code checks.

Euler Buckling
An option similar to tension-only is the Euler buckling option. This option is used as a replacement to tension-only
and allows a member to take up to the Euler buckling capacity of the member in compression before it is removed.
The reason for the Euler buckling option is that allowing tension-only members to take a little compression helps
model convergence greatly. Generally speaking, tension-only members are generally very slender members that
have a small Euler buckling capacity. The intent of this option is to allow a very small amount of compression to get
into your members so you don't get unstable models.
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Note
l

l

l

Euler buckling member code checks will ONLY consider axial tension. Bending and compression forces will
NOT be used when computing code checks.
You can control the amount of compression that an Euler buckling member takes by artificially increasing or
decreasing the Kl/r ratio that is used to calculate the Euler buckling load. The best way to alter the Kl/r ratio
is to modify the Lb parameters for that member on the Hot Rolled, Cold Formed or Wood tabs of the Members spreadsheet.
Using this option for members with high Euler buckling capacities is generally not appropriate and may lead
to unconservative results.

Compression Only
Compression-only behavior is just as it sounds. When a member is defined as compression-only the program will
allow these members to only resist compression forces. If there are tension forces then the member will be
removed and another solution will be run.

Note
l

l

To avoid stability issues, the program will allow the Compression Only member to resist a very small percentage of tension in the member. By allowing the member to take 1e-6% of the member's stiffness in resistance to tension, the program can avoid model instabilities which would be caused by ignoring the
Compression only member all together.
Compression-only member code checks will ONLY consider axial compression. Bending forces will NOT be
used when computing code checks.

Iterative Solution Considerations
When a model contains T/C only members, the program must iterate the solution until it converges. Each iteration
is a solution of the model. After each solution the program checks T/C only member forces. If a tension-only
member has compression then this member has it's stiffness reduced down to 1e-8% of it's original stiffness so it
will take no forces. If an Euler buckling member has a compression greater than its Euler buckling load this member
has it's stiffness reduced down to 1e-8% of it's original stiffness. If a compression-only member has tension then
this member has it's stiffness reduced in a similar fashion. After these member stiffnesses are reduced the stiffness
matrix is re-built and another solution is run.
In subsequent solutions members can have their stiffnesses both removed and added back in. Reducing the stiffness
of members is the identical process just explained. Adding member stiffness back in can occur for members that
have been previously reduced. The program will look at the distance between the end nodes which define the
previously reduced member. From this distance the program can calculate whether that member would now be in
compression or tension. Let's take a tension-only member that had it's stiffness reduced due to the presence of
compression in the first iteration. In the 2nd iteration if the distance between the nodes defining the member got
longer than it was in iteration one, this would signify that the member would now be in tension. Thus, for the next
iteration the program would place this member back in the stiffness matrix.
Because of this iterative solution, models with T/C only members can take a bit longer to solve than a regular static
solution.

Note
l

l
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If a member has it's stiffness reduced, it will still show up in the results. However, the forces and code checks
for this member will all be zero.
For X-bracing that is set to either tension-only or Euler buckling, do not place a node at the intersection of
these braces. You will likely have convergence problems in this case and receive error code 1162.
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Instability Considerations
For members defined as tension-only you can run into problems with instabilities for gravity-only LC's. For
example, let's take a look at an x-braced frame where the x-bracing is defined as tension-only. For a lateral load
combination, the tension-only feature works great.

In the image above we can see that the "compression" brace has no force in it because it has it's stiffness reduced in
the stiffness matrix and that all of the load is passing through the "tension" brace.
However, if we are looking at a gravity load combination, this results in an instability.

In this scenario the columns in this model undergo a small amount of axial shortening. This induces a small amount
of compression and both of the tension-only braces have their stiffnesses reduced. This results in a frame that is
unstable and illustrates the problem. The solution here is to use Euler buckling braces.
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In this case these braces are taking about 500 lbs of compression, a relatively small amount. As long as this value is
small then we can still consider these as tension-only members.

Note
l

Shear effects are considered for all T/C Only member options in separate code checks for shear.

Physical Members
Physical Members provide fixity to all joints that occur along the length of the member, without breaking that
member into multiple smaller members. You may use the physical member feature to avoid defining one 'field'
member with multiple members in your model. This saves time in building and editing your model and in
understanding your results.
To define a Physical Member, check the Physical Member box in the Set Member Properties settings or in the
Modify Member Parameters settings. You may also specify Physical Members in the Members Spreadsheet and
in the Member Information settings.
To understand the benefits of Physical Members see the trusses in the following figure. The first truss shows the
chords modeled without physical members and thus with multiple members modeling each chord. The second
truss models each chord with one Physical Member. Both models will yield the same results. However the Physical
Member model is more intuitive and easier to work with because you don’t have to work with multiple members
when you create the chords, load them, edit them or evaluate their results. Notice that the distributed load may be
defined from start to end for the Physical Member. In the other model the distributed load end magnitudes have to
be specified for each of five members in order for the entire load to be defined.
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Continuous beams, multi-story columns and truss chords are examples of continuous 'field' members that can be
modeled with one Physical Member. You may define them from start to finish without having to explicitly define
their connection to other elements or boundaries through intermediate joints. Subsequently, when it comes time to
make changes to a member you can edit the properties of one Physical Member rather than the multiple members
that might otherwise represent it.
Physical Members are also effective in managing results because the results for one Physical Member are reported
together in the results spreadsheets and the member detail report. With the truss example above the Physical
Member model allows you to look at results for one member making it easier to track maximum forces and other
values.

Note
l

l

You may convert a Physical Member into multiple members by removing the Physical Member property
and then performing a Model Merge to split the member for connectivity. See Model Merge for more
information.
You cannot convert multiple members into one Physical Member. To achieve this you must delete the
multiple members and define a new Physical Member.

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: What are Physical Members.

Member Local Axes
The following diagram illustrates the directions of the member's local axes that are used to define member forces,
stresses, and deflections as well as loads defined in local axes directions:

General Reference Manual

467

Members

As can be seen from the diagram, the local x-axis corresponds to the member centerline. The centerline designates
the member cross section's centroid location. The positive direction of this local x-axis is from the I-joint towards
the J joint. The complicated part is defining the orientation for the local y and z-axes. Of course, we only have to
define the direction for one of these two (y and z) axes. The third axis direction follows automatically based on the
directions of the first two.
If you do not explicitly define the orientation for a member, the default is for the member's local z-axis to lie in the
global X-Z plane or as near as possible. If the member is defined in the global Y-direction, the member's local y and
z axes both lie in the global X-Z plane, so the local z-axis is made parallel to the global Z-axis. This works well for
models with the Y-axis as the vertical axis because any beam members are typically oriented such that vertical
loads are resisted by the strong axis bending of the member. You can change the default orientation of the
members with the Model Settings. For example if your vertical axis is the Z-axis then you can specify the default so
that vertical loads are resisted by the strong axis bending of the member.

Defining Member Orientation
RISA-3D provides two ways to explicitly set the orientation of the y-axis. The first is by rotating the member about
the local x-axis. This member rotation is entered in the x-Axis Rotate column on the Member spreadsheet or may
be specified in the graphic editing tools. For this rotation, positive is counter-clockwise about the x-axis, with the xaxis pointing towards you.
The second way to explicitly define the orientation is by specifying a K joint for the member. If a K joint is defined
the three joints (I,J,K) entered for the member are used to define a plane. This plane is the plane of the member's x
and y-axes. The z-axis is defined based on the right hand rule using the x and y-axes. See below:
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Note
l

To be sure of a member’s orientation you can always view the rendered shape of a member by clicking
the

button on the Quick View toolbar on the Home tab.

Member End Releases
The I Release and J Release fields are used to designate whether the forces and moments at the ends of the
member are considered fixed to or released from the member's points of attachment (the I and J joints). Each
member has 6 force components at each end (axial, y-y & z-z shear, torque, and y-y & z-z bending). Any or all of
these force components can be released from the member's point of attachment. If a force component is released,
that force is not transferred between the joint and the member.
The partial fixity member end release option reduces the joint rotational stiffness about the member local y and z
axes. The linear stiffness of the connection is reduced by the rotational spring constant to utilize a partially
restrained connection, as opposed to a fully released or fixed connection.
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To specify member releases go to the I Release or J Release field for the member in the Members Spreadsheet on
the Advanced Tab, click the

button, and specify the condition.

Alternatively, you may specify the end condition by directly typing in the field. To indicate that a force component is
released, put a X for that component in the release field. You can move within the release field using the space bar
which will result in a O for no release.
RISA-3D has two special "keyword" release configurations built-in. These are:
AllPIN => Mx, My, Mz (all moments) released (OOOXXX)
BenPIN => My, Mz (bending only) released (OOOOXX)
If a Partial Fixity Option is selected, the keyword will show a P for the rotational restraint followed by the
rotational stiffness input.
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These keyword entries are included because 99% of the release configurations you'll ever want to define will be
one of these two (98% will be BenPIN). You can call out the keyword entry by just entering the first letter of the
keyword. So if you go to a release field and enter "bp", the keyword "BenPIN" will be filled in automatically.

Note
l

l
l
l

RISA-3D will not allow you to release the member torsion at both ends. This is because it will be
unstable as it would be free to spin about its centerline. For this reason, pinned end conditions should be
modeled using the "BenPIN" entry instead of "AllPIN".
A partial fixity end release cannot be combined with a member end offset.
Shear deformations are not considered for members with partial fixity end releases.
Tapered WF members cannot be used in conjunction with partial fixity end releases.

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: End Release.

Simpson Yield-Link
The Yield-Link is a prequalified connection developed and manufactured by Simpson Strong-Tie for steel special
moment frames. For more information about the Yield-Link Connections, click the link to visit the Simpson StrongTie’s website here.
Currently in the program Yield-Links can be added to steel beams as Member End Releases to include their partial
rotational stiffness in the analysis. The program calculates the rotational stiffness automatically based on the sizes
of the Yield-Link and the beam.
To add a Yield-Link to a beam, click on the ellipsis button next to the I Release or J Release field to open the Set
Member End Releases dialog. The Yield-Link size can be selected from the dropdown box under Simpson Yield-Link.

General Reference Manual

471

Members

When choosing a specific Yield-Link to use, the nomenclature for the definition of the release is as follows: YL42.25, where YL4 represents the Yield-Link stem thickness in eighths of an inch (ex. 0.5” = 4 x ⅛”) and 2.25 is the
width of the yield link (in inches). For new series of Yield-Link with longer lengths, the nomenclature can be as
follows: YL4-2.25-10, where the last number 10 is the longer length than standard links (in inches)
Users can also type in the Yield-Link size in the I Release or J Release field from either the Properties Panel or
the Members -> Advanced Spreadsheet. The nomenclature of Yield-Link (e.g. YL4-2.25) needs to be followed for
the program to recognize the input.
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The selection of Yield-Link size needs to meet the following requirements:
l
l

l
l

l
l

Yield-Link is only available for Hot-Rolled Wide Flange Beams.
Currently the maximum beam depth allowed for Yield-Link is W36. The minimum beam depth allowed for
Yield-Link range from W12, W16, and W24 depending on which Yield-Link series is used:
l YL4 series: Min. W12, Max. W18
l

YL4 longer series: Min. W12, Max. W27

l

YL6 series: Min. W16, Max. W27

l

YL6 longer series: Min. W16, Max. W36

l

YL8 series: Min. W24, Max. W36

l

YL8 longer series: Min. W24, Max. W36

The permitted beam flange thickness needs to be greater than 0.4 inch.
The permitted beam flange width and column flange width for any specific Yield-Link size can be found in
Simpson's Yield-Link Design Guide.
If Yield-Link is used on one end of a beam, the other end cannot have Fully Fixed or Custom Releases.
If Yield-Links are used on both ends of a beam, the link size must be the same at each end.

Note:
If the input Yield-Link size and beam size do not meet the above requirements, the program will ignore the YieldLink rotational stiffness during solution. A warning message will be given to indicate which requirement was not
met.
Once users have input the Yield-Link size, together with the Beam Size, the program calculates the rotational
stiffness of the Yield-Link and displays it in the I and J Release Edit dialog. This partial stiffness will be used in
solution for the model. The rotational stiffness calculation follows the following equations:
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With the Yield-Link defined, the wireframe model shows the member end release condition applied. The display
looks the same as custom end releases in the Mz direction, which is the same direction where the Yield-Link
rotational stiffness is applied.

After solution, the partial stiffness from Yield-Links can be viewed in the member Detailed Report under the I/J
releases.
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Deflection Ratio Options
The Beam Deflection Ratio can be used during member design to check the deflection criteria. By default, the
program will determine whether a member is a cantilever or is supported on both ends. In certain cases where the
beam should be considered otherwise, more control over these support types for a beam can be designated in the
Deflection Ratio Options. This feature is only applicable to members designated as "beams" and only affects the
beam deflection ratios located in the Beam Deflection tab of the Member Deflections spreadsheet.
The option to set the support type for the beam deflection ratio can be applied from any of the following locations:
l
l

Additional Properties section of the Properties Panel
Members Spreadsheet \ Advanced Tab

Clicking the

button in the spreadsheet brings up the following dialog box:
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Single span beams can be designated as supported on both ends, or cantilever on either I- or J- end. Multi-span
beams have an additional option to be cantilever on both I- and J- end. A double cantilever option is available for
multi-span beams since internal supports will support the beam. Designating member ends as either supported or
cantilever will affect only the beam relative deflection and also determine which equation is used when calculating
beam deflection ratios. See Beam Deflections.
For a member supported on both ends, the maximum relative displacement used in the beam deflection ratio will
be the largest straight line distance (in the vertical y direction) between the deflected shape and the original
undeflected shape.
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For members with a cantilever end, the location of the maximum relative deflection will be at the free end of the
member. The displacement value is equal to the rotation at the supported end multiplied by the length of the
member.
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Note
l

l

Designating specific member end support types for the beam deflection ratio will not affect global deflection or the member deflection ratios located in the Service and Strength tabs of the Member Deflections
spreadsheet.
For additional information on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in Search keywords: Deflection Ratio

Analysis Offset
The Analysis Offset feature allows a member to be offset from its centerline for analysis. When it is enabled the
member is actually shifted to the offset location for analysis. In order to provide connectivity the program places
hidden rigid links to connect the member to the nodes that define the member's I/J Joints. Joints which fall along a
physical member are also automatically connected to the member's actual analysis location via hidden rigid links.
An analysis offset can be applied from any of the following locations:
l
l

Additional Properties section of the Properties Panel
Members Spreadsheet \ Advanced Tab

Clicking the
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The blue dot represents where the member is drawn in the model, the shape represents where the shape will be
offset relative to the centerline. Therefore in the above image the wide flange is offset in a way to account for the
connections on this member being on the "vertical" (local y-axis) leg. In the below image the angle is offset in a way
to account for the connections on this member being on the "horizontal" (local z-axis) leg.

In this case there would be no practical application for using a -z axis or -y axis setting since neither leg would be
near the line that the member was modeled on.
The most common application for this feature is modeling non-symmetric braces where the centroid of the brace
does not align in the same plane as the columns/beams that the brace connects to. See the example below.
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Example
Consider a single angle brace that frames into a beam and column

In RISA-3D this would be modeled so that both the brace and the beam end connect to the same Joint, which the
column also passes through

When lateral load is applied to this frame with no analysis offset, the brace has a concentric axial force since its
centerline aligns with the centerline of the beam and column. This would be accurate for a double-angle brace, but
for a single angle brace the centroid of the brace is actually offset from the plane of the frame by a small but
significant distance. That offset eccentricity should cause a bending in the brace which accompanies an axial
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compression force in the brace. This can be accounted for by shifting the location of the brace to its true centroid
location.

In this case the brace should be shifted along its positive Local z-axis by a distance of z-bar (distance from centroid
to connected leg) plus half the gusset plate thickness. For a 3/4" gusset plate the analysis offset should be set to the
+z axis plus 3/8":

For analysis the program will move the brace outward and put in a rigid link. This rigid link is not visible in the
wireframe view, although the rendered view and deflected shape will both illustrate the offset location of the
member. Below is a reconstructed view of what the program actually uses for analysis in this example.
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The end result is that the brace bends in the out of plane direction when loaded with axial compression, which
matches what should occur for a single angle that is bolted on only one leg.

Unless both legs of the single angle are attached to the gusset in this example it is actually unconservative to omit
the analysis offset in the model, since bending will be ignored without it.
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Member End Offsets
Member offsets reflect the fact that the member ends may not be attached at the centerline of the member being
attached to. For example, a beam connected to the flange of a column is offset from the centerline of the
column. The distance of the offset would be ½ the depth of the column.
You may enter explicit offset distances or have them calculated automatically. To enter offsets explicitly simply
enter the value of the offset. To have the offset calculated, enter the non-numeric label of the member whose depth
defines the offset distance.
For example, say your member is framing into the flange of a 12" deep column. The offset distance would be 6", so
you would enter '6' for the offset. Now, if that column gets changed to a 14" shape, you would have to go back and
change the offset distance to 7". This can be time consuming if you have many offsets.
If instead the column has a label of M100, specifying M100 as the member offset causes the offset to be calculated
as half of the depth of the member M100. For the W12 column the offset would be 6" and when the column is
changed to a W14 the offset becomes 7".

Note
l

l

When you use a member label to define the end offset, this value is ALWAYS taken as simply the depth
of the member. Thus, if you are framing at an angle into a member or into the weak axis of a member
you should not use this feature.
When the model is solved the member length is adjusted in the stiffness matrix by the offset distance resulting in a shorter, stiffer member. Also the results listed for members with offsets do take into account
the offset distances. The I-end and J-end results are the results at the offset locations, and the report locations are determined by dividing the member length minus the offset distances by the Number Of Sections on the Model Settings.

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Offsets.

Inactive and Excluded Elements
Making an element, such as a member, plate or wall panel, inactive allows you to analyze the structure without the
item, without having to delete the information that defines it. This leaves data intact so the item may be easily
reactivated. This is handy if you want to try a frame with and then without certain items, without having to actually
delete the data.
Making an element Inactive means the item is not included when the model is solved or plotted.
Making an element Excluded means the item in the solution, but excluded from the results list. An excluded item
will be treated like any other member in the solution and plotting of the model, but the item will not be listed in the
solution results (forces, stresses, deflections, etc.). This is useful if there are certain items whose results you're not
interested in. You don't have to clutter up the results with these items and can concentrate on the items you're
most interested in. See Printing for more limiting printed results.

Note
l

When making elements inactive you may need to update the unbraced lengths of the adjacent members.

Member Shear Deformations
Including shear deformation models the effects of shearing forces on the lateral displacements of the members.
Shear deformation is included in the analysis by checking the Consider Shear Deformation box in the Solution tab
of the Model Settings.
Shear deformation effects are based on the material shear modulus (G) and the shear area.
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Including shear deformation causes the member stiffness matrix to be modified by the term M, where:

Where As = Area * Shear Deformation Factor
These shear area coefficients will be automatically calculated for all standard members, but must be entered for
arbitrary sections. While these shear deformation factors are always less than 1.0, they can vary from 0.85 for solid
rectangular shapes, to 0.88 for solid circular shapes, to 0.53 for thin pipes. These coefficients are used strictly for
shear deformation effects and should not to be confused with shear stress factors described in the next section. A
good reference for the calculation of both of these coefficients is Stress, Strain, and Structural Matrices by Walter
D. Pilkey.
For members whose length is much greater than the depth, shear deformation has a relatively minor impact. When
the length of the member is less than 10 times its depth, shear deformation begins to have a significant impact on
the solution. Keep this in mind if you are creating models where members are being broken up into several pieces
because the length used to calculate the term M is the joint-to-joint member length.

Note
l

l
l

Shear deformation effects are included for the joint deflections only and not for the internal member
deflections.
Shear deformation effects are included for joint loads and not for member point loads.
Shear deformation can play a significant role in the stiffness of the member and thus the results.

Member Shear Areas
The equation for calculating shear area varies for different shape types:
l
l
l

l

For WT, LL, L, Av =(depth*thickness)/1.2
For channel, Av =(depth*thickness)/1.0
For rectangular tube, Av =(2*depth*thickness)/1.0 for AISC 360-05 (13th edition) and AISC 360-10 (14th edition), but (2*(depth-3*web thickness2))/1.0 for AISC 360-16 (15th edition).
For round tube, Av =A/2

Member Shear Stresses
Since shear stress is not equally distributed over a cross section, it is unconservative to take the maximum shear
stress as simply the beam shear (V) divided by the beam’s cross sectional area. To achieve more accurate results

you must reduce the shear area by a shear stress factor,
where:

and
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These shear stress factors will be automatically calculated for all standard members, but must be entered for
arbitrary sections. While these shear area coefficients are always less than 1.0, they can vary significantly. Common
values include 0.67 for solid rectangular shapes, and 0.75 for solid circular shapes.

Note
l

For wide flange and channel shapes, RISA will replace this calculation with the shear stress calculations
required by the Steel Code specifications.

Torsion
A twisting of the member induces torsional forces and stresses. The primary reference used in the development of
RISA-3D's torsional calculations was Design Guide #9, Torsional Analysis of Steel Members, available from the
AISC. The equations used for torsional stresses won't all be repeated here, but they can be found in the reference.
RISA-3D models warping members using CASE 2 from the torsional reference.
Note:
l

Torsion considerations for any other cases can be grossly over or underestimated. RISA's calculation of torsion capacity is based on torsion due to racking of the structure, not point or line torques on an individual
member. That type of check is not supported.

It is more accurate to consider warping effects when calculating member stiffnesses and stresses, but there is a way
you can turn off these effects. In the Model Settings on the Solution tab, you'll see the checkbox Consider
Torsional Warping. If this box is not checked warping effects will not be considered, i.e. stress and stiffness
calculations for wide flanges and channels will be done just like all the other shapes (k = GJ/L). You may wish to do
this to compare the RISA-3D results with and then without warping, or to compare RISA-3D results with a
program that does not include warping.

Warping
A primary consideration in the calculation of torsional properties and stresses is whether the cross section is
subject to warping. Solid cross sections are NOT subject to warping. For RISA-3D, all closed shapes such as
pipes and tubes are considered to be NOT subject to warping. Cross sections composed of rectangular elements
whose centerlines all intersect at a common point are NOT subject to warping. Examples are Tee shapes and angle
shapes. For simplification, double angle cross sections are also assumed to be not subject to warping. So, the only
shapes RISA-3D considers subject to warping effects are wide flanges and channels (I's and C's). The importance of
this extends beyond the stress calculations, however. Warping considerations also impact the calculation of
torsional stiffness for these shapes.

For a nonwarping member or a warping member with warping unrestrained, the member's torsional stiffness is
given by:
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G

= Material Shear Modulus
J

= Cross Section Torsional Stiffness

L

= Member Length

For a member subject to warping, if the warping of the member is restrained its torsional stiffness is:

Cw

= Cross Section Warping Constant

E

= Material Modulus of Elasticity

L

= Torque Length

Thus restraining the warping effects for a cross section subject to warping (I's or C's) makes the shape much stiffer
in torsion. Think of it this way; if you twist a wide flange, the flanges want to warp. If you restrain the flanges from
warping its much harder to twist the wide flange as it is stiffer in torsion.

Member Releases
If a member is released for any rotational degree of freedom at either end, warping is not considered for that
member. For example, if you model a wide flange member with a “BenPIN” release code (at either or both ends),
warping would not be considered for that member. This is because any connection that doesn't resist bending
moments is certainly not going to restrain warping. RISA-3D does not consider the effect of warping “pins” at this
time.

Warp Length
The "warp length" is the length between points of torsional restraint (or release). This may be equal to or greater
than the member's actual joint to joint length. This warp length is calculated automatically by RISA-3D and is used
for the member's torsional stiffness and stress calculations. Each member’s warp length is shown on the member
detail report (see Member Detail Report).
Physical members that are subject to torsion will always have their warp length be at least the length of the
physical member. Members framing in along the length of the physical member are assumed to not reduce the
warp length.
Note that the calculation of the warp length by RISA-3D can be “fooled” by beams that are modeled by several
segments. The warp length used for each member will be the length of each straight-line segment rather than the
whole length. Using Physical Members rather than member segments will avoid this. This is not possible however
when modeling curved members with straight line segments.

Warping Pins
A member that is subject to warping effects, like a WF or channel shape, will still experience warping stresses, even
if warping restraint is not provided at the ends of the member. RISA-3D currently does NOT consider any warping
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effects for members that have warping “pinned” end conditions. The addition of warping effects for members with
warping pins will be addressed in a future program version.

Torsional Stresses
RISA-3D calculates and lists the torsional stresses for the members of the structure, including the warping stresses.
Pure torsional shear is calculated for all non-warping “open section” shapes based on the equation:

Mx
t

= Torsion Moment
= Maximum Thickness of Any Part of the Cross Section

This is the only torsional stress calculated for non-warping shapes. Shape types that are not “open cross sections”
will have their shear stresses calculated with equations that are appropriate for each type.
For warping shapes (I's and C's), three separate stresses are calculated: pure torsion shear, warping shear and
warping normal (bending) stresses. These results are all listed for review. The equations used to calculate these
values won't be listed here but they are contained in the reference.

Code Check
These torsional stresses are included when the AISC code check (ASD or LRFD) is calculated for the member.
The shear stresses (pure torsion and warping) are included in the required shear force that is then used in the
Shear UC check:

The warping normal stresses are added to the weak axis bending stresses for calculation of the required weak axis
bending moment that is then used in the Max UC check. By “weak axis bending stresses”, we mean the bending
stresses produced by moments about the local y-axis. When including shear stresses from torsion in the shear code
check, the program uses the worst case of the torsional shear stresses (top and bottom flanges or web) and
combines that with the actual shear stresses due to pure flexure. This is intentionally conservative in cases where
the worst case torsional shear occurs in the flange, but the worst case flexural shear occurs in the web.
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Applied Torsional Loads
You may apply member point torques along the length of the member. However, these loads are intended to work
only for non-warping members. The reason is that there are many derivatives necessary to properly handle these
member point torques when applied to warping members. The calculations for non-warping members is quite
simple, but for warping members they're complex. This may be added in a future version.
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Members - Results
When the model is solved, the results are separated into material specific design results and generic results. The
generic member results are discussed in this section. The material specific design results are discussed in the
following sections of the manual: Hot Rolled Steel - Design, Concrete - Design, Cold Formed Steel - Design, and
Wood - Design. For information on Member Detail Reports see the Results section.

Number of Reported Sections
Note that the member results (forces, stresses, code checks) are only reported at the section locations. For example,
if you set the Number Of Reported Sections in the Model Settings Dialog to be '2', you will not get any results
for the middle of your member, you will only get results for the end points. If you have a point load applied to your
member at a location that is not a section location, you will probably not report the maximum moment in the
section if it does not occur at an endpoint.
To Adjust the Number of Sections
l
l

In the Model Settings Dialog, select the Solution tab.
Adjust the Number of Reported Sections as needed.

Note
l

Adjusting the number of sections affects the amount of output.

Number of Internal Sections
Internally, the program subdivides the member into equally spaced sections to calculate forces, stresses, code
checks, etc. The Number of Internal Sections can be adjusted in the Model Settings Dialog. If this value were set
to 100, this would mean that for a member that is 100ft long, RISA-3D will calculate these values at approximately
every foot. These values are then used in the member steel, wood, and concrete code checks, the diagrams in the
model view, and in the detail reports. The locations of the maximum code checks are reported at a distance from
the I-joint.
To Adjust the Number of Internal Sections
l
l

In the Model Settings Dialog, select the Solution tab.
Adjust the Number of Internal Sections as needed.

All other results are reported at the Number of Reported Sections that you specify in the Model Settings Dialog.
This controls how many places you receive reported or printed member force, stress, torsion, and deflection
results. These locations are also equally spaced so setting the value to 5 will give you 5 equally spaced sections; at
the ends, the middle and the quarter points.

Note
l

l

l

Adjusting the Number of Internal Sections will not affect the amount of output in the results
spreadsheets.
You may want to stick with odd numbers for the Number of Reported Sections. Setting the Number of
Reported Sections to an even number will not report forces/stresses at the midpoint of the member,
which is often the location of maximum moment.
Setting the Number of Reported Sections to '2' will only report end forces which, might be desirable
for connection calculation but not when looking for maximum forces along a members length. There is a
printing option for end forces that is the equivalent to setting the Number of Reported Sections to '2'
but allows you to see more results on screen while printing only the end forces.
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Member Force Results
Access the Member Section Forces Spreadsheet by going to the Results Menu and then selecting Member Forces
then clicking the Sections tab.
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These are the member forces calculated along each active member taking into account any member offsets. The
number of sections for which forces are reported is controlled by the Number Of Reported Sections specified in
the Model Settings Dialog.
The Maximums Tab shows the maximum force that occurred in the member based on the Number of Internal
Sections. Because the Number of Internal Sections is typically much larger than the Number of Reported
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Sections, this means that the Maximums Tab will always display the highest/lowest force in the member whereas
the Sections Tab will miss the highest/lowest force under all but the most simple load diagrams.
The End Reactions Tab shows the member forces at the ends of the member. This may not be useful for
continuous members or cantilever members where the i-end and j-end may not be at a support.
The units for the forces are shown at the top of each column. As for the sign convention, the signs of these results
correspond to the member's local axes, using the right hand rule. The left side forces at each section location are
displayed. There are six force values for each section location.
These are axial, shear parallel to the local y axis (Shear y-y), shear parallel to the local z axis (Shear z-z), torque
moment, moment about the member's local y axis (Moment y-y) and moment about the member's local z axis
(Moment z-z). Please see the diagram below:

This diagram shows a member section location with all positive section forces. As can be seen, the section forces
listed at any given section are the left side forces. For axial forces, compression is positive. For moments, counterclockwise around the member axis is positive.

The sign convention for shear is positive when the free body diagram causes the member to spin clockwise (with I
End on the left and J End on the right).
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These section forces may also be displayed graphically. Remember that the section forces used for the plot are the
left side forces. For an example of what you would see for the graphic plot of the moment diagram for a member,
please see below:

RISA-3D uses the right hand rule joint convention and is always consistent with this convention. Since the left side
moment is being used, a member under negative Mz moment would have the "holds water" deflected shape, which
is contrary to some beam conventions. The opposite is true for My moments which will tend to "hold water" under
a positive moment and "shed water" under a negative moment.
The 2nd/1st Moment Ratios Tab shows the ratio of maximum moment with and without secondary P-Delta effect.
In general, the larger the ratio is, the more significant the secondary effect is. Notice that some design codes may
have a limit on this ratio (e.g., ACI has this limit as 1.4), but this limit is not checked by the program.
For enveloped results, the maximum and minimum value at each location is listed. The load combination producing
the maximum or minimum is also listed, in the "LC" column.
The moving load results are enveloped and will display the Load Combinations with maximum and minimum values
shown for each section location, for each active member. The governing load combination and step location is
shown for each result value under the "LC" column. The first number is the load combination, the second is the step
number: (load combination - step number). See Moving Loads to learn more.

Note
l
l

See Spreadsheet Operations to learn how to use Find, Sort, and other options.
See Results View Settings - Members to learn how to plot member results.

Member Stress Results
Access the Member Stresses Spreadsheet by going to the Results Menu and then selecting the Member Stresses
Spreadsheet.
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These are the member stresses calculated along each active member. The number of sections for which stresses are
reported is controlled by the Number Of Reported Sections specified in the Model Settings Dialog.
There will be seven stress values listed for each section location along the member taking into account any member
offsets. The units for the stresses are shown at the top of each column. As for the sign convention, the signs of these
results correspond to the signs of the forces. These line up as positive or negative according to the member local
axis directions. Compression is positive and tension is negative.
The axial stress is the ratio P/A, where P is the section axial force. A positive stress is compressive, since the sign of
the stress follows the sign of the force.
The shear stresses are calculated as V/As, where As is the effective shear area. The program obtains As by
multiplying the total area by the shear stress factor. This factor is calculated automatically for most cross sections,
but must be entered for Arbitrary members. Refer to Member Shear Stresses.
The bending stresses are calculated using the familiar equation M * c / I, where "M" is the bending moment, "c" is
the distance from the neutral axis to the extreme fiber, and "I" is the moment of inertia. RISA-3D calculates and lists
the stress for the section's extreme edge with respect to the positive and negative directions of the local y and/or z
axis. A positive stress is compressive and a negative stress is tensile.
Note that two stress values are listed for each bending axis. This is because the stress values for a bending axis will
not be the same if the shape isn't symmetric for bending about the axis, as with Tee and Channel shapes. The ytop and y-bot values are the extreme fiber stress for the + or – y-axis locations. The same is true for the z-top and zbot stresses.
The locations for the calculated stresses are illustrated in this diagram:
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So, the y-top location is the extreme fiber of the shape in the positive local y direction, y-bot is the extreme fiber in
the negative local y direction, etc. The y-top,bot stresses are calculated using Mz and the z-top,bot stresses are
calculated using My.
For enveloped results, the maximum and minimum value at each location is listed. The load combination producing
the maximum or minimum is also listed, in the "LC" column.
The moving load results are enveloped and will display the Load Combinations with maximum and minimum values
shown for each section location, for each active member. The governing load combination and step location is
shown for each result value under the "LC" column. The first number is the load combination, the second is the step
number: (load combination - step number). See Moving Loads to learn more.

Note
l

l
l
l

A special case is bending stress calculations for single angles. The bending stresses for single angles are
reported for bending about the principal axes.
Torsional stress results are listed separately on the Torsion spreadsheet.
See Spreadsheet Operations to learn how to use Find, Sort, and other options.
See Results View Settings - Members to learn how to plot member results.

Single Angle Results
Depending on whether a single angle has been fully restrained against rotation or not, it will either behave about its
geometric axes or its principal axes. This behavior can be controlled by correctly specifying the unbraced lengths for
the angle. In the diagram below the z and y axes are the geometric axes. The z' and y' are the principal axes. The y'
axis is considered to be the weak axis for principal behavior, and the z' is considered to be the strong axis.
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The orientation of the shape is defined using the local y and z axes shown in the above diagram, but for principal
axis behavior the bending calculations are done with respect to the y' and z' axes shown (the principal axes). The y'
axis is the axis of minimum 'I' and the z' axis is the axis of maximum 'I'. RISA calculates the angle "α" and
transposes the moments as shown below:
Mz' = Mz * cos(α) + My * sin(α)
My' = -Mz * sin(α) + My * cos(α)
The My' and Mz' moments are the moments shown as My and Mz respectively in the member forces results.
Likewise, the y-top and y-bot bending stresses are relative to the extreme fibers along the y' axis (for the Mz'
bending moment). The z-top, z-bot stresses are for My' bending at the extreme fiber locations along the z' axis.

Note
l

If both LcompTop and LcompBot have been set to zero then the angle will behave about its geometric
axes and the member forces and stresses will be displayed relative to the geometric axes. Alternatively,
setting the L-torque value to zero will also constrain the single angle to behave about its geometric axes.

Member Torsion Results
Access the Member Torsions Spreadsheet by going to the Results Menu and then selecting Member Torsions.

These are the torsional stresses calculated along each member. The number of sections for which torsional stresses
are reported is controlled by the Number of Reported Sections option on the Model Settings Dialog.
The units for the torsion stresses are shown at the top of each column. RISA-3D calculates pure torsion shear for
any shape type; this value is based on the maximum thickness of any part of the cross section. Closed shapes such
as tubes and pipes do not warp, nor do solid rectangular or circular shapes. For these shapes, there are no
warping stresses to report. Warping only occurs in open cross sections where the rectangular pieces that make up
the cross section do not all intersect at a single point. For example, a Tee shape could be thought of as two
rectangular pieces, the flange and the stem. These two pieces intersect at the midpoint of the flange, so there is no
warping. A channel, on the other hand, is comprised of three pieces, the two flanges and the web. These three
pieces do NOT share a common point, so a Channel will warp. The same is true for a Wide Flange, so warping
stresses are calculated only for I shapes (WF,S,H) and Channel shapes with warping restrained.
The shear and bending stresses caused by torsion are integrated into the code check and shear check calculations
for the member, so your final code check (and final shear check) values DO include torsional effects. Warping shear
is a shear stress acting parallel to the member's local y-and z-axis. Warping bending stress is a triangular stress
normal to the cross section acting on the flanges, with the maximum stress at the outer edges of the cross section,
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the z-top and z-bot locations. As for the sign convention, the signs of these results correspond to the signs of the
forces. These line up as positive or negative according to the member local axis directions. Compression is positive
and tension is negative. See Torsion for more information on these calculations.
For enveloped results, the maximum and minimum value at each location is listed. The load combination producing
the maximum or minimum is also listed, in the "LC" column.
The moving load results are enveloped and will display the Load Combinations with maximum and minimum values
shown for each section location, for each active member. The governing load combination and step location is
shown for each result value under the "LC" column. The first number is the load combination, the second is the step
number: (load combination - step number). See Moving Loads to learn more.

Note
l
l

See Spreadsheet Operations to learn how to use Find, Sort, and other options.
See Results View Settings - Members to learn how to plot member results.

Member Deflection Results
Access the Member Section Deflections Spreadsheet by going to the Results Menu and then selecting Member
Deflections

Service

The Service tab will contain deflection results only for load combinations marked as Service in the Load
Combinations - Design tab.
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Strength

The Strength tab will contain deflection results only for load combinations NOT marked as Service in the Load
Combinations - Design tab.
The Service and Strength tabs are the member deflections calculated along each active member. The number of
sections for which deflections are reported is controlled by the Number Of Reported Sections specified on the
Model Settings Dialog.
The member section deflections are comprised of 3 translations in the member local axis directions, the rotation (x
Rotate) about the local x-axis (the twist), and the relative deflection to length ratios for the y and z deflections. The
units for the deflections are shown at the top of each column. As for the sign convention, the signs of these results
correspond to the member's local axes, using the right hand rule.
The L/y' and L/z' ratios are the total member length (minus member offsets) divided by the relative deflection. The
deflection in this calculation is not the deflection shown in the columns to the left, which are the absolute
deflections. The deflection used is relative to the straight line between the deflected positions of the end joints. For
cantilevers, the deflection is relative to the original position of the member.
Expressed as an equation, n = L/deflection, where n is what is tabulated in the spreadsheet. The smaller the
deflection, the larger the value. If 'NC' is listed, that means the 'n' value is greater than 10000 which is a very small
deflection. The minimum value that will be shown is '1'. For example, if the deflection criteria is L/360, check here
to make sure no tabulated values are less than 360. Greater than 360 is OK.
For enveloped results the maximum and minimum value at each location is listed. The load combination producing
the maximum or minimum is also listed, in the "LC" column.
The moving load results are enveloped and will display the Load Combinations with maximum and minimum values
shown for each section location, for each active member. The governing load combination and step location is
shown for each result value under the "LC" column. The first number is the load combination, the second is the step
number: (load combination - step number). See Moving Loads to learn more.

Note
l

l
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For members that have not been designated as a beam, the maximum member deflection ratio from the
Service or Strength tab will be reported as the Max Defl Ratio at the end of the member detail report.
See Spreadsheet Operations to learn how to use Find, Sort, and other options.
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l

If you wish, you can go to the model view to plot and animate the deflected structure. The amount of
deflection shown on the plot is controlled by the magnification factor. The joints are plotted based on the
joint displacements, and these member deflections are used to plot the member's curvature between the
joints. See Results View Settings - Members to learn how to plot member results.

Beam Deflections

Enveloped Spreadsheet

Batch Spreadsheet

The Beam Defl spreadsheet shows the strong-axis (y) relative deflections, y', for Beam member types. This
spreadsheet will base the L'/y' Ratio on the actual span for multi-span beams. If there are multiple span beams,
each span will have it's own entry. The L'/y' Ratio uses the span length of the beam, denoted by L' (as opposed to
the full member length, L) compared to the relative deflection, y'.
The program will detect the presence of cantilever spans. If an entire member or the end span(s) of a member are
unsupported at one end, the program will consider those spans a cantilever and use 2*Span Length for the L'/y'
Ratio calculations.
The location and value for the relative deflection, y', is dependent on the beam being either supported or cantilever.
For a member supported on both ends, the maximum relative displacement used in the beam deflection ratio will
be the largest straight line distance (in the vertical y direction) between the deflected shape and the original
undeflected shape.
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For members with a cantilever end, the location of the maximum relative deflection will be at the free end of the
member. The displacement value is equal to the rotation at the supported end multiplied by the length of the
member.
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For multi-span members, the program will give span information in the expanded interactive strong-axis absolute
deflection diagram. A vertical red line will be displayed at support locations which will give the proper span
information.
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The L'/y' Ratio is based on relative deflection and member span length. The relative deflection for each span takes
into account the span end deflections and is the maximum vertical deflection component measured from the
absolute displacement to a straight line drawn from one end of the span to the other. In the image below, the
relative deflection, y', per span is called out as D1, D2, and D3.

502

RISA-3D V20

Members - Results

The green line is the actual deflected shape.
The light blue vertical line is the cursor marker in the expanded interactive strong-axis absolute deflection diagram.
The light red vertical lines are the support locations.
The dark blue lines are straight line connectors between supports at the deflected location.
The dark red vertical lines are the relative strong-axis (y) deflection used in the L'/y' Ratio.
While the program determines if a member is a cantilever or supported based on member behavior and modeling
configuration, there may be cases where the beam is actually considered otherwise. In this case, the
Deflection Ratio Options can be used to designate a member end specifically as supported or cantilever. Any
members with designated support ends using the Deflection Ratio Options will be denoted by a star suffix on the
L'/y' Ratio listed in the Beam Defl spreadsheet.

Note:
l

l
l

For members that have been designated as a beam, the maximum beam deflection ratio will be reported as
the Max Defl Ratio at the bottom of the member detail report.
Overstrength load combinations will not be considered in this spreadsheet.
There are no weak-axis (local z) deflections considered.
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Beam Check

The Beam Check spreadsheet shows the local strong-axis (y) deflections for Beam member types for load
combinations defined in the Member Design Rules - Deflection tab. If a deflection value exceeds the limit from the
design rule then the value will show in RED. This spreadsheet will also base the L/y ratios on the actual span for
multi-span beams. If there are multiple span beams each span will have it's own entry.

Note:
l

l
l
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If you're used the Suggested Design feature to optimize members in your model the program will consider
these deflections in this optimization.
Overstrength load combinations will not be considered in this spreadsheet.
There are no weak-axis (local z) deflections considered.
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Model Merge is a feature located on the Modify Tab that scans through your model and automatically merges
elements in the model. Model Merge detects unconnected nodes along member spans, unconnected crossing
members and duplicate nodes, members and plates. You can use Model Merge to build models faster as well as to
detect and fix modeling errors.
Knowing what Model Merge does allows you to skip modeling steps as you build your model and let the software
perform these steps for you. You can take advantage of Model Merge in modeling your structure in many ways, a
few of which are:

Note
l

Model Merge will "connect" Physical Members by inserting a node at their intersection but will not break
them up into smaller members. Model Merge also eliminates duplicate Physical Members so you should
still use model merge to detect errors when working with these types of members. See Physical Members to learn more.

Model Merge Options
There are three main options for the model merge.
The Merge Tolerance is set in the Model Settings screen and defines the maximum distance 2 nodes can be apart
and still be merged together. It is also used when scanning for crossing members and for unattached nodes along
the spans of members.
If the Merge Crossing Members box is checked then as part of the merge process, all members will be scanned
along their lengths for crossing members. Crossing members will be merged together at their intersection points. If
you have cross bracing you may or may not want them to be merged. A finite element crossing a physical member
will cause only the finite element to be broken up at the point of intersection. If two physical members are
crossing, a node will be placed at the intersection point.
Merge Inactive Members if left unchecked allows you to limit the merge process to the parts of your model that
are selected. This allows you to prevent the program from merging portions of your model where you may have
intentionally put nodes at the same location or have two members next to each other.
Trim/Extend Crossing Beams can help connect member ends that are within the merge tolerance from an
adjacent beam. Checking this box will move the end node of that member so that it lies on the adjacent beam.
Trim/Extend Crossing Wall Panels can help when you have two wall panels that are overlapping or intersecting
by a distance smaller than the merge tolerance. This allows you to easily correct minor modeling flaws. This will
also correct the condition where a defined wall panel is non-coplanar.
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Model Merge Examples

Looking at this frame, consider the column line on the right side, members 1-7 and 7-13. If you did not use Physical
Members you would define this just that way, as two separate members. With the model merge capability you could
instead enter a single member definition, 1-13, and let the model merge function break it up for you.
Other convenient uses of the model merge function are laying out floor plans and being able to draw all the nodes
right over the main girders or defining truss chords as full length rather than specifying each panel point. The
model merge will take care of breaking up the members at all the intersecting points. Of course the Physical
Member feature goes a step farther for these situations because these members never need to be split to model a
connection – allowing you to make edits and understand results more readily. See Physical Members to learn more.

Model Merge Limitations
Certain types of shape types and certain load types can cause members to not get broken up by the model merge
function. In particular, members that are Tapered WF shapes will not get broken up by the model merge. Even if
such members have intermediate unattached nodes, or crossing members within their spans, they will not be
broken up.

Model Merge Process
1. Duplicate nodes are merged together.
2. All the members are scanned for other members crossing along their span. If a crossing member is found, a
nodes is created at the intersection point.
3. All the members are scanned for nodes along their span. If found, the member is broken up into pieces to
incorporate the nodes.
4. Duplicate members are merged together. Physical members take precedence over finite element members.
Longer members take precedence over shorter members that are fully coincident with the longer member.
When duplicate members with different section sets are merged, the set listed first in the Sections Sets
spreadsheet are used.
5. Duplicate plates are merged together.
To better understand how the model merge function works, please refer to this figure:
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Diagram A shows the model before a merge. The two column lines are separated in diagrams A and B strictly for
ease of viewing, they should be considered to be right on top of each other. Nodes 1 and 5 (in diagram A) have
exactly the same coordinates, as do nodes 3 and 10. None of these members are Physical Members.
Step 1 of the merge eliminates duplicate joints changing the model from diagram A to diagram B. On diagram A,
nodes 1 and 5 are duplicates (same coordinates), as are nodes 3 and 10. Nodes 5 and 10 are merged into nodes 1
and 3 respectively. This means any loads applied to nodes 5 and 10 are now applied to nodes 1 and 3. Any
members connected to 5 and 10 are now connected to nodes 1 and 3 (these members are shown with the inclined
lines in diagram B).
Step 2 looks for crossing members, however, there aren't any for this particular example. Members that are parallel
to each other aren't treated as "crossing" since the end nodes of overlapping members will be merged in Step 3.
Step 3 is where the members are scanned for intermediate span nodes. This takes us from diagram B to diagram C.
Referring to diagram B, member 1-2 has two intermediate nodes (5 and 6), member 6-7 has one intermediate node
(node 2), and so on. The members with intermediate joints are broken up, shown in diagram C.
Step 4 eliminates duplicate members, in this case those that were created in step 2. This takes us from diagram C to
diagram D. Looking at diagram C, the duplicate members are shown as the double lines. The first member listed on
the Member spreadsheet is maintained and the other member is deleted. Any loads applied to the deleted member
are transferred to the remaining member.
The final merged model is shown in diagram D. The column line is now comprised of 8 members, 1-5, 5-6, 6-2, etc.
up to member 9-4.

Note
l

The direction code of loads merged for duplicate members and plates is kept the same. Elements with
loads in local directions and different orientations may result in a load direction that is not be the same
as the original direction.

To Perform a Model Merge
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1. In the current model view window, select the items you wish to merge. Typically you will want everything to
be selected.
2. Go to the Modify Tab and click on the Model Merge button to bring up the model merge parameter window.
3. Set the parameters for the new merge. Click Apply All or Apply Selected to apply the model merge to the
entire model or items you selected. For help on an item, click

and then click the item.

Note
l

You may undo any mistakes by clicking the Undo

button.

508

RISA-3D V20

Model Settings

Model Settings
The model settings may be accessed on the Home tab in the Model section. The Units, Info and Settings buttons
are highlighted below.

The Model Settings are settings specific to the model which is currently open. The information stored here is
retained with the model, and will be retained even if the model is opened on a different computer.
Refer to the Units topic for more details on the units settings.
You may save any of the settings in the Model section as the default setting, such that new models you create will
begin with the settings that you saved as Defaults. To do this, simply enter the information that you want to save
and click the Save as Defaults button.

Project Information

Click on the Info button to enter descriptive information such as a title for the particular model being defined, the
name of the designer and a job number. The title may then be printed at the top of each sheet of the output, and on
the graphic printouts of the model. Note that you can click on Save as Defaults and then your settings will be saved
the next time you open the program.
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The Project Notes field is intended for information about the model that may be useful for the engineer or
reviewer to refer to. This section is limited to 4000 characters.
The Checked By field is intended for the model reviewer to initial upon completion of a model review. Their initials
will then be printed on each sheet of the output.

Solution
The entries within the Settings button provide most of the control for model specific settings.

The entries under the Solution tab are used to control settings that affect the general solution of the model.
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Members
Number of Reported Sections controls how many places along each member you receive reported member force,
stress, torsion, and deflection results. This only affects the amount of data displayed in the results spreadsheets, and
has no effect on the solution of the model or the code checks. See Printing and Member Results for more
information.
Number of Internal Sections controls how many places along each member the software calculates and stores
results such as deflections and code checks. The member force diagrams displayed in the model view and the detail
plot are also drawn from these results. Increasing this value means that the program will make more "cuts" along
the beam's length, which means it is more likely to hit the theoretical maximum and minimum values for code
checks.
Note:
l

l

l

Number of Sections cannot exceed 20. Also, Number of Internal Sections cannot be less than twice the Number of Sections. If unacceptable values are entered for either of these fields the program will automatically
reset them to acceptable values.
In the embedded version of RISAFoundation in RISAFloor or RISA-3D, the Beam Section Options will not
appear. In these cases, the Model Settings from RISA-3D will control here.
The Number of Sections and INTERNAL sections are remembered between RISAFloor and RISA-3D. If either
of these is changed in RISA-3D, the RISAFloor results will be cleared as soon as RISAFloor is entered again.
This is to keep results consistency between the programs.

The Member Area Load Mesh Size is used to determine the maximum size when meshing an area load and
attributing the load to members. See Area Loads to learn more about this.
Check the Consider Shear Deformation box if shear deformation considerations are to be included in the model
solution. See Member Shear Deformations for more information.
The Consider Torsional Warping option considers torsional warping effects when calculating stiffness and stress
values for shape types that warp. See Member Warping for more information.

Wall Panels
The Approximate Mesh Size is the base mesh size that is used when wall panels solved. If there is a constraint
smaller than this mesh size, the mesh will be refined to accommodate this constraint. You can see the mesh size
graphically on the wall panels when you solve your model.
Note:
l

The mesh size is also used for plate sub-mesh for RISAFloor Concrete floor Semi-Rigid diaphragms.

The Transfer Forces Between Intersecting Wood Walls option allows the user to decide whether wall panels
framing into each other will transfer loads. Wall panels that are parallel to and touching each other will always
transfer loads. This was added because there are times when intersecting perpendicular walls are not actually
attached to each other, thus may separate if loading conditions cause this.
The Increase Wood Wall Nailing Capacity for Wind Loads option will automatically increase the shear capacity
of wood wall and diaphragm panels by 1.4 for all load combinations that contain wind loads. Load combinations
that have both wind and seismic loads acting simultaneously will not receive this increase.
Run a P-Delta Analysis for Wall Panels is used to enable P-Delta analysis for wall panels. Even if this box is
checked the P-Delta analysis will only be performed on load combinations which have P-Delta enabled.
The Optimize Masonry and Wood Walls option defines whether you want to automatically iterate the solution for
masonry and wood walls.
The Maximum Numbers of Iterations option defines how many automatic iterations will occur.
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Note:
l

l
l
l

l

This automatic iteration procedure will only happen for Batch or Envelope solutions. This is because we do
not want to update your wall panel thicknesses if you are only solving a DL combination. In that case the program would then downsize your panel unnecessarily.
For more information on masonry wall optimization see the Masonry Wall - Design topic.
For more information on wood wall optimization see the Wood Wall - Design topic.
Concrete wall design will be done automatically and the selections here will not affect this design. This is
because concrete wall reinforcement changes will have very little effect on the stiffness of the walls.
The program will stop the iteration procedure if the results from the previous solution match the results
from the current solution.

Processor Core Utilization
The Single option will use a single core to run the model solution. This option is useful when you have several
other computer programs that are CPU intensive running in conjunction with RISA-3D.
The Multiple (Optimum) option will use half of the available cores on your computer to run the solution. This
option will provide a faster solution time compared to using a single core but will still allow half of your computer’s
available cores to be used for other programs and computer processes.
The Maximum option will use all of the available cores on your computer minus one. For instance, if you have 8
available cores and select the Maximum option the program will use 7 cores in the processing of the solution. This
option will provide the fastest solution time but will still apportion a single core to be used for other programs and
computer processes.

Advanced
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The P-Delta Convergence Tolerance is used to adjust the tolerance used to determine convergence of the P-Delta
analysis. Be sure to enter this value as a percentage! The default for this is ½ of 1 percent (.5%). See P-Delta
Analysis to learn more about this.
The Eigensolution Convergence Tolerance is used to set how close a subsequent solution must be to the previous
solution for a mode to be considered converged. See Dynamic Analysis for more information.
The Gravity Acceleration is used to convert loads into masses for the purpose of a dynamic analysis.
The Merge Tolerance is used as the maximum distance 2 nodes can be apart and still be merged together. It is also
used when scanning for crossing members and for unattached joints along the spans of members.
The Solver to be used during solution may be selected by clicking the radial button next to Standard Skyline or
Sparse Accelerated. See Solution for more information on these two options.
The Dynamics Solver options allow you to choose between the Standard Solver, the Accelerated Solver and a Ritz
Vector solution. Refer to the Solution topic for a more details.
l

l

l

The Standard Solver uses a simple sub-space iteration to solve for the natural frequencies. This solver has
been used for years and the accuracy of the results is very well established. It has been included only for
comparative / verification purposes.
The Accelerated Solver uses an accelerated sub-space iteration with a Lanzcos starting vector. The accelerated solver is the default and should produce solution in a fraction of the time that the standard solver
would take to produce them.
The Ritz Vector solution does not solve for true mode shapes and natural frequencies. However, it is generally the best choice when running a response spectra analysis. The use of Load Dependent Ritz vectors
provides a more accurate response spectra analysis for the same number of modes.

The Time-History options allow the user to choose between the Modal Superposition and Direct Integration
solution methods. It also allows the user to set the damping preferences for each of these solution methods. Refer to
the Solution and the Dynamic Analysis - Time History topics for more details on these settings.
The P-Delta Analysis options allow the user to choose between the Standard Nodal Shear method and Geometric
Nonlinear Stiffness method. Refer to P-Delta Analysis for more details on these two methods.
The Diaphragm Stiffness controls the stiffness of the rigid diaphragm. This is set to a unitless value of 1 x 107 by
default. This value has been calibrated as providing the best behavior for most models. For more information refer
to the Diaphragm topic.
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Axis

The Vertical Axis may also be set here as well. Setting the vertical axis may also require you to set the Default
Member Orientation also shown. As you specify new members RISA-3D will try to orient them correctly. The
member local z-axis is typically the strong axis for a member and RISA-3D will orient members such that when you
draw non-vertical members (beams) they will automatically be oriented such that loads in the vertical direction are
resisted by the strong axis bending of the member. See Member Local Axes and Defining Member Orientation for
more information.
The Convert Existing Data checkbox will convert the existing orientation data to the newly selected vertical global
axis.
The Plate Local Axis may be designated here as Global or Nodal. This can be changed at any time and will modify
the axes of all plates. If set to Global, the local axes of all plates will be oriented in the same orthogonal direction,
regardless of plate geometry. However, the positive out-of-plane axis will be dependent on the configuration in
which the plate or mesh was drawn. If set to Nodal, the positive orientation of the plate axes will be dependent on
the manner in which the plate was created. See Drawing Plates and Submeshing Plates for more information.
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Codes

The settings under the Codes tab control which design code is used for code checks for each material type.
The HR Steel entry indicates which code is to be used for the design of hot rolled steel. For more information see
Hot Rolled Steel Design.
Note:
l

l

If the AISC 360 code is selected (either ASD or LRFD), the Adjust Stiffness menu will appear. The
options in this menu control the stiffness reduction provisions listed in the code. See Hot Rolled Steel Design for more information on how the reduction is calculated and applied.
If the EN 1993-1-1:2005 (Eurocode) is selected, the National Annex menu will appear. If you select
"None" the design will be performed per the generic Eurocode specifications. If you select a National
Annex from the list then the provisions relating to that specific National Annex will also be considered in
the design. Where the National Annex and the generic Eurocode differ, the National Annex provisions are
used. See the Hot Rolled Steel - Design topic for more information on the differences in design.

The Connection entry indicates which code is to be used for connection design. This entry is only considered if you
are also using RISAConnection. See the RISAConnection Integration topic for more information.
The CF Steel entry indicates which steel code is to be used for the design of cold formed steel. For more
information see Cold Formed Steel Design.
The Wood entry indicates which wood code is to be used for the design of wood, including wood walls and
structural composite lumber. For more information see Wood Design.
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Note:
l

l

The temperature menu is used to calculate the temperature factor (Ct) for the NDS code design. This factor is
used in the design of wood members for all editions of the AF&PA code. See NDS-2012, Section 2.3.3 for
more information.
This selection is ignored for the CSA O86 code design. Rather than applying a separate temperature factor,
the CSA O86 code suggests that the designer apply the wet properties reduction factor when the member is
subject to prolonged exposure to temperatures higher than 50°C (122°F). See Chapter 11 (Reference Information) of the Wood Design Manual (2010) for more information.

The Concrete entry indicates which concrete code is to be used in the design of concrete members and walls. For
more information see Concrete Design.
Note:
l

ACI 318-08 and ACI 318-11 behave identically in the program, as there were no relevant changes between
these two editions of the code.

The Masonry entry indicates which masonry code is to be used for the design of masonry walls. For more
information see Masonry Design.
Note:
l

If the UBC 1997 ASD code is chosen, there is an option for whether the construction of the wall is subject to
special inspection. This affects some values in design under that code.

The Aluminum entry indicates which aluminum code is to be used in the design of aluminum. For more
information see Aluminum Design.

Note
l

l

The Building and Bridge options refer to the Safety Factors the code requires to be used for Building or
Bridge type structures.
If the 2010 code is selected (either ASD or LRFD), the Adjust Stiffness menu will appear. The options in
this menu control the stiffness reduction provisions listed in Chapter C (Design for Stability) of the code.
See Aluminum- Design for more information on how the reduction is calculated and applied.

The LL Reduction check boxes for columns and beams indicate whether LL Reduction will be considered. These
check boxes are only available for models that are integrated with RISAFloor. And, they only affect elements that
originated in the RISAFloor model.
Note:
l
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Concrete

The entries under the Concrete tab contain options related to the analysis and design of concrete members.
The Analysis Methodology controls which method will be used to determine the biaxial column capacity. The
options are the PCA Load Contour Method and the Exact Integration Method.
The Parme Beta Factor is used to approximate the column’s 3D interaction surface when using the PCA Load
Contour Method. See Biaxial Bending of Columns for more information.
The Compression Stress Block option allows you to choose what type of stress block to consider in your analysis.
The options are the constant Rectangular Stress Block and the Parabolic Stress Block. See Parabolic vs.
Rectangular Stress Blocks for more information.
Check the Analyze using Cracked Sections box if you want to modify the member and wall stiffnesses by the Icr
Factor as described in both the Concrete - Design and Wall Panels topics.
Checking the Leave room for horizontal rebar splices (2*d bar spacing) box, RISA will default to a two bar
diameter or one inch clear spacing, whichever is greater, to allow for lap splices and continue to maintain adequate
spacing between parallel bars. Otherwise a minimum spacing of one bar diameter between parallel bars will be
allowed.
Check the List forces which were ignored for design the Detail Report check box to see force warnings in the
detail report.
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The Minimum % Steel for Columns allows you to choose the minimum percentage of reinforcement steel to be
used in a concrete column section. The percentage entered will be multiplied times the gross area of the column
section to determine the minimum amount of reinforcement required in each column. It should be noted that the
minimum percentage allowed by ACI 318-14 Section 10.6.1.1 (ACI 318-11 Section 10.9.1) is 1%.
The Maximum % Steel for Columns allows you to choose the maximum percentage of reinforcement steel to be
used in a concrete column section. The percentage entered will be multiplied times the gross area of the column
section to determine the maximum amount of reinforcement allowed in each column. It should be noted that the
maximum percentage allowed by ACI 318-14 Section 10.6.1.1 (ACI 318-11 Section 10.9.1)1 is 8%.
Note:
l

Concrete cover for beams and columns is specified under Design Rules under the Concrete Rebar tab.Concrete cover for beams and columns is specified under Design Rules under the Concrete Rebar tab.

The Rebar Material Spec allows you to choose from the standard ASTM A615 (imperial), ASTM A615M ("hard"
metric, i.e. #8M is an 8mm bar), BS 4449 (British), prENV 10080 (Euro), CSA G30.18 (Canadian), IS 1786 (Indian),
and AS/NZS 4671:2001 (Australian/New Zealand) reinforcement standards.
Check the Warn if beam-column framing arrangement is not understood check box to see bad framing
warnings in the Warning Log.
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The Shear Reinforcement Options allow you to control the Number of Shear Regions that will be used when
detailing a beam or column span. You can also specify a Region 2 & 3 Spacing Increase Increment that you'd like
the program to use when increasing or reducing the spacing of the shear ties.

Seismic
The options on the Seismic tab list settings that are specifically related to calculation of code prescribed Seismic
Loads. This information can be used by RISA-3D to automatically generate the Lateral Loading on your structure.
Depending on which Seismic Code you select will depend on the input options that you have.

Most of the input fields on this tab are discussed in the Seismic Load topic. Below are a few inputs which are
specific to this tab. See the section Drift Calculations to see how Rho, Cd, Drift Category and Risk Category affect the
calculation of story drift results.
(Ω) is the Overstrength Factor. This can be included in the seismic load combinations generated by the LC
Generator.
The Redundancy Factor (ρ) is based on the extent of redundancy in your structure. This can be included in the
seismic load combinations generated by the LC Generator.
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Applying In-Plane Moment to Plates
Occasionally you may need to model an applied in-plane moment at a node connected to plate elements. The
plate/shell element cannot directly model in-plane rotations. One way around this is to model the in-plane moment
as a force couple of in-plane forces. You would replace the applied in-plane node moment at 1 node with 2 or 4 inplane forces at 2 or 4 nodes , which would produce the same magnitude in-plane moment. See below:

This might require re-meshing the area receiving the moment into smaller plates so that the load area can be more
accurately modeled. If a beam member is attached to the node and will be used to transfer the moment, than you
will want to look at the topic Modeling a Beam Fixed to a Shear Wall below.

Modeling a Beam Fixed to a Shear Wall
Occasionally you may need to model the situation where you have a beam element that is fixed into a shear wall. A
situation where this may occur would be a concrete beam that was cast integrally with the shear wall or a steel
beam that was cast into the shear wall. The beam cannot just be attached to the node at the wall because the
plate/shell element does not model in-plane rotational stiffness. A fairly simple work around is to use rigid links to
transfer the bending moment from the node at the wall as shear force to the surrounding nodes in the wall. See
Rigid Links in the Modeling Tips section to learn how to create rigid links. This modeling method provides a more
accurate analysis than trying to use a plate/shell element with a “drilling degree of freedom” which attempts to
directly model the in-plane rotation. See the figure below:
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The only trick to this method is getting the proper member end releases for the rigid links. We want to transfer
shear forces from the wall node to the interior wall nodes without having the rigid links affect the stiffness of the
shear wall. Notice from the figure that the I-node for all the links is the node connected to the beam element, while
the J-nodes are the ends that extend into the shear wall. The J-ends of all the rigid links should have their x, Mx,
My, and Mz degrees of freedom released. Only the y and z degrees of freedom (local axes shears) should be
connected from the J-ends to the interior wall nodes . This release configuration will allow the shears to be
transferred into the wall, but the wall stiffness will not be adversely affected by the presence of the rigid links.

Modeling a Cable
While there is not a true “cable element”, there is a tension only element. A true cable element will include the
effects of axial pre-stress as well as large deflection theory, such that the flexural stiffness of the cable will be a
function of the axial force in the cable. In other words, for a true cable element the axial force will be applied to the
deflected shape of the cable instead of being applied to the initial (undeflected) shape. If you try to model a cable
element by just using members with very weak Iyy and Izz properties and then applying a transverse load, you will
not get cable action. What will happen is that the beam elements will deflect enormously with NO increase in axial
force. This is because the change in geometry due to the transverse loading will occur after all the loads are
applied, so none of the load will be converted into an axial force.

Guyed Structure (“Straight” Cables)
You can easily model cables that are straight and effectively experience only axial loading. If the cable is not
straight or experiences force other than axial force then see the next section.
When modeling guyed structures you can model the cables with a weightless material so that the transverse
cable member deflections are not reported. If you do this you should place all of the cable self-weight elsewhere on
the structure as a point load. If you do not do this then the cable deflections (other than the axial deflection) will be
reported as very large since it is cable action that keeps a guyed cable straight. If you are interested in the
deflection of the cable the calculation is a function of the length and the force and you would have to calculate this
by hand.
The section set for the cable should be modeled as a tension only member so that the cable is not allowed to take
compression. See T/C Members for more on this.
To prestress the cable you can apply a thermal load to create the pre-tension of the cable. See Prestressing with
Thermal Loads to learn how to do this.

Modeling Composite Behavior
Occasionally you may want to model a structure with composite behavior. A practical situation where this arises is
with composite concrete floor slabs, which have concrete slabs over steel or concrete beams. Another common case
where composite behavior may be considered is where you have a steel tank with stiffeners. The stiffeners might
be single angles or WT shapes.
The most accurate way to model this behavior for composite floor systems is to use a program (such a RISAFloor)
that was created explicitly for this purpose. If that is not an option you may want to use an arbitrary member with
an effective moment of inertia, Ieff, calculated according to the AISC or Canadian code provisions. This method has
the advantage of being able to account for the effects of partial composite behavior, while the methods described
below assume perfect connectivity between the steel beam and the concrete slab.
If you have already modeled the concrete deck with plate elements, then the situation can be quickly modeled for
horizontal beams by using one beam modeled as a physical member and also using Analysis Offsets. The beam
would simply be drawn along the plates/nodes for the composite section. This method has the advantage of being
very fast to model but it also neglects the depth of the concrete in computing the total vertical offset between the
centerline of the beam and the centerline of the slab. Note that you have to have an appropriate number of nodes
along the span of the beam to model the shear transfer between the slab and the beam. A more refined (and
complicated) method using rigid links is described next.
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An example of a plate/beam model with composite action included using rigid links is shown here:

Note that beams and plates are each modeled at their respective centerlines. It is this offset of the beam and plate
centerlines that causes the composite behavior. The distance between the centerlines is typically half the depth of
the beam plus half the thickness of the plate elements. If the beam is an unsymmetrical shape, like a WT about the
z-z axis or a single angle, then you would use the distance from the flange face to the neutral axis.
As shown above, a rigid link is used to connect each set of nodes between the beam and the plates. This rigid link is
fixed to each node and therefore has no member end releases. See Rigid Links in the Modeling Tips section to learn
how to create rigid links.
Graphical editing offers the fastest way to model composite action. It is usually best to model the plates with an
appropriately fine mesh first. Then you would copy the plate nodes that are directly over the beam down to the
centerline elevation of the beams. Next you would draw your beam to the two outer nodes at the beam centerline
elevation.
There are a number of ways to build your rigid link member between all the corresponding plate and beam nodes .
A good way to connect all the links is to generate grid members (Grid Member Generation). You can also draw the
first one and then copy it along the length of the member.
Now perform a model merge. If you have used finite members rather than Physical Members the merge Model
Merge will break up finite element beams at all the intermediate locations. See Model Merge for more information.
If you’re using physical members, performing the model merge will clean up duplicate nodes and members but not
break up the beam member since the links are automatically attached to Physical Members as long as their node lie
on the member.

Modeling Inclined Supports
You may model inclined supports by using a short rigid link to span between a node which is restrained in the
global directions and the item to receive the inclined support. See the figure below:

The rigid link should be “short”, say no more than 0.1 ft. The member end releases for the rigid link at node “B” are
used to control which degrees of freedom are pinned or fixed in the inclined directions. This works because the
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member end releases are in the local member axes. See Rigid Links in the Modeling Tips section to learn how to
create rigid links.
The section forces in the rigid link are the inclined reactions. Note that you need to make sure the rigid link is
connected to the members/plates at the correct inclined angle. You can control the incline of the angle using the
coordinates of nodes “A” and “B”. You can also rotate the rigid link to the proper angle.

Modeling One Member Over Another
Occasionally you may need to model the situation where one member crosses over another member. A common
situation where this occurs is in the design of framing for crane rails, where the crane rail sits on top of, or is
hanging beneath, the supporting beam. See the figure below:

The two beams are each modeled at their correct centerline elevations. Both the top and bottom members need to
have a node at the point of intersection. The distance between the nodes would be half the depth of the top beam
plus half the depth of the bottom beam. The method to model this is to connect node A to node B is with a rigid
link. The member end releases at the A or B end can be used to control which degrees of freedom get transferred
between the beams. For example, if Beam A is free to pivot over Beam B then you would apply a Pin end release to
the top of the rigid link, and a Fixed end release to the bottom of the rigid link. Don't pin both ends of the rigid link
though, because then there can be no shear transfer between the beams. See Rigid Links in the Modeling Tips
section to learn how to create rigid links.

Reactions at Nodes with Enforced Displacements
The reaction at an enforced displacement can be obtained by inserting a very short (.02' or so) rigid link between
the node with the enforced displacement and any attached members. The member forces in this rigid link will be
the reactions at the node with the enforced displacement. It is helpful to align the link to be parallel with one of the
global axes, that way the local member forces will be parallel to the global directions unless of course you are
modeling inclined supports. See Rigid Links below to learn how to create rigid links.

Rigid Links
Rigid links are used to rigidly transfer the forces from one point to another and to also account for any secondary
moments that may occur due to moving the force. This is in contrast to using the tether feature for nodes where
the forces are shared by 2 or more node degrees of freedom (DOF), but any secondary moments are lost when
tethering the nodes . Tethered nodes actually share common DOF and so do not account for the distances between
them. Rigid links do not have any practical internal deformation, I.e. there is no differential movement between the
I-node and the J-node . Rigid links may be used to model situations such as composite behavior or beams fixed to
walls modeled with plate elements. They are also useful for getting information such as reactions at inclined
supports or reactions at nodes with enforced displacements.
To Make a Rigid Link
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1. On the General tab of the Materials spreadsheet create a material Label called “LINK”. Enter “1e6 (ksi)” for
the value of E. Blank out the value for G by going to that field and pressing the space bar. Double check that
the Density is set to zero. Leave all the other values as their defaults.
2. On the General tab of the Section Sets spreadsheet create a section set Label called “RIGID” with the “LINK”
Material.
3. Move the cursor to the Shape field and hit your space bar to erase the information in this field.
4. Set the A,and Iy, Iz and Jvalues to “1e6 (based on units of inches)”.
5. To make a rigid link, on the Members spreadsheet create a member that references the RIGID section set created above. You can control which DOF are transferred through the link by using the member end releases.

Note
l

l

The density is set to zero in case the self-weight is used in a loading condition. If the density is left as
the default then any gravity loading would cause the rigid link to add a very large load into your model
due to it’s large area.
To keep the model merge from deleting your rigid links, be careful not to create links whose lengths are
less than your merge tolerance.

The weight density should be set to zero in case self-weight is used as a loading condition. If the material used is
not weightless, then any gravity loading would cause the rigid link to add a very large load into your model.
(Gravity load is applied as a distributed load with a magnitude equal to the member area times the weight density).
For models with very stiff elements, like concrete shear walls, the rigid link may not be rigid in comparison. If you
see that the rigid link is deforming, then you may have to increase the stiffness of the link. The easiest way to do
this is to increase the A, Iy, Iz, and J values for the RIGID section set. Make sure that the combination of E*I or E*A
does not exceed 1e17 because 1e20 and 8.33e18 are the internal stiffnesses of the translational and rotational
Reaction boundary conditions. If you make a member too stiff, you may get ghost reactions, which tend to pull load
out of the model. (The total reactions will no longer add up to the applied loads.)

Solving Large Models
Large models are those where the stiffness matrix size greatly exceeds the amount of available free RAM on your
computer. Solving large models can take a long time, so it is useful to have an understanding of what steps can help
speed up the solution. The time it takes to solve a model is dependent on several things; these include the
bandwidth of the stiffness matrix, the number of terms that need to be stored for the stiffness matrix, and the
amount of RAM in your computer.
A bandwidth minimizer is used at the beginning of the solution to try to reorder your degrees of freedom to get a
reduced bandwidth stiffness matrix size. Sometimes, however, the bandwidth minimizer can be fooled and will give
a poor matrix column height and a huge number of matrix terms.
If you are getting a stiffness matrix that is larger than you would expect and you don't think that you have any
modeling errors, you can try a few things to reduce the bandwidth. The first thing you can try is to sort your nodes .
Typically you will want to sort your nodes on the Coordinates spreadsheet from “Low to High” in the 2 lateral
directions and then lastly in the vertical direction. After you sort your nodes , try to solve again and check the
matrix size. The order of sorting depends on the model, so you might want to try a couple of different combinations
and check the model each time. Sometimes, sorting the nodes will result in cutting the height and number of terms
by a factor of 2.
You will also want to make sure you don't have separate structures in the same model where one is big and the
other small. You will get a very large matrix height if the bandwidth minimization starts on the small model and
then jumps to the big model. Instead, you will probably want to split these into 2 separate files.
The amount of “address space” available to solve your model is based on several things: the amount of RAM in your
computer, the amount of free hard disk space, the operating system, the Virtual memory settings in the Windows
Control Panel, and the internal limitations of your operating system.
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If you get an error that states “You have run out of memory, try increasing your virtual memory…” you will want to
note the amount of memory that was requested at the time versus the amount that was available. This amount
should displayed along with the error message. This amount will give a starting point from which you can increase
the available address space. You may need to increase the amount of Virtual Memory so that you have enough
address space to run the model and your other applications. (You typically do this by double clicking on “My
Computer”, then “Control Panel”, then “System”. Within the System options, you would click on the “Performance”
tab and then you click on the “Virtual Memory” button.) Make sure that you are specifying more Virtual Memory
than is needed to solve your model.
There is an internal limitation to the amount memory that Windows will allocate to the RISAProgram. Within a 32
bit addressing space, Windows has a basic limit of 4 Gigabytes. Of that, they reserve 2 Gigs for the operating
system. Therefore, RISA can only use a maximum of 2 Gigabytes with large models (where the stiffness matrix
alone is well in excess of 1.0 Gigs), your only option may be to re-model your structure using fewer degrees of
freedom.

Ways to Minimize the Memory Use
Keep in mind that many of these solutions may result in a decreased accuracy of your solution
l

l

l

l

Set the Number of Sections and INTERNAL Sections to a minimal amount. This can be done via the Model
Settings - Solution tab.
Set the Mesh Size for wall panels (if they exist in your model) to a larger value. This can be done via the
Model Settings - Solution tab.
Solve fewer load combinations. It is almost always possible to reduce the total number of combinations by
inspection. Engineering judgment can help determine which load combinations will not control for your structure.
Check to see that you are not causing an overly tight mesh for wall panels (if they exist in your model) by
your modeling practices. This can cause a large amount of internal plates to be created and tax the solution.
See the Wall Panels - Tips For Ensuring a Healthy Mesh section for more information.

Modeling a "Gap" (Expansion Joint) Between Structures
A gap element is a member that mimics the behavior of a gap or expansion joint between adjacent structures.

While RISA does not offer the capability to directly create a gap element, one may be indirectly created using the
properties of the member and an applied thermal load. The concept is to place a ‘shrunk’ member between adjacent
structures. The shrinkage of the member is achieved with a negative thermal load, in the form of a member
distributed load.
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The amount of shrinkage should be equal to the width of the gap, such that the structures act independently until
they move close enough to each other to ‘touch’ and thereby transmit loads to each other. To calculate the thermal
load required for a gap use the following formula:

Where:
ΔT = Applied thermal load
Gap = Distance between two structures
L = Length of gap element
α = Coefficient of thermal expansion

In order to prevent the gap element from ‘pulling’ its connected structures towards it due to shrinkage it must be
defined as a ‘compression only’ member under the advanced options tab. It is also advisable to define the gap
element as a rigid material such that the amount of load it transfers once the gap is closed is not affected by elastic
shortening.
Lastly, in cases where the applied temperature would need to be of an extraordinary magnitude, it might be useful
to increase the coefficient of thermal expansion of the material such that a smaller temperature load would achieve
the same shrinkage.
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Nodes are used to define the ends of members and plate corners. Nodes are also used to specify boundary
conditions, diaphragms, story drift locations, and nodal loads. Each node is a point in space defined by coordinates
in the global X, Y, and Z directions and temperature that may be used in conjunction with thermal loads.

Note
l

The terms "node" and "joint" are interchangeable and are both used in this manual and in the program.

Nodes may be input manually, or they may be created automatically as you draw new members and plates on the
drawing grid. Once defined, the nodes may be edited in three ways: graphically, in the Node Properties Panel, or
in the Node Coordinates Spreadsheet.

To Define Nodes
l

l

Select the Node Coordinates spreadsheet from the Spreadsheets tab
Data Entry portion of the Explorer panel.
Define the node coordinates and temperature.

Data Entry button or from the

Note
l
l
l

You may use cut and paste, block fill, and block math to enter and edit nodes.
You may choose the prefix that is used to label the nodes.
To modify one node you may click that node in the 3D View to view and edit its properties in the Properties panel.

To Relabel Nodes
l

l

After sorting the Node Coordinates spreadsheet into the desired order, select the Modify tab and click
the Relabel All or Relabel Selected button then select Nodes.
Alternatively, you can right-click in the Node Coordinates spreadsheet and select either Relabel
All Nodes or Relabel Selected Nodes.

Rounding Off Node Coordinates
l
l

Select the Modify tab and choose Round Off Coordinates.
Alternatively, you can right-click in the Node Coordinates spreadsheet and select Round Off Node
Coordinates.

Note
l

This utility will round off all the node coordinates to 1, 2, or 3 decimal places (user selected). This sometimes is useful for models that have been generated or created via DXF import and have node coordinates with a large number of decimal places that aren't significant. Rounding off those coordinates makes
the data more consistent and can help avoid problems such as non-coplanar plate/wall nodes. Also, the
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default member orientations can change based on whether the member is exactly parallel to a global axis
and slight unintended coordinate differences can have an impact here as well.

Node Coordinates Spreadsheet
The Node Coordinates spreadsheet records the node coordinates and ambient temperatures for the nodes and may
be accessed from the Spreadsheets tab Data Entry button Node Coordinates.

The first column is used to assign a unique Label to every node. You can then refer to the node by its label. Each
label has to be unique, so if you try to enter the same label more than once you will receive an error message. As
you create new lines, the program will automatically create a new, unique label for each node.
The next three columns contain the coordinates of the node in each of the global directions. These represent the
relative offsets of the nodes from the origin of the coordinate system (0, 0, 0). The appropriate units are listed at
the top of each column.
The next column is used to define the ambient, no-stress, temperature at the node. Temperature loads are then
calculated based on the differential between the ambient temperature interpolated across the member, and the
applied thermal load. See Loads - Thermal Loads for more information.
The last column is used to detach nodes from a diaphragm. See Diaphragms - Modeling Tips to learn more about
this.
Several options on the Modify tab help you work with nodes. Selecting Relabel All or Relabel Selected will let you
define a prefix to be used for the node labels before creating a new label for each node by using this prefix with a
sequential number. For example, if you were to enter a prefix of “FLR”, the first node would get label FLR1, the
second one would get FLR2, etc.
Another option is Round Off Coordinates. Selecting this will round off all the node coordinates to 1, 2, or 3 decimal
places. This is useful for models that have been created using generation functions or DXF files where a high
number of decimal places is present for some of the coordinates.

Node Information Dialog
Just as with the members and plates you may click any node to view it’s properties. All of the same information
that is stored in the Nodes spreadsheet is displayed for the node you choose, and may be edited. This is a quick
way to view and change node properties.
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Label - You can view and edit the joint’s label.
Coordinates - You can view and edit the node coordinates.
Temperature - Allows you to set the ambient temperature at that node for Thermal Loading.
Boundary Conditions - Here you can view and edit the node boundary conditions. The edit boxes to the right of
the boundary condition list boxes are where you would enter additional data for a boundary condition such as a
spring stiffness, a Story number, or a primary node label for a Tethered node.

Note
l

It’s more efficient to use the Properties panel to change the properties for many nodes at once. Simply
select multiple nodes in the 3D View and choose Nodes from the dropdown list in the Properties panel.
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Nodes - Results
When the model is solved, there are several groups of results specifically for the nodes. Story Drift calculation
results are discussed in Drift Results, the others are discussed here.

Node Deflections Results
Access the Node Deflections Spreadsheet by selecting it from the Results Menu.

These are the deflections, or displacements, for every node in the structure. Each node has 6 values calculated, 1 for
each of the 6 global degrees of freedom. Those being 3 translations and 3 rotations. The units for the displacements
are shown at the top of each column. The rotations are shown in units of radians (1 radian = 57.3 degrees,
approximately).
For enveloped results the maximum and minimum value for each displacement is listed. The load combination
producing the maximum or minimum is also listed, in the "lc" column. To include a particular Load Combination in
the envelope analysis, open the Load Combinations Spreadsheet and check the box in the Solve column.
The moving load results are enveloped and will display the Load Combinations with maximum and minimum values
shown for each section location, for each active member. The governing load combination and step location is
shown for each result value under the "LC" column. The first number is the load combination, the second is the step
number: (load combination - step number). See Moving Loads to learn more.

Note
l
l
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See Spreadsheet Operations to learn how to use Find, Sort, and other options.
See Results View Settings - Reactions to learn how to plot node results. You will NOT be able to plot the
deflected shape for an envelope analysis. This is because the various maximum and minimum displacements probably correspond to different load combinations, so a deflected shape based on these values would be meaningless.
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Node Reaction Results
Access the Node Reactions Spreadsheet by selecting it from the Results Menu.

These are the reactive forces applied to the structure at its points of support. A positive reaction is applied in the
direction of the global axis and a negative reaction is applied in the direction opposite the global axis. A positive
moment is given according to the right hand rule assuming the thumb is pointing in the positive global axis
direction. Assuming a reaction has been calculated at all points of support, the total of the reactive forces in each
direction should equal the total applied force in each direction. The units for the reactions are listed at the top of
each column, and a total reaction for each direction is summed at the bottom of each translation column.
Wall Panel Reactions represent the total reactions for the wall about the bottom center of the wall. This location
does not change even if the center of the wall is within an opening, or if the edge of the wall is restrained as well as
the base.
The last line provides the center of gravity (COG) for the applied loads. This "COG" is based on the load components
acting in the VERTICAL direction. If there are no vertical loads in the combination a "COG" will not be calculated.
For enveloped results the maximum and minimum reaction value is listed. The load combination producing the
maximum or minimum is also listed, in the "LC" column.
The moving results loads are enveloped and will display the Load Combinations with maximum and minimum
values shown for each section location, for each active member. The governing load combination and step location
is shown for each result value under the "LC" column. The first number is the load combination, the second is the
step number: (load combination - step number). See Moving Loads to learn more.
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Overstrength Tab
If your solution included a load combination that included overstrength load factors, a second tab will be included
in the Node Reactions spreadsheet. This tab contains all the reactive forces per the overstrength load combinations.

Note
l
l
l
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See Spreadsheet Operations to learn how to use Find, Sort, and other options.
See Results View Settings – Reactions to learn how to plot node results.
An 'NC' listing means "No Calculation". This occurs for boundary conditions defined with the 'Fixed'
option and joints with an enforced displacement in that degree of freedom.
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Nodes - Tethering Nodes
When a node is "tethered", it is linked in one or more directions to other nodes (the "Primary" node). Both nodes
(Tethered and Primary) actually share the same degree of freedom for the direction of tethering. The tethering can
be for any or all of the six global degrees of freedom. A node can be tethered to more than one node (in different
directions). Any number of nodes may be tethered to the same primary node, but the primary node itself may not
be tethered to another node.

Note:
l

Since the advent of rigid links there are not many circumstances where nodal tethering is the best solution
for modeling.

An example of the use of nodal tethering is in X bracing, where the bracing members overlay and are pinned to each
other. Modeling this connection makes the analysis far more complex than simply modeling the braces as separate
pieces, and is generally not recommended. However, if it is desired to specifically account for interaction between
the braces then this pinning will force the brace midpoints to deflect together for translations, but still leave them
free to rotate independently.

In this diagram the braces are NOT modeled as physical members. Brace 1 to 3 is modeled with non physical
members from nodes 1 to 5 and 5 to 3. Brace 2 to 4 is modeled with non physical members from nodes 2 to 6 and
6 to 4. Nodes 5 and 6 are at the same location where the braces overlap and are pinned together.
We would tether node 6 to node 5 for the translation directions. To define a tethered node, use the Boundary
Conditions spreadsheet. Enter the label of the node to be tethered as the "Node No.", and for the directions in
which it is tethered, enter TETHER nnn, where nnn is the label of the primary node.
For this X brace example, we would enter the following on the Boundary Conditions spreadsheet:

Here we have "TETHER 5" entered for the X, Y and Z translations. The rotation fields areleft blank because node 6
is free to rotate independently. We don't have to enter anything for node 5.

Note:
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l
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Tethered nodes should NOT be used to build rigid diaphragms. Tethering the translations will not give
correct diaphragm behavior. If you need a rigid diaphragm, you should use the Rigid Diaphragm feature.
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P-Delta - Analysis
When a model is loaded, it deflects. The deflections in the members of the model may induce secondary moments
due to the fact that the ends of the member may no longer be co-linear in the deflected position. These secondary
effects, for members (not plates), can be accurately approximated through the use of P-Delta analysis. This type of
analysis is called "P-Delta" because the magnitude of the secondary moment is equal to "P", the axial force in the
member, times "Delta", the distance one end of the member is offset from the other end.
Since RISAFloor is designing entirely for gravity loads it does not need to account for the P-Delta effect. However,
elements of the lateral force resisting system do need to consider this effect when being designed for lateral forces.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: P-Delta.
To Perform a P-Delta Analysis
l

l

In Model Settings -Solution tab, click the Advanced button to choose one of the two methods for PDelta Analysis, namely the Standard Nodal Shear Method and the Geometric Nonlinear Stiffness Method.
On the Load Combination spreadsheet, indicate the P-Delta combinations by placing a "Y" in the PDelta column.

Note
l

You may indicate a compression only P-Delta analysis by placing a "C" in the P-Delta column.

P-Delta Procedure
Standard Nodal Shear Method
The actual modeling of these secondary moments is done through the calculation of secondary shears (shown as V
in the diagram):

P*Δ=V*L
so, V = P * Δ / L
These shear forces are applied at the member ends. For a 3D model, this P-Delta calculation is done for the
member's local y and local z directions.
1.
2.
3.
4.

The solution sequence is as follows:
Solve the model with original applied loads
Calculate the shears (V's) for every member in the model
Add these the shears (V's) to the original loads and re-solve
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5. Compare the displacements for this new solution to those obtained from the previous solution. If they fall
within the convergence tolerance the solution has converged. If not, return to step 2 and repeat.
Geometric Nonlinear Stiffness Method
Unlike the Standard Nodal Shear method, the Geometric Nonlinear Stiffness Method does not apply any nodal shear
load to the member, instead, the stiffness matrix of the structure is directly modified to consider reduction of
stiffness due to axial loads. This method is based on approach by Chen, W. F. and Lui, E. M., Structural Stability:
Theory and Implementation (1987).
Similar as the Standard Nodal Shear Method, this method also requires an iterative procedure. In Step one, the
linear static equilibrium equations are solved for the original model. In step two, the internal axial loads obtained
from step one are used to form the geometric stiffness matrices as shown below, where P is axial load and L is the
member length. The geometric stiffness matrix includes both the P-Delta and P-Small Delta effects. The geometric
stiffness matrix is then assembled with the original stiffness matrix to obtain an updated stiffness matrix which
considers P-Delta effect. The equilibrium equations are re-solved to obtain the new internal forces/new geometric
stiffness matrices, and this procedure is repeated until it converges.

P-Delta Divergence
For both methods, if the P-Delta process is diverging dramatically, it will be stopped before numerical problems
develop and an error will be displayed. If this error is displayed, the P-Delta displacements have reached a level
where they are more than 1000 times greater than the maximum original displacements. If this happens with your
model, the model may be unstable under the given loads, or there may be local instabilities present. See P-Delta
Troubleshooting and Testing Instabilities to learn how to solve these problems.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: P-Delta.

P-Delta Limitations on Standard Nodal Shear Method
The P-Delta algorithm in the Standard Nodal Shear Method is based on end-joint displacements and will not
automatically account for the effect of interior span forces on members, or member end rotations. As such the RISA
implementation of P-Delta can be referred to as a P-Big Delta analysis.
In addition to the P-Big Delta effect, there can also be a P-Little Delta effect caused by end node rotation or
transverse loading between node points. Please refer to the P-Little Delta topic for more information.

Note
l
l
l

P-Small Delta effect is considered in Geometric Nonlinear Stiffness Method.
P-Delta effects are not calculated for plates.
P-Delta effects are not currently include in Dynamic / Modal Analysis.

Compression Only P-Delta
The P-Delta effect can be thought of as decreasing the flexural stiffness of members in compression and increasing
the flexural stiffness of members in tension. It is possible that if you have members with extremely large tensile
forces, and intermediate nodes that are not connected to supports or other "stiff" members, the P-Delta algorithm
could cause a node displacement to reverse direction, instead of converging to zero. This is an incorrect result. (A
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practical example where this could happen would be a truss chord with a large amount of tension that also has
extra nodes in-between the panel points.) If you have members with very large tensile forces, and intermediate
nodes , you may want to do a "compression only" P-Delta analysis. You invoke this by putting a "C" in the P-Delta
field, instead of a "Y". A "compression only" P-Delta analysis will only affect members that are in axial compression.
The P-Delta analysis will not modify members that are in tension.

P-Delta Convergence
The default convergence tolerance is 0.5%. This means that the displacements from one solution to the next must
vary by no more than ½ of 1 percent for the solution to be considered converged. You may adjust this tolerance on
the Model Settings. If you have a model that does converge but takes a lot of iterations, you may want to increase
this tolerance so convergence is faster. Be careful! If you set this value too high, unstable models may falsely
converge. It is not advisable to set this value above 2 or 3 percent.

P-Delta Troubleshooting
The first step in troubleshooting a P-Delta model that won't converge is to run the load combination without PDelta analysis and make sure there are no instabilities. If it turns out that degrees of freedom are being locked, this
indicates instabilities that you will want to fix.
In some ways, a P-Delta divergence may indicate an elastic buckling failure. Therefore, any P-Delta instabilities
should be taken seriously and investigated thoroughly.

Local Instabilities
By far, the most common cause of P-Delta convergence problems is local instabilities. A local instability is when one
part of the model is unstable causing the P-Delta analysis to diverge. To locate local instabilities, run the solution
with P-Delta analysis turned OFF. Now plot the exaggerated deflected shape and animate it. Any local instabilities
should be apparent. See Testing Instabilities for more information.
If you are trying to model P-Delta effects on a 2D frame, you will want to make sure that you restrain the out-ofplane degrees of freedom. See to learn how to do this.

Flexible Structures
In some cases, a model may be so flexible that it is not possible to run a P-Delta analysis. A situation where this
might occur would be a wood frame where all the connections were modeled as pins, but the boundary conditions
did not provide positive lateral support. In the real world, the connections will take some moment and the structure
would be fine, but in the idealized model, there is zero moment resistance at each connection. The total lateral
stiffness would be very small and this would make convergence of a P-Delta analysis unlikely.

Stiffness Reduction for the Direct Analysis Method
The Direct Analysis method requires a reduction in the axial and flexural stiffness of some members. This is done to
account for the non-linear material effects caused by residual stresses. This stiffness reduction can be problematic
during the early stages of design when your members may be smaller than they will be after basic drift and stress
criteria are met. Therefore, RISA gives you the option (on the Codes tab of the Model Settings) to turn off this
stiffness reduction or set it to a constant value (tau = 1.0).

P-Delta Amplification for AISC ASD
In order to ensure that using LRFD load factors does not result in a penalizing effect for P-Delta analysis, the
AISC specification requires that the forces be multiplied by 1.6 during ASD analysis. Therefore, if AISC (360-05, 36010, or 360-16) ASD is specified as the hot rolled code, RISA automatically multiplies all load combinations by 1.6
during solution, then divides the force results by 1.6 prior to displaying the results.
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P-Delta for ACI Concrete
See the P-Little-Delta Topic.

Wall Panels
The P-Delta effect is handled the same way for Wall Panels. The main difference is that the shears for a wall panel
are only generated at the top, story, or the diaphragm locations. The average deflection at the story height (or
diaphragm location) is used to calculate the P-Delta shears for the top and bottom of the story. These shears are
then distributed over the width of the wall at those locations.

Note
l

P-Delta effect is NOT considered for wall panels if Geometric Nonlinear Stiffness Method is selected.

Leaning Column Effect
Gravity columns and walls that are modeled in RISAFloor, but which are NOT included in the Lateral analysis will
still have an effect on the P-Delta analysis in RISA-3D. This is because RISA-3D automatically includes this leaning
column / leaning wall effect. This is done only for columns or walls that are contained within the a rigid diaphragm
slab edge at that floor level. The program then uses the RISAFloor column / wall axial loads (without considering LL
Reduction) along with the rigid diaphragm displacements (projected to each column / wall) to come up with
equivalent leaning column shears for the diaphragm.

Note
l

l
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The leaning column effect does not get accounted for columns or walls which do not connect to a diaphragm.
The leaning column effect does not get accounted for columns or walls that connect to flexible or semirigid diaphragms.
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P-Little Delta Analysis
The P-Little Delta effect is essentially the destabilizing effect of individual member curvature on the axially loaded
members. In practical applications, the effect of P-Little Delta will normally be significantly smaller than the P-Big
Delta effect. The following figure demonstrates the displacements that cause the P-Delta and P-Little Delta effect in
a typical moment frame.

P-Little Delta Procedure
The current implementation of P-Delta analysis does not directly account for the Little Delta effect. While this is
true, the model can be easily adjusted to account for the effect as shown in the figure below.

Because RISA's P-Delta method is based entirely on nodal deflections, the introduction of nodes at the locations
along the column where member displacement effects are at their maximum will adequately account for this effect.
There are a number of "benchmark" tests given in various publications to determine if a program is capable of
properly considering this effect. Some of these benchmark problems (from the AISC Commentary) have been posted
to our website with comparisons to theoretically correct solutions. These comparisons can be used as a basis for
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when the P-Little Delta effect is significant enough to consider in the analysis. They can also be used to determine
how many intermediate nodes are required to adequately account for the effect at a given load level.

Note
l

P-Little Delta effects will have more of an impact as a member approaches its elastic euler buckling load.
Special attention should be paid to cantilevered compression members, or members with significant
weak axis bending moments.

AISC Direct Analysis Method
The AISC manual specifically requires the consideration of the P-Little Delta effect. However, the Direct Analysis
Method (AISC 360-16, Chapter C) inherently acknowledges that P-Little Delta may not be important by stating that
it may be neglected when, “the axial loads in all members whose flexural stiffnesses are considered to contribute to
the lateral stability of the structure” are less than 15% of the Elastic / Euler buckling load of the member.
This may seem like it would be a low axial force, but it can actually be a very large force greater than the total axial
capacity of the column. Situations where this code provision may justify ignoring the P-Little Delta effect would
include strong axis bending of a wide flange column with equal unbraced lengths in the strong and weak axes.

ACI Concrete Design
As of the 2014 edition, ACI 318 offers three options to account for slenderness and curvature in columns and walls
(Section 6.2.6):
l
l
l

Moment Magnification (6.6.4.5)
Elastic Second Order Analysis (6.7)
Nonlinear Second Order Analysis (6.8)

Both forms of second order analysis are more accurate than the moment magnification procedure, which is a hand
calculation method intended to be used when computer analysis is not available. RISA does not have a true
nonlinear solver though, so the program performs an Elastic Second Order Analysis using cracked section
properties.

Columns in RISA-3D
In order to meet the requirements of Section 6.7 (thereby meeting the requirements of Section 6.2.6) you must turn
on P-Delta in the Load Combinations spreadsheet, and possibly add intermediate joints along the length of the
columns. The Split Member tool can be used to add joints along the physical columns.
When ACI 318-08 and newer is used the slenderness effects are not neglected per the provisions of Section 10.10.1
(ACI 318-14 Section 6.2.5)

Walls in RISA-3D
In order to meet the requirements of Section 6.7 (thereby meeting the requirements of Section 6.2.6) you must turn
on P-Delta in the Load Combinations spreadsheet and include P-Delta for walls in the Model Settings. The effects of
P-Little-Delta are accounted for in walls using the Non-Sway Moment Magnification Procedure of ACI 318-11
Section 10.10.6 or ACI 318-14 Section 6.6.4.5.

Limitations
l
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The provisions of ACI 318-11 Section 10.10.2.1 (ACI 318-14 Section 6.2.6) which state that P-Delta moments
should not exceed 1.4 times non-P-Delta moments are not considered.

RISA-3D V20

Plates/Shells

Plates/Shells
The plate/shell finite element allows you to easily model shear walls, diaphragms, shells, tanks and many other
surface structures. We refer to the elements as plate elements, but they are actually plate/shell elements. Plate data
may be viewed and edited in three ways: graphically, in the Information dialog or in the Plates spreadsheet.

Drawing Plates
There are several graphic-editing features that make the creation and modification of models quite easy. Use the
Plates button in the Home tab and Modify menu to use these features in the model view. To create new members or
plates, you can draw them using a drawing grid or draw "dot to dot" from existing nodes. Once you have created
these items, you may use other graphic features to load the model and set boundary conditions.
Creating plate models requires more forethought than beam models. See Plate Modeling Tips and Plate Modeling
Examples for tips on building plate models. To create new plates you can draw them using a drawing grid, a project
grid, or draw "dot to dot" from existing nodes. You can set all of the plate properties up front or you can modify
these properties after you draw them. Modifying properties is discussed in the next sections. See Plate Spreadsheet
for information on plates and their properties.
The Plates tool lets you graphically draw plates in your model. Enter the appropriate plate parameters, and draw
plates between existing nodes or on the drawing grid. You will also notice that the coordinates of the node or grid
point that is closest to your cursor are displayed next to your cursor. The new plates will be shown on screen and
will be recorded in the Plates Spreadsheet.
To actually draw a plate, you have two options. The fastest way is to use the Create Plates by Clicking on Grid
Areas option, and then create plates by clicking on the grid areas formed by the intersecting grid lines. As you click
on an area, a plate will automatically be created in that area. The second option is to create plates by drawing them
one node at a time. You click on the grid point or node that you want to be the "A" node for the plate, then you click
on the "B" node, "C" node, and then the "D" node in either clockwise or counter clockwise order. The plate will
"stretch" like a rubber band as you draw from node to node.

The parameters shown are the same parameters that you would enter on the Plates Spreadsheet.
To Draw Plates
1. If there is not a model view already open then click the View tab on the Ribbon Toolbar and then press the
Open 3D Views button to open a new view.
2. If you are not drawing between existing nodes, you will need to create a drawing grid or define nodes on the
Node Coordinates spreadsheet.
3. Click the Plates button. Then set the plate properties.
a. You must click four points in a clockwise or counter-clockwise order. To create a triangular plate click
on the third joint twice.
b. If in step 3 you chose to click in grid areas then you create plates by clicking between the drawing
grids.
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4. Click OK to start drawing plates by clicking on the nodes or grid points with the left mouse button.
5. To stop drawing altogether right click or press the Esc key.

Note
l

l
l
l
l

The default plate local axis is Global. To set this to Nodal, see Axis settings in the Model Settings. For more
information on plate local axes, see Plate Local Axes.
To draw more plates with different properties, press CTRL-D to recall the Plate Properties settings.
You may also specify or edit plates in the Plates Spreadsheet.
You may also view and edit plate properties by clicking on a plate.
You may undo any mistakes by clicking the Undo button.

Modifying Plates
There are a number of ways to modify plates. You may view and edit the member data in the Plates
Spreadsheet. You may click a plate to view and edit its properties. You can select multiple plates to graphically
modify a possibly large selection of members.
The Plates Properties Panel discussed here lets you modify the properties of plates that already exist in your
model. To use this, you will select the plates you want to modify, specify the properties you want to change, and the
program will automatically update the properties. You can modify plates one at a time by clicking them individually
and then changing the properties in the Properties Panel. See the Graphic Selection topic for more on selecting.
The parameters shown are the same as those used to define new plates.
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Rotating Plates
These options allow the user to perform a clockwise, or counter clockwise rotation so that they can better align the
plate local axes. It also allows the user to flip the local z-axis so that it is headed in the other direction.
To Modify Plates
1. If there is not a model view already open then click View tab on the Ribbon Toolbar then click the Open
3D Views button to open a new view.
2. Click an individual plate or select multiple then change the values in the Properties Panel as desired and
the program will automatically update them.

Note
l
l
l

You may also modify plates in the Plates Spreadsheet.
You may undo any mistakes by clicking the Undo button.
It may not be possible to perfectly align the plate local axes.

Submeshing Plates
On the Home tab, click the Automesh of Plates button. There are three options to submesh plates: auto submesh,
quad submesh, and tri submesh. You can click the triple dot next to Meshing to open up the Submeshing Options
dialog.
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Auto Submesh Plates
The Auto Submesh option in the Meshing drop down menu in the Plates Properties Panel allows you to draw a
polygon that RISA-3D will automatically submesh into smaller quadrilateral plate elements. Just as with Drawing
Plates, the material set and plate thickness of the plates within the mesh may be indicated prior to drawing the
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polygon. In addition to these parameters, a plate edge maximum can also be provided. Polygons of virtually any size
and shape may be drawn provided the drawing lines do not cross. The polygon points must be on the same plane,
either one of the three global planes (XY, XZ, or YZ) or co-planar. Polygons may be drawn in either a clockwise or
counter-clockwise direction. To complete a polygon, simply double click on the last node/grid intersection, or click
on the starting node/grid intersection. Once a polygon is drawn, RISA-3D will create a submesh of quadrilateral
plate elements, limited by the edges of the polygon, and of a size corresponding to the plate edge maximum
indicated by the user. Note that only quadrilateral plate elements are created with the Auto Submesh tool.

When drawing a polygon with the Auto Submesh tool, any existing nodes within the boundary and in the plane of
the polygon will be considered control points. These Control Points will be considered "fixed" points within the
mesh and will dictate the layout of individual plates surrounding them. It is important to note that only currently
selected nodes at the time the polygon is drawn will be used as control points.
To AutoMesh a Polygon
1. If there is not a model view already open then click the View tab on the Ribbon Toolbar and then click the
Open 3D Views button to open a new view.
2. If you are not drawing between existing nodes, you will need to create a drawing grid or define nodes on the
Node Coordinates spreadsheet.
3. Make sure that all nodes that are to be considered Control Points are selected.
4. Click the Plates button and select the Auto Submesh from the Meshing drop down menu. Then set the
plate properties including the plate edge maximum.
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5. Click OK to start drawing a polygon by clicking on the nodes or grid points with the left mouse button.
6. To complete the drawing of a polygon, double click the last point or click on the original starting point.
7. To stop drawing altogether, right click or press the Esc key.

Note
l
l
l

You may also specify or edit plates in the Plates Spreadsheet.
You may also view and edit plate properties by clicking on a plate.
You may undo any mistakes by clicking the Undo button.

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Plate Mesh.

Quadrilateral Plates
You can submesh quadrilateral (4 sided) plate elements into a mesh of smaller elements by using the Quad
Submesh option from the Meshing drop down menu prior to drawing or after the fact by clicking the Submesh
Plates button in the Modify tab of the Ribbon Toolbar then selecting the Quad button in the Properties Panel.
This new mesh can be any size up to the program limits for nodes and/or plates. This is very useful for refining a
coarse mesh of elements, just make sure that all adjacent plate elements (elements sharing an edge) maintain
connectivity.

You can define different submesh increments in each direction. The A,B,C and D nodes for each plate are displayed
in the plates spreadsheet. The A node is the first node clicked on when you created the plate. The B node is the
second and so on. In addition, if the plate local axes is set to Nodal, you can determine which side is which by
displaying the plate local axes and realizing that the local x-axis is parallel to the D-C edge of the plate.
You can submesh the plates one at a time by selecting the Click to Apply option and then clicking on the plates you
wish to submesh. You may also modify entire selections of plates by selecting the plates and then using the Apply
to Selected option.
To Submesh Quadrilateral Plates
1. If there is not a model view already open then click the View tab on the Ribbon Toolbar then click the
Open 3D Views button to open a new view.
2. Select the plates you want to sub mesh.
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3. Click the Submesh Plates button in the Plates section of the Modify tab and select the Quads button in the
Properties Panel. Then specify the number of plates.

Note
l
l

To submesh more plates with different parameters, press CTRL-D to recall the Submesh Plates action.
You may undo any mistakes by clicking the Undo button.

Triangular Plates
This is used to sub-mesh the selected triangular (3 sided) elements into a mesh of 3 quadrilaterals. This is done by
first creating a new node at the center of each selected triangular element and also at the center point along each
edge of the triangular element. These new nodes are then used to create three quadrilateral elements that replace
the triangular element.

To Submesh Triangular Plates
1. If there is not a model view already open then click the View tab on the Ribbon Toolbar then click the
Open 3D Views button to open a new view .
2. Select the plates you want to sub mesh.
3. Click the Submesh Plates button in the Plates section of the Modify tab and select the Tri button in the
Properties Panel.

Note
l
l

To submesh more plates with different parameters, press CTRL-D to recall the Submesh Plates action.
You may undo any mistakes by clicking the Undo button.

Plates Spreadsheet - Primary Data
The Plates Spreadsheet records the properties for the plate/shell elements of the model and may be accessed by
selecting Plates on the Data Entry menu.
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The following data columns hold the Primary data for the plates:

Plate Labels
You may assign a unique label to any or all of the plates. You can then refer to the plate by its label. Each label has
to be unique, so if you try to enter the same label more than once you will get an error message. You may
relabel plates at any time with the Relabel Allor Relabel Selected buttons in the Modify tab of the Ribbon
Toolbar.

Plate Nodes
The A, B, C, and D node entries are used to define the 4 corner nodes of a quadrilateral element. (To define a 3node triangle element, just leave the D node entry blank, or make it the same as the C node.) The nodes must all lie
on the same plane and be entered in either a clockwise or counter-clockwise sequence.
The direction and sequence in which you define the nodes determines how the elements local coordinate system is
set up. This is discussed in the section on Plate Local Axes.

Plate Material
The material set label links the plate with the desired material defined on the Materials Spreadsheet.

Note
l

Plates are always defined with general materials. This is because the other material sets (Hot Rolled, Cold
Formed, Wood, and Concrete) are used to designate member code checking specifications. Since plates are
only used for analysis, no code checking is provided and the material must be designated as a general material.

Plate Thickness
The thickness field on the Plates spreadsheet is the thickness of the element. This thickness is constant over the
entire element.
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Plates Spreadsheet - Advanced Data

The following data columns hold the Advanced data for the plates:

A, B, C, & D Release
The Plate Corner Releases for nodes A, B, C, and D of each plate may be set in these four data columns. See Plate
Corner Releases for more information.

Activation
The Activation data column allows for plates to be set to 'Active', 'Inactive', or 'Excluded'. These choices may be
made by selecting them from the drop down list or by entering an 'I' for 'Inactive' or an 'E' for 'Excluded'. If the cell
is left blank the plate will be 'Active' by default. See Inactive and Excluded Plates for more information.

Plane Stress
The plate formulation may be changed to indicate that the plate is a Plane Stress plate by checking the box in this
data column. This is useful for creating diaphragms that have only in-plane stiffness and will not attract out of plane
shear or moment. The default is to have this box unchecked which allows for both in-plane and out of plane
behavior.

Plate Information
Just as with the node and members you may click any plate to view it’s properties. All of the same information that
is stored in the Plates Spreadsheet is displayed for the plate you choose, and may be edited. This is a quick way to
view and change plate properties. For large selections of plates however the spreadsheet and graphic editing tools
may be the faster solution.
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Label - You can view and edit the plate label.
Corner Nodes - The corner node labels are displayed for you to view or edit.
Thickness Material - The plate thickness (in the current dimension units) and the material may be viewed or
edited.
Activation - The activation state of the plate may be changed. If the plate is made inactive, you will need to activate
the plate from the Plates spreadsheet, or by using the Criteria Select feature to find and select inactive plates.
Plane Stress- The plate formulation may be changed to indicate that the plate is a Plane Stress plate. This is useful
for creating diaphragms that have only in-plane stiffness and will not attract out of plane moments. The default is
to leave this box unchecked which allows for both in-plane and out of plane behavior.

Note
l

It’s generally more efficient to use the Graphic Editing features if you want to change the properties for
many plates at once.

Plate Corner Releases
The A, B, C, & D Release fields are used to designate whether the forces and moments at the corners of the plate
are considered fixed to or released from the plates's points of attachment (the A, B, C, and D nodes). Each plate has
5 force components at each corner (Fx, Fy, Fz, Mx, and My). Any or all of these force components can be released
from the plate's point of attachment. If a force component is released, that force is not transferred between the
node and the plate.
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To specify plate corner releases go to the A, B, C, or D Release fields for the plate in the Advanced Properties of
the Plates Properties Panel, click the ellipsis button, and specify the condition.
Alternatively, you may specify the corner condition by directly typing in the field. To indicate that a force
component is released, put a 'X' for that component in the release field. Enter 'O' for no release.
RISA-3D has a special "keyword" release configuration built-in. That is:
PIN => Mx and My (all moments) released (OOOXX)
This keyword entry is included because 99% of the release configurations you'll ever want to define will be "PIN".
You can call out the keyword entry by just entering the first letter of the keyword, "p". So if you go to a release field
and enter "p", the keyword "PIN" will be filled in automatically.

Note
l

It’s generally more efficient to use the Graphic Editing features if you want to change the properties for
many plates at once.

Inactive and Excluded Plates
Making an item such as a member or plate inactive allows you to analyze the structure without the item, without
having to delete the information that defines it. This leaves data intact so the item may be easily reactivated. This
is handy if you want to try a model with and then without certain items, without having to actually delete the data.
Choosing Inactive Items means the item is not included when the model is solved or plotted.
Choosing Excluded means include the item in the solution, but exclude it from the results list. So, an item set to
Excluded will be treated like any other plate in the solution and plotting of the model, but the plate will not be
listed in the solution results (forces, stresses etc.). This is useful if there are certain items whose results you're not
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interested in. You don't have to clutter up the results with these items and can concentrate on the items you're
most interested in. See Printing for more limiting printed results.

Plate Local Axes
The A, B, C, and D nodes are used to define the corners of a quadrilateral element. (To define a 3-node element, just
leave the D node blank, or make it the same as the C node.) The nodes must all lie on the same plane and be
entered in either a clockwise or counter-clockwise direction.
The direction and sequence in which you define the joints determines how the elements local coordinate system is
set up. The plate local axes can be set to Global or Nodal in the Solution settings in the Model Settings. The
following images depict the difference between Global and Nodal plate local axes, which are shown graphically in
green. To view the plate local axes in such a manner, add the Plate Local Axes button from the available toolbar
buttons. For more information, see Customizable Model View Toolbar.

When the plate local axis is set to Global, the local axes of all plates will be oriented in the same orthogonal
direction, regardless of plate geometry. However, the positive out-of-plane z-axis will be dependent on the
configuration in which the plate or mesh was drawn. The plate local out-of-plane axis will always be the z-axis, but
the positive direction of this axis will be dependent on the direction in which you define the nodes of the plate.
Defining the nodes in a clockwise pattern will result in the out-of-plane z-axis pointing in the positive direction
according to the global axes. For example, in the global XZ-plane, a plate drawn in the positive clockwise direction
will result in the plate local out-of-plane z-axis pointing along the global positive Y-axis. Similarly, a counterclockwise pattern will result in the out-of-plane z-axis pointing in the negative global axes direction. Plates do not
follow the right-hand rule that is common in three-dimensional vector orientation. For more information on the
interpretation of plate results based on local axis orientation, see Plate Force Results.
When the plate local axis is set to Nodal, the local x-axis is defined as positive from the D node towards the C joint
for 4 node elements and from C towards B for 3 node elements. The local y-axis is then placed as close to pointing
towards the A-node as possible. Note that for triangular elements, the y-axis will probably not pass through the Anode. For 3 node elements, the y-axis is “towards” the A-joint and perpendicular to the x-axis. Once the x and y
axes are defined, the positive local z-axis is found using the right hand rule.
The following diagrams illustrate how the elements local coordinate system is related to the node numbering
sequence and direction:
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The default plate local axis is set to Global. To change this to Nodal, see Axis settings in the Model Settings.

Plate/Shell Element Formulation
The element used is a mixed interpolation 4 node quadrilateral element. By mixed interpolation, we mean that the
in-plane and transverse shear strain components are derived independently. This allows the element to be easily
simplified into a plane stress element in cases where transverse shear and bending are not desired. A reference for
this element is Finite Element Procedures, by K.J. Bathe, Prentice-Hall, 1996. The book also provides many
references for papers on the elements convergence and other characteristics. In brief, the element can model
isotropic behavior for plane stress, plate bending and out-of-plane transverse shear.
This is accomplished by starting with the Mindlin-Reissner plate assumptions and adding interpolating functions for
the out- of-plane transverse shear. This approach is analogous to incorporating shear deformation with flexural
effects in beam theory. This results in an element that can be used for thin and thick plate applications. Traditional
plate elements do not model out-of-plane transverse shear well (if at all) and cannot be used for thick plate
applications. The element is also very insensitive to distortion.

Note:
l

The linear-elastic behavior of the program implicitly means that non-linear (2nd order) behavior is not generally supported. Tension-structures such as fabric structures would fall into this non-linear category. Please
see the Modeling Tips - Modeling a Cable section for some ways to approximate this behavior. This section is
applicable to members but the principles illustrated are also applicable to plate modeling as well.

RISA-3D also provides a 3-node triangle element that can be used to build transitional meshes. The stress
characteristics of the triangle are not as accurate as the 4-node quad and use of the triangle should be limited. It is
not recommended that the stresses from the 3-node triangle be used at all. In fact, RISA-3D's Auto Submesh tool
will only create quadrilateral plate elements for this very reason. RISA-3D provides a way to convert your triangular
plates to quadrilaterals, see Submeshing Triangular Plates.

Orthotropic Behavior
The RISA plate element can use two types of plate methodologies for analysis: Isotropic and Orthotropic. The plate
material and methodology can be defined in the Materials spreadsheet under the General tab.
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By default the material properties shown in the Materials/General spreadsheet are for Isotropic material. Isotropic
materials can be used by all element types in the program such as Members, Wall Panels, Solids, and Plates. By
using the Isotropic plate methodology, the plate element does allow a limited degree of orthotropic material
behavior. Specifically, the In-Plane shearing of the plate will be almost entirely controlled by the G value for the
material whereas the direct In-Plane compressive stiffness will be controlled by the E value of the material.
If users toggle the Plate Methodology to Orthotropic, the detailed orthotropic material properties can be defined in
the Edit Orthotropic Material dialog after clicking the triple dots in the Plate Methodology cell.

The orthotropic material properties can be defined per plate local axes. E1 and E2 correspond to Ex and Ey, which
are Young’s modulus in plate's local x and y directions. Similarly, G12, G13, and G23 correspond to Gxy, Gxz, and
Gyz, which are shear modulus per plate's local axes. Nu12 corresponds to Nuxy, which is the Poisson’s ratio
between plate's local x and y direction.
All plates need to have their local axes orientation set as "Global" instead of "Nodal" for the program to analyze
orthotropic behavior. This can be set in the Plate Local Axis Orientation setting under the Global Model Setting.
The following stress-strain relationship is used in the program for orthotropic material:
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Note:
l

Currently orthotropic plate methodology can only be applied to Plate elements in the program. If an orthotropic material is applied to Members, Wall Panels, or Solids, it will be treated as an isotropic material, with
E, G, and Nu taken as E1, G12, and Nu12 from the orthotropic material input. Warning messages will be given
after solution to explain this behavior.

Plate Modeling Tips
A word of caution is in order if you are new to plate modeling. Unlike modeling with beam elements, plate
elements require some understanding of finite element behavior to successfully obtain meaningful results. It is easy
to build a finite element model using the powerful generators and graphic editing tools. However, without
understanding the limitations of the analysis method used, you can end up with an impressive looking but very
inaccurate model. Even if you’ve been engaged in structural engineering for years, modeling with plates is not
something most engineers do frequently. It is therefore not realistic to have the expectation that you should be able
to perform complicated analysis with plate elements in a short amount of time. Good plate modeling takes time,
knowledge of plate and finite element behavior, and experience.
The first tip is to read all the Plate documentation before embarking on an ambitious modeling project. This will
save you much aggravation down the road.

Plate Distortion
The finite elements in a model should be as undistorted as possible. See the following figure:
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Non-Planar Plates
The plate element formulation used in RISA is not very sensitive to distortion within the plane of the plate itself
(see the plate Distortion topic above). However, the plate element formation is particularly sensitive to non-planar
plates. This means that it is critical that all 4 nodes that define a quadrilateral plate remain in the same plane. There
is an internal tolerance of 0.01 inches built into the plate element formulation for maximum allowable planar
distortion. This is appropriate for concrete slabs and shear walls and such. But, extra care should be given to
avoiding out-of-plane plates for extremely small and thin plates.

Plate Generation
A fast way to build a new mesh of finite elements is with the generation features. RISA-3D currently provides
several generation features to quickly build common structures providing an easy way to create cylinders, cones,
grids, radial grids and disks of plates. The best way to see what these features do is to experiment with them. See
Generation to learn more about generation.
Another time-saving method is to draw large elements to represent continuums such as slabs and shear walls and
then use the submesh features mentioned below to refine the mesh.

Note:
l

Before sub-meshing, make sure that any adjacent “large” elements connect at their corner nodes. That way,
any subsequent sub-mesh operations will produce element meshes that automatically connect at the intermediate nodes.

Automatic Plate Sub-Meshing
What if you’ve already built a model and you now decide that your finite element mesh is too coarse? To submesh
elements see Submeshing Plates. Performing a Model Merge afterwards will insure that all the new elements get
connected to existing beam elements and that duplicate nodes get merged. See Model Merge for more information.

Plate Error Checking
The program cannot provide a solution for plates which are poorly shaped or not planar. If any such
"degenerate" plates exist, an error is produced during the solution. Use the Degenerate Plate Check utility in the
Plates section of Modify tab in the Ribbon Toolbar to fix these issues.
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This utility can be used for two purposes:
l

l

Show Problematic Plates provides a model view showing all plates that were non-planar or poorly shaped.
A summary report lists the number of degenerate plates, and the warning log is populated with an exact list.
Split Problematic Plates splits each non-planar plate into four triangular plates. By definition a triangular
plate is always planar, so this will allow the model to solve. The force and stress results for these triangular
plates are not accurate, and should not be used for design. However, the stiffness is adequate for force transfer, so this splitting tool provides a convenient method to force a solution in a model where manually fixing
the plates to be planar would be too time consuming, and where the plate stresses are not a concern.

Finite Element Basics
While this will not be a comprehensive treatment of plate and finite element fundamentals, a review of certain key
basic concepts and terminology will be valuable to the engineer who has not worked with finite elements, or has
not had the opportunity to use them recently.
A place to start is with the types of forces or stresses that can occur in a plate. One term that is commonly used is
“plane stress”. This term is used to describe a state of stress in a plate where all the stresses occur in the plane of
the plate. A real world example would be a shear wall with forces applied only in the plane of the wall. The
resulting plate forces would be just the normal stresses (Fx, Fy) and the in-plane shear stresses (Fxy). There would
be no plate moments or out-of-plane shears generated.

Stress vs. Force
It should be pointed out that the results for a plate are always a stress. These stresses are multiplied by the plate
thickness and the width or length to obtain a force. Note that this force obtained is just an average value for the
plate, since the stress was for a point on the plate and it undoubtedly will vary throughout the plate area. The fact
that the stresses vary within a plate is why a good finite element mesh is so critical to obtain accurate results.
Stresses tend to vary more around point loads and supports, and less in regions that are far from supports and have
a uniform load.
A different example of plate forces would be a horizontal diaphragm that is loaded only in the out-of-plane
direction. The plate results would be plate moments, out-of-plane shears, but no membrane (plane stress) stresses.
The reason for no membrane stresses is that there was no in-plane loading.

Sign Convention
One other comment on plate results is to point out the convention used for moments in plates. With beams, the My
moment describes the moment about the local y-axis. However, with a plate element, the My moment is the
moment that produces stresses in the local y-direction. The My moment in a plate is actually about the local x-axis.
For more information, see Plate Force Results.

General Reference Manual

557

Plates/Shells

Why Meshing Is Required
In a nutshell, finite elements tend to work by trying to approximate the correct deflected shape of the real world
item being modeled. For example, if we are trying to model a horizontal diaphragm, simply supported on all edges,
and loaded out-of- plane, our finite element model must able to approximately recreate the deflected shape of the
diaphragm.
In order to do this with some accuracy, we must use a mesh of elements to represent the physical diaphragm. If we
try to model the diaphragm with only one element (which is what everyone tries to do at least once), we will get
very inaccurate results because one finite element cannot accurately model the deflected shape of the physical
diaphragm. The multiple reasons for this are beyond the scope of this file, and if you want to understand the “why”
please study a reference on finite element analysis such as Bathe’s book.
The most important concept to understand is that finite elements require a certain number of free or unrestrained
nodes in order to produce accurate results. Using enough elements in your mesh will produce accurate results for
the deflection and stresses in the structural item being modeled. The gage of “enough” for common structural
elements is addressed in the Plate Model Examples section of the Reference Manual.

Distortion
Finite elements are also affected by geometric distortion. The best shape for the 4-node quadrilateral is a square.
In practice, elements are frequently distorted, which is fine as long as they aren’t squashed too far out of shape.
The largest internal angle should never be equal to or greater than 180 degrees, and preferably shouldn’t even
approach 180 degrees.

Drilling Degree of Freedom
One last item is that the element used by RISA-3D, like other plate/shell elements, cannot accurately model in-plane
rotations. I.e., a plate/shell element will not provide resistance to a moment applied about the plate’s local z-axis.
For example, let’s say you have a 4x4 grid of elements, simply supported about the edges, and you apply a node
moment to one of the internal nodes so that the moment is about the local z-axis of the elements. RISA-3D will
solve such a model, however you will get all zeros for the node reactions and the element stresses. See Applying InPlane Moments to Plates to learn how to work around this limitation.
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When the model is solved, there are several groups of results spreadsheets specifically for the plates.

Plate Stress Results
Access the Plate Stresses Spreadsheet by selecting the Results Tab Envelope (or LC) button Plate
Stresses. Alternatively, on the Results menu from the Explorer Panel you can select Plate Stresses Spreadsheet.

The plate stresses are listed for the top and bottom of each active plate. The principal stresses sigma1 (σ1) and
sigma2 (σ2) are the maximum and minimum normal stresses on the element at the geometric center of the plate.
The Tau Max (tmax) stress is the maximum shear stress. The Angle entry is the angle between the element's local xaxis, and the direction of the σ1 stress (in radians). The Von Mises value is calculated using σ1 and σ2, but not σ3
which isn't available for a surface (plate/shell) element, so this Von Mises stress does not include any transverse
shear forces.
The equations are:

The angle, Φ, is the angle in radians between the maximum normal stress and the local x-axis. The direction of the
maximum shear stress, τmax, is ± π/4 radians from the principal stress directions.
The Von Mises stress is a combination of the principal stresses and represents the maximum energy of distortion
within the element. This stress can be compared to the tensile yield stress of ductile materials for design purposes.
For example, if a steel plate has a tensile yield stress of 36ksi, then a Von Mises stress of 36ksi or higher would
indicate yielding of the material at some point in the plate.
The σx , σy , and σxy values used to calculate the stresses are a combination of the plate bending and membrane
stresses, thus the results are listed for the top and bottom surfaces of the element. The “Top” is the extreme fiber of
the element in the positive local z direction, and the “Bottom” is the extreme fiber of the element in the negative
local z direction. The membrane stresses are constant through the thickness of the element, while the bending
stresses vary through the thickness of the element, very similar to the bending stress distribution in a beam.
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For enveloped results the maximum and minimum value at each location is listed. The load combination producing
the maximum or minimum is also listed, in the "LC" column.

Note
l
l

See Spreadsheet Operations to learn how to use Find, Sort and other options.
See Results View Settings to learn how to plot Plate Stress results.

Plate Force Results
Access the Plate Forces Spreadsheet by selecting the Results Tab Envelope (or LC) button
Forces. Alternatively, on the Results toolbar you can select Plate Forces Spreadsheet.

Plate

The Plate Forces are listed for each active plate. Interpretation of output results is perhaps the most challenging
aspect in using the plate/shell element. The results for the plates are shown for the geometric center of the plate.

The forces (Qx and Qy) are the out-of-plane (also called “transverse”) shears that occur through the thickness of the
element. The Qx shear occurs on the element faces that are perpendicular to the local x-axis, and the Qy shear
occurs on the element faces that are perpendicular to the local y-axis. Qx is positive in the z-direction on the
element face whose normal vector is in the positive x-direction. This is also the σx face. Qy is positive in the z-
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direction on the element face whose normal vector is in the positive y-direction. This is also the σy face. The total
transverse shear on an element face is found by multiplying the given force by the width of the element face.
The plate bending moments (Mx, My and Mxy) are the plate forces that induce linearly varying bending stresses
through the thickness of the element. Mx is the moment that causes stresses in the positive x-direction on the top of
the element. Likewise, My is the moment that causes stresses in the positive y-direction on the top of the element.
Mx can then be thought of as occurring on element faces that are perpendicular to the local x-axis, and the My
moment occurs on faces that are perpendicular to the local y axis. To calculate the total Mx or My on the face of an
element, multiply the given value by the length of the element that is parallel to the axis of the moment. For
example, looking at the 'Plate Moments' figure above, the total Mx moment could be obtained by multiplying the
given Mx force by the length of side BC (the distance from joint B to joint C). The total My force can be calculated in
the same way by instead using the length of side DC.
The Mxy moment is the out-of-plane twist or warp in the element. This moment can be added to the Mx or My
moment to obtain the 'total' Mx or My moment in the element for design purposes. This direct addition is valid since
on either the top or bottom surface, the bending stresses from Mxy will be going in the same direction as the Mx and
My moments.

Note
l

l

For the placement of concrete reinforcement, it is helpful to realize that laying reinforcement parallel to
the local x-axis will resist the Mx moment.
A positive Mx or My moment will put the top fiber of the plate in tension.

The plane stress forces (Fx , Fy and Fxy) are those forces that occur in the plane of the plate. These forces, which are
also called “membrane” forces, are constant through the thickness of the element. Fx and Fy are the normal forces
that occur respectively in the direction of the local plate x and y-axes, positive values indicating tension. These
forces are reported as a force/unit length. To get the total force on an element, you would need to multiply the
given value by the length of the element that is perpendicular to the normal force. For example, looking at the
'Plane Stress Forces' figure, the total Fx force could be obtained by multiplying the given Fx force by the length of
side BC (the distance from joint B to joint C).
The Fxy force is the in-plane shear force that occurs along the side of the element. The subscript 'xy' indicates that
the shear occurs on the face of the element that is perpendicular to the x-axis and is pointing in the y-direction. Fyx
is the complementary shear force, where the subscript 'yx' indicates that the shear occurs on the face of the element
that is perpendicular to the y-axis and is pointing in the x-direction. RISA-3D only gives values for Fxy because Fxy
and Fyx are numerically equal. The total in-plane shear can be obtained by multiplying the given force value by the
length of the element that is parallel to the shear force. For example, when looking at the 'Plane Stress Forces'
figure, the total Fxy force which is parallel to the local y-axis could be obtained by multiplying the given Fxy force by
the length of side BC.
Note that the plate bending (Qx, Qy, Mx, My, Mxy) and membrane (Fx, Fy, Fxy) results are forces per unit length. For
example, a rectangular element with a B to C length of 10 feet showing a Fx force of 20K would have a total normal
force on the B-C face of the element of 20K (per foot) times 10 feet, or 200K.
For enveloped results the maximum and minimum value is listed. The load combination producing the maximum or
minimum is also listed, in the "LC" column.

Note
l
l

See Spreadsheet Operations to learn how to use Find, Sort and other options.
See Results View Settings to learn how to plot Plate Force results.

Plate Corner Force Results
Access the Plate Corner Forces Spreadsheet by selecting the Results Tab and then selecting Envelope (or LC)
button Plate Corner Forces. Alternatively, on the Results toolbar you can select Plate Corner Forces
Spreadsheet.
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The plate corner forces are the global forces at the corner of each plate and are listed for each active plate.
These are the forces and moments calculated at the corners of the plates, in the GLOBAL directions. These values
are obtained by multiplying the plate's corner displacements with the global stiffness matrix. Unlike the local
stresses and forces, which are very accurate approximations, these corner forces represent EXACT results based on
linear elastic theory. Also, the local forces are listed on a 'per unit length' basis, whereas these global direction
corner forces represent the total force on the plate at the corner in the given direction, in the same way that joint
reactions are reported. At any given joint, the corner forces for all plates connected to that joint should sum to zero
(a requirement of equilibrium), assuming no members or boundary conditions are also present at the joint.
As an example of how to use these corner forces, you can obtain the total shear at a given level in a shear wall by
adding the proper corner forces for the plates at that level. See Plate Modeling Examples to learn how to use the
plate corner forces to get shear wall story shears and moments, as well as slab moments and shears.
For enveloped results the maximum and minimum value is listed. The load combination producing the maximum or
minimum is also listed, in the "lc" column.

Note
l

l
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Internal Force Summation Tool

This tool may be activated by clicking the Node Force Summation button on the Results tab. The tool is only
available from within a model view that has active results for a single load combination or a batch solution. This
tool is not available for an envelope solution.
The Internal Force Summation Tool can be used to quickly come up with information on story shears in a building,
or internal moments in a elevated or on grade slab.
When initiated, the tool requires the user to select two points (A and B). These points will be used to define the
plane in which the internal force summation will be performed. That defines a "cutting plane" perpendicular to the
screen.
Clicking on a third point will lock the cutting plane to that exact location and provide a detailed summary of the
internal forces at that location. These summary results are summarized below:

The Internal Force Summation report is separated into three regions. The first region gives the resultant forces and
moments. The second region gives information needed to locate the reference plane and origin of local axes. The
third region gives a basic reference for the orientation of the local axes and forces.
Since the Forces and Moments are summed only for the selected members, this tool can be easily used to
determine the overall story forces in a shear wall or moment frame (if the whole model is selected), as well as the
forces in an individual bent or pier (if only a portion of the model is selected).
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The Geometric Center of the Selected Items defines the origin at which the forces (F1, F2, and F3) are reported.
This also corresponds to the point used to define the moments (M1, M2 and M3). These forces and moment are all
given with respect to the local 1, 2, 3 axes. The local 3 axis is always perpendicular to the current model view. The
local 1 axis is always defined parallel to the points A and B which were are selected by the user. The 2 axis is then
defined by the right hand rule.
The Vector Normal to the Cutting Plane is used to define the plane where the internal force summation was
performed. This was determined by the user selected points A and B.

Note:
l

For wall panel specific internal force summation, press the Wall Force Summation button on the Results
tab. This button is intended to be used by clicking two points in the same plane as a wall panel (or a group of
co-planar wall panels).

l

Masonry wall panels with the "Transfer Load" option selected in the Wall Design Rules may show different
values between the IFST and the Region Detail Report if you cut across a region next to an opening. This is
because the "Transfer Load" load option will transfer in plane loads from regions above and below openings
into the regions adjacent to the openings for wall panel design. This behavior is also true for concrete walls
which have the "Transfer In" and "Transfer Out" options available in the Wall Design Rules. In order to see
comparable results from the plates using IFST Wall, increase the cut length to include the region width plus
half the distance across each opening.
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l

For semi-rigid slab specific internal force summation, press the Slab Force Summation button on the Results tab. This button is intended to be used by clicking two points in the same plane as a slab (or a group of
co-planar slabs). Semi-rigid slabs are elements found in RISA-3D in a combined RISAFloor-RISA-3D model
with slab floors.

l

For additional advice on this topic, please see the RISA Tips & Tricks website: www.risa.com/post/support.
Type in Search keywords: Story Shears or IFST.

Calculation and Theory
When cutting through a plate, the internal force summation tool uses the plate corner forces to derive the force in
the cutting plate. When cutting through the interior of a plate, any corner node that is "above" the cutting plane is
included in the summation. Moments are then interpreted based on the location of the forces compared to the
centroid of the cutting plane. See the figure below:

Consider the cutting plane A-B defined above. This was created by clicking from left to right on the page (from A to
B). Therefore, there are 8 nodes above cutting plane A-B. These are highlighted in a gray color and are the nodes
whose corner forces will be used to create the base value of the cutting plane force. Because the cutting plane is
below the row of nodes, and because there may be applied surface or self weight loading at the plates, some
interpolation must used between the values above the plane and the values below the plane. This consists of
essentially a linear interpolation.
For cutting plan C-D there are 22 nodes above the cutting plane that will be used to determine the base value of the
cutting plane force.
Note
l

l

This tool only computes forces for elements that are selected in your model. In the same sense, it will
sum up forces for everything that is selected that is in the cutting plane. You may use the selection
tools to unselect portions of the model for which you do not want force results for.
Because these forces are reported with respect to the local 1,2,3 axes of the cutting plane it is NOT
recommended that this tool be used from an isometric view of the structure. It will function best in a
pure plan or a pure elevation view.
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l

The results for the internal force summation tool are always given for the currently displayed results.
The currently displayed results show up in the Results View Settings button (located in the View tab).
If the model has not been run and there are no results, then the tool will be unavailable. Similarly, the
tool is not available with Envelope Results.

Contour Display Details

This tool may be activated by clicking the Contour Diagram button on the Results tab. The tool is only available
from within a model view that is currently plotting a plate contour.
This tool can also be used for curved plate models such as tanks and vessels. The integral of the force diagram is
displayed in the Status Bar at the bottom of the screen. This may be useful for summing up shear forces in a wall or
lintel.

Click the Contour Diagram Report button on the Results tab to turn a visual plate contour into a more traditional
shear or moment diagram. The tool merely transforms the visual contour display into actual numerical that can be
viewed by the user. In the image below, the contour display shows the numerical values associated with the contour
at the cutting line.
When a Contour Display Detail is shown, the right click menu gives access to a Detailed Diagram of the contour cut
as shown below:
This detailed diagram will show you all the results for every section along the length of the diagram. this
information may even be copied to the clipboard for use in a spreadsheet program. This can be done by selecting
Copy Data from the right click menu.
Note
l
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Because this display is just a currently displayed plate contours, the units for the detailed diagrams are
always the same as for the displayed contours.
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The finite element method is an approaching method. This means that the results will never be exact and can be
made better and better, within reason, by sub-dividing the element mesh. Accurate results are dependent on the
modeling of the problem.
The following pages are studies of finite element mesh fineness and its relationship to accurate stress and deflection
results. These studies are meant to be an aide to help you select appropriate mesh fineness for a structure you are
trying to model. These studies will also answer the "why" many people ask when told they must use a "mesh" of
elements to model a structural item (such as a shear wall) instead of using one giant element. Obviously these
studies only give an overview of some basic elements and the engineer must be the final judge as to whether a
specific finite element model is a good reflection of the "real" structure.

Shear Wall Modeling
Theoretical Deflection of Shear Wall with Point Load
Shear Wall Properties
L = 240 in
Area = 1440 in2
B = 12 in
H = 120 in.
E = 4000 ksi
ν = 0.30

I = BH3/12
= 12(120)3 / 12
= 1,728,000 in4
Δ = PL3/3EI +
1.2 PL / AG
= 11.95 in
K=P/Δ
= 15,000k /11.95in
= 1255 kips/in

G = 1538.5 ksi

P = 15,000 kip

Stiffness as a Function of Mesh Fineness

Element
Mesh
Deflection
(in.)
Error
Stiffness
K (kips/in)

1x1

1x2

2x2

2x4

4x8

4.54

8.07

8.26

10.43

11.29

62%

33%

31%

13%

6%

3304.0

1858.7

1816.0

1438.2

1328.6

Note on Methodology:
General Reference Manual
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l

Since the theoretical solution is based on an assumption that plane sections shall remain plane after deformation, the last model (4x8 mesh) had very stiff axial members included at the 2nd, 4th, 6th and top level
across the width of the wall. This prevented horizontal differential joint movement and allows for a more
meaningful comparison with the theoretical solution.

Shear Wall Design Forces

Floor

Shear

Moment

Elements

4

9.99k

100.05k-ft

P49-P52

3

20k

300.08k-ft

P33-P36

2

30k

600k-ft

P17-P20

1

40k

999.98k-ft

P1-P4

Shown above are the analysis results of a 4-story shear wall. This example is for a straight shear wall, however the
method and results are valid for box, channel, or any other shear wall shapes.
The RISA-3D files that were used to obtain these results are included as “4X1WALL.R3D” and “4X4WALL.R3D”. The
10 kip story loads were applied uniformly across each story. This was done to more accurately model loads being
applied to the wall from a rigid or semi-rigid floor.
The story shears at each level were calculated as the sum of the FX corner forces. The story moments at each level
are calculated from the FY corner forces as shown below:
Mi = (Fyouter node* 15ft) + (Fyinner node * 7.5ft)

Story Shears - Hand Calculation
The story shears were calculated as shown below from the corner forces. See the screen shot close up of the FX
corner forces on the next page.
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Story

Sum FX Corner Forcers at Story
Level (k)

Shear

Moment

4

[0.462 + 0.786 + 1.77 + 1.98] * 2 = 9.996

9.9k

P49-P52

3

[1.2 + 1.65 + 3.45 + 3.7] * 2 = 20.000

20k

P33-P36

2

[1.9 + 2.5 + 5.14 + 5.46] * 2 = 30.000

30k

P17-P20

1

[11.76 – 0.32 + 6.09 + 2.47] * 2 = 40.000

40k

P1-P4
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For the graphical display of the corner forces, there are 4
corner forces shown for each plate. This is similar to a beam
element which has 2 member end forces.
To get the story shear at any line, just sum up all the FX
corner forces along the line.

Level 4 Global FX Corner Forces

To get the story moment at any line, just sum the moments
obtained by multiplying the Fy corner forces along a line,
times the moment arm such as the distance of each Fy force
to the center of the wall.

Level 4 Global FY Corner Forces

Story Shears - Summation Tool

A quicker way to calculate story forces is to use the Internal Force Summation tool to have the program
automatically calculate the global forces that pass through a given elevation of the shear wall. To do this, just click
on the Node Force Summation icon in the Results tab whenever you have a set of valid, non-envelope solution
results. This tool will sum the forces for the displayed items at the desired elevation and will report them back to
the user in terms of the Global X, Y and Z directions.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Story Shears.
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Story Moments
The story moments are calculated as the FY Corner forces times their moment arms. The forces are symmetrical so
each force on one side is multiplied by twice the arm length.

Story

Sum FY Corner Forces *
Moment Arm (k)

Story
Moment

Elements

4

[3.92 k * 15' + (2.48 k + 3.02 k) * 7.5'] =
100.05 k'

100.1 kip-ft

P49-P52

3

[12.33 k * 15' + (7.9 k + 7.45 k) * 7.5'] =
300.075 k'

300.1 kip-ft

P33-P36

2

[24.93 k * 15' + (16.5 k + 13.64 k) *
7.5'] = 600.00 k'

600 kip-ft

P17-P20

1

[45.81 k * 15' + (25.16 k + 16.55 k) *
7.5'] = 999.975 k'

999.9 kip-ft

P1-P4

Shear Wall Penetrations

Horizontal Deflection at Top
Shear @ A-A
Shear @ B_B
Shear @ C_C
Shear @ D-D
Reactions at E
Reactions at F

0.028 in.
10.82 kips
24.2 kips
33.74 kips
45.26 kips
10.8 kips
24.2 kips

0.033 in.
10.53 kips
23.08 kips
33.05 kips
47.35 kips
10.53 kips
23.06 kips

This is an example of a typical concrete shear wall with penetrations for windows and doors of various sizes. The
files for the models are WALLPEN1.R3D (coarse mesh) and WALLPEN2.R3D (fine mesh). No theoretical solution
results are given to compare with, however the two finite element densities are compared to observe the rate of
convergence to the “true” answer. The shears at the various lines are computed by adding up the X corner forces
for the element corners closest to the lines. The horizontal deflection is for the top of the wall. A very rigid link is
added to the top of the wall to simulate the effect of a concrete horizontal diaphragm. This has the effect of
stiffening the walls and spreading the load uniformly across the top of the wall. The load is applied as a uniform
load of 3.0 kips/ft. across the top of the wall. The total width of the wall is 38 ft, so the total applied load is 114
kips. The total height of the wall is 18 ft.
The “coarse” mesh on the left is an example of the minimum finite element mesh that should be used to model this
type of wall. Notice that the course mesh gives good results for the wall shears and reactions. The overall
deflection of the coarse mesh is off by about 15% from the “fine” mesh. The coarse mesh tends to give too much
stiffness to the slender walls around the loading door opening on the left, this can be seen in the larger reactions at
points E and F as well in the horizontal deflections. The fine mesh on the right shows that the slender wall sections
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are more flexible than shown by the coarse mesh and thus the reactions and wall shears are reduced for the slender
wall sections.

Diaphragm Modeling
Theoretical Solution for Plate with Fixed Edges
(Results from Roark’s Formulas for Stress and Strain, 5th Ed., pg. 392)
Plate Properties
a = 21 ft.
b = 15 ft.
thickness = 8 in.
E = 3122ksi
q = 60 psi
"α = 0.0226
β1= 0.4356
β2= 0.2094

Deflection at center (y):
= αqb4 / Et3 = 0.891 in.
σCenter = β2qb2 / t2 = 6361 psi
MCenter = σCenter(t2/6)(1kip/1000#)
= 67.8 k-ft/ft
σMax = β1qb2 / t2 = 13,231 psi
M Max = σMax (t2/6)(1kip/1000#)
= 141.1 k-ft/ft

Stiffness and Stress as a Function of Mesh Fineness

Element Mesh
Deflection
@ Center
Error (%)
My @ Center
(K-ft / ft)
Error (%)
Global MX Reaction @ Center
of Long Side to Obtain Max.
Local My
Local My @ Center of Long
Side (Mx Reaction divided by
tributary length)

2x2

4x4

5x5

6x6

0.032

0.895

0.774

0.911

96%

1%

13%

2.2%

80.45

75.8

70.3

73.4

19%

12%

4%

8%

Joint 6
Reaction

Joint 15
Reaction

Joint 18
Reaction

Joint 4
Reaction

844.8 K-ft

717.2K-ft

545.3K-ft

489.4K-ft

80.5 k-ft / ft

136.6 k-ft / ft

129.8 k-ft / ft

139.8 k-ft / ft

43%

3%

8%

1%

Error (%)

The condition being modeled is a flat plate with fixed edges and a uniform load over the entire surface. The RISA3D2DFloor files that were used to obtain these results are included as “2X2FIXED.R3D”, “4X4FIXED.R3D”,
“5X5FIXED.R3D”, and “6X6FIXED.R3D”.
The plate moments at the center of the long side were calculated by dividing the global Mx reaction at the center
of the long side by the tributary length. See the summary results below. (Note that the 5x5 mesh produces good
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results even though the Mx reaction is not at the exact center of the long side.) Remember that plates with
perfectly fixed end conditions have their maximum moments at the center edge of their longest side.

Mesh

Mx Global
Reaction

2x2

Tributary
Length

Equation

My Local
Moment

844.8 k-ft

21ft / 2 = 10.5ft 844.8 / 10.5

80.5 k-ft / ft

4x4

717.2 k-ft

21ft / 4 = 5.25ft 717.2 / 5.25

136.6 k-ft / ft

5x5

545.3 k-ft

21ft / 5 = 4.25ft 545.3 / 4.25

129.8 k-ft / ft

6x6

489.4 k-ft

21ft / 6 = 3.5 ft

139.8 k-ft / ft

489.4 / 3.5

The edge moments only need to be considered as the maximum moments when a plate is fixed at it’s edges, since
the maximum moments will often occur in the center of the plate for most other support conditions. (The edge
moments will still need to be considered for moment reversal if the plate is continuous across the supports).
For the situation of continuous slabs supported by beams between columns, the maximum moment will often occur
at mid span and not at the edges. Thus a 3x3 or 5x5 mesh should be used to obtain correct moments. Even
numbered meshes (e.g. 6x6, 4x4, or 2x2) should be used to obtain the best deflection information and odd
numbered meshes ( e.g. 3x3 or 5x5) should be used to obtain the best bending moment results. The 6x6 mesh
could be used to obtain good moments and deflection results.
The internal My bending moments are obtained using the Global Corner Forces and the Internal Force Summation
tool for the 2x2, 4x4, and 6x6 meshes. The total global MX moment on the side of an element was computed and
then divided by the length of the element. (Global MX moments are parallel to local My moments in this model)
The internal My @ Center are found using the Plate Forces for the odd plate example (5x5) because there is no
node at the center.
It should be noted that the deflection obtained from the 4x4 and 6x6 meshes is larger than that predicted by the
Roark equations because the RISA-3D2DFloor finite element accounts for transverse shear deformation while the
Roark equations ignore shear deformation.
These results are for a uniform load. If the loading is more localized, or approaches a point load, a much finer
mesh in the vicinity of the load will be needed to model the loading itself and to get accurate results. Also note that
RISA-3D2DFloor’s finite element (like most commercial finite elements) is based on small strain theory. This means
that the in-plane diaphragm stresses are not affected when the transverse deflections become large. According to
Roark, (pgs. 405-409), this additional stress becomes significant when the transverse deflection is larger than half
the plate thickness.

Spread Footing Modeling
Stress Accuracy as a Function of Distortion
Shown below are the analysis results for an axial wall load on a spread footing, which is then on soil springs. The
files used for this parametric study are FLXFTNG.R3D for the “flexible” footing results and RGDFTNG.R3D for the
rigid footing results. Note that the theoretical values shown are based on the assumption of an infinitely rigid
footing.

Footing Thickness
Element Aspect
Ratio
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12 in.

24 in.

36 in.

1:1

2:1

3:1
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Thickness:Length
One way shear at “d” from the wall face,
Flexible Footing
Elements Used for Shear
Moment at Wall Face, Flexible Footing
Elements Used for Moment
Theoretical 1-Way Shear at “d” from the
Wall Face
Theoretical Moment at Wall Face

109.2 kips

92.4 kips

70 kips

9-135 (by 14)
10-136 (by 14)
368 k-ft
9-135 (by 14)

10-136 (by 14)
11-137 (by 14)
415.2 k-ft
9-135 (by 14)

11-137 (by 14)
12-138 (by 14)
421.2 k-ft
9-135 (by 14)

117.9 kips

94.3 kips

70.7 kips

424.3 k-ft

424.3 k-ft

424.3 k-ft

As can be seen in the table, the results are converging to the theoretical solution for a infinitely rigid footing as the
footing thickness increases and begins to become “very rigid” when compared to the soil spring stiffness.
To obtain the One Way Shear values at a distance “d” from the wall face, simply sum the FY global corner
force values for the elements on both sides of the appropriate row, and then take the average of these two values.
You need to average the two values in this case, because the corner force results are on either side of a soil spring.
For example, to obtain the one way shear for the 24” thick footing, sum all the FY corner forces for elements 9 to
135 by 14 (9, 23, 37, …) and then 10 to 136 by 14 (10, 24, 38, …). Then take the average of those two sums. If you
don't have soil springs at the corner force locations, you don't have to average the two values. (The sums on each
side in this case will be equal). The easiest way to add up the corner forces is to simply sum them from the
graphics display. This way you don't have to track the element numbers.
To obtain the Moment values at the face of the wall, just add up the MZ global corner forces for the elements along
the wall face. For this example these would be elements 9 to 135 by 14. Again, the easiest way to add up the
corner forces is to sum them from the graphics display so you don't have to worry about element numbers.
The finite element corner forces work best when the footing is aligned with the global axes. That way the global
corner forces line up with the desired footing shears and moments.
Since the theoretical values for the shear and moment are based on the assumption of an infinitely rigid footing, it is
instructive to look at a finite element model where we use an artificially high value of “E” (Elastic Modulus) to
approximate an infinitely rigid foundation.

Rigid Footing Results

Footing Thickness
1-Way Shear at “d” from the Wall
Face, Rigid Footing
Elements Used for Shear
Moment at Wall Face, Rigid Footing
Elements Used for Moment
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12 in.
117.9
kips
9-135 (by
14)
10-136
(by 14)
424.3 k-ft
9-135 (by
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14)

These results agree exactly with the theoretical values.

Computing Soil Spring Stiffness
Obtain the subgrade modulus for a 1’ by 1’ or .3m. x .3m sample plate. A typical value for medium dense dry sand
would be say, k1 = 500 kcf. This value must first be modified to account for our actual footing size (10 ft by 14 ft).
For this example we will use equations from Principles of Foundation Engineering, 3rd edition, by Braja Das, pgs.
263 - 264. We will assume a 1ft x 1ft sample plate.

We can now calculate the spring stiffnesses for all the joints in the model based on tributary area. The program is
capable of automatically generating these soil springs based on the tributary are of each node in the plate element
mesh. Refer to Generating Soil Springs of the Boundary Conditions s section for more information.

Tributary
Area

K(10x14)
k/in^3

K(spring)
k/in

Example
Joint

1 sq.ft = 144 sq.in.

0.07906

11.38

13

0.5 sq.ft = 72 sq.in.

0.07906

5.69

34

0.25 sq.ft = 36
sq.in.

0.07906

2.85

1

Although a little out of date, the ACI publication 336.2R-88, “Suggested Analysis and Design Procedures for
Combined Footing and Mats”, is another good reference for the modeling of mat foundations.

Plate Connectivity Problems
Shown below is a common modeling problem with plate elements. Since plates only have connectivity at their
corner nodes, the applied load at middle joint connects to the plates below the joint, but not to the one above it.
Because of this lack of connectivity, you see the joint "pushing through" the plate edge above in the plotted
deflected shape.

The proper way to hand this type of mesh is with one of the mesh transitions described in the following section.
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For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Plate Connectivity.

Mesh Transition Examples
Coarse Mesh to Fine Mesh
Shown below are two methods for transitioning from an area with a fine mesh to an area with a larger / coarser
mesh.

Three to One

Two to One

Rectangular Mesh to Radial Mesh
Shown below are two methods for transitioning from an area with a rectangular mesh into an area with a radial
mesh.

Square to Round

Round to Square

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Plate Mesh.
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Printing
You may print graphic or tabulated information from your current model.
If a spreadsheet is currently active and you select Print from the Quick Access toolbar or the File menu, you will
be given the option to Print Spreadsheet or a Print Report. In the Print Settings for spreadsheets, you will have
the option to print the Current Spreadsheet, the Selected Lines of the spreadsheet, or switch over to Report
Printing.

If a 3D View is currently active, you will be given the option to Print Graphics or Print Report.
To Print a Report or a Spreadsheet
l

While in a spreadsheet, select Print from theQuick Access toolbar or the File menu and you will be
given the option to Print Spreadsheet or Print Report.

To Print Graphics
l
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While in a 3D View, select Print from theQuick Access toolbar or the File menu and you will be given
the option to Print Graphics or Print Report.
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Printing Reports

The Report Printing Window options help you build your reports with spreadsheets, graphics, Detail Reports, etc..
There are standard reports for you to choose from and you may also name and save any report format you custom
build, as your own template. To choose a standard report, simply pick it from the Report Templates drop down
list.

Building a Report
To build your own custom report you may select any of the spreadsheets, detail reports, or miscellaneous sections
found in the Available Report Sections and they will be populated in the Current Section in Report region. You
can add entire categories by selecting the heading of a dropdown section in the Spreadsheets tab. You can re-order
the report by dragging and dropping the sections in your report you would like to move.You can also remove
sections from your report by unselecting them similar to how they were selected, or you can drag the item our of
the Current Sections in Report region.
The Filter Elements by Property option will filter the sections included in the report based on selected property.
This applies to both spreadsheets and detail reports.

The Current Sections in Report portion of the dialog shows which sections and the order the printed report will
be built. The Misc. tab of the Available Report Sections contains all images that were added to the project as well
as the other miscellaneous items not in the Spreadsheets for Detail Reports tab. Images can be added either using
the "Snapshot" option or by adding external images using the Add Misc Item button.

Note:
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l

l

Any saved reports from the Report Templates drop-down will currently only save spreadsheet information.
Any snapshots, Detail Reports or added items from the Misc. tab will manually need to be added to any saved
reports.
The program will flag solution spreadsheets as to whether there is information available in them. If that type
of solution has not been run you will see a prefix of **NA** ahead of that spreadsheet in the Available
Report Sections.

Snapshot (Capture) Images
A snapshot image button is on the Quick Access Toolbar and the View tab of the ribbon.

When this button is pressed a folder will be automatically created in the same location where the model file is
located. This button will then give some options regarding the print location and file name. Once you define this
information press Save and the program will create this image.

Note:
l

l

If the model has yet to be solved the image will be created in the Model Data Files location from File Application Settings - File Locations.
The relative path of these image files will be saved with the model. If the model file is moved, move the associated Images folder as well and then all images will still be available.

This snapshot is a great way to get images of model views and detail reports that you want to add to your report.
Once a snapshot is taken it will show up in the the Images section in the Advanced tab of the Report Printing
dialog and can then be added to the Current Sections in Report.

Adding Images
Any additional images that you wish to add to your report that are not from RISA, can be added using the Add Item
button. Press this button and navigate to any PNG, BMP, or JPEG file and you can select it. Once that happens it will
then show up in the Misc Items section in the Advanced tab and can then be added to the Current Sections in
Report.

Note:
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l

The complete path of these additional images are saved with the file. If the model file is moved it will still
find these additional images.

Report Print Settings
Formatting options allow you to specify many options:
Shade Lines? - Allows you to shade every other line to enhance readability.
Start at Page # - Allows you select the starting page number. The number shown will be the next page number in
the current sequence, but you can override this for occasions where you need to insert your calculation pages into
an existing report and you need the page numbering to match.
Begin Numbering On - Allows you to start your numbering at some page other than page one. This can be helpful
if you have a title page or table of contents that you don't want to number.
Print Header - All reports have a footer with version information, the file name and path, and the page
number. The header option will include the Model Title specified in the Model Settings , company, designer, job
number, and a place to initial any checking.
Date/Time? - Allows you to turn off the Date/Time stamp so that this will not appear on your printed reports.
Item Options - Allows you to select member related options. You may specify that you want the member results to
be listed for each member section (specified in the Model Settings) or just for the member ends, which can be
useful for connection design.

Note:
l

See the Customizing RISA-3D topic for more information about printing, including the ability to print out a
RISA or custom company logo.

Printing to a File
A flat file is a file without column headings, print formatting, or graphical elements and is useful for importing and
parsing into spreadsheets, database tables, or as post processor input data.

There are several options available to make the flat file easier to parse. Note that printing and then looking at a
sample output file with all the options selected will make it easier to understand what the options do.
You have an option to include the 'Section Headers' which will print a text description of each block of data. For
example, the Node Coordinates data would be preceded by a [NODE COORDINATES] header on it’s own line before
the data. You may also include a 'Record Count' which is useful if you’re writing looping code to read in the number
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of records within each data block. The number of records prints on it’s own line. You can also have a special 'UNITS
Section' be printed out which will give you the units used for all the values in the program.
The field delimiter options let you choose what character will be used to separate each field of data within record.
For example, each coordinate value in the Node Coordinates data would be separated by the character selected.
Programs that you might be importing the file into like MS Excel or MS Access often have options to select what the
field delimiter will be for records of data.
The text delimiter works like the field delimiter, except that it’s used to set apart text labels. All text in the flat file
will be enclosed at the beginning and the end by the selected text delimiter character. This is very useful when
trying to read in label strings that contain embedded spaces. As an example, the Node labels in the Node
Coordinates data would each be enclosed by a single or double quote.
The current flat file options are saved each time the program is closed.
To Print to a Flat File
l

While in the Print Report dialog, choose Write Flat File below the Printer options.

Graphics Printing
At any point, while in a 3D View or Wall Panel Editor, you can print a graphic by choosing Print Graphics from any
of the Print menus. The current window will change into a Print Preview and will allow all the same view settings
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to be adjusted even when in the preview. Rotating, zooming, and rendering are only a few of the settings that can be
altered dynamically in the preview.

Many of the same options that exist in Report Printing are present in Graphic Printing, but some unique options
available are Scale Factors and Title Block Info.
Three different Scale Factors are defined. These scale factors are used to make the text, symbols, Diagrams, and
Navigation Cube displayed as part of the graphic, larger or smaller. A higher scale factor makes the item bigger. This
makes for a cleaner looking graphic print. As far as what scale factors you should use, the only way to be sure is to
experiment a little.
You may include the Title Block Info(Header) to display the Model Title, Designer, Company Name, Date and
Time (All of which are defined in your Project Info). You can also enter a comment that will be included in the Title
Block. Advanced Settings allows you to set the margins.
You can specify a Sketch # and a Sketch Prefix to label your graphic prints as well.
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Results
You may work with the results of a solution by viewing and sorting data in the spreadsheets, graphically plotting
them with the model or by viewing detailed member reports. You may also print the results in any of these
forms. To learn about printing results, see Printing.
Upon the completion of a static solution, RISA opens the Results menu in the Explorer panel and the Reactions
Spreadsheet. You may specify that other results be displayed automatically as well. You may then proceed to view
any results and make any changes for further analysis.
If you make any changes to the model that would void the results, such as moving joints or adding members, the
results will be purged and another solution will be required before the results can be viewed again.
Each of the result types is described in it’s own section:

Results Spreadsheets
l
l
l
l
l
l
l
l
l
l
l
l
l
l
l
l
l
l
l
l

Node Deflection Results
Node Reaction Results
Story Drift Results
Member Force Results
Member Stress Results
Member Torsion Results
Member Deflection Results
Hot-Rolled Code Check
Cold-Formed Code Check
Wood Code Check
Concrete Design Results
Aluminum Code Check
Concrete Wall Results
Masonry Wall Results
Wood Wall Results
Plate Stress Results
Plate Force Results
Plate Corner Force Results
Modal Frequency Results
Mode Shape Results

Detail Reports
l
l
l

Member Detail Reports (Hot Rolled Steel, Cold Formed Steel, & Wood)
Concrete Beam Detail Reports
Concrete Column Detail Reports

Saving Results
When you save a file that has been solved you may also save the results. The next time that the file is opened the
saved results will be opened as well. You may use the Application Settings on the Tools Menu to change the way
that you are prompted to save results.
If changes are made to the model, any saved results are deleted. Saved results for models that no longer exist in the
same directory are also deleted.
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Results Spreadsheets
You may access the result spreadsheets by selecting them from the Results Menu in the Explorer panel, or from
the Results Tab in the Ribbon toolbar. You may use the Find, Sort, and Exclude features to find the results you are
interested in. For example you might sort the member stresses from high to low, bringing all of the highly stressed
members to the top. You might then exclude members that do not have significant axial stresses so that they do not
distract you or so that they are not printed.

Finding Results
l

To go to a certain item while in a spreadsheet click the Find button from the Spreadsheets Tab or
select Find from the Right-Click menu, and type in the desired member, plate or joint label.

Sorting Results
l

To sort the results click on the column of results you wish to sort and then click the Sort button from
the Spreadsheets Tab or select Sort from the Right-Click menu to specify sorting settings. You can sort
based on maximum, minimum, absolute maximum or input order.

Excluding Results
There are three ways to exclude results so that you can work with the results that are important to you.

Excluding Results Before the Solution
Excluding items before the solution allows you to remove the items from the results while leaving them as part of
the model. This exclusion is permanent for that solution and any exclusion changes will then require another
solution. This exclusion may be applied graphically in the Properties Panel for selected members or within the
spreadsheets by recording an “E” in the Inactive field of the Members, Wall Panels, and Plates spreadsheets.
A member with an “E” in the “Inactive?” field will be treated like any other member in the solution and plotting of
the model, but the member will not be listed in the solution results (forces, stresses, deflections, etc.). This is useful
if there are certain members whose results aren't of interest. You don't have to clutter up the results with these
members and can concentrate on the members you are most interested in.

Excluding Results After the Solution
You may run the solution and then graphically select the joints, members, and plates that are of interest. By clicking
the Filter Results button and in the popup dialog, you can select Filter Out UnSelected items from Results or
Filter out Selected items from Results. You may then update the spreadsheets and printed reports so that they
will not have results for the selected or unselected items. All of the spreadsheets and reports will be controlled by
this selection and you may adjust this selection at any time.
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This option is also available by clicking the Filter Results button

from the Results toolbar in the 3D View.

When you open any results spreadsheet, you can tell if it has been filtered by the filter icon in the spreadsheet
header.

Excluding Results While in Spreadsheets
You may also select the results of interest on each spreadsheet. While viewing spreadsheet results you may select
the last line of interest and exclude the rest. Exclusions are applied independently for each results spreadsheet. Any
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exclusion applied to the Member Forces spreadsheet will not affect the Member Stresses spreadsheet, etc. Excluding
items graphically will reset all of the spreadsheets to match the graphic selection. If you wish to combine these two
features to fine tune the results perform the graphic selection first.
To exclude results click on the last line of results you wish to keep and then click the Ignore After button under
the Spreadsheets Tab. You can bring the results back by clicking on the Show All button. Alternatively, you can
select these features from the Right-Click menu in any result spreadsheets.

Note
l

It might be best to first sort the results before excluding. As an example, let's say that you only wanted to
view members with Code checks greater than or equal to 0.7. To do this you would open the Steel Code
Checks spreadsheet and sort the members by Code Check magnitude. Then you would visually identify
the last member with a Code Check of 0.7 and use the Exclude feature to exclude all members after that
one.

Graphic Results
Most of the analysis results may be viewed graphically as well as in the spreadsheets. For the joints you may plot
the reactions. For the members you may plot force diagrams as well as color-code the plotted members by code
check or stress levels. Plate stress contours and corner forces may also be viewed graphically. Deflected shapes and
mode shapes may be viewed and animated. See Model Display Options for more information.
To Plot Results Graphically
1. If you do not already have the model view open click the Open 3D Views button under the View Tab.
2. Click the Model button under the View Tab for model view settings.
3. Select the options you would like to view and click Apply or OK.

Clearing Results
You will be provided with a warning if changes are made to the model that might invalidate the current results.
Should you decide to proceed, the results will automatically be cleared and you will have to re-solve the model to
get results once you are finished making changes. This warning may be disabled in the Application Settings under
the 3D button.
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To manually clear results, click the Clear Results button.

Opening a model with a solution file that was saved in a different version will also prompt you to delete the
solution file in order to open the model.

Internal Force Summation Tool
This tool may be activated by clicking the icon under the Results tab. The tool is only available from within a model
view that has active results for a single combination or a batch solution. This tool is not currently available for an
envelope solution.

This tool was originally created to convert Plate Analysis results into design forces for concrete slabs and walls.
However, the tool is equally useful for structure that have beams, columns and braces. It is frequently used to
determine overall story shears and moments. For detailed information on the tool, please refer to the Plate Design
Tools section.

Note
l
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The internal force summation tool does NOT currently work on Solid Elements.
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Member Detail Report
The detail report allows you to see the overall force/stress/deflection state for any particular member. This report
shows diagrams for all these quantities and also lists detailed information on the code checks for Hot Rolled Steel,
Cold Formed Steel, Concrete, Aluminum and Timber design.
This detail report is available for any member following the solution. If you have run an envelope solution, then you
will only be able to view an enveloped detail report. If you run a Batch + Envelope solution, you can scroll between
individual (Batch) load combination results, and the Enveloped results.
o

o

o

o

o

o

o

If there is a (y) or (z) value next to the code check, it defines whether the controlling case is in the local y or
z axes respectively.
If there is an (s) this tells you that the maximum check occurred at some other axes where a round shape is
used and the cross-sectional properties for the member are the same in all directions.
If you are viewing an enveloped detail report, the governing load combination number will be reported in
parenthesis. Ex: (LC 10).
When a force or stress shows up with multiple colors (see image below), this signifies the difference between
the total value and the value when Live Load Reduction is considered.
The viewing of Live Load Reduction within the diagrams or the consideration of LL reduction in the reported
values can be turned on or off by clicking on the
button.
For members designated as beams, the Max Defl Ratio will report the maximum beam deflection ratio (L'/y')
as reported in the Beam Defl tab of the Member Deflections spreadsheet.
For members that are not designated as beams, the Max Defl Ratio will report the maximum member deflection ratio (L/y') as reported in the Service or Strength tab of the Member Deflections spreadsheet.
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To View a Detail Report
l

l

l

To view a member detail report after running a solution, click on the Detailed Report button
on
the Selection toolbar and then click on that member. If you do not already have the model view open
click the Open 3D Views button on the View Tab in the Ribbon toolbar.
You may also access the detail report while viewing a member results spreadsheet such as Member
Stresses by clicking the Detailed Report button from the Right-Click menu.
You may also use the Detailed Report button on the Results Tab in the Ribbon toolbar and click on a
member to open the report for that member.

Interactive Diagrams
Once a detail report is open, you can also click on any of the force, stress, or deflection diagrams to open an
interactive diagram. Click on any place along the length of the member to see how the value changes.
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The diagrams provided are:

Plot Designation

Plotted Value

A
T
Vy
Vz
My
Mz
Dy
Dz
fa
fc
ft
f(y) and f(z)

Axial Force
Torsional Moment
Shear Force Parallel to y-y Axis
Shear Force Parallel to z-z Axis
Bending Moment About y-y Axis
Bending Moment About z-z Axis
Deflection in Local y Direction
Deflection in Local z Direction
Axial Stress
Bending Compressive Stress
Bending Tension Stress
(Envelope Only)

The "fa" stresses are the stresses resulting from the axial force. The "fc" and "ft" stresses incorporate both bending
moment and torsional normal warping stresses. In the envelope detail report, the "f(y)" and "f(z)"stresses display
both the maximum positive and negative bending stress located at the extreme fiber of the member in the local yand z-axis. These stresses are listed in the Member Stresses spreadsheet as z-Top, z-Bot, y-Top and y-Bot.
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The diagrams are scaled in groups to give a good representation of relative values. For example, the force diagrams
(A, Vy and Vz) are scaled such that the force of maximum magnitude fills the diagram space. The other diagrams are
then plotted using that same scale. The moments, deflections and stresses are similarly scaled together.
When an output file is saved, the program will discard much of the unneeded force, moment and deflection data
used to create the detail report plots. When this saved file is later retrieved, these plots will appear more coarse and
inexact. However, the maximums, minimums and controlling code checks are always maintained regardless of how
coarse the plots appear.

Note
l

l
l

When a force or stress shows up with multiple colors , this signifies the difference between the total
value and the value when Live Load Reduction is considered.
The consideration of LL Reduction is only included for models that are integrated with RISAFloor.
The consideration of LL reduction in the displayed diagram may be turned on or off by toggling the
LL Reduction check box.

Detailed View for Deflection Diagrams
Only members that have been designated as beams will also report the Defl Ratio in the detailed deflection
diagram. This value is the beam deflection ratio which can also be seen in the Beam Defl tab of the Member
Deflections spreadsheet and the summary at the end of the Member Detail Report.

Beam Members

Other Members

Multi-Span Detailed View for Deflection Diagrams
For multi-span beams the detailed deflection diagram will give span information and show a red line at the support
locations. The Defl Ratio is based on the Span Length of the current span.
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Tapered Members
The Detail Reports for tapered members designed to AISC Design Guide 25 contain information not available in
other Hot Rolled Steel Design Reports. Refer to the Tapered Member Results sub-topic of Hot Rolled Steel Design for
more information.

Envelope Member Detail Reports
The Detail Reports can be viewed for single load combinations, or as an envelope. If you solve a Batch + Envelope
solution, you can toggle between the overall enveloped results and the individual load combination results using the
menu at the top left.
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For the enveloped report, all diagrams will show enveloped data. Governing load combinations will be noted in the
header of each load check.
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Note:
l

If you solve a load combination with a Moving Load or a Time History Load, the results will only be available
in the enveloped detail report..

Concrete Member Detail Reports
Concrete member detail reports are similar in function to detail reports for other materials, but they are different in
the type and amount of information they convey. One of the largest differences is that the force diagrams are always
envelope force diagrams, because the majority of the concrete design results are based on the envelope forces.
The detail reports for concrete Beams and Columns are discussed in greater detail in the Concrete - Design Results
section.
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RISAFloor and RISA-3D Integration
While the primary function of RISAFloor is to create and optimize floor systems, another strength is that it can be
used to automatically generate a model of the lateral force resisting system in RISA-3D.

Note:
l

The features described in this section of the manual are only available to users who are running both
RISAFloor and RISA-3D.

Lateral System Model Generation
Beams, columns, and walls whose function is set to "Lateral" on the Primary Data Tab of their respective
spreadsheets in RISAFloor will automatically be generated in the RISA-3D model when accessed via the Director
menu. To access this model, click the Director button on the far right end of the Main Menu and choose RISA-3D.
The RISA Application Interface will then switch from RISAFloor to that of RISA-3D.
Once in RISA-3D you will notice that you can use the RISA-3D features to edit and solve the model. You can add
braces, beams, columns, walls, and additional loads just as you would in a regular RISA-3D model. Refer to the RISA3D General Reference Manual and Tutorials for documentation of RISA-3D's features.
The "gravity" model in RISAFloor and the "lateral" model in RISA-3D are fully linked. Subsequently, any changes
made to RISAFloor generated members in the RISA-3D model will automatically update those same members in
RISAFloor model.

Note:
l

l

l
l
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Beams, columns, and walls whose function is set to "Gravity" in RISAFloor will NOT be generated in
RISA-3D for optimization. These members have been indicated as "gravity-only" members and will not
collect any lateral load in the RISA-3D model. Therefore, these members would only "clutter" the lateral
system model in RISA-3D and are subsequently not drawn.
RISAFloor "Gravity" members may be viewed in RISA-3D via the Misc Tab of the Model Display Options
Dialog. These members will be displayed for visual effect only in the model view but will not contribute
to the stiffness of the RISA-3D model.
The unbraced lengths of RISAFloor Lateral members are coordinated with those in the RISA-3D model.
Members explicitly defined in RISAFloor will have a design list of 'None' in RISA-3D to prevent alternate
shapes from being suggested.
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l

Member end releases in the RISA-3D model are controlled by RISAFloor, and cannot be changed in RISA3D. To modify these, go to the Beams or Columns spreadsheet in RISAFloor.

Diaphragms
Diaphragms are created in RISA-3D for every floor with a defined diaphragm edge in RISAFloor. Although you
cannot delete these diaphragms, you can make them inactive in RISA-3D. The Mass, Mass Moment of Inertia and
Center of Mass are automatically calculated based on the RISAFloor loads and on the settings in Model
Settings. For more information on this interaction, see the Diaphragms topic.

The X and Z eccentricities are used in the equivalent lateral force method for calculation of seismic loads. This
allows you to quickly and easily account for the effects of accidental torsion when calculating your seismic response.
The Diaphragm and Region columns are the names of diaphragms and regions in the model.

Note:
l

Diaphragms defined as rigid are not designed, thus the Region column is blank.

The Type allows you to toggle between flexible and rigid for Beam Supported Floors. The Concrete Supported
floors can be Rigid or Semi-Rigid and the type is defined in the Slab Definitions spreadsheet in RISAFloor.

Note:
l

Beam Supported Floors do not have a Semi-Rigid option at this time. To consider a semi-rigid diaphragm,
modeling the diaphragm as a plate model would be the route to go. Here is more information on Plates.

The Design Rule allows you to switch between design rules for the diaphragm regions. The Design Rules
spreadsheet is where many parameters are defined for your diaphragm. For more information on diaphragm
modeling and interaction, see the Diaphragms topic.

Concrete Floor Slabs
Concrete Floor Slabs (created with RISAFloor ES) are transferred into RISA-3D either as Rigid diaphragms or SemiRigid diaphragms.
Rigid diaphragms have no out-of-plane stiffness therefore it would be recommended that you model lateral beams
in RISAFloor with the Rigid diaphragms. The interaction of slabs and beams is ignored with respect to the analysis
and design of lateral concrete beams in RISA-3D.
Semi-Rigid diaphragms are automatically modeled in RISA-3D with a plate sub-mesh representing the slab. There is
in-plane and out of plane stiffness for a Semi-Rigid diaphragm.

Gravity Loads
The gravity loads on the lateral members, including the beam reactions from the gravity only members, become
part of the RISA-3D model. The Load Categories in RISAFloor are automatically converted into Basic Load Cases in
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RISA-3D. The exceptions to this are the Load Categories that deal specifically with construction loads (DL Const,
and LL Const), which are not converted.

Wind Loads
Wind loads can be automatically generated per various codes.
See Load Generation - Wind Loads for more information.

Seismic Loads
Seismic loads can be automatically generated per various codes.
See Load Generation - Seismic Loads for more information.

Buckling-Restrained Braced Frame (BRBF) System
Buckling-restrained brace (BRB) design is available for models that come from RISAFloor to RISA-3D. The gravity
members can be drawn and designed in RISAFloor. Users can then direct the model to RISA-3D and add BRB
members from specific databases (e.g. CoreBrace database). The BRB-related databases are only available for
RISAFloor-RISA-3D integration. BRB members and design are not available for RISA-3D only models. If an existing
model with BRB shape is detached in RISA-3D, the BRB shapes will be converted to a generic shape RE1x1.
The integration of RISAFloor and RISA-3D fits well with the split gravity and lateral design requirements for the
BRBF system. The framing members such as columns and beams can be designed in RISAFloor under gravity loads
to meet the requirements of them resisting gravity loads without BRB braces. After the model is directed to RISA3D, users can add BRB braces to perform the lateral load design for the whole system.

Detach

On the Modify tab, the Detach RISA-3D from RISAFloor option will detach the RISA-3D model from the RISAFloor
model. This will delete any diaphragm information and generated loads.
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RISAFoundation Interaction
RISAFoundation has the ability to transfer load information from RISA-3D and RISAFloor and use this information
to design foundations. The following entry will describe how these loads come across the design modules so you
can accurately use RISAFoundation for your foundation design.

RISAFoundation Interaction with RISA-3D
RISAFoundation transfers joint reactions from RISA-3D into RISAFoundation by way of load categories. This is not
the same as load combinations. Load categories are defined in the Basic Load Cases spreadsheet of RISA-3D.
To get your reactions to transfer from RISA-3D to RISAFoundation:
1. Loads must besplit into specific load categories (DL, LL, etc.) under the Basic Load Cases spreadsheet.
2. The model must be solved.
3. The Director button is used to then transfer to RISAFoundation.

Note:
l

l
l

l

l

If you do not define a load category for a basic load case, then the loads from that case will not be transferred into RISAFoundation.
You must run at least a single load combination.
When you are working between RISA-3D and RISAFoundation Model Settings will only be brought over to
RISAFoundation the first time you transfer from the RISA-3D module. After this first transfer, any time you
change something in RISA-3D from Model Settings that would affect RISAFoundation, then you would also
have to go into RISAFoundation and make the change.
Boundary conditions defined as Reaction or Spring will be transferred but Fixed boundary conditions will
not.
Wall reactions will be brought into RISAFoundation as a series of point loads along the base of the wall. The
point reactions are taken from the location of the base of the wall mesh from the RISA-3D model.

Example of Interaction
A simple example would be the braced frame structure seen below on the left. This has been created in RISA-3D.
The load applied to this structure came from Load Category WL (wind load). Note that this structure had other
loads applied as well. But the wind loads are used as an example.
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RISA-3D Wind Loads Graphical Representation

RISAFoundation Wind Loads Graphical Representation

First a load combination is run (note that this does not have to have wind in the load combination), then
RISAFoundation is chosen from the Director in RISA-3D. The Director is the means by which navigation to different
modules in the program is possible. When RISAFoundation is first entered dead loads applied to points in a plan
view of your structure are displayed. Clicking the

button will then get an orientation similar to the one shown

above. Next, choose WL-Wind Load from the drop down list.
The loads shown above on the
right will be displayed. Note that these loads appear consistent for the type of loading present.

Note:
l

l

The points are relabeled in RISAFoundation, though labeled in a way that can be easily compared to the original RISA-3D model joints. You can scroll through the different types of loads and compare them to RISA-3D
for accuracy verification.
Load combinations do not transfer over from RISA-3D, thus they will need to be re-created in RISAFoundation. An easy way to do this would be to just copy the spreadsheet over from RISA-3D.

Foundations at Different Elevations
If, when moving into the RISAFoundation from RISA-3D, there are foundations that are at different elevations, a
dialog box will pop-up that looks like this:
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You may choose to bring over reactions at a single elevation of your choice. This may be helpful if there are some
reactions that are due to an adjacent structure or support that is not a foundation.
You may choose to bring over all reactions regardless of elevation. This is a good option to have if there is a partial
basement level or any condition where there truly are foundations at different levels.
Note:
l

All of the differing elevations will be brought in at a single elevation.

RISAFoundation Interaction with RISAFloor
This interaction is a little more involved because it involves three programs (RISA-3D, RISAFloor and
RISAFoundation). For RISAFoundation, the bases of columns and the bottom of walls will be considered boundary
conditions. Thus, loads are applied at the bases of these elements for foundation design in RISAFoundation.
To transfer from RISAFloor to RISAFoundation you must pass through RISA-3D. Please see the RISA-3D to
RISAFoundation procedure

Gravity Elements in RISAFloor
Elements (columns, walls) defined as gravity only are the only elements which transfer load directly from RISAFloor
into RISAFoundation. Wall reactions come in as line loads and column reactions come in as point loads.
Wall line load reactions are brought in according the overall moment, M, and axial force, P in the overall wall. The
wall moment is taken as a summation of force*distance about one end of the wall. Once P and M are calculated, the
magnitudes at either end of the wall are calculated as:

Lateral Elements in RISAFloor
When applying loads to lateral members within RISAFloor, those loads are simply attributed to the members
brought over into RISA-3D. Thus, RISAFoundation does not bring any information in from RISAFloor concerning
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lateral members. All of this information is taken directly from RISA-3D. From this point we are just working as if we
only had RISA-3D and RISAFoundation working together. See above.

Limitations
RISAFoundation can not recognize moving loads
Moving Loads, not described as a load category, and their reactions can't be read as loading within RISAFoundation,
thus loads will need to be applied manually to the foundations to account for these.

RISAFoundation requires your Y-axis to be vertical
Models coming from RISA-3D need to have the Y-axis to be vertical to be brought into RISAFoundation. If the Y-axis
is not the vertical axis, then a dialog box will pop up when you try to link to RISAFoundation with this message.

RISAFoundation will not consider non-linear load effects
In a true Non-Linear analysis (with Tension Only or Compression Only members), the individual reactions would
vary depending on which LC was used to create it because different members may be active for different LC's. In
that manner the Load Category reactions that make their way into RISAFoundation are imperfect because a DL or
LL reaction would technically be different for the WLX and WLZ cases.

RISAFoundation will not consider second order effects
In a true second order analysis, the P-Delta effect would vary depending on which LC was used to create it because
of the non-linearity of the effect when multiple loads are combined together. In that manner the Load Category
reactions that make their way into RISAFoundation are imperfect because the P-Delta effect on a DL or LL reaction
would technically be different depending on whether the final Load Combination included WLX or WLZ cases.
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Section Sets
Cross-section properties may be assigned to members in one of two ways; either by choosing a shape directly from
the steel database, or by using a section set. Section sets provide a way to group members so that they have the
same properties. Adjusting the set properties, rather than selecting and adjusting each member can achieve
changes to the properties for all of the members in the set. You must use section sets if you want to perform timber
code checks or steel shape optimization.
The cross section data for the members is recorded on the Section Sets spreadsheet. Cross sectional properties can
be entered manually or may be retrieved from one of the shape databases. Currently the databases include Hot
Rolled Steel, Cold Formed Steel, Wood, Concrete, and Aluminum. Once the section is defined, it is then referenced
on the Members spreadsheet when assigning properties to a member.
To Define a New Section Set
1. In the Data Entry menu click on Section Sets to open the spreadsheet.
2. Select the tab for the Material type that you will be using
3. Enter the section set label and other information. You may edit or create a new material by clicking on
the browse button

in the cells.

4. You may open the database by clicking on the browse button

in the Shape column.

Note:
l

l

If you leave the Shape name blank for General Sections, then you may enter the rest of the properties
(A, I, J) yourself without having to define an arbitrary shape.
For rectangular, circular, and pipe shapes you can use the On-Line shapes to automatically define the
shape properties. See On-Line Shapes.

Section Sets Spreadsheet
The Section Sets spreadsheet records the section properties for the member elements and may be accessed by
selecting Section Sets in the Data Entry menu.

The following are input columns on the spreadsheet that may be used to specify cross section data for the members
in the model.

Section Label
The Section Label is the label you'll reference on the Members spreadsheet to assign properties to a member.
This label can be anything you wish, so long as it's not the same as any other section set label.
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Section Database Shape
The Shape field is used to obtain properties from the shape databases. To use the database, simply enter the name
of the database shape and the shape properties (A, I, J) will be filled in automatically. Click
database.

to pick from the

If you don't want to use a database shape and wish to enter the shape properties directly, just leave this field blank.

Note:
l

For rectangular, circular, and pipe shapes you can use the On-Line shapes to automatically define the
shape properties. See On-Line Shapes.

Section Material
The Material field is used to enter the label of the material. The material must be defined on the Materials
spreadsheet or on the Wood Properties spreadsheet.

Member Type
Enter the member type for the section set. The choices are Column, Beam, Vertical Brace, and Horizontal Brace.
Here are the main effects that the member type will have on your structure:
1.
2.
3.
4.
5.
6.

If using concretemembers, this will define the rebar layout (column vs beam) .
If using design lists, they specifically reference the member type.
If using member area loads, loads will not be attributed to members defined as Hbraces or Vbraces.
If using the RISA-Revit link the link will not work properly unless you use member types.
If integrating with RISAConnection, the connection validation requires proper use of member types.
If using the seismic detailing provisions then you must use proper member types.

Design List
Enter the design list type that you wish to use for this section set. This entry will affect the members that are
available to program when it is suggesting alternate or optimized shapes. Refer to Design Optimization for more
information on the member optimization procedure. Also refer to Appendix A – Redesign Lists for information on
creating or editing these lists.

Design Rules
Enter the design rules type that you wish to use for this section set. When the program is checking alternate or
optimized shapes, it will restrict its selections to members that obey the chosen design rules. Refer to Design
Rules– Size / U.C. for more information.

Cross Section Properties
The cross section properties will be filled in automatically if you use a database shape. For General Materials, you
may leave the shape field blank and enter these directly. Iyy and Izz are for bending about the respective member
local axes. Note that it's not a good idea to edit these fields if you already have a database shape assigned. Any
changes will not be saved and will be replaced with the original values when the file is reopened or the shape is
reentered in some other manner. You should create a new shape in the database to avoid this situation.

Note:
l
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For Tapered WF shapes, only the shape properties at the I-end will be shown on the Section Sets
spreadsheet. To view properties for both ends use the Edit button in the Shape Selection settings.

RISA-3D V20

Seismic Detailing - Input / Design Rules

Seismic Detailing - Input / Design Rules
Seismic Design Rules can be applied to Column, Beam and VBrace members in the model. These will invoke various
design or code check requirements according to AISC seismic design provisions (AISC 341, AISC 358). The program
will use the 2005, 2010, or 2016 versions of these codes depending on the HR steel design code settings on the
Model Settings.
These design provisions primarily apply only to Hot Rolled steel members. However, the Overstrength Req'd
design option applies to all members to which that seismic design rule has been applied. The reason for this is so
that members (collectors or such) which require design to the overstrength provisions per the requirements of
ASCE-7 can be automatically designed to the higher force requirements of the Overstrength load combinations.
The default entry for a member's seismic design rule is None which means that no special seismic detailing
provisions will apply to the code checking provisions for that member.

Seismic Design Rules - Hot Rolled Frame - General / Columns
The first portion of the Seismic Design Rules under the Hot Rolled Frame tab applies to the steel frame in general
and Hot Rolled columns.

Label
The label is a user defined text string which is used as a unique identifier for each of the seismic design rules
defined for the structure. The program comes pre-loaded with number of generic seismic design rules based on
AISC 341 seismic detailing specification.
Clicking on the triple-dots in the Label column will bring up the Seismic Design Rule Editor dialog, where users can
further define the frame type, member ductility, and member overstrength requirements, etc. Users can choose
either to use this editor dialog or the spreadsheet to edit a seismic design rule.
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Frame Type
This defines the frame type (e.g. SMF, SCBF) for the frame. The program is pre-loaded with several typical seismicforce-resisting-systems based on AISC 341 seismic detailing specification. The program uses this entry to determine
which code sections of seismic detailing requirements should be applied to members with the current seismic
design rule.

Column Ductility
This defines the ductility requirements for the columns.
High Ductility refers to a member which requires Seismically Compact sections for members such as a Special
Concentrically Braced Frame (SCBF) or a Special Moment Frame (SMF).
Moderate Ductility refers to a member which require Compact sections for frame members, but which does not
require the special Seismic Compactness defined in AISC 341. One example would be an Intermediate Moment
Frame (IMF).
Minimal Ductility refers to a member which does not have specific compactness requirements beyond the normal
AISC specification. This can even include members with slender elements. One example would be an Ordinary
Moment Frame (OMF).

Note:
l

l

l
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Ordinary Concentrically Braced Frames (OCBF) require Moderate or High ductility out of the brace members (depending on the version of the code), but allow for Minimal ductility out of the other members.
The program will automatically account for this brace ductility requirement. Therefore, the Frame Ductility may still be entered as Minimal.
When checking the seismic compactness of members, the axial load used to calculate Ca is based on the
worst case axial compression from the normal load combinations. It will not consider any axial force that
occurs from an "overstrength" load combination.
The Frame Ductility setting is used by the program when it is checking some of the miscellaneous beamcolumn moment connection requirements per AISC 358. For example: if the beam to column connection
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is specified by the user as a Reduced Beam Section (RBS) then the span to depth ratio of the beam must
be greater that 7.0 to be considered a highly ductile frame, and greater than 5.0 to be considered a moderately ductile frame.

Column Overstrength
In seismic design some members may be required to be designed to an elevated / overstrength load. In RISA, this is
done by creating load combinations with the Omega overstrength factors applied to the earthquake loads. If the
column members are required to be designed to these load combinations, then this check box will be checked.

Note:
l

l

l

l

l

In many cases, it's only the axial effect of the overstrength loads that needs to be considered in the
column overstrength code checks. In these cases, it could be overly conservative to consider the moment
with these elevated axial forces. A future revision to the program will add an Axial Only option to this
input field which would allow the program to ignore the effects of moment when the amplified axial
force is taken into account.
Generally speaking the 2005 version of AISC 341 requires that moment frame columns be designed for
the overstrength loads whenever the axial force for the regular load combinations exceed 40% of the
column's axial capacity. However, the 2010 and newer versions of the same specification always require
that these columns be designed to these overstrength loads. Therefore, this entry cannot be modified
when the 2010 or newer code is selected.
The program does not consider any of the limitations related to the "sum of shears which can be transmitted to the column" or the "sum of the expected strength of the braces".
If a Seismic Design Rule is applied to a column member which is not hot rolled steel (such as a wood
drag strut or collector), that member will ignore the design rules except for the Overstrength required
flag. If this is selected, then the non-steel member's capacity will be checked against the forces derived
from the overstrength seismic load combinations.
Refer to the LC Generator and the Set BLC Entry sub-topics in the Load Combinations section for more
information regarding the creation of overstrength load combinations.

Seismic Design Rules - Hot Rolled Frame - Beams
This portion of the spreadsheet contains information pertinent mostly for the design of hot rolled beams that are
part of moment frames. The only exception to this is the Beam Overstrength option which applies to any beam
member which is assigned the seismic design rule.
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Beam Ductility
This defines the ductility requirements for the beams. The definitions of High Ductility, Moderate Ductility,
Minimal Ductility are described under the Column Ductility section above.

Connection
This field designates which of the pre-qualified moment connections defined in AISC 358 or its supplement are
being used for the beam to column moment connection. The options include the following:
Bolted Flange Plate (BFP) as described in Chapter 7 of AISC 358.
Reduced Beam Section (RBS) as described in Chapter 5 of AISC 358.
Bolted Unstiffened Extended End Plate (BUEEP) and Bolted Stiffened Extended End Plate (BSEEP) as
described in Chapter 6 of AISC 358.
Welded Unreinforced Flange - Welded Web (WUF-W) as described in Chapter 8 of AISC 358.
Kaiser Bolted Bracket (KBB) as described in Chapter 9 of AISC 358
Other/None: There are times where AISC 341 and AISC 358 have conflicting provisions. This includes the definition
of the probable maximum moment at the hinge and the definition of the Strong Column / Weak Beam Ratio. When
one of the pre-qualified connections is selected then the program will enforce the AISC 358 version of the
provisions. When the Other connection is selected then, the AISC 341 version of these provisions will be enforced
instead. This "connection option" should normally be used when the beam will not have moment connections (i.e. it
is part of a braced frame).

Note:
l

The moment connection setting is used (in combination with the Frame Ductility setting on the column
tab) to check some of the miscellaneous beam-column moment connection requirements per AISC 358.
For example: if the beam to column connection is specified by the user as an Reduced Beam Section
(RBS) then the column depth must be limited to a maximum of W36, and the beam weight cannot exceed
300 lbs / ft.

Beam Overstrength
In seismic design some members may be required to be designed to an elevated / overstrength load. In RISA, this is
done by creating load combinations with the Omega overstrength factors applied to the earthquake loads. If the
beam members are required to be designed to these load combinations, then this box would be checked.

Note:
l

l

l

l
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Beams in a braced frame may act as some form of a collector or drag strut. As such, the ASCE-7 seismic
provisions would require that they be designed for the overstrength load combinations.
If a Seismic Design Rule is applied to a beam member which is not hot rolled steel (such as a wood drag
strut), that member will ignore the design rules except for the Overstrength required flag. If this is selected, then the non-steel member's capacity will be checked against the forces derived from the overstrength seismic load combinations.
If only an overstrength load combination was run then you will get no results for members that are not
required to be designed to overstrength loading.
Refer to the LC Generator and the Set BLC Entry sub-topics in the Load Combinations section for more
information regarding the creation of overstrength load combinations.
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Z Factor
This factor is used to define the reduction in plastic hinge moment expected for Reduced Beam Sections. Enter in
the ratio between the plastic section modulus for the reduced beam section and the unreduced beam. For RBS
connections this value will vary greatly, but will always be less than 1.0. The program will not allow a value of less
than 0.1 to be entered in by the user. If this value is left blank, then no reduction in moment is considered.
This factor will be used to determine the probable design strength and the strong column / weak beam moment
ratio for the connection. It does NOT currently reduce the stiffness of the beam used in the analysis.

Note:
l

AISC 358 has some restrictions on the length and depth of cut that is allowed for the RBS section. RISA
does not make any attempt to enforce these restrictions.

Hinge Location
This entry defines the location of the assumed plastic hinge (in inches) from the face of the column. This is used to
determine the design moment at the face of the column as well as the strong column / weak beam ratio.
For RBS connections, this entry should be the distance from the face of column to the center of the reduced beam
section.
For stiffened connections (such as BSEEP, or BFP), this will usually be the distance from the face of column to the
end of the stiffener, haunch, or flange plate.
For unstiffened end plate connections, this entry will usually be the lesser of 50% of the beam depth or 3 times the
beam flange width.
For WUF-W connections, this entry will normally be set to 0.0.

Seismic Design Rules - Hot Rolled Frame - Braces
This portion of the spreadsheet contains information pertinent to the design of hot rolled braces. The only
exception to this is the Brace Overstrength option which applies to any VBrace member which is assigned the
seismic design rule.

Brace Ductility
This defines the ductility requirements for the braces. The definitions of High Ductility, Moderate Ductility,
Minimal Ductility are described under the Column Ductility section above.
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Overstrength Required
In seismic design some members may be required to be designed to an elevated / overstrength load. In RISA this is
done by creating load combinations with the (Ω0) overstrength factors applied to the earthquake loads. If the brace
members are required to be designed to these load combinations, then this box would be checked.

Note:
l

l

If a Seismic Design Rule is applied to a brace member which is not hot rolled steel, that member will
ignore the design rules except for the Overstrength required flag. If this is selected, then the non-steel
member's capacity will be checked against the forces derived from the overstrength seismic load combinations.
Refer to the LC Generator and the Set BLC Entry sub-topics in the Load Combinations section for more
information regarding the creation of overstrength load combinations.

Max KL/r
In seismic design some members may have the following restriction on the maximum slenderness (KL/r) value that
they are allowed to have.

Examples would be AISC 341-05 braces that are part of a Special Concentrically Braced Frame (SCBF). This would
also include AISC 341-05 and AISC 341-10 K, V, or inverted V braces in an Ordinary Concentrically Braced Frame
(OCBF).

Limitations
Panel Zone Capacity - Currently, the program uses the elastic shear capacity equations (AISC 360-2010, eqns J10-9
and J10-10) for its code check of the panel zone. When plastic panel zone deformation is considered (along with
shear capacity of the flanges) less conservative equations ( J10-11 and J10-12) may be more appropriate.
V and Inverted V Braced Frames & Gravity Loads - The requirement that the beam be analyzed as though the
brace carried no dead or live load cannot be directly met in the RISA-3D analysis. However, this may be
accomplished by integrating the model with RISAFloor, which automatically analyzes the beam for gravity loads as
though the brace were not present.
Unbalance Beam force in Braced Frames - The effect of unbalanced brace forces is calculated only for beams in V
or an inverted V frame configuration. This force is reported in the Seismic Detailing portion of the beam's detail
report. However, this force is NOT used in the code checking of the beam UNLESS a capacity-limited (CL) load
combination is used. For capacity-limited LCs (e.g. LC with ELX-CL), the program will apply brace expected
strengths as seismic loads for columns and beams design. Under these load combinations, the beam unbalanced
forces will be automatically considered in beam design by applying the capacity-limited forces.
Expected Strength of Braces - The effect of expected strength of braces is considered through the capacity-limited
load combinations (e.g. ELX-CL, ELZ-CL) for columns and beams in braced frames such as SCBF and BRBF. Users
need to select the supported design code (AISC 2010 or 2016), assign seismic design rules with appropriate frame
type (e.g. SCBF or BRBF), and generate capacity-limited load combinations to perform capacity-limited design for
columns and beams in braced frames.
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The seismic detailing results are presented in two ways: the seismic detailing results spreadsheet and the seismic
detailing sections of the member detail reports. The seismic detailing results spreadsheet is intended to be a
summary report. More detailed information can be found for each member on that member's detail report.

Seismic Results Spreadsheet - Columns
The first tab of the Seismic Design Rules spreadsheet applies to the Hot Rolled members which have been assigned
to the Member Type of Column and which have a seismic design rule applied.

Label, Seismic Design Rules and Req'd Ductility
These fields display the member's basic input data for reference purposes.

Max Code Check and Load Combination
This field summarizes the member code checks from all the load combinations that included seismic force. It does
NOT include code checks related to connection design like panel zone shear checks or continuity plate checks. If the
load combination that controlled the design used the overstrength seismic forces (meaning it had an Ω factor in the
load combination) then the governing load combination will be followed by an asterisk (*).

Slenderness Checks
This field summarizes the worst case condition between local element compactness checks and KL/r slenderness
restrictions (if any). Whether the member passed the required element compactness checks based on the Req'd
Ductility setting. Highly ductile frames are considered to require a "seismically compact" member per the
provisions of AISC 341 Table D1.1. Whereas moderately ductile frames are considered to require a "compact"
member per the requirements of the regular AISC 360 design standard (Table B4.1).
This field will also give a warning message if the column fails any KL/r restrictions such as those given in AISC 34105 section 9.7b which requires that columns which are unbraced must have a KL/r < 60.

Note:
l

For sections that do not have a Compact limit per Table B4.1 of the AISC 360 (i.e. Case 3), and who do not
meet or exceed the non-compact limit, RISA will report as "non-slender".

Panel Zone Checks and Eqn
Whenever the program detects a valid seismic moment connection between a beam and a column it will check the
panel zone of the column per the regular AISC 360 chapter J checks.
For frames that require high ductility (SMF), the required panel zone shear force will be based on the maximum
probable moment projected to the face of column per AISC 341.
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For frames which do not require high ductility (IMF and OMF), the panel zone shear demand will be based on the
end moments from the solved load combinations. If the Overstrength Req'd flag has been set for the column, then
the Ωo load combinations will be used as well. This is because AISC 341 gives little additional panel zone
requirements beyond those given in the AISC 360 specification.
In addition, the program will check the panel zone for column beam connections per the extra seismic detailing
checks of AISC 341. That is the requirement that the thickness of the column web is greater than the sum of the
depth and width of the panel zone divided by 90.
Only the worst case / controlling code equation for the panel zone checks will be reported here. However, detailed
information on the other equations are reported in the column detail report.

Note:
l

l

l

l

The regular panel zone checks are done using the formulas which assume that panel zone deformation is
not included in the analysis.
Currently, the effects of column story shear (which tend to decrease the panel zone shear demand) are
not taken into account.
Per the seismic detailing specification, the extra panel zone thickness checks are only checked for "highly
ductile" frames (i.e. Special Moment Frames).
These conditions are checked for each beam connected to the column with a valid seismic moment connection. However, the total panel zone shear demand is based on the sum of the panel zone shears from
the individual beams. This may be overconservative for cases with an IMF or OMF frame where the maximum moments in the beams occur for different load cases.

Continuity Plate
Whenever the program detects a valid seismic moment connection between a beam and a column, it will
automatically check the column's capacity to resist the concentrated beam flange forces from the moment
connection per section J10.6 of the regular AISC 360 specification. If any of these checks fail, then the program will
report that a continuity plate is required at that connection location.
When the user has selected one of the pre-qualified moment connections from AISC 358, then the program will
enforce the additional continuity requirements of AISC 358-2005 section 2.4.4 or AISC 341-2010 section E3.6f. For
bolted end plates, the equivalent equations from AISC 358 hapter 6 will be used instead. Because the codes do not
require these provision for frames with minimal ductility (OMF's) this check will not be enforced in those cases.
Only the worst case / controlling code equation for the continuity plate checks will be reported here. However,
detailed information on the other equations are reported in the column detail report.

Note:
l

The demand moment used to calculate the beam flange forces is based on the Req'd Moment reported on
the Beams tab of the Seismic Detailing results.

Strong Column / Weak Beam Ratio and Controlling Beam
The Strong Column / Weak Beam ratio will be checked for all moment connections between a beam(s) and the
column. The worst case (lowest) ratio will be reported here. If the frame ductility requirements dictate a minimum
value for this ratio, then the program will also list a pass / fail check in this column. The controlling beam is
reported to identify the location on the column which resulted in the lowest SC/WB ratio. If the worst case
connection had beams framing in from either side then only one of the beams is reported as only one is required to
identify that location.

Miscellaneous Checks
This section relates to a number of miscellaneous checks required by AISC 358. For columns this is normally related
to the maximum depth or weight of the column, or whether the member type (tube, wide flange, pipe) is valid with
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the moment connection assigned to it. Other connection limitations (non-orthogonal / skewed connections) are
reported with the beam's Misc Checks.

Seismic Results Spreadsheet - Beams
The second tab of the Seismic Design Rules spreadsheet applies only to Hot Rolled steel members which have been
assigned a Member Type of Beam and which have a seismic design rule applied.

Label, Seismic Design Rules and Req'd Ductility
These fields display the member's basic input data for reference purposes.

Connection Type
This field merely lists the type of moment connection that was specified for the member in the Seismic Design Rules
applied to the member.

Max Code Check and Load Combination
This field summarizes the member code checks from all the load combinations that included seismic force. It does
NOT include code checks related to connection design like panel zone shear checks or continuity plate checks. If the
load combination that controlled the design used the overstrength seismic forces (meaning it had an Ω factor in the
load combination) then the governing load combination will be followed by an asterisk (*).

Slenderness Checks
This field summarizes whether the member passed the required element slenderness checks based on the Req'd
Ductility setting.
For the 2005 code, highly ductile frames are considered to require a "seismically compact" member per the
provisions of AISC 341, whereas moderately ductile frames are considered to require a "compact" member per the
requirements of the regular AISC 360 design standard.
For the 2010/2016 code seismically compact and compact limits are determine from AISC 341 table D1.1. AISC 360
limits are only used when reporting whether a member should be reported as non-compact, slender.

Note:
l

For sections that do not have a Compact limit per Table B4.1 of the AISC 360 (i.e. Case 3), and who do not
meet or exceed the non-compact limit, RISA will report as "non-slender".

Required Shear
The required shear strength for connection design is listed here. For Highly ductile connections this will be the
shear force required to develop a plastic hinge on either side of the beam plus the contribution of shears from the
gravity loads. In the member's detail report we refer to these forces as Vpr and Vg.
Connections which require Minimal ductility will be designed for the lesser value of the required hinge shear force
(Vpr +Vg) or the Ω shear developed when considering the overstrength load combinations.
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For Moderately ductile connections the required shear force for connection design will be based on the connection
type. Connections listed with a connection type of "other" will use the same criteria as the minimally ductile
connections. The pre-qualified connections (BUEEP, RBS, et cetera) will typically require the same design shear
values (Vpr +Vg) as required for the Highly ductile connections.

Note:
l

l

l

l

The Other connections will assume a value of 1.1 to account for strain hardening (rather than the Cpr
factor used in AISC 358).
The Vg values are obtained during a batch or envelope solution by looking at the beam shears at the
hinge location for every solved load combination which does not include any wind or seismic loading.
If there were no gravity-only load combinations solved then Vg is approximated by taking half the difference in the shear force between the two ends of the beam member.
For minimally ductile moment frames, the required shear need not exceed R*Vu either. Though this is
unlikely to ever govern over the Ω*Vu calculation.

Required Moment
The required Moment strength for connection design is listed here. Currently all highly and moderately ducttile
moment frames beam connections will require that the connection be designed for the maximum probable moment
projected to the face of the column. For minimally ductile moment frames, the required moment need not exceed
R*Mu based on discussion in the AISC 341 commentary.

Note:
l

l

This moment is not used to code check the actual beam and column members. It is used, however, to
determine if the column will require continuity plate stiffeners to resist the connection forces.
The Beam Detail Report may also lists the Overstrength Moments (Ω0*Mu) obtained from solving the
overstrength load combinations. These are reported for reference only.

Strong Column / Weak Beam Ratio and Controlling Column
The Strong Column / Weak Beam ratio will be checked for all moment connections between a beam(s) and the
column. The worst case (lowest) ratio will be reported here. If the frame ductility requirements dictate a minimum
value for this ratio, then the program will also list a pass / fail check in this column. The controlling column
member is reported to identify which end of the beam resulted in the lowest SC/WB ratio.

Span To Depth Ratio
This field summarizes reports the span to depth ratio for the beam. This value is important because it is used in
testing for the AISC 358 pre-qualified connections. Each of the pre-qualified connections will have limits on the
minimum span to depth ratio for which that moment connection can be used. When the frame ductility
requirements and connection type have limits on this value then the program will also list a pass / fail check in this
column.

Note:
l

The span used in this calculation is the clear span from column flange to column flange as specified in
AISC 358.

Miscellaneous Checks
This section relates to a number of miscellaneous checks required by AISC 358.
l
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Geometry Checks on the Beam (i.e. max. Weight, Depth, Flange Thickness, Flange
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l

l

Sloped connections: If beam and column webs are in the same plane, the connection need not be orthogonal.
But, the program will not perform seismic moment connection calculations when the slope exceeds 15
degrees.
Strong Axis Connections: The program currently only supports strong axis moment connections for seismic
code checking. The tolerance for determining if a connected is skewed enough to be disqualified is 5 degrees.

Seismic Results Spreadsheet - Braces
The third tab of the Seismic Design Rules spreadsheet applies only to Hot Rolled steel members which have been
assigned a Member Type VBrace and which have a seismic design rule applied.

Label, Seismic Design Rules and Req'd Ductility
These fields display the member's basic input data for reference purposes.

Note:
l

For OCBF frames, the required frame ductility will be listed as minimal even though the element slenderness
requirements will enforce the highly ductile (i.e. seismically compact) limits for the brace.

UC Max and LC
This is the combined bending and axial code check for the brace. This code check is based on non-overstrength load
combinations only, unless the Seismic Design Rule for the brace has been designated as Overstrength Req'd. The
Load Combination number which resulted in the highest UC value is reported. If the governing load combination
contained overstrength seismic forces (Ω0) it will be followed by an asterisk (*).

Slenderness Checks
This field summarizes the worst case condition between local element compactness checks and KL/r slenderness
restrictions (if any). This field summarizes whether the brace passed the element compactness checks based on the
Req'd Ductility setting. Special Concentrically Braced Frames require a "seismically compact" member per the
provisions of AISC 341.
This also indicates when a brace fails the KL/r restrictions listed in AISC 341.

Note:
l

l

For OCBF frames (which have minimal required frame ductility) still require that the bracing member's element slenderness meet the highly ductile (i.e. seismically compact) limits of AISC 341.
For sections that do not have a Compact limit per Table B4.1 of the AISC 360 (i.e. Case 3), and who do not
meet or exceed the non-compact limit, RISA will report as "non-slender".

Required Tension and Compression
This field summarizes the axial forces required for the design of the brace connections. The connection design
forces are separated into tension and compression design forces. These forces are determined based on the capacity
of the brace itself.
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Note:
l

For frames with Minimal ductility, where Overstrength is required for the brace, the maximum brace
axial load from Overstrength (Ω0) load combinations is reported if it exceeds the capacity-based connection design forces.

Unbalanced Beam Forces
For brace configurations which the program identifies as V or Inverted-V (Chevron) the program automatically
calculates the unbalanced beam forces per the provisions of AISC. The resultant unbalanced vertical force on the
beam is reported.

Note:
l
l

l

l
l

For braces that are non-symmetric the most unbalanced combination of tension/compression is reported.
The horizontal and vertical components are shown relative to the beam's local axes. (Up) and (Down) refer
to the direction of the resultant force on the beam relative to its positive local y axis.
These unbalanced forces are not actually used in the design of the beam member. They are reported for reference only.
The beam must have a seismic design rule assigned to it in order to view these forces.
The requirement that the beam be analyzed as though the brace carried no dead or live load cannot be met
by RISA-3D, since the program cannot force certain members to only carry certain components of a load.
This can be accomplished by integrating the model with RISAFloor though, which will analyze the beam for
dead and live loads as though the brace were not present.

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Unbalanced.

Miscellaneous Checks
There are no miscellaneous brace checks in the program at this time. This field has been reserved for future
additions, and will always report "Pass".
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The seismic detailing results are presented in two ways: the seismic detailing results spreadsheet and the seismic
detailing sections of the member detail reports. The seismic detailing results spreadsheet is intended to be a
summary report. More detailed information can be found for each member on that member's detail report as
described below. The information described here is based on enveloped information from a batch solution.

Design Forces for Moment Connections
The seismic portion of hot-rolled steel detail reports for beams in moment frames contain sections called Required
Connection Shear Strength and Required Connection Moment Strength.

Required Connection Shear Strength
The Vg listed is the shear at the plastic hinge location in the beam due to gravity loads. RISA determines this value
by taking the worst case shear from the load combinations which do NOT include any wind or seismic loads. If
there are no solved LC's which meet this criteria, then the value is taken as half the difference in the end shears
from the seismic LC's.
RISA uses the term Vpr to refer to the shear required to produce the maximum probable hinge moment (Mpr) on
both sides of the beam.. This value will be equal to 2*Mpr / Distance between plastic hinge locations. If the
connection is Other / None then the Mpr will be based on a Cpr of 1.1 per AISC 341 assumptions. If the connection
is a WUF-W connection, this will be based on a Cpr of 1.4. Otherwise, the calculation will be based on the Cpr of the
material as defined in AISC 358.
The Ωo*Vu value listed in the detail report is the shear demand based on the worst case of the Overstrength Load
Combinations. This is presented because AISC 341 (Section 10.2a in the 2005 code or Section E1.6b in the
2010/2016 code) says that moderately and minimally ductile frames need not have their shear connection designed
to a force greater than this value.
Per AISC 341, the required shear strength Demand for a connection requiring high ductility will be based on the Vpr
value plus the shear due to gravity loading (Vg). For minimal ductility, the required shear strength Demand will be
based on the lesser of this shear (Vpr + Vg) or the shear demand from the overstrength load combinations.

Note:
l

l

l

The Vg values are obtained during a batch or envelope solution by looking at the beam shears at the hinge
location for every solved load combination which does not include any wind or seismic loading.
If there were no gravity-only load combinations solved then Vg is approximated by taking half the difference
in the shear force between the two ends of the beam member.
In addition, the program will not allow the design shear to exceed R*Vu. Though this is not likely to ever control over the Ωo*Vu loading.

Required Connection Moment Strength
The required Moment strength for connection design is listed here along with the values used to compute it.
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The Hinge Location reported here is the Hinge Location from the assigned Seismic Design Rule. This represents the
distance from the face of column to the center of the plastic hinge.
The Ze value is the effective plastic section modulus of the hinge. It is equal to the plastic section modulus of the
beam multiplied by the Z Factor from the assigned Seismic Design rule.
The Mpr value is the probable plastic moment projected to the face of the column. This would be equal to
Cpr*Ry*Fy*Ze.
The Demand Moment is the Mpr moment projected to the face of the column. The projection of this moment must
account for the extra moment due to the shear force at the hinge location times the distance from the hinge location
to the face of column. This would be equal to Mpr + (Vpr+Vg)*Hinge Location distance. This value will be used as
the demand moment for calculating the beam flange force demand to determine if the column requires continuity
plate stiffeners.
The Ωo*Mu is reported mostly for reference. However, it may be used to determine the shear demand on the
column's panel zone. In addition, moment frames requiring minimal ductility will not allow the demand moment to
exceed R*Mu.

Column Panel Zone Capacity Calculations for Moment Frames
The seismic portion of hot-rolled steel detail reports for columns in moment frames contains a section called Panel
Zone Summary.

For frames that require high ductility (SMF), the Demand Vu is based on the maximum probable moment projected
to the face of column. In addition, the program will check the panel zone for column beam connections per the extra
seismic detailing checks of AISC 341 (eqn 9-2 in the 2005 code or E3-7 in 2010/2016). That is the requirement that
the thickness of the column web is greater than the sum of the depth and width of the panel zone divided by 90.
For frames which do not require high ductility (IMF and OMF), the panel zone shear demand will be based on the
end moments from the solved load combinations. If the Overstrength Req'd flag has been set for the column, then
the ΩoMu values listed in the section above (Design Forces for Moment Connections) will be used instead.

Note:
l

l

Currently, the effects of column story shear (which tend to decrease the panel zone shear demand) are
not taken into account.
These conditions are checked for each beam connected to the column with a valid seismic moment connection. However, the total panel zone shear demand is based on the sum of the panel zone shears from
the individual beams. This may be over-conservative for cases with an IMF or OMF frame where the maximum moments in the beams occur for different load cases.

Continuity Plate Checks for Columns in Moment Frames
The seismic portion of hot-rolled steel detail reports for columns in moment frames contains a section called
Continuity Plate Summary.
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These checks come from either the AISC 358, AISC 341 or the AISC 360 depending on the required ductility of the
system and the type of moment connection used.

Required Flange Force Calculations
The flange force, Puf, is the demand force that the column has to resist. This force is based on the probable
maximum moment at the face of column (see the Demand Moment from the Design Forces for Moment Connections
section listed above). This will be used for the AISC 358 Continuity Plate Checks.

Note:
l

l
l

When the WUF-W connection is used the program will calculate the probable maximum moment at the face
of the column based on a Cpr of 1.4. This connection assumes a large degree of strain hardening which artificially increases the probably maximum moment over the other pre-qualified connections with a similar
beam and material.
When an Other / None connection is used, the Cpris always assumed to be equal to 1.1.
When ASD design is used the required Flange Force for connection design is determined by dividing the probably maximum moment at the face of the column by a factor of 1.5.

AISC 341-05 Continuity Plate Checks
Column Flange Thickness Requirement (AISC 341: Section 11.5 for 2005, no equivalent in
2010/2016)
For wide flange columns in moment frames which require minimal ductility (OMF's), continuity plates are required
if the equations from section 11.5 are not met. For connections which require higher ductility (SMF or IMF) see the
AISC 358-05 Continuity Plate Checks listed below.

AISC 358/341 Continuity Plate Checks
Column Flange Thickness Requirement (AISC 358: Section 2.4.4 in 2005, E3.6f in 2010/2016)
For wide flange columns with a pre-qualified moment connection (except for Extended End Plates) continuity plates
are required if column flange thickness does not meet the requirements of these sections. This check is enforced for
only high and intermediate ductility requirements (SMFs and IMF's) in 2005, but is checked for all frames in
2010/2016.

Note:
l

If the connection type is listed as Other / None then this check is not enforced even for frames with high
ductility requirements.

End Plate Moment Connections (BUEEP and BSEEP from AISC 358: Section 6.10)
Moment connections requiring high or intermediate ductility (SMFs and IMFs) which use an end plate moment
connections require the continuity plate checks described in Section 6.10 of AISC 358.
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For End Plate Moment Connections (BUEEP and BSEEP) the program will check following concentrated force failure
modes to determine if continuity plates are required:
l
l

l

Column Web Yielding (per AISC 358-05: Equation 6.9-24)
Column Web Crippling (per AISC 358-05: Equation 6.9-29 through 6.9-31): With the assumption that N =
2*tbf
Column Web Compression Buckling (per AISC 358-05: Equation 6.9-26 and 6.9-27): With the caveat that this
check is only performed if the moment connection has beams framing in on both sides of the column.

Note:
l

l

l

These checks are really just variations of the normal AISC 360 continuity plate checks. However, they have
been customized to account for the presence of the end plates. For this reason, the BUEEP and BSEEP
moment connections do NOT check the AISC 360 Continuity Plate requirements as they would be considered
redundant.
The Column Flange Bending checks of equation 6.9-21 are not performed. These checks require the calculation of the Yc term which depends on the number of bolts and the geometry of the connection. Thus, it
can not be calculated and an N/A is presented instead.
The bolted end plate moment connection equations from AISC 358 are only formulated for LRFD design.
Therefore, in cases where ϕ equals 0.75, an Ω value of 2.0 will be assumed. Similarly, in cases where ϕ
equals 0.9, an Ω value of 1.67 will be used.

AISC 360 Continuity Plate Checks
For SMFs, IMFs and OMFs that are not using BUEEP and BSEEP connections AISC 341 requires that the connections
still meet the requirements of AISC 360-05 Section J10. The program will check the following concentrated force
failure modes to determine if continuity plates are required:
l
l
l

l

Column Flange Bending (per AISC 360-05: Equation J10-1.)
Column Web Yielding (per AISC 360-05: Equation J10-2 and J10-3.) With the assumption that N = tbf
Column Web Crippling (per AISC 360-05: Equation J10-4, J10-5a and J10-5b.) With the assumption that N =
tbf
Column Web Compression Buckling (per AISC 360-05: Equation J10-8.) With the caveat that this check is
only performed if the moment connection has beams framing in on both sides of the column.

Multiple Moment Connections Framing to a Column
When a column with seismic design rules has a beam framing in from each side, each beam will show up separately
in the detail report with its own continuity plate checks. Since these checks are local to the beam flange to column
flange force transfer, the program does not assume any interaction between the continuity plate checks of the two
beams.

Strong Column / Weak Beam (SC/WB) Moment Ratios
The seismic portion of hot-rolled steel detail reports for columns in moment frames contains a section displaying
the Column Beam Moment Ratio which is frequently referred to as the Strong Column / Weak Beam Moment
ratio.

This value is reported for reference only for frames that require Minimal or Moderate Ductility (OMF's and IMF's).
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For frames that require High Ductility (SMF's), any value less than 1.0 is considered to fail the SC/WB code check
per AISC 341(Section 9.6 in 2005 and E3.4 in 2010/2016). These frames report a warning that connection bracing
is required anytime the SC/WB ratio is calculated as less than 2.0 per the AISC 341 section for unbraced
connections.

Note:
l

l

The Sum M*pbvalue is based on the maximum probable moment at the plastic hinge location projected to the
centerline of the column.
For two sided moment connections, this Sum M*pbvalue assumes that the shear force from gravity loads (Vg)
adds to the plastic hinging shear force (Vpr) on one side of the connection and takes away from it on the
other side.

Bracing Requirements for Beams in a Moment Frame
The seismic portion of hot-rolled steel detail reports for beams in moment frames contains a section called Beam
Flange Bracing. This section reports the required beam flange bracing forces for moment connection. These values
depend on ductility requirements of the connection.

For connections which require high or moderate ductility (SMF, or IMF), the Lb values used in Equation A-6-8 are
based on Maximum Spacing values shown in the detail report. These maximum spacing for beam bracing is based
on the requirements of AISC 341 (sections 9.8 / 10.8 in 2005 and E2.4a /E3.4b in 2010/2016).
For connections which require minimal ductility (OMF), Lb values used in Equation A-6-8 are based on the
maximum of Lcomp-top, Lcomp-bottom or Lp as defined in AISC 360-05 equation F2-5.

Note:
l

l

The Cd values in equations A-6-7 and A-6-8 are always assumed to be 1.0 based on the commentary to AISC
341.
For RBS connections, the Mr values used in equations A-6-7 and A-6-8 are assumed to be equal to the plastic
section modulus at the reduced beam section.

Requirements for Braced Frames
In addition to the input echo and the Element Slenderness checks, braced frames display the following sections in
the member detail report. These sections are displayed for the Brace Member and (in the case of V or inverted V
braced systems) the beam member attached to the V bracing.

Brace Connection Strength

The three brace connection design forces are all presented for reference, although the actual design of the
connection is outside of the scope of RISA-3D. The first two are determined based on the capacity of the brace itself.
The third value is based on the maximum force in the brace from the solved load combinations. If the brace has
been specified to be designed for Overstrength (Ω0) then this value will be based on the Overstrength load
combinations.

Note:
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l

When using the 2010/2016 code, the expected brace strength in compression is based on the normal AISC
360 chapter E requirements computed assuming a yield stress equal to Ry*Fy.

Unbalanced Forces
For brace configurations which the program identifies as V or Inverted-V (Chevron) the program automatically
calculates the unbalanced beam forces per the provisions of AISC 341. The resultant unbalanced forces on the beam
are reported.

For more information see the Seismic Detailing Results topic; For additional advice on this topic, please see the
RISA Tips & Tricks section of the website: www.risa.com/post/support. Type in Search keyword: Unbalanced.

Brace KL/r Restriction

The program will report the KL/r check for certain brace members based on the user input setting for the Seismic
Design Rules. Examples where a user would likely select this input would be braces that are part of a Special
Concentrically Braced Frame (SCBF) as well as K, V, or inverted V braces in an Ordinary Concentrically Braced
Frame (OCBF).

Buckling Restrained Braces (BRB)
The adjusted brace strength and required connection strength for BRB are different than other HR members. The
compression strength adjustment factor (β) and strain hardening adjustment factor (ω) are included in the
calculation. See "Buckling-Restrained Brace (BRB) Members"for additional information on these parameters.

Miscellaneous Seismic Checks
Element Width-to-Thickness Ratios Checks
This section of the detail report displays the results of the element Width-to-Thickness ratios checks per the
provisions of AISC 341.
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l

AISC 341 Table D1.1 requires (based on the frame ductility and member type) that the Width-to-Thickness
ratios of the cross section satisfy certain criteria. Members do not meet the criteria will report Fail using red
text to indicate that the member has failed the AISC 341 criteria.

Miscellaneous AISC 358 Pre-Qualification Checks
This section of the detail report displays the results of some of the miscellaneous provisions of AISC 358.
Specifically those sections related to pre-qualification of the beam-column moment connection. Some of these
requirements are related to the beam or column dimensions (size, weight, et cetera). Some of them are related to
the clear span to beam depth ratio.

Note:
l

The program is not checking any of the AISC 358 weld restrictions.

Other Miscellaneous Checks
The program produces warning messages (in the detail report only) relating to the vaious AISC 341 restrictions.
Among them are the provisions which require columns with a L/r ratio greater than 60 to be braced out of plane as
shown below.
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Shape Databases
For each material, there are several databases of common structural shapes such as Hot Rolled Steel Wide Flanges,
Cold Formed Shapes, Wood, Concrete Tees, etc. You may also choose from shapes created in RISASection. You may
type in the names directly, select shapes from these databases or add your own shapes.
l

What Aluminum Shapes are available?

Database Shape Types
There are different types of shapes for each material type including General shapes. Names for each shape type
follow a syntax so that they may be typed directly into the Shape field on the Section Sets spreadsheet or on the
Primary tab of the Members spreadsheet. Alternately you may click the
it.

button to look up a shape and select

Hot Rolled Shapes
AISC, Canadian, Trade Arbed and custom Hot Rolled shapes are accessed by clicking the Shape Database
button from the Advanced tab of the Ribbon and then clicking the Hot Rolled tab from within the Shape
Database Editor dialog.

The hot rolled shapes and databases are more fully described in the Hot Rolled Steel Design section. See Hot Rolled
Steel Databases for more information.

Virtual Joists and Virtual Joist Girders
The Steel Joist Institute (SJI) has put together Virtual Joist and Virtual Joist Girder tables which convert common
joist and joist girder sizes into equivalent wide flange beams. These shapes are available by selecting Virtual Joist
Girder or Virtual Joist from the Database menu. For additional advice on this topic, please see the RISA Tips
& Tricks webpage at risa.com/post/support. Type in Search keywords: Virtual Joist Girders

Cold Formed Shapes
Manufacturer and custom cold formed shapes are accessed by clicking the Shape Database
button from the
Advanced tab of the Ribbon and then clicking the Cold Formed tab from within the Shape Database Editor
dialog.

The cold formed shapes and database are more fully described in the Cold Formed Design section. See Cold
Formed Steel Databases for more information

Concrete Shapes
Concrete shapes do not have a predefined database like hot rolled and cold formed steel. Instead, they are defined
using a parametric shape code that may be assigned any depth or width. There are two types of shapes currently
supported: Rectangular and Round. See Concrete Database for more information.
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Wood Shapes
The available wood shapes are based on the dimension lumber and post and timber shapes given in the NDS or CSA
O86, depending on what code you have chosen as your Wood design code. You may also design for multiple plies of
these shapes. Note that the NDS dimension lumber shapes are all nominal sizes. CSA O86 shapes are actual sizes.
Allowable stress values for each shape are based on the species and grade information given in the selected design
code. See Wood Database for more information.

Aluminum Shapes
US, Canadian and custom Aluminum shapes are accessed by clicking the Shape Database
button from the
Advanced tab of the Ribbon and then clicking the Aluminum tab from within the Shape Database Editor dialog.

The aluminum shapes and databases are more fully described in the Aluminum - Databases section.

General Shapes
Arbitrary Shapes
Arbitrary Shapes are a special, catch-all shape. This arbitrary shape type is provided so that any shape can be
added to the shape database.
AISC code checks are not calculated for arbitrary shapes since their place in the specification is unknown.
Everything else will be calculated for them (forces, deflections, stresses). The max thickness (Max thick) value for
the cross section is used to determine the pure torsional shear stress for the shape. "J" is the torsional constant. The
"d" values (the distances to the extreme fibers) allow the program to calculate stresses at the extreme fibers.

Note:
l

l

These shapes will generally be rendered using a greenish cruciform shape. The center of the cruciform will
reflect the centroid of the section with the tips of the cruciform representing the distances from the neutral
axis to the extreme fiber.
Refer to Member Shear Deformations and Member Shear Stresses for more information on the shear area
factors (As-zz Def, As-yy Def, .As-zz Stress, & As-yy Stress) shown in the figure below.

To Add an Arbitrary Shape to the Database
l

To enter an arbitrary shape in the database, click the Shape Database
button from the Advanced
tab of the Ribbon and then clicking the General tab from within the Shape Database Editor dialog. Set
the shape type to Arbitrary, click Add and then enter the shape name and properties.
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RISASection Files
You may create simple or complex sections in RISASection and then import those sections for use in your model.
Sections that exist in RISASection (files located in the "RISASection" file specified in File - Application Settings File Locations) will be available for use in the model. Each section must have a unique name for it to be available.
The shapes that are designated as General Material, Arbitrary Shape Type in RISASection will show up in the
General tab under the "RISASection" Database.

The shapes that are designated as Hot Rolled Steel Material in RISASection will show up in the Hot Rolled tab
under the appropriate Shape Type (Channel, Wide Flange, etc.) when "RISASection" is selected as the Database.

Note: Currently, RISASection can only import General and Hot Rolled Steel shapes. More material choices will be
available in a future version.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: RISASection Integration.

Troubleshooting RISASection / RISA- Interaction
There are a few common issues that arise when attempting to access RISASection files from within RISA-.
l

l

When RISA-3D launches, it will only import RISASection files that exist in the directory specified in File Application Settings - File Locations.
RISA-3D only reads in database files when it is first launched. Therefore, if a RISASection file is created or
modified, then RISA-3D must be closed and re-started before it will recognize the new or modified section.

There are some common mistakes that are made from within the RISASection program that may cause an issue
when trying to read that shape from within RISA-3D.
l
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The name of the RISASection "File" is actually different from the name of the section itself. Both names will
appear in the RISA-3D database, but it is important to give your sections unique names in order to properly
tell them apart. Note: each RISASection file can contain many different sections. Hence the need to name
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l

l

l

each individual section.
Unless specifically identified as a Hot Rolled Material type and shape (from within RISASection), the shapes
will be imported as Arbitrary shapes with a General Material type
RISASection can save files with a new *.nmsx file type (for RISASection 2.0 or higher), or an old *.nms (for
RISASection version 1.1 or older). If saved as the old file type, the sections will only come in as Arbitrary
members with a General material type.
If the file is saved with a *.nmsx extension it will not be read into older versions of the RISA programs (prior
to RISA-3D version 9.1.1.

Structural Desktop (SDT) Shapes
The SDT database is provided by the Structural Desktop software in a file called SDT.FIL. Structural Desktop
automates drawing production of RISA models. The SDT database is provided for shapes that are not directly
supported in RISA models (such as bar joists) but are available in Structural Desktop. For more information on
Structural Desktop see www.structuraldesktop.com.

On-Line Shapes
On-Line shapes are shapes whose dimensions are defined directly in the syntax of the shape name. On-line shapes
are not stored in the shape database because there is enough information from the label syntax to calculate all the
shape properties. A pipe, for example, can be fully defined by specifying the thickness and diameter.
These shapes are treated just like database shapes for stress calculations. Currently, Pipes, Solid Rectangular and
Solid Circular shapes are defined on-line as discussed below in Pipe Database Shapes, Solid Rectangular Shapes, and
Solid Circular Shapes.

Pipe Database Shapes
Pipe shapes, which are hollow circular shapes, are entered as on-line shapes. The syntax for these shapes is
"PIdiaXthick", where "dia" is the pipe outside diameter and "thick" is the pipe thickness (in inches or centimeters).
For example (assuming US Standard units), PI10X.5 would be a 10" diameter pipe with a wall thickness of 1/2".

Solid Rectangular Shapes
These shapes can be defined as on-line shapes. The syntax is "REhtXbase", where "ht" is the rectangle height and
"base" is the rectangle base (in inches or cm). For example, RE10X4 would be a 10" deep, 4" width rectangular
shape (assuming US Standard units). These shapes can also be defined in the Shape Editor. When defined in the
Shape Editor the depth of the solid rectangular section must always be greater than or equal to the width.

Solid Circular Shapes
These shapes are defined as on-line shapes. The syntax is "BARdia", where "dia" is the circle diameter. For
example (assuming metric units), BAR2 would be a circular bar with a diameter of 2 cm.

Database Files
The shape databases are stored in the database files (*.FIL). These files may only be edited through the program.
The path to these files is set in the File Locations tab of Application Settings, which is found in the File menu.
After adding a new shape in your model, you will be prompted with this Changes to Shape Database dialog. Click
'Yes' if you want to add the shape to your Shape Database to be available for all future models. Click 'No' if you do
not want the new shape to be available for other models, this will not save the shape to your Shape Database.

General Reference Manual

625

Shape Databases

You can also make edits to the geometric and section properties of the shapes in your Shape Database. If you
modify geometric properties, you can also use the Re-Calc button for the program to automatically calculate the
corresponding section properties.

After editing the geometric or section properties for a shape in your model, you will be prompted with this Changes
to Shape Database dialog. Click 'Yes' if you want to add the shape modifications to your Shape Database to be
available for all future models. Click 'No' if you do not want the changes to apply to other models, this will not save
the changes in the Shape Database for other models.

Note
l

l
l

l
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Alterations to the shape databases are not permanent unless you agree to save them. Changes that are
not saved only remain valid for the current session and will not be present the next time you start RISA.
New shapes are always added to the bottom of the database in blue text.
To delete a shape specify the database and shape type you wish to delete and then click the Delete button.
To edit a shape click the Edit button and edit the shape properties. Only shapes that are not part of the
default database are able to be edited. If the shape you would like to edit is a default database shape, the
program will ask if you would like to make a copy of the shape. Geometric values can be edited here, and
will allow you to recalculate the section properties if edits have been made.
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Solid Elements
The Solid or 8 node brick element allows you to model structures that are too thick to be modeled by plate
elements. Common applications could include dam models, extremely thick pile caps or vibrating equipment with
extremely thick support slabs. Essentially, these elements should be used whenever the Mindlin – Reissner
assumption of linear strain through the thickness of the element would not be appropriate.
Solid elements may be viewed / edited in a couple of ways, but can only be created by extruding existing plate
elements.

Creating Solids
Solid Elements are not drawn in RISA-3D. Instead, they must be extruded from a mesh of plate elements. Use the
Insert menus or the Drawing Toolbar to create new solids. Once you have created these items, you may use other
graphic features to load the model and set boundary conditions.
Creating solid models requires more forethought than either beam or plate elements. To create solids you must first
create a plate element mesh and then extrude that mesh into a series of solid elements. See Plate Modeling Tips and
Plate Modeling Examples for tip on building plate element meshes. You can set all the element properties up front
or you can modify these properties after you draw them. Modifying Properties is discussed in the next section.
The Extrude Plates into Solids dialog is shown below. This lets you take any existing plate and extrude it out into a
three dimensional object.
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To Extrude Solids:
1. If there is not a model view already open, then click the Open 3D Views in the View tab of the ribbon toolbar.
2. If you do not already have a plate element mesh, then you must create one. See Drawing Plates for more
information on this.
3. Click the Solids button and set the solid properties.
4. Enter the extruding options. The X, Y, and Z components of the extruding vector, the thickness of the extrusion, and the number of elements along the extrusion vector.
5. You may choose to extrude a single solid at a time or you may choose to extrude an entire selection of plates.
To extrude only a few plates choose Extrude by Clicking Plates Individually and click Apply. Click on plates
with the left mouse button. To extrude a selection of plates, choose Extrude All Selected Plates and click
Apply.

Note
l
l
l

l

Only Quadrilateral plates can be extruded.
To extrude more solids with different properties, press CTRL-D to recall the Create Solids dialog.
You may also view and edit solid properties by clicking on a solid.
You may undo any mistakes by clicking the Undo

button.

Modifying Solids
To modify solids, you may click on a solid to view and edit its properties in the Properties panel. You can also
select multiple Solids and use the Properties panel to modify a possibly large selection of elements.
The Properties panel discussed here lets you modify the properties of solids that already exist in your model. You
can modify solids one at a time by selecting a single solid and modifying the properties. You may also modify entire
selections of solids by selecting the solids first and then modifying the parameters for the entire set. See the
Selection topic for more on selecting.
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Sub-Meshing Solids
You can submesh solid plate elements into a mesh of smaller elements. This new mesh can be any size up to the
program limits for joints and/or solids. This is very useful for refining a coarse mesh of elements, just make sure
that all adjacent solid elements (elements sharing an edge) maintain connectivity.

You can define different submesh increments in each direction.
You can submesh the solids one at a time by selecting the Click to Apply option and then clicking on the solids you
wish to submesh. You may also modify entire selections of solids by selecting the plates and then using the Apply
to Selected option.
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To Submesh Solid Elements
1. If there is not a model view already open, then click the Open 3D Views in the View tab of the ribbon toolbar.
2. Select the Solids you want to sub mesh.
3. Click the Submesh Solids button in the Modify tab in the Ribbon toolbar. Then specify the number of
pieces along the side.

Note:
l

l

To submesh more solids with different parameters, press CTRL-D to recall the Submesh Solids settings.
You may undo any mistakes by clicking the Undo

button.

Solids Spreadsheet
The Solids Spreadsheet records the properties for the solid elements of the model and may be accessed by selecting
Solids on the Data Entry menu.

The following data columns hold the Primary data for the solids:

Solid Labels
You may assign a unique label to any or all of the solids. You can then refer to the solid by its label. Each label has
to be unique, so if you try to enter the same label more than once you will get an error message. You may
relabel solids at any time with the Relabel Allor Relabel Selected buttons in the Modify tab of the Ribbon
Toolbar.

Solid Nodes
The A, B, C, D, E, F, G, and H node entries are used to define the 8 corner nodes of the solid element. These nodes
are unable to be edited from within the spreadsheet, since solids are created by extruding existing plates.

Solid Material
The material label links the solid with the desired material defined on the Materials Spreadsheet.

Note
l
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Solids are always defined with general materials. This is because the other material sets (Hot Rolled, Cold
Formed, Wood, and Concrete) are used to designate member code checking specifications. Since solids are
only used for analysis, no code checking is provided and the material must be designated as a general material.
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Activation
The Activation data column allows for solids to be set to 'Active', 'Inactive', or 'Excluded'. These choices may be
made by selecting them from the drop down list or by entering an 'I' for 'Inactive' or an 'E' for 'Excluded'. If the cell
is left blank the plate will be 'Active' by default. See Inactive and Excluded Solids for more information.

Solid Information
Just as with the nodes, members, and plates you may click any solid to view it’s properties. All of the same
information that is stored in the Solids spreadsheet is displayed for the solid you choose, and may be edited. This
is a quick way to view and change solid properties.

Solid Labels
You must assign a unique label to all of the solids. You can then refer to the solid by its label. Each label has to be
unique, so if you try to enter the same label more than once you will get an error message. You may relabel solids
at any time by clicking the Relabel All button in the Modify tab in the Ribbon toolbar and selecting Solids.

Corner Nodes
The A, B, C, D, E, F, G, and H node entries are used to define the 8 corner nodes of a hexahedral element.
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Solid Material
The material set label links the solid with the desired material defined on the Material spreadsheet.

Activation
The activation state of the element may be changed. If the solid is made inactive, you will need to activate the solid
from the solids spreadsheet, or by using the Criteria Select feature to find and select inactive solids.

Note
l

l

If you have a plate that has a side of a length that is less than the merge tolerance that you specify in the
Model Settings under the Solutions tab, then we will not extrude a solid element from that plate.
If you come across this as being a problem, then your plates are probably not well meshed and you should
think about cleaning up your mesh.

Inactive and Excluded Solids
Making an item such as a member or solid inactive allows you to analyze the structure without the item, without
having to delete the information that defines it. This leaves data intact so the item may be easily reactivated. This is
handy if you want to try a model with and then without certain items, without having to actually delete the data.
Choosing "Inactive" makes the item inactive, i.e. the item is not included when the model is solved or plotted.
Choosing "Exclude" will exclude it from the results list. So, an item set as "Exclude" will be treated like any other
solid in the solution and plotting of the model, but the solid will not be listed in the solution results (forces, stresses
etc.). This is useful if there are certain items whose results you're not interested in. You don't have to clutter up the
results with these items and can concentrate on the items you're most interested in. See Printing for more limiting
printed results.

Solids Formulation
A reference for this element is Finite Element Procedures, by K.J. Bathe, Prentice-Hall, 1996. Although the book
does not complete the element derivations, it does provide many references for papers on the family of elements. In
brief, the element formulation is standard 8-node isoparametric formulation.

Node Connectivity
The node connectivity in our current solid formulation follows the “left hand rule”. It means if the first 4 nodes are
ordered counterclockwise in plane (as shown in the picture below), then node 5 has to be below node 1. However, if
the first 4 nodes are ordered clockwise in plane, then N5 would have to be above node 1.
The node connectivity for solid element is listed in the following picture.
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If the solid element is generated using the extrusion tool, the nodes will automatically be generated in the proper
order. However, when user is modifying the location the nodes, it is important to keep the order the nodes to be
consistent with the rules stated above. If not, then the local element matrix will be singular and an error message
will be produced at solution time.

Degrees of Freedom
The Solid element activates the THREE translational degrees of freedom at each of its connected nodes. Rotational
degrees of freedom are NOT activated. This element contributes stiffness to all of these translational degrees of
freedom. If a rotational load or constraint is applied to a node that is only connected to the solid elements, it will be
ignored. Modeling these types of rotations would be similar to modeling the "Drilling Degree of Freedom" for plates.
Refer to the Modeling Tips section of the general reference manual for more information.

Coordinate System
For the time being, no local coordinate system is defined for the solid element. All the input and output, such as
material properties, stresses, displacements are all defined in the global coordinate systems.

Solid Modeling Tips
Number of Elements
The standard iso-parametric formulation needs at least 4 elements through the thickness in order to accurately
simulate a bending dominant part (such as a thin beam or thin plate).

Aspect Ratio of Elements
Solid Elements are more sensitive to element distortion than plate elements. For this reason, it is a good idea to
keep a solid elements relatively un-distorted. The best formulation for a solid is a cube with equal length sides.
Note
l

Solids are always defined with general materials. This is because the other material sets (Hot Rolled, Cold
Formed, Wood, and Concrete) are used to designate member code checking specifications. Since solids are
only used for analysis, no code checking is provided and the material must be designated as a general material.
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l

It’s generally more efficient to use the Graphic Editing features if you want to change the properties for many
solids at once.

Loading
For the time being, only joint loads and self weight can be applied to the solid elements.

Verification Examples
Open the Solid_Cantilever.r3dfrom the Examples folder in the RISA directory.

In this example, a straight cantilever beam (modeled with solid elements) is subjected to a unit force at the tip in
the three orthogonal direction and the unit moments at the tip about the three orthogonal directions, each in a
different load case. The tip displacements are compared with hand calculations as shown below:
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The values shown in the table for the RISA output is an average of the 35 nodes at the tip of the cantilever.

Case

Equation

Theory

RISA

% Difference

Axial Extension

Delta = PL/AE

0.060"

0.060"

0

Strong Axis Bending

Delta = PL3/3EI

1.372"

1.361"

0.80

Weak Axis Bending*

Delta = PL3/3EI

4.322"

4.203"

2.75

From this table we can see that solid element deflections are in very good agreement with the theoretical values.
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Solid Elements - Results
When the model is solved, there are two types of results specifically for solid elements: Solid Stresses and Solid
Principal Stresses.

Solid (Global) Stress Results
Access the Solid Stress results by selecting Solid Stresses from the Results panel.

The solid element stresses in the global directions are evaluated at the standard 2 x 2 x 2 Gauss integration points
of the element and extrapolated/interpolated to the joints and the center of the element for graphical display of the
stress contours. The Solid Stresses spreadsheet, however, only displays the center stress value for each element.
These stresses are always reported with respect to the global X, Y and Z axes of the model.
For enveloped results the maximum and minimum value at each location is listed. The load combination producing
the maximum or minimum is also listed, in the "LC" column.

Sign Convention for Stresses
For solid element stresses, RISA uses a sign convention where tension is represented by a positive value of Sigma
XX, Sigma YY, or Sigma ZZ.
Sign convention for the other stresses is as shown in the image below.
o

o

o
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The first subscript represents the plane on which the stress is acting. In the case of Sigma YZ, the plane is
perpendicular to the Global Y plane.
The second subscript represents the direction of the stress. In the case of SigmaYZ, a positive stress has an
orientation in the positive Z direction.
Since RISA's implementation uses only isotropic material, Sigma YZ = Sigma ZY, Sigma XY = Sigma YX, and
Sigma XZ = Sigma ZX.
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Note:
l
l

See Spreadsheet Operations to learn how to use Find, Sort as well as other useful spreadsheet options.
See Results View Settings to learn how to plot solids results.

Solid Principal Stress Results
Principal values and their associated principal directions are also computed. Access the Solid Principal Stress
results by selecting Solid Principals from the Results panel.

Principal Stresses
Sigma1, Sigma2, and Sigma3 represent the principal stresses for the element. The principal stresses are the three
eigenvalues of the 3 by 3 stress matrix.
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Orientation of Principal Stresses
The direction of the Sigma1 principal stress is defined by Angle1X, Angle1Y, and Angle1Z. Where each of the angles
defines the angle between that global axis and the principal stress direction. The same definitions hold true for the
Sigma2 and Sigma3 stresses.

Von Mises Stress
The Von Mises stress is a combination of the principal stresses and represents the maximum energy of distortion
within the element. This stress can be compared to the tensile yield stress of ductile materials for design purposes.
For example, if a steel plate has a tensile yield stress of 36 ksi, then a Von Mises stress of 36 ksi or higher would
indicate yielding of the material at some point in the plate.

For enveloped results the maximum and minimum value at each location is listed. The load combination producing
the maximum or minimum is also listed, in the "LC" column.

Note:
l
l

See Spreadsheet Operations to learn how to use Find, Sort as well as other useful spreadsheet options.
See Results View Settings to learn how to plot solids results.

Solid Corner Force Results
Access the Solid Corner Forces Spreadsheet by selecting the Results Tab and then selecting Envelope (or LC)
button Solid Corner Forces. Alternatively, on the Results toolbar you can select Solid Corner Forces
Spreadsheet.

The solid corner forces are the global forces at the corner of each plate and are listed for each active solid.
These are the forces calculated at the corners of the solids, in the GLOBAL directions. These values are obtained by
multiplying the solid's corner displacements with the global stiffness matrix. Unlike the local stresses and forces,
which are very accurate approximations, these corner forces represent EXACT results based on linear elastic theory.

638

RISA-3D V20

Solid Elements - Results
Also, the local forces are listed on a 'per unit length' basis, whereas these global direction corner forces represent
the total force on the solid at the corner in the given direction, in the same way that node reactions are reported. At
any given node, the corner forces for all solids connected to that node should sum to zero (a requirement of
equilibrium), assuming no members or boundary conditions are also present at the node.
For enveloped results, the maximum and minimum value is listed. The load combination producing the maximum or
minimum is also listed, in the "LC" column.

Note
l

See Spreadsheet Operations to learn how to use Find, Sort, Label Marked Lines in Current ViewShow
Selected Lines in Current View and other options.
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Solution
Note:
l

The linear-elastic behavior of the program implicitly means that non-linear (2nd order) behavior is not generally supported. Tension-structures such as guy cables or fabric structures would fall into this non-linear category. Please see the Modeling Tips section for some ways to approximate this behavior. This note applies to
all elements in the program (wall panels, plates, members, etc.).

Four solution options are presented when you click Solve on the menu. Some of the options require other solution
types to be performed. See Results for information on solution results. For additional information on Dynamic
Analysis and Response Spectra Analysis results refer directly to those sections. For connection design within RISA3D see the RISAConnection Integration topic.

What do you want to do?
l
l
l
l

Perform a dynamic analysis.
Perform a response spectra analysis.
Perform a Time History solution.
Perform a Static Solution

What do you want to know?
l
l

What is an Envelope Solution?
What is an Batch Solution?

Differences Between RISA-3D and RISAFloor
RISAFloor performs an independent solution at each floor. The assumptions in the Floor solution are essentially the
following:
l
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The vertical stiffness of walls are infinite and are not affected by the stiffness of the members supporting
them.
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l

l
l

Vertical and rotational stiffness of columns are approximated based on the floor height and properties (EEI/L
and AE/L).
Lower floors will not affect the solution or loading of floors that are located above them.
RISA-3D results do not currently account for Live Load Reduction coefficients in the analysis or design unless
the model is linked to RISAFloor.

These assumptions are not always 100% accurate. Therefore, the RISA-3D solution can differ in cases where these
assumptions are less than perfect.

Static Solutions / Stiffness Matrix
Static solutions are based on load combinations and may be performed on any defined load combinations. When a
static solution has been performed and the results are available the

icon on the status bar in the lower left

corner will changefrom
to
. If any changes are made to the model that invalidate the results then the results
will be cleared and another solution will be necessary.
The solution is based on the widely accepted linear elastic stiffness method for solution of the model. The stiffness
of each element of the structure is calculated independently. These element stiffnesses are then combined to
produce the model's overall (global) stiffness matrix. This global matrix is then solved versus the applied loads to
calculate joint deflections. These joint deflections are then used to calculate the individual element stresses. The
primary reference for the procedures used is Finite Element Procedures, by K. J. Bathe (Prentice-Hall, 1996).

Skyline Solver
This solution method is also sometimes referred to as an Active Column solution method. In finite element analysis,
the nonzero terms of the stiffness matrix are always clustered around the main diagonal of the stiffness matrix.
Therefore, the Skyline or Active Column solutions take advantage of this by condensing the stiffness matrix to
exclude any zero stiffness terms that exist beyond the last non-zero term in that column of the matrix.
Since the majority of terms in a stiffness matrix are zero stiffness terms, this method greatly reduces the storage
requirements needed to store the full stiffness matrix. However, for large models (+10,000 joints) , the memory
requirements even for a skyline solution can be problematic.
This solution method has been used successfully in RISA for more than 20 years, and has proven its accuracy
continuously during that time.

Sparse Solver
The skyline solver described above is moderately efficient because it only stores and performs operations on the
terms within the "skyline" of the stiffness matrix. However, that solution still contains a great number of zero
stiffness terms within the skyline of the matrix. A Sparse Solver will reduce the matrix size to an absolute minimum
by eliminating the storage of ALL zero stiffness terms.
A sparse solver is the most efficient solution methodology possible because it stores and performs operation only
on the non-zero terms of the stiffness matrix. For this reason the sparse solution is preferred from both a solution
speed and memory requirement standpoint.

Note
l

The skyline solver is retained mostly for comparison and verification purposes.

Multi-Threaded Solutions
RISA products now have the ability to use multiple CPU cores if you set the Processor Core Utilization to Multiple
(Optimum) or Maximum in the Model Settings. The program will split up the solving based on load combination and
use each available CPU core to solve load combinations in parallel. Once this portion of the solution is complete the
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program then combines this data for enveloping and design purposes. This behavior will improve solution time for
computers with multiple cores and models with large numbers of load combinations.
During the load combination portion of the solution the solution dialog will show progress for each core being used.

Single Combination Solutions
Choose this option to solve one load combination by itself.

Envelope Solutions
Static solutions may also be performed on multiple combinations and the results enveloped to show only the
minimum and maximum results. Each of the results spreadsheets will contain minimum and maximum values for
each result and also the corresponding load combination. The member detail report and deflected shape plots are
not available for envelope solutions. See Load Combinations to learn how to mark combinations for an envelope
solution.

Batch Solutions
Static solutions may be performed on multiple combinations and the results retained for each solution. When
performing a batch solution, you have the option to also include a set of envelope results. This is useful when an
envelope result is desired to quickly determine a controlling load combination, but when the investigation of that
load combination required the greater details given with batch solution results. When using the Batch + Envelope
Solution, to view the envelope results, click on a spreadsheet in the Results toolbar. To view the batch results, click
on that same spreadsheet in the Results toolbar a second time. Both the envelope and batch solution spreadsheets
should now be available simultaneously.
You may group the results by item or by load combination by choosing from the Results section on the Results tab.
For example you can have all the combination results for member M1 together or you can have all the member
results for Load Combination "D+L" together. See Load Combinations to learn how to mark combinations for a batch
solution.
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Dynamic Solutions - Eigenvalues & Mode Shapes
In this section, the term "Dynamic Solutions" refers to solving of the dynamic properties of a structure. This
involves assembling the mass matrix, solving for the eigen values (natural periods / frequencies), as well as
determining the mode shapes of vibration associated with each period / frequency. Dynamic analysis requires a
load combination, but this combination is merely used to determine the mass of the model. See Dynamic (Modal)
Analysis for much more information.
When a dynamic solution has been performed and the results are available the

icon on the status bar in the

lower left corner will change from gray to
. If any changes are made to the mode that invalidates the results then
the results will be cleared and another solution is necessary.

Accelerated Solver
The Accelerated Solver is actually three solvers in one: A Direct Jacobian, an Accelerated Sub-Space solver, and a
Lanczos Solver. Each of these solvers will have a certain range of models for which it is most efficient. Therefore,
RISA will automatically detect which should be most efficient for the given model and use that solver for the eigensolution. This solver is much more efficient than the standard solver and will fine frequencies and mode shapes in a
fraction of the time the standard solver. Therefore, it is the default solution option.

Standard Solver
This solver uses sub-space iteration to solve for the Eigen values. This solver has been used for years and the
accuracy of the results is very well established. It has been included mostly for comparative / verification purposes.

Ritz Vector Solver
This solver uses Load Dependent Ritz (LDR) vectors to bias the dynamic solution. This means that the solution does
not necessarily represent the true mode shapes or natural frequencies of the structure. As such, this solution should
not be used in cases where the natural frequencies and modes shapes are the main goal.
Ritz vectors are derived by using a static displacement vector as the basis of the derived vector, only allowing for
the solution of modes / vectors that will be excited by the initial loading or which will contribute to the total
response. In RISA, the initial static displacement vectors are based on the load combination used for the definition
of dynamic mass. The mass defined in this load combination is converted into a static load in each direction for
which a Response Spectra solution is requested. The solution of which forms the basis for the initial Ritz Vectors.
Note:
l

l

l

l

For cases where the mode shapes and frequencies are used to estimate dynamic response (i.e. Response Spectra or Time History analysis), it has been demonstrated that using Ritz vectors can produce a more accurate
response than would be obtained using the same number of true eigen modes.
It is possible, however, for there to be some frequency shift in the mass participation. For the case of earthquake response of a typical building structure, this frequency shift should result in a more conservative base
shear than would be produced by a true eigen solution producing the same amount of mass participation.
In particular Ritz Vectors are useful for cases in which it is difficult to obtain the desired level of mass participation with a traditional eigen value analysis. This is because Ritz vectors are biased towards a presumed
deflected shape.
When Ritz Vectors are used for a Time History analysis the LC used as the basis for the dynamic mass should
contain TH loading at the main joints of the structure. The program will detect this and then include the
Time History Load function in the initial static displacement vector. This doesn't change the mass matrix at
all. But, it will bias the Ritz Vectors to displacements at those joints which leads to a more accurate Time History response with fewer modes.
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Dynamic Solutions - Response Spectra
l

l

Whenever a dynamic / eigen solution has been performed the

icon on the status bar in the lower left

corner will change from gray to
.
If any changes are made to the model that invalidate these dynamic results (even if they don't invalidate the
mass matrix), the dynamic results will be cleared and need to be re-solved before a time history analysis can
be performed.

Note:
l

l

l
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Alpha will default to zero, at which point the solution is identical to the Newmark Beta method using integration constants Beta = 0.25 and gamma = 0.5.
A negative value for alpha is often used then the desire is to dissipate energy associated with higher frequency response. This makes the HHT solution methodology more stable than other solution methods, and
may allow the user to set their integration time step slightly larger to improve time history solution speed.
Refer to topic Dynamic Analysis - Time History for more information on setting time steps.
RISA requires an Eigensolution or Ritz Vector solution even when Direct Integration is used. Refer to
Required Number of Modes for a discussion on this topic.
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Spreadsheet Operations
Powerful spreadsheets may be used to view, sort and edit the input data and results. The spreadsheets and model
views are synchronized. As you edit a model graphically the spreadsheets are automatically updated and as you
make changes in the spreadsheets the model views reflect these changes immediately.
The input data may be accessed from the Explorer sidebar or the Data Entry spreadsheet
Spreadsheets tab of the ribbon.

button on the

You may edit the data or you can add new data. You can also paste data from another application directly into the
spreadsheet via the Windows clipboard. Any changes made to the input spreadsheets may also be viewed
graphically.
After solving the model, results are recorded in spreadsheets for browsing. These spreadsheets may be accessed
from the Explorer sidebar or the various result spreadsheet buttons (Envelope
) found on the Results tab of the ribbon.
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You may sort the results in order to find maximums and exclude data that is not important. You may also copy this
data to the Windows clipboard and use it in another application.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Advanced Spreadsheet.

Moving and Scrolling
To move between cells in a spreadsheet, click any cell or use the keyboard arrow keys. When you move to a cell it
becomes the active cell. To see a different area of the spreadsheet use the vertical scroll bars on the right side of the
spreadsheet.

To Scroll

Do This

One row up or down

Click the arrows on the vertical scroll bar.

One column left or
right

Click the arrows on the horizontal scroll bar.

One page up or down

Click above or below the scroll box in the vertical scroll bar.

One page left or right

Click to the left or right of the scroll box in the horizontal
scroll bar.

A large distance

Drag the scroll box to the approximate relative position.

Note:
l

l

The size of a scroll box indicates the proportional amount of the spreadsheet that is visible. The position
of a scroll box indicates the current location relative to the spreadsheet.
The mouse wheel is also an excellent tool for scrolling up and down in spreadsheets or graphics. Roll the
wheel or click and drag to move around.

Spreadsheet Keyboard Commands
The following keyboard commands are available:

646

Key

Function

Arrow Keys

Move the active cell one location
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Key

Function

TAB

Move right one cell
Move to the first column of the next line.

ENTER

Adds new line if necessary.

PAGE UP

Move the active cell one full page up.

PAGE
DOWN

Move the active cell one full page down.

HOME

Move to the first line of the spreadsheet.

END

Move to the last line of the spreadsheet.

F3

Insert new line below current line and repeat the current values in the new
line.

F4

Delete current line.

F8

Add new row to end using values from row above.

Selecting Spreadsheet Cells
Before you can carry out commands or tasks in a spreadsheet, you must select the cells that you want to work with.

To Select

Do This

A single cell

Click the cell, or press the arrow keys to move to the cell.

A range of cells

Click the first cell of the range, and then drag to the last
cell.

An entire row

Click the row heading.

An entire column

Click the column heading.

Adjacent rows or
columns

Drag across the row or column headings

Note:
l

To cancel a selection of cells, click any single cell in the spreadsheet.

Undoing Operations
RISA-3D provides you with virtually unlimited Undo capability so that you may easily correct mistakes or just back
up to try different possibilities. Simply click the Undo button as many times as you wish to go back a step.

Another option is Multiple Undo, accessed by the drop-down arrow next to the Undo button. This will allow you to
choose, back to a specific previous action, that you would like to Undo.
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The model view and the spreadsheets will visually display the "undoing". Remember that graphic edits are undone
as well.

Redoing Operations
RISA-3D provides you with virtually unlimited Redo capability so that you may reapply actions that were
previously undone. Simply click the Redo button as many times as the Undo button was used just prior.

Another option is Multiple Redo, accessed by the drop-down arrow next to the Undo button. This will allow you to
choose, back to a specific previous action, that you would like to Redo.

The model view and the spreadsheets will visually display the "redoing". Remember that graphic edits are redone
as well.
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Editing Spreadsheets
The spreadsheets have been specifically developed for the input and editing of structural models. There are many
ways to edit the spreadsheets allowing you to quickly build your model. You may copy and move data from other
locations or other files. You may also fill large blocks of cells automatically and perform math on these cells.
To Change Basic Load Cases in a Load Spreadsheets
l

Use the drop down load list or the adjacent buttons on the window toolbar to control the basic load case
in a load spreadsheet.

To Fill Selected Cells
1. Select the cells you wish to fill.
2. Click the Block Fill button.

3. Type the value you wish to apply.

4. Click OK.
To Perform Math on Selected Cells
1. Select the desired cells.
2. Click the Block Math button.

3. Specify the value and the operation you wish to apply.

4. Click OK.
To Cancel or Undo Editing
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l
l

To cancel an entry before you press ENTER, press ESC.
To undo a completed entry, click the Undo button.

.
To Edit Cell Contents
1.
2.
3.
4.

Click the cell that contains the data you want to edit.
Make any changes to the cell contents.
To enter your changes, press ENTER.
To cancel your changes, press ESC.

Note
l
l

To replace the contents of a cell, click on the cell and type the new entry.
To edit the contents of a cell, double-click on the cell and use the arrow keys to locate the cursor and perform the edit.

Inserting, Deleting and Clearing Cells
To insert cells you must insert an entire row. When you delete cells you must delete an entire row. The row is
removed from the worksheet and shifts the lower cells to fill the space. When you clear cells, you remove the cell
contents but leave the blank cells on the spreadsheet.
To Insert Rows
1. Click a cell in the row immediately above where you want the new row.
2. To insert a blank line, click the Insert Row button.

3. To have the values of the current line copied in the new line, click the Add Row button.

To Clear Cell Contents
1. Select the cells, rows, or columns you want to clear and press the DELETE key.
To Delete Rows
1. Select the rows you want to delete.
2. Click the Delete Selected Rows button and the lower cells will shift up to fill the space.

Note
l
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Some spreadsheets do not allow you to delete lines. For example the Member Design spreadsheet has
one line for each member defined. You may leave these lines blank but may not delete them.
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Moving and Copying Cell Contents
Standard Windows cut, copy and paste functions are fully supported. By using the clipboard you may move or copy
any spreadsheet data to another location in the same spreadsheet, or to another spreadsheet (provided it fits). You
may also copy data to or from another model or any other application that supports copy and paste such as a word
processor or spreadsheet.
To Move or Copy Cells
1. Select the cells you want to move or copy.
2. To copy the cells select the Copy Button from the Spreadsheet ribbon.

3. Click on the cell you wish to place the data in and click the Paste button.

To Move or Copy Cells between Existing Cells
1. Select the cells you want to move or copy.
2. To copy the cells selectthe Copy Button from the Spreadsheet ribbon.

3. Select a cell on the row above where you want to place the data.
4. Click the Insert Row button for each new line that is needed.

5. Click on the upper left cell you wish to place the data in and click the Paste button.

To Move or Copy Cells to Another File
1. Select the cells you want to move or copy.
2. To copy the cells selectthe Copy Button from the Spreadsheet ribbon.

3. Open the file you wish to copy the data to.
4. Click on the cell you wish to place the data in and click the Paste button.

Note:
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l

l

Your data stays in the clipboard until you cut or copy new data. You may repeat step 4 to move or copy
data to multiple locations.
When you copy information, you have the option to Copy or Copy with Headers. This is helpful if you
are copying information to a spreadsheet-type program. See the Customizing RISA topic for more information on this.

Sorting and Finding in Spreadsheets
You may sort spreadsheets by the values in most any column. Simply click in the column you wish to sort, click on
the Sort button and choose the sorting method.

You may relabel the nodes, members, plates, or solids after sorting them by using the options in the Tools Menu.
To locate or find a specific element while in a spreadsheet, click the Find & Replace button on the Spreadsheet tab
of the ribbon.

Default Spreadsheet Data
Many of the spreadsheets provide the option to save the current data as the default and every new file subsequent
to the save will already have that data. This way the office standards that you might use in most of your models are
already entered and available in new models. This feature is available in the following spreadsheets: Materials,
Design Rules, Footings, and Load Combinations.
To save default data simply click the Save as Defaults button when you are ready and the current data in the
spreadsheet will be used in each new file that you create.

The data is saved for the current, active, spreadsheet only and affects no other open or closed spreadsheets.

Special Spreadsheet Functions
There are special functions that help you with a particular spreadsheet. For example you may generate K factors for
members on the Member Design Parameters Spreadsheet. These features may be accessed on the Window
Toolbar or you may right click your mouse on the spreadsheet and choose the feature on the Shortcut Menu.
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Member Design Spreadsheet
Click
to approximate the K factor for the current member or all of the members. See K Factors (Effective Length
Factors) learn more about this feature.

Basic Load Case Spreadsheet
Click
to copy loads from one basic load case to another. You may choose certain load types such as distributed
loads and point loads. Once you have created a copy you can use the spreadsheet tools to quickly modify the loads.
Click

to clear loads from a basic load case.

Load Combinations Spreadsheet
Solution options are easily available while working in the Load Combinations spreadsheet.

You may click LC Generator button to have the program generate load combinations based on a variety of Building
Codes. See Generating Building Code Combinations for more information.

Selecting Items in the Model View
In certain results spreadsheets there is the capability to have elements selected graphically.
The process is as follows:
1. Open the desired results spreadsheet.
2. Highlight the lines from your spreadsheet that you wish to view graphically, by clicking on the number of
those lines on the far left.
3. Click the Select Graphical Highlight icon in the Spreadsheet ribbon.

4. Only those elements highlighted will be selected graphically.
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Note: The inverse process can be used with the Unselect Graphical Highlight.
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Stability
Instabilities occur whenever a node can deflect or rotate without limit. Put another way; a node is unstable if
there is nothing to restrain it.
With that one statement you can understand and resolve any instability problem. Instabilities are easy to
understand and easy to fix. The next section explains what RISA-3D does with instabilities. The following sections
provide some simple examples of instabilities and their resolution.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Instabilities.

Instability Procedure
Because many instabilities are inconsequential to the results yet they prevent a solution RISA-3D locks them as they
are discovered and proceeds with the solution. This locking is a boundary condition that removes the degree of
freedom from the solution. A reaction (if any) is not calculated and that is one of the dangers of ignoring
instabilities. See Testing Instabilities to learn how to test if an instability is affecting the results.
At the end of the solution you will be notified that nodes have been locked and that you may view the affected
nodes in a model view. These locks will also be reported in the Reactions spreadsheet.

Note
l

Isolated rotational instabilities do not produce a notification that nodes have been locked. You may
adjust this in the Output section of the Application Settings from the File menu if you wish to be
warned about all instabilities.

Instability Causes
Common causes of instabilities are briefly mentioned here and then highlighted in the examples below.

Member End Releases – Boundary Conditions
Overuse of member end releases and/or boundary conditions is by far the most common cause of instability as
shown in the examples below. The solution is to either remove a member end release or change a boundary
condition so that the node is restrained. At least one member or boundary needs to be fixed to each node to
prevent instability. If you think of a node as the end of a member and specify no release for that member end this
member still will not experience moment at the end if all other elements are left unfixed.
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Unconnected Elements
Nodes that are not connected into the model cause instabilities. This is much more common in models without
Physical Members as can be seen below. The solution may be to merge the model with the model merge feature.

Flexible Elements
Members or plates with relatively small properties such as a long member with a moment of inertia of 1.0 in4 can
cause instabilities. This is usually not a problem unless the members are not used properly.

Instability Examples
These simple examples are provided to directly address the common scenarios that occur in structural modeling.
You will notice a recurring theme so once you understand one or two of them you will have a handle on the causes
and resolutions for most instabilities, including those in more complex models.
Remember the golden rule as you look at each example: A node is unstable if there is nothing to restrain it.

Cantilever Beam/Column
If a member end release is specified at the free end of a cantilever the node becomes unstable because it is free to
rotate without any resistance.
Cause: Specifying a member release at the free end of a cantilever member.

Resolution: Remove the member end release.
If the member is not released from the node then the member provides resistance to the node so that it cannot
rotate without limit. The member end moves and rotates and the node goes along for the ride. There will be no
moment at the free end of the member since there is nothing there to pass moment.

Column at a Support
If a pinned column base is modeled with a pinned boundary condition AND a member end release at the base of the
column the node becomes unstable because it is free to rotate without any resistance.
Cause: Specifying a pinned boundary condition AND a member release.
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Resolution: Either remove the member end release or specify a fixed boundary condition. Do not do both unless
you want a fixed column base that resists moment.
If the member is not released from the node then the member provides resistance to the node so that it cannot
rotate without limit. The member end rotates and the node goes along for the ride. There will be no moment at the
base of the member since the pinned boundary cannot resist moment.
If instead the boundary is specified as fixed then the boundary provides resistance to the node so that it cannot
rotate. The member end release allows it to rotate while the node does not. There will be no moment at the base
of the member since the fixed boundary cannot pass moment through the member end release.

Simply Supported Beam
If a pinned beam end is modeled with a pinned boundary condition AND a member end release the node becomes
unstable because it is free to rotate without any resistance.
Cause: Specifying a pinned boundary condition AND a member release.

Resolution: Either remove the member end release or specify a fixed boundary condition. Do not do both unless
you want a fixed member end that resists moment.
If the member is not released from the node then the member provides resistance to the node so that it cannot
rotate without limit. The member end rotates and the node goes along for the ride. There will be no moment at the
end of the member since the pinned boundary cannot resist moment.
If instead the boundary is specified as fixed then the boundary provides resistance to the node so that it cannot
rotate. The member end release allows it to rotate while the node does not. There will be no moment at the end of
the member since the fixed boundary cannot pass moment through the member end release.
Beam-Column Connection
If a pinned beam/column connection is modeled with a released column end AND a released beam end the node
becomes unstable because it is free to rotate without any resistance.
Cause: Specifying a released column end AND a released beam end.

Resolution: Either remove the column end release or the beam end release. Do not do both unless you want a
fixed connection that resists moment.
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If the column is not released from the node then the column provides resistance to the node so that it cannot rotate
without limit. There will be no moment at the connection since the beam end release cannot pass moment.

Simple Truss
If a truss panel point is modeled with releases at the ends of EVERY member connecting to that point the node
becomes unstable because it is free to rotate without any resistance.
Cause: Specifying all members with released ends.

Resolution: Either remove one end release or add a rotational boundary condition at each node. Do not do both.
If one member end is not released from each node then the member provides resistance to the node so that it
cannot rotate without limit. There will be no moment at the member end since the remaining members have end
releases and cannot pass moment.
You may also solve the problem with a rotational boundary condition at each node. Using the ALL code you can
restrain each node for rotation and proceed to use end releases at all members.

2D Models
If you are solving a 2D model defined in the XY plane and you're only interested in the planar action, you could
enter "ALL" and put an "F" (for Fixed) for Z translation, X Rotation and Y Rotation. See the following figure:

Note
l
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If a node is explicitly listed with boundary conditions, those boundary conditions override the "ALL" conditions for all 6 directions. The "ALL" specified boundary codes apply only to those nodes NOT otherwise listed on the Boundary spreadsheet. This is why nodes 1 and 2 in the figure above also have the
Fixed code in the Z translation, 2x Rotation and 2y Rotation fields.
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Unconnected Elements
If a node, member or plate is not connected to the model then there will be instability. With the use of Physical
Members this is rare in a model that only consists of beam elements however those that have plates or finite
members can be defined in a way that they are not connected.
Cause: Unconnected elements. The portal frame is not connected to the plate elements because the bottoms of the
columns do not fall on plate corners. The plates are stable however the portal frame is not.

Resolution: For beam models, run the Model Merge feature. For plate models redefine the mesh so that plates are
connected at their corners. Model merge will not solve problems caused by lack of plate continuity.

3D Models
For three-dimensional models, torsional instabilities are not uncommon. A "torsional" instability is where a
member, or a series of members, is free to spin about its centerline (local x) axis. This diagram illustrates such a
situation:

The member M3 as a whole is unstable because there is nothing to restrain it from spinning in torsion. At nodes
N1 and N2 the columns and beams framing into the member (members M1, M2, M8, M9) are pinned. The same can
be said of Members M7 and M10 framing into the member ends. Therefore, there is nothing in the model that will
restrict the torsional rotation of the M1 beam.
Another example of a potential local instability is X-bracing with a center node and loaded with self-weight. Xbracing has almost no out-of-plane stiffness, so even a little bit of out-of-plane load applied at the center node could
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cause an instability. (The out-of-plane load could come from a P-Delta analysis, lateral load, etc.) A diaphragm with
very weak out-of-plane properties modeled with plate elements can also be a source of potential local instability.

Testing Instabilities
Although some can be ignored, keep in mind that not all instabilities are necessarily inconsequential. Look at the
following model:

This is an example of a single bent frame that is laterally unstable. To obtain a solution the lateral direction would
be locked and a solution obtained, though not a correct one. The warning message may be annoying if you know
the instabilities being locked are of no consequence, but there won't be any surprises.
The best way to test whether an instability is inconsequential or not is to apply a Reaction to the node in the
unstable degree of freedom. Then re-run the model and examine the reactions. If the Reaction that is restraining
the instability is showing a non-zero force or moment, then you have a problem with the model that must be
corrected for you to get valid results. If the Reaction that is restraining the instability is showing a ZERO force or
moment, then the instability is inconsequential to the results.
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Unbraced Lengths
The member capacity for axial compression and for flexure is dependent on the spacing of elements which provide
bracing along the length of a member. By default the program assumes that no bracing is provided along the length
of the Physical Member. This is represented by the condition where the unbraced length field is shown as
empty/blank.
Note
l

If bracing is not provided at each end of the physical member then the assumption that the unbraced length
equals the physical member length can be unconservative. The program allows you to specify an unbraced
length greater than the physical member length to address this situation.

You may specify unbraced lengths as a fixed distance or by using RISA's Unbraced Length Commands. The unbraced
lengths are:
o
o
o
o
o

Lbyy
Lbzz
Lcomp-top
Lcomp-bot
L-torque

The unbraced lengths that are used for member capacity calculations are listed in the Member Detail report after
solution.
Note:
l

Specifying bracing via unbraced lengths does not provide physical bracing to the model for analysis. It only
affects the member capacity calculated for code checks. See the example below.
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Lb Values (Lb, Lu, Le)
The Lb values: Lbyy and Lbzz, represent the distance between points which brace the member against Flexural
(column-type) Buckling about the member's local y and z axes, respectively. Lb bracing prevents the entire member
from moving laterally (perpendicular to its own axis). These Lb values are used to calculate slenderness ratios
(KL/r) for both directions, which are used in the calculation of member axial compression capacity.
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Lcomp Values (Lcomp, Le-bend)
The Lcomp values, Lcomp-top and Lcomp-bot, represent the distance between points which brace the top or
bottom flange of the member against Lateral-Torsional (beam-type) Buckling. These Lcomp values are used to
calculate the member's flexural (bending) capacity. Where the top flange of the member is in compression due to
bending, Lcomp-top is used. Where the bottom flange of the member is in compression due to bending, Lcomp-bot
is used. Lcomp bracing prevents the member's flange from moving laterally (perpendicular to the member's axis).
Members which experience a moment reversal along their length (such as fixed-end or continuous members) have
compression in both the top and bottom flange (although not simultaneously). The program uses the appropriate
Lcomp (top or bottom) based on moment direction to calculate the bending capacity at each internal section along
the member.
The top flange is the flange on the positive local y-axis side of the member. Therefore if a beam if rotated 180
degrees about its own axis (flipped upside down) the "top" flange will actually be facing downwards.

Note:
l

Concrete members are not checked for lateral-torsional buckling, so Lcomp is not used for concrete.
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L-torque
The L-torque value represents the distance between points which restrain the member against twisting about its
own axis. This value is used to calculate the member's Torsional Buckling and Flexural-Torsional Buckling capacity.
These limit states affect the member's axial compression capacity.

Note:
l

l

l

The L-torque value is NOT used for calculations of stiffness or stress for members subjected to warping. This
is done using an internal "warping length" set by the program.
Not all design codes check for Torsional Buckling or Flexural-Torsional Buckling. For those that do, these
limit states will only be checked if L-torque > Lbzzand Lbyy.
Currently the AISC 360 code, CSA S16-14 code, Aluminum codes, and the 2010 and newer Cold Formed Steel
codes support this unbraced length.

Automated Unbraced Length Commands
Aside from leaving the unbraced length blank or inputting a fixed distance, you can harness the program's ability to
use a limited intelligence for determining unbraced lengths. In order to do this you can simply type in the name of
the Unbraced Length Commands into the unbraced length field. If a valid command word is used then the program
will accept and display that command in lieu of a distance value.

Some member types are pre-populated with an Unbraced Length Command when they are created. Below is a list of
the commands which may be used:

Segment
When this command is used, all Nodes which fall along the length of the physical member are assumed to provide
bracing. If Nodes are not evenly spaced along the member then an unbraced length is calculated for each "segment".
A segment is defined as the distance between adjacent Nodes. In the example below, the member is defined as one
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physical member spanning from N1 to N2. The intermediate node N3 is considered as a brace point when Segment
is specified for this member. Therefore the forces which occur in Segment 1 will be compared against a capacity
calculated using Lb1, and the forces occuring in Segment 2 will be compared against a capacity calculated using Lb2.

When using the Segment command the program will assume that each node along the length of the member can act
as a brace location regardless of whether any bracing or restraint exists. In the example above this will result in an
unconservative member capacity if no bracing will be supplied at N3 in real life.

Lbyy
This command is only available for Lcomp-top and Lcomp-bot. When this command is used, the value entered for
Lbyy will also be used for Lcomp.

In the example below, Case C, the Lbyy command could be appropriately be used in the Lcomp-top field. In the
example below, Case D, the Lbyy command could be appropriately used in both Lcomp fields. It would not be
appropriate to use the Lbyy command for Case A or Case B below.
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Floor
For RISA-3D models which are linked to RISAFloor models, if an unbraced length is set in RISAFloor, it is listed as
Floor in RISA-3D spreadsheets. This indicates that the unbraced length was set in RISAFloor for all locations along
the length of the member, and those same values are being used in the RISA-3D model.
In the example below, the fixed-end beam M2 is using the Framing command for Lcomp-bot in RISAFloor.

When this beam is brought into RISA-3D, the RISA-3D member properties show that Lcomp-bot is referencing
RISAFloor (Floor).

666

RISA-3D V20

Unbraced Lengths
After the model is solved you can confirm in the Member Detail Report that the RISAFloor unbraced length is being
used. The maximum code check occurs at 0 feet from the i-end of the member. Because this is a fixed-fixed beam,
the bottom flange is in compression there so Lcomp-bot is used instead of Lcomp-top.

Material Specific Behavior
Hot Rolled Steel
l

l

l

For AISC ASD 9th Edition calculation of Kl/r for WTs and Double Angles, there is an effective Kl/r ratio that
may be used when Flexural-Torsional buckling controls. This can be found in the commentary Section E3.
Specifying LcompTop and LcompBot both as zero constrains a single angle to bend/buckle about its geometric axes. Otherwise it will behave about its principal axes. Alternatively, specifying L-torque as zero also
constrains single angles to bend/buckle about their geometric axes. See Member Results for more information on Single Angle behavior.
For single angles behaving about their principal axes, Lbyy specifies bracing against buckling about the
minor principal axis. Lbzz specifies bracing against buckling about the major principal axis. See Member Results for more information on Single Angle behavior.

Cold Formed Steel
In general, the unbraced lengths for Cold Formed bending checks are based on the Lcomp value and axial checks
are based on Lb values. Below describes more specifics based on the AISI 2012 code.
Lateral Torsional Buckling (AISI C3.1.2)
Lt = Lcomp
Lcomp is the unbraced length for the flange that’s in bending compression at that section (either Lcomp_top or
Lcomp_bot).
This applies to all shapes and all AISI codes.
Note: Older Versions of RISA-3D (v12 and older)
Lt= smaller of Lbyy and Lcomp
When Lateral Torsional Buckling governs over local buckling, the display of the Seff in the Detail Report will report
the Sc which is the elastic section modulus of effective section calculate relative to the extreme compression fiber at
Fc.
Distortional Buckling (AISI C3.1.4)
Lm=Lcomp
Lcomp is the unbraced length for the flange that’s in bending compression at that section (either Lcomp_top or
Lcomp_bot).
Axial Strength (AISI C4.1)
L= Could be Lbyy or Lbzz, whichever gives the larger of (KL/r)yy or (KL/r)zz
Flexural Torsional Buckling or Torsional Buckling (AISI C4.1.2)
Lt= L-Torque
Note: Older Versions of RISA-3D (v12 and older)
Lt= smaller of Lbyy and Lcomp
Distortional Buckling (AISI C4.2)
Lm= L-Torque
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l

The Torsional Warping constant for Back-to-Back Channels and Tracks, Cw is calculated per the AISI
prescribed doubly symmetric shapes (AISI-08 Manual 3.3.3) that are continuously welded (all the unbraced
lengths are 0). If the Back-to-Back shape is not continuously welded (any of the unbraced lengths larger than
zero), Cw is twice the value of each individual section.

l

For Hat Channel (HU) shape types, the Lcomp-top and Lcomp-bot values only apply to the flanges perpendicular to the local y axis (see image below). Therefore, if your loading is applied in the local z direction,
these entries will not apply. This assumption was made in reference to section C3.1.2.1 of the AISI Specification with Commentary whose footnote tells us that the limit state of Lateral-Torsional Buckling does not
apply to these shapes.

Concrete
l

l

The unbraced lengths for Flexural Buckling (Lbyy, Lbzz) are called Lu-yy and Lu-zz for concrete. Their behavior is the same as the behavior for Lbyy and Lbzz.
The unbraced lengths are used for the Moment Magnification procedure in older versions of the ACI code.

Wood
l
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The unbraced lengths for Flexural Buckling (Lbzz, Lbyy) are called Le1 and Le2 for wood. Their behavior is
the same as the behavior for Lbyy and Lbzz.
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l

l

The unbraced lengths for Lateral-Torsional buckling (Lcomp-top, Lcomp-bot) are called Le-bend Top and Lebend Bot for wood. Their behavior is the same as the behavior for Lcomp-top and Lcomp-bot.
See AF&PA NDS-2012, Table 3.3.3 for information on how to determine Le-bend based on the unbraced
length. This procedure is not followed automatically in RISA.

Aluminum
l

l

Specifying LcompTop and LcompBot both as zero constrains a single angle to bend/buckle about its geometric axes. Otherwise it will behave about its principal axes. Alternatively, specifying L-torque as zero also
constrains single angles to bend/buckle about their geometric axes. See Member Results for more information on Single Angle behavior.
For single angles behaving about their principal axes, Lbyy specifies bracing against buckling about the
minor principal axis. Lbzz specifies bracing against buckling about the major principal axis. See Member Results for more information on Single Angle behavior.

For additional advice on this topic, please see the RISA Tips & Tricks website: www.risa.com/post/support. Type in
Search keywords: Unbraced Lengths.

K Factors (Effective Length Factors)
Effective Length Factors (K) are recommended or required for some design codes. The effective length factor allows
you to adjust the unbraced length for Flexural Buckling as a simplified method of accounting for buckling effects.
Kyy is a modifier factor for Lbyy. Kzz is a modifier factor for Lbzz.
If the K Factor field is left blank/empty then it is taken as 1.0, thereby not affecting the unbraced length.
If a value is entered for a K Factor, that value will be used for the entire length of the physical member. If an entry
is not made (left blank), the value will internally default to '1' for that member.

Note
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l

K-torque for Torsional or Flexural-Torsional Buckling is always be assumed to be 1.0, except for Aluminum
design where it is taken as the lesser of Kyy or Kzz.

K Approximation Feature
RISA-3D is able to approximate the recommended K values for a member based on the member's sway condition
and end release configuration. The K-factor approximation is based on AISC 360-10, Table C-A-7.1. To access this
feature you must be in the Members spreadsheet, on the tab which shows the unbraced lengths. Click theK-Factor
icon on the Spreadsheets menu.

The following table gives the values the program calculates for various conditions.

Table
Case

End Conditions

Sidesway?

KValue

(a)

Fixed-Fixed

No

.65

(b)

Fixed-Pinned

No

.80

(c)

Fixed-Fixed

Yes

1.2

(d)

Pinned-Pinned

No

1.0

(e)

Fixed-Free

Yes

2.1

(f)

Pinned-Fixed

Yes

2.0

RISA-3D recognizes a pinned boundary condition for the K approximation for a full pin, i.e. if all the rotations in the
boundary condition are released. If any of the rotations in a boundary condition are restrained, the boundary
condition is considered "fixed" for the K factor approximation.
Any configuration not described here is given the default value of '1.0'.
If any value that influences these K values is changed, the K factor approximation should be redone. For instance, if
you have RISA-3D approximate K factors, then change some of the member end release designations, you should
redo the K factor approximations.
Remember that the K factors are approximations and you should check to make sure you agree with all K factors
RISA-3D assigns. You can always override a K factor after an approximation by directly entering the value that you
want in the appropriate field. Keep in mind that a subsequent approximation will overwrite any manually input
values so you will need to override the approximation each time it is performed.
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Limitation:
RISA-3D will currently neglect the influence of adjoining framing members when those members are connected at a
joint that also has degrees of freedom restrained by boundary conditions. For example, suppose a column and beam
member connect at a joint that is restrained for translation in all directions (i.e. the joint is "pinned"). The K factor
approximation will neglect the beam member when it calculates the K factor for the column and visa-versa. The
effect will be that the ends of the members at that joint will be seen as "pinned" and not "fixed" for the K factor
approximation.

Sway Flags
The Sway Flags indicate whether the member is to be considered subject to sidesway for bending about its local y
and z axes. The y sway field is for y-y axis bending and the z sway field is for z-z axis bending. Click on the field to
check the box and indicate that the member is subject to sway for that particular direction, or leave the entry blank
if the member is braced against sway. These sway flags influence the calculation of the K factors as well as the Cm
and Cb factors.
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Units
You can work with imperial (kips, inches, etc.) or metric (KN, meters, etc.) units, or any combination of the two. The
current units appropriate for each data item are shown at the tops of the data columns in the spreadsheets and
with the plot of values in the model view.
You may save any of the units as the default setting so that when you start a new model that information is already
there. To do this, simply enter the information that you want to save and check the Save as Defaults box and click
OK.

To Change Units
1. Click the Units button in the Model section of the Home tab.
2. Specify the units you want for each item in the drop down lists.
Standard units systems are preset and may be specified by clicking the Standard Imperial and Standard
Metric buttons.
3. If you do not wish to convert values already entered then clear the check box for Converting Existing Data.
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Standard Imperial Units
This is the units system currently prevalent in the United States. 'Feet' are used for location entries such as node
coordinates and load locations, and 'Inches' are used for section property entries such as area and moment of
inertia. Force and weight units are in 'kips', where 1 kip = 1000 pounds. Stress units are in 'ksi' (kips per square
inch).

Standard Metric Units
This units system uses 'Meters' for location entries and 'Centimeters' for section property entries. Force units are in
'kN' (kiloNewtons), where 1 KN = 1000 Newtons. Stress units are in 'MegaPascals' (MPa), where a MegaPascal is
1,000,000 Newtons per square meter. Weight units are in 'Kilograms' and thermal units are in 'Degrees centigrade.

Units Specifications
The following are the unit specifications and their applications:

Measurement

Usage

Lengths

Coordinates, Unbraced Lengths, Load Locations

Dimensions

Shape Properties, Plate Thickness, Member Offsets

Material Stiffness

E, G

Weight Densities

Material Density

Forces

Loads, Forces

Linear Forces

Distributed Loads

Moments

Loads, Forces

Surface / Area Loads

Plate/Shell Surface Loads, Area Loads
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Measurement

Usage

Translational Springs

X Y Z Boundary Conditions

Rotational Springs

X Rot, Y Rot, Z Rot Boundary Conditions

Temperatures

Thermal Coefficient, Temperatures

Deflections

Deflections, Displacements

Stresses

Fy, Allowable and Actual Stresses
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Wall Panels
The wall panel element allows you to easily model walls for in plane and out of plane loads. Wall panel data may be
viewed and edited in two ways: graphically in the Wall Panel Editor or in the Wall Panels Spreadsheet.

Drawing Wall Panels

There are several graphic-editing features that make the creation and modification of models quite easy. Use Wall
Panels button to use these features in the model view. To create new wall panels, you can draw them using a
drawing grid or draw "dot to dot" existing nodes. Once you have created these items you may use other graphic
features to apply loads and set boundary conditions.
You can set many of the wall panel properties up front or you can modify these properties after you draw them.
Modifying properties is discussed in the next sections. See the Wall Panels topic for information on wall panels and
their properties.
The Wall Panels button lets you graphically draw wall panels in your model. Enter the appropriate wall panel
parameters, and draw wall panels between existing nodes or on the drawing grid. You will also notice that the
coordinates of the node or grid point that is closest to your cursor are displayed next to your cursor. The new wall
panels will be shown on screen and will be recorded in the Wall Panels Spreadsheet.
To actually draw a wall panel, you have two options. One way is to modify your Drawing Grid according to how you
wish to lay out your wall panels and use the Create Wall Panels by Clicking on Grid Areas option. Wall panels
can then be created by clicking in the grid areas formed by the intersecting grid lines. As you click on an area, a wall
panel will automatically be created in that area. The second option is to create wall panels by drawing the diagonal
that defines it. First click on the grid point or node that you want to be the start node for the diagonal, then the end
node for the diagonal. The wall panel will "stretch" like a rubber band as you draw from node to node.
Note:
l
l

You must draw wall panels rectangular.
Wall panels must be oriented vertically in your model.
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The parameters shown are the same parameters that you would enter on the Wall Panels Spreadsheet.

To Draw Wall Panels
1. If there is not a model view already open then click the View tab on the Ribbon Toolbar and press the
Open 3D Views button to open a new view.
2. If you are not drawing between existing nodes, you will need to create a drawing grid or define nodes on the
Node Coordinates spreadsheet.
3. Click the Wall Panels button. Then set the wall panel properties.
4. Click Apply to start drawing wall panels by clicking on the nodes or grid points with the left mouse button.
1. You must click two points.
2. Or, click in grid areas.
5. To stop drawing altogether right click or press the Esc key.

Note
l
l
l
l
l

To draw more wall panels with different properties, press CTRL-D to recall the Wall Panel action.
You may also specify or edit wall panels in the Wall Panels Spreadsheet.
You may also view and edit wall panel properties by clicking on a wall panel.
You may undo any mistakes by clicking the Undo button.
Drawing top to bottom or bottom to top determines the panel's local axes directions. See Wall Panel Local
Axis for more information.

Modifying Wall Panels
There are two ways to modify wall panels. You may view and edit the member data in the Wall Panel Spreadsheet
or you may click a wall panel to view and edit its properties. You can also double click a wall panel to open the
Wall Panel Editor.
A group of selected wall panels can be modified all at once by selecting multiple plates then changing their
properties in the Properties Panel. See the Graphic Selection topic for more on selecting.
The parameters shown are the same as those used to define new wall panels.

To Modify Wall Panels
1. If there is not a model view already open then click the View tab on the Ribbon Toolbar and click the Open
3D View button to open a new view.
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3. You may choose to modify a single wall panel at a time or to an entire selection of wall panels.
1. To modify a single wall panel, click on the wall panel and change the properties in the Properties
Panel.
2. To modify a selection of wall panels, select the walls collectively by clicking and dragging over them,
then change the properties in the Properties Panel.

Note
l
l
l
l

l

To modify more wall panels with different parameters, press CTRL-D to recall the Wall Panels action.
You may also modify wall panels in the Wall Panels Spreadsheet.
You may undo any mistakes by clicking the Undo button.
The thickness option is only available if you are choosing a General or Concrete material. Wood and Masonry
require you to change their thickness in the Design Rules spreadsheet.
For existing models of version 9.1.1 or earlier, all wall panels will be brought in using Custom regions/openings. Here we provide an option that will reset all wall panels to base their design on the Wall Design
Rule.

Wall Panel Spreadsheets
Another way of editing wall panels is through the Wall Panel Spreadsheet. This spreadsheet is accessible through
the Data Entry Toolbar and includes data on two tabs: Primary and Advanced.

The following data columns hold the primary data for the wall panels:

Wall Panel Labels
You may assign a unique label to any or all of the wall panels. You can then refer to the wall panel by its label.
Each label has to be unique, so if you try to enter the same label more than once you will get an error message. You
may relabel wall panels at any time with the Relabel Wall Panels option on the Tools menu.
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Wall Panel Nodes
The A, B, C, and D node entries are used to define the 4 corner nodes of a wall panel. The nodes must all lie on the
same plane, be oriented parallel to the vertical axis and be entered in either a clockwise or counter-clockwise
sequence. They can not be adjusted from the spreadsheet.

Wall Panel Material Type and Material Set
The material set label links the wall panel with the desired material defined on the Material Spreadsheet.
Note
l

Currently wall panels can only be made up of concrete, masonry, wood, or general materials.

Wall Panel Thickness
The thickness field on the Wall Panels Spreadsheet is the thickness of the element. This thickness is constant over
the entire element. Note that the thickness for Masonry and Wood wall panels are set in the Design Rules
spreadsheet. For concrete and general material walls the value is defined here.

Design Rule
This allows you to choose a specific design rule from the Design Rules spreadsheet. The design rule is where you
can specify very detailed information for the wall.

Panel/Spacing
This shows the current panel for masonry and wood walls. Wood and masonry walls can require an iterative
solution. This means that the panel properties used for a wall panel may change from solution to solution, so here is
the place where that information is displayed. Note that the panel properties also show up in the output.
When you select a design rule for a wall panel, there may be a range of sheathing call-outs, stud spacings and
bar/grout spacings. At the initial solution the program simply uses the first item in the list that meets the criteria of
the design rule and then the optimization starts from there. This initial criteria is what will show up in the
Panel/Spacing column. After you optimize your wall this panel criteria may update/change. If you want to reset all
of these values to the original values, simply right click when in the Wall Panels spreadsheet and select Reset Wall
Panels Design.
Note:
l
l
l

For masonry walls we show the current bar/grout spacing.
For wood walls we show the current sheathing call-out and the current stud spacing.
For concrete walls this column is not applicable, as the stiffness of the wall is not affected by the program
optimiziation.

Reset Wall Panels Design
The Wall Panels spreadsheet will list the panel parameters designed by the program after solution. From the
Primary tab, you can reset the wall panels design by selecting the Reset Wall Panels Design from the right-click
menu. This will reset the panel design to the parameters based on the Wall Design Rule.
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Seismic Rule
This field defines a Seismic Design Rule and is applicable to concrete walls only. Please see the Concrete Wall Seismic topic for more information.

Design Method
This is a column specific to wood wall panels and allows you to choose which design method you choose to work
with: Segmented, Perforated or Force Transfer. See the Wood Wall Panels topic for more information. These design
methods are not applicable for concrete, masonry, or general wall panels.
Note:
l

Currently, wood wall panel design is only available for NDS design.

SSAF (Shear Stiffness Adjustment Factor)
This is a factor specific to wood wall panels that allows the user to manually adjust the shear stiffness of a
particular wall panel. Because the program uses a finite element solution, the program does not automatically
consider some contributions to the FEM deflections, such as nail slip. With this adjustment factor the user can
match up the deflections from their hand calculations with the FEM node deflections at the top nodes in the wall.

Icr (In Plane and Out of Plane)
These values are considered for both masonry and concrete wall design and allow you to modify the stiffness of the
wall for cracking considerations. This value will be multiplied by the Igross of the wall.

Masonry Walls
By default (if left blank) the program will use a value of 0.50 for both In-plane and Out-plane Icr Factor. This value
comes from Section 3.1.5.2 of the ACI 530-11 code. If you have performed a cracked section analysis or want to
override this default you can input it directly here.

Concrete Walls
By default (if left blank) the program will use a value of 0.70 for In-plane Icr Factor and 0.35 for Out-plane Icr
Factor. These are the minimum factors for beams (Out-plane) and columns (In-plane) per ACI 318-14 Section
6.6.3.1.1 (ACI 318-11 Section 10.10.4.1). If you have performed a cracked section analysis or want to override this
default you can input it directly here.
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For service level analysis, the level of cracking will be significantly less. Therefore, the stiffness used in your
analysis should be representative of the reduced loading and reduced cracking. Per the ACI 318-14 Section
R6.6.3.2.2 (ACI 318-11 Section R10.10.4.1), the program will account for this increased stiffness by applying a factor
of 1.43 to the cracked section properties for any load combination that has the “Service Load” flag checked on the
Design tab of the Load Combinations Spreadsheet
Note:
l

l

This factor will only be used if the Use Cracked Sections checkbox is checked in the Concrete tab of Model
Settings.
This factor (or 1.43*Icr) can not be greater than 1.0.

K Factor
This is the effective length factor and is available concrete, masonry and wood walls. If left blank this will be taken
as 1.0.

Note:
l

l

For masonry this factor affects ACI 530-11 equations 2-16, 2-17, 2-19, 2-21, 2-22, 3-11, 3-12, 3-18, 3-19, and
Section 3.3.5.3.
For wood this affects the Cp factor calculation (specifically FcE) for wood compression capacity for both studs
and chord design.

Cm In/Out
This input controls the Cm calculation for P-Little Delta calculations for concrete wall panels. If this is left blank the
program will auto-calculate this value. See the P-LIttle Delta section of the Concrete Wall - Design topic for more
information.

Activation
This column allows you define a wall panel as inactive or excluded. Please see the Inactive and Excluded Elements
for more information.

Wall Panel Editor
The Wall Panel Editor allows the user to edit the detailed properties of a wall panel including openings, regions
and boundary conditions. This dialog also gives design options and details for the specific panel and is accessible by
double-clicking on an existing wall panel.
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If the wall panel is drawn upper right to lower left it will be drawn with the panel's local x-axis going from left to
right. If drawn lower right to upper left the panel's x-axis will go from right to left and is presented here as though
you are looking at the back side of the panel.

Note:
l

There are many icons, dropdown lists and information shown depending on the type of wall panel you are
working with. See the Masonry Wall - Modeling, Wood Wall - Design and Concrete Wall - Design topics for
more information.

Creating Openings
Within the Wall Panel Editor, you have the option of adding rectangular openings to the wall panel. To draw an
opening, select the Openings button and then select two grid intersections which make up the two diagonal corners
of your opening. Notice that you can view your cursor coordinates next to your cursor. The opening dimension is
also displayed based on the first click of the opening relative to the second click.
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To exit this tool right-click your mouse.
Note:
l

l

l

l

l

l

Drawing an opening in a concrete wall will create a lintel above the opening. We will not design the lintel but
we will give analysis results. See the Concrete Wall - Design topic on lintels.
Drawing an opening in a masonry wall will create a lintel above the opening. For more information on defining lintel geometry and design properties, see the Masonry Wall - Design topic on lintels.
Drawing an opening in wood wall will create a header above the opening. For more information on defining
the header properties, see the Wood Wall - Design topic on headers.
Drawing an opening in a general wall panel, there is no header/lintel automatically created. The general wall
panel is given as an option for analysis only.
Openings can not overlap a region. Regions must be deleted before you draw an opening in an area. After the
opening is created you can go back and redraw the regions.
Openings must be drawn greater than 3 inches away from wall edges.

Creating Regions

Within the Wall Panel Editor, you also have the option of creating different rectangular regions within your wall
panel. Regions are used to further define areas of your wall panel for use in analysis/design. If you do not specify a
region in a wall panel without openings, then the entire wall panel will be considered a region.

To automatically draw regions you must first have your openings input. Once you have that you can click the
Generate Wall Regions Automatically button and the program will define regions as we would expect a user to
want them.
Note:
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l

If the regions defined are not located correctly by the generator, you can delete the generated regions with
the Delete button and redraw them manually. See below for more information on this.

To manually draw a region, select the Create New Regions button and use your cursor to select two grid
intersections which make up the diagonal corners of the region. Similar to wall openings, local coordinates and
region dimensions will be displayed next to the cursor in the Wall Panel Editor. To exit this tool right-click your
mouse.
Note:
l

l
l

l

For masonry wall panels, there is a region editor that allows you to define design properties for the region.
Double-click inside the boundary of the drawn region to open this editor. See the Masonry Wall - Design
topic for region information. Note that design and analysis results are displayed by region.
For wood wall panels the design and analysis results are displayed by region.
For concrete wall design, the program will automatically create regions at solution around openings. If there
are floors/diaphragms that cut through your wall, then separate regions/designs will be created above and
below the floors/diaphragms.
For general wall panels we will not do any design for you. However, you can lay out your regions so that
your analysis results will allow you to design your general wall panels much more easily.

Boundary Conditions

Within the Wall Panel Editor, all boundary conditions are applied as continuous along a wall panel edge. To set
boundary conditions within the wall panel editor, select the Boundary Conditions button, select your boundary
condition criteria, and click the wall panel edge to apply the boundary condition too. To exit out of this tool rightclick your mouse. You can also apply boundary conditions to your wall panel outside of the Wall Panel Editor as
well, but this is the only place where you can define a continuous boundary condition.
For wood wall panels, hold downs and straps are used in the program as well. For more information on adding
hold-downs and straps, see the Wood Wall - Design topic.

Wall Grid
The drawing grid, which appears in the upper right corner of the Wall Panel Editor screen, gives the user options
for drawing within the Wall Panel Editor window. The options include:
Snap Options allows you to provide snap points at the edges of the wall panel at quarter and third points.
Grid Increments allow you to set a drawing grid within the Wall Panel Editor separate from that in the main model
view that you can snap to when drawing openings and regions. This field can work in two separate ways:
l

l

A single increment: If you put a single value here (0.5 ft for example), then this increment will be used across
the entire wall until the end of the wall is reached.
Multiple input increments: If you have specific locations you wish to define you can use this field to place
exact grid points. Commas are used to delineate different grids and @ symbols can be used to apply the same
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increment multiple times (5, 10, 2@8, 3 for example). If you place multiple increments in and you are not yet
to the end of the wall then the last increment defined will be used until the end of the wall is reached.

View Controls
In addition to the wall panel editing tools, the Wall Panel Editor window includes the following view controls:

Delete allows you to delete openings, regions or boundary conditions from the wall panel.

Render will turn rendering of the current model view on or off, depending on the current setting.

Nodes will show any nodes that fall in the plane of the wall panel and allow you to snap to them when
drawing regions or openings.

Wall Grid will turn the display of the Drawing Grid on or off, depending on the current setting.

Diaphragm Display will turn the display of the Diaphragms on or off, depending on the current setting.

Detach Wall Panel From Diaphragm will allow you to click on a diaphragm in the editor to detach it
from the wall. The detached diaphragm will then show up in gray.
Loads will turn the display of the wall panel loads on or off, depending on the current setting.

Zoom Extents redraws the wall panel to fit within the Wall Panel Editor window.
Print Current View prints your current wall panel view.
Note:
l

There are also view controls specific to concrete and masonry. For more information see the Concrete Wall Design and Masonry Wall - Design topic.

l

There are also view controls specific to wood. For more information see the Wood Wall - Design topic.
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Wall Panel Local Axes
When a wall panel is drawn it comes along with a set of local axes. If the wall is drawn top left to bottom right
versus bottom left to top right it will change the direction of the local axes.

In most cases the local axes direction does not affect results. Here is a list where the local axis is important:
l

l

l

Applying Loads: Wall panel surface loads can be applied to the local axes directions. Thus, the local axes direction will affect the sign of the applied load.
Viewing Plate Contours: Wall plate contours can be viewed based on local axes, thus knowing the orientation
is necessary to get meaningful information from these contours
Out-of-Plane Concrete Wall Design: Concrete cover can be different for each face of a concrete wall. Which
face you are defining is based on the +z and -z local axes.

Note:
l

Check out the Flip Axis command to allow you to change these local axes.

Loading
Wall panels can be loaded either directly or indirectly from supporting other elements (other walls, columns,
beams, etc.). Line loads and distributed loads can be applied directly to wall panels, similar to how they are applied
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to members. These loads can be applied vertically or horizontally. Wall panel surface loads can also be applied
directly to the wall.

Load Attribution
In RISA-3D, the use of finite elements dictates how loads pass through wall panels. Load is attributed to the
structure according to relative stiffnesses of elements. In concrete, wood and masonry design, many empirical
equations are formed based on approximations or idealizations. Because of this, you may not get your loading in
your wall panel elements (regions and lintels) to match hand calculations exactly. A prime example of this occurs
with the 45 degree rule for lintels for masonry. According to theory, arching action occurs in lintels to the point
that, if the top of your wall is a sufficient distance away, only the load in the triangular portion above your lintel
would actually be taken into the lintel itself. Also, no load applied at the floor level would be felt by the lintel either.
See the image below.
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Within RISA-3D, this idealization will not hold true. The wall panel is a finite element mesh that attributes load
according to the plate mesh FEM behavior. The load that is getting into the lintel is a true representation of how the
wall is actually working. There is still arch action taking place as you can tell if you look at the vertical force
contours in the wall panel.

In the image above, the red color is an area of very low axial force in the wall. Thus, you can see that, due to plate
distribution of force, there is still arching action taking place. This arching action, however, will not be immune to
additional loads added to the wall or the opening being located lower in the wall (as is assumed with the idealized
arching action in many texts). Thus, though your loads for lintel design may not be identical to what idealized
methods might consider, this is a rational loading for the geometry and loading input on the wall panel.

Meshing the Wall Panels
At solution time, the wall panels will be automatically meshed into quadrilateral plate elements. Unlike the plate
elements created directly by the user, the automatically generated plate elements are transient in the program and
will not be saved in the input file.
The wall panel meshing is treated similar to analysis results. When the results of an analysis are deleted, the wall
panel mesh is cleared to be re-built during the next solution. When a solution results file is saved, the meshed
elements will be included in that file.
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Mesh Size
The global mesh size for the wall panels can be input on the Solution tab of the Model Settings. The smaller the
mesh size, the more accurate the analysis will be. However, smaller mesh size will also lead to longer solution time
and more memory usage. The default mesh size is 12 inches RISA-3D.
Localized small mesh sizes are used in the lintel locations for masonry walls, in order to achieve more accuracy for
the lintel forces.

Graphical Display of the Wall Panel Mesh
By default, the plate elements associated with the wall panels are not visible to the user. The mesh can be turned on
using the setting on the Panels tab of the Model Display Options. The Analysis Mesh check box will turn the display
of the wall panel mesh on or off.

Note
l

The display of the mesh is only available when there are active analysis results.

Point Constraints for the Panel Mesh
Point constraints are the locations within the wall panel that require connectivity to the meshed plate elements. The
program will automatically generate point constraints at the following locations:
1. Location of an existing node on the wall panel edges, region boundaries and opening boundaries.

2. Where beams intersects the wall panels (out-of-plane) on the wall panel edges, region boundaries and opening
edges.
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3. Location of an external boundary condition.
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Note:
l

Unattached node that are located on the wall panels can be considered as point constraints and prolong the
meshing time. It is highly recommended that the user delete any unattached nodes before solving.

Line Constraints for the Panel Mesh
Line constraints are the locations within the wall panel that require continuous connectivity to plate edges rather
than a single point. The program will automatically generate line constraints at the following locations:
1. Opening edges.
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2. The edge and vertical centerline of a defined region.

3. Where a diaphragm intersects the wall panel.
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4. At the intersection of multiple wall panels.

5. Where a plate element mesh intersects the wall panel.
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6. Where a beam or column element intersects within the plane of the wall panel.

Tips for Ensuring an Accurate Mesh
In order to generate an efficient mesh that gives accurate results, it is critical to place the line constraints and point
constraints correctly. If line constraints or point constraints are very close to each other, the auto mesher will be
forced to generate small sized elements in order to satisfy the constraints. Therefore, a large number of plate
elements will be generated and the solution will be slowed down significantly.
The following guidelines should be followed to ensure a quality mesh:
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l
l

l
l

Avoid generating very narrow regions and openings.
Avoid small offsets between the external boundary conditions with the location of the region boundaries and
wall boundaries.
Avoid small offsets between opening edges with the region boundaries .
When a wall panel is intersected by another wall panel, diaphragms, beams or plate elements, keep in mind
that the intersection is a line/point constraint. Avoid the small offsets between intersections with the region
boundaries or opening edges inside the wall panel.

Example #1: Region Boundaries
1. The left boundary region R1 is placed very close to the opening but not on the opening.
2. The left boundary of region R2 is placed very closed to the left edge of the wall but not exactly on the wall
boundary.
In order to satisfy the line constraints required by the opening edge, region boundaries, and wall boundaries, the
program is forced to generate very small meshes in the portion of the wall adjacent to these constraints.

Example #2: Poorly Located Boundary Conditions:
The left boundary of region R1 is at the vertical center line of a wall panel. At the same time, the user placed an
external boundary condition at the bottom of the wall panel, which is slightly offset from the center line. In order to
accommodate the line constraint of the region boundary and the point constraint of the external boundary
condition, the automesher is forced to generate a very small mesh adjacent to these constraints.

Merge Tolerance for Auto-Correction of Mesh
If the distance between the line constraints and point constraints are smaller than the merge tolerance specified on
the Model Settings (which defaults to 0.12 inches) then the auto-mesher will automatically snap the constraints
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together during the meshing. This can eliminate some of the meshing issues that occur in the examples above.
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Wall Panels - Results
When the model is solved there are results spreadsheets specifically for Wall Panel Design and for Wall Forces. The
Wall Panel Design spreadsheets are divided into different tabs: In plane, Out of Plane, Lintel, Wood Wall Axial,
Wood Wall In-Plane, Wood Header and Wall Panel Seismic. Each tab gives code checks based on the relevant code
depending on the material type. These spreadsheets can be used as a summary of all of the panels in your model.
To get detailed information about each panel, you can use the Wall Panel Detail Reports.

Concrete Wall Spreadsheet Results
l
l

In Plane Results Spreadsheet
Out of Plane Results Spreadsheet

Concrete Wall Detail Reports
l
l

Wall Summary Detail Report
In Plane/Out of Plane Detail Report

Masonry Wall Spreadsheet Results
l
l
l

In Plane Results Spreadsheet
Out of Plane Results Spreadsheet
Lintel Results Spreadsheet

Masonry Detail Reports
l
l
l
l

In-Plane / Shear Wall Detail Report
Out-of-Plane Detail Report
Slender Wall Detail Report
Lintel Detail Report

Wood Wall Spreadsheet Results
l
l
l

Axial Results
In Plane / Shear Results
Header

Wood Wall Detail Reports
l

In-Plane or Shear Wall Detail Report

Wall Force Results
The Wall Force Results spreadsheet lists the axial force, shear and moments for each wall panel. The elevations
where forces are reported are at the base of walls and at the locations of any diaphragms that intersect the walls.
The elevation is given in terms of global elevation.
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The Wall Label column displays the wall panel label.
The LC column reports the relevant Load Combination.
The Elevation column reports the elevation (in Global Coordinates) at which the forces are reported.
The Axial value reports the axial force in the wall. Compression force is reported as positive, Tension force as
negative.
The x-Shear value is the shear force in the local x direction for the wall. This is the shear wall / strong direction of
the wall.
The z-Shear value is the shear force in the local z direction for the wall. This is the cantilever / weak direction of
the wall.
The x-x Moment value is the moment about the local x axis for the wall. This is the cantilever / weak direction of
the wall.
The z-z Moment value is the moment about the local z axis for the wall. This is the shear wall / strong direction of
the wall.

General Wall Detail Report
The general wall detail report shows the material type, height, length, and envelope forces for general walls.
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Note
l

No detail report is generated for general walls with openings when there is no region defined.

The Wall Panel Design Spreadsheet displays the calculated results for wall elements and may be accessed by
selecting Wall Panel Design from the Results menu on the Explorer Panel. The spreadsheet has nine tabs:
Concrete In, Concrete Out, Masonry InMasonry Out, Masonry Lintel, Wood Wall Axial, Wood Wall In-Plane,
Wood Header and Wall Panel Seismic.
The first two tabs as well as the last tab give results of Concrete Wall analysis. For more information on these tabs
see Concrete Wall Results and Concrete Wall - Seismic Results.
The next three tabs are results of Masonry Wall analysis. For more information on these tabs see Masonry Wall
Results.
The next three tabs are results of Wood Wall analysis. For more information on these tabs see Wood Wall Results.
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CFS Wall - Design
The CFS wall panel element allows you to easily model, analyze and design CFS walls for in-plane loads. Here we
will explain the specific inputs and design considerations. For general wall panel information, see the Wall Panels
topic. For CFS wall results interpretation, see the CFS Wall Results topic.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: CFS Walls.
Full code checking and design can be performed on the panel sheathing, studs, and chords based on the following
codes:
l

The AISI S240-15 CFS Structural Framing & AISI S400-15 w/S1-16 Seismic Design of CFS Structural Systems

CFS Wall Input
The Walls tab gives some specific information and options for modeling/analysis of CFS walls. The Walls tab can be
accessed by double clicking on a wall panel within the 3D view window.

CFS View Controls

Toggle Wall Studs Display allows you to turn the display of the studs on and off.

General Reference Manual

699

CFS Wall - Design

Chords allows you to turn the display of wall panel region chords on and off.
Header allows you to turn the display of headers on and off.
Studs allows you to turn the display of the studs on and off.
Top/Sill Plate allows you to turn the display of the top/sill plates on and off.

Design Rules
You must set up design rules for the stud/chord sizes, as well as make database selection for shear panels. This is
done in the Wall Design Rules spreadsheet in the CFS Wall (Studs) and CFS Wall (Fasteners) tabs. See the CFS
Wall - Design Rules topic for more information.

Creating Openings in CFS Walls with Headers

Within the Walls tab, you have the option of adding rectangular openings to wood wall panels. To draw an opening,
select the Openings button and then select two nodes or grid intersections which make up the two diagonal
corners of your opening. When an opening is drawn, a header beam is automatically created above the opening.
Currently header design is not available for CFS walls

Edit/View the Existing Wall Design Rule - This option allows you to view as well as make edits to the Wall
Design Rule that is currently applied to the wall.
Create a New Wall Design Rule - This option will allow you to create a new Wall Design Rule to be applied to the
wall.

Hold-Downs and Straps
Hold-downs and straps are automatically added to your walls in their required locations. For a Type I - Segmented
design, you must have hold-downs or straps at the bottom corners of each of your design segments. The program
will not permit the drawing of hold-downs or straps at locations where they are not allowed.
If there are custom locations that you want to add hold-downs or straps, you can do this within the Walls tab.
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Hold downs can represent the anchorage of your wall to the foundation or the connection of shear wall chords
between floors. To add hold-downs to the base of your wall, first select theHold Downs icon in the Walls tab.

Hold downs must be added after regions are created and can only be added at the corners of regions. Hold down
requirements depend on the type of wall design you are performing.
Straps represent the connection of the current wall panel to a wall panel below. To add straps to the base of your
wall, first select the Straps icon in the Walls tab.

Straps also can only be added after regions are created and can only be added at the corners of regions. Strap
requirements also follow the same logic as hold downs as to where they must be defined as far as regions are
concerned.
Note:
l

l

l
l

l

Hold-downs and straps are not designed for CFS Walls. However, the required forces will still be reported.
More information on this can be found in the CFS Wall Results topic.
All boundary conditions for wall panels should be defined in the wall panel editor. Adding external boundary
conditions can create problems.
The locations of hold-downs and straps define where the program will calculate tension forces in your walls.
By default, the program will automatically add hold-downs to the base of walls that have boundary conditions applied to them and will apply straps to walls that have walls below.
All Straps and Hold-downs are placed at the base of walls only. So, if you would like to put a strap or holddown between floors, you would apply it to the base of the upper wall.

General Requirements for Shear Walls
The design of CFS shear walls per the available design codes requires that many criteria are satisfied before a wall
can be considered adequate. For RISA to work within this framework, we require that certain modeling practices be
followed. Outlined below are many general wall modeling practices and limitations as well as specific requirements
for the Type I - Segmented method that is available for CFS Walls in the program.
Note:
l

RISA-3D does not currently support Type I with FTAO or Type II walls.

Type I - Segmented Method
The Type I - Segmented methodology is defined in Section B5.2 of the AISI S240-15 North American Standard for
Cold-Formed Steel Structural Framing.
Where there is a wall panel with openings, the area above and below the openings is disregarded and the wall is
designed as being made up of separate, smaller shear walls.
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Like all wall panels, the segmented CFS wall is broken into a series of meshed plate elements to represent the
overall wall. The portions of the segmented shear wall that are considered "ineffective" in resisting shear are
modeled with a plate elements that have a significantly reduced shear stiffness so that they will not receive any
significant moment or shear from the FEM analysis.
See the diagram below for more information:

In addition, the out of plane stiffness and in plane stiffnesses of the segmented CFS wall are modeled separately
based on different assumed plate thicknesses. This is done to insure that the shear stiffness is based entirely on the
properties of the sheathing and is not influenced by the out-of-plane stiffness of the wall studs.

Note:
l

If you have several stacked Segmented wall panels with misaligned openings, you will receive the Warning
Message shown below upon solution. This message means that RISA-3D has assumed that the strap force
from the above wall panel will be spread out across the region directly under it. Therefore, you need to be
aware of this assumption and detail the wall panel accordingly.

l

A shear panel design will be chosen for the worst-case region in a segmented wall. That panel will then be
used for all regions in that wall. The worst-case region is the one that has the highest Shear UC value.

Geometric Requirements and Limitations
The program will check the geometric requirements per AISI S240-15 B5.2.1.1 and AISI S400-E1.4 as required
unless otherwise noted below. The sections noted below are assumed to be satisfied and are not checked.
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Note:
l
l
l

AISI S400-E1.4 parts (d) - (g) and (k) - (r)
AISI S240 B5.2.2.3.2.1.1 parts (c) and (e)
AISI S400 E2.3.1.1.1.1 parts (c) and (e)

General Program Functionality and Limitations
Assigning Code and Design Methodology
CFS wall designs will be based on the AISI S240-15 North American Standard for Cold-Formed Steel Structural
Framing and S400-15 w/S1-16 North American Standard for Seismic Design of Cold-Formed Steel Structural Systems.
You can select these codes in the CFS Walls dropdown within the Codes section of the Model Settings. If you set this
code to “None”, the program will not perform design for the CFS walls.
The design properties of CFS stud and chords within the wall are referenced from the AISI S100 specification
referenced in the Cold Formed Steel dropdown.
In this manner, the design methodology (ASD or LRFD) for the entire wall panel (stud, chord and sheathing design)
is determined by the design method selected in the Cold Formed Steel dropdown. For example, if the AISI S100-16:
ASD code is selected as shown below, the CFS walls will use ASD factors in the stud, chord and sheathing designs.
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RISAFloor and RISA-3D Interaction
When using RISAFloor and RISA-3D in combination, the interface transitions nicely between the two programs.
Here is a quick walk through of this interaction.

Input Interface
1. Model the entire building (gravity and lateral members) within RISAFloor. Be sure to model all openings and
regions for all of the wall panels in the model.

2. Add loading and solve the model.
3. Take the model into RISA-3D via the Director tool.
4. Once in RISA-3D you must add your hold downs and straps to your wall panels.
Note:
l

l
l

l

You can not modify your openings or regions in RISA-3D. All region and opening modifications must be taken
back to RISAFloor to be done.
Hold downs and straps can not be added to wall panels in RISAFloor.
Hold downs are required at the corners of all full height regions in the wall panel for the Segmented design
method.
The Design Rule and Design Method can be changed in either program at any time.

Modeling Tips- Platform Framing
The CFS wall height in RISA is measured from the bottom of the sill plate to the top of the floor framing as shown
below. However, platform framing causes the wall height to be significantly shorter than a RISA model would
represent.
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This is especially problematic for the FTAO design method where the region above openings is assumed to be much
larger than it is built. However, currently only the Type I - Segmented method is available and the portions above
and below the opening are not used to transfer shear forces.

Limitations for Hold-downs / Straps (Including deformation)
l
l

The program does not currently have a database for or optimize hold-downs/straps for CFS walls.
The manufacturer listed or user defined hold-down deformation can be input in the Wall Design Rules
spreadsheet for inclusion in the design deflection calculation. See the CFS Wall - Results topic for more
information.

Automatic Boundary Conditions
l

In RISA-3D, if no boundary conditions or hold downs are defined for CFS wall panels at the lowest level of
the structure, the program will automatically create hold downs at the corners of the wall panel. If you do
not want the hold downs to be automatically created, define a "free" boundary condition at the base of the
wall panel in the wall panel editor.

Deflection
The program will report the design deflection for CFS shear walls that have wood or steel sheathing.
l

There is currently no code check for drift or deflection for CFS shear wall panels.

Stud Design
Studs are only designed for load combinations which do not contain a wind or seismic load. The maximum axial
load, determined as an envelope force from all of the "gravity" load combinations which have been solved, is
determined for each region.
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Studs are checked per AISI S240-15 B3.2: Wall Stud Design. The program currently only uses the All Steel Design
methodology in which case bracing from the attached sheathing or structural bracing is ignored. Therefore the
unbraced length for the buckling of the stud is taken as the full wall height. The top and bottom track thicknesses
are considered negligible and are not deducted from the total height.

Note:
l
l

The program currently does not optimize the stud size or spacing.
The program will use an effective length factor, K, equal to 1.0 for the design of the studs.

Stud force demand and number of studs calculation:
The program first divides the maximum axial force in the region by the length of the region. Then it will multiply
this distributed force by the stud spacing to get a maximum stud demand.
The program calculates the number of studs based on the following procedure:
1. Determine the number of spaces between studs by dividing the region length by the stud spacing.
2. Round this number up to the nearest whole number.
3. Determine the number of studs by adding one to this number.

Openings
l

Currently, the program does not perform header design. This will be available in an updated version.

Chord Design
The chord design is based on forces that are calculated differently for Compression versus Tension. The tension
chord force is calculated including the dead load stabilizing moment. The compression chord force includes the only
the tributary area of one stud spacing in the compression force. For Segmented design, the chord forces are found
based on each region.
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Chord forces are calculated per the following equations:

Where:
l
l
l
l

M = Moment at the base of the wall
L = Length of the wall
P = Axial force at the base of the wall
n = Number of Studs = Length/Stud Spacing

Notes:
l

l

l

In RISA-3D, the edge of the CFS walls represent the centerline of the chord member. Therefore, the depth
of the chord member will not affect the chord force calculation since the centerline of the chord member
will always be assumed at the edge of the wall.
The eccentricity checkbox in the Wall Design Rules spreadsheet will not affect the chord force calculation.
RISA-3D models the shear walls using only the sheathing. The vertical resistance occurs only at the tension and compression chords. Thus, if two wall panels are stacked on top of each other, the load transfer
will only happen at the chord locations. Therefore, the lateral analysis should agree very well with hand
calculations. However, it also means that gravity load design may be more appropriate in RISAFloor.

Hold-Down Force
Hold-Down forces are calculated per the following equations:
Note that the hold-down force calculation will be dependent on if the eccentricity checkbox has been checked and
the value input in the eccentricity field.
l

When the "Eccentricity" check-box is unchecked in the CFS Wall Design Rule (Fasteners tab), the hold-down
force is exactly equal to the chord force indicated above.

l

When the "Eccentricity" check-box is selected in the CFS Wall Design Rule (Fasteners tab), an eccentricity distance should be indicated in the "Ecc Dist" column. This distance should be the distance between the holddown and the centerline of the chord member.
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The Hold-Down force is calculated by finding the Tension chord force. In order to accommodate an unsymmetrical
vertical load on the wall, the program adopted a more accurate approach by calculating the moment at the
compression side first and then finding the resulting reaction on the tension side.

The resulting equation to determine the hold-down force is as follows:

Where:
l
l
l
l
l
l
l

Ma = moment at point A(CL of compression chord)
M = moment at base of the wall
P = Axial load at the base of the wall
L = length of the wall
bc = width of chord member
Rb = reaction at point B = hold down force
CL = Hold down eccentricity distance (per selected hold down)

Lateral Force Distribution
l
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The lateral force distribution between piers is based on the relative stiffness of the sheathing, not on the
length of the shear wall. For example, if you have an 8 foot wall and a 4 foot wall, the 8 foot wall will take
more than 8/(8+4)*100% of the force. The moment of inertia in the 8 foot wall will allow for a larger proportion of load to go into that pier.
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Shear Panel Material Capacities
Shear capacity of the wall will be dependent on the Sheathing Material and Design Method that was chosen in the
Design Rules spreadsheet - CFS Wall (Fasteners) tab. When design values are pulled from design tables, the
program will use the appropriate capacity from the table based on the height-to-width ratio of the wall, member
thickness of the stud members and type of loading used.
Tabulated shear capacities are based on the AISI S240-15 CFS Structural Framing and AISI S400-15 w/S1-16 Seismic
Design of CFS Structural Systems codes. If the governing lateral load is a seismic load (under the load category EL,
ELX, ELY, ELZ, etc) then the capacity will be pulled from the AISI S400-15 code.

Note:
l

Curtain wall considerations per AISI S240-15 are not considered in the program.

Wood Sheathing
Tabulated design values are referenced from AISI S240-15 Table B5.2.2.3-2 and AISI S400-15 Table E1.3-1.

Steel Sheathing
Tabulated design values are referenced from AISI S240-15 Table B5.2.2.3-1 and AISI S400-15 Table E2.3-1.
If the Effective Width Method is used as the design method, this will be referenced from AISI S400-15 Chapter E2.3.

Note:
l

The program will not perform the end distance check in the effective width method. This is assumed to be
satisfied.

Fiberboard
Tabulated design values are referenced from AISI S240-15 Table B5.2.2.3-4. AISI S400-15 does not apply for this
material.

Gypsum
Tabulated design values are referenced from AISI S240-15 Table B5.2.2.3-3. AISI S400-15 does not apply for this
material.

Stiffness Assumptions
Vertical Direction
RISA uses an orthotropic plate element to de-couple the vertical and shear stiffness of the CFS walls. The vertical
stiffness will be based on the E value of the studs and chords as specified in the Materials spreadsheet and the
thickness of the wall. The thickness is taken as

Where,
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In-Plane Shear
The in-plane shear stiffness will be based on the Ga value designated within the specified nailing schedule divided
by the sheathing thickness. Both the Ga value and the sheathing thickness are defined in the specified sheathing
schedule.

Out-of-Plane Shear
For the out of plane shear, RISA uses the same Young's Modulus (E) as used in the vertical direction and a thickness
that is calculated from the out of plane moment of inertia. This becomes:

CFS Wall Self Weight
The program will calculate CFS wall self weight as a sum of all the weights of the components. The material density
is used to calculate the self weight of the studs, chords, top plates, sill plate, and sheathing. These are all then
summed together to give the self weight of the entire wall.

Note:
l
l

For this calculation, stud height equals full wall height.
The number of studs is calculated using the stud spacing specified in Design Rules.

CFS Wall Optimization
The program will optimize CFS walls based on the required demand forces. The program can optimize sheathing for
in-plane shear design.
This optimization can substantially modify the stiffness of the wall. To properly adjust the stiffness requires an
iterative solution that updates the stiffness of the model. This includes updating the strength properties of the wall
as well as the stiffness. The program will handle this optimization/iteration automatically.
To update the stiffness portion of the wall, the program must re-solve your model with these updated stiffnesses as
this will change the distribution of forces through the model. Thus, the program will start with it's initial stiffness
parameters and solve the model. It will then optimize the wall to meet strength criteria. Another solution will then
be run with the new stiffnesses and the program will again optimize the wall to meet strength criteria. This
procedure will continue to occur until all wall panel results match those of the previous solution.
The program will always present results in the output that coincide with the stiffness used in the final solution.
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Panel Optimization

The procedure that RISA uses for design optimization is fundamentally based upon the assumption that there is a
'cost' to shear capacity, and therefore the ideal panel design would have as little shear capacity as possible to meet
code requirements. Once the program has determined the shear demand on the wall it will choose the most
economical panel configuration based on that which has a Shear Capacity closest to, but not exceeding the shear
demand.
The program will also only pick shear panels that qualify based on the region height-to-width ratio and minimum
stud thickness requirements.
The default shear panels in the program come straight from published tables in the AISI S240-15 and AISI S400-15.

Note:
l

l

The shear forces listed in the XML spreadsheet are nominal shear strength values. The force capacity will be
adjusted by the appropriate factor depending on if the ASD or LRFD design method is selected in the Cold
Form Steel code dropdown.
Panels with a label containing the characters "_W" together will be ignored during design optimization.
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CFS Wall - Design Rules
The CFS wall panel element allows you to easily model, analyze and design CFS walls for in plane loads. Here we
will explain the CFS specific inputs and design considerations. For general wall panel information, see the Wall
Panels topic. For information on CFS wall design considerations, see the CFS Wall - Design topic. For CFS wall
results interpretation, see the CFS Wall Results topic.

Unity Check

Max Bending Chk
This will define the hold-down maximum code check value. Currently, hold-down design/optimization is not
available for CFS walls. However, this will be made available in a future release.

Max Shear Chk
This will define the shear panel selection maximum code check value. Typically this will always be 1.0, but this
allows the option of having the program pick out a shear panel layout that is not at maximum capacity. Putting a
value of 0.8 will choose a panel thickness and nailing that is at 80% of capacity.

CFS Wall (Studs)

Top Plate
Use the Top Plate column to specify the member to be used as a top plate for your wall. A top plate is a member
that runs continuously along the top of the wall studs.
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Sill Plate
Use the Sill Plate column to specify the member to be used as a sill plate for your wall. A sill plate is a member that
runs continuously along the bottom of the wall studs.

Studs
Use the Studs column to specify the member to be used for studs in your wall. Studs are vertical members in the
wall, attached to the sill plate at the bottom and the top plate at the top. Note that you can use back-to-back or toeto-toe options as well.

Stud Space
Use the Stud Space column to specify the spacing between the studs within the wall.

Header Size
This defines the default header size for all openings. Note that the program will not provide a design for CFS
headers at this time.

Design Rules - CFS Wall (Fasteners)

Type of Wall
This option determines the design methodology of the CFS wall panel. Currently CFS walls can only be designed
using the Type I - Segmented method.

Sheathing Material
You can select which sheathing material you would like to be used for lateral design optimization. The specific
sheathing material that you select will automatically populate the corresponding sheathing database in the adjacent
Schedule column.

Schedule
You can select the sheathing database and Panel Group you would like to use for design optimization. By selecting
the Select Individual Panel option, an individual panel type may be assigned. For information on how the
optimization works, see the CFS Wall - Design topic. For more information on this schedule, as well as information
on how to edit or create your own custom schedule, see Appendix G-CFS Design Databases

Design Method
This column allows you to choose the method in which the lateral capacity will be determined by the program. If
you choose the Table option, the program will reference tabulated shear capacities in the AISI S240 and AISI S400
manual. The Effective Strip Method is only available for the Steel Sheet sheathing material option. For more
information on this see the CFS Wall - Design topic.
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Min/Max Panel Thick
These values set minimums and maximums for the thickness of the sheathing that will be designed. If the same
value is input for both max and min, then that will be the thickness used.

Fastener Min Edge Space Max/Min
These values set minimums and maximums for the spacing of the nails that fasten the sheathing to the boundary
members (top plate, sill plate, hold down chords). Note that a 12" spacing is assumed for all field nailing (nails
fastening the sheathing to the internal studs).

HD Chords
You can choose what member size you would like to use for the Hold Down Chords (Posts) at both ends of the wall
panel.

Eccentricity
This checkbox controls whether the eccentricity distance of the hold-down (input into the Ecc Dist column) will be
used in the calculation of the hold-down force. For more information see the Hold Down force calculation section in
the CFS Wall - Design topic.

Ecc Dist
You can use this column to input an eccentricity distance to be used in the calculation of the hold down force. This
distance should be measured from the centerline of the HD chord to the actual hold-down anchorage.

HD Deflection
You can use this column to input the manufacturer hold down deflection which will be used in the reported shear
wall design deflection calculation.
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CFS Wall Results
CFS Wall results are presented in the Wall Panel Design Spreadsheet and the detail reports.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: CFS Walls.

CFS Wall Results Spreadsheets
CFS Wall Axial Results

The Wall Panel column lists the CFS wall panels that you have defined.
The Region column lists the wall panel region that the results are based on.
The Stud Size and Spacing columns show the stud size and spacing chosen for your wall, based on the Design
Rules you have defined.
The Axial Check value is a code check ratio between the member load and the member capacity. The adjacent Gov
LC column shows the governing load combination for the design.
The Chord Size column shows the optimum chord size chosen for your wall, based on the Design Rules you have
defined. Note that the chords are the vertical hold-down members/posts at the both ends of the wall.
The Chord Axial Check value is a code check ratio between the member load and the member capacity. The
adjacent Gov LC column shows the governing load combination for the design.
Note:
l

l

When running the Segmented design method, the wall panel regions above and below the opening are not
considered in design. Thus an NC (no calculation) will be displayed.
If there are some constraints that will not allow a wall to be designed, an NC (no calculation) will be displayed. Check the Warning Log within the program for more information on this.
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CFS Wall In-Plane Results

The Shear Panel Label shows the optimum shear panel arrangement chosen for your wall, based on the Design
Rules you have defined.
The Region gives the region for which the design values are being displayed.
The Shear Check value is a code check ratio between the panel shear load and the panel shear capacity. The Shear
Force and Gov LC show the values and load combination which governed the design.
The Hold-Down Force and Gov LC show the maximum value of hold-down/strap and the load combination which
produced the highest strap force. This maximum force could occur on either end of the wall/region.
Note:
l

l

l

When running the Segmented design method, the wall panel regions above and below the opening are not
considered in design. Thus an NC (no calculation) will be displayed. If running a combined RISAFloor and
RISA-3D model use RISAFloor to get header results.
If there are some constraints that will not allow a wall to be designed, an NC (no calculation) will be displayed. Check the Warning Log within the program for more information on this.
If 'default' is shown in the Hold-Down Label column it means that a hold down is not required for this
wall/region.

CFS Wall Self Weight
The program will calculate the self weight of a CFS wall based on the weights of the individual components. Using
the material density, the self weight is calculated for the studs, chords, top plates, sill plates, and sheathing. These
are all then summed for the total self weight of the wall.

CFS Wall Detail Reports
The detail report gives detailed information about the wall design. The detail reports are specifically molded to the
type of design specified.
Note:
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l
l

Only the Segmented design method is considered for CFS walls at this time.
Many of the values for design checks seen below are not performed in RISAFloor as it is strictly a gravity
design program.

Accessing the Detail Reports and the Specific Windows
Once you have a solved model, the detail reports become available. They are accessible in two ways:
1. If you have the Wall Panel Design spreadsheet open, you can right-click on a line in the spreadsheet and
select Detailed Report.
2. If you are in a graphic view of your model, there is a

button that will open up the detail report window.

Note:
l

Detail report information is not available for an envelope solution.

Once the detail report window is open, you will see a dialog area at the top.

l

- Allows you to click between the different wall panels in your
model.

The Wall detail report gives an overall summary of your wall, complete with governing code checks and opening
information.

Segmented Method
The Segmented design method uses each of the three detail report sections to give design information.

Wall Window
This window gives an overview of the wall, giving controlling region information and deflection information. Note
that this window only gives information on the full-height segments in your wall, as this is the basis of the
Segmented method.

Input Echo
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This lists information about the wall, similar to the Region report and also gives an image of the wall. The image
shows the location of hold-downs/straps, regions and headers.

Design Summary
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The Enveloped Results gives the code checks for all of the controlling elements in the wall and their associated
load combinations.
The Region Information gives the tabulated results of all of the full-height regions in your wall.
The Opening Information simply states that header design cannot be completed with the Segmented method. The
regions above and below the opening have their shear stiffnesses set to be zero and this causes the header forces to
be invalid.
The Deflection Results gives both the calculated AISI code deflection (Maximum Region Deflection) and the FE
deflection for use as a means of comparison. Because the AISI equations are empirical and take into account many
non-elastic considerations such as nail slip, these two values may not be the same.

Region Window
This window gives information for your wall on a region by region basis. Note that only full-height regions of the
wall panel will have a region detail report. The Segmented method only considers these full height segments in the
design of the wall.
The region detail report is split into four portions: input echo, diagrams, design details, and cross section detailing.
Note that in RISAFloor the detail reports are less detailed because RISAFloor does not consider lateral forces which
RISA-3D does.

Input Echo
Below is the input echo portion of the detail report.

Criteria

Description

Code

Gives the code used to design your wall panel.

Design Method

Gives the design method that was used.

Wall Material

Specifies the CFS type assigned to the entire wall

Panel Schedule

Specifies the sheathing material used to optimize panel selection (set in Design Rules)
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Materials

Description

Wall Studs

Specifies the CFS material type assigned to the wall studs

Stud Size

Top Plate Size

Specifies the member size used for the wall studs
Specifies the CFS material type assigned to the chords (vertical members at both
ends of the wall)
Specifies the member size used for the chords (vertical members at both ends of
the wall)
Specifies the CFS material type assigned to the top and sill plates
Specifies the member size used for the top plate

Sill Plate Size

Specifies the member size used for the sill plate

Geometry

Description

Total Height

This is the height of the wall panel region

Total Length

This is the length of the wall panel region
This is the ratio of wall height to length, using the minimum wall height

Chord Material
Chord Size
Top Plate & Sill

Region H/W Ratio

Cap. Adj (2w/h)

This is an aspect ratio reduction factor for the shear panel strength per AISI S240-15
B5.2.2.1. This factor applies only for wall panels that have an aspect ratio greater than 2
but less than or equal to 4. This factor is applied separately for each full-height region in
your wall.

Stud Spacing

This is the optimized stud spacing based on your Design Rules

K

This is the effective length, K Factor used for stud and chord compression design

HD Eccentricity

This is the eccentricity of the hold-down connection. This is based on user input (set
within the Design Rules).

Envelope Diagrams
These diagrams show the axial forces, in-plane shear, and in-plane moments of the wall, as well as the maximum
and minimum forces and their locations.
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Note:
l

The diagrams are not actually enveloped.
l The Axial diagram shown is the diagram from the governing load combination for Stud design.
l The Shear and Moment diagram is the diagram from the governing load combination for Shear Panel
design.

Design Details
This portion gives you the capacity and strength values at the section in the wall where the combined check is
maximum, as well as the governing load combination. Much of this information is also reported in the CFS Wall
Panel Design spreadsheets.
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Shear Panel
The Selected Shear Panel gives the call-out from the shear panel database. The information below it is the
information describing the call-out.
The provided capacity of the shear panel is taken from the Shear Capacity column of the panel database. This is the
adjusted capacity based on tables within the AISI S240-15 and S400-16. The Governing LC explicitly states if the
controlling load combination was based on Wind or Seismic. The program does a unity check for all LCs that are
being solved, finds the maximum value and reports that information.
This section of the report echoes the database information for the selected shear panel. For more information on
these properties refer to Appendix G-CFS Shear Wall Files.

Note:
l

l

l

The displayed "Shear Capacity" takes the given nominal shear capacity from the design code and multiplies
or divides it by the appropriate code factor and aspect ratio factor when applicable.
A shear panel design will be chosen for the worst-case region in a segmented wall. That panel will then be
used for all regions in that wall. The worst-case region is the one that has the highest Shear UC value.
Because wind and seismic loading allows for different design capacities, the highest shear in the wall may
not be the governing shear (if that highest shear was due to wind).
Chords, Studs

The provided capacities of these members are calculated using the standard provisions for tension/compression
members. These members are assumed to be fully braced in the weak axis, and unbraced in the strong axis. For
more information on the chord force calculations, see the CFS Wall - Design topic.
Note:
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l

For chord results, the tension/compression capacity is computed using the reduced cross-sectional properties caused by the hold-down bolt hole.
Deflections

The deflection listed in the detail report is based on an approximation from the design code:

AISI Design Deflection
Per the AISI S240-15 North American Standard for Cold-Formed Steel Structural Framing Equation B5.2.5-1:

Refer to the AISI 240-15 standard page 52 for detail definitions for each term in the equation.
The first component of the above equation determines the Bending Component of the deflection.
The second component of the above equation determines the Shear Component of the deflection.
The third component of the above equation determines the Hold-Down Elongation, which causes additional
deflection. The delta_v term refers to vertical deformation of the hold-down. This is a user input within the Wall
Design Rules.

Note
l

This is the theoretical deflection of the wall. This may differ from the deflection of the wall as performed by
finite element analysis within RISA. Therefore, this deflection value may not coincide with the reported
deflection value in the deflections spreadsheets.

Cross Section Detailing
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The last section of the detail report consists of the wall detailing information. This information is provided as a
visual confirmation of the wall design. The wall thickness, and stud spacing are shown as dimensions. The triangle
shows sheathing on one side of the wall, with the abbreviated panel designation. The chord sizes/forces are shown
at either end.

Note:
l
l

724

The graphic will show hold-downs regardless if one is required or not.
The chord members will always be shown as CS members face-to-face despite what is specified in the Design
Rules. This is just a graphical representation of the chord member placement.
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Concrete Wall Panel - Design
The concrete wall panel element allows you to easily model, analyze, and design concrete walls for in plane and out
of plane loads for the codes defined below:
l
l

The 2019, 2014, 2011, 2008 and 2005 Editions of ACI 318.
The 2014 Edition of CSA A23.3.

Note:
l
l

Unless otherwise specified, all code references below are to ACI 318-14.
Walls designed in RISA meet all of the requirements for Ordinary Concrete Shear Walls.

Here we will explain the concrete-specific inputs and design considerations. For general wall panel information, see
the Wall Panels topic. For concrete wall design rule information, see the Concrete Wall - Design Rules topic. For
concrete wall results interpretation, see the Concrete Wall Results topic.

Concrete Wall Input
Double-click on the wall from the model view to open the Wall Panel Editor. A new window will appear for the
wall panel and the Walls tab of the ribbon toolbar will give viewing options for Region and reinforcement display
(after solution). You can also draw in openings, assign boundary conditions, and create regions. The properties of
the wall panel can be modified in the Properties Panel.
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Concrete Wall Display Controls
l

l

l

l

l

l

Show Nodes allows you to turn the display of nodes on or off.
Show Regions allows you to turn the display of regions on or off.
Show Lintel allows you to turn the display of lintels on or off.
Rendered allows you to toggle the rendering of the wall panel on or off.
Show Diaphragm allows you to turn the display of diaphragms on or off.
Show Rebarallows you to turn the display of reinforcement on or off after you have solved your model.

Concrete Wall View Controls
l

Front will orient the wall panel so that you are looking at the front (positive X-axis to the right).
l

Back will orient the wall panel so that you are looking at the back (positive X-axis to the left).
l

Zoom Extentswill reposition the wall panel to fit in the Wall Panel view.

Concrete Wall Drawing Tools
The wall panel grid increment and snap points can be specified in the Drawing Tools section of the Walls tab.

The

Wall Grid allows you to modify your snap options, drawing grid in the wall panel editor.

Concrete Wall Regions
Concrete walls depend on Regions for results presentation. The program automatically creates these regions at
solution time. If you have a wall panel with no diaphragms then a single region will be created over the entire wall
and you will get a single reinforcement design for the entire wall. If there are diaphragms that pass through your
wall panel and/or there are openings in the wall, then the wall will be broken up into multiple regions above and
below the diaphragms and around the openings, giving a different reinforcement design for each region.
Within each region, the program will optimize the spacing of bars for strength, spacing and minimum reinforcement
considerations of the wall.
From within the Wall Panel Editor, you have the option of creating rectangular regions within the concrete wall
panel. Regions are used to define reinforcement in different parts of the wall. Each region will be assigned a
uniform reinforcement, which may be different than the reinforcement in other parts of the same wall (unless you
are using Group Story option from Wall Design Rules).
If no regions have been drawn on a wall then they will be automatically generated when a solution is performed. To
automatically generate regions prior to running a solution, click theDesign Wall Regions Automatically button
.
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To manually draw regions, select the Design Wall Regions manually
button and use your cursor to select two
nodes or grid intersections which make up the diagonal corners of the region. To exit this tool right-click your
mouse.

Concrete Design Considerations
ACI 318-14/19 Reinforcement Design
The program will design the reinforcement spacing for you. For this design reinforcement spacing, rho, and strength
requirements are considered for design. If specific reinforcement is defined in the Wall Design Rules spreadsheet
then it may be possible for the reinforcement design to not meet code requirements.
Sections 25.2 and Chapter 11 have provisions regarding min/max spacing, required reinforcement ratios, and
proper proportioning of wall reinforcement. If your wall does not meet a code requirement the program will give a
red warning message in the detail report.
Section 25.2 (General Reinforcement Requirements)
The minimum spacing requirements from Section 25.2.1 are considered for design.
Chapter 11 (Wall Reinforcement Detailing)
The maximum spacing requirements from section 11.7.2.1 and 11.7.3.1 are considered for design.

Note:
l

The precast wall spacing requirements of Section 11.7.2.2 and 11.7.3.2 are not considered.

The minimum spacing requirements of Section 11.6.1 are also considered for design. Additionally, the thickness
requirement from Section 11.7.2.3 as well as the proportioning and cover checks in that section are also considered.
The program will consider the reinforcement requirements of Section 11.6.2 if the Vu exceeds 0.5*ϕ*Vc.

ACI 318-11 Reinforcement Design
The program will design the reinforcement spacing for you. For this design reinforcement spacing, rho, and strength
requirements are considered for design. If specific reinforcement is defined in the Wall Design Rules spreadsheet
then it may be possible for the reinforcement design to not meet code requirements.
Sections 7.6, 14.3 and 11.9 all have provisions regarding min/max spacing, required reinforcement ratios, and
proper proportioning of wall reinforcement. If your wall does not meet a code requirement the program will then
give you a red warning message in the detail report.
Section 7.6 (General Reinforcement Requirements)
The minimum spacing requirements from 7.6.1 and the maximum spacing requirements from section 7.6.5 are
considered for design.
Section 14.3 (Wall Reinforcement Requirements)
The minimum spacing requirements of Sections 14.3.2 and 14.3.3 and maximum spacing requirements of 14.3.5 are
also considered for design. Additionally, the thickness requirement from Section 14.3.4 as well as the proportioning
and cover checks of 14.3.4 are also considered.
Section 11.9.8 and 11.9.9 (Shear Reinforcement Requirements for Walls)
The program will consider the reinforcement requirements of Section 11.9.9 if the Vu exceeds 0.5*ϕ*Vc (per Section
11.9.8).
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CSA A23.3-14 Reinforcement Design
The program will design the reinforcement spacing for you. For this design reinforcement spacing, rho, and strength
requirements are considered for design. If specific reinforcement is defined in the Wall Design Rules spreadsheet
then it may be possible for the reinforcement design to not meet code requirements.
Clause 14.1.7.1 and 14.1.8 have provisions regarding wall geometry, min/max spacing, required reinforcement
ratios, and proper proportioning of wall reinforcement. If your wall does not meet a code requirement the program
will then give you a red warning message in the detail report.
Clause 14.1.7.1 (General Wall Geometry Requirements)
The thickness of the walls shall be not less than the smaller of lw / 25 or hu / 25, but not less than 150 mm.
Clause 14.1.8 (Wall Reinforcement Requirements)
The program considers the provisions for reinforcement diameter (14.1.8.2), number of layers (14.1.8.3), max
spacing of reinforcement (14.1.8.4), and min reinforcement ratio (14.1.8.5 & 14.1.8.6).

Reinforcement Placement
The reinforcement is designed to meet spacing, rho, and strength requirements. This design may cause the
reinforcement spacing design to not fit in the wall region at the exact spacing designed for. Therefore the program
will add bars to the extreme ends of the wall region to take these remainders into account.
The reinforcement layout algorithm works as follows (picture looking down on a cross section of wall):
First the required spacing is calculated and the wall region length is divided by this spacing.
a. If two bars cannot fit at this spacing, one bar (each face if specified) will be placed at each end of the wall
(meeting cover req'ts).
b. If only three bars fit at this spacing then one bar (each face if specified) will be placed at each end of the wall
(meeting cover req'ts) and one bar in the center of the wall.
c. If more than three bars are required, then reinforcement is filled in uniformly in the center of the wall and
an equal remainder is left between the end bar and the second bar. The image below illustrates this (assume
symmetry on both ends of the wall).
Note:
l

This process is only required for very skinny walls. Almost all walls will fall into Step c above.

Axial Tension
The axial tensile capacity for a wall assumes all reinforcement is fully developed. The capacity (with no bending
interaction) equals:
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where n = number of vertical bars in the wall.

Axial Compression
The axial compressive capacity (with no bending interaction) is taken from equation 10-2.
If CSA A23.3-14 code is selected, Clause 10.10.4 was used to calculate the axial compressive capacity (with no
bending interaction).
Note:
l

Slenderness is taken into account per section 6.6.4.5. See the Second Order Effects section below. CSA A23.314 uses the same procedure in considering slenderness effect.

Bending
Both in plane and out of plane capacity consider beam theory in design. For out of plane design (if no axial force)
the capacity is simply defined as:

Note:
l

For out of plane reinforcement design, the reinforcement on both faces is taken into account. Thus, the capacity equation above may have two parts to it in order to consider the extreme tension bar and also the bar
nearest the compression face that may also be in tension

Minimum Required Moment
ACI 318-14 Section 6.6.4.5.4 (ACI 318-11 Section 10.10.6.5) requires a minimum required moment to be taken into
account for each axis in the wall. Thus, if the value from ACI 318-14 Eq 6.6.4.5.4 (ACI 318-11 Eq 10-17) is greater
than the calculated moment demand this value will be used. This is meant to account for a minimum eccentricity of
the axial force in the wall. CSA A23.3-14 has similar requirements on minimum required moment as defined in
10.15.3.1.
The design moment may be factored up due to P-Little Delta effects (see below).

Shear
In-Plane
When ACI 318-19 is selected, Vc is calculated using Equation 11.5.4.3. For wall panels subjected to net axial tension,
αs is calculated using Equation 11.5.4.4.
When other ACI 318 editions are selected, Vc is taken into account using ACI 318-14 Detailed Equations from Table
11.5.4.6 (ACI 318-11 Equations 11-27 and 11-28), where:
l
l

d = 0.8*lwall
Nu, Mu and Vu are taken at the location of maximum shear demand.
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When CSA A23.3-14 are selected, Vc is taken into account using Equation 11.6. The factor β is calculated using
Equation 11.11 where:
l
l

The longitudinal strain εx is calculated using Equation 11.13.
The equivalent crack spacing parameter sze is calculated using Equation 11.10.

Vs is taken from ACI 318-14 Equation 11.5.4.8 (ACI 318-11 Equation 11-29). Although Vs is only required if Vu >=
0.5*ϕ*Vc, any minimum reinforcement requirement will be used as Vs and added to the shear capacity.
Note:
l
l

l

The maximum Vn per ACI 318-14 Section 11.5.4.3 (ACI 318-11 Section 11.9.3) is also checked.
In ACI 318-14 Section 11.6.2 (ACI 318-11 Section 11.9.9), the lw term here is taken as the FULL length of the
wall, not the length of the region. ACI 318-14 Section 11.5.4.6 (ACI 318-11 Section 11.9.6) take the lw to be
the length of the region.
In ACI 318-14 Section 11.6.2 (ACI 318-11 Section 11.9.9) the hw term here is taken as the height of the
region.

When CSA A23.3-14 are selected, Vs is taken from Equation 11.7 where the angle of inclination θ is calculated using
Equation 11.12.

Out-Of-Plane
When ACI 318-19 is selected, Vc is calculated using Equation (c) in Table 22.5.5.1. Note that ACI 318-19 code
suggests ρw may be taken as the sum of the areas of longitudinal bars located more than two-thirds of the overall
member depth away from the extreme compression ﬁber. Therefore, RISA calculates ρw as the sum of the areas of
vertical bars on the tension face.
When other ACI 318 editions are selected, the equations from ACI 318-14 Sections 22.5.6.1 and 22.5.7.1 (ACI 31811 Section 11.2.15 and 11.2.3) is used for Vc.
When CSA A23.3-14 are selected, Vc is calculated in the same way as In-Plane shear section.
If there are axial tension forces present it is possible for the Vc to go to zero. If axial tension is present the program
will use shear friction of the vertical reinforcement in the wall, which will appear as phi*Vns in the output. phi*Vns
is calculated as follows:

Thus, the program calculates the portion of the vertical reinforcement that is already engaged in tension and uses
the remaining strength to be used for shear friction. The program also sets a maximum shear friction capacity equal
to what the concrete wall with no axial force could take. A coefficient of friction, μ, of 1.0 is conservatively assumed.
When CSA A23.3-14 are selected, shear friction is ignored in the shear strength calculation.
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The larger of phi*Vnc and phi*Vns is used in the code check. If there is no axial tension in the wall then phi*Vns = 0
and shear friction will not be considered. The intention is to only use shear friction when needed for a case where
the wall is loaded in tension and can produce a very small phi*Vnc value.

Lambda
Lambda is considered differently for the 2005 and newer codes. For ACI 318-05 the program will always consider
lambda = 0.75 if the Density of concrete is <= 115 pcf and lambda = 1.0 otherwise (ACI 318-05 Section 11.2.1). For
the ACI 318-08 and newer codes, the program will use the Lambda value directly from the Materials spreadsheet.

Deflections
The deflection listed in the detail report is based on the finite element analysis of plate elements. This deflection
agrees well with beam theory, thus can be calculated based on beam equations.
Note:
l

If you are checking a hand calculation of the in-plane deflections, be sure to include the deflection due to
shear and consider the cracked moment of inertia.

Interaction Diagrams

The program uses a concrete solver to create the interaction diagram and uses this diagram to calculate the
capacity of a wall/wall region based on the demand axial force and moment. The program computes the code check
based on making a straight line through the origin, the moment/axial force demand location, and where that line
crosses the interaction diagram curve. For the out of plane report there is the possibility of different cover spacing
at each face of the wall. Thus, the capacities for each face of the wall are reported.

Moment and Axial Force Thresholds
The program will ignore axial forces and moments that are below a certain threshold. If the moment or axial force
is deemed to be inconsequential to the code check then the program will simply not include the interaction of that
force. There are two thresholds that are considered:
l

l

Axial Force Threshold: If Pu < 0.01*f'c*Ag for that LC, then the axial force in the wall region will be ignored
for code checks for that LC.
Moment Threshold: If Mu < 0.01*d*Pu for that LC, then the moment in the wall region will be ignored for
code checks for that LC.

These two thresholds allow the concrete solver to work much more efficiently while having little to no effect on
code check values.
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Second Order Effects
Per ACI 318-14 Section 6.7.1.1 (ACI 318-11 Section 10.10.4) an elastic second order analysis will satisfy code
requirements. In RISA this means running a P-Delta analysis to consider secondary moments induced due to the
displacement of member ends and a P-Little Delta analysis to account for member curvature effects.
The ACI 318-14 requires that either Section 6.6.4, 6.7 or 6.8 are used for sway frames. The ACI 318-08/11
specifications require that either Section 10.10.3, 10.10.4 or 10.10.5 are used. The ACI 318-05 specification requires
that you follow provisions of Section 10.13.
Because a P-Delta analysis (big and little) is a more robust analysis the program requires this analysis for all ACI
specifications.

P-Delta
The secondary effects due to the displacements of member ends is taken into account with the inclusion of a P-Delta
analysis.
To perform a P-Delta Analysis place a "Y" in the P-Delta column of the Load Combinations spreadsheet. For more
information on this, see P-Delta .

Element Curvature Effects (P-Little Delta)
The design moment (max of demand moment and minimum required moment) must be factored up per Section
10.10.6 if the wall is considered slender.
Slenderness requirements are given in ACI 318-14 Section 6.2.5 (ACI 318-11 Section 10.10.1). The program
conservatively only considers ACI 318-14 Equation 6.2.5.b (ACI 318-11 Equation 10-6). Thus, if the KL/r (in either
direction) exceeds 22, then the provisions of ACI 318-14 Section 6.6.4.5 (ACI 318-11 Section 10.10.6) are also
considered. CSA A23.3-14 uses the same procedure in considering the P-Little Delta effect.
Note:
l

l
l

l

l

l

l

l

The M2 moment will be calculated separately at each section of the wall vertically, rather than using a single
M2 moment for the entire height of the wall.
If Pu > 0.75*Pc the program will fail the wall and not give a code check.
The moment of inertia (I) in the Pc equation is taken conservatively as 0.25*Ig per ACI 318-14 Section
R6.6.4.4.4 (ACI 318-11 Section R10.10.6.2).
Cm is calculated per ACI 318-14 eq. 6.6.4.5.3a (ACI 318-11 eq. 10-16). User may override this and manually
input Cm value in Walls spreadsheet - Advanced tab.
Lu for the wall is either defined as the full height of wall or story (a story is broken up by diaphragms that
cross the wall.
P-Little Delta is only considered for full story height regions. Non full-height regions will give a note and not
do P-Little Delta.
If the controlling load combination experiences tension, the Mc results will be suppressed and show N/A
because tension would actually reduce the amplified moment.
For more information on this, see P-Little Delta .

Concrete Lintel Considerations
The addition of openings into a wall in the wall panel editor will automatically create a lintel above the opening. It
will be symbolized by a blue bar that has the name of the lintel inside of it. The program will produce axial, shear
and moment diagrams for the lintel that can be viewed from the Concrete Wall Detail Report from the Lintel dropdown option. Here we will explain some of the different considerations.
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How Lintels are Defined
In RISA-3D the lintel is considered as the entire region directly above an opening (L1 below), even though the blue
bar does not cover this entire area.

At solution the program will then perform a summation of forces over this entire region and presents the analysis
results in the detail report. These results are presented as a "beam" analysis. The program will cut through the
entire region vertically multiple times along the length of the region. At each cut the program will calculate the
axial, shear and moments. The results from each of these cuts are then combined to form the force diagrams.
Note:
l

Keep in mind that the program only reports results in the detail report if there is a region above the opening
AND the width of the region matches exactly the width of the opening. Therefore, a region drawn off-center
of the opening will not give lintel results.

Load Attribution
See the Wall Panels topic for more information.
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Concrete Wall Modeling Considerations
Optimization Procedure
The program will use the Wall Design Rules and start with the maximum spacing and check that configuration for
strength, spacing, and minimum reinforcing requirements. If the max spacing works, then the design is done. If not
then the program will reduce the spacing by the spacing increment and then do the same checks. This will occur
until a bar spacing is reached to satisfy the code requirements.

RISAFloor/RISA-3D Design Enveloping
If you are using RISAFloor and RISA-3D in tandem to do gravity and lateral design, then the program envelopes the
results of both. Thus, RISAFloor will never increase the spacing of bars larger than what was required in RISA-3D
and vice versa. Also, when moving between programs, the reinforcement spacing that controls will be carried on
into the other program.
For example, let's assume RISAFloor required vertical bars that are #6 @ 12" oc. We then use the Director to take
the model to RISA-3D. In RISA-3D, the required vertical bars are #6 @ 8" oc. Now, if we take the model back to
RISAFloor and solve again, the #6 @ 8" oc spacing is brought over to RISAFloor and code checks are now based on
this spacing.
Note:
l

When going back and forth between RISAFloor and RISA-3D, you must solve the model in each of the programs to capture this enveloping. If you do not re-solve, then you are then seeing the results from the previous time you solved in that program without updating for the enveloping.

Modeling Multi-Story Shear Walls
For multi-story walls that have diaphragms intersecting, separate regions will be drawn above and below the
diaphragms (see Figure 1). The design of each of these regions can be different. This, however, is only true of the
spacing of reinforcement. The bar size must be equal for the full-height of the wall, because the Design Rule is for
the entire wall and all regions.
If you want to change bar size over the height of the wall, simply create separate wall panels and stack them on top
of one another. In this way you can define different Design Rules and thus different reinforcement bar sizes up and
down the wall (see Figure 2).
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For the stacked regions model where the intention is to drop off bars as you work your way up the wall, lets give an
example. Let's say that at the base of the wall you have bars at a 4" o.c. spacing. At some point you want to drop off
bars to create an 8" o.c. spacing.
All you need to do here is set your Design Rules such that the Min Vert Bar Spacing is set to 4", the Max Vert Bar
Spacing is set to 8" and the Spacing Increment is set to 4".

Wall Cover Dimensions and Local Axes
The program is able to consider different reinforcement cover dimensions for each face of the wall. Because of this
the orientation of the wall is important. In the program the Exterior Face of the wall is oriented in the +z local
axis direction. The Interior Face of the walls is oriented in the -z local axis direction.
Note:
l
l

In RISAFloor the wall local axis is irrelevant as we are only doing axial checks.
If the cover on both faces is identical then the local axis orientation is irrelevant.

A wall drawn in a clock-wise fashion will have its local axis pointed in the positive direction. A wall drawn in a
counter-clockwise fashion will have its local axis point in the negative direction.
If the wall local axis is facing the wrong direction then use the Local Axis Flip from the Modify Walls dialog to
correct it.
When bringing a model from RISAFloor to RISA-3D then you want to think about how you are drawing in RISAFloor
so that the local axes come in properly in RISA-3D. You will want to draw the walls in in RISAFloor in a counterclockwise manner to get the local z axes to point outward.
Wall Panels Drawn in RISAFloor in Counter-Clockwise Fashion

Image of Local Axes in RISA-3D
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You can go to Model Display Options - Panels tab to view the local axes for the wall.

Limitations
l

l
l

l

l
l
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Horizontal reinforcement is designed for in plane shear forces, spacing, and minimum reinforcement checks.
They are not used for bending design at this time.
Walls with bars each face in the wall will require the same size bar and spacing for both faces.
For sloped walls due to sloping floors, regions cannot be defined in the upper triangular area of the wall
panel. Thus, the stiffness of the wall in this area is accurate, but you will get no design results for this portion
of the wall.
Concrete walls are considered completely separately in both the in plane and out of plane directions. Any
interaction of the wall, reinforcement, etc., between in plane and out of plane behavior is not considered.
Reinforcement development is not considered. All reinforcement is assumed to be fully developed.
ACI 318-14 Chapter 18 (ACI 318-11 Chapter 21) and CSA A23.3-14 Clause 21 provisions for seismic design
are currently not considered in the program.
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Concrete Wall - Design Rules
The concrete wall panel element allows you to easily model, analyze, and design concrete walls for in plane and out
of plane loads. Here we will explain how concrete design rules work. For general wall panel information, see the
Wall Panels topic. For information on concrete wall design considerations, see the Concrete Wall - Design topic. For
concrete wall results interpretation, see the Concrete Wall Results topic.

Unity Check

Setting a maximum Bending Check (Axial & Bending) or a maximum Shear Check controls the rebar which the
program chooses for the wall design. A value of 0.9 denotes that the program may choose a rebar layout that is at
90% of capacity.

Note:
l

The same unity check parameters are valid for masonry walls as well. However, these parameters are not
considered in wood wall design. For wood walls these values are always assumed to equal 1.0.

Concrete Wall (Rebar) Rules

Vert and Horz Bar Size
These are the vertical and horizontal bar sizes used for reinforcement of the wall.

Note:
l

The bar size and spacing is assumed to be the same for each face of the wall. Currently reinforcement must
be the same for both faces.
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Max/Min Vert and Horz Bar Space
The program will design the reinforcement spacing based on these guidelines. If you want the reinforcement to be
at an exact spacing, simply enter that spacing as both the min and max in order to force this spacing.

Horz and Vert Bar Increment
This is the spacing change increment that the program will use for design. If the maximum spacing does not work,
the spacing will drop by this increment and be checked again. The program will work its way down until it reaches
a spacing that meets all reinforcement requirements.

Group Wall
For walls that have multiple regions, this checkbox allows you to group the reinforcement for the regions in a wall.
Thus, the worst case vertical and horizontal reinforcement spacing will be used for all regions in the wall.

Concrete Wall (Cover) Rules

Outer Bars
This defines whether the reinforcement mesh has the Horizontal or Vertical bars closest to the face of concrete. This
will affect the "d" calculation for the wall. If the location is Centered then this defines which bar is nearest the
outside face of concrete.

Horizontal
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Vertical

Location
This allows you to locate reinforcement at each face of wall or centered. If the reinforcement is defined as centered
then the program places the vertical bar directly at the center of the wall. The horizontal bar is then placed to one
side or the other based on the "Outer Bars" designation.
Note:
l

The ACI code requires two curtains of reinforcement if the wall is 10" thick or greater, thus the program will
give a warning in the results if you configure your wall like this.

Int Cover (-z)
This is the clear cover distance from the interior face of wall to the outer reinforcement. The interior face of the
wall is defined by the negative z local axis direction of the wall.

Ext Cover (+z)
This is the clear cover distance from the exterior face of wall to the outer reinforcement. The exterior face of the
wall is defined by the positive z local axis direction of the wall.

Edge Cover
This is the "in plane" cover dimension for the outer edges of walls.

Transfer In and Transfer Out
These options allow you to transfer loads from regions above and below openings to adjacent full-height regions.
Transfer in is for in plane loads and transfer out is for out of plane loads. Here is an image of a wall:
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If either of the Transfer options are turned on for this wall, then any loading in that plane (in plane or out of plane)
for regions above and below openings will have their load transferred into the adjacent regions.

A couple of things to keep in mind with the Transfer options:
l

l
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This is a design-level tool. That is, there is no stiffness change for the model. The program uses the stiffness
of all regions for its stiffness. However, after solution, the forces that have accumulated in the regions above/below openings are moved into the adjacent regions. The adjacent region design will then include these
forces.
Results output will not give any information for these "transferred" regions. Only the regions adjacent to the
openings will have results.
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Concrete Wall Results
Concrete wall results are presented in the Wall Panel Design spreadsheet on the Concrete tabs, the Concrete
Reinforcing spreadsheet on the Concrete Wall tab and the detail reports. Results are reported on a region by
region basis.

Concrete Wall Spreadsheet Results
The Wall Panel Design spreadsheet contains tab that involve concrete wall design: Concrete , . Each tab gives code
checks based on the chosen concrete code and can be used as a summary of all of the walls and wall regions in your
model. To get detailed information about each region, you can see the Wall Panel Detail Report.
Note:
l

l

Concrete lintel results are not given in the output spreadsheets because the program analyzes them without
designing. You must go to the detail report to see lintel analysis results.
If a wall panel is set to Transfer forces, then regions above and below opening will not have results. See the
Concrete Wall - Design Rules topic for more information.

In Plane

The Concrete In tab provides in plane code checks and capacities relevant to the in plane behavior of the wall.
The Max UC entry gives the maximum code check due to axial force plus in-plane bending. The Shear UC will show
the in plane shear code check. A value greater 1.0 for any of these values would indicate failure.
The LC columns report the load combination that produces each of the highest code check values.
The Pn*Phi reports the axial capacity of the wall.
Note:
l

An NC means that the axial force in the wall is less than the threshold value, so the axial force is not considered.

The Mn*Phi reports the calculated in plane moment capacity for the region.
Note:
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l

An NC means that the bending moment in the wall is less than the threshold value, so the axial force is not
considered.

The Vn*Phi reports the calculated in plane shear capacity for the region.

Out of Plane

The Concrete Out tab provides out of plane code checks and capacities relevant to the out of plane behavior of the
wall.
The Max UC entry gives the code check due to axial force plus out of plane bending. The Shear UC will show the
out of plane shear code check. A value greater 1.0 for any of these values would indicate failure.
The LC columns report the load combination that produces each of the highest code check values.
The Pn*Phi reports the axial capacity of the wall.
Note:
l

An NC means that the axial force in the wall is less than the threshold value, so the axial force is not considered.

The Mn*Phi reports the calculated out of plane moment capacity for the region.
Note:
l

An NC means that the bending moment in the wall is less than the threshold value, so the axial force is not
considered.

The Vn*Phi reports the calculated out of plane shear capacity for the region.

Concrete Reinforcing Spreadsheet Results
The Concrete Wall tab contains reinforcement results for each region in a concrete wall panel.
Note:
l
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If a wall panel is set to Transfer forces, then regions above and below opening will not have results. See the
Concrete Wall - Design Rules topic for more information.
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Concrete Wall

The Concrete Wall tab displays the thickness, horizontal and vertical reinforcement sizes, and spacing for each
region in the concrete wall.

Concrete Wall Detail Reports
The detail reports show the overall geometry, analysis, and design for the individual regions/stories of the wall
panel. The report also shows envelope diagrams for the forces and moments in the region.
Three basic types of detail reports are provided: Wall Summary, Region and Opening.

Accessing the Detail Reports and the Specific Windows
Once you have a solved model, the detail reports become available. They are accessible in two ways:
1. If you have the Wall Panel Design spreadsheet open, there will be a button at the top of the screen:
. This will open up the detail report window.
2. If you are in a graphic view of your model, there is a
button on the Selection toolbar. Clicking this
button and clicking on a wall panel will open up the detail report window for that wall panel.
Note:
l

If a wall panel is set to Transfer forces, then regions above and below opening will not have results. See the
Concrete Wall - Design Rules topic for more information.

Once the detail report window is open, you will see a dialog area at the top.

These options control the display of the Detail Report:
l

- The arrow buttons allow you to scroll quickly between the different wall panels in your model.
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Wall Report
This report gives an overview of the wall, a summary of the controlling code checks and deflection information. This
report also displays information about the wall, similar to the Region Input Echo and also gives an image of the
wall. The image shows region locations, wall length and story dimensions, and the nodes that define the corners of
the wall panel.
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The Region Results section gives the tabulated results of all regions in the wall for in plane design axial/bending,
shear and deflection for quick reference. You can view the individual region reports to get a more detailed
explanation of these values.
The Reinforcement Results section gives the reinforcement results for each region in the wall.

Region Report - In Plane
This window gives information for your wall on a region by region basis. The Region detail report is split into five
portions: input echo, diagrams and design, wall section properties, interaction diagrams and cross section detailing.
Note:
l

In RISAFloor, the detail reports are less detailed because RISAFloor does not consider lateral forces.

Input Echo
Below is the input echo portion of the detail report.
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Criteria

Description

Code
Design Rule
Loc of r/f
Outer Bars
Bar Size
Bar Spacing

Gives the code used to design the wall.
Gives the design rule used to design reinforcement and cover for the wall.
States whether reinforcement is defined at each face of the wall or centered.
States whether the outer bar in the wall is vertical or horizontal.
States the bar size for both horizontal and vertical reinforcement
States the bar spacing for both horizontal and vertical reinforcement
States whether the regions in the wall are grouped or not. See the Concrete Wall Design Rules topic for more information.

Group Wall?

Materials

Description

Material Set
Concrete f'c
Concrete E
Concrete G
Conc Density
Lambda
Conc Str Blk
Bar Fy
Steel E

States the Material used for the design of the wall.
States the compressive strength of the concrete.
States the modulus of elasticity of the concrete.
States the shear modulus of the concrete.
States the unit density of concrete used for self-weight calculations.
States the lightweight concrete factor for shear design.
States whether a rectangular (Whitney's) or parabolic stress block was used.
States the reinforcement strength for both vertical and horizontal bars
States the modulus of elasticity for reinforcement.
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Geometry

Description

Wall Dimensions
Cover Dimensions

States the height, length, and thickness of the wall panel region.
States the interior, exterior, and edge reinf. cover dimensions.
States the effective length factor which is used in determining slenderness of the
wall.
States whether a wall is considered to be cracked or not. Defines whether or not to
use cracking in the determination of the moment of inertia.
States the factor that Igross is multiplied by to get the cracked moment of inertia.
This defaults to 0.7 for in plane and 0.35 for out of plane.

K
Use Cracked?
Icr Factor

Diagrams and Design
In Plane

Out of Plane
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Envelope Diagrams
These diagrams show the axial forces, in-plane shear, and in-plane moments of the wall region, as well as the
maximum and minimum forces and their locations. The results give an envelope solution of all load combinations .
Because the enveloped results displayed are always the maximum values and because axial and bending forces are
checked per their combined effects, the forces in the envelope diagrams won't necessarily be the forces that the
wall region is designed to. For example, if there is a high bending moment at the top of a wall region and a high
axial force at the base of the wall region, the program will do a check at each location up the wall region, considering
the shear and moment at that location for THAT load combination. Thus, the maximum axial force given at the
location of maximum bending may NOT be the axial force for the LC that produced the maximum bending.

Code Check Summary
This portion of the report gives the capacity and strength values at the section in the wall region where the
combined check is maximum, as well as the governing load combination. Much of this information is also reported
in the Concrete Wall Panel Design spreadsheets.
Axial/Bending Details
The axial and bending capacity are based upon an interaction diagram for the wall region. See below
for interaction diagram information. The program computes the code check based on making a
straight line through the origin, the moment/axial force demand location and where that line crosses
the interaction diagram curve.
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For the out of plane report there is the possibility of different cover spacing at each face of the wall
region. Therefore the program reports capacities for each face of the wall region. The capacity at the
exterior face means that reinforcement at the exterior face of the wall is in tension and vice-versa for
the interior face.

Note:
l

The program considers walls to act completely separately in the out of plane direction from the
in plane direction. Any out of plane/in plane interaction will need to be taken into account by
hand.

Shear Details
The shear details section gives the shear demand required in the wall region. The in plane shear
strength of the concrete and steel are listed separately, along with the code-prescribed maximum
allowed shear. For out of plane shear design, the simplified equation will be used. For more
information on shear capacity of concrete walls, see the Concrete Wall - Design topic.

Deflections
The deflection listed in the detail report is based on the finite element analysis of plate elements. This
deflection agrees well with beam theory, thus can be calculated based on beam equations.
Note:
l
l

If the deflection ratio is larger than L/10000, then L/10000 will be reported.
If you are checking a hand calculation for in plane deflections, be sure to include the deflection
due to shear and consider the cracked moment of inertia.
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Wall Section Properties

This section reports the properties used to calculate the wall capacities. The reinforcement details (minimums and
provided area) are reported.

Slender Wall Considerations (P-Little Delta)

ACI 318-14 Section 6.6.4.5 (ACI 318-11 Section 10.10.6) considers moment magnification of non-sway frames. This
is essentially the P-little delta effect in the form of an amplified moment due to the effects of element curvature, Mc.
This moment replaces the actual demand moment in design checks. For more information on this see the Concrete
Wall - Design topic.
Note:
l

l

l

750

Mact is the actual demand moment in the wall from analysis. The program compares this to the M2min
moment and uses the maximum as the M2 moment.
Since the moment can be different positive or negative for out of plane bending, the program will provide an
Interior and Exterior calculation in this case.
If the controlling load combination experiences tension, the Mc results will be suppressed and show N/A
because tension would actually reduce the amplified moment.
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Interaction Diagrams

The program uses a concrete solver to create the interaction diagram and uses this diagram to calculate the
capacity of each wall region based on the demand axial force and moment. The program then computes the code
check based on making a straight line through the origin, the moment/axial force demand location and where that
line crosses the interaction diagram curve.

Cross Section Detailing
In Plane

Out of Plane
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The last section of the detail report consists of a graphic cross-sectional view of the wall. This view gives cover
dimensions, reinforcement size and spacing, and the wall thickness for placement verification.

Concrete Lintel Report
Lintels - Criteria / Materials / Geometry
The right section of the detail report echoes back the basic input parameters (Criteria, Materials, Geometry) entered
by the user. An example is shown below:

Since the lintel is not being designed, much of this information is not used but is displayed for reference.

752

RISA-3D V20

Concrete Wall Results

Information
Valid Region
Total Height
Total Length
Thickness
Other Information

Description
This is the region that the forces are being considered over. The program will sum
forces of the region directly above the opening and the forces given in the detail
report come from this portion of the wall.
This is the height of the region above the opening that forces are being reported
for.
This is the width of the opening that the lintel is spanning.
This is the thickness of the wall.
All of the other information is general information for the overall wall.

Lintel Detail Reports - Diagrams
The left section of the detail report provides the enveloped axial, shear and moment diagrams over the length of the
lintel. These can be viewed for both in and out of plane forces and are the "beam" forces for the lintel.
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Concrete Wall - Seismic Design
Concrete walls can now be designed for seismic design provisions. Here the process is described.

Note:
l

ACI 318-19 and ACI 318-14 are the supported codes for this feature and all code references given in this
topic are specific to these codes.

Seismic Design Rules

Label
The label is the name for the Wall Seismic Design Rule that is called out for a wall panel.

Wall Type
These are the three wall types supported in RISA-3D.

Ordinary
This option adds no extra checks to the wall on top of the regular code checks for a non-seismic consideration per
section 18.2.1.6(b). The provisions required to be met are elements not considered in the RISA-3D analysis/design.

Intermediate Precast
This option has provisions specific to wall piers per section 18.5. This Wall Type assumes Seismic Design category
D, E or F.

Special
This option has provisions specific to section 18.10.

Shear Force Amplification in ACI 318-19
ACI 318-19 Section 18.10.3.1 requires the special concrete wall to consider the design shear force amplification per
Equation (18.10.3.1). RISA calculates the amplification factors Ωv and ωv automatically based on the code
provisions. The governing Ωv and ωv values are provided in the wall panel/region Detail Report. These
amplification factors are used to calculate the seismic design force Ve. Note that the combined amplification factors
shall not exceed 3.0 per Equation (18.10.3.1).
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Ωv is calculated per Table 18.10.3.1.2. RISA assumes the lowermost wall panel/region base to be the critical section.
In the table, the hwcs refers to the height of the entire structural wall, and lw is the width of a wall panel/region.
Mpr is the moment capacity calculated assume steel yield stress is 1.25*fy. The governing combination of Mpr/Mu
will be used to calculate Ωv factor. For the wall panel/region at critical section, Mpr and Mu values are reported in
the Region result of the Detail Report.

ωv is calculated per Equation (18.10.3.1.3), the number of story above the critical section ns is user-input
parameter in Global Model Setting-Seismic Tab:

Pier Design
Pier design is governed by section 18.10.8. Section 18.14 is not considered. This design consideration is applicable
to Intermediate Precast and Special shear wall types. To determine whether to perform pier checks we use the
pier dimensions from Table R18.10.1. Piers must have vertical edges that meet at a wall edge or opening.
The wall below has four piers.
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The program is checking the reinforcement in the piers based on Section 18.10.8.1, which references section 18.7.4,
18.7.5 and 18.7.6. If any of these cases gives a failure we will give red text in the detail report regarding this.
Specifically, the program checks:
l
l
l
l
l
l
l

l

Rho-min/rho-max per Section 18.7.4.1
Defining closed hoops per Section 18.7.5.2.a
Max spacing of vertical bars per Section 18.7.5.2.e
Cross ties required per Section 18.7.5.2.f
Max spacing of horizontal bars per Section 18.7.5.3
Rho-min horizontal per Section 18.7.5.4.
Wall pier shear checks per Section 18.7.6.1.1.
l V = 2*M
e
pr/Hp. Mpr is calculated using fye = 1.25*fy.
l If V < V , use V . Otherwise, use V .
u
e
e
u
If (Ve / Vu) > 0.5 and Pu < Ag*f’c/20 then Vc should be taken as zero per Section 18.7.6.2.1.

Coupling Beams
Coupling beam design is governed by section 18.10.7 and is applicable to the Special shear wall type.
Specifically the program checks:
l

l
l
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The program uses a threshold of L/H of 4. If L/H > 4 there will be no design and you must manually design
the coupling beam per Section 18.6. If L/H < 4 then the program will design the coupling beam using diagonal reinforcement.
Vn per equation 18.10.7.4.
Reinforcement checks per Section 18.10.7.4(d). Section 18.10.7.4(c) is not used because (d) is simpler.
l Reinforcement must be "Each Face".
l Outer bars must be "Horizontal".
l Rho-min as the max of (i) & (ii) per Section 18.10.7.4(d).
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Boundary Elements/Zones
Boundary zone checks are based only on section 18.10.6.3. The program performs a check of the maximum extreme
fiber compression stress for the worst-case earthquake load combination. If this value exceeds 0.2*f'c then a
boundary zone is required. The program will currently tell you if a boundary zone is required or not. It will not
design for the provisions of the boundary zone.

Reinforcement Limits for Regions
These checks are for regions that are outside of pier locations.
Specifically the program checks:
l
l
l
l
l
l

Rho-min Vertical and Horizontal per Section 18.10.2.1.
Vertical and Horizontal max spacing per Section 18.10.2.1.
Bar location based on H/L per Section 18.10.2.2.
Vn-max per Section 18.10.4.1 and 18.10.4.4.
Rho-min Vertical > Rho-min Horizontal based on H/L per Section 18.10.4.3.
Rho-max Vertical per Section 18.10.6.5a.

Design Spreadsheet Results
Wall Panel Seismic Detailing
Results for Seismic Detailing checks are provided in the Wall Panel Design spreadsheet - Concrete Seismic tab.
Results are provided per region, and the Seismic Detailing column provides a summary of the Seismic Detailing
checks. For a more detailed output, check the “Seismic Detailing” portion of the Wall Panel Detail Report.
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Coupling Beam/Wall Pier
This column determines whether the output is for a coupling beam or a wall pier.

Region/Pier
This column states the specific region and the associated pier or lintel.

UC Shear In-Plane
There is one main shear code check for either piers (per Section 18.7.6.1.1) or coupling beams (per equation
18.10.7.4). If the load combination that controlled the design used the overstrength seismic forces (meaning it had
an Ω factor in the load combination) then the governing load combination will be followed by an asterisk (*).

LC
The governing load combination.

BZ Required?
If No it means there are no boundary elements/zones required. If Yes then boundary elements/zones are required.

Reinforcing Spreadsheet Results
Wall Panel reinforcement is provided in the Concrete Reinforcing Spreadsheet - Concrete Wall tab. Results are
provided per region. For a more detailed output, check the “Wall Reinforcement” portion of the Wall Panel Detail
Report.
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Detail Report Results
Wall Summary Report
In this report the program gives a color-coded view of the piers and coupling beams in the wall. In the tables the
code checks and reinforcement is reported as well.
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Shear Details - Seismic Tab in ACI 318 - 19
When ACI 318-19 code is selected and special concrete shear walls are used in seismic analysis, a new Shear Details
- Seismic tab is added next to the regular Shear Details tab. In this tab, the governing Ωv value as well as Mpr, Mu
values are presented. The amplified shear demand will be used to calculate the new UC values.
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Please note that for each wall panel group (a group of seismic concrete shear walls stacked on each other to resist
seismic load), the governing Ωv value is used for all panels in this group. There may be multiple wall panels/regions
at the critical location which produces different Ωv values, the program only reports the governing Ωv, Mpr, and Mu
values in the detailed reports of each wall panel/region.

Wall Summary Report
In this report the program gives a color-coded view of the piers and coupling beams in the wall. In the tables the
code checks and reinforcement is reported as well.

Pier Report
In the pier report the program performs a shear code check and gives results for the reinforcement limits required.
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Coupling Beam Report
In the coupling beam report the program defines the shear check based on the diagonal bars and gives overall wall
reinforcement checks.
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Masonry Wall Panel - Modeling
The masonry wall panel element allows you to easily model, analyze and design masonry walls for in plane and out
of plane loads. Here we will explain the masonry specific inputs and procedures for modeling. For general wall
panel information, see the Wall Panels topic. For information on masonry design rules, see the Masonry Wall Design Rules (this is where you can define block thickness and self-weight). For masonry calculation considerations
and code references, see the Masonry Wall - Design topic. For masonry wall results interpretation, see the Masonry
Wall Results topic.

Note:
l

All code references in this topic refer to the TMS 402-16 specification unless noted otherwise.

Masonry Wall Input
The Wall Panel Editor gives some specific information and options for modeling/analysis of masonry walls.

Masonry View Controls
Masonry Wall Panels will have the following view controls:

Toggle Region Display allows you to turn the display of regions on or off.

Toggle Lintel Display allows you to turn the display of lintels on or off.
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Toggle Out of Plane Reinforcement allows you to turn the display of out of plane reinforcement on or
off after you have solved your model.

Toggle In Plane Reinforcement allows you to turn the display of in plane reinforcement on or off after
you have solved your model.

Creating Openings in Masonry with Lintels

Within the Wall Panel Editor, you have the option of adding rectangular openings to masonry wall panels. To draw
an opening, select the Openings button and then select two nodes or grid intersections which make up the two
diagonal corners of your opening. When an opening is drawn a lintel is automatically created above the opening. To
view or edit the properties of a masonry lintel, double-click inside the boundary of the drawn opening. This will
bring up the Editing Properties window for that particular lintel.
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This window will show the design options set in the Wall Design Rules - Lintel spreadsheet to design/analyze your
lintel. If you have multiple lintels in a wall and want a specific design that differs from the other lintels, then you
can double click the lintel then select "Convert to Custom...". When using the custom option, the program will now
use all of the information set in the Lintel Editor and will disregard any information given by the design rule.
Here we will walk through the different input options available for designing/analyzing lintels:
Depth - This is the depth of your lintel.
Bearing Distance - This is the bearing length at either end of the lintel. This is used to calculate the effective length
of the lintel.
Bar Size - This is the reinforcement size you wish to use for your main reinforcing in the lintel.
Bars Per Layer - This is the number of bars you wish to have in a given layer of reinforcement. There is also an
option to have the this value optimized based on geometry of the section and also the number of layers that you
have defined.
Number of Rebar Layers - This is an option if you need multiple layers of reinforcement in the lintel.
c/c Spacing of Layers - This is the distance between layers (if there is more than one).
CL Rebar to Lintel Bot - This value is used to calculate the "d" value for the lintel.
Stirrup Size - This is the size of stirrup that will be added to the lintel if required.
Note:
l

When inputting bar sizes for your lintels, the program will not allow you to place reinforcement that will not
actually fit into the lintel because of width constraints. We use the actual dimensions of the block, the faceshell thickness for the given block chosen and use a 1/2" clear cover between reinforcement and the block
per section 6.1.3.5.

Masonry Regions
Within the Wall Panel Editor, you have the option of creating rectangular regions within the masonry wall panel.
Regions are used to define reinforcement in different parts of the wall. Each region will be assigned a uniform
reinforcement, which may be different than the reinforcement in other parts of the same wall.
If no regions have been drawn on a wall then they will be automatically generated when a solution is performed. To
automatically generate regions prior to running a solution, click the Automatic Wall Regions button
To manually draw regions, select the Manual Wall Regions
button and use your cursor to select two nodes
or grid intersections which make up the diagonal corners of the region. To exit this tool right-click your mouse.
To view or edit the properties of a masonry region, double-click inside the boundary of the drawn region. This will
bring up the Review or Change Wall Design Rule dialog for that particular region.
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You can choose to edit/view the existing wall design rule, or create a new wall design rule. The information is
populated from the Wall Design Rules spreadsheet for masonry. For more information see the Masonry Wall Design Rules spreadsheet on setting this up.

For masonry wall panel regions, you can also customize regions which will make it different than the Wall Design
Rule. To use a custom design region, select Convert to Custom Design Region. When using the custom option, the
program will now use all of the information set in the Region Editor and will disregard any information given by the
design rule for that region.
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Note:
l

For models created with version 9.1.1 or earlier ALL regions will come in set to Custom, bringing over the
information exactly as it comes from the existing model. For all newly created models in version 10 or later
the regions will default to the wall design rule.

Within this dialog you can specify the properties which will be used for the design of the region. The program can
optimize the bar spacing and the boundary zone width based on code checks. The block size, reinforcing strength
and the method of self-weight calculation are defined in the Design Rules under the Masonry Wall tab.
Note:
The program designs regions separately for out-of-plane and in-plane forces, thus the Region Editor is divided into
different parts.
Here we will walk through the different input options available for designing/analyzing regions:
Transfer - This is an option as to whether or not you want this region to transfer Out of Plane and In Plane Loads.
If you check these transfer options, the program will dump those loads above and below an opening into the
adjacent regions for design.
Note:
l

l

These transfer options are only available when you have defined a region above or below an
opening.
If you do not choose to check these transfer options you will see design results for regions
above and below openings.

Axial - Allows you to define properties of a region based on axial forces.
l

l
l

l

Block Grouting - Allows you to define how you want your wall grouted. If you choose "Partially Grouted"
the program will optimize the grout spacing with the Bar/Grout Spacing
Reinforced - Gives the option of designing the wall as reinforced or unreinforced.
Bar/Grout Spacing - This allows you to define the bar/grout spacing. If you have the "Optimize" box
checked, the program will optimize the reinforcement spacing based on code checks.
Vert Bar Size - This is the main vertical bar size that will be used in design.
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l

l

Location - This defines how you want to lay out the reinforcement in your region. Each Face will put reinforcement on both faces of a given cell. Staggered alternates the bars to either face of wall region.
Note:
l When using the staggered option you are selecting to space the bars at each face at double the bar/grout spacing defined above. For example, if you have a staggered spacing at 24" oc you have a bar on
the outside face at 48" oc and a bar on the inside face at 48" oc. These bars are staggered, thus you
have grout filled cores at 24" oc.

In-Plane Reinforcement - Allows you to define properties of a region based on in-plane forces.
l
l
l

l

l

Vertical Bar Size - Allows you to define vertical bar size for the boundary zones.
Bars Per Cell - Allows you to define one or two bars per cell.
Boundary Zone Width - The user must define a boundary zone width but RISA will optimize the width if
the "Optimize" box is checked.
l Note: If you have the optimize checkbox selected, the program will optimize the boundary zone width
based on code checks.
Horizontal Bar Size - Allows you to define horizontal bar size to be used if horizontal reinforcing is
required.
1.5x Shear Increase - This is an option that may be required in high seismic zones. This option is available
per section 7.3.2.6.1.2.

Merge Lintels
When an opening is drawn in a masonry wall panel, you will notice that a lintel beam region is automatically
created above the opening. If you have multiple openings, you may want to merge the individual lintels into one. To

do this, select the Merge Lintels
button. If you have two lintels you want to merge, then click within each of
the openings to merge them into one. If you have multiple lintels that you want to merge, click inside of the two
openings that define the ends of the merged lintel that you want. You will see that this merges your multiple
openings into one. To exit out of this tool right-click your mouse.
When merging lintels, the top edges of the lintels have to be identical. If, once you have merged lintels, you delete
one of the openings the entire lintel will be deleted. At that point, you have to delete any openings left in the wall
that don't have a lintel over them.

Masonry Wall Optimization
The program will optimize masonry walls and lintels based on the required demand forces. The program can
optimize:
l
l
l
l

Vertical bar/grout spacing for out of plane design.
Boundary zone widths for in plane flexural design.
Horizontal bar spacing for in plane shear design.
Reinforcement bars for lintel flexural design.

Of these optimizations, the only one that substantially modifies the stiffness of the wall is the vertical bar/grout
spacing. To properly adjust the stiffness requires an iterative solution that updates the stiffness of the model. This
includes updating the strength properties of the wall as well as the stiffness. This optimization/iteration can be
done automatically (by checking the box) or can be done manually (by unchecking the box) in the Model Settings Solution tab.
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To update the stiffness portion of the wall, the program must re-solve your model with these updated stiffnesses as
this will change the distribution of forces through the model. By checking the boxyou are telling the program to resolve automatically. Thus, the program will start with it's initial stiffness parameters and solve the model. It will
then optimize the wall to meet strength criteria. Another solution will then be run with the new stiffnesses and the
program will again optimize the wall to meet strength criteria. This procedure will continue to occur until you reach
the number of Iterations set or until all wall panel results match those of the previous solution.
By unchecking the box the program will only run the solution once and the results will be based on the original
configuration. You can then manually optimize your walls using the Suggested Design spreadsheet.
After the solution is run (with or without optimization) the design results are based on the stiffness used in the last
iteration (by unchecking the box a single iteration is run). The program will then compare the design of the last
iteration with the stiffness used in that last iteration. If the two are the same, the results shown are the final results.
If the two are not the same, the program will then provide these two different results in the Suggested Design
spreadsheet.
The program will always present results in the output that coincide with the stiffness used in the final solution.
Note:
l

The updating of the stiffness for the model is only required for the vertical bar/grout. Thus, boundary zone
widths, horizontal shear reinforcement and lintel reinforcement are optimized automatically.

General Reference Manual

769

Masonry Wall Panel - Modeling

Suggested Design

In the Suggested Design spreadsheet you will get a list of wall panels in your model that are not yet fully
optimized, showing the vertical bar and/or grout spacing of the last iteration (Current Spacing) and the program
optimized spacing (Suggested Spacing). From here you have the ability to Use Suggested? which means that you
want to re-run the solution with the Suggested Spacing. You can choose this for each wall panel individually. Once

you have these checkboxes checked appropriately, press the
button. After this, the stiffness matrix is reformulated and may cause some redistribution of loads through the model. Because of this, the Suggested Spacing
may also update and you may need to Use Suggested? multiple times to converge on a solution.
Note:
l

l
l
l

If the wall does not show up in the Suggested Design spreadsheet, then the current wall panel settings used
are the optimal ones.
For more information on wood wall optimization see the Wood Wall - Design topic.
For more information on member optimization see the Design Optimization topic.
Concrete walls do not show up here because the reinforcement optimization does not affect the stiffness of
the wall.

Lintels
For masonry lintels you must input the dimensions, bar size and number of layers of bars for the lintel, but are
given the option of optimizing how many bars are in a given layer. If you provide a max/min number of bars in the
Wall Design Rules - Masonry Lintel tab then the program will optimize the number of bars in a layer. Because this is
just a change in reinforcement, this is an automatic optimization that does not require an iterative solution.

Lintel Reinforcement Placement Check
The program will do a check to see that the reinforcement in the lintel will fit properly. The available width for
reinforcing in the lintel is based on the width of block, thickness of grout between the block and the reinforcement,
and it assumes there will be a double-leg stirrup.

where
l
l

tgrout = 0.5 in (per Section 6.1.3.5 of ACI 530-13; the program assumes coarse grout)
dbstirrup = diameter of stirrup (from the Wall Design Rules - Masonry Lintel tab)

Note that we use a minimum bar spacing equal to the minimum of either db or 1".
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Regions
For masonry regions, there are two options for optimizing. For out of plane design, the program will optimize the
spacing of bars for strength (not deflection) considerations of the wall. For in-plane design, the boundary zone
width will be optimized for strength as well. The spacing of reinforcement/grouting affects the overall stiffness of
the wall thus you must iterate your solution to update this spacing. The boundary zone design affects the overall
stiffness very little, thus this is an automatic optimization that does not require an iterative solution. If you provide
a min/max boundary zone width in the Wall Design Rules - Masonry In tab, then the program will optimize the
boundary zone width.

Limitations
l
l

l

l

Openings and regions must be input only in RISAFloor if you are using RISA-3D and RISAFloor in tandem.
For sloped walls due to sloping floors, openings and regions can not be defined in the upper triangular area
of the wall panel. These openings are not supported at this time. This will be addressed in a future version.
For areas of masonry wall panels that are not defined as a region, the stiffness of the wall is assumed to be
that of an ungrouted masonry wall and the weight of the wall is assumed to be that of a fully grouted wall.
Masonry has specific requirements regarding the spreading out of concentrated loads at certain angles and
for certain depths (Section 5.1.3). These provisions are not considered in RISA, as the finite element mesh
stiffness is what determines load path. See the Wall Panels - Load Attribution topic for more information.
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Masonry Wall Panel - Design
The masonry wall panel element allows you to easily model, analyze and design masonry walls for in plane and out
of plane loads for these specific codes:
l
l
l

The 2016 TMS 402 ASD and 2013, 2011, 2008, 2005, 2002 and 1999 Editions of ACI 530 ASD
The 2016 TMS 402 Strength and 2013, 2011, 2008, 2005, 2002 and 1999 Editions of ACI 530 Strength
The 1997 edition of the UBC for ASD and Strength

Here we will explain the calculation concepts and code references used in the program. For general wall panel
information, see the Wall Panels topic. For information on masonry design rules, see the Masonry Wall - Design
Rules (this is where you can define block thickness and self-weight). For masonry wall modeling procedures, see the
Masonry Wall - Modeling topic. For masonry wall results interpretation, see the Masonry Wall Results topic.

Note:
l
l

l

All code references in this topic refer to the TMS 402-16 specification unless noted otherwise.
References will be made to RMEH and NCMA. For more information on these designations, see the Masonry
Wall - Design Rules topic.
Walls designed in RISA meet all of the requirements for Ordinary Masonry Shear Walls except for the Minimum Reinforcement requirements of TMS 402-16 Section 7.3.2.3.1. That provision should be checked by
hand outside of RISA.

Shear Design - In Plane ASD
In Plane Shear Stress, fv
This stress is calculated from Equation 8-24:

where:
l
l

V = Total in plane shear in the wall region
Anv = net shear area

In RISA Anv is defined as follows:

where:
l
l
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dinplane = distance from compression face to centroid of boundary zone
Eqsolidthickness = value from RMEH textbook which represents the "average" thickness of wall considering
block voids.
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Note:
l

If the 1.5x Shear Inc checkbox is checked in the Masonry Wall - Design Rules, then fv is factored up by a 1.5
factor. This option is available per section 7.3.2.6.1.2.

In Plane Shear Capacity, Fv
The program calculates the capacity, Fv, from Equation 8-22:

The program also checks to verify we do not exceed the Fv max value from Equations 8-23 and 8-24 (or
interpolation between them) that is reported in the detail report.
Fvs is only required if fv > Fvm. If fv < Fvm, then the program will not add any shear reinforcement and Fvs = 0. If
Fvs is required, then the program will back calculate a spacing, s, that will satisfy the steel shear capacity required.
This shear spacing is reported in the detail report.
When shear reinforcement is required the program will also meet the d/2 or 48" spacing required by 8.3.5.2.1. If Fv
max must be exceeded to pass the code check, the program will use Fv max as the capacity and state "Over
Allowable" for the Shear Steel Spacing.

Note:
l
l

The program does not do explicit seismic design, thus Equation 8-25 is not used.
The M in the Fvm equation above is taken as the maximum moment in the region instead of the moment at
the location where the shear is maximum.

Shear Design - Out of Plane ASD
Out of Plane Shear Stress, fv
This stress is calculated from Equation 8-21:
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Out of Plane Shear Capacity, Fv
The program calculates the capacity, Fv, from Equation 8-25 shown above, except that only the Fvm term is
considered. There is no way to add shear reinforcing steel.
The program also checks to verify we do not exceed the Fv max value from Equations 8-26 and 8-27 (or
interpolation between them) that is reported in the detail report.

Axial Design - ASD
In and Out of Plane Axial Stress, fa
The axial stress in a wall due to axial forces, fa, is calculated as:

This is applicable for all out of plane and in-plane masonry calculations. When fa < fb then the masonry has cracked
and then a cracked section analysis is performed. See the Bending Design - ASD section below for more information
on this procedure.

Note:
l
l

The program does not design masonry for net tension forces. fa will equal 0 ksi in these cases.
In and out of plane stress, fa will be the same. However, the location where these forces are reported may be
different. In plane forces will generally be reported at the base of a wall. Out of plane forces may be reported
at the base (cantilevered walls) or at midheight (simply supported walls).

In and Out of Plane Axial Capacity, Fa
The calculation of Fa is per either Equation 8-13 or 8-14, depending on the h/r ratio. These equations match
Equations 8-18 and 8-19 if you assume Ast = 0. RISA conservatively uses only the masonry in calculating the
compression capacity. The equations are as follows:

where:
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l
l

r is taken from the UBC-97 Table 21-H-1 (concrete masonry units) and Table 21-H-2 (clay masonry units).
h = effective height of wall region = K*hactual

Note:
l

The program does not design masonry for net tension forces. If there is net tension, Fa will still equal the
compressive capacity of masonry.

Bending Design - ASD
In Plane Stresses fb and fs
These calculations are different depending on a cracked section or uncracked section. The wall is considered
uncracked if fa (compression) > fb. The wall is considered cracked if fa (compression) < fb.
For uncracked masonry, the calculations are as follows:

where:
l

d = Total length of wall

Because the masonry is uncracked, no stress can develop in the steel.
For cracked masonry, the program performs an iterative analysis to determine the section properties of the
cracked wall.
The maximum masonry stress (fm) is obtained by solving the moment equilibrium equation as a quadratic equation
of kd. This equation comes from vertical equilibrium ( C - P - T = 0 ).
Here is a representative wall with axial force and moment:
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From this image we do a summation of moments about point T and come up with a quadratic equation in terms of
kd.

An assumption is made for fm = fa + fb, where fa = P/A and fb = M/S. From this C and T is determined. Once we
calculate a value for T we can then define the boundary zone steel required. The final solution is determined
through iteration. Each iteration of the steel area is based on the amount of steel needed to create a 0.005 ksi
difference in the calculated bending stress (fb) and is carried out until the calculated value of required
reinforcement is less than the reinforcement provided.
The final values are given in the detail report:
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A good reference for this iterative procedure is Section 7.10.1 of Design of Reinforced Masonry Structures,
copyright 2001 by Narendra Taly and published by McGraw-Hill.
From this analysis fm is calculated. This must then be broken down into fa and fb for the detail report. Because
Section 8.3.4.2.2 states:

the proportion is simplified. RISA will simply take fa = P/An for fa and the remaining value from fm is used as fb.
From the tension force in the wall, T, the program calculates the required number of boundary zone bars and places
them in the wall. The reported code check is then based on:

Out of Plane Stresses fb and fs
The masonry bending stresses are referenced in UBC Section 2107.2.15 and are as follows:

However, if you are using a partially grouted wall where the neutral axis passes through the webs of your masonry,
then RISA will do a T-section analysis to define the section properties. We use a similar analysis as if you were
doing a t-beam analysis for a concrete tee section. For more information on this, see "Design of Reinforced Masonry
Structures" by Narendra Taly, copyright 2001, example 6.3, P6.61.
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The area in red is shown as the compression block in the image above.

In and Out of Plane Masonry Bending Capacity, Fb
For unreinforced masonry, the Equation 8-15 is:

For reinforced masonry, Section 8.3.4.2.2 states:

Because of this provision, RISA defines:

In and Out of Plane Steel Capacity, Fs
Section 8.3.3.1 defines the allowable steel stress, Fs.

In Plane Design - Strength
In Plane Axial Strength, Pn
This is calculated from Equations 9-15 and 9-16:

Note:
l

l
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Keep in mind that An is calculated differently for NCMA vs RMEH. See the Masonry Wall - Design Rules topic
for more information.
h = effective height of wall region = K*hactual
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In Plane Moment Strength, Mn
The Mn value is based on the axial - moment interaction diagram for the wall based on strain compatibility at
different levels of axial force. Once the interaction diagram is created the Mu is plotted and the code check is then
calculated.

Note:
l

In plane moment strength is solely accounted for by boundary zone steel. We do not use every bar in the
wall and calculate the steel stress per bar. The "d" used for in plane design is from the extreme compression
fiber to the centroid of reinforcement in the boundary zone. For a reference on this, see "Masonry Structures
Behavior and Design" by Drysdale, Hamid, and Baker, copyright 1999.

For a wall with no axial force, the Mn can be calculated from the equation:

Note:
l

The maximum usable masonry strain at the extreme compression fiber, emu, is assumed to be 0.0025. For
assumptions of the extreme compression fiber for Seismic Detailing checks of Masonry Walls, refer to the
Maximum Area of Flexural Tensile Reinforcement (Max. Flexural Rho Check - Strength) section.

In Plane Shear Strength, Vn
The program calculates the capacity, Vn, from Equation 9-17:
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The program also checks to verify the Vn max value from Equations 9-18 and 9-19 (or interpolation between them)
that is reported in the detail report is not exceeded.
Vns is only required if Vu > Phi*Vnm. If Vu < Phi*Vnm, then the program will not add any shear reinforcement
and Vns = 0. If Vns is required, then the program will back calculate a spacing, s, that will both satisfy the steel
shear capacity required and satisfy the maximum reinforcement spacing . This shear spacing is reported in the
detail report.
If Vn max must be exceeded to pass the code check, the program will use Vn max as the capacity (so the wall fails
in shear) and state "Over Allowable" for the Shear Steel Spacing.

Note:
l

The M in the Vnm equation above is taken as the maximum moment in the region instead of the moment at
the location where the shear is maximum. This is generally a conservative assumption.

Out of Plane Design - Strength
Out of Plane Axial Strength, Pn at max Mom
Here there are two different possible calculations.
If there is out-of-plane moment on the walls this is calculated from Section 9.3.5.4.2 as follows:
l

If h/t < 30, Pn at max Mom = 0.20*f'm*An

l

If h/t > 30, Pn at max Mom = 0.05*f'm*An

If there is no out-of-plane moment this is calculated from Equations 9-15 and 9-16:

Note:
l
l
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t from the above equations is taken as the Block Nominal Thickness.
h = effective height of wall region = K*hactual
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Out of Plane Moment Strength, Mn
This calculation comes from the Commentary of Section 9.3.5.2 as follows:

The program is actually using an interaction diagram for out of plane bending as well. However, the code places a
limit on axial force from Section 9.3.5.4.2. This limit essentially means that only the lower portion of the interaction
diagram will be used. In this lower portion of the interaction diagram, the bending capacity changes in a linear
fashion with respect to axial force.

Thus, the equation above is nearly identical to the value that the program's interaction diagram will produce.

Note:
l
l

In the case of high axial tension, it is possible that moment capacity will near zero.
In partially grouted walls an effective width is calculated for b from Section 5.1.2

Out of Plane (Slender) Moment Demand, Mu
The out of plane demand moment, Mu, comes from the finite element analysis only. Equation 9-23 gives a formula
for calculating the midheight moment due to out of plane loading, axial eccentric loading, and P-Little Delta effects.
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In RISA the first two portions can be captured by modeling the loads accordingly. Eccentric axial loading would
need to be modeled with both a vertical load and a moment. The P-Delta analysis that RISA uses during the Finite
Element solution does not account for P-Delta effects on plate elements or wall panels themselves. Instead the
program captures P-Little Delta effects from the iterative procedure shown in the Moment and Deflection
Amplification section below. This is very similar to that provided in the UBC and MSJC slender wall design
provisions.

Out of Plane (Slender) Deflection, δs
Out of plane deflections are calculated based on the Wall's Finite Element Analysis using a modified thickness, tmod,
for the wall plates. The modified thickness is calculated using the wall panel's out of plate cracked moment of
inertia, Icr, which can be input in the Advanced tab of the Wall Panels spreadsheet.

Note:
l

The original thickness of the wall panel is the actual thickness of the wall panel, not to be confused with the
nominal thickness.

RISA-3D then uses Finite Element Analysis using the modified thickness of the plates to calculate the out of plane
deflection of the wall.

Unreinforced Masonry Design - ASD
Out of Plane Bending and Axial Design - ASD
For out of plane design for axial and bending the program performs 3 checks: a compression check, a tension check,
and a slenderness check.

Compression Check (per Equation 8-11)

where:
l
l
l

fa and Fa are computed the same way as for reinforced masonry.
fb = M/S. S = Sx value from NCMA TEK 141B (regardless of Wall Area Method designation).
Fb = 1/3*f'm per Equation 8-15

Tension Check (per Section 8.2.4.2)

where:
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l

Fbt = Allowable flexural tensile stress per Table 8.2.4.2

Slenderness Check (per Equation 8-12)

where:

l
l
l
l

Per Equation 8-16.
I comes directly from NCMA TEK 141B for both Wall Area Methods, NCMA and RMEH.
e is always assumed equal to 0.
h = effective height of wall region = K*hactual

Note:
l

If using an Unreinforced wall the program will ALWAYS use an ungrouted wall for design, regardless of
what is set in the masonry wall design rules.

Out of Plane Shear Design - ASD
This stress is calculated from Equation 8-21:

Note:
l

We do not use Equation 8-17 to calculate shear stress.

The program calculates the capacity, Fv, from Equation 8-22 shown above, except that only the Fvm term is
considered. There is no way to add shear reinforcing steel.
The program also checks to verify we do not exceed the Fv max value from Equations 8-23 and 8-24 (or
interpolation between them) that is reported in the detail report.

In Plane Bending and Axial Design - ASD
For unreinforced masonry we use the same design provisions from reinforced masonry. Thus, we still use
reinforcement for both the boundary zones and shear reinforcement (if needed). See the reinforced sections for
more information on this design.

Note:
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l

Because this type of design is very uncommon it is not currently available.

In Plane Shear Design - ASD
The in plane shear stress, fv, is calculated as follows:

The in-plane shear stress capacity, Fv, is calculated from Section 8.2.6.2. Because we do not know whether the wall
is in running bond or not we omit options (c), (d), (e) and (f).

Unreinforced Masonry Design - Strength
Out of Plane Bending and Axial Design - Strength
For unreinforced masonry we perform the axial check per Section 9.3.5. For bending the program does not give
results.

Note:
l

Because this type of design is very uncommon it is not currently available.

In Plane Bending, Axial, and Shear Design - Strength
For unreinforced masonry we use the same design provisions from reinforced masonry. Thus, we still use
reinforcement for both the boundary zones and shear reinforcement (if needed). See the reinforced sections for
more information on this design.

Note:
l

Because this type of design is very uncommon it is not currently available.

Masonry Lintel Design - ASD
Here we will talk about specific calculations regarding lintel design for allowable stress design.

Note:
l

There is no lintel design for unreinforced lintels. Regardless of whether you design the wall as reinforced or
unreinforced, all lintel design will use reinforcement. Because unreinforced lintels are very uncommon it is
not currently available.

Shear Stress, fv
This stress is calculated from Equation 8-21:

where:
l
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d = distance from extreme compression fiber in top of lintel to the centroid of reinforcement.
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Shear Capacity, Fv
The program calculates the capacity, Fv, from Equation 8-25, which is shown in the previous In Plane Shear
Capacity Fv section.
The program also checks to verify we do not exceed the Fv max value from Equations 8-23 and 8-24 (or
interpolation between them) that is reported in the detail report.
Fvs is only required if fv > Fvm. If fv < Fvm, then the program will not add any shear reinforcement and Fvs = 0. If
Fvs is required, then the program will back calculate a spacing, s, that will satisfy the steel shear capacity required.
This shear spacing is reported in the detail report.
When shear reinforcement is required the program will also meet the d/2 or 48" spacing required by 8.3.5.2.1. If Fv
max must be exceeded to pass the code check, the program will use Fv max as the capacity and state "Over
Allowable" for the Shear Steel Spacing.

Note:
l
l

l

The program does not do explicit seismic design, thus Equation 8-25 is not used.
The M in the Fvm equation above is taken as the maximum moment in the region instead of the moment at
the location where the shear is maximum. This is generally a conservative assumption.
The detail report shows a stirrup with two legs. However, the program only considers one leg in the Av calculation.

Bond Stress, u, and Bond Capacity U
The bond stress check is one that has been grandfathered in from the UBC-1997 specification section 2107.2.16 and
is defined previously in the In Plane Bond Stress u section. Σo is the summation of the circumference of all vertical
bars.
The bond stress capacity was defined previously in the Bond Stress Capacity U section.

Stresses fb and fs
The masonry bending stresses were defined previously in the Out of Plane Stresses fb and fs section.

Bending Capacity, Fm (Fb) and Steel Capacity, Fs
Section 8.3.4.2.2 states:

Section 8.3.3.1 defines the allowable steel stress, Fs.

Masonry Lintel Design - Strength
Here we will talk about specific calculations regarding lintel design for strength design.

Note:
l

There is no lintel design for unreinforced lintels. Regardless of whether you design the wall as reinforced or
unreinforced, all lintel design will use reinforcement. Because unreinforced lintels are very uncommon it is
not currently available.

Shear Strength, Vn
The program calculates the capacity, Vn, total from Equation 9-17, which was shown previously in the In Plane
Shear Strength Vn section.
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The program also checks to verify the Vn max value from Equations 9-18 and 9-19 (or interpolation between them)
that is reported in the detail report is not exceeded.
Vn,steel is only required if Vu > Phi*Vn,masonry. If Vu < Phi*Vn,masonry, then the program will not add any
shear reinforcement and Vn,steel = 0. If Vn,steel is required, then the program will back calculate a spacing, s, that
will satisfy the steel shear capacity required. This shear spacing is reported in the detail report.
If Vn max must be exceeded to pass the code check, the program will use Vn max as the capacity (so the wall fails
in shear) and state "Over Allowable" for the Shear Steel Spacing.

Note:
l

The M in the Vnm equation above is taken as the maximum moment in the region instead of the moment at
the location where the shear is maximum. This is generally a conservative assumption.

Moment Strength, Mn
Lintel design in RISA does not account for axial force, thus Mn is calculated simply from:

Here are the calculations of other values reported in the detail report:
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Masonry Wall - Design Rules
The masonry wall panel element allows you to easily model, analyze and design masonry walls for in plane and out
of plane loads. In this section, we will explain the masonry specific inputs and design considerations. For general
wall panel information, see the Wall Panels topic. For masonry wall modeling procedures, see the Masonry Wall Modeling topic. For masonry calculation considerations and code references, see the Masonry Wall - Design topic.
For masonry wall results interpretation, see the Masonry Wall Results topic.

Note:
l

All code references in this topic refer to the TMS 402-16 specification unless noted otherwise.

Unity Check

Setting a maximum Bending Check (Axial & Bending) or a maximum Shear Check controls the rebar which the
program chooses for the wall design. A value of 1.0 denotes that the program may choose a rebar layout that is at
100% of capacity.
Note:
l

For the Max Shear Check for in plane design, the program will only optimize the spacing of reinforcement.
It will not optimize the grout spacing. If you want to adjust grout spacing, review the Masonry Out tab.

Masonry Wall General
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Block Nominal Width
This is the nominal thickness of masonry walls. The program will subtract 3/8" from this value to get the actual
thickness. This value is used, along with the value of grout / bar spacing, to determine the effective thickness of the
wall. The effective thickness is based on table B3 of the Reinforced Masonry Engineering Handbook, by Amrhein,
Copyright 1998.

Block Grouting
This option defines how the wall is grouted. If "Partially Grouted" is chosen, then the spacing of grout will be based
on the bar spacing defined on the Masonry Out tab.

Reinforced
This defines whether the wall is reinforced or not.

Wall Area Method
This option defines where the wall area is taken from. The NCMA option pulls the "An" value from the NCMA
TEK 141B document. The RMEH option pulls the "Equivalent Solid Thickness" value from Table B-3a and B-3b from
the Reinforced Masonry Engineering Handbook, James Amrhein, 5th edition copyright 1998.
In doing research on these two methods of calculating the area for a masonry wall, the two methods produce very
different results. The NCMA values assume face-shell mortar bedding and web bedding around grout-filled cells.
The RMEH values assume full mortar bedding (both face-shells and all webs). The Amrhein values also appear to
average in the area of horizontal bond beams as well. This would make the area conservative for a self-weight
calculation, but unconservative for stress calculations. With these considerations in mind we are defaulting the
behavior to use NCMA by default.
See the Masonry Wall - Design topic for the specific calculations regarding NCMA or RMEH.

Note:
l

l
l
l

In version RISA-3D V10.0.1 and older the program used both methods in different circumstances. Now the
program is consistent with this usage.
If you open an existing model from RISA-3D V10.0.1 and older the program will default to the RMEH option.
If you start a model from scratch the program will default to the NCMA option.
For self-weight the program will ALWAYS use RMEH, as the presence of bond beams in the wall is realistic
and this is a conservative value.

Masonry Wall In Plane Design

Vert Bar Size
Allows you to define vertical bar size for the boundary zones.

788

RISA-3D V20

Masonry Wall - Design Rules

Bars Per Cell
Allows you to define one or two bars per cell in the boundary zones.

Min/Max Boundary Zone
Allows you to give a maximum and minimum boundary zone width. The program will then design the width based
on 8" increments (1/2 of a block length).

Horz Bar Size
Allows you to define horizontal bar size to be used if horizontal reinforcing is required.

1.5x Shear Inc
The 1.5x Shear Inc checkbox has been moved to the Seismic Design Rules spreadsheet in the Masonry Walls tab.
Please see Masonry Wall - Seismic Design.

Transfer Load
This option will transfer in plane loads from regions above and below openings into the regions adjacent to the
openings. Note that the design of regions above and below openings will be omitted.

Masonry Wall Out of Plane Design

Bar Size
This is the main vertical bar size that will be used for axial/out of plane design.

Bar Space Min/Max
This allows you to give a maximum and minimum bar/grout spacing. If you give a range between the max and min,
then the program will optimize the reinforcement spacing according to strength requirements (code checks).

Bar Placement
This defines how the reinforcement is placed in the wall region.
Center will put a single bar centered in a given cell.
Non-Center will put a single bar non-centered in a given cell.
Each Face will put reinforcement on both faces of a given cell.
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Staggered alternates the bars on either face along the length of the region.

Note:
l

When using the staggered option you are selecting to space the bars at each face at double the bar/grout spacing defined above. For example, if you have a staggered spacing at 24" oc you have a bar on the outside face
at 48" oc and a bar on the inside face at 48" oc. These bars are staggered, thus you have grout filled cores at
24" oc.

Cover
Allows you to specify the distance from the exterior of the masonry block to the extreme fiber of the reinforcement.
The default cover value is defined as Min. The Min input will use whichever governs between these two sections of
the specification:
l

l

Section 6.1.3.5 states a minimum distance between the inside of the face shell and the reinforcement . RISA is
conservative and always assumes this to be 1/2". Thus, the cover calculated in this fashion = tfaceshell + 1/2"
Section 6.1.4 requires a cover dimension = 1-1/2" or 2" depending on bar size and whether the masonry is
exposed to weather. In the program this is always assumed to be 1-1/2".

Thus, the Min term will create a cover equal to the maximum of tfaceshell + 1/2" OR 1-1/2".
For any other cover you wish to impose simply overwrite the Min value with your value. If using the Non-Center
option then the cover will always be from the +z local axis face of the wall.
For example, let's assume the wall shown below is using the "Non-Centered" reinforcement and the cover is set to
2.5". The image below shows exactly where this bar is then located in the wall (d = 7.625" - 2.5" - 3/8" = 4.75").

The actual "d" used in design will depend on the governing direction of loading. If load is applied in both out-ofplane directions to the wall then it is possible that a lower level of loading can produce a higher code check because
the "d" is smaller in one direction than the other.
If a non-sensical value is defined (i.e. one where the bar does not fall inside of the block core then the program will
give an error in the results and place the reinforcement just inside the faceshell of the block.

Note:
l

For the Center bar placement this field is ignored.

Mortar/Cement Types
Allows you to specify the type of mortar/cement in the wall. This affects the modulus of rupture (flexural tensile
stresses) from Tables 8.2.4.2 and 9.1.9.2.

Transfer Load
This option will transfer out of plane loads from regions above and below openings into the regions adjacent to the
openings. Note that the design of regions above and below openings will be omitted.
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Masonry Wall Lintel Design

Depth
This is the total depth of your lintel.

Bear Length
This is the bearing length at either end of the lintel. This is used to calculate the effective length of the lintel.

Bar Size
This is the reinforcement size for your main reinforcing in the lintel.

Min/Max # Bars Per Layer
This is the number of bars you wish to have in a given layer of reinforcement. If you give a range between the max
and min, then the program will optimize the reinforcement spacing based on geometry of the section and also the
number of layers that you have defined.

Num of Layers
This is an option if you require multiple layers of reinforcement in the lintel.

c/c Sp of Layers
This is the distance between layers (if there is more than one).

Dist to Bot
This defines the distance from the centerline of the lowest-most bar to the bottom fiber of the lintel.

Stirrup Size
This is the size of stirrup that will be added to the lintel if required.

Analysis Method
This is the lintel analysis method that will determine the design of the masonry lintel. The Simply Supported
analysis method will produce lintel reinforcement design results, which can be seen in the masonry lintel detail
report. The FEA analysis method will only display shear and moment diagrams in the detail report for the masonry
lintel based on the results of finite element analysis.
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Masonry Wall Results
Masonry wall results are presented in the wall results spreadsheets and the detail reports. Results are reported on a
region by region basis. In addition, the code checks for lintels spanning openings are reported separately.
For general wall panel information, see the Wall Panels topic. For information on masonry design rules, see the
Masonry Wall - Design Rules . For masonry wall modeling procedures, see the Masonry Wall - Modeling topic. For
masonry calculation considerations and code references, see the Masonry Wall - Design topic.

Note:
l

All code references in this topic refer to the TMS 402-16 specification unless noted otherwise.

Masonry Wall Spreadsheet Results
The information on this spreadsheet is present on three tabs that involve Masonry design: In plane, Out of Plane
and Lintel. Each tab gives code checks based on the chosen masonry code and can be used as a summary of all of
the panels and panel regions in your model. To get detailed information about each region, you can see the Wall
Panel Detail Report.

In Plane

The In-Plane results are intended to provide the code checks relevant to shear wall behavior for the wall.
For ASD codes the Combined UC entry gives the code check due to axial force plus in-plane bending. The Shear UC
will show the code check for shear effects. A value greater 1.0 for either of these values would indicate failure.
For Strength codes the Axial UC, Bending UC and Shear UC gives the individual code checks for each of these limit
states.
The Fa or Pn*Phi reports the allowable axial stress or axial capacity.
The Fb or Mn*Phi reports the calculated allowable bending or moment capacity for the region.
The Fv or Vn*Phi reports the calculated allowable shear stress or Shear Capacity for the region.
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Out of Plane

The Out-of-Plane results are intended to provide the code checks relevant to out of plane bending for the wall.
For ASD codes the Combined UC entry gives the code check due to axial force plus out of plane bending. A value
greater than 1.0 would indicate failure. Note that this value represents the maximum of the different combined
checks shown in the detail report ((fa+fb)/Fb, fa/Fa, and fs/Fs).
For Strength codes the Axial UC and Bending UC gives the individual code checks for each of these limit states.
The Fa or Pn*Phi reports the allowable axial stress or axial capacity.
The Fb or Mn*Phi reports the calculated allowable bending or moment capacity for the region.
The Fv reports the calculated allowable shear stress for the region.
For slender wall design additional checks and analyses are required. These are reported in the region's detail
report.

Masonry Lintels

The Masonry Lintel results give the results for the masonry lintels that span over user defined openings in the wall.
They can also be viewed by looking at the detail report associated with each opening.
The Bending UC entry gives the code check due pure flexure of the Lintel. Axial force is not considered in this code
check at all. The Shear UC gives the code check for shear. A value greater 1.0 for either of these values would
indicate failure.
The Fm and Fs or Mn*Phi reports the calculated allowable bending stress or moment capacity for the region.
The Fvm and Fvs or Vn*Phi reports the allowable shear stress or shear capacity.
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Concrete Reinforcing Spreadsheet Results
The last two tabs of this spreadsheet contain results for Masonry Wall reinforcement.

Masonry Wall

The Masonry Wall tab displays analysis results for the reinforcement of each region defined in your masonry wall.

Lintel Reinforcing

The Masonry Lintel tab displays analysis results for the reinforcement of each lintel defined in your masonry wall.

Masonry Wall Detail Reports
The detail reports show the overall geometry, analysis and design for the individual regions of the wall panel. The
report also shows envelope diagrams for the forces and moments in the region.
Three basic types of detail reports are provided: Wall Summary, Region and Opening.

Accessing the Detail Reports and the Specific Windows
Once you have a solved model, the detail reports become available. They are accessible in two ways:
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1. If you have the Wall Panel Design spreadsheet open, there will be a button at the top of the screen:
. This will open up the detail report window.
2. If you are in a graphic view of your model, there is a
button on the Selection toolbar. Clicking this
button and clicking on a wall panel will open up the detail report window for that wall panel.
Note:
l

If a wall panel is set to Transfer forces, then regions above and below opening will not have results. See the
Concrete Wall - Design Rules topic for more information.

Once the detail report window is open, you will see a dialog area at the top.

These options control the display of the Detail Report:
l

l

- The arrow buttons allow you to scroll quickly between the different wall panels in your model.
- This button will allow you to take a snapshot of the current detail report you are viewing so that it can
be added to a report. View the Printing topic for more information.

l

- The first drop down list allows you to select between individual Region and Opening (Lintel)
results and a summary of the entire Wall. Below we will explain the importance of each of these sections.

l

- The second drop down list allows you to select between different Regions or Openings within the individual wall panel.

Wall Report
This report gives an overview of the wall, a summary of the controlling code checks and deflection information. This
report also displays information about the wall, similar to the Region Input Echo and also gives an image of the
wall. The image shows region locations, wall length and story dimensions, and the nodes that define the corners of
the wall panel.
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The Region Results section gives the tabulated results of all regions in the wall for in plane design axial/bending,
shear and deflection for quick reference. You can view the individual region reports to get a more detailed
explanation of these values.
The Reinforcement Results section gives the reinforcement results for each region in the wall.
The Lintel Reinforcement Resultssection gives the label and reinforcement for any lintels in the wall..

In Plane Masonry Detail Reports
In Plane-Masonry - Input Echo
The top section of the detail report echoes back the input information used in the design of the wall region or lintel.
This information is summarized below:
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Criteria

Description

Code

Gives the code used to design your wall panel.
Indicates whether special inspection is required for your wall. Special inspection is
normally required for all walls designed to the MSJC / IBC codes. The UBC 1997 is
the one code that allows the user to decide whether special inspection is required.
See the Wall Design Rules - Masonry Wall spreadsheet
Indicates the bar size to be used to resist shear forces.
Indicates the bar size to be used to resist the tensile stress due to moment.
Indicates the number of vertical bars present in the boundary region of the wall.
This gives you the distance from the compression face of the wall to the centroid of
tension reinforcement.

Special Inspection
Wall Area
Horizontal Bar Size
Vertical Bar Size
Number of Tension Bars
Effective depth

The Materials column can be mostly modified under the Materials button on the Data Entry toolbar.
The Geometry column gives the basic geometry of the wall. Block grouting and the grout spacing are specified in
the Wall Panel Editor. The block nominal width is input under the Wall Design Rules - Masonry Wall tab.

In Plane Masonry - Force Diagrams and Code Check Summary
The next section of the detail report displays the envelope axial shear and moment diagrams as well as a summary
of the code checks performed on the shear wall.

The Combined Check Summary gives maximum overall code checks considering the effects of both bending and
axial stresses. This section is not reported for MSJC strength design.
The Axial Summary and Bending Summary give the values used in the axial and flexural code checks at the
location which controls the combined check (fa+fb)/Fb for ASD design.
For ASD design, the maximum bending stress in the flexural reinforcement is reported as fs, and the allowable steel
bending stress as Fs. These values are given for the Load Combination and section that produce the maximum code
check (fs/Fs).
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The Shear Summary reports the maximum shear demand on the beam as fv or Vu. The allowable shear stresses
are then reported as Fvm and Fvs, where Fvm is the allowable of the masonry alone and Fvs is the allowable
considering the effects of the shear reinforcement.

In Plane Masonry - Axial Details

Axial Details

Description

Maximum Axial Force
Location
Load Combination
Radius of Gyration (r)
h/r
Reduction Factor R

The maximum axial force in the wall.
The location along the height of the wall which produces the maximum axial force.
The load combination that produced the maximum axial force.
The out of plane radius of gyration for the wall.
Slenderness ratio of the wall
This is the slenderness reduction portion of equations 8-13, 8-14, 9-11 and 9-12.

In Plane Masonry - Bending Details

Ultimate Strength Design
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Bending Details

Description

Maximum Moment
Location
Load Combination

The maximum moment in the wall.
The height of the wall where the maximum bending moment is located.
The load combination that produced the maximum bending moment.
The uncracked section modulus. This is based on the effective thickness and the
length of the wall.
The area of tension steel in this region of the wall panel.
The reinforcement ratio in this region of the wall panel.
The length of the compression block.
The ratio of the distance between the centroid of the compressive and tensile forces (j).
Depth of compression block.
Depth of Neutral Axis.
Depth of section from compression fiber to centroid of tensile reinforcement.

Section Modulus (S)
Tension Steel Asv
Percentage of Steel (p)
k*d
j
a
c
d

In Plane Masonry - Cracked Section Details

See the Masonry Wall - Design topic for more information.

In Plane Masonry - Shear Details

Shear Details
Moment

Shear Steel Area

Shear Bar Spacing
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Description
The moment corresponding to the maximum shear check is reported along with
the M/Vd ratio.
The shear area per bar (Av) is reported along with its center to center spacing and
the perimeter of the reinforcing bars used for the calculation of allowable bond
stress.
If the shear can be taken by the masonry block alone, we will report "Not
Reqd."
l If shear reinforcement is required, we will report "Yes."
l If the wall maximum shear the wall can take is reached, we will report
"Over allowable."
The spacing of shear steel in the region of the wall panel.
l
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In Plane Masonry - Cross Section Detailing

This section of the detail report is meant to provide a visual confirmation to the user of the boundary zone width
and reinforcement.

Out of Plane Masonry Detail Reports

Out of Plane Walls - Input Echo
The top section of the detail report echoes back the input information used in the design of the wall region or lintel.
This information is summarized below:

The information in the Criteria section is mostly described in detail in the section on In Plane Detail Report. The
End Face Dist is the distance from the edge of wall to centroid of vertical bar.
The Materials column can be mostly modified under the Materials button on the Data Entry toolbar.
The Geometry column gives the basic geometry of the wall. Block grouting and the grout spacing are specified in
the Wall Panel Editor. The block nominal width is input under the Design Rules>Masonry wall tab.
The Eq Solid Thickness comes from the "Wall Area Method" in the Wall Design Rules - Masonry Wall tab.

Out of Plane Walls - Force Diagrams and Code Summary (ASD)
The next section of the detail report displays the envelope axial shear and moment diagrams as well as a summary
of the code checks performed on the transverse wall.
Note:
l
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The forces given in the detail report are given on a per foot basis. Thus these forces are averaged over the
width of a given region. For specialty loading conditions, you may need to create much smaller regions to get
more accurate local load conditions.
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The Combined Check Summary gives maximum overall code checks considering the effects of both bending and
axial stresses. This section is not reported for MSJC strength design.
The Axial Summary and Bending Summary give the values used in the axial and flexural code checks at the
location which controls the combined check (fa/Fa)+(fb/Fb).
For ASD design, the maximum bending stress in the flexural reinforcement is reported as fs, and the allowable steel
bending stress as Fs. These values are given for the Load Combination and section that produce the maximum code
check (fs/Fs).
The Shear Summary reports the maximum shear demand on the beam as fv or Vu. The allowable shear stresses
are then reported as Fv
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Design Details

Description

Radius of Gyration (r)
h/r
k

The out of plane radius of gyration for the wall.
Slenderness ratio of the wall.
This value multiplied by d gives the depth to the neutral axis.
The depth between the extreme face of masonry in compression and the center of
the tension reinf.
This value multiplied by d gives the moment arm between the compression and tension resultants.
This is the value used to calculate the shear capacity. For fully-grouted walls, this is
simply the center to center spacing of vertical reinforcement. For partially-grouted
walls, this value is conservatively taken as the width of the grouted cell plus the
thickness of the web and end wall on either side. An example of this can be seen in
Example 6.3 (p6.65) of "Design of Reinforced Masonry Structures" by Taly, copyright 2001.
These are the moments and axial forces used to calculate the shear capacity. These
are both conservatively taken as the maximum M & P in the entire region, rather
than the M & P at the location of maximum shear.
This is the M/Vd ratio used to calculate the shear capacity.

d
j

Width for Shear

Corresponding M & P
M/(V*d)

T-Section Analysis
See the Masonry Wall - Design topic for information on a T-section analysis.

Out of Plane Walls - Force Diagrams and Code Summary (Strength)
The next section of the detail report displays the envelope axial shear and moment diagrams as well as a summary
of the code checks performed on the out-of-plane loaded slender wall.
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The Axial Details provide the axial code check for pure compression forces. The Pn at max Mom value reported is
the maximum allowable axial force based on Section 9.3.5.4.2
The Bending Details are explained below:
l
l
l

l
l

l

Mu/ phi*Mn represents the ratio of applied moment to moment capacity of the wall
Mu, max is the out-of-plane bending moment at the controlling location of the wall.
phi Mn is the out-of-plane moment capacity of the wall at the controlling location. It is calculated per Section
9.3.5.2.
phi is the strength reduction factor specified in Section 9.1.4.
Location is the elevation of the wall which resulted in the highest (Mu / phi*Mn) ratio. It is the location at
which Mu and Pu are used to calculate phi Mn.
Load Combination is the load combination which resulted in an Mu and Pu which yielded the highest (Mu /
phi*Mn) ratio.

Note:
l

If there is an over-reinforced section this can cause a failure in the masonry wall solver. If this occurs the program will produce an Over-reinforced message. To reconcile this you will need to either increase the thickness of masonry block, decrease the grout spacing or decrease the bar size or number of bars in the wall.

Deflection Details
Dmax/Dlimit is a code check result. Thus, if the value is larger than one, your wall fails deflection criteria. Delta
max is the calculated deflecting using the iterative slender wall design procedure detailed in the Masonry Wall Design topic. The Delta max is the allowable deflection from Section 9.3.5.5.
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Note:
l

l

Both the Service and the Masonry flags must be checked on the Design tab of the Load Combinations for the
deflections to be checked for that load combination.
The forces in the region are given on a per foot basis and are an average of the forces over the width of the
region.

Sectional Properties (Strength)

The center to center distance between reinforcing Total Width and the Eff Width (which accounts for partially
grouted walls) are both reported in this section. The Flange Thick tf refers to the thickness of the face shell
whereas the Effective Thick te refers to the overall effective depth of the block.
The gross area and moment of inertia are reported along with the modulus of rupture, cracking moment, neutral
axis, modular ratio between steel and masonry, and the cracked moment of inertia.
The area of steel As and the effective area of steel Ase are reported, with the effective area based upon As + Pu/fy.
The gross steel ratio (rho gross) is calculated as the area of steel divided by the total area of the section.
The Rho Provided (%) is calculated as the area of steel divided by the total width times the effective depth
(As/bd). This is limited to a Rho Maximum (%) value of 0.5 * rho balanced per the UBC-97 Section 2108.2.3.7. This
provision was implemented in future codes as well.
The Sectional Properties gives a number of the properties used during the iterative slender wall design procedure.
All of these properties are reported based on a section of wall equal to the center to center spacing of the
reinforcement.

Out of Plane Masonry - Cross Section Detailing

This section of the detail report is meant to provide a visual confirmation to the user of the spacing and location of
reinforcement.

Masonry Detail Reports - Lintels
Lintels - Criteria / Materials / Geometry
The first section of the detail report echoes back the basic input parameters (Criteria, Materials, Geometry) entered
by the user. An example is shown below:
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The geometry portion and the dead weight of the wall warrant further explanation

Attribute
Beam Dead Weight
Wall Dead Weight
Dist to Top of Wall
Actual Length
Bearing Length
Effective Length
Effective Width
Effective depth
Total Depth

Description
This is based on the user defined density for the Lintel / Opening.
This is based on the wall self weight or the self weight of the region immediately
above the opening.
This is the distance from the top of the lintel to the top of the wall and is used in
the calculation of the arching action of the lintel loads.
This is the total width of the opening.
This is the bearing length of the lintel on either side of the opening.
The Center to Center distance between lintel supports. Assumed to be length of the
opening plus half of the bearing area on each side.
The thickness of the block used to define the lintel.
Equivalent to the "d" distance, the distance from the effective compression face to
the centerline of the tension reinforcing.
This is the total depth of the fully grouted portion of the lintel.

Lintel Detail Reports - Diagrams and Code Check Summary
The next section of the detail report provides the envelope shear and moment diagrams as well as a summary of the
code checks for the Lintel.

Lintel Detail Reports - Design Details
The next section of the detail report gives further details for the design checks performed on the lintel.
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This Bending Details show the magnitude, location and load combination that correspond to the maximum
moment used in the design as well as the area of flexural steel required (As) and the steel ratio (rho).
The Compressive Stress Block Details show the parameters used in calculating the strength of the lintel.
The Shear Details show the magnitude, location and load combination that correspond to the maximum shear used
in the design, the M/(V*d) ratio for shear design, and the required spacing of ties (if applicable).

Lintel Detail Reports - Cross Section Detailing

This section of the detail report is meant to provide a visual confirmation to the user of the basic geometry and
reinforcement provided in the lintel.
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Masonry Wall - Seismic Design
Masonry walls can now be designed for seismic design provisions. Here the process is described.

Note:
l

Currently seismic design in masonry walls is only supported under the ACI 530-13 and TMS 402-16 codes.
All code references given in this topic are specific to these codes.

l

Seismic design will be performed when the following input are met:
l

Supported codes (ACI 530/TMS 402 2013 or 2016)

l

Seismic design rules are assigned properly

l

Seismic load combinations are used in solution

Seismic Design Rules
For seismic design of masonry walls to be performed, the masonry wall panel must be assigned a Seismic Design
Rule. Three default Seismic Design Rules are provided in the Seismic Design Rules spreadsheet - Masonry Walls tab
as a starting point. Users are responsible to edit/create seismic design rules that fit specific design scenarios.

Label
The label is a user defined text string which is used as a unique identifier for each of the seismic design rules
defined for the structure. The program comes pre-loaded with a number of generic seismic design rules that users
can edit upon to fit their design projects.

Wall Types
These are the three masonry wall types supported for masonry wall seismic design in RISA-3D.

Ordinary
This wall type will perform design checks based on the minimum reinforcement requirements of Ordinary
Reinforced Masonry Shear Walls per section 7.3.2.4.

Intermediate
This wall type will perform design checks for Minimum Reinforcement Requirements of Chapter 7, in addition to
additional requirements of Intermediate Reinforced Masonry Shear Walls per section 7.3.2.5.
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Special
This wall type will perform design checks for Minimum Reinforcement Requirements of Chapter 7, in addition to
additional requirements of Special Reinforced Masonry Shear Walls per section 7.3.2.6. These requirements include:
l

Additional requirements are checked for Special Reinforced Masonry Walls per section 8.3 (ASD Solution) and
9.3 (Strength Solution) in RISA-3D.

Special Boundary Elements
This setting indicates that the wall will be designed with Special Boundary Elements per Section 9.3.3.6. The
program will not check for the maximum area of vertical reinforcement requirements for walls with this checkbox
turned on in the seismic design rules. Refer to the Design Considerations section for additional information on
checks provided for walls designed with Special Boundary Elements.
l

This setting is turned on by default for Special wall types. But users can edit the seismic design rules to meet
their design needs.

1.5x Shear ASD
This setting applies a 1.5x factor to the shear demand of the walls with the seismic design rule applied in models
solved with either TMS 402-16: ASD or ACI 530-13: ASD codes.
l

This setting is turned on by default for Special wall types.

Design Considerations
All Wall Panels with Seismic Design Rules applied will be checked for the following Minimum Reinforcement
Requirements.

Minimum Reinforcement Requirements
All masonry design walls assigned a seismic design rule will be checked for minimum reinforcement requirements
per ACI 530/TMS 402 section 7.3.2. including:
l

l

Vertical Reinforcement
l

At Wall Ends (for wall regions at the ends of the wall panel)

l

Minimum Bar Size

l

Maximum Bar Spacing Around Openings (for applicable Wall Panel Regions)

Horizontal Reinforcement
l

At Top of Wall Region

l

Minimum Bar Size

l

Maximum Bar Spacing Around Openings (for applicable Wall Panel Regions)

Additionally, all wall types are checked for Mortar type requirements per ACI 530/TMS 402 section 7.4.4.2.2.

Special Reinforced Masonry Walls - Additional Requirements
Additional checks are provided for wall types assigned a “Special” seismic design rule per section 7.3.2.6. These
additional checks include:
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l

Maximum vertical spacing of vertical reinforcement
l

l

Maximum spacing of horizontal reinforcement
l

l

Shall be the smallest of one-third of the length of the wall region, one-third the height of the wall
region and 48 inches.

Shall be the smallest of one-third of the length of the wall region, one-third the height of the wall
region and 48 inches.

Minimum cross-sectional area of vertical & horizontal reinforcement
l

The sum of vertical and horizontal cross-sectional area shall be at least 0.002Ag(vert), where Ag(vert)
is the cross-sectional area of the wall panel region (on a horizontal plane)

l

Minimum vertical & horizontal cross-sectional area shall be 0.0007Ag, where Ag is the gross crosssectional area perpendicular to reinforcement being considered

Note:
l

All seismic checks performed in the program are listed in the seismic detailing section per regions in the
detailed report. Users can refer to section 7.3.2.6 for additional requirements not checked by the program.

ASD Masonry Code - Additional Requirements
The ACI 530/TMS 402 code has additional seismic detailing requirements for masonry shear wall panels, some of
which are considered in RISA-3D. The seismic detailing requirements in this section are only considered if the
model is solved using one of the supported Service (ASD) masonry codes.

Max. Flexural Rho Check
Masonry Wall Panels with a Seismic Design Rule of “Special”, a shear span ratio (M/Vdv) ≥ 1, and an axial load ≥
0.05f’mAn, shall be checked for a maximum reinforcement ratio equal to ρmax, calculated based on ACI 530/TMS
402 Equation 8-20:

Where:
l

n is the modular ratio of steel reinforcement

l

f’m is the compressive strength of masonry

l

fy is the yield strength of steel reinforcement

ASD Wall Shear Stress Increase Check
Masonry Wall Panels with a Seismic Design Rule of “Special” will be checked if a ASD shear stress increase of 150%
(1.5x factor) is applied to the in-plane shear demand as required in Section 7.3.2.6.1.2. The program automatically
handles this requirement if the “1.5x Shear ASD” setting is turned on in the Seismic Design Rules - Masonry Walls
tab, and will apply a 1.5 factor to the shear demand in the wall region.
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LRFD Masonry Code - Additional Requirements
The ACI 530/TMS 402 code has additional seismic detailing requirements for masonry shear wall panels, some of
which are considered in RISA-3D. The seismic detailing requirements in this section are only considered if the
model is solved using one of the supported Strength (LRFD) masonry codes.

Special Boundary Elements Requirements
For Masonry Wall Panels with a Seismic Design Rule of “Special” and walls “Special Boundary Elements” setting
turned on in the Seismic Design Rule, the program will determine if Special Boundary Elements are required per
Section 9.3.6.6.1. Two conditions are considered to determine if Special Boundary Elements are required:

If any of the conditions above hold true, then Special Boundary Elements are not required per Section 9.3.6.6.1. If
both of the conditions above do NOT hold true, then Special Boundary Elements are required. The program does not
design the walls with the Special Boundary Elements. Users shall proceed to the requirements of Section 9.3.6.6 for
further design requirements if special boundary elements are required.
Note:
l

The requirements of Section 9.3.6.6.1 are checked per wall panel regions, not the entire wall panel.

l

Wall is assumed to be rectangular in shape and geometrically symmetrical.

l

For wall panels designed using Special Boundary Elements, no checks for maximum vertical reinforcement
are required per ACI 530/TMS 402. Refer to TMS 402/602-16 and ACI 530-13 for additional information on
ductility requirements.

Design Seismic Shear Capacity Limits
For Masonry Wall Panels with a Seismic Design Rule of “Special”, the program checks if the Design Shear Strength,
phi_Vn, exceeds a shear value (Vu) that corresponds to 1.25 times the nominal flexural strength of the wall,
calculated as follows:
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Where:
l

Mn is the in-plane nominal flexural strength of the wall panel region

l

Mu is the in-plane moment (flexure) demand in the wall panel region

l

V is the actual shear demand in the wall panel region

Additionally, the Design Shear Strength must not exceeds 250% of the shear demand in the wall panel region:

If any of the minimum and maximum limits to the Design Shear Strength is not met, a “Fail” will be indicated in this
check in the Seismic Detailing section of the Wall Panel Detail Report for the wall panel region.

Maximum Area of Flexural Tensile Reinforcement (max. Flexural Rho Check - Strength)
For walls not designed with Special Boundary Elements (without the “Special Boundary Elements” and designed
using a Strength code, all wall panel regions will be checked against maximum flexural reinforcement requirements
per Section 9.3.3.2. Section 9.3.3.2 stipulates minimum levels of strain at the extreme tension fiber, which the
program handles individually for each wall panel region, with a minimum tension reinforcement strain factor, “α”,
for each masonry seismic wall type.
The tension reinforcement strain factor is dependent on the wall type, seismic response modification R factor, and
the shear span ratio (M/Vdv) ratio, as shown in the table below:

The strain ratio for the extreme rebar layer, calculated as es/ey, where es is the strain in the steel at the extreme
tension rebar layer and ey is the yield strain of reinforcement.
The procedure for determining compliance is as follows:
l

Wall Panel Region in-plane reinforcement design is done based on the flexure (moment) demand in the wall
panel region.

l

Shear span ratio (M/Vdv), depth to neutral axis c and seismic response modification R factor are reported.

l

Required minimum tension reinforcement strain factor is obtained per the table above.

l

Strain ratio, calculated as es/ey, where es is the strain in the steel at the extreme tension rebar layer and ey
is the yield strain of reinforcement, is compared to α.

l

If es/ey ≥ α, then reinforcement in the wall panel region is in compliance with Section 9.3.3.2.

l

If es/ey < α, then the reinforcement in the wall panel region is NOT in compliance with Section 9.3.3.2.

l

The strain in the steel at the extreme tension rebar layer is calculated based on the depth to neutral axis c,
and the effective depth of the wall region, d, as shown in the diagram below:
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The calculation of the strain at the extreme tension reinforcement layer is as follows:

Note:
l

Out of plane reinforcement is not considered in meeting ductility requirements for Section 9.3.3.2.

l

The effects of compression reinforcement is considered in the in-plane flexural capacity of the wall panel
regions when calculating the location of the neutral axis.

l

The maximum usable masonry strain at the extreme compression fiber, emu, is assumed to be 0.0035 for the
calculation of the strain at the extreme tension steel for Seismic Detailing checks. For assumptions of the
extreme compression fiber for non-seismic in-plane checks, refer to the In Plane Design - Strength section.

l

Section 9.3.3.2.1 requires axial forces to be taken from the loading combination given by D + 0.75L +
0.525QE. The program has no way of determining if this load combination is present in the model, or if it
governs the design of the wall panel. Therefore, it is recommended that users include this load combination
in the set of solved load combinations, and determine if ductility requirements are met for this specific load
combination.

Assumptions and Limitations
1. All walls are assumed to be laid in a running bond.
2. No checks are provided for seismic detailing requirements at roof and floor diaphragms, at wall corners, for
dowels or through control joints. Additional requirements may apply for seismic design categories D, E and
F. Refer to TMS 402-16 or ACI 530-13 Chapter 7 for additional requirements.
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Masonry Wall - Seismic Design Results
Results for Seismic Detailing of Masonry Walls are provided via Spreadsheets and wall panel Detail Report.

Design Spreadsheet Results
Wall Panel Seismic Detailing
Results for Seismic Detailing checks are provided in the Wall Panel Design spreadsheet - Masonry Seismic tab.
Results are provided per region, and the Seismic Detailing column provides a summary of the Seismic Detailing
checks. For a more detailed output, check the “Seismic Detailing” portion of the Wall Panel Detail Report.

Reinforcing Spreadsheet Results
Wall Panel reinforcement is provided in the Concrete Reinforcing Spreadsheet - Masonry Wall tab. Results are
provided per region. For a more detailed output, check the “Seismic Detailing” portion of the Wall Panel Detail
Report.
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Detail Report Results
Seismic Detailing Checks - Wall Panel Region
Seismic Detailing checks are provided for each of the wall panel regions towards the end of the Detail Report. Each
Seismic Detailing section has a header “Region RX (Seismic Detailing)”, where RX is the region number.
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The Seismic Detailing checks depend on which design philosophy is being performed (e.g. ASD vs Strength) and the
Wall Panel’s Seismic Design Rule. See below an example of the checks provided for a Strength design of a Masonry
Wall Panel with a “Special” Seismic Design Rule designed with Special Boundary Elements:
Legend:
l

A “PASS” indicates that the seismic detailing check is in compliance with the referenced section.

l

A “FAIL” indicates that the seismic detailing check is NOT in compliance with the referenced section.

l

A “N/A” indicates that the seismic detailing check is NOT APPLICABLE for the Wall Panel Region.
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Wood Wall - Design
The wood wall panel element allows you to easily model, analyze and design wood walls for in-plane loads. Here we
will explain the wood specific inputs and design considerations. For general wall panel information, see the Wall
Panels topic. For wood wall results interpretation, see the Wood Wall Results topic.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Wood Walls.
Full code checking and design can be performed on the panel sheathing, studs, chords, headers and hold-downs
based on the following codes:
l

l
l
l
l

The 2015/18 edition of the NDS (Note the 2018 NDS did not include an update to the SDPWS, so it continues to use the 2015 spec for lateral wall design.)
The 2012 edition of the NDS
The 2005/08 edition of the NDS (National Design Specification)
The 2014 edition of the CSA O86
The 2009 edition of the CSA O86

Wood Wall Input
The Walls tab gives some specific information and options for modeling/analysis of wood walls. The Walls tab can
be accessed by double clicking on a wall panel within the 3D view window.
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Wood View Controls

Toggle Wall Studs Display allows you to turn the display of the studs on and off.
Chords allows you to turn the display of wall panel region chords on and off.
Header allows you to turn the display of headers on and off.
Studs allows you to turn the display of the studs on and off.
Top/Sill Plate allows you to turn the display of the top/sill plates on and off.

Design Rules
You must set up design rules for the stud/chord sizes, as well as make database selection for shear panels and holddowns. This is done in the Wall Design Rules spreadsheet in the Wood Wall (Studs) and Wood Wall (Fasteners)
tabs. See the Wood Wall - Design Rules topic for more information.

Creating Openings in Wood Walls with Headers

Within the Walls tab, you have the option of adding rectangular openings to wood wall panels. To draw an opening,
select the Openings button and then select two nodes or grid intersections which make up the two diagonal
corners of your opening. When an opening is drawn, a header beam is automatically created above the opening. To
view or edit the properties of a header beam go to the Wall Design Rules spreadsheet. In the case where you may
have different opening headers in the same wall, you can define those different headers by double-clicking inside
the boundary of the drawn opening. This will bring up the Wood Wall Definition Editor window for that
particular opening which will then allow you to modify header properties.
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Edit/View the Existing Wall Design Rule - This option allows you to view as well as make edits to the Wall
Design Rule that is currently applied to the wall.
Create a New Wall Design Rule - This option will allow you to create a new Wall Design Rule to be applied to the
wall.

Hold-Downs and Straps
Hold-downs and straps are automatically added to your walls in their required locations. For a Segmented design,
you must have hold-downs or straps at the bottom corners of each of your design segments. For Perforated and
Force Transfer Around Openings (FTAO), hold-downs straps are only allowed at the two far corners of the wall
panel. The program will not permit the drawing of hold-downs or straps at locations where they are not allowed.
If there are custom locations that you want to add hold-downs or straps, you can do this within the Walls tab.
Hold downs can represent the anchorage of your wall to the foundation or the connection of shear wall chords
between floors. To add hold-downs to the base of your wall, first select theHold Downs icon in the Walls tab.

Hold downs must be added after regions are created and can only be added at the corners of regions. Hold down
requirements depend on the type of wall design you are performing.
Straps represent the connection of the current wall panel to a wall panel below. To add straps to the base of your
wall, first select the Straps icon in the Walls tab.

Straps also can only be added after regions are created and can only added at the corners of regions. Strap
requirements also follow the same logic as hold downs as to where they must be defined as far as regions are
concerned.
Note:
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l

l
l

l

l

All boundary conditions for wall panels should be defined in the wall panel editor. Adding external boundary
conditions can create problems.
The locations of hold-downs and straps define where the program will calculate tension forces in your walls.
If you have applied your hold-downs or straps for the Segmented design with openings in your wall, then
they will be required at the interior of the wall panel. However, running Perforated or FTAO does not require
hold-downs or straps at the interior of the wall panel. Thus, if you toggle between Segmented to Perforated
or FTAO, then the hold-downs or straps you drew will be removed at the interior of the walls. If you switch
back to Segmented, the interior hold-downs or straps will come back again.
By default, the program will automatically add hold-downs to the base of walls that have boundary conditions applied to them and will apply straps to walls that have walls below.
All Straps and Hold-downs are placed at the base of walls only. So, if you would like to put a strap or holddown between floors, you would apply it to the base of the upper wall.

The output for straps and hold-downs will show up on the detail report for the wall panel. More information on this
can be found in the Wood Wall Results topic.

General Requirements for Shear Walls
The design of wood shear walls per the available design codes requires that many criteria are satisfied before a wall
can be considered adequate. For RISA to work within this framework, we require that certain modeling practices be
followed. Outlined below are many general wall modeling practices and limitations. Also included are specific
requirements for each of the three design procedures for wood wall design with openings: Segmented, Force
Transfer Around Openings, and Perforated.
The three different types of shear walls are defined in Section 4.3 of the NDS Special Design Provisions for Wind and
Seismic.
Note:
l

The Canadian CSA O86 design code only supports the Segmented method, as described below.

Segmented Method
Where there is a wall panel with openings, the area above and below the openings is disregarded and the wall is
designed as being made up of separate, smaller shear walls.
Like all wall panels, the segmented wood wall is broken into a series of meshed plate elements to represent the
overall wall. The portions of the segmented shear wall that are considered "ineffective" in resisting shear are
modeled with a plate elements that have a significantly reduced shear stiffness so that they will not receive any
significant moment or shear from the FEM analysis.
See the diagram below for more information:
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In addition, the out of plane stiffness and in plane stiffnesses of the segmented wood wall are modeled separately
based on different assumed plate thicknesses. This is done to insure that the shear stiffness is based entirely on the
properties of the sheathing and is not influenced by the out-of-plane stiffness of the wall studs.

Note:
l

If you have several stacked Segmented wall panels with misaligned openings, you will receive the Warning
Message shown below upon solution. This message means that RISA-3D has assumed that the strap force
from the above wall panel will be spread out across the region directly under it. Therefore, you need to be
aware of this assumption and detail the wall panel accordingly.

l

A shear panel design will be chosen for the worst-case region in a segmented wall. That panel will then be
used for all regions in that wall. The worst-case region is the one that has the highest Shear UC value.

Force Transfer Around Openings Method
This method is based on a rational analysis of the wall generally referred to as the "Diekmann Method" This method
is documented in detail in Design of Wood Structures ASD/LRFD (6th edition) by Breyer, Fridley, Cobeen, and
Pollock. The assumption being that straps and blocking can added at the corners of the openings to transfer the
sheathing forces across these nodes. This method essentially allows you to use the entire area of the wall (minus
the opening) to resist the shear in the wall.
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The basic assumptions made in the shear wall analysis are the following:
l

l

l

The sheathing resists the shear forces. The average shear force in each block of the wall (numbered 1~8 as
shown in the image above) is used as the controlling shear force in that location. The maximum shear in each
of these locations will control the design of the wall. The program uses an area weighted average of the Fxy
plate forces to determine the average shear for each block.
The moment at the edge of each block that is above or below an opening is assumed to be transmitted across
the opening interface by horizontal tension straps or compression blocks as shown in the image above. The
required force is reported to the user, but the design and length of these elements is left to the engineer.
The moment at the edge of each block that is to the right or left of an opening is assumed to be transmitted
across the opening by tension straps or compression blocks. Since it is likely that the sheathing and king
studs will be capable of transmitting these forces, these elements are not shown in the image above.
However, these forces are reported so that the design of the studs and sheathing in these regions can be
checked by the engineer to consider these effects.

Note:
l

l

The program is limited in the automatic generation of regions for walls with multiple openings that are not
aligned. Therefore, it is recommended that complex walls will multiple openings be simplified based on engineering judgment to facilitate easier detailing of the force transfer around these openings.
This design method is not available for Canadian CSA O86 design. If you select this design method, the program will automatically change it back to Segmented.

Perforated Method
This method for design of wood shear walls with openings may end up being the most cost effective. It only
requires hold downs at the corners of the wall, yet it does not require straps or blocking around the openings. A
perforated shear wall design approach is, however, subject to a number of code constraints about when it can be
used.
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The basic design procedure for perforated walls is to essentially ignore the portions of the wall that do not have full
height sheathing and treat the wall instead as a significantly shorter wall. This amplifies the chord and hold down
design forces significantly while at the same time increasing the design unit shear as shown in the equations below:

Where:

Note:
l

l

l
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The perforated method of design also has many caveats that are given in Section 4.3.5.3 of the NDS 2015 Special Design Provisions for Wind & Seismic. The program will not allow the design of wall panels that do not follow these provisions.
For multi-story perforated shear walls, the amplified hold down forces required per the code become difficult to interpret for the lower walls. Therefore, when RISA calculates the hold down forces for the lower
wall it assumes that the reduction coefficients for the upper wall are identical to the values for the lower
wall. This will result in conservative hold down forces when the lower wall has more openings than the
upper wall. But, it may be un-conservative for situations where this is not the case. This assumption does
NOT affect the shear design of either wall, nor does it affect the strap force calculations in the upper wall.
This design method is not available for Canadian CSA O86 design. If you select this design method, the program will automatically change it back to Segmented.
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Shear Capacity Adjustment Factor, Co:
The NDS Special Design Provisions for Wind & Seismic lists Effective Shear Capacity Ratio (Co) values that are used in
calculating the nominal shear capacity of perforated shear walls. Because the tabular values are limited to wall
heights of 8’ & 10’, RISA instead uses equation (4.3-5) from the 2015 NDS SDPWS to calculate the Co factor for any
height wall.

Where,

When using these equations, RISA takes Ao as the true area of the openings. However, Table 4.3.3.5 of the 2015 NDS
SDPWS (Table 4.3.3.4 from older versions of the NDS SDPWS) references Co values based on all opening heights
equal to the maximum opening height. Therefore if you want the program to calculate Co equal to that in Table
4.3.3.5 of the NDS, you must draw all openings as equal to the maximum height. Please see the image below for
reference.

Note:
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l

When the assumption is made that all opening heights are equal to the maximum opening height then the
equation produces values of Co that are within 1% for all the values shown in the NDS table.

Co Limitation for Stacked Wall Panels
For wall panels that are stacked on one another, each wall panel has its own Co value. These Co values will be
different if the openings in each wall are different. This is the source of a limitation in the program.
The program determines the design forces in each wall panel separately using the finite element solution. We then
take those design forces and factor them for the Co values. The problem is that the design forces for the bottom wall
are affected by the Co value for the upper wall. Thus, the forces that come down on a lower wall from an upper wall
have been factored for the Cofrom the upper wall. RISA-3D does not consider this. The program takes the forces
from the finite element solution and uses the Co value only for the wall in question.
Thus, the highest level in a stacked wall configuration will always use Co in a correct manner. The lower wall(s),
however, will be conservative if they have more openings than the upper wall(s) and can be unconservative if the
upper wall(s) have more openings than the lower wall(s).
This limitation must be considered when designing Perforated walls that are stacked.

General Program Functionality and Limitations
RISAFloor and RISA-3D Interaction
When using RISAFloor and RISA-3D in combination, the interface transitions nicely between the two programs.
Here is a quick walk through of this interaction.

Input Interface
1. Model the entire building (gravity and lateral members) within RISAFloor. Be sure to model all openings and
regions for all of the wall panels in the model.
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Note:
l

You can not modify your openings or regions in RISA-3D. All region and opening modifications must be taken
back to RISAFloor to be done.

2. Add loading and solve the model.
3. Take the model into RISA-3D via the Director tool.
4. Once in RISA-3D you must add your hold downs and straps to your wall panels.
Note:
l
l

l

l

Hold downs and straps can not be added to wall panels in RISAFloor.
Hold downs are only allowed to be added to the lower corners of the wall panel for the Perforated or Force
Transfer Around Openings design methods.
Hold downs are required at the corners of all full height regions in the wall panel for the Segmented design
method.
The Design Rule, Design Method and SSAF can be changed in either program at any time.

Modeling Tips- Platform Framing
The wood wall height in RISA is measured from the bottom of the sill plate to the top of the floor framing as shown
below. However, platform framing causes the wall height to be significantly shorter than a RISA model would
represent.
The design method FTAO is the only method that will cause significant problems because the region above openings
is assumed to be much larger than it is built. In order to adjust for this framing depth, you can adjust your opening
height to include the depth of the floor framing. This will reduce the portion of the wall above the opening thus
reducing the amount of area to transfer shear forces.
In Segmented and Perforated design methods, the portion above and below the opening are not used to transfer
shear forces.
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Limitations for Hold-downs / Straps (Including deformation)
l

l

l

The program does not currently have a database for continuous tie rod hold-downs. However, the design results that are presented for each floor are intended to provide the type of information necessary for the
design of these types of hold downs.
The davalues (deflection at peak load) from our hold-down database are based entirely on the manufacturers
listed values. These do not include any allowance for shrinkage (which is often as much as 1/4" or more per
floor), or crushing of the sill plate.
There is not currently a da value used in the calculation for strap deformation for upper floor levels.

Automatic Boundary Conditions
l

In RISA-3D, if no boundary conditions or hold downs are defined for wood wall panels at the lowest level of
the structure, the program will automatically create hold downs at the corners of the wall panel. If you do
not want the hold downs to be automatically created, define a "free" boundary condition at the base of the
wall panel in the wall panel editor.

Deflection
l

There is currently no code check for drift or deflection for shear wall panels.

Chord Design
The chord design is based on forces that are calculated differently for Compression versus Tension. The tension
chord force is calculated including the dead load stabilizing moment as per Section 4.3.6 of the NDS 2015 Special
Design Provisions of Wind & Seismic. The compression chord force includes the only the tributary area of one stud
spacing in the compression force. For Segmented design, the chord forces are found based on each region, and in
FTAO and Perforated design methods the chord forces are determined for the entire wall.

Chord forces are calculated per the following equations:
l
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When the "Eccentricity" check-box is selected in the Wood Wall Design Rule (Fasteners tab):
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l

When the "Eccentricity" check-box is NOT selected in the Wood Wall Design Rule (Fasteners tab):

Where:
l
l
l
l
l

M = Moment at the base of the wall
L = Length of the wall
bc = width of chord member
P = Axial force at the base of the wall
n = Number of Studs = Length/Stud Spacing

Notes:
l

l

For Perforated Design, the term M/(Length-ChordWidth) found in the above equation is replaced with
Vh/(CoΣLi-ChordWidth) as indicated in the Equation 4.3-8 of the NDS 2015 Special Design Provisions for
Wind & Seismic.
RISA-3D models the shear walls using only the sheathing. The vertical resistance occurs only at the tension and compression chords. Thus, if two wall panels are stacked on top of each other, the load transfer
will only happen at the chord locations. Therefore, the lateral analysis should agree very well with hand
calculations. However, it also means that gravity load design may be more appropriate in RISAFloor.
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Hold-Down Force
The Hold-Down force is calculated by finding the Tension chord force. In order to accommodate an unsymmetrical
vertical load on the wall, the program adopted a more accurate approach by calculating the moment at the
compression side first and then finding the resulting reaction on the tension side.

Hold-Down forces are calculated per the following equations:
l

When the "Eccentricity" check-box is selected in the Wood Wall Design Rule (Fasteners tab):

l

When the "Eccentricity" check-box is NOT selected in the Wood Wall Design Rule (Fasteners tab):
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Where:
l
l
l
l
l
l
l

Ma = moment at point A(CL of compression chord)
M = moment at base of the wall
P = Axial load at the base of the wall
L = length of the wall
bc = width of chord member
Rb = reaction at point B = hold down force
CL = Hold down eccentricity distance (per selected hold down)

Stud Design
Studs are only designed for load combinations which do not contain a wind or seismic load. The maximum axial
load, determined as an envelope force from all of the "gravity" load combinations which have been solved, is
determined for each region.
The compression capacity for the specified stud size is calculated with the assumption that the stud is fully braced
against buckling about its minor axis (within the plane of the wall). This is because the blocking and sheathing are
assumed to provide this bracing. The unbraced length for major axis buckling is taken as the wall height, minus the
thickness of the top and sill plates.
The program divides the region axial force by the number of studs that would be present in that region for a given
stud spacing. An optimal stud spacing is then selected based on the stud capacity, and the parameters defined in the
Design Rules.

Force Distribution
l

The lateral force distribution between piers is based on the relative stiffness of the sheathing, not on the
length of the shear wall. For example, if you have an 8 foot wall and a 4 foot wall, the 8 foot wall will take
more than 8/(8+4)*100% of the force. The moment of inertia in the 8 foot wall will allow for a larger proportion of load to go into that pier.

Shear Capacity Adjustment Factors
40% Increase Factor Wind Load Cases
The allowable shear stress values tabulated in Appendix F are intended to be the allowable shear for seismic loads.
The solution tab of the Model Settings has a check-box which will automate the 40% shear capacity increase for any
load combinations that include Wind Loads. This is called "Wind ASIF" in the detailed report output.

Allowable Stress Reductions for Slender Wall Segments
The program will modify the allowable stress of the wall based on the 2b/h adjustment factor per NDS SDPWS
section 4.3.3.4 exception 1. This adjustment factor is only applied to the wall for load combinations which include
seismic loads. This adjustment factor only affects walls with an aspect ratio between 2.0 and 3.5. This is called
"Cap.Adj. (2w/h)" in the detailed report output.
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For Segmented and FTAO wall panels designed per the NDS 2015, the program also checks the Aspect Ratio factor
per section 4.3.4.2. This factor will reduce the sheathing capacity for lateral (Wind or Seismic) load combinations on
walls who have a design region whose aspect ratio is greater than 2.0. This is called "Aspect Ratio" in the detailed
report output.
The final governing factor (minimum of Cap. Adj. (2w/h) and Aspect Ratio) is reported as the Gov. H/W Cap.
This is then multiplied by the sheathing capacity to give the final Adjusted Cap.

Specific Gravity Adjustment Factor
The NDS defines an adjustment factor associated with using stud material that is less dense than Douglas-Fir-Larch
or Southern Pine. The program automatically accounts for this factor in the design of Wood Shear Walls.

Unblocked Shear Wall Adjustment Factor
Section 4.3.3.2 of the 2015 NDS Special Design Provisions for Wind and Seismic is ignored in RISA-3D. The program
will always assume that the sheathing panel is blocked for both NDS and CSA design.

Uplift Limitation
Section 4.4 of the 2015 NDS Special Design Provisions for Wind and Seismic is ignored in RISA-3D. The program
currently does not design wall panels for uplift forces.

Stiffness Adjustment Factors
Shear Stiffness Adjustment Factor (to change FEM results)
This stiffness adjustment factor is set on the Wall Panels spreadsheet and is intended as a way to force the FEM
stiffness of the wall to more closely resemble the stiffness from the APA / NDS three term deflection equation.
This adjustment affects the stiffness of the entire wall. Therefore, for segmented walls the engineer may be forced
to model the piers separately if they need to adjust the pier stiffnesses independently. In a future release, this may
become an automated factor.

Green Lumber
The Wood Wall (Studs) tab of the Design Rules spreadsheet contains a Green Lumber check-box to account for the
50% reduction in the Ga value defined in the NDS footnote.
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Stiffness Assumptions
Vertical Direction
RISA uses an orthotropic plate element to de-couple the vertical and shear stiffness of the wood walls. The vertical
stiffness will be based on the E value of the studs and chords as specified in the Materials spreadsheet and the
thickness of the wall. The thickness is taken as

Where,

In-Plane Shear
The in-plane shear stiffness will be based on the Ga value designated within the specified nailing schedule divided
by the sheathing thickness. Both the Ga value and the sheathing thickness are defined in the specified sheathing
schedule.

Out-of-Plane Shear
For the out of plane shear, RISA uses the same Young's Modulus (E) as used in the vertical direction and a thickness
that is calculated from the out of plane moment of inertia. This becomes:

Wood Wall Self Weight
The program will calculate wood wall self weight as a sum of all the weights of the components. The material
density is used to calculate the self weight of the studs, chords, top plates, sill plate, and sheathing. These are all
then summed together to give the self weight of the entire wall.

Note:
l
l

For this calculation, stud height equals wall height minus the thickness of the sill plate and the top plate.
The number of studs is calculated using the stud spacing specified in Design Rules.

Wood Wall Optimization
The program will optimize wood walls based on the required demand forces. The program can optimize:
l
l
l

Sheathing for in-plane shear design.
Stud spacing for axial design.
Hold-downs for in plane design.

Of these optimizations the two that substantially modifies the stiffness of the wall are the sheathing and the stud
spacing. To properly adjust the stiffness requires an iterative solution that updates the stiffness of the model. This
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includes updating the strength properties of the wall as well as the stiffness. This optimization/iteration can be
done automatically by checking Optimize Masonry and Wood Wallsin the Model Settings - Solution tab or can be
done manually by unchecking this option.

To update the stiffness portion of the wall, the program must re-solve your model with these updated stiffnesses as
this will change the distribution of forces through the model. By checking Optimize Masonry and Wood Walls you
are telling the program to re-solve automatically. Thus, the program will start with it's initial stiffness parameters
and solve the model. It will then optimize the wall to meet strength criteria. Another solution will then be run with
the new stiffnesses and the program will again optimize the wall to meet strength criteria. This procedure will
continue to occur until you reach the Maximum Number of Iterations set or until all wall panel results match
those of the previous solution.
By unchecking Optimize Masonry and Wood Walls the program will only run the solution once and the results
will be based on the original configuration. You can then manually optimize your walls using the Suggested Design
spreadsheet.
After the solution is run (with or without optimization) the design results are based on the stiffness used in the last
iteration (by unchecking the Optimize Masonry and Wood Walls option a single iteration is run). The program
will then compare the design of the last iteration with the stiffness used in that last iteration. If the two are the
same the results shown are the final results. If the two are not the same the program will then provide these two
different results in the Suggested Design spreadsheet.
The program will always present results in the output that coincide with the stiffness used in the final solution.
Note:
l
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The updating of the stiffness for the model is only required for the sheathing and stud spacing optimization.
Thus, hold-down call-outs are optimized automatically.
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Suggested Design

In the Suggested Design spreadsheet you will get a list of wall panels in your model that are not yet fully
optimized, showing the panel and stud spacing of the last iteration and the program optimized values. From here
you have the ability to Use Panel? or Use Stud Space? which means that you want to re-run the solution with the
suggested design. You can choose this for each suggestion for each wall panel individually. Once you have these
checkboxes checked appropriately press the Suggested Design icon in the Results tab to re-solve the model with
the suggested design. After this the stiffness matrix is re-formulated and may cause some redistribution of loads
through the model. Because of this the suggested design may also update and you may need to Use Panel?and/or
Use Stud Space? multiple times to converge on a solution.
Note:
l

l

l
l
l

If the wall does not show up in the Wood Wall Suggested Design spreadsheet then the current wall panel settings used are the optimal ones.
If either the stud spacing or the panel fields are blank that means that the current selections are the optimal
ones.
For more information on wood wall optimization see the Wood Wall - Design topic.
For more information on member optimization see the Design Optimization topic.
Concrete walls do not show up here because the reinforcement optimization does not affect the stiffness of
the wall.
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Panel Optimization

The procedure that RISA uses for design optimization is fundamentally based upon the assumption that there is a
'cost' to shear capacity, and therefore the ideal panel design would have as little shear capacity as possible to meet
code requirements. Once the program has determined the shear demand on the wall it will choose the most
economical panel configuration based on that which has a Shear Capacity closest to, but not exceeding the shear
demand.
The default shear panels in the program come straight from published tables in the IBC, UBC, and CSA O86 design
manuals. "St-I" refers to Structural I panels and "RS" refers to Rated Sheathing panels.

Note:
l

l
l
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The shear force listed in the XML spreadsheet is tabulated for the seismic values. These values will automatically be multiplied by 1.4 for wind forces if the Wind ASIF function is enabled.
Panels with a label containing the characters "_W" together will be ignored during design optimization.
"Rated Sheathing" is a shortened form of "Span Rated Sheathing" or APA Rated Sheathing. This terminology
comes directly from the Department of Commerce standards DOC PS1 and PS2.
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Hold Down Optimization

The procedure that RISA uses for hold-down optimization is fundamentally based upon the assumption that there is
a 'cost' to allowable tension in a product, and therefore the ideal hold-down would have as little tensile capacity as
possible to meet code requirements. Once the program has determined the tensile force required to hold-down the
wall it will choose the most economical hold-down product based on that which most closely matches (but does not
exceed) the tension demand. The program looks to the Allowable Tension field of the hold-down schedule to
choose the design.
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Strap Optimization

The procedure that RISA uses for strap optimization is fundamentally based upon the assumption that there is a
'cost' to allowable tension in a product, and therefore the ideal strap would have as little tensile capacity as possible
to meet code requirements. Once the program has determined the tensile force required to strap down the wall it
will choose the most economical strap product based on that which most closely matches (but does not exceed) the
tension demand. The program looks to the Allowable Tension field of the strap schedule to choose the design.

Optimization Options
For users who are new to wood wall design within RISA, the best procedure is to utilize the full databases, and to
limit the potential designs by utilizing the design rules spreadsheets. This results in a design based on the maximum
number of options, which is often the most efficient design.
For experienced users who have more specific limitations in terms of the designs they would like to see, userdefined Groups (or families) are the solution. For example, an engineer who prefers to use only one sheathing
thickness, or one nail type can create a custom Group that contains only the arrangements they want. For more
information on creating these custom groups see Appendix F-Wood Shear Wall Files.
For more information on Wood Walls see Wood Wall Results.
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Wood Wall - Design Rules
The wood wall panel element allows you to easily model, analyze and design wood walls for in plane loads. Here we
will explain the wood specific inputs and design considerations. For general wall panel information, see the Wall
Panels topic. For information on wood wall design considerations, see the Wood Wall - Design topic. For wood wall
results interpretation, see the Wood Wall Results topic.

Unity Check

Max Bending Chk
This will define the hold-down maximum code check value. Typically this will always be 1.0, but this allows the
option of having the program pick out a hold-down that is not at maximum capacity. Putting a value of 0.8 will
choose a hold-down that is at 80% of capacity.

Max Shear Chk
This will define the shear panel selection maximum code check value. Typically this will always be 1.0, but this
allows the option of having the program pick out a shear panel layout that is not at maximum capacity. Putting a
value of 0.8 will choose a panel thickness and nailing that is at 80% of capacity.

Wood Wall (Studs)
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Top Plate
Use the Top Plate column to specify the member to be used as a top plate for your wall. A top plate is a member
that runs continuously along the top of the wall studs. Note that you can use multiple plies of nominal lumber, or
custom shapes.

Sill Plate
Use the Sill Plate column to specify the member to be used as a sill plate for your wall. A sill plate is a member that
runs continuously along the bottom of the wall studs. Note that you can use multiple plies of nominal lumber, or
custom shapes.

Studs
Use the Studs column to specify the member to be used for studs in your wall. Studs are vertical members in the
wall, attached to the sill plate at the bottom and the top plate at the top. Note that you can use multiple plies of
nominal lumber, or custom shapes.

Min/Max Stud Space
You may specify a minimum and maximum spacing of wall studs. The program can then optimize the stud spacing
based on axial design only. For information on how the optimization works, see the Wood Wall - Design topic.
l

l

If you specify the maximum and minimum stud spacing as the same value, then we will use that value exclusively.
Out of plane design is not performed for wood walls, so any optimization is based only on axial forces in the
studs.

Green Lumber
NDS Design: Check this box if your moisture content is greater than 19%. The program will then multiply the Ga
value of the shear panel by 0.5 per Note 5 of Tables 4.3A and 4.3B of the NDS SDPWS.
CSA O86 Design: Check this box if you have wet service conditions. This will effect the Service Condition Factors, Ks
per CSA O86-14 Table 6.4.2.

Header Size
This defines the default header size for all openings. Note that this can be modified in the Wall Panel Editor by
double-clicking the opening and choosing Custom.

Header Matl
By default we will use the same material for the header as we are for the studs, chords, etc. However, you can
change the material here.

840

RISA-3D V20

Wood Wall - Design Rules

Design Rules - Wood Wall (Fasteners)

Schedule
You can select the Code, and Panel Group you would like to use for design optimization. By unchecking the Select
Entire Panel Group box an individual panel type may be assigned. For information on how the optimization works,
see the Wood Wall - Design topic. For more information on this schedule, as well as information on how to edit or
create your own custom schedule, see Appendix F-Wood Design Databases

Min/Max Panel Thick
These values set minimums and maximums for the thickness of the sheathing that will be designed. If the same
value is input for both max and min, then that will be the thickness used.

Double Sided
You can choose whether you want the program to force sheathing on only one side of the panel, both sides, or to
choose the optimum based on weight.

Max/Min Nail Spacing
These values set minimums and maximums for the spacing of the nails that fasten the sheathing to the boundary
members (top plate, sill plate, hold down chords). Note that a 12" spacing is assumed for all field nailing (nails
fastening the sheathing to the internal studs).

HD Chords
You can choose what member size you would like to use for the Hold Down Chords (Posts) at both ends of the wall
panel.

HD Chord Material
You can specify whether the hold down chords are of the same material as the wall, or another material.
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Hold Down
You can select the Manufacturer and Hold Down Series you would like to use for design optimization. By selecting
Explicit Hold Down from the Current Selection Type drop-down you can select an individual hold down product
to be assigned. For information on how the optimization works, see the Wood Wall - Design topic. For more
information on this schedule, as well as information on how to edit or create your own custom schedule, see
Appendix F-Wood Shear Wall Files

Chord Strap
You can select the Manufacturer and Strap Series you would like to use for design optimization. By selecting
Explicit Hold Down from the Current Selection Type drop-down you can select an individual hold down product
to be assigned. For information on how the optimization works, see the Wood Wall - Design topic. For more
information on this schedule, as well as information on how to edit or create your own custom schedule, see
Appendix F-Wood Shear Wall Files
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Eccentricity
You can choose to include the eccentricity of the Hold-Down location by checking the "Eccentricity" check-box in
this spreadsheet. This is used in calculating the Chord forces and the Hold Down force. The Hold-Down center-line
is defined in the Hold-down database.
If the "Eccentricity" check-box is left unchecked the program will use the full length of the wall (ignoring the chord
thicknesses and the hold down eccentricity).
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Note:
l
l

844

Eccentricity option is only applicable to hold-downs, not straps.
Eccentricity option does not affect the capacity of the wall sheathing.
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Wood Wall Results
Wood Wall results are presented in the Wall Panel Design Spreadsheet and the detail reports.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Wood Walls.

Wood Wall Results Spreadsheets
Wood Wall Axial Results

The Wall Panel column lists the wood wall panels that you have defined.
The Region column lists the wall panel region that the results are based on.
Note:
l

For Perforated or Force Transfer Around Openings design methods, regions are not used. Thus, an N/A will
be displayed.

The Stud Size and Spacing columns show the optimum stud size and spacing chosen for your wall, based on the
Design Rules you have defined.
The Axial Check value is a code check ratio between the member load and the member capacity. The adjacent Gov
LC column shows the governing load combination for the design.
The Chord Size column shows the optimum chord size chosen for your wall, based on the Design Rules you have
defined. Note that the chords are the vertical hold-down members/posts at the both ends of the wall.
The Chord Axial Check value is a code check ratio between the member load and the member capacity. The
adjacent Gov LC column shows the governing load combination for the design.
Note:
l

l

When running the Segmented design method, the wall panel regions above and below the opening are not
considered in design. Thus an NC (no calculation) will be displayed.
If there are some constraints that will not allow a wall to be designed, an NC (no calculation) will be displayed. Check the Warning Log within the program for more information on this.

Wood Wall In-Plane Results
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The Shear Panel Label shows the optimum shear panel arrangement chosen for your wall, based on the Design
Rules you have defined.
The Region gives the region for which the design values are being displayed.
Note:
l

The Perforated and Force Transfer Around Openings methods do not consider regions in their design, thus
N/A is displayed.

The Shear Check value is a code check ratio between the panel shear load and the panel shear capacity. The Shear
Force and Gov LC show the values and load combination which governed the design.
The Hold-Down Label shows the optimum hold-down product chosen for your wall, based on the Design Rules you
have defined.
The Chord Strap Label shows the optimum strap product chosen for your wall, based on the Design Rules you
have defined.
The Tension Check value is a code check ratio between the tension load and the hold-down tensile capacity. This
column will only be populated for wood walls at the base level of the structure. The program does not do wall to
wall strap design.
The Tie-Down Forceand Gov LC show the maximum value of hold-down/strap and the load combination which
produced the highest strap force. This maximum force could occur on either end of the wall/region.
Note:
l

l

l

When running the Segmented design method, the wall panel regions above and below the opening are not
considered in design. Thus an NC (no calculation) will be displayed. If running a combined RISAFloor and
RISA-3D model use RISAFloor to get header results.
If there are some constraints that will not allow a wall to be designed, an NC (no calculation) will be displayed. Check the Warning Log within the program for more information on this.
If 'default' is shown in the Hold-Down Label column it means that a hold down is not required for this
wall/region.

Wood Wall Header Results

The Header Label gives the label of your header. If there is more than one header in a wall you can see which is
which in the wall panel editor.
The Design Rule gives the rule that is defining the size and material.
The Size gives the size from the Design Rule.
The Bend UC value is a bending code check ratio. This is given for the load combination from the Gov LC column.
The Shear UC value is a shear code check ratio. This is given for the load combination from the Gov LC column.
The Gov LC gives the load combination that governed the design. The program finds the largest UC value for either
bending or shear and reports the associated load combination here.
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Note:
l

l

The Bend UC and Shear UC are always given for the SAME load combination. Whichever load combination
produced the highest code check for either bending or shear will have its results shown in these columns.
The program will only design wood headers for non-EL and non-WL load combinations.

Wood Wall Self Weight
The program will calculate the self weight of a wood wall based on the weights of the individual components. Using
the material density, the self weight is calculated for the studs, chords, top plates, sill plates, and sheathing. These
are all then summed for the total self weight of the wall.

Wood Wall Detail Reports
The detail report gives detailed information about the wall design. The detail reports are specifically molded to the
type of design specified. Here we will walk through how to access the different information for each of the types of
design: Segmented, Perforated and Force Transfer Around Openings.
Note:
l

l

RISAFloor only considers the Segmented design method. If using RISAFloor together with RISA-3D, simply
taking your model into RISA-3D will open up the Perforated and Force Transfer Around Openings design
methods.
Many of the values for design checks seen below are not performed in RISAFloor as it is strictly a gravity
design program.

Accessing the Detail Reports and the Specific Windows
Once you have a solved model, the detail reports become available. They are accessible in two ways:
1. If you have the Wall Panel Design spreadsheet open,
2. If you are in a graphic view of your model, there is a button that will open up the detail report window.
Note:
l

Detail report information is not available for an envelope solution.

Once the detail report window is open, you will see a dialog area at the top.
l

- Allows you to click between the different wall panels in your model.

The Wall detail report gives an overall summary of your wall, complete with governing code checks and opening
information. The Opening detail report gives information to the header design for the opening as well as detailed
information for the Force Transfer Around Openings method. The Region detail report only applies for
Segmented walls. Below we have give detailed information on each type of design: Segmented, Perforated and
Force Transfer Around Openings.

Segmented Method
The Segmented design method uses each of the three detail report windows to give design information.

Wall Window
This window gives an overview of the wall, giving controlling region information and deflection information. Note
that this window only gives information on the full-height segments in your wall, as this is the basis of the
Segmented method.

Input Echo
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This lists information about the wall, similar to the Region report and also gives an image of the wall. The image
shows the location of hold-downs/straps, regions and headers.
Design Summary
The Enveloped Results gives the code checks for all of the controlling elements in the wall and their associated
load combinations.
The Region Information gives the tabulated results of all of the full-height regions in your wall.
The Opening Information simply states that header design cannot be completed with the Segmented method. The
regions above and below the opening have their shear stiffnesses set to be zero and this causes the header forces to
be invalid.
The Deflection Results gives both the calculated NDS deflection (Maximum Region Deflection) and the FE
deflection for use as a means of comparison. Because the NDS/CSA O86 equations are empirical and take into
account many non-elastic considerations such as nail slip, these two values may not be the same. The use of the
SSAF helps to make these two values similar.

Opening Window
This window defines the openings in the wall. The segmented wall design method assumes zero stiffness over the
opening, therefore, there is no header design for a Segmented wall with openings. Walls specified as a Perforated or
FTAO can be analyzed for a header design.

Region Window
This window gives information for your wall on a region by region basis. Note that only full-height regions of the
wall panel will have a region detail report. The Segmented method only considers these full height segments in the
design of the wall.
The region detail report is split into four portions: input echo, diagrams and design, design details, and cross section
detailing. Note that in RISAFloor the detail reports are less detailed because RISAFloor does not consider lateral
forces which RISA-3D does.

Input Echo
Below is the input echo portion of the detail report.

Criteria

Description

Code
Wall Material

Gives the code used to design your wall panel.
Specifies the wood type assigned to the entire wall
Specifies the sheathing/nailing schedule database used to optimize panel selection
(set in Design Rules)
Shows whether or not the program needed to optimize the hold-down, or if the
user explicitly defined a hold down
Specifies the manufacturer of chosen hold-down
Specifies the manufacturer of chosen strap

Panel Schedule
Optimize HD
HD Manufacturer
Strap Manufacturer
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Materials

Description

Wall Studs
Stud Size

Top Plate & Sill
Top Plate Size
Sill Plate Size

Specifies the wood material type assigned to the wall studs
Specifies the member size used for the wall studs
Specifies the wood material type assigned to the chords (vertical members at both
ends of the wall)
Specifies the member size used for the chords (vertical members at both ends of
the wall)
Specifies the wood material type assigned to the top and sill plates
Specifies the member size used for the top plate
Specifies the member size used for the sill plate

Geometry

Description

Total Height
Total Length
Region H/W Ratio

This is the height of the wall panel region
This is the length of the wall panel region
This is the ratio of wall height to length, using the minimum wall height
This is an aspect ratio reduction factor for the shear panel strength per NDS
SDPWS section 4.3.3.4 Exception 1 (2015). This factor applies only for seismic
loads, thus it will be 1.0 for wind load combinations per NDS SDPWS section 4.3.4.1
(2005/8). This factor is applied separately for each full-height region in your wall.
This is an aspect ratio reduction factor for the shear panel strength per NDS
SDPWS section 4.3.4.2 (2015). This factor applies only for seismic and wind loads
on Segmented or FTAO walls. This factor is applied separately for each region in
your wall.
This is the governing (minimum) factor per the Cap. Adj (2w/h) and Aspect Ratios
shown above. Only the minimum shall apply per NDS SDPWS section 4.3.3.4 Exception 1.
The code gives a 40% increase in the tables if the lateral load is wind over seismic.
For seismic loads this ASIF will be 1.0 (only applicable to NDS design).
This is the optimized stud spacing based on your Design Rules
This is the effective length, K Factor used for stud and chord compression design
This is the eccentricity of the hold-down connection. This is based on the manufacturer's catalog and measured as the distance from the center of the chord to
the hold-down bolt

Chord Material
Chord Size

Cap. Adj (2w/h)

Aspect Ratio

Gov. H/W Cap.
Wind ASIF
Stud Spacing
K
HD Eccentricity

Diagrams and Design
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Envelope Diagrams
These diagrams show the axial forces, in-plane shear, and in-plane moments of the wall, as well as the maximum
and minimum forces and their locations.

Note:
l

The diagrams are not actually enveloped.
l The Axial diagram shown is the diagram from the governing load combination for Stud design.
l The Shear diagram is the diagram from the governing load combination for Shear Panel design.
l The Moment diagram is the diagram from the governing load combination for Hold-Down design.

Design Summary
This portion gives you the capacity and strength values at the section in the wall where the combined check is
maximum, as well as the governing load combination. Much of this information is also reported in the Wood Wall
Panel Design spreadsheets.
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Shear Panel
The provided capacity of the shear panel is taken from the Shear Capacity column of the panel database. This is the
allowable shear value from Table 2306.4.1 from the 2006 IBC (for NDS design) or Table 9.3A, 9.3B, and 9.3C from
the CSA O86-14 (for Canadian design). This capacity automatically considers whether the loading is based on wind
or seismic loads. The Governing LC explicitly states if the controlling load combination was based on Wind or
Seismic. The program does a unity check for all LCs that are being solved, finds the maximum value and reports that
information.

Note:
l

l

A shear panel design will be chosen for the worst-case region in a segmented wall. That panel will then be
used for all regions in that wall. The worst-case region is the one that has the highest Shear UC value.
Because wind and seismic loading allows for different design capacities, the highest shear in the wall may
not be the governing shear (if that highest shear was due to wind).
Chords, Studs

The provided capacities of these members are calculated using the standard provisions for tension/compression
members. These members are assumed to be fully braced in the weak axis, and unbraced in the strong axis. For
more information on the chord force calculations, see the Wood Wall - Design topic.
Note:
l

For chord results, the tension/compression capacity is computed using the reduced cross-sectional properties caused by the hold-down bolt hole.
Hold-Downs

The provided capacity of the hold-down is taken from the Allowable Tension column of the hold-down database.
This is information supplied by the manufacturer. Note that we are modifying the Cd value for the hold-down based
on taking a ratio of the assumed Cd values from the database and the Cd called for in the Load Combinations
spreadsheet.
Chord Straps
The provided capacity of the chord strap is taken from the Allowable Tension column of the chord strap database.
This is information supplied by the manufacturer. Note that we are modifying the Cd value for the chord strap
based on taking a ratio of the assumed Cd values from the database and the Cd called for in the Load Combinations
spreadsheet.
Deflections
The deflection listed in the detail report is based on an approximation from the design code.:

NDS Design Deflection
Per the NDS 2015 Special Design Provisions for Wind and Seismic, Equation 4.3-1:

b = Shear wall length, ft
Δa = Total vertical elongation of wall anchorage system (including fastener slip, device elongation, rod elongation, etc.) at
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the induced unit shear in the shear wall, in (This value is taken from the hold down database and scaled per the
actual tension force; hence you multiply this value by the holddown ratio given in the output)
E = Modulus of elasticity of end posts (chords), psi
A = Area of end post (chord) cross-section, in2
Ga =

Apparent shear wall shear stiffness from nail slip and panel shear deformation, kips/in. (taken from shear panel database)

h = Shear wall height, ft
ν = Induced unit shear, lbs/ft
δsw = Total shear wall deflection determined by elastic analysis, in
The first term of the above equation determines the Bending Component of the deflection.
The second term of the above equation determines the Shear Component of the deflection.
The third term of the above equation determines the Hold-Down Elongation, which causes additional deflection.

Note
l

l

l

This is the theoretical deflection of the wall. This may differ from the deflection of the wall as performed by
finite element analysis within RISA. Therefore, this deflection value may not coincide with the reported
deflection value in the deflections spreadsheets. For information on making the FEM deflections similar to
the reported deflections from the NDS calculated deflections, see the Shear Stiffness Adjustment Factor
information.
For Perforated design deflections, the total deflection is to be divided by Coper section 2305.3.8.2.9 of the
IBC 2006. Because the unit shear values have already been amplified by Co, the only portion of the deflection
that needs to be divided is the hold-down portion.
The hold-down deflection is reported for the maximum shear LC, which may not result in the largest holddown component, but typically results in the highest total deflection.

CSA O86 Design Deflection
Per the CSA O86-14 clause 11.7.1.2 (or CSA O86-09 clause 9.7.1.1):

Total vertical elongation of wall anchorage system (including fastener slip, device elongation, rod elongation,
da = etc.) at the induced unit shear in the shear wall, mm. (This value is taken from the hold down database and
scaled per the actual tension force; hence you multiply this value by the hold down ratio given in the output)
E = Modulus of elasticity of boundary elements (chords), N/mm2
A = Area of end post (chord) cross-section, mm2
Bv= Shear through-thickness rigidity of the sheathing, N/mm (taken from shear panel database)
Hs = Shear wall segment height, mm
Ls =Shear wall segment length, mm
ν = Induced unit shear, N/mm
Δsw = Total shear wall deflection determined by elastic analysis, mm
The first term of the above equation determines the Bending Component of the deflection.
The second term of the above equation determines the Shear Component of the deflection.
The third term of the above equation determines the Hold-Down Elongation, which causes additional deflection.
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Note
l

l

This is the theoretical deflection of the wall. This may differ from the deflection of the wall as performed by
finite element analysis within RISA. Therefore, this deflection value may not coincide with the reported
deflection value in the deflections spreadsheets. For information on making the FEM deflections similar to
the reported deflections from the CSA calculated deflections, see the Shear Stiffness Adjustment Factor
information.
The hold-down deflection is reported for the maximum shear LC, which may not result in the largest holddown component, but typically results in the highest total deflection.

Design Details
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The Selected Shear Panel gives the call-out from the shear panel database. The information below it is the
information describing the call-out.
Note:
l

There will also be an "Adjusted Shear Capacity" that takes the given shear capacity from the design code and
divides it by any appropriate adjustment factors from the Geometry section at the top of the report.

The Selected Hold-Down gives the call-out from the hold-down database. The information below it is the
information describing the call-out. The "Base Capacity" is the capacity from the manufacturer divided by the
assumed Cd value from the database. The "CD factor" that is displayed is the value from the load combinations
spreadsheet for the controlling load combination. The actual capacity of the hold-down is the Base Capacity*CD
factor.
The Selected Chord Strap gives the call-out from the strap database. The information below it is the information
describing the call-out. The "Base Capacity" is the capacity from the manufacturer divided by the assumed Cd value
from the database. The "CD factor" that is displayed is the value from the load combinations spreadsheet for the
controlling load combination. The actual capacity of the chord strap is the Base Capacity*CD factor.
The above section of the report echoes the database information for the selected shear panel and hold-down. For
more information on these properties refer to Appendix F-Wood Shear Wall Files.

Cross Section Detailing
The last section of the detail report consists of the wall detailing information. This information is provided as a
visual confirmation of the wall design. The wall thickness, and stud spacing are shown as dimensions. The triangle
shows sheathing on one side of the wall, with the abbreviated panel designation. The chord sizes/forces and hold
down or strap designations/forces are shown at either end. If either chord is only experiencing a compression force,
the hold down or strap will not be drawn.

Note:
l

The displayed chord force is not necessarily the force used in the hold-down design because hold-down
optimization only considers the governing tension LC.

Perforated Method
Opening Window
This window is identical to the Segmented Window information.

Wall Window
This is where the majority of the information is located for the perforated method.
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The General information gives some of the important parameters in designing the wall.
The Geometry section gives dimensions and ratios for the wall panel.
l

l
l
l

The Wall H/W Ratio is checked against the aspect ratio limits given in Table 4.3.4 of the NDS 2015 Special
Design Provisions for Wind & Seismic (SDPWS).
The Max Opening Ht is used in the calculation of Co.
The % Full Ht Sheathed is used in the calculation of Co.
The Full Ht Sheathed is the Sum Li value for Co.
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The Materials information just gives the sizes of the members that are not explicitly talked about in the detail
report.
Note:
l

The top plate, sill plate and trimmer sizes are used only for the Material Take Off.

The Design Details section gives adjustment factors and some other values used to calculate Co. See the Wall
Panels topic for more information on the Shear Stiffness Adjustment Factor. See the Wood Wall - Design topic for
more information on Co.
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The Deflections section gives the calculated deflection for the three term shear wall equation from the NDS. See
above for more information on deflections.
The Wall Results section gives:
l

l
l

l

The Governing LC is the load combination that produced the highest allowable code check. This will also
state if this load combination was a wind or seismic LC.
The Total Shear is the total shear in the wall for the governing LC.
The Max. Unit Shear is the maximum shear in the shear panel and it is what is used to optimize the sheathing/nailing selection from the shear panel database. Note that the Max Unit Shear may not be the absolute
maximum, because shear walls governed by wind are allowed a 40% stress increase. Thus, a wind Max Unit
Shear would need to be 40% higher than a seismic Max Unit Shear to govern.
The Shear Ratio is a ratio of the Max Unit Shear over the Shear Capacity of the shear panel selected from the
database.

The Selected Shear Panel , Selected Hold-Down, and Selected Strap section gives the same hold down, strap, and
shear panel information that was given in the Segmented region report.
There is then the chord, stud, hold-down, and strap design section that has the same information as given in the
Segmented region report.
The Cross Section Detailing section gives a detailed view of the wall. For more information see the Segmented
section.

Force Transfer Around Openings (FTAO)
Wall Window
This is the overall wall information and is essentially identical to the Perforated method wall window information.
There is some geometry information that is not necessary for FTAO that is omitted.
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Opening Window
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The Criteria section gives the code being used and which design method used.
The Geometry section gives the opening dimensions and the h/w ratio.
The Materials section gives dimensions for some of the members in the wall.
The Envelope Diagrams give the enveloped shear and moment diagrams for the header beam above the opening.
The FTAO graphic shows the design block numbers around the wall panel opening along with the strap numbers.

General Reference Manual

859

Wood Wall Results

The Design Details section is split into two different tables: Opening Straps and Analysis Summary. The opening
straps information gives the location, direction, force in the strap and the load combination that caused that force.
Note:
l

l

For more information on how the strap forces and unit shears are calculated, see the Wood Wall - Design
topic.
The program does not design the straps around the opening, just presents the forces.

The analysis summary gives the unit shear and the h/w ratio for each of the blocks.
The information below is the code check information for the header member. This is identical to the information
given for Segmented Window information.
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Warning Log

The Warning Log Spreadsheet provides you with a record of any warnings or errors that occurred during the
solution of your model. The log should be reviewed for warnings or errors that would affect the design of your
structure. The error log reports back the item label for which the error occurred.
You can view the warning log by clicking on the Spreadsheets menu item and then clicking on the Warning Log
selection.
Pressing the ! hyperlink will open the help file to give further explanation on this item.
Here is a common warning which could require some additional explanation:

Sum of reactions is not equal to the sum of the loads (LC xx)! Check for any small rigid
links or fixed boundary conditions.
When the solution is complete, the program checks the sum of the reaction forces in each direction if this is more
than 0.1% different from the sum of the applied loads, then this warning message will be displayed. The most
common causes for this warning message are the following:
l

l

l

A joint instability which has been automatically LOCKED by the program. If the joint is locked then the reaction at that location is not computed. Once you rectify the instability then this warning log message should
also go away. You may also need to uncheck the "Lock isolated ROTATIONAL instabilities without notification" box as this may conceal some instabilities. See the Stability section for more information.
A user assigned boundary condition which was used the "Fixed, reaction will not be calculated" option rather
than the "Reaction" option. See the Boundary Conditions section for more information. Using the term
"Fixed" suppresses the reaction output in the Joint Reactions and thus the applied loads does not equal joint
reactions. In this case the Warning Log could likely be ignored, as there is a valid reason for this discrepancy.
A "ghost reaction" may have developed where one or more rigid elements (Diaphragms, rigid end offsets, or
rigid links) have become so stiff that they actually became stiffer than the internal stiffness used by the program to define boundary conditions. In this rare case forces may be leaving the model at locations other than
boundary conditions. Having a combination of a rigid diaphragm, rigid links, rigid end offsets, top of member
offsets, etc., all in a localized place in the model could cause these.

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Sum of Reactions.

Please refer to the Help File in RISA-3D for detailed information about each error message. The
Help File may be accessed by selecting
The RISA Help in the upper right-hand corner. Choose
the Warning Log topic
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The Wood Database may be accessed from the Wood tab of the Section Sets spreadsheet by clicking in the Shape
field and then clicking
, or by clicking the Shape Database button on the Advanced tab of the ribbon and then
clicking the Wood tab of the Shape Database dialog.

Wood Material/Shape Selection
Unlike any other material, the design properties for wood members depends both on the material selection as well
as the shape selection. Therefore, the Wood tab of the Shape Selection database contains shape and material
selections.

Material Selection
The Material Selection menu reads in material options that are currently listed on the Wood tab of your Materials
spreadsheet. You may select one of these existing materials, or click on the Create/Edit Wood Material button
to open the Create/Edit Wood Material dialog which will allow you to add in a new material, or edit an existing
material without having to go to the Materials spreadsheet.

Create/Edit Wood Material dialog
The Create/Edit Wood Material dialog allows you to create or edit a material that will then be automatically
added to your Materials spreadsheet. This allows you to enter/select this information directly from the Draw
Members Property Panel without having to first manually enter the information in the Materials spreadsheet.
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l

To create a new custom wood material, first choose Custom from the Wood Type drop down. Then click on
the New button to manually enter the design values for a new custom wood material. This information will
then be automatically saved to the Custom Wood Species spreadsheet.

Size Selection
Currently there are two ways to define a member size. In the Shape Type dropdown the options available are from
either the defined list of Nominal Sawn Lumber sizes, or by using the Net Rectangular/Round option (typically
referred to as Full Sawn).
l

l

The Nominal Sawn Lumber option will populate a list of nominal sized shapes for the NDS design code and
a list of net sized shapes for the CSA O86 design code. When the NDS design code is chosen, the program will
automatically reduce the shape properties to their net sizes. If the CSA O86 design code is selected, a list of
actual metric sizes will be shown.
Either Net Rectangular or Net Roundoption will allow you to manually enter any dressed size that you like.
o Rectangular imperial full sawn (as opposed to nominal dimensions) shapes will be designated with a
"FS" suffix. You may also use this nomenclature to type the size directly into the spreadsheet. For
example, a 7.25"x12" net rectangular member can be typed in as "7.25x12FS".
o Rectangular metric full sawn (as opposed to nominal dimensions) rectangular shapes will be designated with a "MFS" suffix. You may also use this nomenclature to type the size directly into the
spreadsheet. For example, a 184mmx305mm net rectangular member can be typed in as
"184x305MFS".
o Round imperial shapes will be designated with a "RND" suffix. You many also use this nomenclature to
type the size directly into the spreadsheet. For example, a 10" net round member can be typed as
"10RND".
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o

Round metric shapes will be designated with a "MRND" suffix. You many also use this nomenclature to
type the size directly into the spreadsheet. For example, a 254mm net round member can be typed as
"254MRND".

Note
l

l

Multiple-ply lumber is assumed to be fastened sufficiently to achieve full composite behavior between
plies. Therefore a two-ply member will have eight times greater minor-axis flexural stiffness than a
single ply member (as opposed to double the stiffness).
If using multiple plies there is a Bolted check-box. If this box is unchecked it is assumed that the plies
are nailed together. If bolted is checked then it is assumed the plies are bolted together. This affects the
Kf value from section 15.3.2 of the NDS 2005/2008, 2012, 2015, and 2018. If you define the multi-ply section as bolted a "B" (or "MB" for metric sizes) will appear after the shape name.

View Design Properties
Once you have selected the appropriate member size and material, you can view the un-adjusted wood design
values (Fb, Fv, Ft, etc.) for the selected combination in the Properties table at the bottom of the dialog. The final
adjusted values (Fb', Fv',Ft', etc.) will then be displayed after solution in the Member Detail Reports.

Wood Database Limitations:
Round Shapes
Per section 3.7.3 of the NDS, the design of a round cross section shall be based on the design calculations for a
square shape with the same cross-sectional area. Therefore the moment of inertia values will be calculated per the
equivalent square shape, not the round cross section. However, the section modulus value, S is calculated per the
actual round shape.

Glulam Databases
The program includes five tables of available glulam materials: NDS Tables 5A - 5D and CSA O86 Table 6.3. The
values in NDS tables 5B & 5D depend on the number of laminations in the glulam. Therefore you will see three
listings (2 Laminations, 3 Laminations, or 4 Laminations) for each material. If you have a custom material that is not
available from these lists, you can always enter your appropriate design values as a Custom Wood Material for use
in your model.
Note:
l

l

The design values used per NDS tables 5B & 5D take into account footnote #1 to reduce the reference shear
design value Fvy depending on the number of lamintations.
None of the other footnotes in either of these tables is taken into account.

Mechanically Graded Lumber
Mechanically graded lumber grades (MSR & MEL) are available for use with the ANSI/AWC NDS-2015 and the CSA
O86-2014 design codes. Older versions of the design codes will not support design of mechanically graded materials
from the program databases. However, you can always enter the properties as a Custom Wood Material to get the
design calculations for these materials in older code versions.
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In order to assign a mechanically graded lumber material, you must select both the species and then the mechanical
(MEL or MSR) grade. The species selection determines the shear capacity and compression perpendicular to grain
capacity design values.
See Footnote #2 from NDS 2015 Table 4C which says that all species from NDS 2015 Table 4A are applicable. See
clause 6.3.2 from CSA O86-14 which says that specified shear strengths shall be taken from CSA O86 Table 6.3.1A.
The other design values are defined per the mechanical grade. See NDS 2015 Table 4C and CSA O86-14 Tables 6.3.2
and 6.3.3.

Structural Composite Lumber (SCL)
Each SCL manufacturer has documentation of their proprietary material design values. Because these are updated
so often, RISA-3D relies instead on the design data from approved product reports (APA and ICC-ES) to build the
material databases:
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Footnote Limitations:
Each of the above reports includes tables with design values which were used to create the RISA-3D and RISAFloor
SCL design property material databases. However, due to the difficulty of design variation, the following limitations
are present:
l

l

l

The Fb design values are not factored in accordance with the depth of the member. Currently RISA-3D
always uses the single tabular Fb value regardless of member size.
The Ft design values are not factored in accordance with the length or thickness of the member. Currently
RISA-3D always uses the single tabular Ft value regardless of member size.
The Fb design value will be increased by 4% if the member is designated as a repetitive member using the Cr
check-box on the Wood tab of the Members spreadsheet.

Alternatively, you can always enter the appropriate design values, per the applicable footnotes, as a Custom Wood
Material.

Design Values
The design properties may be verified by clicking on the elipsis next to the Material section of the specific member's
information in the Property Panel.

The values are as follows:
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l
l
l
l
l
l
l
l
l
l
l
l

l
l

Fb_joist: Bending capacity due to joist/beam edge loading
Fb_plank: Bending capacity due to plank/flat edge loading
Fv_joist: Shear capacity due to joist/beam edge loading
Fv_plank: Shear capacity due to plank/flat edge loading
Fc_joist: Compressive (perpendicular to grain) axial capacity due to joist/beam edge loading
Fc_plank: Compressive (perpendicular to grain) axial capacity due to plank/flat edge loading
Fc: Compressive (parallel to grain) axial capacity, regardless of load direction
Ft: Tensile axial capacity, regardless of load direction
E_joist: Modulus of elasticity due to joist/beam edge loading
E_plank: Modulus of elasticity due to plank/flat edge loading
E_mod: Young's Modulus modifier (always set as 1.0)
COV_E: Coefficient of Variation in Modulus of Elasticity per NDS Table F1. This value is used in the Emin calculation. For SCL materials COV_E always equals 0.10.
E_joist_min: Emin (as calculated per NDS Appendix D equation D-4) due to joist/beam loading
E_plank_min: Emin (as calculated per NDS Appendix D equation D-4) due to plank/flat edge loading

Currently the program only designs using the Joist properties of the SCL materials. This assumes that the loading is
always on the small dimension side of the member. In a future version we will be taking the Plank values into
consideration as well. In the meantime you can always enter the appropriate design values from these tables as a
Custom Wood Material for use in your model.
Note:
l

Canadian wood member design only includes SCL design for the CSA O86-14 code.

Custom Wood Sizes:
If you would like to enter explicit dimensions of a member or if the member is "Not Dressed", the member must be
designated as a "Full Sawn" member by choosing Net Rectangular as the Shape Type and entering the exact
dimensions of the member in the boxes below. This applies to regular wood species, custom wood species,
Structural Composite Lumber (SCL), and Glu-Lam members.
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Full code checking can be performed on Dimension Lumber and Post and Timber size wood shapes based on the
following codes:
l
l
l
l
l
l
l
l

The 2018 edition of the NDS
The 2015 edition of the NDS
The 2012 edition of the NDS
The 2005/08 edition of the NDS
The 2001 edition of the NDS
The 1991 / 1997 editions of the NDS
The 2014 edition of the CSA O86 Canadian wood design code
The 2009 edition of the CSA O86 Canadian wood design code

Note
l

When the 1991 / 1997 NDS is selected, the 1991 NDS specification will be used with the 1997 stress
tables. This is consistent with the requirements of the 1997 UBC.

Glu-Lams
Glu-Lams are treated as any other wood species and may be selected from the list of species on the Wood tab of the
Materials spreadsheet.

Glulam Material Properties
Available Glulam Materials are per Tables 5A and 5C of the NDS Supplement and Table 6.3 of the CSA O86. When a
Glu-Lam is selected, the grade will be listed as "na" or not applicable.
If you prefer to use a material that is not listed in the design code glulam tables, please enter the material type as a
Custom Wood Species.

Note
l

l

l

Glu-Lams from Table5A are always assumed to have the special tension laminations. Therefore, the Fbx
value is not reduced.
RISA is NOT applying any of the footnotes to Table 5A and 5C at this time except for the following:
l Footnote #1 from Table 5A - For balanced materials Fbx- shall equal Fbx+ for the stress class.
l Footnote #3 from Table 5A - Fvx and Fvy are increased for Southern Pine Glulam materials.
Commentary to CSA O86 Clause 6.2 notes that the Hem Fir glulam species listed in Table 6.3 are not common and therefore they are not included by default in RISA. If you prefer to use one of these materials,
please enter it as a Custom Wood Species.

Glulam Dimensions
All Glu-Lam members should be dimensioned as "Full Sawn" using the format wXdFS (or wXdMFS for metric sizes),
where "w" and "d" are the actual width and depth dimensions. If the size is entered as wXd without the FS
designation, then the size will be assumed to be regular dimensional lumber.

Glulam Redesign Lists/ Optimization
RISA includes two redesign lists for Glu-Lams: Glu-Lam_Western for Western Species and Hardwoods (HW), and
Glu-Lam_SouthernPine for Southern Pine (SP/SP).

868

RISA-3D V20

Wood - Design

Glulam Limitations
Please note that glulam design is not supported for the 91/97 NDS design code.

Custom Wood Materials
To use a custom wood material that is not part of the standard NDS or CSA O86 databases, you will need to define
the custom design properties. This can be done through the Materials spreadsheet or by clicking the Custom
Wood button on the Advanced tab.

Custom Wood Properties Spreadsheet
To access the Custom Wood Properties input dialogue, click the Custom Wood button on the Advanced tab.
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l
l
l
l
l
l
l
l

Fb - Bending Stress Limit
Ft - Tension Stress Limit
Fv - Shear Stress Limit
Fc - Compression (Parallel to Grain) Stress Limit
E - Modulus of Elasticity
E05 - Fifth Percentile Modulus of Elasticity (for Canadian CSA O86 design only, ignored for NDS design)
Type - Wood Type, used for determination of design variables (COVE, Emin, c, etc.) and design calculations.
CF/KZ - Wood Size Factor. The program will default this to 1.0 unless manually entered by the user.

Notes:
l

l
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Most wood materials (sawn lumber visually & mechanically graded, glulam, SCL, and LVL) are available in
the current wood materials database. Please see the Wood tab of the Materials spreadsheet for more information.
Due to the limited entries in the Custom Wood spreadsheet, Glulam members are always assumed to be balanced, uniform material:
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o
o
o
o

Fb is taken as the Fbx+, Fbx-, and Fby values for glulam design.
Fv is taken as the Fvx and Fvy values for glulam design.
E is taken as the Ex and Ey values for glulam design.
Glulams will always use the CV volume factor equation per NDS Table 5C (this is the same equation as
Tables 5A,5B, and 5D assuming that the material is not Southern Pine).

Create and Apply a Custom Wood Material
Create and apply your custom material by doing the following:
1. First, open the Materials spreadsheet and click on the Wood tab.
2. Select the last row in the spreadsheet and press Enter to create a new entry.
3. Select "Custom" as the material Type.
4. Click within the Species cell and then click on the triple dot
button. This will open the Select Custom
Material dialog box.
5. Either select an Existing Material (this is read in from the Custom Wood Properties dialogue, see above),
or Create a Custom Material by typing the properties directly into this dialog.

Note
General Reference Manual
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l

The Type menu is used to designate whether the entry is a Visually Graded sawn lumber, a MSR mechanically graded lumber, a MEL mechanically graded lumber, a Glulam material, or a SCL (structural composite lumber). This selection effects the design factors and the applicable provisions of the selected
design code.

For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Custom Wood Species.

Wood Member Design Parameters
The Member Design Parameters spreadsheet records the design parameters for the timber code checks and may
be accessed by selecting Members from the Data Entry toolbar on the Explorer panel and then clicking on the
Wood tab. These parameters may also be assigned graphically. See Modifying Member Design to learn how to do
this.

These parameters are defined for each member.

Label
You may assign a unique Label to all of the members. Each label must be unique, so if you try to enter the same
label more than once you will get an error message. You may relabel at any time by right clicking within the
spreadsheet and choosing either Relabel All Members or Relabel Selected Members.

Shape
The member Shape or Section Set is reported in the second column. This value is listed for reference only and may
not be edited as it is dictated by the entry in the Section/Shape column on the Primary tab.

Length
The member Length is reported in the third column. This value may not be edited as it is dependent on the
member end coordinates listed on the Primary Data tab. It is listed here as a reference for unbraced lengths which
are discussed in the next section.

Unbraced Length
See the Unbraced Lengths topic.
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K Factors (Effective Length Factors)
See the Unbraced Lengths topic.

Adjustment Factors
Please see below for information about the various wood adjustment factors.

Sway Flags
See the Unbraced Lengths topic.

NDS Adjustment Factors
The NDS design codes have a number of adjustment factors that are applied to the various allowable stresses to
determine the capacity of the member. The adjustment factors are summarized in section 2.3 of the code. The
following topics help to summarize how adjustment factors are obtained and used.

Note
l

l

Cb (Bearing Area Factor), CT (Buckling Stiffness Factor), Cc (Curvature Factor), CI (Stress Interaction Factor),
and Cvr (Shear Reduction Factor) are NOT used in the RISA analysis.
If you are using the Canadian CSA O86 design code, see the section below for the CSA adjustment factors.

Timber Design CD (Load Duration Factor- NDS)
CD is the Load Duration adjustment factor used for ASD codes. It is entered on the Load Combinations spreadsheet
for each load combination for which you want wood code check results. The CD factor must be entered for each
individual load combination because the CD factor is dependent on the types of loads that are applied in each load
combination. Therefore, different load combinations could have different CD factors. For example, per the NDS 2018
specification, a load combination that had only dead load, would have a CD factor of “0.9”, while another
combination that was comprised of dead load plus wind load would have a CD factor of “1.6”.
The CD factor will only be applied to wood code checks on wood members. See Table 2.3.2 in the NDS 2018
specification for the CD factors to be applied for typical loads. Appendix B has additional information about the
Load Duration Factor.

Note
l

The CD factor used for a load combination should be for the load with the shortest load duration in that load
combination.

Timber Design Cm (Wet Service Factor)
Cm is the Wet Service adjustment factor. It is applied when you check the Cm checkbox in the Materials
Spreadsheet.

Timber Design Ci (Incision Factor- NDS)
Ci is the Incision factor per Table 4.3.8 of NDS code. It is applied when you check the Ci checkbox in the Materials
Spreadsheet.

Timber Design Ct (Temperature Factor)
Ct is the Temperature adjustment factor. It is calculated internally based on the wood Temperature value set on
the Codes tab of Model Settings. See section 2.3.3 of the NDS 2018 for more information on this factor.
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Timber Design CP and CL (Column/Beam Stability Factors - NDS)
The Column Stability Factor, CP, and the Beam Stability Factor, CL, are calculated internally. These calculated values
are shown on the Wood tab of the Code Check Spreadsheet, as well as in the Member Detail Reports. See NDS
2018 section 3.3.3 for information on the CL factor and NDS 2018 section 3.7.1 for information on the CP factor.
The value of Emin used for the calculation of these factors is calculated using equation D-4 from appendix D of the
2018 NDS. For some members (especially for glulams) this equation may produce a slightly more accurate value of
Emin that shown in the NDS tables.

Note
l

The column stability factor, CP, is affected by the Kf factor from NDS 2018 section 15.3.2, depending on
whether multi-ply members are bolted or nailed together. Bolted columns will have a shape name with a B
after. See the Wood-Database topic for information on how to define bolted vs nailed multi-ply members.

Timber Design CF (Size Factor- NDS)
CF is the Size adjustment factor. It is applied automatically when you assign a wood shape from the NDS shape
database. See Tables 4A, 4B, 4D, and 4E in the NDS supplement for information on the CF factor.

Note:
l

Prior to the 2012 NDS, Table 4D (Reference Values for Timbers) combined the Size Factor(CF) and the Flat
Use Factor (Cfu) under the Size Factor (CF) description. Per the code commentary, you are required to apply
both the CF per the equation in Table 4D and the CF per the tabular values. To clarify between the two, the
program calls the calculated value (per the equation) CF and the tabular value Cfu. This is verified with clarification in the NDS 2012 design code.

Timber Design CV (Volume Factor)
CV is the Volume adjustment factor. It is applied automatically when you assign a glulam or SCL material member.
The user can override the calculated value by manually entering the factor on the Wood tab of the Members
Spreadsheet.

Note:
l
l

In the calculation of CV, RISA takes L as the full length of the member. This is a conservative assumption.
This factor is not available for the NDS 1991/1997 design option.

Timber Design Cfu (Flat Use Factor)
Cfu is the Flat Use adjustment factor. is automatically applied to the weak axis allowable bending stress of a wood
member whenever weak axis moments are present. See the tables in the NDS supplement for more information on
this factor.

Note
l
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Prior to the 2012 NDS, Table 4D (Reference Values for Timbers) combined the Size Factor(CF) and the Flat
Use Factor (Cfu) under the Size Factor (CF) description. Per the code commentary, you are required to apply
both the CF per the equation in Table 4D and the CF per the tabular values. To clarify between the two, the
program calls the calculated value (per the equation) CF and the tabular value Cfu. This is verified with clarification in the NDS 2012 design code.
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Timber Design Cr (Repetitive Factor)
Cr is the Repetitive Member adjustment factor. This factor specifies if the beam is one of a group of repetitive
members. This design parameter can be set on the Wood tab of the Members Spreadsheet. If you put a check in
the Cr field, a factor of 1.15 will be applied to beam members that are 2" to 4" thick. See the section 4.3.9 of the
NDS 2018 for information on this factor.

Note
l
l
l

This flag will be ignored for a NDS shape that is thicker than 4".
A value of '1.0' will be used for Wood Products.
Different restrictions apply to the use of the Cr factor for Structural Composite Lumber and Glu-Lams.

Timber Design CH (Shear Stress Factor)
CH is the Shear Stress adjustment factor. This design parameter can be set on the Wood tab of the Members
Spreadsheet. If left blank the program will use a default value of 1.0. See the tables in the NDS supplement for
information on other CH factors.

Note
l
l

The CH factor is only available for the 1991/1997 NDS option. For other codes, this entry will be ignored.
Only tables 4A, 4B, and 4D are used.

Timber Design Cf (Form Factor)
Cf is the Form adjustment factor. It is applied automatically when designing by the NDS 91/97 or 2001 Specification
and a 'Round' shape is selected from the NDS shape database. See section 2.3.8 in the NDS (91/97, 2001) for
information on the Cf factor.

Note
l
l

This factor is not applied when designing with the NDS 2005 or 2012 specifications.
This factor is not applied to "diamond" shaped members, which are just rectangular members on edge.
This factor is not applied to diamond shapes because any applied moments are transformed internally to
the local member axes for the code check calculations, which is the same as applying the “diamond” form
factor and NOT transforming the moments.

Timber Design Kf (Format Conversation Factor)
Kf is the format conversion factor for LRFD design only. The tabulated reference design values provided in the
NDS Supplement contain safety adjustments appropriate for ASD. The Kf factor converts these values to nominal
design values for LRFD. These factors are provided in NDS Table 4.3.1 and Appendix N.

Timber Design Phi (Resistance Factor)
Phi is the resistance factor for LRFD design only. These values are provided in NDS Table 4.3.1 and are dependent
on the property ranging from 0.75 for shear and 0.90 for compression.

Timber Design lambda (Time Effect Factor- NDS)
Lambda is the Time Effect adjustment factor used for LRFD codes. It is entered on the Load Combinations
spreadsheet for each load combination for which you want wood code check results. The lambda factor must be
entered for each individual load combination because the lambda factor is dependent on the combination of loads.
Therefore, different load combinations could have different lambda factors. For example, per the NDS 2018
specification, a load combination that had only dead load, would have a CD factor of “0.6”, while another
combination that was comprised of dead load plus wind load would have a CD factor of “1.0”.
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The lambda factor will only be applied to wood code checks on wood members. See Table N3 in the NDS 2018
specification for the lambda factors to be applied for typical load combinations.

CSA O86 Adjustment Factors
The CSA O86 design code has a number of adjustment factors that are applied to the various allowable stresses to
determine the capacity of the member. The adjustment factors are summarized in clause 4.3 of the code. The
following topics help to summarize how adjustment factors are obtained and used.

Note
l

KB (Length of Bearing Factor), KE (End Fixity Factor), KF (Foundation Factor for plywood), KM (Bending
Capacity Modification Factor), KN (Notch Factor), KR (Radial Stress Factor), KT (Treatment Factor), and KX
(Curvature Factor) are NOT used in the RISA analysis.

Timber Design KD (Load Duration Factor - CSA)
KD is the Load Duration adjustment factor. It is entered on the Load Combinations spreadsheet for each load
combination for which you want wood code check results. The KD factor must be entered for each individual load
combination because the factor is dependent on the types of loads that are applied in each load combination.
Therefore, different load combinations could have different KD factors. For example, per the CSA O86 -2009
specification, a load combination that had only dead load, would have a KD factor of 0.65, while another
combination that was comprised of dead load plus wind load would have a KD factor of 1.15.
The KD factor will only be applied to wood code checks on wood members. See Table 5.3.2.2 in the CSA O86 - 2014
specification for the KD factors to be applied for typical loads.

Note
l

The KD factor used for a load combination should be for the load with the shortest load duration in that load
combination.

Timber Design Ks (Service Condition Factor)
Ks is the Service Condition adjustment factor. It is applied when you check the Ks check-box in the Materials
Spreadsheet. See clause 6.4.2 (sawn lumber) or clause 7.4.2 (glulams) in the CSA O86-14 for more information on
this factor.

Timber Design CV (Shear Load Coefficient-CSA)
CV is the Shear Load coefficient for glulam members. It is applied automatically when you assign a material from
the CSA Table 7.3 glulam material database. By default this value will always be taken as 1.0. However, the user
can override this value by manually entering the factor on the Wood tab of the Members Spreadsheet.

Timber Design KH (System Factor)
KH is the System adjustment factor. This factor depends on the System Factor selection applied to the member on
the Wood tab of the Members spreadsheet:
l
l

l

None - Assumes that the member is NOT in a system of repetitive members and therefore KH = 1.0.
Sheathed - Assumes that the member is in a system of repetitive members and the members are sheathed
with plywood. This is defined as "Case 2" in clause 6.4.4.2 for sawn lumber. In this case KH will come from
Table 6.4.4 (2014 code).
UnSheathed - Assumes that the member is in a system of repetitive members but the members are NOT
sheathed with plywood. This is defined as "Case 1" in clause 6.4.4.1 for sawn lumber. In this case KH will
come from Table 6.4.4 (2014 code).

Note
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l

l

If the member is a glulam, selecting either "Sheathed" or "Unsheathed" will apply the KH factors per clause
7.4.3. If "None" is selected than KH will be taken as just 1.0.
Always assumed 1.0 for wood wall design per the CSA O86 design codes.

Timber Design KZ (Size Factor- CSA)
KZ is the Size factor. It is applied automatically when you assign a wood shape from the CSA shape database. See
Table 6.4.5 in the CSA O86-14 design code for information on this factor.

Timber Design KL (Lateral Stability Factor - CSA)
KL is the Lateral Stability factor. This factor is calculated internally per the equation given in clause 7.5.6.4.4 for
both glulam and full sawn members.
The final calculated values of both CB and KL are shown on the Wood tab of the Code Check Spreadsheet, as well
as in the Member Detail Reports.

Note:
l

Clause 6.5.4.2.1 allows full sawn members to use the glulam clause 7.5.6.4 to determine KL.

Timber Design KC (Slenderness Factor)
KC is the Slenderness factor. This factor is calculated internally per the equation given in clause 6.5.6.2.4 for full
sawn members and per clause 7.5.8.5 for glulam members.

Note:
l

The program will use the maximum Cc value (per clause 6.5.6.2.2 or 7.5.8.2) in the KC calculation.

Timber Design Flat Use Factor -CSA
The Flat Use factor is just called "Flat Use" in the member detail report. There is no explicit factor for this defined
in the CSA O86-14 design code. However, there is a note for Table 6.3.1C (Material Strengths for Beams and
Stringers) that includes a flat use adjustment factor. The program will determine this factor based on the asterisk
table under Table 6.3.1C.

Limitations - Wood Design
o

o
o

It is assumed that the load on the member is occurring through the member's shear center. This means secondary torsional moments that may occur if the load is not applied through the shear center are not considered.
Currently the program only considers the Joist loaded edge design values for SCL members per NDS design.
CSA O86 wood design will not automatically account for the Es value (per clause 5.4.1). If the user wants to
account for this modified modulus of elasticity, then you must manually adjust the material properties.

Adjustment Factor Limitations
l
l
l
l
l
l
l
l

Buckling Stiffness Factor - The NDS buckling stiffness factor, CT, is not currently accounted for.
Bearing Area Factor - The NDS bearing area factor, Cb, is not currently accounted for.
Curvature Factor - The NDS curvature factor for glulams, Cc, is not currently accounted for.
Stress Interaction Factor - The NDS stress interaction factor for glulams, CI, is not currently accounted for.
Shear Reduction Factor - The NDS shear reduction factor for glulams, Cvr, is not currently accounted for.
Length of Bearing Factor - The CSA O86 length of bearing factor, KB, is not currently accounted for.
End Fixity Factor - The CSA O86 end fixity factor, KE, is not currently accounted for.
Foundation Factor - The CSA O86 foundation factor (for plywood), KF, is not currently accounted for.
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l

l
l

l
l
l

Bending Capacity Modification Factor - The CSA O86 bending capacity modification factor, KM, is not currently accounted for.
Notch Factor - The CSA O86 notch factor, KN, is not currently accounted for.
Shear Load Coefficient - The CSA O86 shear load coefficient for glulams, CV, will always default to 1.0. The
user can override this by manually typing in the appropriate CV value on the Wood tab of the Members
spreadsheet.
Radial Stress Factor - The CSA O86 radial stress factor, KR, is not currently accounted for.
Treatment Factor - The CSA O86 treatment factor, KT, is not currently accounted for.
Curvature Factor - The CSA O86 curvature factor for glulams, KX, is not currently accounted for.

NDS Emin Calculation
RISA will calculate the Emin value for NDS wood materials rather than read it in from the design tables. In the 2018
edition of the NDS, Emin is calculated per equation (D-4) from Appendix D.

COVE (the coefficient of variation in modulus of elasticity) comes from Table F1 in Appendix F.

Note
l

If your member is a glulam or SCL material, the Emin equation becomes:

Wood Member Code Check Results
Access the Wood Code Checks Spreadsheet by selecting the Code Check spreadsheet from the Results toolbar on
the Explorer Panel and then clicking the Wood tab.

Code Checks
The final result of the design solution are the code check values (ratios of actual stress to allowable stress). So, if
these values are less than 1.0, the member passes. If they are greater than 1.0, the member fails.

Note:
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l
l
l

If the value is greater than 9.999 it will be listed as "9.999".
The Member Detail Report gives a more detailed view of the values used to perform the code check.
See Results View Settings - Members to learn how to view the code check results graphically.

The UC Max value represents the combined bending and axial force stresses. The governing equation that was used
to calculate the UC Max value is listed at the far right of the spreadsheet in the Eqn column.
The Shear UC is the maximum ratio of actual to allowable shear stress.
The Loc fields that are to the right of the code check fields tells at what location the maximum code check occurs
measured from the I-joint location of the member.
The Dir field tells us in which local member direction the maximum shear is occurring (y or z).

Capacity Values
The values (Fc', Ft', Fb1', Fb2', Fv') are the factored allowable stresses per NDS wood member design.
o

o

o
o

For the bending stresses (Fb), Fb1' is for bending about the local z-z axis (the strong axis) and Fb2' is for
bending about the local y-y axis (the weak axis).
RB is the adjustment factor described by Eqn. 3.3-5 of the 2018 NDS Specification. This is a slenderness
ratio that is not allowed to exceed 50.
CL is the beam stability factor calculated using Eqn. 3.3-6 of the NDS Specifications.
CP is the column stability factor calculated using Eqn. 3.7-1 of the NDS Specifications.

The values (Pr, Tr, Mr, Vr/Wr) are the allowable forces per CSA O86 wood member design. These will only be
visible when you have selected the CSA O86-09: Ultimate or CSA O86-14: Ultimate as your wood design code in
.Model Settings.
o
o

o

o

o

Reference equations are reported in the member detail report for the calculation of each capacity value.
The Vr/Wr shear resistance value for glulams depends on the CV value. Unless manually entered by the user,
this value is always assumed 1.0.
o This value is called "Vr" in the 2009 version of the code and "Wr" in the 2014 version of the code.
The Pr, axial compressive resistance for sawn lumber members will have a 75% reduction taken into
account (per clause 6.5.6.4.3) for bolted multi-ply members.
The Tr, axial tensile resistance for glulams only considers the gross area of the member when calculated per
clause 7.5.11.
The glulam material Table 7.3 in the CSA O86-09 does not include weak axis bending or shear values. Per the
commentary to clause 7.5, glulams will use the sawn lumber values for the glulams species' grade No. 2 listing in Table 6.3.1A.

Finally, the Equation controlling the code check is listed. For NDS wood member design, this will be either Eqn. 3.91 or 3.9-3. Eqn. 3.9-2 is not checked since this equation includes the tension stress in a beneficial (nonconservative) manner. All other requirements in Section 3.9 are also checked, such as fc < FcE1, etc. To see ALL
the adjustment factors and other information used to calculate the factored allowable stresses, please go to a detail
report for the member in question. You can do that by right clicking in a spreadsheet row and clicking Detailed
Report or by clicking the Detailed Report button on the Results toolbar.
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Notes
l

l

For Enveloped results the combination that produced the listed code and shear checks is given in the "LC"
column. The other values are the corresponding values and are not necessarily the maximums across all the
combinations.
Moving Load results are enveloped and the governing load combination and step location is shown for each
result value under the "LC" column. The first number is the load combination, the second is the step number:
(load combination - step number). See Moving Loads to learn more.

Special Messages - Wood Design
In some instances code checks are not performed for a particular member. A message explaining why a code check
is not possible will be listed instead of the code check value. You may click the cell that contains the message and
look to the status bar to view the full message. Following are the messages that may be listed:

Code Check Not Calculated
This is the general message displayed when code checks were not performed for a member. It could mean that you
have not selected a Design Code in Model Settings, or you have not included any load combinations for this material
type in your solution. Check the Design tab of the Load Combinations spreadsheet.

RB value is greater than 50
Section 3.3.3.7 of the NDS code limits the slenderness ratio RB to a maximum of 50. Similarly, clause 7.5.6.4.3 of the
CSA O86 limits CB to a maximum of 50. You will need to reduce the effective span length, increase the thickness of
the shape, or reduce the depth of the shape.

le/d is greater than 50
Section 3.7.1.4 of the NDS code limits the column slenderness ratio of Le1/b or Le2/d to a maximum of 50. You
need to reduce your effective length by reducing the actual length between supports or changing the effective
length factor “K”. You can also use a thicker shape.

fc is greater than FcE1
Section 3.9.2 of the NDS code limits the actual axial compressive stress to be less than the term FcE1. This term is
approximately the Euler buckling stress for buckling about the strong axis of the member. (Buckling is in the plane
of bending)

fc is greater than FcE2
Section 3.9.2 of the NDS code limits the actual axial compressive stress to be less than the term FcE2. This term is
approximately the Euler buckling stress for buckling about the weak axis of the member. (Buckling is in the plane of
bending)

fb1 is greater than FbE
Section 3.9.2 of the NDS code limits the actual strong axis bending compressive stress to be less than the term FbE.
This term is approximately the lateral buckling stress.
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Appendix A – Redesign Lists
RISA-3D has Redesign Lists that are used to optimize hot-rolled steel, cold-formed steel, dimensional lumber, and
concrete beams and columns. Although, the criteria used for this optimization is the Design Rules, the sizes must
be chosen from the available sizes in the Redesign List.
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Redesign.

Creating or Modifying Redesign Lists

Access the redesign lists from within RISA-3D by clicking the Redesign Lists button on the Advanced tab.
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Select a material using the tabs at the top of the dialog. For each material, select a Database, Member Type, Shape
Type, and Design List.
Click New to create a new Redesign List for the selected Member Type and Shape Type.
Click Delete to permanently delete the currently selected Redesign List.
Click Copy to copy and rename the currently selected Redesign List.
The Available Shapes on the left will be listed based on the selected Database, Member Type, and Shape Type.
The Current Design List on the right will list all the shapes in the selected Design List.
Select shapes in the Available Shapes or Current Design List and use the Add or Remove buttons to modify the
Current Design List.
Use the Move Up and Move Down buttons to re-order the shapes in the Current Design List.
These design lists can then be assigned to a specific member or Section Set.
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Design List Mismatch
If you see a Design List and Shape Database Mismatch dialog, then there is a mismatch between your default shape
database and the design list you have currently selected. Either choose a Design List to match the default Shape
Database, or change your default Shape Database so that you can use the Design List you want. To check your
default Shape Database, open the Shape Database which is located on the Advanced tab of the ribbon toolbar. In the
Shape Database, your default databases will currently be selected for each material.

Locating the Design Lists
By default the redesign list files exist in the Redesign Lists folder in the user's Documents\RISA folder. However,
this folder can be changed by selecting the RISA-3D button Application Settings File Locations.

File Naming Convention for the Design Lists
The design lists must be ASCII text files with a file extension of ASC. In addition, the first 3 characters of the Design
indicate which Region the lists will be available for. The region can be changed by selecting the RISA-3D button
Application Settings General Advanced. Each region corresponds to the following file name prefix.

Region

File Prefix

United States

US_

Canada

CA_

Britain

BS_

Europe

EU_

India

IN_

Australia

AU_

New Zealand

AU_

Mexico / South America

MX_

File Format for Redesign Lists
The following is an example of a user defined redesign list. You may view these files using any text editor such as
Window’s Notepad. However, this file must be saved in the risa__redesign_lists folder as an ASCII text file with a file
extension ASC. If the file is saved with a txt extension, it will not be read intoRISA-3D. The various entries for the
input fields are described below:
The first field [RISA_REDESIGN_LIST] identifies this as a RISA Redesign list. If this line is not present the file will
not be recognized by the program.
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The second field [NAME] identifies that the next entry will be the name of the Shape Group that will identify this list
in the program. In this case, this Shape Group is given the name Available W24s.
The next field [MATERIAL_TYPE] identifies that the next entry will be the material type that this shape group
belongs to. This material type must be given one of the following designations: Hot Rolled Steel, Cold Formed Steel,
Wood, Steel Products, or Wood Products.
The next field [MEMBER_TYPE] identifies that the next entry will be the designation of the member type. This entry
must be designated as either a Beam or Column.
The next field [ASSOCIATED DATABASE] identifies that the next entry will be the RISA database name in which the
entered shapes are defined.
The next field [UNITS] identifies the units used to define the member sizes in the redesign list. Entries may be
Inches, Millimeters, or Centimeters. This field is only applicable to files similar to the concrete and wood lists which
have the dimensions built right into the list. For files which are based on database shape names, this field will have
no effect.
The next field [END HEADER] identifies the end of the descriptive information and the beginning of the shape list.
The next field [AVAILABLE_SHAPES] identifies that the next series of lines will signify all of the shapes available for
this Shape Group. The end of this field is reached when the [SHAPE_END] entry is read. The file below uses an
asterisk (*) to specify that W24x68’s and W24x76’s are NOT available for this particular job.
The next field [OPTIMUM_SHAPES] identifies that the next series of lines will signify the preferred shapes for this
Shape Group. The program will attempt to only use optimum shapes for beams that are significantly braced. By
significantly braced, we mean that the unbraced length of the top flange is less than or equal to three feet. The end
of this field is reached when the [SHAPE_END] entry is read.
The last field [END] identifies the end of the file.

[NAME]
Available W24s
[MATERIAL_TYPE]
Hot Rolled Steel
[MEMBER_TYPE]
Beam
[ASSOCIATED_DATABASE]
AISC
[END_HEADER]
[AVAILABLE_SHAPES]
W24X104
W24X103
W24X94
W24X84
*W24X76
*W24X68
W24X62
W24X55
[SHAPE_END]
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[OPTIMUM_SHAPES]
W24X55
W24X62
*W24X68
W24X76
[SHAPE_END]
[END]

Manual Modification
By default, RISA installs a series of default redesign lists for each material and member type. The default lists are
assumed to be a compilation of what engineers would typically choose. To view the available sections for each list,
you can open up the file located in the Redesign Lists folder using a word editing program.
To modify an existing redesign list, open the file in a word editing program to override any of the variables. The
same formatting as the original file should be followed as well as saving the file to the same location, otherwise the
program will not recognize the changes.
To create a new redesign list, open an existing file and run a Save As to save the file with a different file name in the
same location. The [NAME] input as described in the above section will be the label you will see within the program
so it is important to give your design list a unique name. The [MATERIAL_TYPE], [MEMBER_TYPE], and
[ASSOCIATED DATABASE] are important criteria your member must have in order for the design list to be available.
If a member in the model includes all three of the criteria defined in a particular design list, this design list will be
available within Members spreadsheet Design List pull down box (see Design Lists for more information).

Note:
l

If you want to list a member size in the redesign list file but not have it considered as part of the redesign
list, you can put an asterisk in front of the shape name.
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Appendix B – Error Messages
Extensive error checking is performed during data entry and model solution in order to prevent you from having to
scan input files for offending data. If an error or questionable entry is detected, an error or warning message will
be displayed. Errors are divided into two groups such that data entry error numbers are between 1000-1999 and
solution errors are between 2000-2999.

Please refer to the Help File in RISA for detailed information about each error message. The Help
File may be accessed by selecting Help Topics from the Help Menu. Choose Appendices :
Appendix B - Error Messages.
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STAAD files may be imported into RISA-3D by choosing File Import and then specifying STAAD as the file type.
RISA-3D can translate files produced by the STAAD III or STAAD/Pro programs.
The translation process will cause model information including geometry data, member and element properties,
load information, some advanced modeling information, and AISC steel code check information to be read into RISA3D.
Translated geometry data are the joints, members, and plate/shell elements. Supported member and element
properties are the material property information, element thickness and member section shape data. Loading
information includes joint loads, support displacements, member distributed and point loads, and element surface
loads. The advanced modeling information that are translated are such things as the joint boundary conditions,
including springs, the member end releases, and the “Truss” members. Note that the STAAD model type (i.e. Space,
Plane, etc.) will also be detected and this information will be used to help translate the model.
The translator has been tested with files as old as STAAD, version 10. If you’re having a problem translating an
older or newer file some features may not be available.

Translation log File
All lines that are not translated, including unsupported shapes, unsupported loads, comment lines, etc., are written
out to a log file called 'filename'.TXT (where 'filename' is the prefix of your STAAD filename ). A message will pop
up and tell you the location of the file and whether any important warnings were written to the file. This file is an
ASCII text file that can be viewed with any editor (NotePad, WordPad, etc.) and should be reviewed after each
translation.

Supported STAAD Features
The translator supports both the "Single Item per Line" format and "Multiple Item per Line" format for Joint
definition and Member/Element Incidences. (The "Single Item per Line" format was an option for older versions of
STAAD). The use of the REPEAT keyword or command file data generation functions are not supported. If you
have a model with these features, you will need to read the model back into STAAD and save it back out. Saving the
model back out of STAAD will expand data specified with the REPEAT keyword or data generation functions.
Most properties, loads, etc. are assigned in STAAD using a "list" of items. RISA-3D supports most of the list format
features, including the TO and BY keywords, the line continuation character "-", and the listing of items by "Group"
name. We do not support the listing of members by specifying Global Axes for members, or by specifying Global
Ranges for joints, members, and elements. If you have a model that uses either Global Axes or Global Ranges to
specify item lists, you will need to specify the item lists using one of the other list features that are supported.
All comment lines (lines that start with the "*" character) are skipped and copied to the STAAD log file.

STAAD General Keywords
UNIt statements cause model data to be interpreted in the specified units. All STAAD unit types are supported.
SET Z UP - This statement will cause the vertical axis setting on the Global Parameters to be set to the Z-axis.
(Default vertical in RISA-3D is the Y-axis)
FINish - This keyword is used to mark the end of the STAAD file. Nothing is translated after the FINISH keyword.

STAAD Model Type Keywords
RISA-3D recognizes the STAAD model types and uses the information to help translate the model.
PLAne models are assumed to be in the X-Y plane at a Z-coordinate of zero. Thus, only the X and Y coordinates are
read and the Z coordinates of all joints are set to zero.
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SPAce models are read in as is.
TRUss models cause member end releases to be set for all members so that members will only take axial loads.
The member release codes are set to ALLpin on the I-end and BENpin on the J-end. Depending on the model
geometry, this may cause RISA-3D to report instabilities when solving. (The instabilities occur if all the members
connecting to a joint have the bending rotational degrees of freedom released, the joint then will have no rotational
stiffness.) If this happens in a plane truss, you can use the ALL Boundary Condition code to apply a very soft
spring to the in-plane rotational DOF. For space trusses, you can use the ALL code to apply very soft springs to all
the rotational DOF’s (MX, MY, MZ) for all free joints. See Stability for more information.
FLOor models are assumed to be in the X-Z plane at a Y-coordinate of zero. Thus only the X and Z coordinates are
read and the Y coordinates are all to zero.

STAAD Joint Keywords
JOInt COOrdinates - Only Cartesian coordinates are supported. If you have a model in cylindrical or reverse
cylindrical coordinate, you will need to read the model into STAAD and then save it back out. This will cause the
coordinates to be converted to the Cartesian format. Repeat keywords and command file data generations are not
supported.
JOInt LOAd - All joint forces, moments, and support displacements are read in using the units from the last Units
statement. Support displacements that are rotations are converted from the STAAD convention of degrees to the
RISA-3D convention of radians.
SUPports - All regular joint support types are available, including spring supports. Inclined supports and automatic
spring generation using the Footing or Elastic Mat keywords are NOT supported.

STAAD Member Keywords
MEMber INCidences – Repeat keywords and command file data generation are not supported.
MEMber PROperties- If a type is not specified for Member Properties, AMErican will be assumed.
MEMber PROperties AMErican- Unsupported shapes will cause members that were assigned those shapes to be
grouped together by section set with the default section properties. Different section sets will be created for the
same unsupported geometric sections with different material properties. Data lines specifying unsupported shapes
will be written out to the STAAD log file.
MEMber PROperties CANadian- Unsupported shapes will cause members that were assigned those shapes to be
grouped together by section set with the default section properties. Different section sets will be created for the
same unsupported geometric sections with different material properties. Data lines specifying unsupported shapes
will be written out to the STAAD log file.
PRIsmatic - Shape properties specified using the prismatic keyword are supported. A section set will be created
and the section properties will be entered into the Sections spreadsheet. A RISA-3D “arbitrary” database shape will
NOT be created, and thus no bending or torsion stresses will be calculated for these sections. Note that just the
properties are read in. RISA-3D does try to detect what ‘type’ of prismatic shape is being specified. The following
“property_spec” items are recognized and read in for prismatic sections : AX, IZ, IY, IX, AY, AZ, YD, and ZD. The
section area is calculated as a rectangular section via the YD and ZD items if they are specified and the area was not
already given with the AX spec. Shear area factors are calculated from the specified AY and AZ values. If not
specified, these values are set to 1.2, which is the RISA-3D default.
TABle - Shape properties specified using the AISC American standard table or Canadian standard table of steel
shapes are supported. These shapes are matched against the RISA-3D shape database and for matched shapes, full
stress calculations and steel code checks are performed.
For American AISC standard shapes, the following “type_spec” words are supported: ST, RA, LD, SD, T, and SP. All
wide flange, channel, WT, single and double angle, and HSS shapes are supported. All pipe shapes, built up box type
tube shapes, double channels, and built up plate girders are not supported. For double angles, only specified
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spacings of 0",3/8", or 3/4" are recognized. The translator will treat double angles with other spacings as
unsupported shapes, however these shapes can be later added to the database using the shape editor.
For Canadian shapes as listed in the S16.1-94 standard, the following “type_spec” words are supported: ST, and T.
All wide flange, channel, and WT shapes are supported. The HSS shapes are supported, however, STAAD uses the
AISC names for the HSS shapes. All pipe shapes, single angles, double angles, built up box type tube shapes, double
channels, and built up plate girders are not supported.
MEMber RELease - All full member end releases are recognized. Partial releases are not supported or translated.
MEMber TRUss - Members which are assigned this property are given an I-end release of ALLpin and a J-end
release of BENpin. The member will take moment if a distributed load or self weight load is applied.
MEMber LOAd - Most member loads are supported. Unsupported member loads include projected point loads and
projected moments, loads with a shear center offset, distributed moment loads, and triangular loads with the
maximum at the center of the member specified using the LIN load option.
STArt GROup DEFinition - This feature is used in STAAD to give a frequently used list of member/element items
an easier to reference “name”. There is a limit of 32,000 groups, and 50,000 total group items that RISA-3D will use
when translating the STAAD file.
CONstants - The constant keywords STEEL, CONCRETE, and ALUMINUM are supported. Note that since RISA-3D
ties material properties and section properties together by using Section Sets, members with the same geometric
properties but different material properties will be assigned to different Section Sets.
DEFine MATerial STArt – This feature is fully supported for ISOTROPIC materials only. NON-Isotropic material
definitions will be replaced by the first default material in RISA-3D.

STAAD Element Keywords
ELEment INCidences - Repeat keywords and command file data generation are not supported.
ELEment PROperty - Only uniform element thicknesses are supported. If multiple thicknesses are specified for an
element, only the first thickness is read and used as the thickness for the whole element.
ELEment LOAd - Only uniform surface loads are supported.
STArt GROup DEFinition - This feature is used in STAAD to give a frequently used list of member/element items
an easier to reference “name”. There is a limit of 32,000 groups, and 50,000 total group items that RISA-3D will use
when translating the STAAD file.
CONstants - The constant keywords STEEL, CONCRETE, and ALUMINUM are supported. Note that since RISA-3D
ties material properties and section properties together by using Section Sets, members with the same geometric
properties but different material properties will be assigned to different Section Sets.
DEFine MATerial STArt – This feature is fully supported for ISOTROPIC materials only. NON-Isotropic material
definitions will be replaced by the first default material in RISA-3D.

STAAD Load Keywords
LOAding - All Load cases will be translated into Basic Load Cases in RISA-3D. The loads within each Load Case will
be translated to the appropriate BLC in RISA-3D. Note that RISA-3D does not solve BLC’s, only Load Combinations.
If you want to have a particular BLC solved by itself, you should build a Load Combination with only that BLC
specified.
LOAd COMbination - All load combinations will be translated into load combinations in RISA-3D. The SRSS feature
is not supported for BLC’s. The SRSS feature for load combinations in RISA-3D only applies to Response Spectrum
loading. If P-Delta analyses are desired, they must be assigned later on the Load Combination spreadsheet. RISA3D has a limit of 8 Basic Load Cases per Load Combination. If a STAAD file is read that has more than 8 LOAD cases
per Load Combination, only the first 8 will be used. A warning will be written to the log file.
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STAAD AISC Parameters
PARameter - Only the AISC (ASD 9th or LRFD 2nd ) codes and the Canadian CAN/CSA S16.1-94 code are supported
in RISA-3D . The following parameters are recognized: KY, KZ, LY, LZ, FYLd, UNL, UNF, CB, SSY, SSZ, CMY, and
CMZ. You can check the values that have been translated into RISA-3D on the Design Parameters spreadsheet.

Unsupported STAAD Features
In general, you will want to examine your STAAD translation log file to note all lines that were not read in and
translated. Typically a line will only be written to the log file if it is not recognized and translated successfully. This
will give a good indication of any features that weren’t brought into RISA-3D.
STAAD solves LOAD cases and LOAD Combinations; RISA-3D only solves Load Combinations. You will need to have
additional load combinations containing only one basic load case per combination to solve your basic load cases.
P-Delta analyses are specified for each load combination in RISA-3D. The P-Delta flag will NOT be set automatically.
You will need to go set it for combinations where you want to include P-Delta effects.
RISA-3D does not translate any of the information in the JOB Information block of model files.
Members with K-joint’s cause joints to be created at the K-joint coordinates. These joints have their degrees of
freedom locked automatically during model solution.
RISA-3D has a limit of 8 Basic Load Cases per Load Combination. If a STAAD model has more than 8 LOAD cases in
a Load Combination, only the first 8 will be used and a warning message will be written to the log file.
Any response spectra entered in your STAAD file will need to be entered in RISA-3D’s spectra database. STAAD
stores each spectra with a particular data file, whereas RISA-3D maintains a library of spectra which are accessible
from any data file.
Shapes that are defined using a User defined shape database file will need to be entered into RISA-3D’s shape
database. RISA can automatically convert these shapes based on a Mapping file defined in the STAAD Mapping File
section at the end of this appendix.
RISA-3D doesn’t support non-isotropic materials. If you translate a model with a non-isotropic material specified,
we will still translate the model, but we’ll use the first default material instead.

STAAD User’s Overview
Folks who have a lot a structural modeling experience with STAAD can usually come up to speed with RISA-3D
fairly quickly. The only thing that’ll slow you down is figuring out how to do in RISA-3D what you knew how to do
in STAAD. The RISA-3D User's Guide is a great place to start, in spite of the fact that it covers a lot of basic
modeling concepts, because it shows you the most common ways to get things done in RISA-3D. In STAAD, you
were probably accustomed to generating the model by manually editing the command text file, or maybe starting
the model with the graphical pre-processor and then fine tuning the model by hand in the text file. With RISA-3D
the steps are similar, except that you won’t ever be directly editing the text file. You will do all manual data editing
using our spreadsheets. Things like Section Sets and Material Properties are good examples of data that will always
be entered via the spreadsheets. The actual model geometry and the application of boundary conditions, loads, and
design parameters is usually done quickest using the Model Generation functions or the Graphics Editing functions.
Most of these tools will require that you spend a few minutes the first time you use them to study what they can do
and how it can help you model. There is a full explanation of all the input parameters for each graphical tool in this
Help file under each graphical tool topic.
Many STAAD users who are now using RISA-3D often want to know about the differences in the way modeling is
performed between the two programs. You may want to read about some of the differences between RISA-3D and
STAAD that we’ve documented and discussed in the relevant Help file topics.
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A big plus for people who’ve used STAAD for a while and built up a library of models is that RISA-3D can read
STAAD input files.
The translation process will cause model information including geometry data, member and element properties,
load information, some advanced modeling information, and AISC steel code check information to be read into RISA3D.

STAAD Differences from RISA-3D
STAAD is a "batch" mode program, where you are building a text input file either by hand or using their preprocessor. The latest STAAD/Pro program is very nearly an interactive program, with the only external programs
being the solvers. RISA-3D is completely an interactive program in that we do not write an intermediate file. All
input, solution, and results are performed using the same program.
For manual data entry, the input file can be directly edited in STAAD, whereas in RISA-3D you edit your data
manually in custom spreadsheets that error check your input as it goes in. RISA-3D also has many built in
spreadsheet functions to assist manual editing of the model data. You can cut and paste from other programs and
spreadsheet directly into the RISA-3D data spreadsheets. The *.R3D file format uses keyword delimited format that
may be edited directly from a text editor such as notepad. See Appendix D for more information on the RISA file
format. Directly editing the *.R3D file also bypasses many of the error-checking features that would catch
syntactical errors in the model data (having your model data integrity assured before you even run the model will
save you lots of time in the long run).

Member Data
RISA-3D uses a Section Set to relate a set of members to a particular shape. The analog in STAAD is their "Groups".
The RISA-3D Section Set combines a material and a shape into a one entity, which is then assigned to members. In
RISA-3D, steel redesign is performed on a Section Set basis, so the worst-case member in a section set will control
the size of all the members in that set.

Load Data
STAAD solves Primary LOAD cases and LOAD Combinations; RISA-3D only solves Load Combinations. If you’d like
to run all your Basic Load Cases in addition to your Load Combinations, you will need to set up additional load
combinations that only contain one basic load case per combination. RISA-3D has a limit of 8 Basic Load Cases per
Load Combination. To learn how to get more than 8 BLC’s per Load Combination, see Nesting Load Combinations
for more information.

Analysis Types
A P-Delta analysis is a specific analysis option for a STAAD file and usually applies to all the loads in the current
data file. In RISA-3D, a P-Delta analysis can be specified by setting a P-Delta flag for each combination on the Load
Combination spreadsheet where you would like to include 2nd order effects.

Dynamics/Response Spectrum
Any response spectra used by your STAAD file will need to be entered in RISA-3D’s spectra database. STAAD stores
each spectra with a particular data file, whereas RISA-3D maintains a library of spectra which are accessible from
any data file.
For dynamic analysis in RISA-3D, mass is assigned in the vertical direction and then assumed to act in all three
global directions. In STAAD, you have to specify your mass in all the directions in which you want it to act.

STAAD Mapping File
The STAAD importing feature now accepts a mapping file (STAAD_Mapping_File.XML). This file format allows
RISA to import User defined database or table shapes from STAAD. All parameters in the tables are assumed to be
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based on units of kips and inches.

Column Headers:
RISA Shape Name Shape Name in RISA Programs
type-spec Can be any of the following : ST, RA, D, LD, SD, T, CM, TC, BC, TB
table-name Table section name like W6X9, C9X15 etc.
SP Spacing between angles
WP Width of Cover Plate
TH Thickness of plate or tubes
WT Width of tubes
DT Depth of tubes
OD Outer Diameter
ID Inner Diameter
CT Concrete Thickness for Composite Sections
FC Compressive Strength of Concrete for Composite Sections.
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RISA-3D uses a plain text, keyword driven input file. The input data is delimited by sets of keyword labels that
divide the input into a number of segments containing semantically related data.
Each input segment may include one or more input records. The input records are text strings that define sets of
properties for single input items, e.g., label, coordinates, etc. for nodes. Each record is terminated with a semicolon
(;), except for a few project description records (between the [.PROJECT_DESCRIPTION] and [.END_PROJECT_
DESCRIPTION] labels). Those records are delimited by their corresponding keyword labels.
Multiple records are used to describe multiple instances of input items. The number of records immediately follows
the keyword label and is given in the <> brackets.
Lines starting with a // are ignored by the program and may be used for user comments.
The reading of Label fields (such as member names, or shape names) uses a combination of fixed length fields and
field delimiter. The field lengths are set in the Label Length Data. Care should be taken to maintain the proper
length for all label fields. If the length of the field is not entered correct, the program will attempt to use the field
delimiters (") to read the data. A combination of incorrect field length and the use of (") marks within a shape label
itself (e.g. a shape label of: 3/4" rod bracing) will result in the program producing an error during the reading of the
file.

Please refer to the Help File in RISA-3D for detailed information about the file format. The Help
File may be accessed by selecting Help Topics from the Help Menu.
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Appendix E - Interfacing with Other Programs
RISA-3D interacts with a number of other RISA programs within the RISA suite (see below) as well as a the 3rd
party programs listed in the sections below.

Integration with other RISA programs
For information on the integration between Floor and 3D see RISA-3D Integration.
For information on the integration between RISA-3D and RISASection see Shape Databases.
For information on the integration between RISA-3D and Foundation see RISAFoundation Integration.
For information on the integration between RISA-3D and RISAConnection see RISAConnection Integration

Exporting to ADAPT Builder
RISA-3D has the ability to export Node Reactions in an ADAPT Builder file format(.b3d file extension). This allows
for the reactions to be imported as loads in ADAPT Builder.

Exporting to SDS2
RISA-3D has the ability to export Enveloped Member End Reactions in a Flat file format(.txt file extension).

Linking your Autodesk Revit Structure model with RISA-3D
AutoDesk® Revit® Structure users can now link directly with RISA-3D and/or RISAFloor. This link is being
continuously improved and updated. Therefore, for the most up to date information on this link, please visit the
AutoDesk and RISA web sites.
risa.com/products/risa-revit-link
autodesk.com/products/revit/overview
For additional advice on this topic, please see the RISA Tips & Tricks webpage at risa.com/post/support. Type in
Search keywords: Revit.

Importing or Exporting SAF Files
RISA-3D has the ability to import and export files in the SAF file format(.xlsx file extension). This is an open
exchange file format that allows for exchanging data between structural analysis software. This is an initiative from
Nemetschek Group to improve collaboration.
For more information and to download an SAF Viewer, visit: https://www.saf.guide/en/stable/gettingstarted/what-is-saf.html

Importing or Exporting CIS/2 Files
RISA-3D and RISAFloor have the ability to import and export files in the CIS/2 file format(.stp file extension). This is
a generic file format that allows different pieces of software to communicate with each other. Our three main
partners that accept and produce this type of file are:
l
l
l

SDS2 Design Data
Tekla Structures
StruCad

For more information and to download the CIS/2 translator, visit our website at: risa.com/products/risa-cis2translator
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Importing or Exporting DXF Files
For DXF importing / exporting, refer to the DXF Files section of the main manual.

Importing STAAD Files
Refer to Appendix C for more information on importing STAAD files.

Importing SAF Files
RISA is actively involved in the SAF Open Exchange Initiative with other Nemetschek brands. For more information,
visit the SAF Open Exchange Guide: https://saf.guide/
In order to import an SAF file, the vertical axis in RISA-3D must be Z.

Exporting to an SDNF File Format
The Steel Detailing Neutral File is a file format that is used by a number of CAD and steel detailing packages. This
format is superior to a DXF export in that it contains member size and orientation information as well. The SDNF
export dialog may be obtained by selecting File - Export - SDNF from the Main Menu Toolbar.
Because the SDNF data exchange is so heavily dependent on naming conventions for the structural steel, there are a
number of options related to the steel shape prefixes and naming conventions as shown in the dialog below.
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Note
l

l

SDNF exporting includes member information only. It does not export Wall Panel Elements, solids or
plates.
The SDNF exporting does not link to the Member Detailing information. Setting cardinal points and offsets in the Member Detailing will have no effect on this export.

Structural Desktop
Structural Desktop is a 3rd party program that works inside AutoCAD and is capable of importing RISA models into
AutoCAD for the purposes of drawing production. Structural Desktop is also capable of exporting RISA files as well.
Structural Desktop also includes a library of steel joists that can be used directly inside of RISA-3D or 2D. Refer to
the Shape Database - General Shapes section of the manual for more information.
For more information, see the RISA and Structural Desktop web sites:
risa.com/partners/prt_sdt.html
www.structuraldesktop.com
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RISA-3D has design databases for wood shear walls and diaphragms which are used to optimize the nailing and
hold downs for the wall. The criteria used for this optimization is specified on the Wood Wall (Fasteners) and Wood
Diaphragms tabs of the Design Rules spreadsheet. In addition to this basic criteria, the user may specify a subset of
the overall database from which the design / optimization must be performed.

Hold Downs

Each database of hold downs is specified by an XML file in the "Hold Downs" sub-directory of the Wood Wall panels
directory. The location of this directory is based on the information in the File Locations tab of the Application
Settings dialog.
The program comes pre-loaded with three XML files, one for Simpson hold-downs, one for Canadian Simpson holddowns, and one for USP hold-downs. The name of the XML file itself will be used in the list of databases in the Hold
Down Schedule Dialog.
The first sheet of the XML file should always be descriptive of the contents of the database (such as Simpson
HoldDowns). This is because the name used here is the name used in the Design Rules spreadsheet. This sheet
contains all of the identifier, design and code check information used for each hold down. These entries are
described below.

Full Database - Required Fields
The following fields are required information. If they are not provided or are left blank, then that hold down will not
be available for use in that database.
The Label field is used to identify the hold down. This field must be referenced on the sheets that identify families
or groups of hold downs. Maximum numbers of characters for this field is 32.
The Deflection at Peak Load entry is used to calculate the deflection of the shear wall per APA / NDS formulas.
This deflection is then reported on the shear wall detail report for each wall panel.
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The CD Factor is the assumed load duration factor that was used as the basis for specifying the listed Allowable
Tension value for that hold down.
A load combination may be solved with a load duration factor different from the CD Factor described above. When
this is the case, the Allowable Tension for that hold down will be adjusted based on the difference between the
assumed and actual load duration factors.

Full Database - Optional Fields
The following fields are optional. They are not currently used in the design or capacity calculations, but are
reported on the detail reports for reference purposes only.
The Manufacturer field is an identifier for the hold down. It is provided so that the engineer can more easily
identify the callouts for their final design drawings.
The allowable capacity of the hold down will vary based on the Chord Thickness. Therefore, the Min Chord
Thickness gives the minimum chord thickness that will yield the listed allowable tension load. However, this field
is NOT currently used in the calculations. A future revision may provide a warning message if the actual chord
thickness provided is less than required.
The allowable capacity of the hold down will vary based on the density of the wood species being used. Therefore,
the Required Chord Species lists the density assumed for the entered allowable tension. However, this field is NOT
currently checked in the calculations. A future revision may provide a warning message if the actual chord density
provided is less than required.
The Bolt Size when specified is used to reduce the axial capacity of the hold down chord itself. The only change to
the calculation is that the program will perform the allowable tension check on the net area of the chord member
rather than the gross area.

Grouping Hold Down Schedules for Design Optimization
The other sheets allow the user to group hold downs together into families for optimization purposes. These
additional sheets CANNOT be the first sheet in the XML file as that first sheet must always be the one where the full
database information resides.
The hold down labels specified on these sheets refer only to hold downs that have already been defined on the full
database sheet. The information in this sheet need not be organized in a specific order. Instead, they will always be
optimized based on the assumption that the hold down cost is directly related to the tension capacity. Therefore,
when this group is selected, then the hold down within the group with the code check closest to unity, but still less
than 1.0 will get selected during the optimization process.
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Straps

Each database of straps is specified by an XML file in the "Straps" sub-directory of the Wood Wall panels directory.
The location of this directory is based on the information in the File Locations tab of the Application Settings dialog.
The program comes pre-loaded with a database for Simpson Chord Straps. The name of the XML file itself will be
used in the list of databases in the Strap Schedule Dialog.
The first sheet of the XML file should always be descriptive of the contents of the database (such as Simpson Chord
Straps). This is because the name used here is the name used in the Design Rules spreadsheet. This sheet contains
all of the identifier, design and code check information used for each strap. These entries are described below.

Full Database - Required Fields
The following fields are required information. If they are not provided or are left blank, then that strap will not be
available for use in that database.
The Label field is used to identify the strap. This field must be referenced on the sheets that identify families or
groups of straps. Maximum numbers of characters for this field is 32.
The CD Factor is the assumed load duration factor that was used as the basis for specifying the listed Allowable
Tension value for that hold down.
A load combination may be solved with a load duration factor different from the CD Factor described above. When
this is the case, the Allowable Tension for that hold down will be adjusted based on the difference between the
assumed and actual load duration factors.
Allowable Tension is the value the program will use when designing the strap to be used.

Full Database - Optional Fields
The following fields are optional. They are not currently used in the design or capacity calculations, but are
reported on the detail reports for reference purposes only.
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The Manufacturer field is an identifier for the strap. It is provided so that the engineer can more easily identify the
callouts for their final design drawings.
The Clear Span is the distance the strap is required to span between elements it is resisting the tension of.
End Length is the length of the strap that extends past the clear span
The allowable capacity of the strap will vary based on the density of the wood species being used. Therefore, the
Required Chord Species lists the density assumed for the entered allowable tension. However, this field is NOT
currently checked in the calculations. A future revision may provide a warning message if the actual chord density
provided is less than required.
The Fastener Type shows whether Nails or Bolts is used to fasten the strap to the tension chords.
The Number of Fasteners field show how many fasteners are required to be used to meet the requirements of the
tension capacity given by the strap.

Grouping Strap Schedules for Design Optimization
The other sheets allow the user to group straps together into families for optimization purposes. These additional
sheets CANNOT be the first sheet in the XML file as that first sheet must always be the one where the full database
information resides.
The strap labels specified on these sheets refer only to straps that have already been defined on the full database
sheet. The information in this sheet need not be organized in a specific order. Instead, they will always be optimized
based on the assumption that thestrap cost is directly related to the tension capacity. Therefore, when this group is
selected, then the strap within the group with the code check closest to unity, but still less than 1.0 will get selected
during the optimization process.

Panel Nailing Schedules

Each database of wall panels is specified by an XML file in the "Shear Panels" sub-directory of the Wood Wall panels
directory. This directory is located based on the information File Locations tab of the Application Settings dialog.
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The program comes preloaded with XML files, including OSB and Plywood databases from the American Wood
Council's 2015 Special Design Provisions for Wind and Seismic.
Note:
l

The 2015 IBC refers directly to AWC SDPWS 2015 instead of publishing separate IBC tables as in previous
versions.

The first sheet of the XML file should always be descriptive of the contents of the database (such as IBC 2012). This
is because the name used here is the name used in the Design Rules spreadsheet. This sheet contains all of the
identifier, nailing, design and code check information for each nailing schedule. These entries are described below.

Full Database - Required Fields
The following fields are required information. If they are not provided or are left blank, then that nailing schedule
will not be available for use in the database.
The Label field is a used to identify the panel schedule and its nailing requirements. This field must be referenced
on the sheets that identify families or groups of panels. Maximum numbers of characters for this field is 32.
Note:
l

Panels with a label containing the characters "_W" together will be ignored during design optimization.

The Min Panel Thickness is used during the design optimization to limit the selected panels based on the Design
Rules chosen by the user. It is also used to help set the elastic stiffness of the wall panel used during the FEM
solution.
The Ga value is the Apparent Shear Stiffness from nail slip and panel deformation as defined in equation 4.3-1 of
the NDS' Special Design Provisions for Wind and Seismic. This value (in combination with the Min Panel Thickness
defined above) is used to set the elastic stiffness of the wall panel that will be used during the FEM solution.

Note:
l

When a family or group of panels / nailing schedules are assigned to a shear wall, the lowest value of Ga and
Min Panel thickness will be used to determine the elastic stiffness of the plate elements in the FEM solution.

The One/Two Sided field is used during the design optimization to limit the available panels based on the Design
Rules specified by the user.
The Boundary Nail Spacing field is used during the design optimization to limit the available panels based on the
Design Rules specified by the user.

Note:
l

The maximum field spacing is never entered in the program but is generally equal to 12 inches for the nailing schedules defined in the 1997 UBC and 2006 IBC databases. If a different nail spacing is present, then the
user should add in a new nailing schedule to the existing database with a user defined shear capacity.

The Shear Capacity listed in the spreadsheet is the primary value that controls the code checking of the shear wall.
This is the seismic capacity, which the program can automatically increase for wind loads if the Wind ASIF function
is enabled.

Full Database - Optional Fields
The following fields are optional. They are not currently used in the design or capacity calculations, but are
reported on the detail reports for informational purposes only.
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The Panel Grade and Min Penetration fields are identifiers for the engineer, but are not used in the design
calculations. They are provided so that the engineer can most easily identify the panels in their design results and
drawings.
The Panel Applied Over Gypsum field is also a identifier for the engineer that will not be used in the design
calculations.
The Nail Size listed in the spreadsheet is intended to refer to the Common nail size, but is reported only for
reference purposes and are NOT used in the capacity calculations. If the nail size is changed by the user, then the
user should also change the Shear Capacity entry accordingly. Below is a reference table for common, box, and
sinker nails.

Diameter

Length

Penny
Weight

Common
(in)

Common
(Wire
Gage)

Box
(in)

Sinker
(in)

6d

0.113

11.5

0.099

0.092

2

1.875

7d

0.113

11.5

0.099

0.099

2.25

2.125

8d

0.131

10

0.113

0.113

2.5

2.375

10d

0.148

9

0.128

0.120

3

2.875

12d

0.148

9

0.128

0.135

3.25

3.125

16d

0.162

8

0.135

0.148

3.5

3.25

Box and Common Sinker
(in)
(in)

The Staple size listed in the database is reported for reference purposes only. If the staple size is entered or
changed by the user, then the user should also change the shear capacity entry to the appropriate value.

Grouping Panel / Nailing Schedules for Design Optimization
The other sheets in the database allow the user to organize multiple nailing schedules into groups or families for
design optimization purposes. These additional sheets CANNOT be the first sheet in the XML file as that first sheet
must always be the one where the full database information resides.
The panel labels specified on these sheets refer only to panel / nailing schedules that have already been defined on
the full database sheet. The information in this sheet need not be organized in a specific order. Instead, they will
always be optimized based on the assumption that the installed cost is directly related to the shear capacity.
Therefore, when a group or family is selected, then the nailing schedule within the group with the code check
closest to unity, but still less than 1.0 will get selected during the optimization process.
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Diaphragm Nailing Schedules

Each database of diaphragms is specified by an XML file in the "Diaphragms" sub-directory of the Wood schedules
directory. This directory is located based on the information on the File Locations tab of the Application Settings
dialog.
The program comes preloaded with XML files, including OSB and Plywood databases from the American Wood
Council's 2015 Special Design Provisions for Wind and Seismic.
Note:
l

l

The 2015 IBC refers directly to AWC SDPWS 2015 instead of publishing separate IBC tables as in previous
versions.
Diaphragm design is currently only available for flexible diaphragms that were created in RISAFloor and
brought into RISA-3D.

The first sheet of the XML file should always be descriptive of the contents of the database (such as IBC_06-09_OSB
). This is because the name used here is the name used in the Design Rules spreadsheet. This sheet contains all of
the identifier, nailing, design and code check information for each nailing schedule. These entries are described
below:

Full Database - Required Fields
The following fields are required information. If they are not provided or are left blank, then that nailing schedule
will not be available for use in the database.
The Label field is a used to identify the diaphragm nailing. This field must be referenced on the sheets that identify
families or groups of panels.
Note:
l

Panels with a label containing the characters "_W" together will be ignored during design optimization.

The Case field is used to specify the layout of the shear panels as shown below. Any diaphragm that has a Case 1
layout also has a Case 3 layout, and the same goes for 2/4 and 5/6.
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The program considers the deck span defined in RISAFloor to coincide with the long direction of the plywood.
Therefore, Cases 2, 3 and 6 are considered parallel to the to the RISAFloor deck span. Whereas, Cases 1, 2 and 5
would be considered perpendicular to the same deck span.
The Blocked field specifies whether blocking is used to achieve the associated design strength. It also determines
the method by which the diaphragm deflection will be calculated. For more information see Diaphragm Deflection.
The Panel Grade field specifies what grade of structural panel is used in the diaphragm. This may be set to either
“Structural-I”, "Rated Sheathing" or “Other” and is used as a criteria in the Design Rules.
The Panel Thickness field specifies the thickness of the structural panel used for the diaphragm. This is a decimal
value that is rounded to four places for reporting convenience. For example, a 15/32” panel is listed as 0.4688
The Boundary/Cont Edge Spacing field specifies the nail spacing at the boundary and along any continuous edges.
These must be specified as the same value.
The Other Edge Spacing field specifies the nail spacing at non-continuous edges.
The Nail Lines field specifies the number of lines of nails along each panel edge. This value is greater than (1) for
High Load diaphragms. This value is not currently used in design optimization, but is reported on the output for
reference purposes only.
The Strong Shear Capacity field specifies the shear strength of the diaphragm (lbs/ft) based on its stronger case.
For example, while Case 1/3 represents the same panel layout, Case 1 has greater strength than Case 3 (based on
load direction). This is the seismic capacity, which the program can automatically increase for wind loads if the
Wind ASIF function is enabled.
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The Weak Shear Capacity field specifies the shear strength of the diaphragm (lbs/ft) based on its weaker case.
There are many situations where strong and weak capacities are identical. In these cases the same value must be
specified for both fields. This is the seismic capacity, which the program can automatically increase for wind loads if
the Wind ASIF function is enabled.
The Strong Ga field specifies the apparent shear stiffness (kips/in) of the diaphragm as specified in the NDS
document Special Design Provisions for Wind and Seismic Since this is the strong direction it will be based on the
stronger direction / case for loading. For example, while Case 1/3 represents the same panel layout, Case 1 has
greater stiffness than Case 3 (based on load direction). For more information see Diaphragm Deflection.
The Weak Ga field specifies the apparent shear stiffness (kips/in) of the diaphragm as specified in the NDS
document Special Design Provisions for Wind and Seismic.
The Gt field specifies the shear stiffness of panel depth. It is always the same for both strong weak directions, hence
it does not need to be specified twice. For more information see Diaphragm Deflection.
The Strong Nail Slip (en) field specifies the nail slip used for deflection calculations based on the stronger case.
For example, while Case 1/3 represents the same panel layout, Case 1 may have less nail slip than Case 3 (based on
load direction). For more information see Diaphragm Deflection.
The Weak Nail Slip (en) field specifies the nail slip used for deflection calculations based on the weaker case.
There are many situations where strong and weak nail slips are identical. In these cases the same value must be
specified for both fields. For more information see Diaphragm Deflection.

Note:
l

The Gt and Nail Slip fields are ignored for unblocked diaphragms.

Full Database - Optional Fields
The following fields are optional. They are not currently used in the design, capacity or deflection calculations, but
are reported on the detail reports for informational purposes only.
The Framing Width field identifies the minimum required framing width for the nailing layout. A higher shear
capacity can typically be achieved for a diaphragm by using wider supporting framing, thereby reducing the tension
perpendicular to the grain of supporting members.
The Minimum Penetration field identifies the minimum required nail penetration specified in the IBC/NDS tables.
The Nail Size listed in the spreadsheet is intended to refer to the Common nail size, but is reported only for
reference purposes and are NOT used in the capacity calculations. If the nail size is changed by the user, then the
user should also change the Shear Capacity entry accordingly. The section on shear walls contains a good reference
table for common, box and sinker nails.

Grouping Panel / Nailing Schedules for Design Optimization
The other sheets in the database allow the user to organize multiple nailing schedules into groups or families for
design optimization purposes. These additional sheets CANNOT be the first sheet in the XML file as that first sheet
must always be the one where the full database information resides.
The labels specified on these sheets refer only to nailing schedules that have already been defined on the first (full)
database sheet.
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RISA-3D has design databases for CFS shear walls which are used to optimize the nailing for the wall. The criteria
used for this optimization is specified on the CFS Wall (Fasteners) tab of the Design Rules spreadsheet. In addition
to this basic criteria, the user may specify a subset of the overall database from which the design / optimization
must be performed.

Panel Nailing Schedules

Each database of wall panels is specified by an XML file in the "Shear Panels" sub-directory of the CFS Wall panels
directory. This directory is located based on the information File Locations tab of the Application Settings dialog.
The program comes preloaded with XML files, including Wood, Steel sheet, Fiberboard, and Gypsum databases
based on the AISI S240-15 and AISI S400-15 codes.
The first sheet of the XML file should always be descriptive of the contents of the database (such as AISI 2015
Wood). This is because the name used here is the name used in the Design Rules spreadsheet. This sheet contains
all of the identifier, nailing, design and code check information for each nailing schedule. These entries are
described below.

Full Database - Required Fields
The following fields are required information. If they are not provided or are left blank, then that nailing schedule
will not be available for use in the database.
The Label field is a used to identify the panel schedule and its nailing requirements. This field must be referenced
on the sheets that identify families or groups of panels. Maximum numbers of characters for this field is 32.
Note:
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l
l

Panels with a label containing the characters "_W" together will be ignored during design optimization.
Panels containing the same exact label name as a preceding panel will be ignored and will not be loaded into
the program.

The Type of Wall dictates the design method that this row should be associated with.
The Sheathing Material indicates which material of the sheathing. This should be Wood Structural, Steel Sheet,
Fiberboard or Gypsum Board Panels.
The 2:1 to 4:1? column should only contain a yes or no entry. “No” means that the row will only apply for walls
with height-to-width ratios up to 2:1. “Yes” means that the row only applies for walls with height-to-width ratios
greater than 2:1 but less than 4:1.
The Thickness column is used during the design to help set the elastic stiffness of the wall panel used during the
FEM solution.
The Fastener Spacing is used during the design optimization to limit the available panels based on the Design
Rules specified by the user.
The Min Member Thickness is used in the design optimization to pick a sheathing configuration that satisfies the
minimum required stud thickness. For wood sheathing, this column is treated as the required thickness since AISI
S400 does not permit any other thickness to be used for the wood sheathing case.

The Gov by S400 (EL) determines whether this sheathing configuration comes from the AISI S400-15 code or not.
This column should only contain a yes or no entry. A “no” entry means that this configuration comes from AISI
S240-15 and will only be applied to load combinations that do not contain earthquake load categories. A “yes” entry
means that this configuration is pulled from the AISI S400-15 provisions and will only be applied when the load
combination contains an earthquake load category (EL, ELX, ELZ, etc).
The Shear Capacity listed in the spreadsheet is the primary value that controls the code checking of the shear wall.
This is the nominal lateral capacity of the shear wall that is pulled directly from the tables in AISI S240 and S400.
The program will then apply the appropriate factors depending on if ASD or LRFD design is selected.
The Shear Modulus is (in combination with the panel Thickness defined above) is used to set the elastic stiffness of
the wall panel that will be used during the FEM solution. This value is also used in the reported design deflection
calculation for wood or steel sheathed panels.
For 7/16” OSB, we are assuming 24/16 OSB rated sheathing and approximating G based on AISI S240-15-C pg. 30.
CGGVtV = 177,300 psi
For Struct 1 sheathing (4-ply) we are using IBC values assuming 24/16 rated sheathing. The values reported in the
table are given in lb/in. For the values input in the spreadsheets that we’ll use, we take this value and divide by the
panel thickness to get this in psi which is required in the deflection calculation.
Note:
l

When a family or group of panels / nailing schedules are assigned to a shear wall, the lowest value of Shear
Modulus and Min Panel thickness will be used to determine the elastic stiffness of the plate elements in the
FEM solution.
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Full Database - Optional Fields
The Min Screw Size listed in the spreadsheet is reported only for reference purposes and are NOT used in the
capacity calculations.

Grouping Panel / Nailing Schedules for Design Optimization
The other sheets in the database allow the user to organize multiple nailing schedules into groups or families for
design optimization purposes. These additional sheets CANNOT be the first sheet in the XML file as that first sheet
must always be the one where the full database information resides.
The panel labels specified on these sheets refer only to panel / nailing schedules that have already been defined on
the full database sheet. The information in this sheet need not be organized in a specific order. Instead, they will
always be optimized based on the assumption that the installed cost is directly related to the shear capacity.
Therefore, when a group or family is selected, then the nailing schedule within the group with the code check
closest to unity, but still less than 1.0 will get selected during the optimization process.
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Technical Support
Technical support is an important part of the RISA-3D package. There is no charge for technical support for all
licensed owners of, or subscribers to, the current version of RISA-3D. Technical support is very important to the
staff at RISA Tech, Inc.
Hours: 6AM to 5PM Pacific Time, Monday through Friday (excluding holidays)
Before contacting technical support, you should typically do the following:
1. Please search the Help File or General Reference Manual. The Help File and General Reference are
meant to cover most common questions asked about RISA-3D. The Table of Contents or Search can be used
to find specific topics. This is a good first step in finding the answer to your question. It is also good practice
to go through all of the Tutorials when you first get the program. This will help you get a feel for the program and likely increase your modeling confidence.
2. Ensure that you are running the latest version of the software. Click the Help/Info button on the Quick
Access Toolbar.
3. Visit our website at risa.com.
4. Make sure you understand the problem, and make sure your question is related to the program or structural
modeling.
5. Take a few minutes to experiment with the problem to try to understand and solve it.
Email: support@risa.com. If your question is related to a specific model, please send us that model. That makes it
much easier for us to debug a problem or answer questions about specific issues. The model file has a .R3D
extension. Make sure you tell us your name, company name, serial number, Key ID, or Cloud ID, phone number, and
give a thorough problem description. If you have multiple members, plates, or load combinations, make sure you
specify which ones to look at.
Phone Support: (949) 951-5815. Feel free to call, especially if you need a quick answer and your question is not
model specific and therefore doesn't require us to look at your file.

General Reference Manual

909

Index

Index
Animation 297

2

Animating Deflections 297
2010 NBC 174

Animating Mode Shapes 164

2015 NBC 174

Animating Moving Loads 402

2016 ASCE 174

Appending Files 200

2D Models 40

Application Interface 4

3

Application Settings
Advanced 104

3D View 17

A

File Locations 108
General 102

Accelerated Solver 643
Acceleration (spectral) 166
Accidental Torsion
Dynamic (modal) analysis 158
Adding Shapes 30, 43, 300, 344, 622
Advanced Tab 11
AISC 13th and 14th Editions - Design Guide
25 323
AISC Code Check Results 328

Input 105
Output 106
Applying Changes 222
Applying Loads 348
Arbitrary Shapes 623
Arc Generation 202
Circular Arc 202
Parabolic Arc 203
Area Loads 379

AISC Design Code Limitations 310

Attribution 390

AISC Design Code Special Messages 312

Direction 380

AISC Design Codes 309

Distribution 382

ALL Boundary Condition 40

Drawing 379

Aluminum - Design 33

Spreadsheet 380

Aluminum Design
Limitations 35
Results 34
Aluminum Design Parameters 33
Aluminum Detail Report 35
Aluminum Unbraced Length 33
Ambient Temperature 528
Analysis Offset 478

General Reference Manual

Australian & New Zealand Design Codes 321
Australian & New Zealand Design Codes - Limitations 322
Australian Code Check Results 337
Automatic Backup 102
Customizing 102
File Operations 201
Automatic Generation 202

i

Index

Axes 514
Member Local Axes 467

British Code Check Results 331

Plate Local Axes 552

British Design Code - Limitations 316

Setting the Plate Local Axes 514

British Design Code - Member Design Parameters 316

Setting the Vertical Axes 514
Axial Force 490
Axial Stress 493

Building a Report 577
Building Codes 173, 368

Axis 514

C

B

Cables 521

Backup 102, 201
Customizing 102
File Operations 201
Bar Shapes 304
Database 304
Limitations 312
Base Elevation 429
Base Shear 425
Baseplate Connections 98
Batch Solution 642
Beam Stability Factor (wood) 874
Block Operations (spreadsheet) 645
Boundary Conditions 37, 683
All 40
Creating and Modifying 37
Display 274, 283
Fixed 41
Reaction 41
Slave Joints 42
Soils Springs 574
Spreadsheet 39
Springs 41, 574
Box Selections 254
Brace to Base Plate Connections 98
Braced Frames 619

ii

Braces 164, 533

Canadian Code Check Results 329
Canadian Design Codes - Limitations 314
Canadian Design Codes - Member Design Parameters 313
Canadian Design Codes - Special Messages 315
Cb Factor (AISC) 309
Center of Gravity 531
CFS View Controls 699
CFS Wall - Design 699
CFS Wall Detail Reports 716
CH factor (Wood) 875
Channel Shapes 302
Circular Generation 202
Arc 202
Disk 209
Radius 210
Clearing Cells 650
Click to Rotate 215
Cm Coefficient 448
Cold Formed 47
Concrete 62
Hot Rolled 309
Wood (moisture) 448
Coefficient of thermal Expansion 447
Cold Formed Steel Design 46
AISI 46

RISA-3D V20

Index

Bending Coefficients 47-48

Tie Spacing 517

Limitations 50

Unbraced Lengths 60

R-Value 48

Concrete Design Considerations 727

Results 48

Concrete Design Results 71

Color 275-276, 284-285, 292, 294

Concrete Lintel Considerations 732

Column Stability Factor (Wood) 874

Concrete Reinforcing Spreadsheet Results 742,
794

Commands
Shortcuts and Hot Keys 23
Company Name (printed) 580
Composite Behavior 521
Compression Only 41
Member 463
P-Delta 536
Springs 41
Compressive Strength 449
Concrete Cover 111
Concrete Cracking 197
Concrete Design 59
Beam Results 71
Code Options 59
Controlling Bar Sizes 110
Cover 110
Cracking 62-63
Design Rules 110
Detail Reports 75
K Factors 61
Limitations 66
Messages 69
Rebar Layout 53
Rebar Layout (Beams) 63
Rebar Layout (Columns) 62
Spans 59
Stress Block 64
Sway 61
T-beams & L-beams 64

General Reference Manual

Concrete Stiffness 63
Icracked (Beams) 63
Icracked (Columns) 62
Service Level Stiffness (beams) 63
Service Level Stiffness (columns) 62
Concrete Wall Design 725
Concrete Wall Design Rules 737
Concrete Wall Detail Reports 743
Concrete Wall Modeling Considerations 734
Concrete Wall Regions 726
Concrete Wall Results 741
Concrete Wall Seismic 754
Concrete Wall Spreadsheet Results 741
Cone Generation 208
Connection Results 91
Connection Rules 87
Context Help 299
Convergence 537
Dynamics 159
P-Delta 513, 537
T/C Members and Springs 41, 463
Work Vectors 159
Coordinates 25
Copy 236, 238
Linear Copy 236, 238
Loads 352
Mirror Copy 240
Offset 237

iii

Index

Rotate Copy 239

Stainless Steel 344

Spreadsheet Cells 651

Structural Desktop (SDT) 625

Corner Forces 561, 638

Date 579

Cover 111

Defaults 102, 652

CQC Method 168

Load Combinations 357

Cr factor (Wood) 875

Materials 446

Creating Openings 681

Mode 28

Creating Regions 682

Plot Options 273, 282

Criteria Selections 255

Deflection Ratio Option 462

Crossing Members 505

Deflection Ratio Options 475

CS shapes 45

Degenerate Plate Check 556

CS Shapes 32

Degrees of Freedom (DOF's) 39

CSA 086 Adjustment Factors 876

Deleting 234

CU shapes 44

Density 447

Custom Shapes 623
Arbitrary 623

Self Weight 348

Cold Formed 43

Design Category 425

Hot Rolled 300

Design Lists 881

Customization 102

Design Parameters 456

CV 874

Cold Formed 46

Cylinder generation 207

Concrete Beams 62
Concrete Columns 60

D

Hot Rolled 308

Damping 189
Damping Ratio 170

Wood 872
Design Rules 109

Data Entry Preferences 102

Concrete 110

Database 622

Deflection 110

Aluminum 31, 623
Arbitraty Shapes 623
Cold Formed 44, 622

iv

Material Properties 447

Size/UC 109
Detail Reports 587
Concrete Detail Reports 75

Concrete 53, 622

Dialog Boxes 28

Hot Rolled Steel 300, 622

Diaphragm Deflection Calculations 142

NDS Wood 623, 862

Diaphragm Design Limitations 143

On-Line Shapes 625

Diaphragm Key Plan 143

RISA Section 624

Diaphragm Nail Spacing Schedule 141

RISA-3D V20

Index

Diaphragm Results - Detail Reports 137

Loads 349

Diaphragm Stiffness 117

Members 455

Diaphragms 116

Plates 541

Accidental Torsion 158

Point Loads 393

Modeling 571

Snap Points 231

Slaving 534

Surface Loads 413

Diaphragms - Analysis and Results 133

Wall Panels 675

Direct Analysis Method 515, 537

Drawing Grid 683

Direct Analysis Method - Ratio 148, 540

Drawing Tools Tab 10

Direct Analysis Method - Stiffness
Reduction 309

Drift 145

Directionality Factor (Kd) 429
Discretizing Mass 160
Disk Generation 209
Displacements 530

Defining Story Joints 42
Drift - Seismic 147
DXF Files 150
Dynamic Analysis 156, 166, 178, 643
Dynamic Pan / Zoom / Rotate 22

Display
Deflection 216

E

Loads 216

E (Young's Modulus) 446

Distance Tool 23

Edit mode 28

Distortion 555

Eigensolution 156

Distributed Loads 396

Elevated Slabs 128

Directions 399

Email (support) 909

Drawing 396

Emin Calculation 878

Spreadsheet 397

Enforced Displacements 376, 523

Dome 203

Envelope Solution 642

Double Angles 303, 323

Error Messages 886

Database 303

EuroCode Code Check Results 333

Limitations 311

EuroCode Design Codes - Limitations 319

Drawing 222
Area Loads 379

EuroCode Design Codes - Member Design Parameters 317

Boundaries 37

EuroCode Design Codes - Special Messages 320

Distributed Loads 396

Excluding Results 483, 583

Grid 228

Exporting Files 201

Import DXF 232

Exposure Category 429

Joint Loads 375

Exposure Coefficient 430, 432

General Reference Manual

v

Index

Exposure Constant Alpha 430

Generate Time History 178

Exposure Constant zg 430

Generation 202
Arcs 202-203

F

Cones 208

F'm compressive strength 450

Cylinders 207

Fc' (compressive strength) 449

Disk 209

File Locations 108

Members 204

File Menu 6

Radius 210

File Operations 198

Tanks 207, 211

Filling Spreadsheets 649

Trusses 205

Filter Input 269

Geodesic Dome Generation 206

Find 652

geometric axes 667, 669

Fixed Boundary Conditions 41

Governing Equation 426

Flat File 579

Graphic 213

Flat Use Factor -CSA 877

Display 213

Flat Use Factor (Wood) 874

Editing 222

Flexible Diaphragms 121

Printing 580

Floor Level 432-433

Results 585

Fluid Density 211

Selection 252

Footings 572

Grid 228

Form Factor (wood) 875

Drawing 228

Foundations 574

Project 224

Frequencies 161

Grid Increments 683

Convergence 159

Ground Elevation Factor 429-430

Number of Modes 157

Gupta method 168

Trouble Shooting 164

Gust Effect Factor 431

Work Vectors 159
Fu (Ulitmate Stress) 447

H

Function 178

Hardware Requirements 1

Fy (Yield Stress) 447

Height 432

G

Help Options 299
Hold Downs 700, 820

G (shear Modulus) 446

Home Tab 8

General Member Design Limitations 322

Hot Keys 23

General Preferences 102

vi

RISA-3D V20

Index

Hot Rolled Steel Design 306

Iterations 463

AISC

Dynamic Analysis (subspace iterations) 159

ASD Limitations 311

P-Delta 537

Allowable Stress Increase Factor 310

T/C Members 463

Code Limitations 306

T/C Springs 40

K Factors 669
Lateral-Torsional Buckling Modification
Factor 309
Parameters 308

J
J-Joint 460
Joints

Results 328

Displacements 530

HSS Shapes 302

Loads 375

HU Shapes 45

Mass 376

I

Reactions 531
Results 530

I-Joint 460

Slaving 533

Icr (Concrete Walls) 679
Image Capture 578

K

Import 181

K-Joint 460

Importance Factor 425, 430

K (Concrete Walls) 680

Importing Files 201

K Factors 669

Inactivating

Keyboard Commands 23

Members 483
Plates 551
Inclined Supports/Reactions 522

Kf Factor 875

L

Indian Design Codes - Limitations 321

L Shapes 32, 303

Indian Design Codes - Member Design Parameters 320

Labels 110, 460, 548, 630

Information Dialog 528

Lateral Stability Factor - CSA 877

Large Models (modeling tips) 524

Joints 528

Layers (CAD) 150

Plates 549

Lbyy 665

Input Filter 269

Lbyy, Lbzz or Lb-in Lb-out 60, 661

Insert Cells 650

Leeward Pressure 433

Integration Error Messages 98

License Agreement 2

Interactive Diagrams 588

Limitations 736

Inverting Selections 255

Limits 2

Isometric View 215

General Reference Manual

vii

Index

Line Selections 255

Manuals 1

LL Shapes 303

Masonry - Suggested Design 770

Load Attribution 686

Masonry Lintels 764

Load Combinations 357

Masonry Regions 765

Design Options 360

Masonry View Controls 763

Load Duration Factor - CSA 876

Masonry Wall Design 772

Load Generation 428

Masonry Wall Design Rules 787

Load Generation - Seismic Loads 423

Masonry Wall Detail Reports 794

Load Generation - Wind Loads 421

Masonry Wall Modeling 763

Loads 348

Masonry Wall Optimization 768

Cases 351, 359

Masonry Wall Results 792, 813

Categories 355, 359

Masonry Wall Seismic 807

Combinations 357

Mass 157

Display 279, 288

Dynamics 157

Duration factors 367, 873

Floor Mass 158

Joint Loads 375

Joint Load 376

Member Loads 379, 393, 396, 411

Nodal Load 376

Nodal Loads 375

Mass Moment of Inertia 158, 377

Notional Load Generation 421

Master Joints 42, 533

Path 405

Match 250

Plate Loads 413

Material Properties 446

Seismic Load Generation 423

Material Set 678

Time Effect Factor 875

Material Take-Off 452

Local Axes 467

Material Type 678

Members 275, 284, 292, 460, 467

Mean Roof Height (h) 430

Plates 276, 285, 294, 552

Member Design Lists 109

Local Modes 157, 164

Member Design Rule Editor 111

Lock to Axis 231

Member Shear Areas 484

Lock to Plane 232

Members 454

Locked Joints 655

Adding Nodes 245

Locking Selections 265

Analysis Offset 462

Lumped Mass 160

Bending Stress 493

M
Maintenance (program) 2

viii

Deflections 497
Detail Reports 587
Drawing 454

RISA-3D V20

Index

End Offsets 483

Seismic 519

End Releases 469

Solution 510

Forces 490

Model View 27

Generation 204

Model View Settings 273, 282

Inactive 483

Modeling Tips 520

Local Axes 467

Applying in-plane moment to plates 520

Modifying 456

Beam fixed to a shear wall 520

Orientation 467

Cables 521

Physical 466

Composite Behavior 521

Properties 457

Dynamics 160

Results 489

Inclined Supports / Reactions 522

Shear Area 483

Large Models 524

Sign Convention 492

One member crossing over another 523

Splitting 244

Plates 555

Spreadsheet 459

Reaction at enforced displacement 523

Stresses 493

Rigid Links 523

Torsion 485, 496

Modes (program) 28

Torsional stresses 487, 496

Modify Tab 9

Warping 485, 511

Modifying

Merge Lintels 768

Members 456

Messages 861, 886

Plates 543

Error Message 886
Warning Log 861

Wall Panels 676
Modifying Loads 349

Mezzanine Levels 442

Moment Connection 96

Mirror 240

Moving Elements 241

Modal Combination 168

Moving Load Step Point Load Generation 408

Modal Frequency 161, 167

Moving Loads 402

Mode Shapes 162

Multi-Threaded Solutions 641

Model Merge 249, 505
Model Settings 509

N

Advanced 512

NDS 868

Axis 514

Nesting load combinations 364

Codes 515

New Models 102

Concrete 517

New Zealand Code Check Results 339

Rebar 518

General Reference Manual

ix

Index

Nodes 527, 530

Paths 108, 405

Loads 375

Patterns 406

Mass 376

Phone (support) 909

Normal Stress 559

Physical members 462, 466

NPS Shapes 32

Pins 469, 550

Nu (Poisson's Ratio) 446

Boundary Conditions 37

Number of Sections 489

Corner Releases 550

O

End Releases 469
Pipe Shapes 302, 625

OD Shapes 32

Plane Stress 557

On-Line Help 299

Plate Local Axis 514

On-Line Shapes 625

Plates 541

On-Line website 299

Convention 557

One-way members 463

Convergence 570

One-way springs 41

Corner Forces 561

Openings 681

Corner Releases 550

Optimization 109

Drawing 541

Optimization Results 113

Dynamics 160

Options 102

Examples 567

Overview 1

Forces 560

P

Generation 556
Inactive 551

P-Delta 358, 535
Including P-Delta in a Load Combination 358
Turning off the P-Delta Requirement 106
P-Little Delta - AISC DAM 540
P - Little Delta Analysis 539
Page Number (for printing) 577
Panels 12
Panning (graphics) 215
Parabolic Arc Generation 203
Parapet Wind Loading 434
Partial Views 221
Participation (mass) 157, 161, 164, 168
Participation factors 161, 168

x

Information Dialog 549
Loading 413
Local Axes 543, 552
Mesh 556
Mesh Transition 574-575
Plane Stress 549, 557
Results 559
Spreadsheet 547
Stresses 559
Sub-meshing 546
Point Loads 393
Drawing 393
Spreadsheet 394

RISA-3D V20

Index

Poisson's Ratio 446

Rectangular Tanks 211

Polar Copy 239

Redo 223, 648

Polar Move 242

Regions 682

Polar Origin

Releases 462, 469, 550

Arc Generation 202, 209-210
Move / Copy 239, 242
Polygon Selections 255

Rendering (Graphics)
Members 275, 284, 292
Plates 276, 278, 285, 287, 294, 296

Pressure Coefficient 430, 432

Reports 577, 583

Prestressing 412

Required Modes 157, 168

principal axes 667, 669

Residual Mass 160

Principal Stresses (Plates) 559

Resistance Factor 875

Printing 576

Response Spectra Analysis 166

Program Defaults 102

Load Combinations 361

Program Interaction 597

Plotting Spectra 175-176

Program Limits 2

Solution 644

Program Modes 28

Trouble Shooting 164

Project Grid 224

Results 530, 582

Project Information 509

Joints 530

Projected Loads 380, 399, 416

Members 489

Q

Plates 559
Preferences 106

Quadrilateral element 553

Results Tab 11

Quick Access Toolbar 11

Results View Settings 291

Quick Find 271

Results Window Toolbar 21

Quick View 216

Ribbon Toolbar 6

R

Right-Click Menu 21
Rigid Diaphragms 116

Radius Generation 204
Re-Labeling 460, 527, 548, 630
Re-Labeling Selected Elements 249
Reactions 41, 292
Boundary Condition 41, 523, 531
Rebar 518
Rectangular Drawing Grid 229
Rectangular Shapes 53, 304, 625

Rigid Links 523
RISA-2D Files 201
RISAConnection Integration 86
RISAConnection Spreadsheet 88
RISAFloor
Buckling-Restrained Braced Frame (BRBF)
System | Primary.Not_2D,Primary.Not_
Foundation | [87] 596
Detach 596

General Reference Manual

xi

Index

Diaphragm Mass 377, 595

Members 257

Seismic Loads 596

Nodes 256

Wind Loads 596

Plates 259

RISAFoundation Interaction 597

Solids 262

RISASection 624

Wall Panels 260

Ritz Vector Solver 643

Select Mode 28, 254

Rotating 22, 215

Selection 20

Elements 242

Toolbar 20

Views 215

Using Graphics 252
Using Spreadsheets 270

S

Self-Weight 348

Save As Defaults 102

Dynamic Analysis 160

Saving 6

Material Density 447

Dynamic Results 159

Semi-Rigid Seismic Loads 426

Files 6

Semi-Rigid Wind Loads 443

Results 582

Service Condition Factor 876

Selections 270

Shape Database 622

Views 221
Scaling Elements 243

Concrete 53

Scaling Spectra 170-171

General 622

Scrolling 646

Hot Rolled Steel 300

Secondary Effects 535

Stainless Steel 344

Section Properties 602, 622

Wood 862

Section Results 489

xii

Cold Formed Steel 30, 43

Shear 483

Section Sets 601

Area Coeff (for Deformation) 483

Seismic 603, 609

Area Coeff (for Stress) 484

Seismic Connections 94

Deformation 483

Seismic Design Parameters 423

Modulus 446

Seismic Detailing - Detail Reports 615

Shear Connection Considerations 96

Seismic Load Results 425

Shear Load Coefficient-CSA 876

Seismic Loads 423

Shear Walls 520, 567-568

Seismic Weight 423

Shortcut Keys 23

Select By Property

Shortcut Menu 21

Coordinates 264

Sigma1, Sigma2 (principal stresses) 559

Loads 263

Single Angle 495

RISA-3D V20

Index

Single Angles 312, 322

Procedure 167

Single Solution 642

UBC 173

Size Factor- CSA 877

Splitting Members 244

Size Factor (Wood) 874

Spreadsheets 645

Skyline Solver 641

Copying 651, 653

Slaved Joints 533

Defaults 652

Slenderness Factor 877

Editing 649-650

Sloped Roof Wind Loads 442

Filling 649

Snap Points 231

Finding 652

Soil Properties 191

Inserting 650

Soil Springs 574

Math 649

Solid

Moving 646

Activation 262
Solid Elements 627
Solids 627
Corner Forces 638

Sorting 652
Wall Panels 677
Spreadsheets Tab 10
Springs 41

Creating 627

Boundary Conditions 41

Formulation 632

Soil Spring Calculation 574

Modifying 628

SRSS 168, 362

Results 636

STAAD files 887

Submeshing 629

STAAD users overview 890

Solution 640

Stability 655

Batch 642

Stability Factors (Wood) 874

Envelope 642

Standard Combinations 368

Preferences 106

Standard Skyline Solver 641

Single 642

Standard Solver 643

Sorting 583, 652

Static Base Shear 170

Span 59, 517

Static Solution 641

Sparse Solver 641

Status Bar 25

Spectra 176

Stiffness Matrix 41, 463, 483, 524

Add or Edit 174

Stiffness Reduction 34, 309

ASCE 173

Story Drift. See Drift 146-147

IBC 173

Story Forces / Moments 563, 568

NBC 174

Story node 146

Plotting 175-176

Straps 700, 820

General Reference Manual

xiii

Index

Subgrade Modulus 574

Topographic Factor (Kzt) 430

Submeshing 629

Topographic Factors 429

Suggested Shapes 113

Torsion 485

Surface Loads 413

Transfer Load Between Intersecting Wood
Wall 511

Directions 416
Drawing 413
Spreadsheets 415
Sway
Concrete 61
Sway Flags 671
System Factor 876

Transient Loads 365, 367, 390
Translucent Display 275-276, 278, 284-285,
287, 292, 294, 296
Transverse Shear 553
Trim/Extend Members 246
Tripartite Plot 175
Troubleshooting 861

System Requirements 1

Dynamics 164

T

Error Messages 886
Large Models 524

T Shapes 31

P-Delta 537

Tank Generation 207, 211

Warning Log 861

Tapered Member Results 341
Tapered Members 323
Tapered Wide Flange 302
Database 302
Limitations 312
Tapered Wide Flange Members 95
Technical Support 909
Tee Shapes 302, 311
Temperature 376, 411, 528

Troubleshooting RISAConnection
Integration 96
Truss Connections 469
Truss Generation 205
Truss HSS T-Connections 98
Tube Shape 45
Tube shapes 302
Tutorial 1, 299
Two Dimensional Models 40

Temperature Factor (Wood) 873
Tension only members 462-463

U

Tension only springs 42

UBC 173, 368

Thermal Coefficient 447

Ultimate Stress 447

Thermal Loads 411

Unbalanced Forces 620

Thick Plates 553

Unbraced Lengths 661

Tiling 28

xiv

Concrete 60

Time History 178

Undo 223, 647

Title Bar 5

Unequal Flanges 302, 312

Tooltips 299

Units 672

RISA-3D V20

Index

Unity Check (UC) Results 328

Warning Log 861
Warnings 861

V

Warping 485

Velocity Pressure 431, 433

Web Site 299

Vertical Axis 152, 157, 514

Wet Service Factor (Wood) 873

Vertical Brace Connections 96

Wind ASIF 511

Vibrations 160

Wind Code 429

View mode 28

Wind Load Results 430

View Settings

Wind Loads 421, 428

Model 273, 282

Wind Speed 429

Results 291

Window Selections 254

View Tab 10

Window Tiling 28

Viewer Mode 267

Window Toolbar 18

Volume Factor 874

Windows 26

Von Mises Stress 559

Windward Pressure 433

W

Wood Database Limitations 864
Wood Design 868

Wall Force Results 696

Adjustment Factors 873

Wall Opening Headers 700, 819

Design Code 515

Wall Panel

GluLams 868

Concrete Seismic 757

Limitations 877

Masonry Seismic 813

Messages 880

Wall Panel Editor 680

Parameters 872

Wall Panel Joints 678
Wall Panel Labels 677
Wall Panel Spreadsheets 677
Wall Panel Thickness 678
Wall Panel View Controls 684
Wall Panels 675
Wall Panels - Results 696
Walls 567, 675
Design Forces 568

Shapes 862
Wood View Controls 819
Wood Wall - Design 712, 818, 839
Wood Wall - Suggested Design 835
Wood Wall Detail Reports 847
Wood Wall Floor/3D Interaction 704, 826
Wood Wall Results 715, 845
Work Vectors 159
WT Shapes 302

Dynamics 164
Modeling 567

X

Penetrations 570

X-axis rotation 460

General Reference Manual

xv

Index

X-Braces 533

Y
Y-Top/Y-Bot (bending stress) 493
Yield Stress 110, 447
Young's Modulus 446

Z
Z-Top/Z-Bot (bending stress) 493
Z shapes 31-32
Zooming 22, 220
ZS Shapes 45
ZU Shapes 45

xvi

RISA-3D V20

